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1   Über dieses Dokument

1 Über dieses Dokument
Visualisierungen dienen zum Präsentieren der in die App geladenen Daten. Die Auswahlen, die Sie
in der App treffen, spiegeln sich in allen zugehörigen Visualisierungen auf allen Arbeitsblättern
wider.

Lesen und lernen Sie, wie Sie Arbeitsblätter und Visualisierungen in Ihrer App erstellen und
anpassen. Zudem erfahren Sie, wie Sie wiederverwendbare Master-Elemente erstellen und wie
Formeln in Visualisierungen eingesetzt werden.

Dieses Dokument wurde aus der Online-Hilfe für Qlik Sense erstellt. Es ermöglicht das Lesen der
Hilfe im Offline-Modus und ein einfaches Ausdrucken von Seiten und enthält im Vergleich zur
Online-Hilfe keine zusätzlichen Informationen.

Die Online-Hilfe, zusätzliche Guides und mehr finden Sie auf help.qlik.com/sense.
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2   Creating apps

2 Creating apps
Qlik Sense apps are purpose-built applications created with data. App users explore
the data through visualizations selected and enhanced by app developers.

Apps are created by three primary methods depending on skill level and how much data
manipulation is required upon dataload. Options from basic to advanced include:

1. Uploaded once and never modified.
2. Modified manually through Data manager.
3. Replaced or refreshed with net new changes.

The foundation of an app is the data model and load script. Measures and dimensions are reusable
data items used to build charts. Sheets and stories display and organize your visualizations.
Discoveries can be made by applying filters and selections.

A Qlik Sense app with selections applied

Permissions are required to create and interact with apps. If app functionality is not available to you,
contact your administrator for appropriate permissions.

Qlik Sense apps contain data, and use visualizations to explore that data. Make
discoveries by applying selections to visualizations.
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2   Creating apps

The foundation of an app is the data model and load script. Measures and dimensions are reusable
data items used to build charts. Sheets and stories display and organize your visualizations.
Bookmarks are an easy way to save a specific selection state on a sheet

Whoever creates an app is automatically designated as its owner. An app can be re-used, modified,
and shared with others, depending on access rights. Different actions can be carried out depending
on whether the app is published or not.

The .qvf file format is a proprietary format.

Qlik Sense apps are purpose-built applications created with data. App users explore the data
through visualizations selected and enhanced by app developers. Apps are created by three
primary methods depending on skill level and how much data manipulation is required upon
dataload. Options from basic to advanced include:

2.1 Foundations

Data manager and Data load editor
The Data manager lets you quickly add and transform data. You can also associate data tables. The
Data load editor uses scripts to connect to a data source and retrieve the data.

Measures
Measures are calculations used in visualizations. Kennzahlen werden aus einer Formel berechnet,
die sich aus Aggregierungsfunktionen wie beispielsweise Sum oder Max zusammensetzt und mit
einem oder mehreren Feldern kombiniert wird.

Dimensions
Dimensions are fields used in visualizations. Dimensionen legen fest, wie die Daten in einer
Visualisierung gruppiert werden. Beispiel: Gesamtumsatz pro Land oder Anzahl der Produkte pro
Anbieter

2.2 Structure and visuals

Sheets
Sheets contain data visualizations, such as charts and tables. You create structure in your app by
grouping visualizations on sheets. For example, you could have a sheet for North American sales,
and a different sheet for Europe.

Bookmarks
Bookmarks are shortcuts to a certain set of selections and chart expansions.
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Stories
Stories are based on snapshots of visualizations. You present your data by creating a story that
guides you to new insights by combining snapshots of data at specific times and selection states.

In Qlik Sense Desktop, apps are typically stored in <user>\Documents\Qlik\Sense\Apps,
as <Appname>.qvf, where <Appname> is the name of the app. If you rename an app in
Qlik Sense Desktop, the .qvf is not updated.

2.3 Strukturieren von Apps mithilfe von Arbeitsblättern
Mit Arbeitsblättern können Sie Ihre Ideen und Ziele für Ihre App strukturieren. Wenn Sie
eine neue App erstellen, ist es eine gute Methode, zuerst eine Struktur aus leeren
Arbeitsblättern zu erstellen, bei der jedes Arbeitsblatt für eine Idee oder ein Ziel steht.
Dadurch erhalten Sie einen guten Überblick über die App.

Übersicht
Beispiel: Sie erstellen eine Übersicht über die wichtigsten Kennzahlen des Unternehmens, wie
Umsatz und Gewinnspannen nach Bundesstaat, Region und Produkt. Anstatt all diese
Informationen an einer Stelle zu speichern, könnten Sie sie strukturieren, indem Sie für jeden dieser
Zwecke ein Arbeitsblatt anlegen.

Jedes Arbeitsblatt erfüllt einen eigenen Zweck und betrifft einen bestimmten Aspekt.

Ein Arbeitsblatt enthält die Diagramme und Tabellen für die Datenvisualisierung. Eine App kann
mehrere Arbeitsblätter enthalten. Ihre Auswahlen wirken sich auf die Visualisierungen aus,
unabhängig davon, auf welchem Arbeitsblatt sich diese befinden.

Beispiel eines Arbeitsblatts mit Feldern auf der linken Seite zum Auswählen und Herausfiltern der Daten, die
in den Visualisierungen rechts dargestellt werden sollen.
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Erstellen eines neuen Arbeitsblatts
Sie können ein neues Arbeitsblatt in der App-Übersicht oder über das Extras-Fenster anlegen.

Sie können den Arbeitsblatt-Navigator öffnen, indem Sie in der Arbeitsblatt-Ansicht in
der Symbolleiste auf klicken.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der App-Übersicht auf , um die Arbeitsblätter anzuzeigen.

2. Klicken Sie auf Neues Arbeitsblatt erstellen.
3. Geben Sie dem Arbeitsblatt einen Titel und fügen Sie eine Beschreibung hinzu.
4. Klicken Sie außerhalb des Textbereichs, um Titel und Beschreibung zu übernehmen.

Ein neues Arbeitsblatt wird erstellt.

Ändern des Titels und der Beschreibung eines Arbeitsblatts
Sie können den Titel und die Beschreibung Ihrer Arbeitsblätter ändern. Sie können entweder einen
festen oder einen auf einer Formel basierenden, dynamischen Arbeitsblatt-Titel verwenden.
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2   Creating apps

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der App-Übersicht auf , um die Arbeitsblätter anzuzeigen.

2. Gehen Sie folgendermaßen vor:
l Wenn Sie sich in der Rasteransicht befinden, , klicken Sie auf den Titel des

Arbeitsblatts und anschließend auf .

l Wenn Sie sich in der Listenansicht befinden, , klicken Sie auf .

3. Bearbeiten Sie Titel und Beschreibung.
4. Klicken Sie außerhalb des Textbereichs.

Die vorgenommenen Änderungen werden gespeichert.

Sie können den Titel und die Beschreibung eines Arbeitsblatts auch im Fenster
„Eigenschaften des Arbeitsblatts“ ändern.

Dynamischer Arbeitsblatt-Titel
Im Fenster „Eigenschaften des Arbeitsblatts“ können Sie in der Eigenschaft Titelformel einen auf
einer Formel basierenden, dynamischen Arbeitsblatt-Titel festlegen. Dazu können Sie eine
beliebige Diagrammformel verwenden.

Wenn Sie einen dynamischen Arbeitsblatt-Titel festlegen, wird der feste Titel (Titel) nicht
verwendet.

Festlegen einer Anzeigebedingung für ein Arbeitsblatt
Sie können eine Bedingung in Bedingung anzeigen festlegen, um ein Arbeitsblatt in einer App
abhängig davon, ob eine Formel als wahr oder falsch ausgewertet wird, anzuzeigen oder
auszublenden. Das Arbeitsblatt wird nur angezeigt, wenn die Formel als wahr ausgewertet wird.
Beim Ausblenden eines Arbeitsblatts werden die Daten in einer App nicht ausgeblendet oder
ausgeschlossen.

Beispiel: Sie können ein Arbeitsblatt erstellen, das nur verfügbar ist, wenn bestimmte Werte in Ihren
Daten vorhanden sind. In der Regel verwenden Sie hierfür eine if-Funktion.

Ändern der Miniaturansicht eines Arbeitsblatts
Sie können die Standardminiaturansicht ersetzen, um das Unterscheiden zwischen Arbeitsblättern
in der App-Übersicht und im Extras-Fenster zu erleichtern. Sie können eins der Standardbilder oder
ein eigenes Bild verwenden.

Beachten Sie folgendes:

l Die folgenden Formate werden unterstützt: .png, .jpg, .jpeg und .gif.
l Das optimale Seitenverhältnis einer Miniaturansicht beträgt 8:5 (Breite:Höhe).
l Sie können lediglich die Miniaturansicht von noch nicht veröffentlichten Arbeitsblättern

hinzufügen oder ändern.
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2   Creating apps

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der App-Übersicht auf , um die Arbeitsblätter anzuzeigen.

2. Gehen Sie folgendermaßen vor:
l Wenn Sie sich in der Rasteransicht befinden, , klicken Sie auf den Titel des

Arbeitsblatts und anschließend auf .

l Wenn Sie sich in der Listenansicht befinden, , klicken Sie auf .

3. Klicken Sie auf der Standardminiaturansicht auf .
Die Medien-Bibliothek wird geöffnet.

4. Klicken Sie auf einen Ordner in der Medienbibliothek, z. B. In App oder Standard.
5. Wählen Sie das Bild aus, das Sie als Miniaturansicht für das Arbeitsblatt verwenden möchten,

und klicken Sie auf Einfügen.

6. Klicken Sie auf , um die Bearbeitung zu beenden.

Das ausgewählte Bild wird nun als Miniaturansicht für das Arbeitsblatt verwendet und im Extras-
Fenster und in der App-Übersicht angezeigt.

Sie können die Miniaturansicht eines Arbeitsblatts auch im Extras-Fenster oben rechts
oder im Eigenschafts-Fenster des Arbeitsblatts ändern.

Folgende Formate werden unterstützt: .png, .jpg, .jpeg und .gif.

Für Qlik Sense: Sie können Bilder in den Ordner In app in der Medienbibliothek hochladen. Sie
müssen die Qlik Management Console verwenden, um Bilder in den Standardordner hochzuladen.

Für Qlik Sense Desktop: Sie können Bilder im folgenden Ordner auf Ihrem Computer platzieren:
C:\Users\<user>\Documents\Qlik\Sense\Content\Default. Bilder stehen im Ordner default in der
Medienbibliothek zur Verfügung. Wenn eine App zwischen Installationen verschoben wird, werden
die in der App verwendeten Bilder in der qvf-Datei zusammen mit der App gespeichert. Beim Öffnen
der App an einem neuen Speicherort befinden sich die Bilder im Ordner In App in der
Medienbibliothek für die App.

Ändern der Gitternetzgröße eines Arbeitsblatts
Sie können die Gitternetzgröße des Arbeitsblatts anpassen, um mehr Visualisierungen auf einem
Arbeitsblatt unterzubringen oder besser steuern zu können, wie Visualisierungen positioniert
werden. Das Gitternetz wird angezeigt, wenn Sie eine Visualisierung hinzufügen, verschieben oder
deren Größe ändern.
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2   Creating apps

Die Gitternetzgröße kann im Fenster „Eigenschaften des Arbeitsblatts“ geändert werden.
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Gehen Sie folgendermaßen vor:

1. Gehen Sie zur Einstellung Gitternetzabstand in den Eigenschaften des Arbeitsblatts.
2. Ändern Sie den Abstand von Breit (der Standardoption) zu Mittel, Schmal oder

Benutzerdefiniert.
3. Wenn Sie „Benutzerdefiniert“ wählen, wird ein Schieberegler angezeigt. Verwenden Sie den

Schieberegler, um die Gitternetzgröße zu ändern. Je höher die Zahl, desto schmäler sind die
Gitternetzabstände.

Anpassen der Arbeitsblattgröße

Standardmäßig verwendet Qlik Sense ein responsives Layout für Arbeitsblätter, das das
Arbeitsblatt an die Abmessungen des Benutzerbildschirms anpasst. Sie können eine
benutzerdefinierte Breite und Höhe für das Arbeitsblatt festlegen, wenn Sie ein nicht responsives
Layout für Ihre Arbeitsblätter verwenden möchten. Damit wird sichergestellt, dass Ihr Dashboard
den Benutzern genau so, wie Sie es erstellt haben, ohne responsive Anpassungen angezeigt wird.
Sie können die Höhe und Breite eines Arbeitsblatts beliebig zwischen 300 und 4.000 Pixeln
festlegen.

Wenn der PDF-Download Ihres Arbeitsblatts zu stark vergrößert angezeigt wird, empfiehlt es sich,
die Arbeitsblattgröße von Responsiv zu Benutzerdefiniert zu ändern.

Die Änderung der Arbeitsblattgröße von Responsiv zu Benutzerdefiniert kann sich auf
die interaktive Erfahrung von Business-Anwendern auswirken. Wenn das
Berichtsausgabeformat besonders wichtig ist, sollten Sie eine berichtsspezifische App
erstellen, um Formatvorlagen und Layout besser steuern zu können.
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Wenn ein Arbeitsblatt eine benutzerdefinierte Größe verwendet, können Sie den Gitternetzabstand
ändern, aber Sie können nicht Arbeitsblatt erweitern zum Ändern der Größe verwenden.

Für auf Responsiv festgelegte Arbeitsblätter, die nicht erweitert sind, weist das exportierte PDF der
Arbeitsblätter folgendes Format auf:

o Querformat: 1680 x 1120 Pixel
o Hochformat: 1120 x 1680 Pixel

Wenn die Arbeitsblattgröße auf Benutzerdefiniert festgelegt ist, behält die PDF-Ausgabe des
Arbeitsblatts den benutzerdefinierten Pixelwert für Breite und Höhe bei.

Eine Änderung der Arbeitsblattgröße von Responsiv zu Benutzerdefiniert kann sich auf die
Klarheit der PDF-Ausgabe auswirken. Wenn Sie ein Arbeitsblatt in benutzerdefinierter Größe
manuell als PDF exportieren, beachten Sie die folgende Best Practice:

l Hochformat: Werte von 1680 x 1120 Pixel oder ein Seitenverhältnis von 1:1,5
l Querformat: Werte von 1120 x 1680 Pixel oder ein Seitenverhältnis von 1,5:1

Bei erweiterten Arbeitsblättern oder Arbeitsblättern in benutzerdefinierter Größe kann die
Auflösung der PDF-Ausgabe geringer ausfallen, wenn das Arbeitsblatt zu groß ist, um auf einer
PDF-Seite korrekt angezeigt zu werden.

Gehen Sie folgendermaßen vor:

1. Ändern Sie die Einstellung der Arbeitsblattgröße von Responsiv zu Benutzerdefiniert.
2. Geben Sie eine Breite für das Arbeitsblatt in Pixeln ein.
3. Geben Sie eine Höhe für das Arbeitsblatt in Pixeln ein.

Ändern des Layouts für kleine Bildschirme
Standardmäßig werden Arbeitsblätter auf kleinen Bildschirmen in der Listenansicht angezeigt. Sie
können die Einstellung ändern, damit sie als Raster angezeigt werden. Für Arbeitsblätter muss das
responsive Layout festgelegt sein, damit sie auf kleinen Bildschirmen als Raster angezeigt werden.
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Ein Arbeitsblatt wird auf einem kleinen Bildschirm in Listenansicht (links) und in Rasteransicht (rechts)
angezeigt

Die Rasteransicht zeigt eine kleine Vorschau Ihrer Visualisierungen. Die Listenansicht zeigt nur die
Visualisierungstitel an.

Gehen Sie folgendermaßen vor:

1. Gehen Sie unter Eigenschaften des Arbeitsblatts zu Layout für kleinen Bildschirm.
2. Wählen Sie im Dropdownmenü Rasteransicht aus.

Erweitern des Arbeitsblattbereichs
Sie können den Bereich eines Arbeitsblatts vertikal erweitern, wenn Sie mehr Visualisierungen
hinzufügen möchten, als auf einem Bildschirm angezeigt werden können.

Bei heruntergeladenen erweiterten Arbeitsblättern kann die Qualität der PDF-Ausgabe
geringer ausfallen, wenn das Arbeitsblatt zu groß ist, um auf einer PDF-Seite korrekt
angezeigt zu werden.

Beachten Sie folgendes:

l Aktivieren Sie hierzu Arbeitsblatt erweitern in den Eigenschaften des Arbeitsblatts.
l Durch jede Erweiterung wird die ursprüngliche Höhe des Arbeitsblatts um 50% vergrößert.
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2   Creating apps

l Wenn Sie Visualisierungen haben, durch die gescrollt werden kann, kann dies mit dem
Scrollen durch ein erweitertes Arbeitsblatts konfligieren. Es empfiehlt sich, beim Entwerfen
des Arbeitsblatts etwas freien Platz zum Scrollen zu lassen.

Sie können das Arbeitsblatt auf zwei verschiedene Weisen erweitern:

Gehen Sie folgendermaßen vor:

l Ziehen Sie ein Objekt im Arbeitsblatt nach unten und legen sie es im Ablagebereich ab, der
angezeigt wird.

l Aktivieren Sie hierzu Arbeitsblatt erweitern in Eigenschaften des Arbeitsblatts.

Das Arbeitsblatt ist nun um 50 % der Originalhöhe erweitert. Sie können vertikal im Arbeitsblatt zu
allen Inhalten scrollen.

Hinzufügen von Aktionen zu Arbeitsblättern
Sie können Aktionen zu Arbeitsblättern hinzufügen, die ausgelöst werden, wenn Benutzer zu den
betreffenden Arbeitsblättern navigieren. Sie können beispielsweise automatisch Auswahlen in der
App löschen, wenn Benutzer zu einem bestimmten Arbeitsblatt navigieren.

Weitere Informationen finden Sie unter Hinzufügen von Aktionen zu Arbeitsblättern (page 22).

Adding a background color or image
You can customize the background of a sheet. You can chose a specific background color, or color
by expression. Any image in the media library can be set as a background. The image can be
positioned and resized so it does not fill the entire background.
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The following formats are supported: .png, .jpg, .jpeg, and .gif. If you use a .gif, it can be animated or
static.

Gehen Sie folgendermaßen vor:

1. Open the sheet in Edit mode.
2. Under Sheet properties, click Styling.
3. Set Background to Custom. The default is Auto.
4. Background color:

l Single color: Choose a color using the color picker.
l By expression: Set a color using a user-defined expression. For more information, see

Beispiele (page 649).
5. Background image: Select Image from media library. The default is None.

6. Klicken Sie auf der Standardminiaturansicht auf .
Die Medien-Bibliothek wird geöffnet.

7. Click on a folder in the media library, for example In app or Default. You can also choose to
Upload media, if the image you want is not already in the media library.

8. Select the image you want to use and click Insert.
9. Use the drop down to change the size of your image:

l Original size
l Always fit
l Fit to width
l Fit to height
l Stretch to fit
l Always fill

10. Under Position, you can change the alignment of the image. For example, the image can be
centered on the sheet, or in the top-right corner.

The image and background color you selected is now visible on the sheet.
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Sheet in Edit mode, with a background image set on the left

Kopieren, Ersetzen und Verschieben von Elementen auf
Arbeitsblättern
Sie können Elemente auf einem Arbeitsblatt oder zwischen Arbeitsblättern kopieren, ersetzen und
verschieben. Hierfür haben Sie folgende Möglichkeiten:

l Die Bearbeitungsleiste auf dem Arbeitsblatt ( , und ).

l Die Bearbeitungsleiste auf dem Arbeitsblatt ( , und ).
l Klicken Sie hierzu mit der rechten Maustaste und wählen Sie Ausschneiden, Kopieren und

Einfügen.
l Die Tastenkombinationen Strg+C, Strg+X und Strg+V.

Duplizieren eines Arbeitsblatts
Sie können jedes Arbeitsblatt unabhängig davon duplizieren, ob es zu einer App gehört und Sie es
selbst erstellt haben. Sie sparen durch das Duplizieren von Arbeitsblättern Zeit, indem Sie Inhalte
erneut verwenden und das Duplikat an Ihre Anforderungen anpassen können. Ein dupliziertes
Arbeitsblatt enthält dieselben Visualisierungen wie das Originalarbeitsblatt und ist mit denselben
Master-Elementen verlinkt. Das duplizierte Arbeitsblatt ist eigenständig und weist keine
Verbindung zum Originalarbeitsblatt auf. Duplizierte Arbeitsblätter werden in der App-Übersicht
unter Meine eigenen und im Extras-Fenster unter Arbeitsblätter angezeigt.

Sie können ein Arbeitsblatt wie folgt duplizieren:

l Klicken Sie auf Duplizieren im Shortcut-Menü eines Arbeitsblatts in der App-Übersicht oder
im Arbeitsblattnavigator.
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l Klicken Sie im globalen Menü der App-Übersicht oder in der Arbeitsblattansicht auf
Arbeitsblatt duplizieren.

Hinzufügen von Aktionen zu Arbeitsblättern
Sie können Aktionen für Arbeitsblätter festlegen, die ausgelöst werden, wenn Benutzer
zum Arbeitsblatt navigieren. Arbeitsblattaktionen sind nützlich, wenn Sie App-
Benutzer, die zu einem Arbeitsblatt navigieren, mit einer vordefinierten Auswahl oder
Auswahlsteuerelementen unterstützen möchten. In einem Arbeitsblatt können
beispielsweise automatisch ein Lesezeichen angewendet oder alle Auswahlen
gelöscht werden, wenn Benutzer zu dem Arbeitsblatt navigieren.

Arbeitsblattaktionen können im Eigenschaftsfenster konfiguriert werden. Sie können einem
Arbeitsblatt mehrere Aktionen hinzufügen. Die Aktionen werden in der Reihenfolge ausgeführt, in
der sie unter Actions aufgelistet sind. Sie können die Reihenfolge einer Aktion ändern, indem Sie sie
ziehen.

Eine visuelle Demo zum Hinzufügen von Aktionen zu Arbeitsblättern finden Sie unter Hinzufügen
von Aktionen zu Arbeitsblättern.

Alle in Arbeitsblattaktionen verwendeten Formeln werden ausgewertet, bevor die
Aktionen durchgeführt werden. Daher können Sie eine Formel nicht in einer Aktion
verwenden, die Ergebnisse aus einer vorherigen Aktion auswählt, da die Formel
ausgewertet wird, bevor die Auswahl durch die Aktion getroffen wird.

Arbeitsblattaktionen werden nicht ausgelöst, wenn es sich um ein eingebettetes Arbeitsblatt oder
ein Arbeitsblatt in einem Mashup handelt.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Klicken Sie im Eigenschaftenfenster des Arbeitsblatts auf Aktionen.
3. Klicken Sie auf Aktion hinzufügen.
4. Wählen Sie die Aktion aus, die Sie verwenden möchten.

Für einige Aktionen müssen Sie Details angeben. Beispielsweise müssen Sie für die Aktion
Werte in einem Feld auswählen ein Feld auswählen und entscheiden, welcher Wert im Feld
ausgewählt wird.

5. Geben Sie optional nach Bezeichnung einen Namen für die Aktion ein.

Verfügbare Arbeitsblattaktionen
Sie können eine oder mehrere Aktionen hinzufügen, die ausgeführt werden, wenn der Benutzer zum
Arbeitsblatt navigiert. Für einige Aktionen müssen Sie Details angeben.

Apply bookmark
You can apply the selection that is defined in a bookmark that you choose.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 22

https://share.vidyard.com/watch/P2LTiTvmDTMcbkDuSxqVtG?
https://share.vidyard.com/watch/P2LTiTvmDTMcbkDuSxqVtG?


2   Creating apps

Clear all selections
You can clear all selections in all states in the app. You can optionally overwrite locked selections.

Clear selections in other fields
You can clear selections from all fields except the one you specify. You can optionally overwrite
locked selections.

If no selections are made in the specified field, all values in this field will be selected.
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Move forwards in your selections
You can move one step forwards in your selection history.

Move backwards in your selections
You can move one step backwards in your selection history.

Clear selections in field
You can clear all selections from a field that you specify.

Lock all selections
You can lock all selections in the app.

Lock a specific field
You can lock selections in a field that you specify.

Unlock all selections
You can unlock all selections in the app.

Unlock a specific field
You can unlock selections in a field that you specify.
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Select all values in a field
You can select all values in a field that you specify. You can optionally overwrite locked selections.

Select values in a field
You can select a list of values in a field that you specify. Separate the values to select with a semi
colon. You can optionally overwrite locked selections.

It is not possible to use fields with date, timestamp, or money data type.
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This button action does not select numeric values that are stored or classified as text.
For this purpose, use the Select values matching search criteria action instead.

Select values matching search criteria
You can select all values that match the search results from a search criteria that you specify. You
need to specify the search criteria as a string. You can optionally overwrite locked selections.

l If you want to use an expression, you need to enclose it in single quotes, for example,
='=Sum([Sales Amount]) > 200000'.

l If you want to search for a partial string, you need to use wild cards (*, ?,^). If you do not use
wild cards, only strings that match exactly are selected.

Select alternatives
Select all alternative values in a field that you specify. You can optionally overwrite locked
selections.

Select excluded
Select all excluded values in a field that you specify. You can optionally overwrite locked selections.

Select possible values in a field
Select all possible values in a field that you specify. You can optionally overwrite locked selections.

Toggle field selection
You can set the button to toggle between the current selection, and a selection that adds selections
defined by a search string. You can use wild cards in the search string. If you want to define a list of
values you need to use the format (A|B), where A and B are values to select.
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Set variable value
You can assign a value to a variable.

Gruppieren von Arbeitsblättern
Organisieren Sie Arbeitsblätter im Extras-Fenster mithilfe der Gruppierung.

Sie können Arbeitsblätter im Extras-Fenster gruppieren. Gruppen können ausgeblendet werden.
Damit können Sie eine große Zahl Arbeitsblätter in eine überschaubare Hierarchie organisieren. Sie
können Gruppen als öffentlich oder privat festlegen.
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Gruppierte Arbeitsblätter im Extras-Fenster.
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Hinzufügen von Arbeitsblättern zu einer Gruppe

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Extras-Fenster mit der rechten Maustaste auf ein Arbeitsblatt in Meine
eigenen und wählen Sie Zu Gruppe hinzufügen aus.

2. Wählen Sie eine Gruppe aus oder erstellen Sie eine neue Gruppe.

Alternativ können Sie in der App-Übersicht oder im Extras-Fenster auf ein Arbeitsblatt klicken und
es in eine Gruppe ziehen.

Entfernen von Arbeitsblättern aus einer Gruppe

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Extras-Fenster mit der rechten Maustaste auf ein Arbeitsblatt und wählen Sie
Aus Gruppe entfernen aus.

2. Wählen Sie eine Gruppe aus oder erstellen Sie eine neue Gruppe.

Alternativ können Sie in der App-Übersicht oder im Extras-Fenster auf ein Arbeitsblatt klicken und
es in eine oder aus einer Gruppe ziehen.

Einschränkungen
Gruppen haben die folgenden Beschränkungen:

l Gruppen werden in Qlik Sense Mobile nicht angezeigt. Arbeitsblätter in Gruppen werden
stattdessen in einer Liste angezeigt. Die Reihenfolge der Arbeitsblätter in der Liste in Qlik
Sense Mobile kann von der in den Gruppen definierten Reihenfolge abweichen.

l Sie können keine Gruppen in veröffentlichten Apps veröffentlichen. Sie können jedoch die
Inhalte der Gruppe in Arbeitsblättern veröffentlichen.

2.4 Managing apps
Once you have created and built an app with the sheets and visualizations you want it
to have, you may want to fine-tune it to make it easy and efficient to use, not only for
yourself but also for other people.

The following actions are available to app owners:

l Apply app styling (logo and header)
l Create reusable master items (visualizations, dimensionsand measures
l Add bookmarks to keep track of important and interesting data selections and connections
l Making apps available in Insight Advisor Chat
l Turn off Insight Advisor
l Change the app’s title and description, and also add a thumbnail to it
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l Reload app data
l Manage app reload tasks
l Publish your own apps
l Move your own published apps between streams

Erstellen von Apps
Der erste Schritt beim Erstellen einer App ist das Erstellen eines leeren Platzhalters. Der App-
Platzhalter lässt sich über den Hub erstellen.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Hub auf Neue App erstellen.
2. Geben Sie einen Namen für die App ein.
3. Klicken Sie auf Erstellen.

Die App wird erstellt.
4. Klicken Sie auf App öffnen.

Die App wird in der App-Übersicht geöffnet.

Im nächsten Schritt werden die Daten der neuen App hinzugefügt.

On-Demand-Apps
Mithilfe von On-Demand-Apps können Sie große Datenquellen in Qlik Sense laden und
analysieren.

Der Versuch, einen großen Datenspeicher auf einmal zu analysieren, ist äußerst ineffizient. Für
repräsentative Visualisierungen müssen allerdings alle Daten erkennbar sein. On-Demand-Apps
von Qlik Sense stellen Benutzern Aggregatansichten großer Datenspeicher bereit und ermöglichen
ihnen, relevante Teilmengen der Daten für eine ausführliche Analyse zu identifizieren und zu laden.

On-Demand-Apps bestehen aus mehreren Bausteinen oder Komponenten, und einige dieser
Komponenten werden von Benutzern mit Kenntnissen in der komplexen Skripterstellung erstellt.

Erstellen einer On-Demand-App
Sie erstellen eine On-Demand-App, wenn Sie eine gut verwaltbare Datenteilmenge mithilfe einer
On-Demand-Auswahl-App ausgewählt haben. Jede Auswahl-App, mit der Sie arbeiten, enthält
mindestens einen Navigationslink für die Generierung von On-Demand-Apps in der App-
Navigationsleiste.

Die On-Demand-Apps in der App-Navigationsleiste enthalten Fertigstellungsanzeigen, die grün
werden, sobald Sie in der Auswahl-App eine Auswahl treffen. Jede On-Demand-App auf der App-
Navigationsleiste hat ein Limit für die Datenmenge, die sie enthalten kann. Jede On-Demand-App in
der App-Navigationsleiste kann nur eine begrenzte Menge an Daten enthalten. Wenn in der
Auswahl-App Auswahlen getroffen werden, gibt die Fertigstellungsanzeige an, ob die ausgewählte
Datenmenge in dem für die On-Demand-App festgelegten Rahmen bleibt.
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Sobald die Anzeige einer On-Demand-App vollständig grün ist, können Sie diese App mit den
aktuell ausgewählten Daten generieren. Sie können auch wählen, eine zuvor erstellte Instanz dieser
App zu öffnen. Jede On-Demand-App in der App-Navigationsleiste kann mehrmals generiert
werden, und diese generierten Apps bleiben zugänglich. Wenn die maximale Anzahl an Apps
generiert wurde, müssen Sie eine App löschen, bevor Sie eine neue On-Demand-App generieren
können. On-Demand-Apps können auch eine Ablaufzeit haben, nach der sie automatisch gelöscht
werden.

Anonyme Benutzer können nur On-Demand-Apps erstellen, die automatisch
veröffentlicht werden. Da anonyme Benutzer nur veröffentlichte Apps verwenden
können, können sie keine On-Demand-Apps nutzen, es sei denn, diese werden beim
Erstellen automatisch veröffentlicht. Wenn ein anonymer Benutzer versucht, eine On-
Demand-App zu erstellen, die nicht für die automatische Veröffentlichung festgelegt ist,
wird eine Meldung angezeigt, die darauf hinweist, dass der Benutzer keine App von
diesem konkreten On-Demand-App-Navigationspunkt erstellen kann.

Die maximale Anzahl der Apps und die Aufbewahrungsfrist werden im Navigationslink einer On-
Demand-App festgelegt. Der App-Navigationslink ist einer der Bausteine von On-Demand-Apps. Er
wird üblicherweise vom Ersteller der Auswahl-App hinzugefügt.

Gehen Sie folgendermaßen vor:

1. Open an on-demand selection app.
2. Select from the visualization objects in the selection app.
3. When the completion indicator on an on-demand app in the App navigation bar turns

completely green, click the on-demand app.
You can select an on-demand app in the App navigation bar to open its generation panel.
There you can click the to see the Constraint (maximum number of records allowed) and
the number of records currently selected. You can also see the number of values selected for
each field and any constraints on the fields. When on-demand apps are created, constraints
can be placed on individual fields. For example, a field for Year might be limited so that no
more than two values can be selected.
When the number of records (Row count) currently selected is less than or equal to the
maximum number of records allowed, the completion indicator turns completely green. An
app cannot be generated, however, until all the constraints have been met. If the row count is
within the constraint but one or more of the fields have not met the requirements of their
constraints, the Generate new app button will not be enabled.

If you select Generate new app when constraints panel is open, you will not see
the generated app. Click the to close the panel, and you will see the new app
listed if it generated successfully.

4. Click the Generate new app button to create a new instance of the on-demand app with the
data currently selected.
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The new instance of the app is generated and appears in the generation panel above the
Generate new app button.
To see more about the generated app, open its detail panel.

In this view, you can also rename the on-demand app. By default, on-demand apps are
assigned the name of the navigation point from which they are generated, and the user's
name is appended. For example, when the name of the navigation point is "Ox Sample
Detail," the default name of the generated on-demand app would be "Ox Sample Detail_
John-Doe" for user "John Doe." In the illustration above, the name of the on-demand app has
been changed to "Ox Sample Detail_Airlines." You can rename an on-demand app even if it
has been published.

On-demand apps generated by anonymous users are given default names
indicating that they were generated by an anonymous user rather than a
registered user. Anonymous users can change the names of generated apps just
as registered users can change the names of their apps.

The Apply button applies the selections listed on the generated on-demand app's
Selections tab to the selection app.
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5. Select Open app from the > menu to open the generated app.
You can also reload data and regenerate an on-demand app. The Reload menu is available
when the detail panel is open:

The selections on the Reload menu work as follows:
l Reload: reloads the data based on the current selections that have been made within

the on-demand app.
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l Regenerate using current selections: regenerates the on-demand app using the
current selections that have been made within the selection app.

The Apply button on the Selections tab applies the on-demand app's
selections to the selection app. The on-demand app's selections are those
listed as Selections made when this app was generated. For more
information, see the illustration above.
This is the reverse of what is done when Regenerate using current
selections is used.

l Regenerate copy using the current selections: generates a new on-demand app
using the current selections that have been made within the selection app. The
previously generated on-demand app remains in its current state.

Arbeiten mit einer veröffentlichten On-Demand-App
Die meisten Benutzer, die On-Demand-Apps zum Untersuchen großer Datenmengen verwenden,
greifen auf diese Apps als veröffentlichte Apps zu. Es gibt zwei Punkte, an denen die meisten
Benutzer On-Demand-Apps verwenden:

1. In einer veröffentlichten On-Demand-Auswahl-App. Dort wählen Benutzer Daten aus und
generieren eine On-Demand-App über die App-Navigationsleiste.

2. In einem Stream, in dem eine generierte On-Demand-App veröffentlicht wird.

Veröffentlichte On-Demand-Apps enthalten eine vorab ausgewählte Teilmenge von Daten aus
einer sehr großen Datenquelle. Sie können diese Daten über die Visualierungsobjekte in der On-
Demand-App untersuchen. In dieser Hinsicht sind On-Demand-Apps wie Apps, die mit Daten aus
einer anderen Quelle erstellt wurden.

Nachdem sie veröffentlicht wurden, können Sie sie nicht mehr ändern. Allerdings können Sie, wie
bei anderen veröffentlichten Apps, private Arbeitsblätter und Storys hinzufügen, wenn Sie über die
erforderlichen Zugriffsrechte verfügen. Mit veröffentlichten On-Demand-Apps arbeiten Sie
genauso wie mit anderen veröffentlichten Apps.

App-Design anpassen
Sie können verschiedene Designs anwenden, um die App entsprechend Ihrer
Unternehmensstandards anzupassen. Das ausgewählte Design wird auf alle
Arbeitsblätter in der App angewendet. Nachdem die App veröffentlicht wurde, können
Sie das App-Design nicht mehr ändern.
Gestalten einer App
Folgende Designoptionen sind verfügbar:

l Ändern der Richtung der Zeichen in Text- und Zahlenstrings
l Ändern der standardmäßigen App-Formatvorlage
l Aktivieren oder Deaktivieren des Kontextmenüs für alle Visualisierungen
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l Aktivieren oder Deaktivieren des Daraufzeigen-Menüs für alle Visualisierungen
l Ändern der Hintergrundfarbe für die Arbeitsblatt-Titel
l Ändern der Schriftfarbe der Arbeitsblatt-Titel
l Hinzufügen oder Ausrichten von Bildern, wie etwa Logos
l Ein- oder Ausblenden der Symbolleiste und der Überschrift für alle Arbeitsblätter

Entwickler können über benutzerdefinierte Formatvorlagenerweiterungen weitere
Designs auf eine App anwenden.

Benutzerdefiniertes Design individueller Objekte überschreibt das App-Design.

Öffnen der App-Optionen
Sie können die App-Optionen über alle Ansichten einer nicht veröffentlichten App öffnen.

Gehen Sie folgendermaßen vor:

1. In einer unveröffentlichten App klicken Sie auf und dann auf , um die App-Optionen zu
öffnen.

2. Klicken Sie auf , um die App-Optionen zu schließen.

Wenn Sie ein Mobilgerät verwenden, sind die App-Optionen nicht verfügbar.

Beim Stand von Qlik Sense June 2018 sind für veröffentlichte Apps keine App-Optionen
verfügbar, selbst wenn benutzerdefinierte Sicherheitsregeln mit der Aktion Update auf
App-Ressourcen definiert wurden.

Ändern der Leserichtung

Gehen Sie folgendermaßen vor:

1. In einer unveröffentlichten App klicken Sie auf und dann auf , um die App-Optionen zu
öffnen.

2. Unter Darstellung > Rechts nach links wählen Sie Ein oder Aus.

Wenn die Visualisierung mit Qlik Sense-Diagrammen freigegeben wird, wirkt sich die
Änderung der Leserichtung in der App auch auf die Leserichtung im freigegebenen
Diagramm aus. .
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Ändern der standardmäßigen App-Formatvorlage
Sie können eine der Qlik Standardformatvorlagen oder jede benutzerdefinierte Formatvorlage
zuweisen, die Sie bereits erstellt und installiert haben.

Die vorgegebenen Qlik-Formatvorlagen sind: 

l Sense Horizon: Dies ist die Standard-Formatvorlage, wenn Sie eine neue App erstellen.
l Sense Classic: Sorgt für eine kompaktere Darstellung von Objekten und beschränkt den

Abstand dazwischen.
l Sense Focus: Legt den Innen- und Außenabstand von Objekten fest und sieht bestimmte

Abstände für Titel vor.
l Sense Breeze: Basiert auf Sense Focus, aber mit anderen Farbeinstellungen.

Gehen Sie folgendermaßen vor:

1. In einer unveröffentlichten App klicken Sie auf und dann auf , um die App-Optionen zu
öffnen.

2. Wählen Sie die anzuwendende Formatvorlage aus dem Dropdown-Menü App-Thema aus.

Sie können Formatvorlagen in veröffentlichten Apps nicht ändern.

Benutzerdefinierte Formatvorlagen
Sie können basierend auf Ihren Firmenstandards auch benutzerdefinierte Formatvorlagen erstellen.
Mit Formatvorlagen können Sie eine App präzise formatieren, indem Sie die Farben ändern, Bilder
und Hintergründe hinzufügen sowie die Schriftarten, Schriftgrößen, Schriftbreiten und
Schriftschnitte auf globaler oder detaillierter Basis in der gesamten App festlegen. Sie können auch
Farbpaletten definieren und die Spezifikationen für Ränder, Text- und Zeilenabstände anpassen.

Benutzerdefinierte Formatvorlagen werden beim Exportieren von Arbeitsblättern und
Diagrammen im PDF-Format unterstützt. Dies gilt sowohl für manuell exportierte PDF-
Dateien als auch für PDF-Dateien, die automatisch über Abonnements oder über Qlik
Reporting Service exportiert werden. Allerdings kann ein über eine App mit einer
benutzerdefinierten Formatvorlage generiertes PDF anders aussehen als in der App
angezeigt.

Benutzerdefinierte Formatvorlagen hängen nicht von der App ab. Wenn Sie also
beispielsweise die in einer benutzerdefinierten Formatvorlage definierten Farben
ändern, werden diese in allen Apps aktualisiert, die die Formatvorlage verwenden, selbst
wenn die App veröffentlicht ist.
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Eine von Ihnen erstellte benutzerdefinierte Formatvorlage wird in Qlik Sense als Erweiterung
gespeichert. Die JSON-Datei sowie alle weiteren Ressourcen, beispielsweise CSS-Dateien, werden
komprimiert und als Erweiterung in Qlik Management Console (QMC) importiert. Dadurch können
Sicherheitsregeln in QMC hinzugefügt werden, um zu steuern, zu welchen Formatvorlagen
bestimmte Benutzer Zugriff haben.

Benutzerdefinierte Formatvorlagen werden im Dropdown-Menü App-Thema unter
Benutzerdefiniert angezeigt.

Dropdownmenü für App-Formatvorlage

Deaktivieren des Daraufzeigen-Menüs und des Kontextmenüs
Das Daraufzeigen-Menü und das Kontextmenü sind interaktive Elemente, die angezeigt werden,
wenn Benutzer mit Diagrammen interagieren. Beide Menüs bieten Zugriff auf das Menü „Optionen“,
in dem der Benutzer verschiedene Aktionen im Zusammenhang mit einem Diagramm durchführen
kann. Weitere Informationen finde Sie unter Optionsmenü.

Sie können eines der Menüs oder beide deaktivieren, um die interaktive Erfahrung für App-Benutzer
anzupassen.

Deaktivieren des Daraufzeigen-Menüs
Sie können wählen, das Daraufzeigen-Menü zu deaktivieren, das in Visualisierungen erscheint,
wenn Benutzer mit dem Mauszeiger daraufzeigen. Dies wirkt sich auf alle Visualisierungen in der
App aus.
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Gehen Sie folgendermaßen vor:

1. In einer unveröffentlichten App klicken Sie auf und dann auf , um die App-Optionen zu
öffnen.

2. Klicken Sie auf Menü beim Daraufzeigen für Visualisierungen deaktivieren.

Sie können das Daraufzeigen-Menü für eine einzelne Visualisierung im Bearbeitungsmodus
deaktivieren.

Gehen Sie folgendermaßen vor:

1. Wählen Sie im Bearbeitungsmodus die Visualisierung aus.
2. Gehen Sie im Eigenschaftsfenster zu Darstellung> Allgemein.
3. Wählen Sie Menü beim Daraufzeigen deaktivieren.

Deaktivieren des Kontextmenüs
Das Kontextmenü wird angezeigt, wenn ein Benutzer mit der rechten Maustaste auf ein Diagramm
klickt, oder wenn ein Benutzer den Berührungsbildschirm-Modus aktiviert hat und ein Diagramm
lange berührt. Sie können das Kontextmenü für alle Visualisierungen deaktivieren.

Gehen Sie folgendermaßen vor:

1. In einer unveröffentlichten App klicken Sie auf und dann auf , um die App-Optionen zu
öffnen.

2. Klicken Sie auf Kontextmenü für Visualisierungen.

Ändern der Diagrammanimationen
Diagrammanimationen sind der allmähliche Übergang in einer Visualisierung von der alten Ansicht
zur neuen Ansicht, wenn Daten geändert wurden, beispielsweise nachdem eine Auswahl getroffen
wurde.

Diagrammanimationen können in den App-Einstellungen deaktiviert werden. Sie sind für die
folgenden Diagrammtypen verfügbar:

l Balkendiagramme
l Bullet-Diagramme
l Kombi-Diagramme
l Liniendiagramme
l Kreisdiagramme
l Punktdiagramme
l Trichterdiagramme (Visualization Bundle)
l Matrixdiagramme (Visualization Bundle)
l Sankey-Diagramme (Visualization Bundle)
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Gehen Sie folgendermaßen vor:

1. In einer unveröffentlichten App klicken Sie auf und dann auf , um die App-Optionen zu
öffnen.

2. Wählen Sie unter Darstellung > Diagrammanimationen die Option Ein oder Aus aus.

Optionen zum Ausblenden der Symbolleiste, der Kopfzeile des Arbeitsblatts
und der App-Navigationsleiste
Sie können die Symbolleiste und die Überschrift des Arbeitsblatts in der App ausblenden. Das
bedeutet, dass diese Bereiche auf keinen Arbeitsblättern und für keine Benutzer angezeigt werden,
unabhängig von deren Berechtigungen. Jeder Benutzer mit den Rechten Kann bearbeiten in der
App kann diese Elemente aktivieren oder deaktivieren. Sie können auch einzelne Elemente in der
App-Navigationsleiste, der Symbolleiste und der Kopfzeile des Arbeitsblatts ausblenden.

Symbolleiste
Die Symbolleiste ist der Bereich oberhalb des Arbeitsblatts, der die folgenden Schaltflächen
enthält:

l Extras
l Insight Advisor
l Auswahlen (mit dem Symbol angezeigt)

l Arbeitsblatt bearbeiten

Optional können Sie Extras in der Symbolleiste ausblenden.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Navigationsleiste auf den App-Namen und dann auf , um die App-
Optionen zu öffnen.

2. Klicken Sie unter Darstellung nach Benutzeroberflächeneinstellungen auf .

3. Gehen Sie folgendermaßen vor:
l Um die Symbolleiste auszublenden, deaktivieren Sie Symbolleiste.
l Um Extras auszublenden, wählen Sie unter Symbolleiste die Option Extras aus.

4. Klicken Sie auf Fertig.

Kopfzeile des Arbeitsblatts
Die Kopfzeile des Arbeitsblatts ist der Bereich auf dem Arbeitsblatt, der den Titel, das Titelbild und
die Navigationspfeile des Arbeitsblatts enthält.

Wenn Sie die Kopfzeile des Arbeitsblatts ausblenden, werden die Navigationspfeile in die
Symbolleiste verschoben.

Sie können den Titel des Arbeitsblatts optional ausblenden.
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Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Navigationsleiste auf den App-Namen und dann auf , um die App-
Optionen zu öffnen.

2. Klicken Sie unter Darstellung nach Benutzeroberflächeneinstellungen auf .

3. Gehen Sie folgendermaßen vor:
l Um die Kopfzeile des Arbeitsblatts auszublenden, deaktivieren Sie Kopfzeile des

Arbeitsblatts.
l Um den Titel des Arbeitsblatts auszublenden, wählen Sie unter Kopfzeile des

Arbeitsblatts die Option Arbeitsblatttitel aus.
4. Klicken Sie auf Fertig.

App-Navigationsleiste
Sie können optional die folgenden Optionen in der App-Navigationsleiste für Ihre App ausblenden:

l Logo
l Navigation
l Insight Advisor fragen
l Ressourcencenter
l Benachrichtigungen
l Profil

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Navigationsleiste auf den App-Namen und dann auf , um die App-
Optionen zu öffnen.

2. Klicken Sie unter Darstellung nach Benutzeroberflächeneinstellungen auf .

3. Wählen Sie unter App-Navigationsleiste die Optionen aus, die Sie in der App-
Navigationsleiste ausblenden möchten.

4. Klicken Sie auf Fertig.

Verwendung

Vorteile
Wenn die Symbolleiste und die Überschrift des Arbeitsblatts ausgeblendet werden, steht mehr
Platz für Diagramme, Filterfenster und andere Objekte zur Verfügung.

Das Deaktivieren der Überschrift von Arbeitsblättern bedeutet, dass dieser Bereich nicht angezeigt
wird, wenn Sie Arbeitsblätter herunterladen oder freigeben, Abonnement senden oder Qlik
Application Automation Berichte erstellen. Das ist nützlich, wenn Sie Ihre Arbeitsblätter zum
Erstellen von PowerPoint Präsentationen oder Dashboards verwenden.
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Wenn Sie die Symbolleiste entfernen, haben App-Entwickler mehr Kontrolle darüber, auf welche
Funktionen andere Benutzer leicht zugreifen können. Wenn beispielsweise die Schaltfläche
Arbeitsblatt bearbeiten ausgeblendet wird, kann dies andere App-Entwickler davon abhalten, die
App zu bearbeiten.

Nachteile
Durch das Ausblenden der Symbolleiste werden Funktionen wie Lesezeichen, Notizen, Insight
Advisor oder Arbeitsblattbearbeitung nicht vollständig entfernt. Beispielsweise sind Lesezeichen
nach wie vor in der App-Übersicht vorhanden. App-Benutzer können aber denken, dass diese
Funktionen nicht mehr verfügbar sind.

Wenn Sie die Symbolleiste und die Überschrift des Arbeitsblatts ausblenden, ist die Navigation
zwischen Arbeitsblättern nur über Tastenkombinationen oder Schaltflächenobjekte möglich.

Wenn die Auswahlen ausgeblendet sind, merken die Benutzer möglicherweise nicht, dass
Auswahlen auf die App angewendet wurden. Möglicherweise müssen Sie Filterfenster zu Ihren
Arbeitsblättern oder Filter zu einzelnen Diagrammen hinzufügen.

Beispiele
Ein Arbeitsblatt zeigt die Symbolleiste und die Überschrift an. Auf der Symbolleiste sind Notizen, Insight
Advisor, aktuelle Auswahlen usw. zu sehen. Die Überschrift des Arbeitsblatts enthält das Titelbild, den
Arbeitsblatttitel und die Navigationspfeile.

Das gleiche Arbeitsblatt wie oben, aber die Symbolleiste wird angezeigt und die Überschrift des
Arbeitsblatts ist ausgeblendet. Benutzer können das Titelbild, den Arbeitsblatttitel oder die
Navigationspfeile nicht mehr anzeigen.
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Das gleiche Arbeitsblatt wie oben, aber die die Überschrift des Arbeitsblatts wird angezeigt und die
Symbolleiste ist ausgeblendet. Die Benutzer können nicht sehen, welche Auswahlen angewendet wurden.

Das gleiche Arbeitsblatt wie oben, aber sowohl die Überschrift des Arbeitsblatts als auch die Symbolleiste
sind ausgeblendet.

Ändern der Farbe der Arbeitsblatt-Titel
Als Hintergrundfarbe des Arbeitsblatt-Titels kann eine Farbe oder, durch Auswahl zweier Farben,
ein Farbverlauf festgelegt werden. Für die Schrift des Arbeitsblatt-Titels kann nur eine Farbe
festgelegt werden.

Wenn Sie ein Mobilgerät verwenden, wird der Hintergrund des Arbeitsblatttitels auch
dann in einer Vollfarbe angezeigt, wenn zwei Farben festgelegt worden sind.

Bei der Farbauswahl stehen Ihnen die folgenden Optionen zur Verfügung: 

l Wählen Sie aus der Standardfarbpalette eine Farbe aus.
l Legen Sie eine Hexadezimalfarbe fest, indem Sie in das Eingabefeld # 6 Zeichen eingeben.
l Klicken Sie auf die Palette, um weitere Farboptionen anzuzeigen:

l Klicken Sie auf den Farbkreis, um die Farbe auszuwählen.
l Bewegen Sie den Schieberegler, um die Farbsättigung zu ändern.

Auswählen einer Farbe aus der Standardfarbpalette

Gehen Sie folgendermaßen vor:

1. Klicken Sie in einem Farb-Dropdown-Menü auf .
Das Dialogfeld wird geöffnet, und die Standardfarben werden angezeigt.

2. Klicken Sie auf eine der Farben in der Palette.
Die Farbe wird ausgewählt.
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3. Klicken Sie auf eine Stelle außerhalb des Dialogfelds.
Das Dialogfeld wird geschlossen.

Sie haben durch die Auswahl in der Standardfarbpalette nun eine Farbe festgelegt.

Farbdialogfeld mit der Standardfarbpalette und einer ausgewählten blauen Farbe.

Eingeben einer Hexadezimalfarbe

Gehen Sie folgendermaßen vor:

1. Klicken Sie in einem Farb-Dropdown-Menü auf .
Das Dialogfeld wird geöffnet, und die Standardfarben werden angezeigt.

2. Geben Sie in folgendes Hexadezimal-Eingabefeld 6 Zeichen ein: #
Die Farbe wird in der Palette ausgewählt.

3. Klicken Sie auf eine Stelle außerhalb des Dialogfelds.
Das Dialogfeld wird geschlossen.

Sie haben durch die Eingabe von 6 Hexadezimalstellen nun eine Farbe festgelegt.

Verwenden der erweiterten Farboptionen

Gehen Sie folgendermaßen vor:

1. Klicken Sie in einem Farb-Dropdown-Menü auf .
Das Dialogfeld wird geöffnet, und die Standardfarben werden angezeigt.

2. Klicken Sie unten im Dialogfeld auf .
Im Dialogfeld werden nun die erweiterten Optionen angezeigt.

3. Gehen Sie folgendermaßen vor:
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l Klicken Sie in den Farbkreis.
Die Farbe verändert sich, und der Hexadezimalfarbcode wird entsprechend
aktualisiert.

l Bewegen Sie den Schieberegler.
Die Sättigung verändert sich, und der Hexadezimalfarbcode wird entsprechend
aktualisiert.

Auf beide Weisen lässt sich eine Farbe auswählen.
4. Klicken Sie auf eine Stelle außerhalb des Dialogfelds.

Das Dialogfeld wird geschlossen.

Sie haben durch Verwenden des Farbkreises bzw. des Schiebereglers nun eine Farbe festgelegt.

Farbdialogfeld mit den erweiterten Optionen und einer ausgewählten blauen Farbe.

Hinzufügen eines Bildes
Sie können zum Arbeitsblatt-Titel ein Bild, wie etwa ein Logo, hinzufügen. Folgende Formate
werden unterstützt: .png, .jpg, .jpeg und .gif.

Gehen Sie folgendermaßen vor:

1. Klicken Sie neben Bild auf den Platzhalter für das Bild.
Die Medien-Bibliothek wird geöffnet.

2. Klicken Sie auf einen Ordner in der Medienbibliothek, z. B. In App oder Standard.
3. Wählen Sie das Bild aus, das Sie zum Arbeitsblatt-Titel hinzufügen möchten.

Eine Vorschau des Bilds wird angezeigt.
4. Klicken Sie auf Einfügen.

Das Bild wird hinzugefügt.

Sie haben nun ein Bild zum Arbeitsblatt-Titel hinzugefügt.
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Laden von App-Daten
Apps im Hub werden nicht automatisch aktualisiert, wenn ihre Datenquellen aktualisiert
werden. Bei Laden einer App wird diese mit den neuesten Daten aus den App-
Datenquellen aktualisiert. Wenn Sie eine App zum ersten Mal laden, wird automatisch
eine Ladeaufgabe mit einem einmaligen Auslöser erstellt.

Gehen Sie folgendermaßen vor:

l Klicken Sie mit der rechten Maustaste auf die App und wählen Sie Neu laden aus.

Verwalten Sie die neue Ladeaufgabe im Hub, indem Sie mit der rechten Maustaste auf
die App klicken und Ladeaufgaben verwalten auswählen. Beispielsweise können Sie die
Ladeaufgabe anzeigen, anhalten oder starten. Weitere Informationen zum Verwalten
und Planen von Ladeaufgaben im Hub finden Sie unter Verwalten von App-
Ladeaufgaben (page 46). Administratoren können auch App-Ladevorgänge in QMC
planen. Weitere Informationen finden Sie unter Erstellen von Ladeaufgaben.

App-Ladeberechtigungen
Um eine App im Hub zu laden, benötigen Sie Aktualisierungszugriff auf die App und die
entsprechenden Berechtigungen, die von einem Administrator in der QMC festgelegt wurden.
Weitere Informationen finden Sie unter Konfigurieren der Ladeaufgabenverwaltung für den Hub.

Verwalten von App-Ladeaufgaben
Zeigen Sie App-Ladeaufgaben über den Hub an und verwalten Sie sie. Starten Sie
Ladeaufgaben manuell oder erstellen Sie neue Ladeaufgaben mit geplanten Auslösern,
um den Ladevorgang automatisch auszuführen. Sie können Ladeaufgaben auch
bearbeiten und löschen.

Von einem Administrator in QMC erstellte App-Ladeaufgaben werden auch im Hub angezeigt. Um
die Ladeaufgaben für eine App im Hub anzuzeigen, klicken Sie mit der rechten Maustaste auf die
App und wählen Sie Ladeaufgaben verwalten aus.

Sie benötigen die entsprechenden in QMC festgelegten Berechtigungen, um App-
Ladeaufgaben im Hub zu verwalten. Weitere Informationen finden Sie unter
Konfigurieren der Ladeaufgabenverwaltung für den Hub.

Ladeaufgaben verwalten umfasst die folgenden Informationen und Optionen:
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l Name: Name der Aufgabe.
l Aktiviert: Gibt an, ob die Ladeaufgabe aktiviert oder deaktiviert ist. Deaktivierte Aufgaben

können nicht über den Hub verwaltet oder aktiviert werden.
l Status: Zeigt den aktuellen Status der Aufgabe an. Sie können auf klicken, um eine

Übersicht über die neueste Aufgabenausführung anzuzeigen. Sie können auch auf
Skriptprotokoll herunterladen klicken, um das Skriptprotokoll herunterzuladen.

l Letzte Ausführung: Zeigt an, wann die Aufgabe zuletzt ausgeführt wurde.
l Nächste Ausführung: Zeigt an, wann die Ausführung der Aufgabe das nächste Mal geplant

ist.
l Aktionen: Verwaltungsoption für die Aufgabe. Sie können auf klicken, um Aufgaben zu

starten, bzw. auf , um Aufgaben zu stoppen. Klicken Sie auf , um eine Aufgabe zu

bearbeiten, bzw. auf , um eine Aufgabe zu löschen.
l Aufgabe erstellen: Fügen Sie eine neue App-Ladeaufgabe hinzu und legen Sie

Aufgabeneigenschaften fest. Dazu zählt auch das Erstellen geplanter Auslöser.

Durch Klicken auf aktualisieren Sie die Aufgabenansicht.

Erstellen von App-Ladeaufgaben
Erstellen Sie eine App-Ladeaufgabe im Hub. Bei Ausführung lädt die Ladeaufgabe die Daten in einer
App vollständig neu aus der Quelle. Alle älteren Daten werden verworfen. App-Ladeaufgaben
müssen einen geplanten Auslöser enthalten, damit die Ladeaufgabe automatisch ausgeführt
werden kann. Der Auslöser legt fest, wie viele Male die Aufgabe ausgeführt wird (von einmal bis
unendlich oft) und in welcher Häufigkeit der Ladevorgang stattfindet (einmal, täglich, wöchentlich
oder monatlich). Sie können beispielsweise einen Auslöser erstellen, mit dem die Ladeaufgabe 56
Mal einmal wöchentlich in einer App ausgeführt wird. Erstellen Sie geplante Auslöser für Ihre
Aufgaben, um App-Daten zu einer bestimmten Uhrzeit an einem bestimmten Datum mit der
festgelegten Häufigkeit zu laden.

Weitere Informationen zum Erstellen von App-Ladeaufgaben in QMC finden Sie unter Erstellen von
Ladeaufgaben.

Sie benötigen die entsprechenden in QMC festgelegten Berechtigungen, um App-
Ladeaufgaben im Hub zu erstellen. Weitere Informationen finden Sie unter Konfigurieren
der Ladeaufgabenverwaltung für den Hub.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Hub mit der rechten Maustaste auf die App, für die Sie eine Ladeaufgabe
erstellen möchten, und klicken Sie dann auf Ladeaufgaben verwalten.

2. Klicken Sie auf Aufgabe erstellen.
3. Geben Sie einen Namen für die Aufgabe im Feld Name ein.
4. Prüfen Sie unter Ausführung die Standardeinstellungen und bearbeiten Sie beliebige der

folgenden Eigenschaften:
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a. Aktivieren oder deaktivieren Sie Aktiviert, um die Aufgabe zu aktivieren oder zu
deaktivieren. Die Aufgabe ist standardmäßig Aktiviert .

b. Zeitüberschreitung Aufgabensitzung (Minuten): Der maximale Zeitraum, bevor eine
Aufgabe abgebrochen wird, wenn die Sitzung abläuft. Die Standardeinstellung ist
1440 Minuten.

c. Max. Wiederholungen: Die maximale Anzahl der Versuche durch den Planer, eine
fehlgeschlagene Aufgabe erneut auszuführen. Die Standardeinstellung ist 0.

5. Klicken Sie auf Erstellen.

6. Klicken Sie in der Liste Aufgaben unter Aktionen auf , um die Aufgabeneigenschaften zu
öffnen.

7. Klicken Sie auf Geplanten Auslöser erstellen und wählen Sie die Eigenschaften aus, die Sie
für den Auslöser festlegen möchten.
Geplante Auslöser

Eigenschaft Beschreibung

Auslösername Name des Auslösers. Obligatorisch.

Aktiviert Status des Auslösers. Wenn das Kontrollkästchen aktiviert ist, ist der
Auslöser aktiv.

Zeitzone Die Zeitzone Ihres Betriebssystems zum Zeitpunkt der Erstellung des
Auslösers. Wenn Sie einen Auslöser speichern, werden die
Einstellungen beibehalten, und wenn Sie zu einer anderen Zeitzone
wechseln, werden weiterhin die ursprünglichen Werte angezeigt.
Wenn Sie die Zeitzone und die Startuhrzeit eines Auslösers ändern
möchten, müssen Sie dies manuell tun.

Für einen Auslöser, der vor der Einführung der
Zeitzoneneinstellung erstellt wurde, werden alle Uhrzeiten
und Datumsangaben standardmäßig in Coordinated
Universal Time (UTC) angezeigt.

Eigenschaften von geplanten Auslösern im Hub
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Eigenschaft Beschreibung

Sommerzeit Möglichkeiten zum Berücksichtigen der Sommerzeit.
Sommerzeit einhalten: Bei dieser Option wird die Sommerzeit
berücksichtigt. Wenn in der ausgewählten Zeitzone eine Sommerzeit
gilt, werden die Ausführungszeit und das Ausführungsdatum
entsprechend angepasst.
Immer Standardzeit: Bei dieser Option wird die Sommerzeit nicht
berücksichtigt. Wenn in der ausgewählten Zeitzone eine Sommerzeit
gilt, werden die Ausführungszeit und das Ausführungsdatum nicht
angepasst.
Immer Sommerzeit: Bei dieser Option wird die Sommerzeit
berücksichtigt. Wenn in einer Zeitzone eine Sommerzeit gilt, werden
die Ausführungszeit und das Ausführungsdatum immer entsprechend
der Sommerzeit angezeigt, auch in Zeiträumen, in denen die
Sommerzeit nicht gilt.

Wählen Sie für Zeitzonen ohne Sommerzeit immer die
Option Immer Standardzeit.

Beispiel:

Sie erstellten einen Auslöser für ein Ereignis um 10 Uhr, während Sie
im Januar in Ottawa, Kanada, arbeiteten. Die Zeitzone ist (GMT-0500)
Eastern Time (US & Canada), und von März bis November gilt die
Sommerzeit.
Wenn Sie Sommerzeit einhalten auswählen, wird ein auf 10 Uhr
festgelegter Auslöser immer um 10 Uhr gestartet.
Wenn Sie Immer Standardzeit ausgewählt haben, wird ein auf 10 Uhr
festgelegter Auslöser im Winter um 10 Uhr, aber im Sommer um 9 Uhr
ausgeführt.
Wenn Sie Immer Sommerzeit auswählen, wird ein auf 10 Uhr
festgelegter Auslöser im Winter um 11 Uhr und im Sommer um 10 Uhr
ausgeführt.

Starten Sie . Startuhrzeit und -datum:
l Startuhrzeit: (hh:mm)
l Startdatum: (JJJJ-MM-TT)

End Enduhrzeit und -datum:
l Enduhrzeit: (hh:mm)
l Enddatum: (JJJJ-MM-TT)

Wählen Sie Unendlich aus, um einen Auslöser ohne Enddatum zu
erstellen.
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Eigenschaft Beschreibung

Zeitplan Häufigkeit des Auslösers:

l Einmal.
l Stündlich. Zeitraum zwischen Ausführungen des Auslösers.

Bearbeiten Sie Wiederholen nach je, indem Sie folgende Werte
eingeben:

l Stunde(n) (Standard ist 1)
l Minute(n) (Standard ist 0)

l Täglich. Zeitraum zwischen Ausführungen des Auslösers.
Geben Sie einen Wert für Alle Tag(e) ein (Standardwert ist 1).
Geben Sie beispielsweise 2 ein, um den Auslöser jeden zweiten
Tag zu wiederholen.

l Wöchentlich. Zeitraum zwischen Ausführungen des Auslösers:
l Geben Sie einen Wert für Alle Woche(n) ein

(Standardwert ist 1)
l Wählen Sie einen oder mehrere Tage unter An diesen

Wochentagen aus, um festzulegen, an welchen Tagen
der Auslöser (während der angegebenen Wochen)
wiederholt wird. Geben Sie beispielsweise 3 ein und
wählen Sie Mo aus, um den Auslöser am Montag jeder
dritten Woche zu wiederholen.

l Monatlich. Wählen Sie unter An diesen Tagen einen oder
mehrere Tage aus, um die Tage zu definieren, an denen die
Auslöser jeden Monat wiederholt werden.

Wenn Sie Monatlich ausgewählt haben und
sicherstellen möchten, dass der Auslöser jeden
Monat wiederholt wird, müssen Sie als Datum
spätestens den 28. auswählen.

8. Klicken Sie auf Erstellen und klicken Sie dann auf Übernehmen, um den Auslöser zur
Ladeaufgabe hinzuzufügen.

Nachdem Sie einen Auslöser für eine Ladeaufgabe hinzugefügt haben, klicken Sie auf
Aufgabenliste aktualisieren in der Benachrichtigungsmeldung, oder klicken Sie auf
in der Aufgabenliste, um die Uhrzeit der nächsten Ausführung der Ladeaufgabe in der
Ladeliste anzuzeigen.
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Bearbeiten von App-Ladeaufgaben
Bearbeiten Sie App-Ladeaufgaben im Hub. Erstellen Sie beispielsweise einen neuen geplanten
Auslöser, aktualisieren Sie den Aufgabennamen oder die Ausführungsdetails, oder bearbeiten Sie
die Eigenschaften eines geplanten Auslösers.

Sie benötigen die entsprechenden in QMC festgelegten Berechtigungen, um App-
Ladeaufgaben im Hub zu bearbeiten. Weitere Informationen finden Sie unter
Konfigurieren der Ladeaufgabenverwaltung für den Hub.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Hub mit der rechten Maustaste auf die App, für die Sie eine Ladeaufgabe
bearbeiten möchten, und klicken Sie dann auf Ladeaufgaben verwalten.

2. Klicken Sie in der Liste Aufgaben unter Aktionen auf , um die Aufgabeneigenschaften zu
öffnen.

3. Bearbeiten Sie die Aufgabeneigenschaften.
a. Sie können den Aufgabennamen im Feld Name ändern.
b. Sie können die Eigenschaften der Ausführung ändern.

l Aktivieren oder deaktivieren Sie Aktiviert, um die Aufgabe zu aktivieren oder zu
deaktivieren. Die Aufgabe ist standardmäßig Aktiviert .

l Zeitüberschreitung Aufgabensitzung (Minuten): Der maximale Zeitraum,
bevor eine Aufgabe abgebrochen wird, wenn die Sitzung abläuft. Die
Standardeinstellung ist 1440 Minuten.

l Max. Wiederholungen: Die maximale Anzahl der Versuche durch den Planer,
eine fehlgeschlagene Aufgabe erneut auszuführen. Die Standardeinstellung ist
0.

c. Erstellen Sie einen neuen Auslöser. Wählen Sie Geplanten Auslöser erstellen aus,
legen Sie die Eigenschaften (siehe Beschreibungen unten) für den neuen Auslöser
fest, und klicken Sie dann auf Erstellen, um den Auslöser zur Ladeaufgabe
hinzuzufügen.

d. Bearbeiten Sie einen geplanten Auslöser. Klicken Sie in der Liste Auslöser unter
Aktionen auf . Legen Sie die Eigenschaften fest (siehe Beschreibungen unten) und
klicken Sie auf OK, um Ihre Änderungen zu speichern.
Geplanter Auslöser

Eigenschaft Beschreibung

Auslösername Name des Auslösers. Obligatorisch.

Aktiviert Status des Auslösers. Wenn das Kontrollkästchen aktiviert ist,
ist der Auslöser aktiv.

Eigenschaften von geplanten Auslösern im Hub
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Eigenschaft Beschreibung

Zeitzone Die Zeitzone Ihres Betriebssystems zum Zeitpunkt der
Erstellung des Auslösers. Wenn Sie einen Auslöser speichern,
werden die Einstellungen beibehalten, und wenn Sie zu einer
anderen Zeitzone wechseln, werden weiterhin die
ursprünglichen Werte angezeigt. Wenn Sie die Zeitzone und die
Startuhrzeit eines Auslösers ändern möchten, müssen Sie dies
manuell tun.

Für einen Auslöser, der vor der Einführung der
Zeitzoneneinstellung erstellt wurde, werden alle
Uhrzeiten und Datumsangaben standardmäßig in
Coordinated Universal Time (UTC) angezeigt.
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Eigenschaft Beschreibung

Sommerzeit Möglichkeiten zum Berücksichtigen der Sommerzeit.
Sommerzeit einhalten: Bei dieser Option wird die Sommerzeit
berücksichtigt. Wenn in der ausgewählten Zeitzone eine
Sommerzeit gilt, werden die Ausführungszeit und das
Ausführungsdatum entsprechend angepasst.
Immer Standardzeit: Bei dieser Option wird die Sommerzeit
nicht berücksichtigt. Wenn in der ausgewählten Zeitzone eine
Sommerzeit gilt, werden die Ausführungszeit und das
Ausführungsdatum nicht angepasst.
Immer Sommerzeit: Bei dieser Option wird die Sommerzeit
berücksichtigt. Wenn in einer Zeitzone eine Sommerzeit gilt,
werden die Ausführungszeit und das Ausführungsdatum immer
entsprechend der Sommerzeit angezeigt, auch in Zeiträumen,
in denen die Sommerzeit nicht gilt.

Wählen Sie für Zeitzonen ohne Sommerzeit immer
die Option Immer Standardzeit.

Beispiel:

Sie erstellten einen Auslöser für ein Ereignis um 10 Uhr,
während Sie im Januar in Ottawa, Kanada, arbeiteten. Die
Zeitzone ist (GMT-0500) Eastern Time (US & Canada), und von
März bis November gilt die Sommerzeit.
Wenn Sie Sommerzeit einhalten auswählen, wird ein auf 10 Uhr
festgelegter Auslöser immer um 10 Uhr gestartet.
Wenn Sie Immer Standardzeit ausgewählt haben, wird ein auf
10 Uhr festgelegter Auslöser im Winter um 10 Uhr, aber im
Sommer um 9 Uhr ausgeführt.
Wenn Sie Immer Sommerzeit auswählen, wird ein auf 10 Uhr
festgelegter Auslöser im Winter um 11 Uhr und im Sommer um
10 Uhr ausgeführt.

Starten Sie . Startuhrzeit und -datum:
l Startuhrzeit: (hh:mm)
l Startdatum: (JJJJ-MM-TT)

End Enduhrzeit und -datum:
l Enduhrzeit: (hh:mm)
l Enddatum: (JJJJ-MM-TT)

Wählen Sie Unendlich aus, um einen Auslöser ohne Enddatum
zu erstellen.
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Eigenschaft Beschreibung

Zeitplan Häufigkeit des Auslösers:

l Einmal.
l Stündlich. Zeitraum zwischen Ausführungen des

Auslösers. Bearbeiten Sie Wiederholen nach je, indem
Sie folgende Werte eingeben:

l Stunde(n) (Standard ist 1)
l Minute(n) (Standard ist 0)

l Täglich. Zeitraum zwischen Ausführungen des
Auslösers. Geben Sie einen Wert für Alle Tag(e) ein
(Standardwert ist 1). Geben Sie beispielsweise 2 ein, um
den Auslöser jeden zweiten Tag zu wiederholen.

l Wöchentlich. Zeitraum zwischen Ausführungen des
Auslösers:

l Geben Sie einen Wert für Alle Woche(n) ein
(Standardwert ist 1)

l Wählen Sie einen oder mehrere Tage unter An
diesen Wochentagen aus, um festzulegen, an
welchen Tagen der Auslöser (während der
angegebenen Wochen) wiederholt wird. Geben Sie
beispielsweise 3 ein und wählen Sie Mo aus, um
den Auslöser am Montag jeder dritten Woche zu
wiederholen.

l Monatlich. Wählen Sie unter An diesen Tagen einen
oder mehrere Tage aus, um die Tage zu definieren, an
denen die Auslöser jeden Monat wiederholt werden.

Wenn Sie Monatlich ausgewählt haben und
sicherstellen möchten, dass der Auslöser
jeden Monat wiederholt wird, müssen Sie als
Datum spätestens den 28. auswählen.

4. Klicken Sie auf Übernehmen, um die Änderungen zu speichern.

Wenn Sie einen Aufgabenauslöser geändert haben, klicken Sie in der
Benachrichtigungsmeldung auf Aufgabenliste aktualisieren. Sie können auch auf
klicken, um die Aufgabenliste zu aktualisieren.
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Löschen von App-Ladeaufgaben
Sie benötigen die entsprechenden Berechtigungen, um App-Ladeaufgaben im Hub zu löschen.
Weitere Informationen finden Sie unter Konfigurieren der Ladeaufgabenverwaltung für den Hub.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Hub mit der rechten Maustaste auf die App, in der Sie eine Ladeaufgabe
löschen möchten, und klicken Sie dann auf Ladeaufgaben verwalten.

2. Klicken Sie in der Liste Aufgaben unter Aktionen auf .

Umwandeln eines QlikView-Dokuments in eine Qlik Sense-App
Wenn Sie ein QlikView-Dokument haben, können Sie einen Teil Ihrer Arbeit in Qlik Sense
wiederverwenden. Das Ladeskript und das Datenmodell können verwendet werden, um eine App in
Qlik Sense zu erstellen. Visualisierungen, Dimensionen und Kennzahlen müssen jedoch in Qlik
Sense erstellt werden.

Nach der Umwandlung des Dokuments in eine App müssen Sie das Ladeskript möglicherweise
anpassen, um das Skript in Qlik Sense zu öffnen. In einigen Fällen müssen Sie möglicherweise
Änderungen am QlikView-Skript vornehmen, bevor Sie das Dokument umwandeln können.

Qlik Sense stellt ein Tool bereit, um ein QlikView-Dokument (QVW-Datei) in eine Qlik Sense-App
umzuwandeln. Das Tool konvertiert Visualisierungen, Dimensionen, Kennzahlen und Variablen. Sie
müssen Zugriff zu Dev Hub haben, um das Tool für die Konvertierung von QlikView nach Qlik Sense
verwenden zu können.

Anweisungen für die Verwendung des Konvertierungstools finden Sie auf der Qlik Sense-
Entwickler-Site.
≤ Weitere Informationen finden Sie unter QlikView Converter.

Falls Sie keinen Zugriff auf Dev Hub haben, können Sie ein QlikView-Dokument auch manuell
konvertieren.

Wir empfehlen, bei der Konvertierung einer App die Änderungen nur in einem Duplikat
dieser App vorzunehmen, damit Ihre Änderungen nicht durch eine spätere Konvertierung
überschrieben werden.

Manuelles Umwandeln eines QlikView Dokuments in eine Qlik
Sense App
Sie können ein QlikView-Dokument (QVW-Datei) manuell in eine Qlik Sense App
konvertieren. Wenn Sie Zugriff auf den Dev Hub haben, können Sie das QlikView-zu-
Qlik Sense-Konvertierungstool verwenden, um den Vorgang zu vereinfachen.

Der QlikView-Qlik Sense-Konverter wird auf der Qlik Sense-Entwickler-Site beschrieben.
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Voraussetzungen
l Sie müssen Qlik Sense Desktop installiert haben, um ein QlikView-Dokument in eine Qlik

Sense-App umwandeln zu können.
l Ihr Computer muss beim Konvertieren eines großen QlikView-Dokuments über genügend

Arbeitsspeicher verfügen, und zwar mindestens 32 GB.
l Wenn das QlikView-Dokument ein verborgenes Skript oder Section Access enthält,

benötigen Sie vollständigen Zugriff auf das verborgene Skript sowie auf den Section Access
des Dokuments.

Vor der Konvertierung des Dokuments
Die Eigenschaft Immer ein ausgewählter Wert für QlikView-Listenfelder oder Mehrfachfelder
muss deaktiviert sein, damit bestehende Auswahlen in der Qlik Sense-App entfernt werden. Wenn
Ihr QlikView-Dokument ein verborgenes Skript oder Section Access enthält, müssen Sie das
Dokument vor der Konvertierung anpassen.

Umwandeln verborgener Skripts
Wenn ein QlikView-Dokument mit einem verborgenen Skript konvertiert wird, wird der Teil mit dem
verborgenen Skript nicht berücksichtigt und dieser Teil wird nicht in das Qlik Sense-Skript
übernommen. Wenn Sie das gesamte Skript konvertieren möchten, gehen Sie vor der
Konvertierung des Dokuments wie folgt vor. Dazu benötigen Sie Zugriff auf das verborgene Skript
im QlikView-Dokument.

Gehen Sie folgendermaßen vor:

1. Öffnen Sie das Dokument im Skript-Editor von QlikView.
2. Kopieren Sie den Code aus dem Dialogfeld mit dem verborgenen Skript und fügen Sie ihn in

die Dialogfelder der regulären Skripts ein.
3. Speichern Sie das Dokument.

In Qlik Sense kann Skriptcode nicht verborgen werden.

Entfernen von Section Access-Code
Ein QlikView-Dokument mit Section Access kann infolge der Format- und Funktionsunterschiede
nicht in Qlik Sense importiert werden. Sie können das Dokument jedoch manuell konvertieren.

Gehen Sie folgendermaßen vor:

1. Entfernen Sie vor der Konvertierung des Dokuments den Section Access-Code im Skript-
Editor von QlikView. Dazu benötigen Sie den uneingeschränkten Zugriff auf das Skript des
Dokuments.

2. Wandeln Sie das Dokument in eine App um.
3. Wenden Sie Section Access wieder auf die Qlik Sense-App an. Bei Abweichungen müssen

Sie möglicherweise Folgendes berücksichtigen:
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l Veränderte Benutzerauthentifizierung Das Feld USERID wird jetzt für die
Authentifizierung aller Benutzer verwendet und die Felder NTNAME und PASSWORD
werden nicht mehr unterstützt.

l Wenn Sie Zugriff auf das Skript haben, jedoch nicht auf die Daten, können Sie die App
ohne die Daten öffnen und das Skript sowie Section Access bearbeiten.

l Section Access wird mit strikter Exklusion in Qlik Sense angewendet. Das bedeutet,
dass Sie nur die Daten sehen können, für die Sie spezifische Zugriffsrechte besitzen.

Aus dem Export ausgeschlossene QlikView Variablen
Verschiedene Variablen werden nicht aus einem QlikView Dokument (QVW) exportiert, da sie nur
für QlikView relevant sind oder in Qlik Sense anders gehandhabt werden.

Die folgenden Variablen werden nicht aus einem QlikView Dokument exportiert:

l Alle Variablen, die mit CD beginnen
l Alle Variablen, die mit FLOPPY beginnen
l QvPath
l QvRoot
l QvWorkPath
l QvWorkRoot
l WinPath
l WinRoot
l ErrorMode
l StripComments
l ScriptErrorCount
l ScriptError
l ThousandSep
l DecimalSep
l MoneyThousandSep
l MoneyDecimalSep
l MoneyFormat
l TimeFormat
l DateFormat
l TimestampFormat
l MonthNames
l DayNames
l ScriptErrorDetails
l ScriptErrorList
l OpenUrlTimeout
l HidePrefix
l FirstWeekDay
l BrokenWeeks
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l ReferenceDay
l FirstMonthOfYear
l CollationLocale
l LongMonthNames
l LongDayNames

Umwandeln des Dokuments in eine App

Gehen Sie folgendermaßen vor:

1. Kopieren Sie das QlikView-Dokument (qvw-Format) in das Verzeichnis, in dem sich Ihre Apps
befinden.
Normalerweise ist dies <user>\Documents\Qlik\Sense\Apps. Der Speicherort des
Verzeichnisses Apps hängt jedoch davon ab, wo Sie Qlik Sense Desktop installiert haben.

2. Starten Sie Qlik Sense Desktop.
Nun sehen Sie das QlikView-Dokument als App im Hub, wobei der Name mit (qvw) endet.

3. Klicken Sie auf die App, um sie zu öffnen.

Die App wird im Qlik Sense-Format (qvf-Datei) in den Ordner gespeichert, in dem das QlikView-
Dokument (qvw-Datei) gespeichert war. Das QlikView-Dokument (qvw) wird aus dem Ordner
entfernt und automatisch als Sicherungsdatei (qvw.backup) hier gespeichert:
<user>\Documents\Qlik\Sense\AppsBackup.

Sie haben nun ein QlikView-Dokument in eine Qlik Sense-App migriert. Die App enthält das
Datenmodell, einschließlich der geladenen Daten und des Daten-Ladeskripts.

Sie können das Datenmodell nutzen, um Visualisierungen aufzubauen, es über Qlik Management
Console (QMC) in Ihre Serverumgebung zu kopieren oder zu importieren, allerdings müssen Sie das
Ladeskript anpassen, bevor Sie das Datenmodell erneut laden können.

Sie können eine qvw-Datei aus einem Ordner ziehen und im Qlik Sense Desktop-Hub
ablegen, um sie als Qlik Sense-App zu öffnen. Wird die Qlik Sense-App (qvf-Datei) in
einen anderen Ordner als <user>\Documents\Qlik\Sense\Apps gespeichert, verschieben
Sie sie in den Apps-Ordner, um sie über den Hub verfügbar zu machen.

Bearbeiten des Datenladeskripts in Qlik Sense
Generell sind Qlik Sense- und QlikView-Datenladeskripts kompatibel, allerdings müssen Sie einige
Abweichungen berücksichtigen und das Skript im Dateneditor anpassen, bevor Sie die Daten
erneut laden können. Sie können das Skript direkt in Qlik Sense Desktop anpassen. Oder Sie
importieren die App in Qlik Sense und passen das Skript dann an.

Ändern der Dateipfadverweise zu Datenverbindungen
QlikView unterstützt absolute oder relative Dateipfade, die im standardmäßigen Qlik Sense-Modus
nicht unterstützt werden. Daher müssen Sie Ordnerdatenverbindungen nutzen, um stattdessen auf
die Dateipfade zu verweisen.
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Gehen Sie folgendermaßen vor:

1. Erzeugen Sie Ordnerdatenverbindungen für alle Dateipfade, die in Datenladeskripts
verwendet werden.
Sie müssen die Formeln und Funktionen überprüfen, die auf Dateien verweisen. LOAD-
Befehle sind die am häufigsten verwendeten Befehle, wobei jedoch eine vollständige Liste
verfügbar ist.

2. Ersetzen Sie alle Verweise zu absoluten oder relativen Pfaden im Skript durch lib://-Verweise
auf die von Ihnen erzeugten Datenverbindungen.

Originalskript in QlikView Angepasstes Qlik Sense-Skript

LOAD * FROM [C:\data\Tutorials

source\Sales rep.csv];

LOAD * FROM [lib://Tutorials

source/Sales rep.csv];

In diesem Fall sollte die Tutorials source-
Ordnerdatenverbindung auf
C:\data\Tutorials source\ verweisen oder
auf den Speicherort der Daten, falls Sie die
App auf einen anderen Computer oder Qlik
Sense-Server verschoben haben.

FileSize('C:\data\Tutorials source\Sales

rep.csv')

FileSize('lib://Tutorials source/Sales

rep.csv')

for each Dir in dirlist

('C:\data\Tutorials source\*' )

for each Dir in dirlist

('lib://Tutorials source/*' )

Beispiele

Umgang mit Funktionen, die nicht unterstützt oder empfohlen werden
Nachstehend einige Funktionen in QlikView, die nicht unterstützt oder nicht in Qlik Sense
empfohlen werden, beispielsweise:

l Inputfelder
l Nachrichtenfelder
l Bundle und Info-Laden
l Zusatz ALL

Wir empfehlen, dass Sie den Skriptcode anhand der Liste dieser nicht empfohlenen oder
unterstützten Befehle und Funktionen überprüfen und den Code entsprechend der Empfehlungen
anpassen.

Installieren benutzerdefinierter Konnektoren
Wenn Ihr QlikView-Dokument benutzerdefinierte Konnektoren für den Datenzugriff verwendet,
sollten Sie in der Lage sein, diese zu verwenden, um Daten ohne Veränderungen im Skript in Qlik
Sense zu laden. Dazu muss derselbe Konnektor auf dem Qlik Sense-Computer installiert sein.
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Wenn Sie mithilfe des Datenkonnektors Änderungen an der Datenauswahl vornehmen möchten,
müssen Sie eine Version des benutzerdefinierten Konnektors installieren, der für Qlik Sense
angepasst wurde.

Changing the title and description of an app
You can change the title and description of your apps. When creating a new app the
name of the app is used as its title. When you change the title, the name of the app is
not changed.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der App-Übersicht im Detailbereich der App auf .

2. Bearbeiten Sie Titel und Beschreibung.

3. Klicken Sie auf , um die Bearbeitung zu beenden.

Die vorgenommenen Änderungen werden gespeichert.

You can only change the title and description of an unpublished app.

You can open or close the app details area by clicking the app name in the navigation
bar.

Changing the thumbnail of an app
You can replace the default thumbnail of an app with another thumbnail, to make it easier to
distinguish between apps in the hub. You can use one of the default images, or an image of your
own.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der App-Übersicht im Detailbereich der App auf .

2. Klicken Sie auf der Standardminiaturansicht auf .
Die Medien-Bibliothek wird geöffnet.

3. Click on a folder in the media library, for example In app or Default.
4. Select the image you want to use as a thumbnail for the app and click Insert.

5. Klicken Sie auf , um die Bearbeitung zu beenden.

The image you selected is now used as a thumbnail for the app.

Das optimale Seitenverhältnis einer Miniaturansicht beträgt 8:5 (Breite:Höhe).

Folgende Formate werden unterstützt: .png, .jpg, .jpeg und .gif.
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Für Qlik Sense: Sie können Bilder in den Ordner In app in der Medienbibliothek hochladen. Sie
müssen die Qlik Management Console verwenden, um Bilder in den Standardordner hochzuladen.

Für Qlik Sense Desktop: Sie können Bilder im folgenden Ordner auf Ihrem Computer platzieren:
C:\Users\<user>\Documents\Qlik\Sense\Content\Default. Bilder stehen im Ordner default in der
Medienbibliothek zur Verfügung. Wenn eine App zwischen Installationen verschoben wird, werden
die in der App verwendeten Bilder in der qvf-Datei zusammen mit der App gespeichert. Beim Öffnen
der App an einem neuen Speicherort befinden sich die Bilder im Ordner In App in der
Medienbibliothek für die App.

You can only change the thumbnail of an unpublished app.

You can open or close the app details area by clicking the app name in the navigation
bar.

Duplizieren einer App
Durch das Duplizieren einer App können Sie eine Kopie erstellen, die weiterentwickelt werden kann.
Sie können nur Apps duplizieren, die Sie selbst erstellt haben, es sei denn, der Administrator hat
Ihnen eine Sicherheitsrolle mit aktivierter Duplizierung zugewiesen.

Wenn Sie die Admin-Rolle innehaben und über die benötigten Administrationsrechte verfügen,
können Sie aus QMC Duplikate von Apps erstellen.

Wenn Sie eine veröffentlichte App duplizieren, werden nur die Basisarbeitsblätter und -
storys in die Kopie übernommen.

Gehen Sie folgendermaßen vor:

l Klicken Sie mit der rechten Maustaste auf die App im Hub, die Sie duplizieren möchten, und
wählen Sie Duplizieren aus.
Wenn die Duplizierung startet, wird eine Weile unten am Bildschirm eine entsprechende
Benachrichtigung angezeigt. Nachdem die App dupliziert wurde, wird eine erneute
Benachrichtigung angezeigt, damit Sie die App-Liste akualisieren können. Wenn die
Duplizierung fehlschlägt, wird eine Fehlermeldung angezeigt.

Unter Arbeiten wird eine Kopie der App erstellt. Sie können die App durch Anklicken öffnen und
nach Bedarf bearbeiten.
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Aufgrund der Funktionsweise der Datensynchronisation an Sites mit mehreren Knoten
kann es zu einer fehlerhaften Anzeige von Miniaturansichten oder Bildern in Apps
kommen, wenn diese geöffnet werden, kurz nachdem sie dupliziert oder importiert
wurden. Die fehlerhaften Bilder werden wiederhergestellt, sobald die Synchronisation
abgeschlossen ist. Aktualisieren Sie das Browserfenster, um zu prüfen, ob die Bilder
wiederhergestellt wurden.

Bereitstellen von Apps in Insight Advisor Chat
Sie können Ihre Apps in Insight Advisor Chat im Hub bereitstellen.

Wenn Ihre App verfügbar ist, können Benutzer mit Zugriff auf diese App nach Insight Advisor in Ihrer
App mit Insight Advisor Chat suchen.

Apps, die Section Access verwenden, benötigen zusätzliche Konfiguration für
Dienstbenutzer, damit sie in Insight Advisor Chat verfügbar sind. Wenn sensible
Informationen in App-Namen, Feldnamen oder Master-Elementnamen enthalten sind,
können diese offengelegt werden, wenn Sie Apps, die Section Access verwenden, für
Insight Advisor Chat zur Verfügung stellen. App-Vorschläge für Abfragen umfassen
Apps in Streams, auf die Benutzer Zugriff haben. Dazu können auch Apps gehören, auf
welche die Benutzer im Section Access der App keinen Zugriff haben. Eine Auswahl
dieser Apps hat aber keine Aktion zur Folge. Wenn Sie auf Dimensionen oder
Kennzahlen klicken, um die verfügbaren Elemente einer App anzuzeigen, die Section
Access verwendet, können Benutzern Elemente angezeigt werden, auf die sie keinen
Zugriff haben. Durch Klicken auf diese Elemente erhalten die Benutzer aber keine Daten.

App-Inhaltsverfügbarkeit in Insight Advisor Chat
Wonach Benutzer über die Schaltflächen Kennzahl und Dimension mit Insight Advisor Chat
suchen und zugreifen, hängt davon ab, ob die App veröffentlicht ist und ob ein logisches Modell auf
Ihre App angewendet wird.

Für Ihre eigenen unveröffentlichten Apps können Sie nach Feldern und Master-Elementen in der
App suchen. Für veröffentlichte Apps können Benutzer nur nach Master-Elementen suchen. Wenn
Sie Geschäftslogik auf eine nicht veröffentlichte oder veröffentlichte App angewendet haben,
können Benutzer basierend auf dem logischen Modell nach verfügbaren Feldern und Master-
Elementen suchen.

Wenn Sie auf die Schaltfläche Kennzahl oder Dimension klicken (bzw. „show measure“ oder „show
dimension“ eingeben), werden die entsprechenden Master-Elemente angezeigt. Wenn die App
keine Master-Elemente enthält, werden stattdessen Felder im Zusammenhang mit Kennzahlen oder
Dimensionen angezeigt. Felder oder Master-Elemente, die im logischen Modell ausgeblendet sind,
werden bei Anklicken der Schaltfläche nicht angezeigt, es kann aber in einer Abfrage nach ihnen
gesucht werden.
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Aktivieren von Insight Advisor Chat

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der App in der Navigationsleiste auf den App-Namen.

2. Klicken Sie im Bereich für App-Details auf .

3. Aktivieren Sie Insight Advisor in Hub.

Aktivieren der Skripterstellung auf Diagrammebene
Standardmäßig ist Skripterstellung auf Diagrammebene in Apps deaktiviert. Sie können
sie in den App-Details aktivieren.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der App in der Navigationsleiste auf den App-Namen.

2. Klicken Sie im Bereich für App-Details auf .

3. Aktivieren Sie Skripterstellung für Diagramme.

Deaktivieren von Insight Advisor
Standardmäßig sind Suche für Insight Advisor und Analysetypen für Insight Advisor in
Apps aktiviert. Sie können Insight Advisor deaktivieren, damit Benutzer keinen Zugriff
auf diese Funktionen haben.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der App in der Navigationsleiste auf den App-Namen.

2. Klicken Sie im Bereich für App-Details auf .

3. Deaktivieren Sie Insight Advisor in dieser App.

Löschen einer App
Nicht mehr benötigte Apps können gelöscht werden.

Aus dem Hub können nur Apps gelöscht werden, die Sie erstellt haben und die noch
nicht veröffentlicht wurden.

Wenn Sie eine App veröffentlicht haben, ist die veröffentliche Version gesperrt und kann nur aus
Qlik Management Console gelöscht werden. Die veröffentlichte Version ist ein Duplikat der
ursprünglichen App. Die ursprüngliche Version der App kann nur aus Ihrem persönlichen
Arbeitsbereich im Hub gelöscht werden.

Gehen Sie folgendermaßen vor:
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1. Klicken Sie mit der rechten Maustaste auf die App im Hub und wählen Sie Löschen aus.
Es öffnet sich ein Bestätigungsdialogfeld.

2. Klicken Sie auf Löschen.
Wenn die App gelöscht wird, wird eine Weile unten am Bildschirm eine entsprechende
Benachrichtigung angezeigt. Wenn der Löschvorgang fehlschlägt, wird eine Fehlermeldung
angezeigt.

Veröffentlichte Apps können Sie in Qlik Management Console löschen.

Wenn eine dritte Person eine App aus dem Stream löscht, den Sie aktuell ansehen, wird unten am
Bildschirm eine entsprechende Benachrichtigung angezeigt und Sie haben die Möglichkeit, die
App-Liste zu aktualisieren.

Uploading image files to media library
You can upload images to the media library. Because of limitations in the web browsers supported
by Qlik Sense, it is recommended to keep the height and width as well as the file size of the images
as small as possible. The maximum file size is 5 MB.

Folgende Formate werden unterstützt: .png, .jpg, .jpeg und .gif.

Für Qlik Sense: Sie können Bilder in den Ordner In app in der Medienbibliothek hochladen. Sie
müssen die Qlik Management Console verwenden, um Bilder in den Standardordner hochzuladen.

Für Qlik Sense Desktop: Sie können Bilder im folgenden Ordner auf Ihrem Computer platzieren:
C:\Users\<user>\Documents\Qlik\Sense\Content\Default. Bilder stehen im Ordner default in der
Medienbibliothek zur Verfügung. Wenn eine App zwischen Installationen verschoben wird, werden
die in der App verwendeten Bilder in der qvf-Datei zusammen mit der App gespeichert. Beim Öffnen
der App an einem neuen Speicherort befinden sich die Bilder im Ordner In App in der
Medienbibliothek für die App.

Sie haben mehrere Möglichkeiten zum Öffnen der Medienbibliothek:

l Vom Bereich mit den App-Details. Gehen Sie folgendermaßen vor:
1. Klicken Sie in einer App in der Navigationsleiste oben auf dem Bildschirm auf den App-

Namen.

2. Klicken Sie im Bereich für App-Details auf .

3. Klicken Sie auf der App-Miniaturansicht auf .
l Beim Bearbeiten eines Arbeitsblatts. Zum Beispiel:

l Doppelklicken Sie auf eine Text und Bild-Visualisierung auf dem Arbeitsblatt und
klicken Sie auf .

l Klicken Sie auf den Titelbereich eines Arbeitsblatts. Klicken Sie dann im
Eigenschaftsfenster unter Miniaturansicht auf .

l Folgen Sie dem Verfahren zum Hinzufügen eines Hintergrundbilds zu einem Diagramm
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oder Arbeitsblatt, und klicken Sie dann auf .
Beispiel für ein Balkendiagramm: Customizing the background (page 191)

l Klicken Sie in der Storytelling-Ansicht in der Symbolleiste auf .

The Media library dialog opens and now you can upload images.

Gehen Sie folgendermaßen vor:

1. Select Upload media.
2. Gehen Sie folgendermaßen vor:

l Drop one or more image files onto the designated area.
l Click the designated area to open the upload dialog, browse and select images, and

click Open.
An upload indicator is displayed while the image file is being uploaded. You can cancel an
ongoing upload by clicking on on the image.

You cannot upload a file if its file name already exists in the media library.

Now you have added images to the media library. Click the image and select to insert the image.

Deleting image files from media library
You can delete images from the media library in Qlik Sense.

Sie haben mehrere Möglichkeiten zum Öffnen der Medienbibliothek:

l Vom Bereich mit den App-Details. Gehen Sie folgendermaßen vor:
1. Klicken Sie in einer App in der Navigationsleiste oben auf dem Bildschirm auf den App-

Namen.

2. Klicken Sie im Bereich für App-Details auf .

3. Klicken Sie auf der App-Miniaturansicht auf .
l Beim Bearbeiten eines Arbeitsblatts. Zum Beispiel:

l Doppelklicken Sie auf eine Text und Bild-Visualisierung auf dem Arbeitsblatt und
klicken Sie auf .

l Klicken Sie auf den Titelbereich eines Arbeitsblatts. Klicken Sie dann im
Eigenschaftsfenster unter Miniaturansicht auf .

l Folgen Sie dem Verfahren zum Hinzufügen eines Hintergrundbilds zu einem Diagramm
oder Arbeitsblatt, und klicken Sie dann auf .
Beispiel für ein Balkendiagramm: Customizing the background (page 191)

l Klicken Sie in der Storytelling-Ansicht in der Symbolleiste auf .

The Media library dialog opens and now you can delete images.
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Delete images

Gehen Sie folgendermaßen vor:

1. Select the In app folder.
2. Select the file you want to delete.

3. Click .
A confirmation dialog is displayed.

4. Click Delete.

Now you have deleted images from the media library.

You can also right-click on an image file and select Delete.

For Qlik Sense: You need to use the Qlik Management Console to delete images from the
default folder, or other folders that were created from the Qlik Management Console.

Delete images using Qlik Sense Desktop
You can delete images from the default folder by removing the files from this location:
<user>\Documents\Qlik\Sense\Content\Default.

The images in the In app folder are bundled images, saved in the qvf file together with the rest of
the contents of the app. If a bundled image is no longer used in the app, the image will be deleted
from the qvf file when saving the app.

2.5 Fehlerbehebung – Erstellen von Apps
In diesem Abschnitt werden Probleme beschrieben, die beim Erstellen von Apps und
Visualisierungen in Qlik Sense auftreten können.

Bilder sind nicht in einer App enthalten, die von einer Qlik Sense
Umgebung in eine andere verschoben wurde

Mögliche Ursache

Sie haben eine App in Qlik Sense erstellt und sie in eine andere Qlik Sense-Umgebung verschoben.

Wenn Sie Apps zwischen Qlik Sense-Umgebungen verschieben, werden Bilder möglicherweise
nicht automatisch verschoben. Die Bilder müssen manuell gehandhabt werden, und zwar je
nachdem, zwischen welchen Umgebungen die App verschoben wurde, auf verschiedene Weise.
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Vorgeschlagene Aktion

Importieren Sie die Bilder aus der Qlik Sense-Umgebung, in der die App erstellt wurde, mithilfe von
Qlik Management Console an den Zielspeicherort.

Bilder sind nicht in einer App enthalten, die von einer Qlik Sense Desktop-
Umgebung in Qlik Sense importiert wurde

Mögliche Ursache

Sie haben eine App in Qlik Sense Desktop erstellt und sie in Qlik Sense verschoben.

Wenn Sie Apps zwischen Qlik Sense-Umgebungen verschieben, werden Bilder möglicherweise
nicht automatisch verschoben. Die Bilder müssen manuell gehandhabt werden, und zwar je
nachdem, zwischen welchen Umgebungen die App verschoben wurde, auf verschiedene Weise.

Vorgeschlagene Aktion

Importieren Sie die Bilder mit Qlik Management Console aus dem Bilderordner der Qlik Sense
Desktop-App.

Bilder werden nur dann automatisch eingeschlossen, wenn eine App von einer Qlik
Sense Desktop-Installation in eine andere verschoben wird.

Der Standardspeicherort der Bilder in Qlik Sense Desktop ist
<user>\Documents\Qlik\Sense\Content\Default.

Wenn Sie Bilder in Qlik Sense Desktop im Ordner Content\Default in Unterordnern
organisiert haben, müssen diese der App und ihren Arbeitsblättern, Storys und Text-
und Bildobjekten nach dem Importieren der Bilder manuell hinzugefügt werden.

Bilder sind nicht in einer App enthalten, die von einer Qlik Sense
Desktop-Installation in eine andere verschoben wurde

Mögliche Ursache

Sie haben eine App zwischen Qlik Sense Desktop-Installationen verschoben.

Wenn Sie Apps zwischen Qlik Sense-Umgebungen verschieben, werden Bilder möglicherweise
nicht automatisch verschoben. Die Bilder müssen manuell gehandhabt werden, und zwar je
nachdem, zwischen welchen Umgebungen die App verschoben wurde, auf verschiedene Weise.
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Vorgeschlagene Aktion

Gehen Sie folgendermaßen vor:

l Kopieren Sie die Bilder von dem PC, auf dem die App erstellt wurde, und fügen Sie sie im
Bilderordner des Zielspeicherorts ein.

Der Standardspeicherort der Bilder in Qlik Sense Desktop ist
<user>\Documents\Qlik\Sense\Content\Default.

Das Bild, das ich verwenden möchte, scheint nicht zu
funktionieren
Bilder sind ein Teil von Apps als Miniaturansichten, Arbeitsblätter und Storys, in Text- und
Bildobjekten und in Story-Folien.

Mögliche Ursache

Sie verwenden ein Bild in einem nicht unterstützten Format.

Vorgeschlagene Aktion

Gehen Sie folgendermaßen vor:

l Konvertieren Sie das Bild in eines der unterstützten Formate (png, jpg, jpeg oder gif).

Die Verwendung von Insight Advisor wirkt sich auf die
Systemleistung aus
Insight Advisor verwendet Master-Elemente als Felder in empfohlenen Diagrammen.

Mögliche Ursache

Die von Einblicke generierten Diagramme wählen Felder aus, die zu anspruchsvollen Diagrammen
führen.

Vorgeschlagene Aktion

Gehen Sie folgendermaßen vor:

l Ändern Sie, welche Felder den Benutzern von veröffentlichten Apps gezeigt werden.

Ich kann Laden nicht finden, wenn ich mit der rechten Maustaste
auf eine App klicke
Ich möchte meine App laden, sehe aber die Option Laden nicht, wenn ich mit der rechten Maustaste
auf meine App klicke.
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Mögliche Ursache

Sie haben eine oder mehrere der folgenden Berechtigungen in QMC nicht festgelegt:

l Aktualisierungszugriff auf die App.
l Lesezugriff auf den Ressourcenfilter HubSection_Task.
l HubAdmin-Rolle oder Lese- und Erstellungszugriff auf den Ressourcenfilter ReloadTask.

Vorgeschlagene Aktion

Wenden Sie sich an einen QMC-Administrator, um die Rolle HubAdmin oder Lese- und
Erstellungszugriff auf den Ressourcenfilter ReloadTask zu erhalten.

Ich kann meine App-Ladeaufgaben nicht im Hub verwalten
Ich möchte meine App-Ladeaufgaben im Hub anzeigen, sehe aber die Option Ladeaufgaben
verwalten nicht, wenn ich mit der rechten Maustaste auf eine App klicke.

Mögliche Ursache

Die Sicherheitsregel HubSectionTask ist deaktiviert oder Sie haben keinen Lesezugriff auf den
Ressourcenfilter HubSection_Task. Es kann auch sein, dass Sie keinen Lesezugriff auf App-
Ladeaufgaben für den in QMC konfigurierten Hub haben.

Vorgeschlagene Aktion

Wenden Sie sich an einen QMC-Administrator, um Lesezugriff auf HubSection_Task und entweder
Zugriff auf App-Ladeaufgaben im Hub oder die Rolle HubAdmin zu erhalten. Die Rolle HubAdmin hat
standardmäßig Lesezugriff auf App-Ladeaufgaben im Hub.

Miniaturbilder werden beim Kopieren eines Arbeitsblatts nicht
eingeschlossen

Mögliche Ursache

Sie haben ein Arbeitsblatt aus einer anderen App kopiert. Miniaturbilder werden als App-
Ressourcen gespeichert und werden beim Kopieren eines Arbeitsblatts nicht eingeschlossen. Das
Kopieren von Arbeitsblättern innerhalb einer App funktioniert problemlos.

Vorgeschlagene Aktion

Sie können eine vollständige App kopieren und als Ausgangspunkt verwenden. Darin sind alle
Ressourcen, z. B. Bilder, eingeschlossen.
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Die Leserichtung von rechts nach links funktioniert bei einigen
Visualisierungen, bei anderen nicht

Mögliche Ursache

Sie werden feststellen, dass einige Visualisierungen in Qlik Sense Sprachen wie Arabisch oder
Hebräisch von rechts nach links anzeigen können, ohne dass die Rechts-nach-Links-Leserichtung
in der App aktiviert ist. Um jedoch zu gewährleisten, dass die Rechts-nach-Links-Leserichtung
immer und für alle Visualisierungen in der App korrekt angewendet wird, müssen Sie diese
Einstellung in der App aktivieren.

Vorgeschlagene Aktion

Aktivieren Sie die Lesereihenfolge von rechts nach links in der App, um sicherzustellen, dass die
Einstellung auf alle Visualisierungen in der App angewendet wird.

Gehen Sie folgendermaßen vor:

1. In einer unveröffentlichten App klicken Sie auf und dann auf , um die App-Optionen zu
öffnen.

2. Unter Darstellung > Rechts nach links wählen Sie Ein oder Aus.

Wenn die Visualisierung mit Qlik Sense-Diagrammen freigegeben wird, wirkt sich die
Änderung der Leserichtung in der App auch auf die Leserichtung im freigegebenen
Diagramm aus. .

2.6 Optimieren der App-Leistung
Mit einer geringeren App-Größe, vereinfachten Datenmodellen und der strategischen
Nutzung der Aggregierung mit Auswahlformeln lässt sich die App-Leistung steigern. In
diesem Abschnitt erfahren Sie, wie Sie Leistungsprobleme vermeiden können, indem
Sie auf Bereiche achten, die zu einer Beeinträchtigung der Leistung führen können.
Zudem wird gezeigt, wie Sie die App-Leistung bewerten und überwachen können.

App-Komplexität
Diese nicht fest definierten Kategorien können Sie bei der Diagnose von Problemen unterstützen.
Je komplexer die Apps, desto geringer ist ihre Leistung.

Einfache Apps:

l Enthalten keine Aggregierung mit Auswahlformeln oder If()-Anweisungen.
l Enthalten keine großen Tabellen.
l Nutzen ein einfaches Datenmodell.
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l Enthalten einfache Berechnungen.
l Können große Datenmengen umfassen.

Mäßig komplexe Apps:

l Enthalten ein Datenmodell mit vielen Tabellen, befolgen aber Best Practices.
l Verwenden Aggregierung mit Auswahlformeln und mehrere If()-Anweisungen.
l Enthalten große oder breite Tabellen in Arbeitsblättern (mindestens 15 Spalten).

Komplexe Apps:

l Weisen ein sehr komplexes Datenmodell auf.
l Stellen Verbindungen zu großen Datenmengen her.
l Enthalten komplexe Berechnungen, Diagramme und Tabellen.

App-Details
Für Ihre Hardware-Umgebung müssen Sie die App-Größe berücksichtigen, da diese sich auf die
Leistung Ihrer Qlik Sense Bereitstellung auswirkt. Wenn Sie beispielsweise Ihre Apps nicht
optimieren, benötigen diese mehr Hardwareressourcen.

Die Überwachung der App-Größe unterstützt Sie bei Folgendem:

l Verstehen der aktuellen Leistung
l Verstehen, welche Auswirkung die Bereitstellung einer neuen App auf die Leistung hat
l Verstehen, welche Auswirkung die Änderung einer vorhandenen App auf die Leistung hat
l Beheben von Leistungsproblemen
l Planen von zukünftigem Wachstum

Qlik stellt Tools bereit, mit denen Sie Ihre Apps beurteilen können. Weitere Informationen finden Sie
unter: Leistung und Skalierbarkeit in Qlik Sense Enterprise.

Die folgenden grundlegenden App-Elemente können die Leistung beeinflussen:

Funktion Beschreibung

App-Festplattengröße
(MB)

Die App-Größe finden Sie in der QMC. Gehen Sie zu Apps und öffnen
Sie die Spaltenauswahl rechts neben Aktionen. Klicken Sie auf das
Optionsfeld neben Dateigröße (MB). Wenn Sie Qlik Sense Desktop
verwenden, finden Sie die App-Größe in Windows Explorer. Der
Standardordner ist %USERPROFILE%\Documents\Qlik\Sense\Apps. Im
Ordner Apps sind alle App-Namen und Dateigrößen aufgeführt.

App-Details mit Auswirkung auf die Leistung
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Funktion Beschreibung

App-Größe in RAM
(GB)

Den RAM-Basis-Footprint einer App ermitteln Sie wie folgt:

1. Starten Sie den Qlik Sense Server neu.
2. Notieren Sie sich die aktuelle RAM-Nutzung.
3. Öffnen Sie die Qlik Sense App.
4. Halten Sie die Differenz für RAM fest.

Nutzen Sie den App Metadata Analyzer zum Ermitteln dieser Metrik,
wenn Sie mit Qlik Sense June 2018 oder höher arbeiten.

Gesamtzeilenzahl der
App (M)

Anhand von Systemfeldern können Sie die Gesamtzeilenzahl
berechnen. Erstellen Sie einen KPI mit der Kennzahl Sum($Rows).

Gesamtfelderzahl der
App

Anhand von Systemfeldern können Sie die Gesamtfelderzahl
berechnen. Erstellen Sie einen KPI mit der Kennzahl Sum($Fields).

Gesamttabellenzahl
der App

Anhand von Systemfeldern können Sie die Gesamttabellenzahl
berechnen. Erstellen Sie einen KPI mit der Kennzahl Count(DISTINCT
$Table).

Überwachen der App
Die Qlik Management Console (QMC) enthält Apps zur Überwachung der Systemleistung und -
auslastung in Qlik Sense Enterprise on Windows:

l Die Operations Monitor-App stellt Informationen über Hardwarenutzung wie Serverspeicher
und CPU-Auslastung, aktive Benutzer und Ladeaufgabenaktivitäten bereit. Zudem werden
eine Zusammenfassung und detaillierte Informationen zu Fehlern, Warnungen und
Protokollaktivitäten in der Qlik Sense-Serverumgebung bereitgestellt.

l Die License Monitor-App verfolgt die Lizenznutzung nach und überwacht Änderungen an der
Lizenzzuweisung.

l Die Log Monitor-App zeigt praktisch alle verfügbaren Protokolldaten und ermöglicht
Trendanalysen und Fehlerbehebung.

l Die Sessions Monitor-App zeigt Protokolldaten zur Nutzung von Apps.
l Die Reloads Monitor-App zeigt detaillierte Informationen zu Ladedaten, sowohl über die QMC

als auch über im Hub geöffnete Apps.
l Die Sense System Performance Analyzer-App zeigt die Leistung von Qlik Sense über alle

Knoten hinweg.
l Die Sense Connector Logs Analyzer-App bietet Einblicke in die Auslastung und Fehler

spezifischer Qlik-Konnektoren.
l Die App Metadata Analyzer-App bietet eine ganzheitliche Ansicht aller Ihrer Qlik Sense Apps,

einschließlich umfassender Details eines App-Datenmodells und seiner Ressourcennutzung.
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Große Datenmengen
Diese Architekturstrategien können Sie verwenden, wenn Sie eine Verbindung zu großen
Datenmengen herstellen.

Segmentierung
Sie können QVDs nach Dimensionen wie Zeitrahmen, Region oder Aggregierungsebene
segmentieren. Beispiel: Sie verfügen über die folgenden Dateien:

l Eine QVD, die Daten der letzten zwei Jahre enthält.
l Eine QVD, die Verlaufsdaten für einen längeren Zeitraum als zwei Jahre enthält.
l Eine QVD, die alle auf einer höheren Ebene aggregierten Daten enthält. Beispielsweise wurde

nach Monat statt nach Datum oder nach Land statt nach einzelnen Kunden aggregiert.
l Eine große QVD mit allen Daten, die nur von einem kleinen Teil der Benutzer verwendet wird.

Auf ähnliche Weise können Sie die App segmentieren. Kleinere Apps reichen für den Analysebedarf
der meisten Benutzer aus. Dadurch lassen sich Kosten einsparen.

Sie können auch mehrere Apps mit Schwerpunkten auf verschiedene Regionen haben. So brauchen
die Benutzer keine App mit Daten zu öffnen, an denen sie kein Interesse oder für die sie keine
Zugriffsberechtigung haben. Auch Daten, auf die nicht über Abschnittszugriff zugegriffen werden
kann, benötigen Arbeitsspeicher.

Generierung von On-Demand-Apps (ODAG)
In Qlik Sense On-Demand-Apps erhalten die Benutzer zusammenfassende Ansichten von großen
Datenspeichern. Sie können die relevanten Teilmengen der Daten identifizieren und für eine
detaillierte Analyse laden.

Aus Benutzerperspektive gibt es zwei Apps:

1. Einen Einkaufswagen mit aggregierten Daten.
2. Eine leere Vorlagen-App, in der Details angezeigt werden können.

Der Benutzer trifft Auswahlen in der Einkaufswagen-App. Nachdem ein Schwellenwert erreicht ist,
wird ein benutzerdefiniertes LOAD-Skript erstellt, das die Vorlagen-App mit den angeforderten
Details füllt.

Anwendungsverkettung
Anwendungsverkettung (in QlikView als Dokumentverkettung bezeichnet) bedeutet, dass eine
aggregierte App vorhanden ist, die von den Benutzern regelmäßig genutzt wird. Wenn ein Benutzer
weitere Details benötigt, können Auswahlen von der aggregierten App an eine Detail-App
übergeben werden, wo die Daten auf einer detaillierteren Granularitätsebene angezeigt werden
können. Dadig genuurch wird Arbeitsspeicher gespart, weil die Benutzer keine unnötig detaillierten
Daten laden. Zur Anwendungsverkettung fügen Sie Schaltflächenobjekte zu einem Arbeitsblatt
hinzu. Weitere Informationen finden Sie unter Button (page 401).
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Anwendungsverkettung wird auch über APIs unterstützt. Beispielsweise können Sie die App
Integration API verwenden, um benutzerdefinierte Anwendungsverkettung zu erstellen. Weitere
Informationen finden Sie unter App Integration API.

Leistung des Datenmodells
Diese Indikatoren können sich auf die Leistung des Datenmodells auswirken. Jeder ist eine Best
Practice, die die Nutzbarkeit der App verbessert.

Aktion Beschreibung

Synthetische Schlüssel
entfernt

Qlik Sense erstellt synthetische
Schlüssel, wenn zwei oder mehr
Datentabellen zwei oder mehr
gemeinsame Felder haben. Das kann
bedeuten, dass ein Fehler im Skript oder
im Datenmodell vorliegt.

Zirkelbezüge aus
Datenmodell entfernt

Zirkelbezüge treten auf, wenn zwei
Felder mehr als eine Zuordnung
aufweisen. Qlik Sense versucht, diese
aufzulösen, indem die Verbindung zu
einer der Tabellen geändert wird. Es
sollten jedoch alle
Zirkelbezugwarnungen gelöst werden.

Geeignete
Datengranularität

Sie sollten nur die benötigten Daten
laden. Beispiel: Eine Gruppe von
Benutzern benötigt nur Daten aufgeteilt
nach Woche, Monat und Jahr. Sie
können entweder die aggregierten
Daten laden oder die Daten innerhalb
des Ladeskripts aggregieren, um
Arbeitsspeicher zu sparen. Wenn ein
Benutzer Daten auf einer detaillierteren
Granularitätsebene visualisieren muss,
können Sie ODAG oder
Dokumentverkettung verwenden.

Best Practices für die Leistung des Datenmodells
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Aktion Beschreibung

QVDs nach Möglichkeit
verwendet

Eine QVD-Datei enthält Datentabellen,
die aus Qlik Sense exportiert wurden.
Dieses Dateiformat ist für schnelles
Einlesen von Daten aus einem Skript
optimiert, aber dennoch sehr kompakt.
Das Einlesen von Daten aus QVD-
Dateien ist etwa 10-100 Mal schneller
als das Einlesen aus anderen
Datenquellen.

Beim Laden optimierte
QVD-Dateien

QVD-Dateien können in zwei Modi
gelesen werden: Standard (schnell) und
optimiert (schneller). Der ausgewählte
Modus ergibt sich automatisch aus dem
Skriptmodul.
Das optimierte Laden unterliegt
bestimmten Einschränkungen. Es ist
möglich, Felder umzubenennen, aber
mit allen folgenden Vorgängen wird das
Standardladen ausgeführt:

l Alle Transformationen für
geladene Felder.

l Verwenden einer where-Klausel,
die Qlik Sense veranlasst, die
Datensätze zu entpacken.

l Verwenden von Zuordnen für ein
geladenes Feld.

Nutzen des inkrementellen
Ladens

Wenn Ihre App eine Verbindung mit
großen Datenmengen aus Datenbanken
herstellt, die kontinuierlich aktualisiert
werden, dann kann das erneute Laden
des gesamten Datenbestands
zeitaufwändig sein. Verwenden Sie
stattdessen inkrementelles Laden, um
neue oder geänderte Datensätze aus
der Datenbank abzurufen.
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Aktion Beschreibung

Konsolidiertes Snowflake -
Modell

Wenn Sie mit einem Snowflake-
Datenmodell arbeiten, können Sie
möglicherweise die Anzahl der
Datentabellen verringern, indem Sie
einige von ihnen mit dem Präfix Join
oder mit einer anderen Zuordnung
verknüpfen. Dies ist besonders bei
großen Faktentabellen von Bedeutung.
Als generelle Regel sollte nur eine große
Tabelle verwendet werden.

Tabellen mit einer kleinen
Anzahl Felder sind
denormalisiert

Wenn Sie zwei Tabellen mit wenigen
Feldern haben, kann die Leistung
besser werden, wenn Sie sie
verknüpfen. .

Denormalisierte Lookup-
(Leaf-)Tabellen mit
Zuordnungs-
Ladevorgängen

Sie sollten den Zusatz Join nicht
verwenden, wenn Sie nur ein Feld aus
einer Tabelle in einer anderen Tabelle
hinzufügen möchten. Dafür sollten Sie
die Lookup-Funktion ApplyMap
verwenden.

Entfernte oder vom
Datumsfeld entkoppelte
Zeitstempel

Datumsfelder können viel Platz belegen,
wenn der Zeitstempel vorhanden ist, da
die Zeichenfolgendarstellung und die
Anzahl der distinkten Werte größer sind.
Wenn die Präzision für Ihre Analyse
nicht erforderlich ist, können Sie den
Zeitstempel beispielsweise auf die
nächste Stunde runden, indem Sie
Timestamp(Floor
(YourTimestamp,1/24)) verwenden,
oder die Zeitkomponenten mit Date
(Floor(YourTimestamp)) vollständig
entfernen.

Wenn Sie den Zeitstempel verwenden
möchten, können Sie ihn vom Datum
entkoppeln. Verwenden Sie die gleiche
Floor()-Funktion und erstellen Sie dann
ein neues Feld mit der extrahierten Zeit,
in etwa wie folgt: Time(Frac
(YourTimestamp)).
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Aktion Beschreibung

Unnötige Felder aus dem
Datenmodell entfernt

Laden Sie nur erforderliche Felder in Ihr
Datenmodell. Vermeiden Sie die
Verwendung von Load * und SELECT.
Folgende Felder müssen Sie
beibehalten:

l Felder, die Sie für die Analyse
benötigen.

l Felder, die tatsächlich in der App
genutzt werden.

Link-Tabellen bei
Handhabung großer
Datenmengen vermieden

Sie sollten sooft wie möglich Link-
Tabellen verwenden. Bei großen
Datenmengen können
zusammengefasste Tabellen jedoch
eine bessere Leistung als Link-Tabellen
aufweisen.

Zusammengefasste
Dimensionen in neue
Felder aufgeteilt

Teilen Sie zusammengefasste
Dimensionen in getrennte Felder auf.
Dadurch wird die Anzahl der
eindeutigen Vorkommen von Werten in
Ihren Feldern reduziert. Das Verfahren
ist ähnlich wie beim Optimieren von
Zeitstempeln.

AutoNumber nach
Möglichkeit verwendet

Sie können einen optimierten
Ladevorgang erstellen, indem Sie die
Daten zuerst aus einer QVD-Datei laden
und dann den AutoNumber-Befehl
verwenden, um die Werte in
Symbolschlüssel zu konvertieren.

Dateninseln vermieden Dateninseln können nützlich sein,
beeinträchtigen aber meist die Leistung.
Verwenden Sie Variablen, um Inseln für
Auswahlwerte zu erstellen.

QVDs werden in
inkrementellen Zeitrahmen
gespeichert

Sie sollten QVDs in Segmenten
speichern, z. B. monatlich. Diese
kleineren monatlichen QVDs können
dann viele verschiedene Apps
unterstützen, die möglicherweise nicht
alle Daten benötigen.

Arbeitsblattleistung
Die folgenden Best Practices verbessern die Leistung von Arbeitsblättern und Visualisierungen.
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Aktion Beschreibung

Die If()-Funktion wird nach
Möglichkeit vermieden

Wenn die Funktion If() innerhalb einer
Aggregierungsfunktion verwendet
wird, funktioniert sie auf
Datensatzebene und wird viele Male
ausgewertet.

Wenn Sie beispielsweise 1000
Datensätze in einer Aggregierung
haben, wird eine If()-Bedingung 1000
Mal ausgewertet. Das kann schnell
ausufern, wenn Sie Befehle
verschachteln. Stattdessen sollten Sie
Aggregierung mit Auswahlformeln
verwenden. Ein Filter für die
Aggregierung mit Auswahlformeln wird
vor der Aggregierung angewendet,
was die Antwortzeit verkürzt. Diese
Antworten können mit Aggregierung
für Auswahlformeln auch im
Zwischenspeicher gespeichert
werden, was mit If() nicht möglich ist.
Sie können auch andere Funktionen
und Änderungen am Datenmodell in
Betracht ziehen.

Best Practices für die Arbeitsblattleistung

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 78



2   Creating apps

Aktion Beschreibung

Felder aus unterschiedlichen
Tabellen innerhalb einer
Aggregierungstabelle
werden nach Möglichkeit
vermieden.

Wenn eine Aggregierung bewertet
wird, durchläuft die Berechnung zwei
Schritte:

1. Im ersten Schritt werden die
relevanten Kombinationen
gesucht, auf die sich die
Berechnung stützen soll. Dieser
Schritt ist Single-Threaded.

2. Im zweiten Schritt wird die
Berechnung durchgeführt.
Dieser Schritt ist Multi-
Threaded.

Der Single-Threaded-Teil kann
erhebliche Auswirkungen auf die
Leistung haben. Ein Beispiel sind
zahlreiche Felder innerhalb einer
Aggregierung, zum Beispiel Sum
(Quantity*ListPrice). Wenn sich
Quantity in der Fakttabelle und
ListPrice in der Master-Produkttabelle
befindet, muss die Engine zuerst die
beiden Tabellen verknüpfen, um die
Kombinationen zu suchen, bevor sie
mit dem Summieren des Produkts
beginnen kann. Die Verknüpfung ist
der Single-Threaded-Teil, das
Summieren der Multi-Threaded-Teil.
Wenn beide Felder sich in der gleichen
Tabelle befinden, ist keine
Verknüpfung erforderlich, und die
Aggregierung wird erheblich schneller
ausgewertet.

Aggr()- und verschachtelte
Aggr()-Funktionen werden
so selten wie möglich
verwendet

Die Aggr()-Funktion beeinträchtigt die
Leistung stark. Eine falsche Nutzung
kann zu ungenauen Ergebnissen
führen. Das kann zum Beispiel in einer
Tabelle mit Dimensionen vorkommen,
die von den Dimensionen innerhalb der
Aggr()-Funktion abweichen.
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Aktion Beschreibung

Aggregierung mit
Auswahlformeln wird nach
Möglichkeit verwendet

Aggregierung mit Auswahlformeln
bietet eine Möglichkeit, einen Satz von
Datenwerten zu definieren, der sich
vom normalen, durch die aktuellen
Auswahlen definierten Satz
unterscheidet.

String-Vergleiche nach
Möglichkeit vermieden

String-Vergleiche sind nicht so
effizient wie Aggregierung mit
Auswahlformeln. Beispielsweise
sollten Sie Match(), MixMatch(),
WildMatch() und Pick() vermeiden.
Erstellen Sie stattdessen Flags im
Skript oder verwenden Sie
Aggregierung mit Auswahlformeln.

Berechnungsbedingungen
werden für Objekte mit
umfangreichen
Berechnungen verwendet

Sie können Visualisierungen mit
zahlreichen Datensätzen haben, wenn
keine Auswahlen vorhanden sind. Als
Best Practice können Sie
Berechnungsbedingungen so zu
Objekten hinzufügen, dass diese erst
dann gerendert werden, nachdem
bestimmte Auswahlen getroffen
wurden. Damit wird die Erstellung von
sehr großen Hypercubes vermieden.
Hier ein Beispiel: GetSelectedCount
([Country])=1 OR GetPossibleCount
([Country])=1. In diesem Szenario wird
die Visualisierung erst dann gerendert,
wenn der Benutzer ein einziges Land
auswählt bzw. andere Auswahlen trifft,
für die nur ein Land möglich ist.
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Aktion Beschreibung

Kennzahlen werden im
Skript nach Möglichkeit
vorab berechnet

Alle Kennzahlen, die sich auf der
niedrigsten Granularitätsebene im
Datenmodell befinden, sollten im
Skript berechnet werden. Wenn
beispielsweise im gleichen Datensatz
in einer Tabelle Sales und Cost
vorhanden sind, können Sie die Marge
ableiten, indem Sie Sales - Cost AS
Margin berechnen. Sie können auch
andere Werte vorab aggregieren,
wenn Sie wissen, dass sie nicht
basierend auf der Auswahl variieren
oder an eine andere
Granularitätsebene gebunden sind.

Tabellen haben weniger als
15 Spalten und weisen
Berechnungsbedingungen
auf

Eine Tabelle mit 15 Spalten kann als
breit bezeichnet werden. Wenn Ihre
Tabellen viele Datensätze enthalten,
sollten Sie berechnete Bedingungen
für das Tabellenobjekt verwenden,
damit es erst gerendert wird, nachdem
bestimmte Auswahlen oder Kriterien
erfüllt sind. Wenn Ihre Tabelle sehr
breit ist, haben Sie folgende
Möglichkeiten:

l Erstellen Sie mehrere kleinere
Tabellen, die entsprechend den
Bedingungen angezeigt werden.

l Verwenden Sie Methoden, mit
denen Spalten entsprechend
den Bedingungen angezeigt
werden.

l Beschränken Sie Ihre Tabellen
auf die Felder, die für Ihre
Analyse erforderlich sind.
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Aktion Beschreibung

Arbeitsblätter enthalten
nicht zu viele Objekte

Objekte werden berechnet, wenn der
Benutzer zum Arbeitsblatt navigiert.
Jedes Mal, wenn ein Benutzer eine
Auswahl in diesem Arbeitsblatt trifft,
wird jedes Objekt neu berechnet,
dessen aktueller Status nicht im
Zwischenspeicher vorhanden ist.
Wenn Sie ein Arbeitsblatt mit
zahlreichen Diagrammen haben, muss
der Benutzer bei fast jeder Auswahl
warten, bis jedes einzelne Objekt
berechnet ist. Dadurch wird die Engine
stark belastet. Als Best Practice sollten
Sie das Konzept
Dashboard/Analysis/Reporting (DAR)
befolgen, um eine übersichtliche und
minimale App zu erstellen.

Numerische Flags werden
im Skript genutzt, um sie in
Aggregierung mit
Auswahlformeln einzusetzen

Aggregierung mit Auswahlformeln mit
Flags kann effizienter als String-
Vergleiche und Multiplikationen sein.

Master-Elemente oder
Variablen werden für
Formeln verwendet

Master-Elemente ermöglichen das
Ziehen und Ablegen von gesteuerten
Metriken und garantieren, dass
Formeln im Zwischenspeicher
gespeichert werden. Beispielsweise
unterscheidet sich Sum(Sales) von
SUM(Sales). Formeln werden mit ihrer
Schreibweise (auch Groß- und
Kleinschreibung) gespeichert und
müssen genau übereinstimmen, damit
sie wiederverwendet werden können.
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3 Visualizations
Visualizations let you present data so that your apps users can interpret and explore it.
For example, a bar chart that compares sales numbers for different regions, or a table
with precise values for the same data. Good visualizations help you quickly and
accurately interpret displayed data.

Visualizations are easy to add and customize. They can take the form of charts, such as bar charts,
pie charts,, tables, gauges, or treemaps. Each chart type has unique functionality. Qlik Cloud
Analytics automatically highlights items associated with your selections so you can drill-down and
filter.

3.1 Select visualization types that align with your
purpose

Each visualization type has a specific goal. You need to think about the purpose of your
visualization, and pick a visualization type that lets you explore your data for that purpose
effectively.

For example: You want to show how a measure, quarterly sales, behaves over time. You should
create a line chart, because one of its strengths is displaying how measure values change over
time. Alternatively, you can start with the type of analysis you want to make.

If you are unsure of what visualization types to use with your data, Qlik Sense offers two methods of
creating visualizations with assistance:

l You can use Insight Advisor to let Qlik Sense analyze your data and generate visualizations
based on your searches or selections. You can then choose to add these visualizations to
your sheets.

l You can also create visualizations using chart suggestions by dragging a field onto the sheet
from the assets panel and then dragging additional fields that you want in the visualization
onto the first field. Qlik Sense then creates a suggested visualization based on the fields
selected for the visualization.

3.2 Datenressourcen in Visualisierungen
Visualisierungen verwenden Daten auf viele verschiedene Arten. Worin Ihre Daten
bestehen oder wie sie erstellt werden, wirkt sich auf Ihre Visualisierungen aus. Im
Wesentlichen werden Ihre Datenobjekte zu Dimensionen und Kennzahlen in Ihren
Visualisierungen. Sie definieren die Kategorien in Ihren Visualisierungen und die
Messungen in diesen Kategorien. Ein Feld kann zum Gruppieren von Daten verwendet
werden, oder es kann mit einer Aggregierungsfunktion umgewandelt werden, um eine
Messung in Datenkategorien bereitzustellen.
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Die in Tabellen und Feldern enthaltenen Datentypen bestimmen auch, ob die Daten als
Dimensionen oder Kennzahlen genutzt werden können, und haben Einfluss darauf, welches die
effektivsten Sortieroptionen sind. So werden beispielsweise für quantitative und qualitative Daten
unterschiedliche Verwendungen empfohlen, wenn sie entweder als Dimensionen oder als
Kennzahlen verwendet werden.

Datenressourcen liefern nicht nur die anzuzeigenden Daten, sondern können auch steuern, welche
Daten angezeigt werden und wie sie dargestellt werden. Sie können eine Visualisierung
beispielsweise durch eine externe Dimension oder Kennzahl farbig darstellen. Weitere
Informationen finden Sie unter Changing the appearance of a visualization (page 630).

Das Extras-Fenster enthält die unterschiedlichen Datenquellen, die Sie in Visualisierungen
verwenden können.

Datenressourcen
Die folgende Tabelle enthält die beim Erstellen von Visualisierungen verfügbaren Datenressourcen:

l Felder
l Kennzahlen
l Dimensionen
l Master-Elemente

Felder
Felder enthalten die in Qlik Sense geladenen Daten. Sie enthalten einen oder mehrere Werte und
entsprechen den Spalten in einer Datenbanktabelle. Die Felddaten können qualitativ oder
quantitativ sein.

Beim Erstellen von Visualisierungen verwenden Sie Felder, um die Dimensionen und Kennzahlen zu
erzeugen. Sie können Felder auch auf verschiedene Arten verwenden, wenn Sie Visualisierungen zu
Ihrer App hinzufügen. In einigen Visualisierungen, beispielsweise in Tabellen, können Felder in
unverändertem Zustand dargestellt werden.

Bei einigen Feldern müssen zusätzliche Aspekte berücksichtigt werden, etwa bei Datums- oder
Zeitfeldern.

Weitere Informationen finden Sie unter Felder (page 87).

Kennzahlen
Kennzahlen sind die Daten, die Sie anzeigen möchten. Kennzahlen werden aus einer Formel
berechnet, die sich aus Aggregierungsfunktionen wie beispielsweise Sum oder Max
zusammensetzt und mit einem oder mehreren Feldern kombiniert wird.

Weitere Informationen finden Sie unter Kennzahlen (page 107).
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Dimensionen
Dimensionen legen fest, wie die Daten in einer Visualisierung gruppiert werden. Beispiel:
Gesamtumsatz pro Land oder Anzahl der Produkte pro Anbieter In Dimensionen werden die
distinkten Werte aus dem als Dimension ausgewählten Feld angezeigt. Dimensionen können auch
mithilfe einer Formel berechnet werden.

Weitere Informationen finden Sie unter Dimensions (page 101).

Master-Elemente
Master-Elemente sind Dimensionen, Kennzahlen oder Visualisierungen, die in anderen
Visualisierungen und Arbeitsblättern in Ihrer App wiederverwendet werden können. Beim
Aktualisieren eines Master-Elements werden alle seine Instanzen aktualisiert. Wenn Sie also die
gleiche Kennzahl in 5 Visualisierungen haben, werden sie alle aktualisiert, sobald das Master-
Element geändert wird.

Master-Elemente bieten darüber hinaus mehr Designoptionen. Sie können beispielsweise den
einzelnen Werten einer Master-Dimension Farben zuweisen, damit die Werte in den
Visualisierungen einheitlich dargestellt werden.

Master-Elemente können auch besondere Dimensionen wie Drilldown-Dimensionen und
Kalenderkennzahlen enthalten.

Weitere Informationen finden Sie unter Reusing assets with master items (page 119).

Formeln
Eine Formel ist eine Kombination aus Funktionen, Feldern und mathematischen Operatoren (+ * / =).
Formeln werden zum Verarbeiten von Daten in der App verwendet. Dabei wird ein Ergebnis
ausgegeben, das in der Visualisierung veranschaulicht werden kann.

Formeln dienen in erster Linie zum Erstellen von Kennzahlen. Mithilfe von Formeln können
berechnete Dimensionen erstellt oder Eigenschaften in verschiedenen Visualisierungen festgelegt
werden. Sie können mit Formeln beispielsweise Bereichsgrenzwerte für Messzeiger oder
Positionslinien für Balkendiagramme definieren.

Weitere Informationen finden Sie unter Arbeiten mit Formeln in Visualisierungen (page 160).

Datentypen in Visualisierungen
Unterschiedliche Datentypen haben unterschiedliche Eigenschaften, und bestimmte Daten eignen
sich möglicherweise besser als Dimensionen oder Kennzahlen. Ebenso eignen sich bestimmte
Arten von Daten für Dimensionen und Kennzahlen in einigen Visualisierungen unter Umständen
besser als Dimension, während sie in bestimmten Aggregierungsfunktionen besser als Kennzahlen
geeignet sind.

Die Daten in den Feldern können qualitativ oder quantitativ sein. Quantitative Datenwerte werden
numerisch in einer aufsteigenden Skala gemessen. Quantitative Daten können Verhältnisse oder
Intervalle sein:
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l Verhältnis: Verhältnisse sind quantitative Daten, für die Sie arithmetische Operationen
durchführen können, so etwa in Bezug auf Kosten oder das Alter.
Sie können beispielsweise die Umsatzwerte für einen Monat addieren, um Gesamtwerte zu
erhalten.

l Intervall: Intervalle sind quantitative Daten, für die Sie keine arithmetischen Operationen
durchführen können.
Sie können beispielsweise keine Summe der Wochentemperaturen berechnen, aber Sie
haben die Möglichkeit, die Durchschnittstemperatur pro Tag sowie den Maximal- und
Minimalwert für jeden Tag zu berechnen.

Qualitative Daten lassen sich nicht numerisch messen, können aber sprachlich beschrieben
werden. Qualitative Daten können nominal oder ordinal sein:

l Nominal: Felder mit Nominaldaten enthalten distinkte qualitative Werte, allerdings ohne
festgelegte Reihenfolge.
Produkt- oder Kundennamen sind beispielsweise Nominaldaten, da sie distinkte Werte
aufweisen, aber keine erforderliche Reihenfolge haben.

l Ordinal: Felder mit Ordinaldaten enthalten qualitative Werte, die einen gereihten oder
positionierten Wert aufweisen. Ordinaldaten sollten anhand ihrer Ordnung und nicht
alphabetisch sortiert werden.
Beispiele für Ordinalwerte sind Minimum, Mittel und Maximum. Auch klein, mittel und groß
sind Ordinalwerte.

Die folgende Tabelle enthält einen allgemeinen Überblick über empfohlene Visualisierungstypen
und Aggregierungsfunktionen für Datentypen. Diese Empfehlungen sollten sich nicht als absolut
verstehen.

Datentyp
Empfohlene
Aggregierungsfunktionen

Nicht empfohlene
Aggregierungsfunktionen

Nominal Anzahl Durchschnitt

Median

Summe

Ordinal Anzahl

Median

Durchschnitt

Summe

Verhältnis Anzahl

Durchschnitt

Median

Summe

Visualisierungsempfehlungen für Datentypen als Kennzahlen
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Datentyp
Empfohlene
Aggregierungsfunktionen

Nicht empfohlene
Aggregierungsfunktionen

Intervall Anzahl

Durchschnitt

Median

Summe

-

Felder
Felder dienen zur Aufnahme der Daten, die in Qlik Sense verwendet werden. Felder
können als die Daten betrachtet werden, die mithilfe des Ladeskripts geladen wurden.

Felder enthalten einen oder mehrere Werte, sogenannte Feldwerte. Im Grunde entsprechen die
Felder den Spalten in einer Datenbanktabelle, können aber auch in mehr als einer Tabelle
vorhanden sein. Feldwerte enthalten numerische oder alphanumerische Daten. Nach dem Laden
mithilfe des Ladeskripts können Felder als Tabellenvisualisierungen dargestellt werden.

Beispiel für Daten in einem Ladeskript:

Temp:

LOAD * inline [

Customer Product UnitSales UnitPrice

Imagine Film 4 16

Imagine Film 10 15

Imagine Shutter 9 9

PhotoInc Shutter 5 10

PhotoInc Lens 2 20

PhotoInc Magnifier 4 25

Gallery Film 8 15

Gallery Lens 7 19

] (delimiter is ' ');

Die in der Datenmodelltabelle enthaltenen Felder nach dem Laden der Daten:

Die gleichen Felder als Spalten in einer Tabellenvisualisierung auf einem Arbeitsblatt:
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Datums- und Zeitfelder
Wenn Sie in der App mit Datums- und Zeitstempelfeldern arbeiten, können Sie verschiedene
datumsbezogene Attribute, zum Beispiel Jahr oder Woche, festlegen und in Ihrer Visualisierung
verwenden.

Erstellen von Datenfeldern in Datenmanager
Für alle Datenfelder, die als Datum oder Zeitstempel erkannt werden, werden automatisch
Datumsfelder erstellt, wenn Sie Ihr Datenmodell im Datenmanager über die Option Daten
hinzufügen mit aktivierter Datenprofilerstellung erstellen oder wenn Sie im Datenmanager auf
Daten laden klicken.

Im Datenmanager erstellte Datumsfelder werden automatisch zu autoCalendar
hinzugefügt.

Wenn das Datums- oder Zeitstempelfeld nicht automatisch erkannt wird, können Sie das
Eingabeformat im Tabelleneditor von Datenmanager anpassen. Sie können das Anzeigeformat
auch so festlegen, dass Visualisierungen verwendet werden.

Welche Datums- und Uhrzeitfelder werden automatisch erkannt?
Datums- und Zeitstempelfelder werden basierend auf den Gebietsschemaeinstellungen Ihres
Systems erkannt. Außerdem werden die folgenden Formate erkannt:

l M/D/YYYY h:mm

l D/M/YYYY h:mm TT

l M/D/YYYY

l D/MM/YYYY

l YYYYMMDD

l YYYYMMDDhhmmss
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l YYYYMMDDhhmmss.fff

l YYYYMMDDhhmmssK

l YYYY-MM-DD

l YYYY-MM-DDThh:mm:ss

l YYYY-MM-DD-Thh:mm:ss.fff

l YYYY-MM-DD-Thh:mm:ssK

Formatspezifikator Beschreibung

YYYY Jahr

M, MM Monat

D, DD Tag

hh Stunde

mm Minute

ss Sekunde

fff Millisekunde

TT AM oder PM

K Zeitzone

T Trennzeichen zwischen Datum und Uhrzeit. T kann nicht durch ein
anderes Zeichen ersetzt werden.

Datums- und Uhrzeitformate

Erzeugen von Datums- und Uhrzeitfeldern im Datenladeskript
Wenn Sie den Dateneditor zum Erstellen des Datenmodells verwenden, müssen Sie eine
Kalendervorlage erzeugen, in der Sie Felder für die Ableitung im Datenladeskript definieren. Die
abgeleiteten Datums- und Uhrzeitfelder werden generiert, wenn das Skript ausgeführt und die
Daten geladen werden.

Verwendung von Datums- und Uhrzeitfeldern in Ihrer App

Datums- und Uhrzeitfelder in Visualisierungen

Alle Datums- und Zeitstempelfelder im Extras-Fenster auf der Registerkarte Felder werden mit
markiert, und Sie können sie erweitern, um erzeugte Datums- und Uhrzeitfelder zu verwenden. Sie
können sie in Visualisierungen wie jedes andere Datenfeld verwenden.
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Datums- und Uhrzeitfelder in Dimensionen
Wenn Sie eine Dimension erstellen, können Sie ebenfalls Datums- und Uhrzeitfelder verwenden. Die
Datums- und Uhrzeitfelder werden unter dem Feld aufgeführt, aus welchem sie erzeugt worden
sind.

Datums- und Uhrzeitfelder in Formeln
Sie können in allen Formeln Datums- und Uhrzeitfelder verwenden, beispielsweise wenn Sie eine
Kennzahl erstellen. Die Benennung der Datums- und Uhrzeitfelder entspricht:

[Feldname].autoCalendar.[Datums- und Uhrzeitfeld].

l [Feldname] ist der Name des Datenfelds, das für das Erzeugen der Datums- und
Uhrzeitfelder verwendet wurde.

l [Datums- und Uhrzeitfeld] ist das Datums- und Uhrzeitfeld, das Sie verwenden möchten,
beispielsweise Year.

Beispiel:

Date.autoCalendar.Year

Datums- und Zeitfelder in Kalenderkennzahlen
Kalenderkennzahlen verwenden Datums- und Zeitfelder, die in autoCalendar erstellt werden. Diese
einzelnen Datums- und Zeitfelder werden von einer Aggregierung mit Auswahlformeln berechnet,
mit der ermittelt wird, ob die Daten in den aktuellen Zeitraum fallen oder sich in einer definierten
relativen Position zum aktuellen Datum befinden. Diese Datums- und Zeitfelder sind relativ und
geben Ergebnisse zurück, die auf dem aktuellen Datum basieren. Sie können diese Felder
unabhängig von Kalenderkennzahlen verwenden.

Datums- und Zeitfelder von Kalendern werden wie folgt formatiert:

[Feldname].autoCalendar.[Datums- und Zeitfeld]={[Wert]}

l [Feldname] ist der Name des Datenfelds, mit dem Datums- und Zeitfelder erstellt werden.
l [Datums- und Zeitfeld] ist der Name des verwendeten Datums- und Zeitfelds, z. B. InYTD.
l [Wert] ist der Wert der Analyseformel der Datums- und Zeitfeldgruppe und legt fest, welche

Daten eingeschlossen werden.

Beispiel:

Date.autoCalendar.YearsAgo={1}

Die folgenden Datums- und Zeitfelder (mit Beispielwerten) sind verfügbar:

InYTD
Dieses Datums- und Zeitfeld legt fest, ob Daten in die aktuelle Jahresperiode fallen oder nicht.
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Beispiel Ergebnis

Date.autoCalendar.InYTD=

{0}
Gibt alle Daten zurück, die in die aktuelle Jahresperiode fallen.

Beispiel: Wenn das aktuelle Datum der 54. Tag des Jahres ist,
werden im Datumsfeld die Daten innerhalb der ersten 54 Tage
eines Jahres eingeschlossen.

Date.autoCalendar.InYTD=

{1}
Gibt alle Daten außerhalb der aktuellen Jahresperiode zurück.

Beispiel: Wenn das aktuelle Datum der 54. Tag des Jahres ist,
werden im Datumsfeld alle Daten nach den ersten 54 Tagen eines
Jahres eingeschlossen.

InYTD

YearsAgo
Dieses Datums- und Zeitfeld legt fest, ob Daten aus einem bestimmten Jahr in Relation zum
aktuellen Datum stammen.

Beispiel Ergebnis

Date.autoCalendar.YearsAgo={0} Gibt alle Daten aus diesem Jahr zurück.

Date.autoCalendar.YearsAgo={1} Gibt alle Daten aus dem letzten Jahr zurück.

Date.autoCalendar.YearsAgo={8} Gibt alle Daten zurück, die acht Jahre zurückliegen.

YearsAgo

InQTD
Dieses Datums- und Zeitfeld legt fest, ob Daten in Relation zum aktuellen Datum in die aktuelle
Quartalsperiode fallen oder nicht.

Beispiel Ergebnis

Date.autoCalendar.InQTD=

{0}
Gibt alle Daten aus allen Quartalen zurück, die innerhalb der
Quartalsperiode liegen.

Beispiel: Wenn das aktuelle Datum der 14. Tag des 1. Quartals ist,
werden im Datumsfeld die ersten 14 Tage jedes Quartals
eingeschlossen.

Date.autoCalendar.InQTD=

{1}
Gibt alle Daten aus allen Quartalen zurück, die außerhalb der
aktuellen Quartalsperiode liegen.

Beispiel: Wenn das aktuelle Datum der 14. Tag des 1. Quartals ist,
werden im Datumsfeld alle Daten nach den ersten 14 Tage jedes
Quartals eingeschlossen.

InQTD
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QuartersAgo
Dieses Datums- und Zeitfeld legt fest, ob Daten aus einem bestimmten Quartal in Relation zum
aktuellen Datum stammen.

Beispiel Ergebnis

Date.autoCalendar.QuartersAgo={0} Gibt alle Daten aus dem aktuellen Quartal zurück.

Date.autoCalendar.QuartersAgo={1} Gibt alle Daten aus dem letzten Quartal zurück.

Date.autoCalendar.QuartersAgo={8} Gibt alle Daten zurück, die acht Quartale zurückliegen.

QuartersAgo

QuarterRelNo
Dieses Datums- und Zeitfeld legt fest, ob Daten aus einem bestimmten Quartal in Relation zum
aktuellen Datum stammen.

Beispiel Ergebnis

Date.autoCalendar.QuarterRelNo=

{0}
Gibt alle Tage aus jeder Instanz des aktuellen Quartals
zurück.

Beispiel: Wenn das aktuelle Datum im 4. Quartal ist, werden
im Datumsfeld alle Daten aus jedem 4. Quartal
eingeschlossen.

Date.autoCalendar.QuarterRelNo=

{3}
Gibt alle Daten aus jeder Instanz des Quartals zurück, die
zwei Quartale vor dem aktuellen Quartal liegen.

Beispiel: Wenn das aktuelle Datum im 4. Quartal ist, werden
im Datumsfeld alle Daten aus jedem 1. Quartal
eingeschlossen.

QuarterRelNo

InMTD
Dieses Datums- und Zeitfeld legt fest, ob Daten in Relation zum aktuellen Datum in die aktuelle
Monatsperiode fallen oder nicht.

Beispiel Ergebnis

Date.autoCalendar.InMTD=

{0}
Gibt alle Daten aus allen Monaten zurück, die innerhalb der
aktuellen Monatsperiode liegen.

Beispiel: Wenn das aktuelle Datum der 15. November 2016 ist,
werden im Datumsfeld die ersten 15 Tage jedes Monats
eingeschlossen.

InMTD
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Beispiel Ergebnis

Date.autoCalendar.InMTD=

{1}
Gibt alle Daten aus allen Monaten zurück, die außerhalb der
aktuellen Monatsperiode liegen.

Beispiel: Wenn das aktuelle Datum der 15. November 2016 ist,
werden im Datumsfeld die Daten nach den ersten 15 Tagen bis
zum Ende jedes Monats eingeschlossen.

MonthsAgo
Dieses Datums- und Zeitfeld legt fest, ob Daten aus einem bestimmten Monat in Relation zum
aktuellen Datum stammen.

Beispiel Ergebnis

Date.autoCalendar.MonthAgo={0} Gibt alle Daten aus dem aktuellen Monat zurück.

Date.autoCalendar.MonthAgo={1} Gibt alle Daten aus dem letzten Monat zurück.

Date.autoCalendar.MonthAgo={8} Gibt alle Daten zurück, die acht Monate zurückliegen.

MonthsAgo

MonthRelNo
Dieses Datums- und Zeitfeld legt fest, ob Daten aus einem bestimmten Monat in Relation zum
aktuellen Datum stammen.

Beispiel Ergebnis

Date.autoCalendar.MonthRelNo=

{0}
Gibt alle Tage aus jeder Instanz des aktuellen Monats zurück.

Beispiel: Wenn das aktuelle Datum im Juni liegt, werden im
Datumsfeld alle Daten aus jeder Instanz des Monats Juni
eingeschlossen.

Date.autoCalendar.MonthRelNo=

{1}
Gibt alle Daten aus jeder Instanz des vorherigen Monats
zurück.

Beispiel: Wenn das aktuelle Datum im Juni liegt, werden im
Datumsfeld alle Daten aus jeder Instanz des Monats Mai
eingeschlossen.

MonthRelNo

InWTD
Dieses Datums- und Zeitfeld legt fest, ob Daten in Relation zum aktuellen Datum in die aktuelle
Wochenperiode fallen oder nicht.
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Beispiel Ergebnis

Date.autoCalendar.InWTD=

{0}
Gibt alle Daten aus allen Wochen zurück, die innerhalb der
aktuellen Wochenperiode liegen.

Beispiel: Wenn das aktuelle Datum der dritte Tag einer Woche ist,
werden im Datumsfeld die Daten der ersten drei Tage jeder Woche
eingeschlossen.

Date.autoCalendar.InWTD=

{1}
Gibt alle Daten aus allen Monaten zurück, die außerhalb der
aktuellen Monatsperiode liegen.

Beispiel: Wenn das aktuelle Datum der dritte Tag einer Woche ist,
werden im Datumsfeld die Daten der letzten vier Tage jeder
Woche eingeschlossen.

InWTD

WeeksAgo
Dieses Datums- und Zeitfeld legt fest, ob Daten aus einer bestimmten Woche in Relation zur
aktuellen Woche stammen.

Beispiel Ergebnis

Date.autoCalendar.WeeksAgo={0} Gibt alle Daten aus der aktuellen Woche zurück.

Date.autoCalendar.WeeksAgo={8} Gibt alle Daten zurück, die acht Wochen zurückliegen.

WeeksAgo

WeekRelNo
Dieses Datums- und Zeitfeld legt fest, ob Daten aus einer bestimmten Woche in Relation zum
aktuellen Datum stammen.

Beispiel Ergebnis

Date.autoCalendar.WeekRelNo=

{0}
Gibt alle Daten aus jeder Instanz der aktuellen Woche zurück.

Beispiel: Wenn die aktuelle Woche die zweite Woche des
Jahres ist, werden im Datumsfeld die Daten ab der zweiten
Woche jedes Jahres eingeschlossen.

Date.autoCalendar.WeekRelNo=

{1}
Gibt alle Daten aus jeder Instanz der vorangegangenen Woche
zurück.

Beispiel: Wenn die aktuelle Woche die zweite Woche des
Jahres ist, werden im Datumsfeld die Daten ab der ersten
Woche jedes Jahres eingeschlossen.

WeekRelNo
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Always one selected value
You can select the Always one selected value for a field in an app. The value specifies
that one, and only one, value is always selected for a field. You can use this value to
specify, for example, that one currency is always selected for a field.

Consider the following when using the Always one selected value:

l You can use the Always one selected value on one or more fields.
l You cannot clear the Always one selected value setting when viewing a sheet. You can,

however, clear the setting by editing the sheet in your workspace.
l When you publish an app with the Always one selected value selected, the value is applied

to all sheets in the app. The app consumer cannot clear the value.
l When you duplicate an app, the Always one selected value is duplicated with the app.
l When you export an app without data, the Always one selected value is not exported with

the app.
l The Always one selected value is not supported for derived fields.

You can use the value with a default bookmark in to highlight specific selections for your app
consumer.

Set the Always one selected value

Gehen Sie folgendermaßen vor:

1. Open a sheet in an app.

2. Click Edit sheet.
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3. Click Fields.
4. Right-click a field, and then click Field settings.
5. In the window that opens, select the Always one selected value check box, and then save.
6. Exit sheet edit mode. The value appears as a tab in the top toolbar. Unlike a bookmark, there

is no option to clear the selection.
The Always one selected value in the toolbar

The Always one selected value defaults to the first entry in the field. In the example above,
the value is applied to Region. Asia is the region that is selected by default. You or your app
consumer can change this selection, in this case to a different region.

7. To test that the Always one selected value is working properly, close and then reopen the
app. The value should be shown in the top toolbar.

To remove the Always one selected value for a field, right-click the field in Edit mode, click Field
settings, and deselect the Always one selected value check box.

Always one selected value and default bookmark example: Controlling selections to
guide app consumers to insights
In this example, we set Always one selected value for a field. We then specify a default bookmark
for the app. By specifying a default bookmark, and enabling Always one selected value, we control
what our app consumers see when they open our published app.

1. Here is a sheet in our app before the Always one selected value and a default bookmark are
applied. This should be the sheet that you want app consumers to see as a landing page
when they open the app.
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App in sheet analysis mode

The chart in the app is built using Country as a dimension, and Sum([Total Revenue]) as a
measure.

2. To ensure that one, and only one, value is always selected for the Region field, we edit the
sheet, click Fields, and then right-click Region.

3. Click Field settings.
4. We then select the Always one selected value checkbox and save.

Turning on the Always one selected value setting

5. When we close Edit mode for the sheet, the Always one selected value value appears as a
tab in the top toolbar. The value defaults to the first entry in the field. In this case, the default
value is Asia.
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App in sheet view with default value selected for Always one selected value field

6. However, we want to show revenue for sub-Saharan Africa when the app is opened. So we
select Sub-Saharan Africa from the Region field, and then click Bookmarks to create a new
bookmark for Region("Sub-Saharan Africa"). We then right-click the Region("Sub-Saharan
Africa") bookmark, and click Set as default bookmark.

Now, when we open the app, or publish the app for an app consumer, the app opens with one value
selected, and the default bookmark is shown. The app is opened on the sheet of the bookmark
instead of the app overview.
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App opened with default bookmark, using the defined selection Sub-Saharan Africa

Data used in example
Load script
You can add the paste the data table below into your load script to try this example out in your own
app.

Sales:

LOAD * INLINE [

Region,Country,Item Type,Sales Channel,Order Priority,Order Date,Order ID,Ship Date,Units

Sold,Unit Price,Unit Cost,Total Revenue,Total Cost,Total Profit

Central America and the

Caribbean,Honduras,Household,Offline,H,2/8/2017,522840487,2/13/2017,8974,668.27,502.54,5997054

.98,4509793.96,1487261.02

Asia,Mongolia,Personal

Care,Offline,C,2/19/2014,832401311,2/23/2014,4901,81.73,56.67,400558.73,277739.67,122819.06

Asia,Sri

Lanka,Cosmetics,Offline,M,11/19/2016,419123971,12/18/2016,6952,437.20,263.33,3039414.40,183067

0.16,1208744.24

Asia,Turkmenistan,Household,Offline,L,12/30/2010,441619336,1/20/2011,3830,668.27,502.54,255947

4.10,1924728.20,634745.90

Central America and the

Caribbean,Honduras,Snacks,Online,L,6/30/2016,795490682,7/26/2016,2225,152.58,97.44,339490.50,2

16804.00,122686.50

Australia and Oceania,Australia,Office

Supplies,Online,C,10/27/2015,158535134,11/25/2015,2924,651.21,524.96,1904138.04,1534983.04,369

155.00

Europe,United

Kingdom,Household,Online,L,1/5/2012,955357205,2/14/2012,282,668.27,502.54,188452.14,141716.28,

46735.86

Sub-Saharan
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Africa,Djibouti,Cosmetics,Offline,H,4/7/2014,259353148,4/19/2014,7215,437.20,263.33,3154398.00

,1899925.95,1254472.05

Australia and

Oceania,Australia,Cereal,Offline,H,6/9/2013,450563752,7/2/2013,682,205.70,117.11,140287.40,798

69.02,60418.38

Middle East and North

Africa,Libya,Clothes,Offline,H,10/30/2010,705784308,11/17/2010,6116,109.28,35.84,668356.48,219

197.44,449159.04

Central America and the

Caribbean,Haiti,Cosmetics,Offline,H,10/13/2013,505716836,11/16/2013,1705,437.20,263.33,745426.

00,448977.65,296448.35

Central America and the

Caribbean,Belize,Clothes,Offline,M,7/25/2016,807025039,9/7/2016,5498,109.28,35.84,600821.44,19

7048.32,403773.12

Europe,Lithuania,Office

Supplies,Offline,H,10/24/2010,166460740,11/17/2010,8287,651.21,524.96,5396577.27,4350343.52,10

46233.75

Asia,Turkmenistan,Office

Supplies,Online,M,4/23/2013,462405812,5/20/2013,5010,651.21,524.96,3262562.10,2630049.60,63251

2.50

Middle East and North

Africa,Libya,Fruits,Online,L,8/14/2015,816200339,9/30/2015,673,9.33,6.92,6279.09,4657.16,1621.

93

Sub-Saharan

Africa,Djibouti,Cereal,Online,H,5/20/2017,555990016,6/17/2017,8656,205.70,117.11,1780539.20,10

13704.16,766835.04

Middle East and North

Africa,Pakistan,Cosmetics,Offline,L,7/5/2013,231145322,8/16/2013,9892,437.20,263.33,4324782.40

,2604860.36,1719922.04

North

America,Mexico,Household,Offline,C,11/6/2014,986435210,12/12/2014,6954,668.27,502.54,4647149.5

8,3494663.16,1152486.42

Australia and Oceania,Federated States of

Micronesia,Beverages,Online,C,10/28/2014,217221009,11/15/2014,9379,47.45,31.79,445033.55,29815

8.41,146875.14

Australia and

Oceania,Samoa,Cosmetics,Online,H,7/20/2013,670854651,8/7/2013,9654,437.20,263.33,4220728.80,25

42187.82,1678540.98

Europe,Spain,Household,Offline,L,10/21/2012,213487374,11/30/2012,4513,668.27,502.54,3015902.51

,2267963.02,747939.49

Middle East and North

Africa,Lebanon,Clothes,Online,L,9/18/2012,663110148,10/8/2012,7884,109.28,35.84,861563.52,2825

62.56,579000.96

Sub-Saharan

Africa,Kenya,Vegetables,Online,L,3/18/2012,827844560,4/7/2012,6457,154.06,90.93,994765.42,5871

35.01,407630.41

North America,Mexico,Personal

Care,Offline,L,2/17/2012,430915820,3/20/2012,6422,81.73,56.67,524870.06,363934.74,160935.32

Australia and

Oceania,Australia,Beverages,Offline,H,7/7/2014,240470397,7/11/2014,9389,47.45,31.79,445508.05,

298476.31,147031.74

North America,Mexico,Personal

Care,Offline,M,7/30/2015,559427106,8/8/2015,5767,81.73,56.67,471336.91,326815.89,144521.02

Sub-Saharan
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Africa,Mozambique,Household,Offline,L,2/10/2012,665095412,2/15/2012,5367,668.27,502.54,3586605

.09,2697132.18,889472.91

];

Dimensions
Dimensionen legen fest, wie die Daten in einer Visualisierung gruppiert werden.
Beispiel: Gesamtumsatz pro Land oder Anzahl der Produkte pro Anbieter You typically
find a dimension as the slices in a pie chart or on the x-axis of a bar chart with vertical
bars.

Dimensions are created from fields in the data model tables.

Beispiel:

Product Type is a field in the Product table that is loaded into the app. The values of this field are
the different types that products are grouped into.

You can, for example, create a bar chart to visualize the cost of each type, by adding the Product
Type dimension to the chart. To complete the visualization, you must add a measure (in this case
Cost), which is grouped by the Product Type dimension.

Bar chart with the dimension Product Type and measure Cost.

You can also create different types of master dimensions:

l Drilldown-Gruppen (page 102)
l Cyclic dimensions (page 104)
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Creating dimensions
When you load data into an app, all data is loaded as fields. At the same time, Qlik Sense identifies
the fields from the data model that can be used as dimensions. These are shown to you as you
populate visualizations with data or create master items.

The process of creating a dimension depends on whether you want to customize how data is
grouped. Follow these guidelines:

l To simply use a certain field to group data in your visualization, add the field as a dimension
when you create the visualization. No additional configuration is needed.

l Create a master dimension in the app if you want to:
l Create a standalone entity in the app that is easily recognized as a useful way to group

data.
l Enhance and expand how the dimension fields group data. For example, you can

create a drill-down or cyclic dimension for specific behavior, or set a specific color for
the dimension.

l Allow re-use of the dimension across the app, including by others.
After creating the master dimension, it can be added to any applicable charts as you
configure them.
Reusing dimensions with master dimensions (page 121)

Feldergruppen als Dimensionen
Ein Vorteil von Qlik Sense im Vergleich zu vielen anderen Datenbank-Viewer-Tools und OLAP-
Systemen besteht darin, dass bei Qlik Sense hierarchische Strukturen nicht schon in den zugrunde
liegenden Datenquellen definiert werden müssen. Die einzigartige interne Logik von Qlik Sense
lässt Ihnen alle Freiheiten, auf jedes Feld als volle Dimension und in gewünschter Reihenfolge
zuzugreifen.

Für die meisten Zwecke reicht die integrierte Funktionalität vollkommen aus. In einigen Fällen ist
eine vordefinierte Hierarchie jedoch nützlich, Daten effizienter darzustellen. In Qlik Sense können
Sie dazu Hierarchiegruppen bestehend aus Feldern als Drilldown-Dimensionen definieren.

Es können beliebige Felder oder dynamische Dimensionen zu Gruppen zusammengefasst werden.

Drilldown-Gruppen
Wenn mehrere Felder eine inhaltliche Hierarchie bilden, bietet sich die hierarchische
Gruppe, auch Drilldown-Gruppe genannt, an.

Example 1:

Organization: Company, Department, Employee

Example 2:

Geography: Continent, Country, State, City
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Wird eine Drilldown-Gruppe als Dimension in einem Diagramm benutzt, zeigt das Diagramm die
Werte für das erste Feld in der Gruppe an, das mehr als einen wählbaren Wert enthält. Bleibt durch
die aktuelle Auswahl von Werten nur noch ein wählbarer Wert in diesem Feld, wird automatisch das
nächste Feld der Gruppe benutzt, sofern es mehr als einen wählbaren Wert enthält. Enthält kein
Feld der Gruppe mehr als einen wählbaren Wert, wird das letzte Feld benutzt.

In dem ersten Beispiel oben wird demnach solange Company als Dimension benutzt, bis durch
entsprechende Auswahl von Daten nur noch ein Unternehmen in Frage kommt. Daraufhin dient das
Feld Department als Dimension. Ist nur noch eine Abteilung ausgewählt, zeigt das Diagramm die
Werte der Formel pro Employee an.

Werden durch Aufhebung einer Auswahl wieder mehrere Werte eines höher in der Hierarchie
stehenden Feldes wählbar, ändert sich die Anzeige des Diagramms wiederum automatisch und
dieses Feld wird als Dimension benutzt.

Drillup
Die Drillup-Funktion ist in Balkendiagrammen, Kreisdiagrammen und Liniendiagrammen verfügbar.
Andere Visualisierungen spiegeln die Änderungen in den Diagrammen wider, können jedoch nicht
als Drillup-Funktionen für verschiedene Dimensionen verwendet werden. Wenn Sie die Drilldown-
Funktion in einer Dimensionsgruppe anwenden, verweisen Breadcrumbs zurück auf die vorherigen
Dimensionen. Klicken Sie auf die Dimension, auf die Sie die Drillup-Funktion anwenden möchten.

Im folgenden Balkendiagramm ermöglichen die Breadcrumbs Year > Quarter > Month die Drillup-
Funktion.
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Cyclic dimensions
Group non-hierarchical fields together as a master dimension so they can be cycled
through in a visualization.

Cyclic dimensions allow users to quickly change between fields displayed as dimensions in
visualizations. Users can cycle through the fields in the cyclic dimension using a button. Unlike drill-
down dimensions, fields grouped in a cyclic dimension do not need a hierarchical relationship. Their
only relationship is that they are all of interest with similar measures in a chart.

When a cyclic dimension is used as a visualization dimension, the visualization will use the first
dimension in the list. Users can switch to the next dimension in the order they appear in the cyclic
dimension's list. If you are using a cyclic dimension in multiple visualizations, all the fields in each
visualization using the cyclic dimension will change when you switch to the next field.

You can switch dimension by:

l Clicking in the visualization.
You can also select a specific field from the cyclic dimension by clicking on the field name
label in the axis.

l Clicking a button with the action Step cyclic dimension.
For more information, see Button (page 401).
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Chart using a cyclic dimension

Limitations
Cyclic dimensions have the following limitations:

l The cycle button ( ) is only available in the following visualizations:
l Bar charts
l Bullet charts
l Combo charts
l Grid charts
l Line charts
l Pie charts

l Qlik Sense Mobile has the following limitations with cyclic dimensions:
l Buttons with the action Step cyclic dimension will only cycle dimension if the button

is in a container.
l In offline mode, buttons with the action Step cyclic dimension do not cycle the

dimension.
l In offline mode, any visualization with a cyclic dimension will only display the first

dimension in the cycle. The cyclic dimension cannot be cycled.
l Custom objects may not work with cyclic dimensions.
l Cyclic dimensions are not supported with the following Qlik Dashboard bundle objects:
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l Date picker
l Line
l Text
l Variable input
l Video player

l Cyclic dimensions are not supported with the following Qlik Visualization bundle objects:
l Trellis container

l Cyclic dimensions do not support assigning colors to dimension values
l In the storytelling view, while snapshots display correctly, clicking Go to source will not

apply the cyclic dimension state from the snapshot.
l If a field is removed from the data model but not from a cyclic dimension, the cyclic

dimension will continue to work until it steps to the removed field.

Dynamische Dimensionen
Sie können anhand von Formeln dynamische Dimensionen erstellen. Eine dynamische
Dimension besteht aus einer Formel mit einem oder mehreren Feldern. Alle
Standardfunktionen dürfen verwendet werden.

Aus Performancegründen empfehlen wir, alle Berechnungen im Dateneditor
durchzuführen. Wenn Dimensionen im Diagramm berechnet werden, berechnet Qlik
Sense zunächst die Dimensionswerte und aggregiert dann die Kennzahlen für diese
berechneten Werte. Dies beeinträchtigt die Performance mehr als Berechnungen im
Ladeskript.

In einigen Fällen sind dynamische Dimensionen sehr nützlich zur Datenanalyse: Wenn Sie
beispielsweise die Dimensionswerte während einer Analyse berechnen möchten und die
Dimensionswerte von diesen Auswahlen abhängen.

Dynamische Dimensionen sind auch nützlich, wenn Sie ein Feld modifizieren möchten.

Sobald Sie eine dynamische Dimension erstellt haben, können Sie sie wie jede andere Dimension
verwenden.

Beispiel:

Angenommen Sie haben ein Feld namens Calendar Month, das jeden Monat im Jahr enthält. In Ihrer
App möchten Sie eine Tabelle einfügen, die den Umsatz für jeden der ersten 6 Monate im Jahr
zeigt. Die verbleibenden Monate möchten Sie als Gesamtsumme darstellen. Sie können eine Formel
verwenden, um diese dynamische Dimensionen zu erstellen.

Syntax:
If ([Calendar Month] <7, [Calendar Month], 'Rest')
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Kennzahlen
Bei Kennzahlen handelt es sich um in Visualisierungen verwendete Berechnungen, die
normalerweise auf der Y-Achse eines Balkendiagramms oder in einer Tabellenspalte
dargestellt werden. Kennzahlen werden aus einer Formel berechnet, die sich aus
Aggregierungsfunktionen wie beispielsweise Sum oder Max zusammensetzt und mit
einem oder mehreren Feldern kombiniert wird.

Eine Kennzahl muss eine Bezeichnung haben und kann auch mit weiteren Daten wie einer
Beschreibung und Tags versehen werden.

Beispiel:

Sie können beispielsweise ein Balkendiagramm generieren, um die Kosten jedes Typs anzuzeigen,
indem Sie zum Diagramm die Dimension Product Type und die Kennzahl Cost hinzufügen. Letztere
wird aus der Formel Sum(Cost) erstellt, die das Ergebnis der Berechnung der
Aggregierungsfunktion Sum über das Feld Cost ist. Die Ergebnisse werden mithilfe der Dimension
Product Type gruppiert.

Balkendiagramm mit der Dimension „Produkttyp“ und der Kennzahl „Kosten“.

Erstellen von Kennzahlen
Wenn Sie Daten in eine App laden, werden alle Daten als Felder geladen. Wenn Sie eine Kennzahl zu
einem Diagramm hinzufügen oder eine Master-Kennzahl erstellen, können diese Felder in
Aggregierungen verwendet werden, um bestimmte Berechnungen durchzuführen.

Das Erstellen einer Kennzahl hängt davon ab, ob Sie eine bestimmte Berechnung anpassen oder
standardisieren möchten. Folgen Sie diesen Richtlinien:
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l Um einfach eine Berechnung zu einem Diagramm hinzuzufügen, geben Sie bei der
Konfiguration des Diagramms die Formel für die Kennzahl ein. Es ist keine zusätzliche
Konfiguration erforderlich.

l Erstellen Sie eine Master-Kennzahl in der App, wenn Sie Folgendes vorhaben:
l Erstellen einer eigenständigen, leicht zu erkennenden Entität in der App für nützliche

Berechnungen.
l Verbessern und Erweitern der Definitionen einer Berechnung. Sie können zum Beispiel

Farben und Bezeichnungsformeln definieren, damit sie immer hinzugefügt werden,
wenn die Kennzahl verwendet wird, anstatt diese Eigenschaften in jeder Instanz
separat zu konfigurieren.

l Zulassen einer zentrale Definition einer Kennzahl, so dass sich eine Änderung der
zentralen Definition über die App auf alle Objekte auswirkt, in denen die Kennzahl
referenziert wird.

l Zulassen der Wiederverwendung der Kennzahl in der gesamten App, auch durch
andere.

Nach dem Erstellen der Master-Kennzahl kann diese zu allen anwendbaren Diagrammen
hinzugefügt werden, wenn Sie sie konfigurieren.
Reusing measures with master measures (page 128)

Modifiers
Measures are calculations based on fields, for example Sum(Cost). You can use
modifiers to change how the measure is calculated over the available dimensions.

For example, you can have the values of a measure accumulate over one or two dimensions, or you
can calculate the average of your measure over a specific number of steps.

For information about how to apply a modifier to measure, see Applying a measure modifier (page
629).

Which visualizations have modifiers

Visualization Accumulation Difference
Moving
average

Relative
numbers

Bar chart Yes Yes Yes Yes

Combo chart Yes Yes Yes Yes

Line chart Yes Yes Yes Yes

Table Yes Yes Yes Yes

Straight table (Visualization
bundle)

Yes Yes Yes Yes

Visualizations comparison
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Accumulation
The accumulation modifier allows you to accumulate the values of a measure over one or two
dimensions. Accumulating values makes it easy to visualize how the effect of the measure builds up
over a dimension.

In the following combo chart, the bars and lines accumulate over time.

A combo chart where the line shows the accumulated profit margin and the bars show the accumulated
sales figures.

Syntax:
RangeSum(Above {$M,0,Steps})

Difference
The difference modifier allows you to visualize the difference between consecutive values of a
measure over one or two dimensions. The difference modifier is useful when you want to visualize
the change in direction of grouped data.

In the following bar chart, any drops in yearly profits over a 10 year period appear as negative bars.
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A bar chart showing the profit differences from one year to the next.

Syntax:
$M - Above($M)

Moving average
The moving average modifier allows you to see the average values of a measure over a specific
period. You can use it to filter out the action from short-term value fluctuations. You can change the
number of steps over which the averaging takes place, depending on how strongly you want your
modifier to follow the changes in your data. A moving average is commonly used with time series
data to highlight longer-term trends or cycles.
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In the following line chart moving averages with two difference ranges are shown, one with a 20
step range, and one with a full range.

A line chart showing the price of a product over a five month period.

Syntax:
RangeAvg(Above ($M,0,Steps))
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Relative numbers
The relative numbers modifier allows you to see relative percentages. You can use it to see the
impact of specific selections, relative to the selection, relative to the total, or relative to other fields.
You can change the basis upon which the relative number is calculated.

In the following table a column with sales of each year of a specific selection, and three columns
with relative numbers are shown, one relative to current selection, one relative to total sales for all
years, and one relative to the sales of each year.

A table showing different sales percentages relative to current selection, relative to total sales, and relative
to each year's sales.

The following is an example of the syntax of the modifier relative to the total selection.

Syntax:
$M / Sum( total Aggr( $M, dim ) )

Trendlinien
Eine Trendlinie ist eine visuelle Darstellung der Richtung von Werten über einen
Zeitraum hinweg. Trendlinien zeigen Trends über Zeitintervalle, indem die Richtung von
Werten und die Geschwindigkeit der Wertänderung visualisiert wird.

Weitere Informationen zum Erstellen von Trendlinien finden Sie unter Adding trend lines to
visualizations (page 622).
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Welche Visualisierungen haben Trendlinien

Visualization Trend lines

Bar chart Yes

Line chart Yes

Wann werden Trendlinien verwendet
Eine einzelne Trendlinie kann zu einem Diagramm hinzugefügt werden, um Fluktuationen in Daten
zu glätten und etwaige Trends klarer aufzuzeigen.

Einem Diagramm kann mehr als eine Trendlinie hinzugefügt werden, um verschiedene Trendtypen
oder verschiedene Werte zu zeigen.

Typen von Trendlinien

Durchschnitt
Eine Durchschnitts-Trendlinie zeigt den Durchschnittswert der Daten für den analysierten Zeitraum.
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Ein Balkendiagramm, das den Umsatz pro Monat anzeigt. Eine Durchschnitts-Trendlinie wird als gestrichelte
rote Linie dargestellt.

Linear
Eine lineare Trendlinie zeigt die Zu- oder Abnahme von Werten bei gleichbleibender
Geschwindigkeit. Lineare Trendlinien werden in der Regel mit einfachen linearen Datensätzen
verwendet.
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Ein Balkendiagramm, das den Umsatz pro Monat anzeigt. Eine lineare Trendlinie wird als gestrichelte rote
Linie dargestellt.

Polynom (zweiten, dritten, vierten Grades)
Eine Polynom-Trendlinie ist eine Kurvenlinie, die für fluktuierende Daten verwendet wird.

Die Zahl der Datenfluktuationen kann den Grad des Polynoms bestimmen. Eine Trendlinie für ein
Polynom zweiten Grades hat einen Hoch- oder Tiefpunkt, eine Trendlinie für ein Polynom dritten
Grades bis zu zwei Hoch- oder Tiefpunkte, und ein Polynom vierten Grades bis zu drei Hoch- oder
Tiefpunkte.
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Ein Balkendiagramm, das den Umsatz pro Monat anzeigt. Trendlinien für Polynome zweiten, dritten oder
vierten Grades werden mit gestrichelten roten, gelben bzw. grünen Linien angezeigt.

Exponentiell
Eine exponentielle Trendlinie ist eine Kurvenlinie, die verwendet wird, wenn Datenwerte in immer
höherer Geschwindigkeit steigen oder fallen.
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Ein Balkendiagramm, das den Umsatz pro Monat anzeigt. Eine exponentielle Trendlinie wird als gestrichelte
rote Linie dargestellt.

Logarithmisch
Eine logarithmische Trendlinie ist eine Kurvenlinie, die verwendet wird, wenn die Geschwindigkeit
der Datenänderung schnell steigt oder abfällt, bevor sie gleichmäßiger wird.
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Ein Balkendiagramm, das den Umsatz pro Monat anzeigt. Eine logarithmische Trendlinie wird als
gestrichelte rote Linie dargestellt.

Potenz
Eine Potenz-Trendlinie ist eine gekrümmte Linie. Sie wird für Datensätze verwendet, die
Kennzahlen vergleichen, die sich in bestimmten Raten erhöhen.
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Ein Balkendiagramm, das den Umsatz pro Monat anzeigt. Eine Potenz-Trendlinie wird als gestrichelte rote
Linie dargestellt.

Reusing assets with master items
When you create and build your visualizations, you can save assets to reuse in other visualizations
and on other sheets. You can save visualizations, dimensions, and measures as master items in the
assets panel. When your app gets published these master items will be available to others as ready-
to-use visualizations, dimensions, and measures.

Any updates you make to the master item are applied everywhere the master item is used. For
example, you could use a master measure in as many of your visualizations as you like while only
having to update it in a single instance to update all instances of the measure in your visualizations.

One of the purposes with creating and maintaining master items is for other users to explore their
own ways and directions in the data, on top of what you have provided in the app as pre-made
sheets with visualizations. The users will be able to create their own visualizations with your pre-
made master dimensions and master measures, for example.

Reusing dimensions with master dimensions (page 121)

Reusing measures with master measures (page 128)

Reusing visualizations with a master visualization (page 120)
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Reusing visualizations with a master visualization
You can create a master visualization to be able to reuse it. Users of a published app
will have access to the master visualization but will not be able to modify them.

You can only create master visualizations when you are working with an unpublished
app. Visualizations with Chart suggestions enabled cannot be made into a master
visualization.

Gehen Sie folgendermaßen vor:

1. While editing a sheet, drag a visualization from the sheet to the master items.
If you have given the visualization a title, this is automatically added as the name of the
master visualization.

2. Add a name, or change the name if you want to.
3. Type a description for the visualization (optional).
4. Tags hinzufügen (optional).
5. Click Add.

The visualization is now saved to the master items tab.

You can also add a visualization to the master items by right-clicking it on the sheet, and
selecting Add to master items.

Editing a master visualization
When you update a visualization in the master items, the changes will be reflected in all instances of
the master visualization.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Click Master items in the assets panel.

3. Click the visualization that you want to edit.
Die Vorschau wird angezeigt.

4. Klicken Sie unten in der Vorschau auf .

If the visualization is used on a sheet, a dialog is displayed to inform you that any changes to
the master visualization will be applied to all its instances on the sheets.

5. Klicken Sie auf OK.
The visualization opens for editing.
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Sie können auch mit der rechten Maustaste auf das Master-Element und dann auf
Bearbeiten klicken.

6. Make the changes you want, and click Done in the upper right corner of the visualization to
finish editing.

The visualization is updated and reflected in all its instances.

You can also edit a master visualization by selecting a linked visualization on a sheet,
and clicking Edit in the properties panel. You must be in sheet edit mode.

Reusing dimensions with master dimensions
Wenn Sie mit einer nicht veröffentlichten App arbeiten, können Sie Master-
Dimensionen erstellen, die wiederverwendet werden können. Benutzer einer
veröffentlichten App haben Zugriff auf die Master-Dimensionen, können diese jedoch
nicht bearbeiten.

You can create a master dimension in different ways.

You can also create drill-down groups and cyclic dimensions:

l Creating a drill-down dimension (page 123)
l Creating a cyclic dimension (page 124)

Creating a master dimension from a field
Wenn Sie mit einer nicht veröffentlichten App arbeiten, können Sie Master-
Dimensionen erstellen, die wiederverwendet werden können. You can create a master
dimension from the Fields section of the assets panel.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Click Fields in the assets panel.

3. Click the field you want to use to create a dimension.
Die Vorschau wird angezeigt.

4. Click at the bottom of the preview.
The Create new dimensions dialog opens with the field you selected. The field name is also
used as the name of the dimension.

5. Select if the dimension is to be single, cyclic, or drill-down.
6. Edit the name if you want to.
7. Geben Sie eine Beschreibung für die Dimension ein (optional).
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8. If you want to specify a color, click in the color drop down and select a color through one
of the following methods:

l Click one of the colors in the palette.
l Type a 6 character color code in the Hex input field: #.
l Click at the bottom of the dialog, select a color in the color wheel, and optionally

adjust the saturation slider.
9. Tags hinzufügen (optional).

10. Klicken Sie auf Erstellen.
11. Click Close.

The dimension is now saved in the Dimensions category in the master items, and you can use it in
visualizations.

Sie können schnell verschiedene Dimensionen als Master-Elemente hinzufügen, indem
Sie nach dem Hinzufügen der einzelnen Dimensionen auf Dimension hinzufügen
klicken. Klicken Sie auf Erledigt wenn Sie fertig sind.

Direct Discovery-Felder werden im Extras-Fenster im Abschnitt Felder durch
gekennzeichnet.

Creating a master dimension from the assets panel

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Click Master items in the assets panel.

3. Click the Dimensions heading to expand the category.
4. Klicken Sie auf Neu erstellen.

The Create new dimensions dialog opens.
5. Select if the dimension is to be single, cyclic, or drill-down.
6. Click a field on the left-hand side to select it.

The name of the field is automatically added as the name of the dimension.
7. Change the name if you want to.
8. Geben Sie eine Beschreibung für die Dimension ein (optional).

9. If you want to specify a color, click in the color drop down and select a color through one
of the following methods:

l Click one of the colors in the palette.
l Type a 6 character color code in the Hex input field: #.
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l Click at the bottom of the dialog, select a color in the color wheel, and optionally
adjust the saturation slider.

10. Tags hinzufügen (optional).
11. Klicken Sie auf Erstellen.
12. Click Close.

The dimension is now saved in the Dimensions category in the master items, and you can use it in
visualizations.

Sie können schnell verschiedene Dimensionen als Master-Elemente hinzufügen, indem
Sie nach dem Hinzufügen der einzelnen Dimensionen auf Dimension hinzufügen
klicken. Klicken Sie auf Erledigt wenn Sie fertig sind.

Creating a drill-down dimension
When adding a dimension, you can select between creating a single or a drill-down
dimension.

The following description explains how to create a drill-down group from the Create new
dimensions dialog.

Wenn Auswahlen bewirken, dass das aktuelle Drilldown-Dimensionsfeld nur einen
möglichen Wert enthält, wird stattdessen das nächste Feld in der Liste verwendet.

Gehen Sie folgendermaßen vor:

1. Select Drill-down as dimension type.
2. Click at least two fields from the fields list on the left-hand side to insert them as the

referenced fields.

You can filter which table to select fields from in the drop-down list.

You can rearrange the order of the fields you have selected by dragging them to
new positions in the list of selected fields.

3. Optionally, add labels for the fields added to your drill-down dimension.
Click in Label to add an expression for the label. The expression must start with =.

4. Geben Sie einen Namen für die Dimension ein.
5. Geben Sie eine Beschreibung für die Dimension ein (optional).

6. If you want to specify a color, click in the color drop down and select a color through one
of the following methods:
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l Click one of the colors in the palette.
l Type a 6 character color code in the Hex input field: #.
l Click at the bottom of the dialog, select a color in the color wheel, and optionally

adjust the saturation slider.
7. Tags hinzufügen (optional).
8. Klicken Sie auf Erstellen.
9. Click Close.

The drill-down dimension is now saved in the Dimensions category among the master items.

When you click the dimension in the panel on the left-hand side, the preview displays the dimension
type and which fields are included in the drill-down dimension.

The preview displays the dimension type and which fields are included in the drill-down dimension.

Creating a cyclic dimension
When adding a dimension, you can select between creating a single, drill-down, or
cyclic dimension.

The following description explains how to create a cyclic dimension from the Create new
dimensions dialog.
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Gehen Sie folgendermaßen vor:

1. Select Cyclic as dimension type.
2. Click at least two fields from the fields list on the left-hand side to insert them as the

referenced fields.

You can filter which table to select fields from in the drop-down list.

You can rearrange the order of the fields you have selected by dragging them to
new positions in the list of selected fields.

3. Optionally, add labels for the fields added to your cyclic dimension.
Click in Label to add an expression for the label. The expression must start with =.

4. Geben Sie einen Namen für die Dimension ein.
5. Geben Sie eine Beschreibung für die Dimension ein (optional).

6. If you want to specify a color, click in the color drop down and select a color through one
of the following methods:

l Click one of the colors in the palette.
l Type a 6 character color code in the Hex input field: #.
l Click at the bottom of the dialog, select a color in the color wheel, and optionally

adjust the saturation slider.
7. Tags hinzufügen (optional).
8. Klicken Sie auf Erstellen.
9. Click Close.

Creating a calculated dimension
You can create a calculated dimension from the Master items tab in the assets panel.
The expression editor opens from the Create new dimensions dialog.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Click Master items in the assets panel.

3. Click the Dimensions heading on the Master items tab to expand the category.
4. Klicken Sie auf Neu erstellen.

The Create new dimensions dialog opens.

5. Click in the Field text box to open the Add expression dialog.
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You will now be able to add expressions in different ways, depending on you preferences and of
different levels of complexity.

You can also add an expression by typing directly into the Field text box , but you will
then not be provided with syntax highlighting and syntax check.

Using a common function
1. Select a field from the drop-down list.
2. Click the aggregation function you want to use.
3. Click Insert to insert the function and the field into the expression editor.

You can insert just a function or just a field by selecting only one of them.

4. Klicken Sie auf Übernehmen, um den Dialog Neue Formel zu schließen.
Continue by adding the descriptive data for the dimension.

Adding an expression by typing
1. Type the expression directly in the expression editor.

The field names you use in the expression are checked, and the syntax of the expression is
validated.

As you type in the expression editor, the expression is validated continuously. If
there is an error, you see a hint about what is incorrect. Additional error
information may be available by clicking the icon next to the hint.

Each line in the expression editor is numbered and syntax highlighting is used.
2. Klicken Sie auf Übernehmen, um den Dialog Neue Formel zu schließen.

For a measure, you continue by adding the descriptive data for the measure.

Adding an expression through the properties panel
You can add an expression to a visualization through the properties panel.

1. Open the sheet with the visualization that you want to edit.

2. Click Edit sheet to open the properties panel. (If it is hidden, click Show properties in
the lower right-hand corner to open it.)

3. Click the visualization that you want to edit.
The properties panel for that visualization is displayed on the right-hand side.

4. Under Data, click Add data and select Dimension.
A dimension text box is displayed.

5. Type your expression. The expression must begin with an equals sign (=), otherwise the
string will be interpreted as text.
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Detailed syntax help
You can open the online help with the full description of how to use the current function by double-
clicking the function name in the expression editor and pressing Ctrl+H on the keyboard. This
feature becomes available after having entered the first parenthesis of the expression after the
function name.

This feature is supported only when using a computer with a keyboard.

Adding the descriptive data for the dimension
After having entered the expression, you need to add some descriptive information.

1. Geben Sie einen Namen für die Dimension ein.
2. Geben Sie eine Beschreibung für die Dimension ein (optional).

3. Optionally, click in the color drop down and select a color through one of the following
methods:

l Click one of the colors in the palette.
l Type a 6 character color code in the Hex input field: #.
l Click at the bottom of the dialog, select a color in the color wheel, and optionally

adjust the saturation slider.
4. Tags hinzufügen (optional).
5. Klicken Sie auf Erstellen.
6. Click Close.

The calculated dimension is now saved in the Dimensions category of the Master items, and you
can use it in visualizations.

Editing a master dimension
Bei der Aktualisierung einer Master-Dimension werden die Änderungen für alle Instanzen
übernommen, einschließlich der Visualisierungen, welche die Dimension verwenden.

Edit a master dimension from the assets panel or while editing visualization properties.

Editing a master dimension from the assets panel
Use the assets panel to edit a master dimension when you want to preview the dimension or edit
several master dimensions

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Click Master items in the assets panel.

3. Click the Dimensions heading on the Master items tab to expand the category.
4. Click the dimension that you want to edit.

Die Vorschau wird angezeigt.
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5. Klicken Sie unten in der Vorschau auf .
If the dimension is used on a sheet, a dialog is displayed to inform you that any changes to
the master dimension will be applied to all its instances on the sheets.

6. Klicken Sie auf OK.
The Edit dimension dialog opens, where you update the field or expression, name,
description and tags.

7. Klicken Sie auf Speichern.

The master dimension is now updated.

Sie können auch mit der rechten Maustaste auf das Master-Element und dann auf
Bearbeiten klicken.

Editing a master dimension from visualization properties
When a dimension in a visualization is linked to a master dimension, you can edit the master
dimension from the properties panel. All visualizations in the app that use the master dimension will
be updated. To edit a linked dimension only in this visualization, without affecting the master item,
you must first unlink it from the master. See Die Verlinkung zu einem Master-Element trennen (page
156).

Gehen Sie folgendermaßen vor:

1. In edit mode, select the visualization.
2. In the properties panel, click the Data tab.

Wenn es ausgeblendet ist, klicken Sie unten rechts auf Eigenschaften anzeigen .

3. Under Dimensions, click the linked dimension to edit.
4. Under Master item, click Edit.

A dialog is displayed to inform you that any changes to the master dimension will be applied
to all visualization that use the dimension.

5. Make your changes to the master dimension, and then click Save.

Reusing measures with master measures
Wenn Sie mit einer nicht veröffentlichten App arbeiten, können Sie Master-Kennzahlen
erstellen, die wiederverwendet werden können. Benutzer einer veröffentlichten App
haben Zugriff auf die Master-Kennzahlen, können diese jedoch nicht bearbeiten.

A master measure is a combination of an expression and descriptive data, such as name,
description and tags. You can create a master measure in different ways.

You can also create a master measure based on a measure created in a visualization. Under the
measure in the properties panel of a visualization, click Add new under Master items.
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Master measure formatting
Zahlenformatierung, Farbe und Beschriftung können für eine Master-Kennzahl konfiguriert werden.
Diese Eigenschaften werden nicht auf eine Visualisierung angewendet, wenn Sie die Master-
Kennzahl mithilfe einer Formel referenzieren. Um diese Eigenschaften in einer Visualisierung
anzuwenden, erstellen Sie einen direkten Link zu der Master-Kennzahl, wenn Sie die Visualisierung
konfigurieren.

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster Daten > Kennzahlen.
2. Klicken Sie auf Hinzufügen.
3. Wählen Sie im Dropdown-Menü unter Kennzahlen die Master-Kennzahl aus.

Jetzt wird ein direkter Link zur Master-Kennzahl erstellt.

Creating a master measure from a field
Wenn Sie mit einer nicht veröffentlichten App arbeiten, können Sie Master-Kennzahlen
erstellen, die wiederverwendet werden können. You can create a master measure from
the Fields section of the assets panel.

Wenn Sie ein Element benennen, müssen Sie vermeiden, den gleichen Namen mehr als einem Feld,
einer Variablen oder einer Kennzahl zuzuweisen. Beim Auflösen von Konflikten zwischen Elementen
mit identischen Namen wird eine strikte Reihenfolge eingehalten. Diese Reihenfolge gilt auch bei
allen Objekten oder Kontexten, in denen diese Elemente verwendet werden. Diese Reihenfolge
lautet wie folgt:

l Innerhalb einer Aggregierung hat ein Feld Vorrang vor einer Variablen.
Kennzahlbezeichnungen sind in Aggregierungen nicht relevant und haben keine Priorität.

l Außerhalb einer Aggregierung hat eine Kennzahlbezeichnung Vorrang vor einer Variablen,
die wiederum Vorrang vor einem Feldnamen hat.

l Zudem kann außerhalb einer Aggregierung eine Kennzahl wiederverwendet werden, indem
ihre Bezeichnung referenziert wird, es sei denn, es handelt sich um eine berechnete
Bezeichnung. In dieser Situation reduziert sich die Bedeutung der Kennzahl, um das Risiko
eines Selbstbezugs zu verringern, und in diesem Fall wird der Name immer zuerst als
Kennzahlbezeichnung interpretiert, an zweiter Stelle als Feldname und an dritter Stelle als
Variablenname.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Click Fields in the assets panel.

3. Click the field you want to use to create a measure.
Die Vorschau wird angezeigt.

4. Click at the bottom of the preview.
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The Create new measure dialog opens with the field you selected as the name of the
measure and as a part of the expression.

5. Right-click the field you want to use as a measure and click Create measure.
The Create new measure dialog opens with the field you selected. The field name is also
used as the name of the measure.

6. Click in the Expression field to open the Edit expression dialog.

7. Type the expression directly in the expression editor (the main window).
The field names you use in the expression are checked, and the syntax of the expression is
validated.

As you type in the expression editor, the expression is validated continuously. If
there is an error, you see a hint about what is incorrect in the lower left-hand
corner. Additional error information may be available by clicking the icon next to
the hint.

Each line in the expression editor is numbered and syntax highlighting is used.

You can open the online help with the full description of how to use the current
function by double-clicking the function name in the expression editor and
pressing Ctrl+H on the keyboard. This feature becomes available after having
entered the first parenthesis of the expression after the function name, and only
when using a computer with a keyboard.

8. Klicken Sie auf Übernehmen, um den Dialog Neue Formel zu schließen.
Now you need to add some descriptive data for the measure.

9. Edit the name if you want to.
10. Geben Sie eine Beschreibung für die Kennzahl ein (optional).

11. If you want to specify a color, click in the color drop down and select a color through one
of the following methods:

l Click one of the colors in the palette.
l Type a 6 character color code in the Hex input field.
l Click at the bottom of the dialog, select a color in the color wheel, and optionally

adjust the saturation slider.
12. Tags hinzufügen (optional).
13. Unter Zahlenformat können Sie folgende Optionen auswählen:

l Auto:
l Zahl
l Money
l Datum
l Dauer
l Benutzerdefiniert
l Kennzahlformel
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14. Klicken Sie auf Erstellen.

The measure is now saved in the Measures category in the master items, and you can use it in
visualizations.

Direct Discovery-Felder werden im Extras-Fenster im Abschnitt Felder durch
gekennzeichnet.

Creating a master measure with a common aggregation function
Wenn Sie mit einer nicht veröffentlichten App arbeiten, können Sie Master-Kennzahlen
erstellen, die wiederverwendet werden können. You can easily create a measure using
one of the most common aggregation functions by selecting the function and the field
from drop-down lists.

Wenn Sie ein Element benennen, müssen Sie vermeiden, den gleichen Namen mehr als einem Feld,
einer Variablen oder einer Kennzahl zuzuweisen. Beim Auflösen von Konflikten zwischen Elementen
mit identischen Namen wird eine strikte Reihenfolge eingehalten. Diese Reihenfolge gilt auch bei
allen Objekten oder Kontexten, in denen diese Elemente verwendet werden. Diese Reihenfolge
lautet wie folgt:

l Innerhalb einer Aggregierung hat ein Feld Vorrang vor einer Variablen.
Kennzahlbezeichnungen sind in Aggregierungen nicht relevant und haben keine Priorität.

l Außerhalb einer Aggregierung hat eine Kennzahlbezeichnung Vorrang vor einer Variablen,
die wiederum Vorrang vor einem Feldnamen hat.

l Zudem kann außerhalb einer Aggregierung eine Kennzahl wiederverwendet werden, indem
ihre Bezeichnung referenziert wird, es sei denn, es handelt sich um eine berechnete
Bezeichnung. In dieser Situation reduziert sich die Bedeutung der Kennzahl, um das Risiko
eines Selbstbezugs zu verringern, und in diesem Fall wird der Name immer zuerst als
Kennzahlbezeichnung interpretiert, an zweiter Stelle als Feldname und an dritter Stelle als
Variablenname.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Click Master items in the assets panel.

3. Click the Measures heading to expand that category.
4. Klicken Sie auf Neu erstellen.

The Create new measure dialog opens.

5. Click in the Expression field to open the Add expression dialog.
You find drop-down lists for selecting a field and a common function on the right-hand side.

6. If you want to show fields from a particular table, select this table in the top drop-down list
(optional).
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7. Select a field from the Field drop-down list.
8. Select a function from the bottom drop-down list.

You can insert just a field by not selecting a function.

9. Click Insert to insert the field and the function into the expression editor.

You can open the online help with the full description of how to use the current
function by double-clicking the function name in the expression editor and
pressing Ctrl+H on the keyboard. This feature becomes available after having
entered the first parenthesis of the expression after the function name, and only
when using a computer with a keyboard.

10. Klicken Sie auf Übernehmen, um den Dialog Neue Formel zu schließen.
Now you need to add some descriptive data for the measure.

11. Geben Sie einen Namen für die Kennzahl ein.
12. Geben Sie eine Beschreibung für die Kennzahl ein (optional).

13. If you want to specify a color, click in the color drop down and select a color through one
of the following methods:

l Click one of the colors in the palette.
l Type a 6 character color code in the Hex input field.
l Click at the bottom of the dialog, select a color in the color wheel, and optionally

adjust the saturation slider.
14. Tags hinzufügen (optional).
15. Unter Zahlenformat können Sie folgende Optionen auswählen:

l Auto:
l Zahl
l Money
l Datum
l Dauer
l Benutzerdefiniert
l Kennzahlformel

16. Klicken Sie auf Erstellen.

The measure is now saved in the Measures category in the master items, and you can use it in
visualizations.

Creating a master measure by typing the expression
Wenn Sie mit einer nicht veröffentlichten App arbeiten, können Sie Master-Kennzahlen
erstellen, die wiederverwendet werden können. You can add complex expressions by
typing the expression into the expression editor.
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1. Klicken Sie in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Click Master items in the assets panel.

3. Click the Measures heading to expand that category.
4. Klicken Sie auf Neu erstellen.

The Create new measure dialog opens.

5. Click in the Expression field to open the Add expression dialog.

6. Type the expression directly in the expression editor (the main window).
The field names you use in the expression are checked, and the syntax of the expression is
validated.

As you type in the expression editor, the expression is validated continuously. If
there is an error, you see a hint about what is incorrect in the lower left-hand
corner. Additional error information may be available by clicking the icon next to
the hint.

Each line in the expression editor is numbered and syntax highlighting is used.

You can open the online help with the full description of how to use the current
function by double-clicking the function name in the expression editor and
pressing Ctrl+H on the keyboard. This feature becomes available after having
entered the first parenthesis of the expression after the function name, and only
when using a computer with a keyboard.

7. Klicken Sie auf Übernehmen, um den Dialog Neue Formel zu schließen.
Now you need to add some descriptive data for the measure.

8. Geben Sie einen Namen für die Kennzahl ein.
9. Geben Sie eine Beschreibung für die Kennzahl ein (optional).

10. If you want to specify a color, click in the color drop down and select a color through one
of the following methods:

l Click one of the colors in the palette.
l Type a 6 character color code in the Hex input field.
l Click at the bottom of the dialog, select a color in the color wheel, and optionally

adjust the saturation slider.
11. Tags hinzufügen (optional).
12. Unter Zahlenformat können Sie folgende Optionen auswählen:

l Auto:
l Zahl
l Money
l Datum
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l Dauer
l Benutzerdefiniert
l Kennzahlformel

13. Klicken Sie auf Erstellen.

The measure is now saved in the Measures category in the master items, and you can use it in
visualizations.

Editing a master measure
Bei der Aktualisierung einer Master-Kennzahl werden die Änderungen für alle Instanzen
übernommen, einschließlich der Visualisierungen, welche die Kennzahl verwenden.

Edit a master measure from the assets panel or while editing visualization properties.

Editing a master measure from the assets panel
Use the assets panel to edit a master measure when you want to preview the measure or edit
several master measures.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Click Master items in the assets panel.

3. Under Measures, click the measure that you want to edit.
Die Vorschau wird angezeigt.

4. Klicken Sie unten in der Vorschau auf .

Sie können auch mit der rechten Maustaste auf das Master-Element und dann auf
Bearbeiten klicken.

A dialog is displayed to inform you that any changes to the master measure will be applied to
all visualizations that use the measure.

5. Klicken Sie auf OK.
The Edit measure dialog opens, where you update the expression, name, description, color,
and tags.

6. Klicken Sie auf Speichern.

The measure is now updated.

Editing a master measure from visualization properties
When a measure in a visualization is linked to a master measure, you can edit the master measure
from the properties panel. All visualizations in the app that use the master measure will be updated.
To edit a linked measure only in this visualization, without affecting the master item, you must first
unlink it from the master. See Die Verlinkung zu einem Master-Element trennen (page 156).

Gehen Sie folgendermaßen vor:
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1. In edit mode, select the visualization.
2. In the properties panel, click the Data tab.

Wenn es ausgeblendet ist, klicken Sie unten rechts auf Eigenschaften anzeigen .

3. Under Measures, click the linked measure to edit.
4. Under Master item, click Edit.

A dialog is displayed to inform you that any changes to the master measure will be applied to
all visualizations that use the measure.

5. Make your changes to the master measure, and then click Save.

Using master measures in expressions
You can use master measures in expressions. You can use the master measure by
itself, or use it to build a more complex expression.

When you type in the Expression editor, an auto-complete list of matching master measures
opens.
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Master measure in Expression editor

Considerations
When working with master measures, consider the following:

l If the master measure is renamed or deleted, references in expressions are not automatically
updated. The old reference will return NULL in the expression as there is no measure by that
name.

Master measure formatting
Zahlenformatierung, Farbe und Beschriftung können für eine Master-Kennzahl konfiguriert werden.
Diese Eigenschaften werden nicht auf eine Visualisierung angewendet, wenn Sie die Master-
Kennzahl mithilfe einer Formel referenzieren. Um diese Eigenschaften in einer Visualisierung
anzuwenden, erstellen Sie einen direkten Link zu der Master-Kennzahl, wenn Sie die Visualisierung
konfigurieren.

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster Daten > Kennzahlen.
2. Klicken Sie auf Hinzufügen.
3. Wählen Sie im Dropdown-Menü unter Kennzahlen die Master-Kennzahl aus.

Jetzt wird ein direkter Link zur Master-Kennzahl erstellt.

Example: Using a master measure in an expression
This example creates a master measure, and then uses the master measure in a chart expression.

1. Create the master measure.
i. Click Master items in the assets panel.
ii. Under Measures, click Create new.
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Create new measure button

iii. In the Create new measure dialog box, enter a Name for the master measure, and
then click to open the Expression editor.
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Create new measure dialog box

iv. In the Expression editor, create the expression.
You can type the expression, or use the options available in the expression builder
panel.
Insert the expression using the expression builder Count(distinct item), and then click
Apply.
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Add expression in Expression editor

v. In the Create new measure dialog box, click Create.
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Create measure

The new master measure is created.
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New master measure
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2. Use the master measure in a chart expression.
i. Add a KPI chart to a sheet in an app.

New KPI

ii. Click Add measure, and then click to open the Expression editor for the KPI.
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Open Expression editor

iii. Type the master measure into the expression. As you type, you will get an auto-
complete list of any available master measures. If required, the master measure can be
used to build more complex expressions in the Expression editor.
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Add expression for KPI

iv. Close the Expression editor to view the KPI. You can change properties for the KPI,
including the label, in the properties panel.
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Master measure in KPI

Zuweisen von Farben zu Master-Elementen
Sie können Ihren Master-Elementen Farben zuweisen. Master-Dimensionen und
Master-Kennzahlen zugewiesene Farben bleiben in allen Visualisierungen für alle
Instanzen dieser Master-Elemente erhalten.

Damit die gleichen Dimensionen und Kennzahlen in allen Visualisierungen dieselben Farben haben,
können Sie Master-Elementen bestimmte Farben zuweisen. Master-Dimensionen und Master-
Kennzahlen zugewiesene Farben bleiben in allen Visualisierungen für alle Instanzen dieser Master-
Elemente erhalten. Wenn Sie die Farbe eines Master-Elements ändern, ändert sich auch die Farbe
aller Instanzen dieser Master-Elemente. Für einzelne Visualisierungen kann die Farbe von Master-
Elementen bei Bedarf deaktiviert werden.

Visualisierungen verwenden die Farben der Master-Dimensionen, wenn im Abschnitt Farben und
Legende des Eigenschaftsfensters für Visualisierungen die Option Eine Farbe ausgewählt ist. Die
Farben der Master-Kennzahlen werden verwendet, wenn im Abschnitt Farben und Legende des
Eigenschaftenfensters für Visualisierungen die Option Eine Farbe oder Mehrfarbig ausgewählt ist.
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Wenn für die Einstellung Automatisch einer Visualisierung die Option Eine Farbe oder Mehrfarbig
festgelegt ist, werden automatisch die Farben der Master-Elemente angewendet. Ist dies nicht der
Fall, müssen Sie zu Benutzerdefiniert wechseln und eine unterstützte Einstellung auswählen. Die
Farben der Master-Elemente können in einzelnen Visualisierungen deaktiviert werden.

Wenn in einer Visualisierung sowohl die Farben für Master-Dimensionen als auch für Master-
Kennzahlen angegeben sind, verwendet Qlik Sense als Standardeinstellung die Farben der Master-
Dimensionen. Wenn die Farben der Master-Kennzahlen verwendet werden sollen, muss im
Abschnitt Farben und Legende des Eigenschaftenfensters für Visualisierungen in der Dropdown-
Liste Bibliotheksfarben verwenden die Option Kennzahl ausgewählt werden. In Visualisierungen,
die Master-Kennzahlen mit zugewiesenen Farben und Kennzahlen ohne zugewiesene Farben
enthalten, werden für diese Kennzahlen die Farben der Standardpalette verwendet.

Den distinkten Werten von Master-Dimensionen können Farben zugewiesen sein.

Auf die Werte von Master-Kennzahlen können in Visualisierungen benutzerdefinierte Farbverläufe
angewendet werden. .

Beim Zuweisen von Farben zu Master-Elementen haben Sie die folgenden Optionen:

l Auswahl einer Farbe aus der Standardpalette
l Eingabe eines hexadezimalen Farbcodes
l Auswahl einer Farbe über erweiterte Farboptionen

Zuweisen einer Farbe aus der Standardfarbpalette
Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Klicken Sie auf , um die Master-Elemente anzuzeigen.

3. Wählen Sie ein Master-Element aus Ihrer Bibliothek aus.

4. Klicken Sie auf .

5. Klicken Sie in der Farb-Dropdownliste auf .

6. Wählen Sie eine der Farben in der Palette aus.
7. Klicken Sie auf eine Stelle außerhalb des Dialogfelds.
8. Klicken Sie auf Speichern.
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Das Farbdialogfeld mit der Standardfarbpalette und einer ausgewählten blauen Farbe.

Zuweisen einer Farbe über einen Hexadezimalfarbcode
Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Klicken Sie auf , um die Master-Elemente anzuzeigen.

3. Wählen Sie ein Master-Element aus Ihrer Bibliothek aus.

4. Klicken Sie auf .

5. Klicken Sie in der Farb-Dropdownliste auf .

6. Geben Sie in das Eingabefeld einen 6-stelligen Farbcode ein: #.
7. Klicken Sie auf eine Stelle außerhalb des Dialogfelds oder drücken Sie die Eingabetaste.
8. Klicken Sie auf Speichern.

Zuweisen einer Farbe über erweiterte Farboptionen
Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Klicken Sie auf , um die Master-Elemente anzuzeigen.

3. Wählen Sie ein Master-Element aus Ihrer Bibliothek aus.

4. Klicken Sie auf .

5. Klicken Sie in der Farb-Dropdownliste auf .

6. Klicken Sie unten im Dialogfeld auf .
Im Dialogfeld werden die erweiterten Optionen angezeigt.

7. Wählen Sie im Farbkreis eine Farbe aus.
Die ausgewählte Farbe ändert sich, und der Hexadezimalfarbcode wird entsprechend
aktualisiert.
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8. Optional können Sie die Farbsättigung über den Schieberegler ändern.
Die Sättigung verändert sich, und der Hexadezimalfarbcode wird entsprechend aktualisiert.

9. Klicken Sie auf eine Stelle außerhalb des Dialogfelds.
10. Klicken Sie auf Speichern.

Das Farbdialogfeld mit dem Farbkreis in den erweiterten Optionen und einer ausgewählten blauen Farbe.

Assigning colors to master dimension values
You can assign colors to the distinct values contained in a master dimension. This
ensures that the distinct values of your dimensions use the same colors in all
visualizations.

Colors assigned to values are used when you choose to color By dimension and have Library
colors enabled. If you choose to color by Single color, the master dimension's color is used instead.

Assigning colors to master dimension values has the following limitations:

l A maximum of 100 colors can be assigned to a dimension's values.
l Dimension values cannot be longer than 1024 characters. Longer values are disabled in the

list of values.
l Drill-down and cyclic dimensions do not support assigning colors to dimension values

Weisen Sie Master-Dimensionswerten keine Farben zu, wenn Sie Section Access
verwenden oder mit vertraulichen Daten arbeiten, da die Werte durch die
Farbkonfiguration offengelegt werden könnten.

The Value colors section of Edit dimensions contains the options for assigning colors to a
dimension's distinct values. You can search the list of values with .
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Qlik Sense automatically applies an auto fill to your values to provide a default color. The auto fill is
either a single color or a color scheme. Changing your auto-fill settings will not change colors you
have assigned to values.

In addition to distinct values, you can set colors for the values classified as others in a visualization,
that is, the collection of distinct values that fall outside the displayable values in a dimension. You
can also set colors for null values.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Klicken Sie auf , um die Master-Elemente anzuzeigen.

3. Select a master dimension from your library.

4. Click .

5. Click Value colors.
6. If you want to change the auto fill settings, set Auto fill to Custom , select the auto fill

method, and either select a single color or color scheme.
7. Select a value and do one of the following:

l Select a color in the color wheel, and optionally adjust the saturation slider.
l Type a 6 character color code in the Hex input field: #.

Values assigned colors display the icon.

8. If you want to remove an assigned color, select the value and click .

9. Optionally, to assign a color to Others or Null values, click and do one of the following:
l Click one of the colors in the palette.
l Type a 6 character color code in the Hex input field: #.
l Click at the bottom of the dialog, select a color in the color wheel, and optionally

adjust the saturation slider.
10. Click Save.

Zuweisen von Farben zu Master-Kennzahlwerten
Sie können einer Master-Kennzahl einen Farbverlauf oder ein Segmentschema
zuweisen und Visualisierungen so nach Kennzahl mit Farben versehen, die nicht in den
Standardfarbschemata enthalten sind.

Wenn Sie die Farbgestaltung mit nur einer Farbe auswählen, wird anstelle des Farbschemas die
Farbe der Master-Kennzahl verwendet.

So weisen Sie den Werten in einer Master-Kennzahl benutzerdefinierte Segment- oder
Verlaufsfarben zu:

1. Rufen Sie die Segmentfarben auf und aktivieren Sie diese.
2. Wählen Sie das Vorlagenschema aus.
3. Wählen Sie das Segmentformat aus.
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4. Optional: Fügen Sie Grenzen hinzu oder entfernen Sie diese.
5. (Optional) Bearbeiten Sie die Grenzen von Segmentwerten.
6. Weisen Sie den Segmenten Farben zu.
7. Speichern Sie.

Aufrufen und Aktivieren von Segmentfarben

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Klicken Sie auf , um die Master-Elemente anzuzeigen.

3. Wählen Sie eine Master-Kennzahl aus Ihrer Bibliothek aus.

4. Klicken Sie auf .

5. Klicken Sie auf die Registerkarte Segmentfarben.
6. Legen Sie für die Schaltfläche Segmentfarben die benutzerdefinierte Farbgebung fest.

Auswählen des Vorlagenschemas
Das Vorlagenschema enthält eine Standardvorlage, die bearbeitet werden kann. Sie können aus
den Standardklassen und Verläufen auswählen.

Gehen Sie folgendermaßen vor:

l Wählen Sie unter Vorlagenschema auswählen ein Vorlagenschema aus.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 150



3   Visualizations

Auswählen des Segmentformats
Das Segmentformat bestimmt, wie Farben zugewiesen werden. Mit Prozentsatz werden
Werteklassen basierend darauf hinzugefügt, wo Werte in das Perzentil des jeweiligen Werts
eingefügt werden können. Mit fester Wert werden definierte Werte zur Festlegung der Grenzen
jedes Segments verwendet.

Gehen Sie folgendermaßen vor:

l Legen Sie Segmentformat auf Fester Wert oder Prozentsatz fest.

Hinzufügen, Bearbeiten und Entfernen von Grenzen
Standardmäßig richtet sich die Anzahl der Segmente nach dem ausgewählten Schema. Sie können
zusätzliche Segmente erstellen, indem Sie Grenzen hinzufügen. Wenn ein neues Segment erstellt
wird, markiert ein Zeiger den Wert der Grenze des Segments.

Gehen Sie folgendermaßen vor:

l Klicken Sie auf die Schaltfläche Grenze hinzufügen, um dem Messzeiger eine Grenze
hinzuzufügen.

l Verwenden Sie den Schieberegler, um den Wert einer Grenze zu ändern. Sie können auch
einen Wert für die ausgewählte Grenze eingeben.

l Klicken Sie auf die Schaltfläche Grenze entfernen, um die ausgewählte Grenze zu entfernen.

Bearbeiten von Segmenten
Standardmäßig richten sich die Segmentfarben nach dem ausgewählten Schema. Sie können die
Farbe eines Segments und sein Ende ändern.

Gehen Sie folgendermaßen vor:

l Klicken Sie auf das Segment, um die Farben zu ändern.
l Wählen Sie Verlauf aus, um verschiedene Farbschattierungen für den Übergang zwischen

den Segmenten für die ausgewählte Grenze zu verwenden.

Erstellen von Kalenderkennzahlen
Verwenden Sie Kalenderkennzahlen, um Daten über relative Zeiträume zu analysieren.
Sie möchten beispielsweise die Verkaufszahlen für den aktuellen Jahresverlauf mit den
Verkaufszahlen derselben Periode des letzten Jahres vergleichen.

Kalenderkennzahlen aggregieren Daten aus einem Feld über einen Zeitraum. Diese Daten werden in
der Kategorie Kennzahlen in den Master-Elementen gespeichert. Kalenderkennzahlen bestehen
aus einem zu aggregierenden Feld, einer Aggregierung, einem Datumsfeld und einem Zeitraum für
dieses Datumsfeld, mit dem die Daten festgelegt werden, die in der Aggregierung verwendet
werden sollen. Sie erstellen Kalenderkennzahlen unter Felder im Fenster Extras über das Dialogfeld
Kalenderkennzahlen erstellen.
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Sie können Felder aus Tabellen aggregieren, die im Datenmanager oder von einem Skript im
Dateneditor geladen wurden, solange sich das Feld in derselben Tabelle wie das Datumsfeld oder
in einer verknüpften Tabelle befindet.

Das Datumsfeld muss jedoch aus einer Tabelle stammen, die mit dem Datenmanager geladen
wurde, weil Kalenderkennzahlen Formeln verwenden, die als Datums- und Zeitfelder mit einem Tag
gekennzeichnet sind, die in autoCalendar deklariert sind, und Datumsfelder können nur dann zu
autoCalendar zugewiesen werden, wenn sie im Datenmanager geladen werden.
Kalenderkennzahlen unterstützen die folgenden Aggregierungen mit dem Aggregatfeld: Sum,
Count, Avg, Min und Max.

Kalenderkennzahlen unterstützen keine Kalender, die mit dem Dateneditor erstellt
wurden. Wenn Sie mit dem Dateneditor erstellte Kalender verwenden und
Kalenderkennzahlen erstellen möchten, müssen Sie mit dem Datenmanager eine
Tabelle mit einem Datumsfeld laden, um sie mit Tabellen zu verwenden, die mit dem
Dateneditor geladen werden.

Wenn Ihr Datumsfeld mehr als einem Kalender unterliegt und beide Kalender für die
Verwendung mit Kalenderkennzahlen qualifiziert sind, wird bei den Kalenderkennzahlen
der erste im Datenladeskript geladene Kalender verwendet.

Bei einer Kalenderkennzahl kann einer der folgenden Zeiträume verwendet werden, die für die
Verwendung mit wöchentlichen, monatlichen, vierteljährlichen und jährlichen Kalenderkennzahlen
verfügbar sind. In jedem Zeitraum sind verschiedene Kennzahlen für Perioden vorhanden, wie zum
Beispiel der aktuelle Monat, das laufende Jahr bis heute und die aktuelle Woche des Vorjahres. Für
die Erstellung von Kalenderkennzahlen sind die folgenden Zeiträume und Kennzahlen verfügbar:

Kennzahl Beschreibung

YTD Das laufende Jahr bis heute für alle Jahre.

YTD Aktuelles Jahr Das laufende Jahr bis heute für das aktuelle Jahr.

YTD Vorjahr Das laufende Jahr bis heute für das Vorjahr.

Kalenderkennzahlen für den Zeitraum „Jährlich“

Kennzahl Beschreibung

MTD Der laufende Monat bis heute für alle Monate und Jahre.

MTD Aktueller Monat Der laufende Monat bis heute für den aktuellen Monat.

MTD Letzter Monat Der laufende Monat bis heute für den letzten Monat.

Aktueller Monat Alle Tage in diesem Monat.

Aktueller Monat Vorjahr Alle Tage in diesem Monat des Vorjahres.

Letzter Monat Alle Tage im letzten Monat.

Kalenderkennzahlen für den Zeitraum „Monatlich“
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Kennzahl Beschreibung

QTD Das laufende Quartal bis heute für alle Jahre.

QTD Aktuelles Quartal Das laufende Quartal bis heute für das aktuelle Quartal.

QTD Letztes Quartal Das laufende Quartal bis heute für das letzte Quartal.

Aktuelles Quartal Alle Tage im aktuellen Quartal.

Aktuelles Quartal Vorjahr Alle Tage im aktuellen Quartal des Vorjahres.

Letztes Quartal Alle Tage des letzten Quartals.

Kalenderkennzahlen für den Zeitraum „Pro Quartal“

Kennzahl Beschreibung

WTD Die laufende Woche bis heute für alle Wochen in allen Jahren.

WTD Aktuelle Woche Die laufende Woche bis heute für die aktuelle Woche.

WTD Letzte Woche Die laufende Woche bis heute für die letzte Woche.

Aktuelle Woche Alle Tage in dieser Woche.

Aktuelle Woche Vorjahr Alle Tage in dieser Woche des Vorjahres.

Letzte Woche Alle Tage in der letzten Woche.

Kalenderkennzahlen für den Zeitraum „Wöchentlich“

Nachdem die Kalenderkennzahlen erstellt wurden, werden sie genauso wie Master-Kennzahlen
behandelt. Das heißt, Kalenderkennzahlen können in einer nicht veröffentlichten App
wiederverwendet und bearbeitet werden. Benutzer einer veröffentlichten App haben Zugriff auf die
Kalenderkennzahlen, können diese jedoch nicht bearbeiten.

Erstellen einer Kalenderkennzahl aus einem Feld
Gehen Sie in einem Arbeitsblatt im Bearbeitungsmodus bei geöffneter Registerkarte Felder wie
folgt vor:

1. Klicken Sie mit der rechten Maustaste auf ein Feld und wählen Sie Kalenderkennzahlen
erstellen aus.
Standardmäßig wird das Feld, auf das Sie mit der rechten Maustaste klicken, als das
Aggregatfeld eingeschlossen.

2. Wählen Sie in der Dropdown-Liste Datumsfeld ein Datumsfeld aus.
3. Wählen Sie in der Dropdown-Liste Aggregatfeld ein Feld aus.
4. Wählen Sie in der Dropdown-Liste Aggregierung eine Aggregierung aus.
5. Wählen Sie in der Dropdown-Liste Zeitraum einen Zeitraum aus.

Unter Vorschau der Kennzahlen wird eine Liste der verfügbaren Kennzahlen angezeigt.
Mit dem Schalter Vorschau der Kennzahlen können Sie die Anzeige der Kennzahlenformeln
umschalten.

6. Wählen Sie die Kalenderkennzahlen aus, um sie zu den Master-Elementen hinzuzufügen.
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Standardmäßig sind alle Kennzahlen ausgewählt.
7. Klicken Sie auf In Master-Elementen speichern.
8. Klicken Sie auf Schließen.

Tagging master items
You can use tags to organize master items. You will find matches in tags when searching in the
assets panel. You can also tag master items with synonyms for Insight Advisor. Use the format
alt:<term> in synonym tags. For example, alt:cities.

Each tag can contain a maximum of 31 characters, and each master item can have up to 30 tags.

Adding tags to a master item
You can add tags when creating or editing a master item.
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Adding tags while creating a new measure

You can add tags by clicking or by pressing Enter.

Previewing tags
In the assets panel, tags are displayed when previewing dimensions, measures, and visualizations.
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The preview displays the dimension type, which fields are included in the drill-down dimension and tags.

Die Verlinkung zu einem Master-Element trennen
Trennen Sie die Verlinkung einer Dimension oder Kennzahl in einer Visualisierung mit dem Master-
Element, um nur die aktuelle Instanz der Dimension oder Kennzahl zu bearbeiten. Durch das
Aufheben der Verlinkung wird die Verbindung zum Master-Element getrennt, und die Dimension
bzw. Kennzahl wird eigenständig. Wenn Sie alle Instanzen einer verlinkten Dimension oder
Kennzahl aktualisieren möchten, müssen Sie das Master-Element bearbeiten. Weitere
Informationen finden Sie unter Editing a master dimension (page 127) oder Editing a master
measure (page 134).

Trennen der Verlinkung über das Eigenschaftsfenster
Trennen Sie die Verlinkung zu einer Master-Dimension oder Master-Kennzahl in einer Visualisierung
über das Eigenschaftsfenster.

Gehen Sie folgendermaßen vor:

1. Klicken Sie auf Arbeitsblatt bearbeiten.
Das Eigenschaftsfenster öffnet sich auf der rechten Seite.

2. Wählen Sie die Visualisierung auf dem Arbeitsblatt aus.
Die Eigenschaften für die ausgewählte Visualisierung werden im Eigenschaftsfenster
angezeigt.

3. Navigieren Sie unter Daten zu der Dimension oder Kennzahl und klicken Sie sie an.
Eine verlinkte Dimension oder Kennzahl wird mit dem Symbol gekennzeichnet.

4. Klicken Sie auf .
Ein Dialogfeld weist darauf hin, dass Sie dabei sind, die Verlinkung mit einem Master-Element
zu trennen.

5. Klicken Sie auf OK.

Sie können jetzt die Dimension oder Kennzahl in der Visualisierung bearbeiten, ohne dass sich dies
auf andere Visualisierungen auswirkt, die die Master-Elemente verwenden.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 156



3   Visualizations

Sie können lediglich die Verlinkung einer einzigen Dimension trennen, nicht jedoch einer
Drilldown-Dimension.

Trennen der Verlinkung zu einer Master-Visualisierung
Trennen Sie die Verlinkung einer Visualisierung mit der Master-Visualisierung, um nur
die aktuelle Instanz zu bearbeiten. Durch das Trennen der Verlinkung wird die
Verbindung zwischen der Visualisierung auf Ihrem Arbeitsblatt und dem Master-
Element entfernt. Die aktuelle Visualisierung wird eigenständig. Weitere Informationen
zum Bearbeiten aller Visualisierungen, die mit einer Master-Visualisierung verlinkt sind,
finden Sie unter Editing a master visualization (page 120).

Gehen Sie folgendermaßen vor:

1. Klicken Sie auf Arbeitsblatt bearbeiten.

2. Klicken Sie auf in der oberen rechten Ecke einer verlinkten Visualisierung und dann auf
Verlinkung zur Visualisierung trennen.
Ein Dialog wird angezeigt, dass Sie dabei sind, eine Verlinkung zu einer Master-Visualisierung
zu trennen.

3. Klicken Sie auf OK.

Die Visualisierung auf dem Arbeitsblatt kann bearbeitet werden und die Änderungen beeinflussen
keine anderen Visualisierungen.

Sie können auch mit der rechten Maustaste auf die verlinkte Visualisierung klicken und
dann im Kontextmenü auf Verlinkung zu Visualisierung trennen klicken.

Löschen einer Master-Dimension oder Master-Kennzahl
Sie können Dimensionen und Kennzahlen aus den Master-Elementen löschen, solange die App
noch nicht veröffentlicht wurde.

Wenn Sie eine Master-Dimension oder -Kennzahl löschen, funktionieren die
Visualisierungen nicht mehr, die das gelöschte Master-Element verwenden – es sei
denn, Sie ersetzen das Element durch eine neue Dimension oder Kennzahl.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Klicken Sie im Extras-Fenster auf Master-Elemente.
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3. Klicken Sie auf Dimensionen oder Kennzahlen, um die entsprechende Kategorie zu
erweitern.

4. Klicken Sie die Dimension oder Kennzahl an, die Sie löschen möchten.
Die Vorschau wird angezeigt.

5. Klicken Sie unten in der Vorschau auf .
Ein Dialogfeld weist darauf hin, dass alle Visualisierungen, welche die Dimension oder
Kennzahl verwenden, nicht mehr funktionieren.

6. Klicken Sie auf OK.

Die Dimension oder Kennzahl wird aus den Master-Elementen gelöscht, und alle Visualisierungen
auf den Arbeitsblättern, die das gelöschte Element verwendet haben, funktionieren nicht mehr. Der
Text Dimension nicht gefunden oder Kennzahl nicht gefunden wird für diese Visualisierungen
angezeigt.

Einer Visualisierung fehlt sowohl eine Dimension als auch eine Kennzahl. Beide wurden aus den Master-
Elementen gelöscht.

Ersetzen ungültiger Dimensionen oder Kennzahlen
Wenn eine Dimension oder Kennzahl aus den Master-Elementen gelöscht wurde, funktionieren alle
Visualisierungen nicht mehr, die mit diesem gelöschten Master-Element verknüpft waren – es sei
denn, die fehlende Dimension oder Kennzahl wird ersetzt.

Gehen Sie folgendermaßen vor:
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1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Klicken Sie im Extras-Fenster auf Master-Elemente.

3. Ziehen Sie eine Dimension aus dem Abschnitt Dimensionen oder eine Kennzahl aus dem
Abschnitt Kennzahlen auf die Visualisierung auf dem Arbeitsblatt.
Das Shortcut-Menü wird geöffnet.

4. Wählen Sie Ungültige Dimension ersetzen oder Ungültige Kennzahl ersetzen aus.

Die Visualisierung ist vollständig und funktioniert wieder.

Deleting a master visualization
You can delete visualizations from the master items as long as the app is not published.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Click Advanced options.

3. Klicken Sie auf , um die Master-Elemente anzuzeigen.

4. Click the visualization that you want to delete.
Die Vorschau wird angezeigt.

5. Klicken Sie unten in der Vorschau auf .
A dialog is displayed stating that wherever this visualization is used on sheets there will be
invalid instances of it.

6. Klicken Sie auf OK.

The visualization is deleted from the master items, and on all sheets where this visualization was
used, you see invalid visualizations. You now need to replace the invalid visualization with other
ones, or delete the instances.

You can also delete visualizations from the preview that is displayed when clicking the
visualization in the master items.

Replacing an invalid visualization on a sheet
The representation of the invalid visualization is there to tell you that there used to be a
visualization at a certain location on the sheet, but the invalid visualization serves no purpose.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt. Klicken Sie auf , um die Master-
Elemente anzuzeigen.
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2. Drag a visualization from the master items to the location of the invalid visualization on the
sheet.

The invalid visualization is replaced.

Deleting an invalid visualization
1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Right-click on the invalid visualization and select Delete in the shortcut menu.

The invalid visualization is deleted.

Arbeiten mit Formeln in Visualisierungen
Visualisierungen in Qlik Sense werden aus Diagrammen erstellt, die wiederum
abhängig vom Typ des Diagramms aus Dimensionen und Kennzahlen erstellt werden.
Visualisierungen können mit Titel, Untertitel, Fußnoten und anderen Elementen
versehen sein, die zur Übermittlung von Informationen beitragen. Alle Elemente, die zu
einer Visualisierung gehören, können einfach aufgebaut sein: beispielsweise eine
Dimension, die aus einem Feld mit Daten und einem Titel mit Text besteht.

Für Visualisierungen, die Kennzahlen enthalten, sind die Kennzahlen auf Felder gestützte
Aggregierungen. Konkret sind Kennzahlen Berechnungen, die zahlreiche Datensätze einbeziehen.
Beispielsweise bedeutet Sum(Cost), dass alle Werte des Felds Cost mittels der Funktion Sum
aggregiert werden. Anders ausgedrückt: Bei Sum(Cost) handelt es sich um eine Formel.

Was ist eine Formel?
Eine Formel ist eine Kombination aus Funktionen, Feldern und mathematischen Operatoren (+ * / =)
sowie anderen Kennzahlen. Formeln werden zum Verarbeiten von Daten in der App verwendet.
Dabei wird ein Ergebnis ausgegeben, das in der Visualisierung veranschaulicht werden kann. Sie
sind nicht auf die Verwendung in Kennzahlen beschränkt. Sie können dynamischere und
leistungsfähigere Visualisierungen erstellen, indem Sie Formeln für Titel, Untertitel, Fußnoten und
sogar Dimensionen verwenden.

Das bedeutet beispielsweise, dass für den Titel der Visualisierung anstatt statischem Text eine
Formel verwendet werden kann, deren Ergebnis abhängig von den getroffenen Auswahlen
unterschiedlich ausfallen kann.

Wo kann ich Formeln verwenden?
Formeln können überall dort in Visualisierungen verwendet werden, wo das Symbol bei der
Bearbeitung der Visualisierung im Eigenschaftsfenster angezeigt wird. Das Symbol weist auf ein
Formelfeld hin. Wenn Sie auf klicken, rufen Sie den Formel-Editor auf. Hier erhalten Sie
Hilfestellung beim Erstellen und Bearbeiten von Formeln. Formeln können auch direkt in das
Formelfeld eingegeben werden, ohne dass der Formel-Editor verwendet wird.
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Eine Formel kann nicht direkt als Master-Element gespeichert werden. Wird eine Formel jedoch in
einer Kennzahl oder Dimension verwendet, die wiederum mit den beschreibenden Daten, wie z. B.
Name, Beschreibung und Tags, als Master-Element gespeichert wird, erfolgt die Speicherung der in
der Kennzahl oder Dimension enthaltenen Formel.

Formeln werden sowohl in Skripten als auch in Diagrammvisualisierungen verwendet. Sie können
einfach sein und nur für grundlegende Berechnungen verwendet werden. Komplexere Formeln
umfassen Funktionsfelder und Operatoren. Formeln können in verschiedenen Situationen
verwendet werden. Der Unterschied zwischen Kennzahlen und Formeln liegt darin, dass Formeln
keine Bezeichnung oder beschreibenden Daten aufweisen.

In einem Skript wird eine Formel bei der Ausführung des Skripts ausgewertet. In
Visualisierungen (einschließlich Diagrammen und Tabellen) wird die Formel jedes Mal
automatisch ausgewertet, wenn sich der logische Status eines in der Formel
verwendeten Feldes oder der Wert einer verwendeten Variablen oder Funktion ändert.
Hinsichtlich Syntax und verfügbarer Funktionen bestehen einige Unterschiede zwischen
Skript-Formeln und Diagrammformeln.

Detaillierte Referenzen zur Skript- und Tabellenfunktionen finden Sie in der Datei
Skriptsyntax und Diagrammfunktionen.

Working with the expression editor
You can enter the expression editor to add or edit an expression wherever you see the symbol in

the properties panel while editing a visualization. The symbol indicates an expression field. Click
to enter the expression editor.

You can add expressions in two ways. Expressions can be created using the Fields, Functions,
Variables, and Set expressions sections by making selections and inserting them into the
expression field. You can edit the inserted expressions and add more complex expressions by
typing directly into the expression field. You can undo an action by clicking the Undo button .

Inserting an expression using Fields
You can insert an expression by making selections from the Fields section at the right-hand side of
the expression editor dialog.

Gehen Sie folgendermaßen vor:

1. If you want to limit the available fields to those from a particular table in your data model,
select a table from the Filter by table drop-down list.

2. Select a field from the Field drop-down list.
3. Select the aggregation function you want to use. The functions available are from the group

of basic aggregation functions.
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4. If you want to insert the current selection as a set expression in your aggregation, use the
Set expression check box. The current selection is always based on the default state.

5. If you want to insert a Distinct or a Total clause together with the aggregation function, use
the check boxes for each clause. Each clause can be used separately.

6. Click Insert to insert the field and the function into the expression field.

If you do not select an aggregation function, only the field will be inserted into the
expression. Clauses can only be added if you select an aggregation function.

7. Klicken Sie auf Übernehmen, um den Dialog Neue Formel zu schließen.
Bei einer Dimension oder Kennzahl fahren Sie fort, indem Sie zur jeweiligen Dimension oder
Kennzahl beschreibende Daten hinzufügen.

Inserting a function using Functions
You can insert more than the basic aggregation functions by making selections from the Functions
section at the right-hand side of the expression editor dialog.

1. If you want to filter the list of available functions, select a function category from the
Function category drop-down list.

2. Select a function from the Function name drop-down list.
You see a preview of the function.

3. Click Insert to insert the function and the first parenthesis into the expression field.
4. Type the rest of the expression in the expression editor according to the syntax.
5. Klicken Sie auf Übernehmen, um den Dialog Neue Formel zu schließen.

Bei einer Dimension oder Kennzahl fahren Sie fort, indem Sie zur jeweiligen Dimension oder
Kennzahl beschreibende Daten hinzufügen.

Inserting a variable using Variables
You can insert a variable by making selections from the Variables section at the right-hand side of
the expression editor dialog.

1. If you want system variables to appear in the list of available variables use the Show system
variables check-box.

2. Select a variable from the Variable drop-down list.
You see a Definition and Value of the variable, if available.

3. Click Insert to insert the variable into the expression field.
4. Klicken Sie auf Übernehmen, um den Dialog Neue Formel zu schließen.

Bei einer Dimension oder Kennzahl fahren Sie fort, indem Sie zur jeweiligen Dimension oder
Kennzahl beschreibende Daten hinzufügen.

Inserting a set expression using Set expressions
You can insert a set expression by making selections from the Set expressions section at the right-
hand side of the expression editor dialog.
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1. Select whether to Use current selections or Use bookmark, as a set expression.
You can only Use current selections if a selection has been made in the app. You can only
Use bookmark if a bookmark is available. Use the Bookmark drop-down menu to choose
between bookmarks.

2. If you have defined alternate states, you can change the alternate state which the set
expression is based on. Select the alternate state from Alternate state drop-down menu.

3. Click Insert to insert the set expression into the expression field.
4. Klicken Sie auf Übernehmen, um den Dialog Neue Formel zu schließen.

Bei einer Dimension oder Kennzahl fahren Sie fort, indem Sie zur jeweiligen Dimension oder
Kennzahl beschreibende Daten hinzufügen.

Adding or editing an expression by typing

Gehen Sie folgendermaßen vor:

1. Type the expression directly in the expression field.
The field names you use in the expression are checked, and the syntax of the expression is
validated.

As you type in the expression editor, the expression is validated. If there is an
error, you see a hint about what is incorrect. Additional error information may be
available by clicking the icon next to the hint.

Wenn Sie den Namen einer Funktion oder Formel eingeben, wird eine Popup-Hilfe angezeigt,
die Informationen zur korrekten Eingabe der Funktion einschließlich Argumentnamen und
Zusätzen enthält.

In der Popup-Hilfe bestimmter Diagrammfunktionen wird der ALL-Zusatz
angezeigt. Es wird empfohlen, den ALL-Zusatz nicht zu verwenden. Verwenden
Sie stattdessen die Auswahlformel {1}.

Each line in the expression editor is numbered and syntax highlighting is used.
2. Klicken Sie auf Übernehmen, um den Dialog Neue Formel zu schließen.

Bei einer Dimension oder Kennzahl fahren Sie fort, indem Sie zur jeweiligen Dimension oder
Kennzahl beschreibende Daten hinzufügen.

Autocomplete, evaluation and color coding
When typing in the expression editor, you get an autocomplete list of matching fields, variables and
functions to select from. The list is narrowed down as you continue to type. The color coding helps
you to see where fields, variables and functions are used in the expression.

The color coding applies both in the autocomplete list and in the expression itself.

You can verify that any dollar-sign expansions added in your expression give the correct result, by
checking the expression evaluation, in the dollar-sign expansion preview.
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Search and replace
When using the expression editor, you can open the search and replace toolbar by clicking . Type
in the string you want to look for in the Search for field, using the Match case option if necessary.
All the matching occurrences in the expression will be highlighted and you can navigate between all
of them using the Previous and Next arrows. You can then optionally replace one or all of the
occurrences with the string you enter in the Replace with field.

Detailed syntax help
You can activate help mode by clicking the Help button . When active, all functions in the
expression editor act like hyperlinks. Clicking on a function opens a browser tab to the online help
section with the full description of how to use the specific function. When a function is clicked, help
mode is exited.

Verweise auf Felder, Kennzahlen und Variablen
Eine Formel kann Verweise auf Felder, Variablen und Kennzahlen enthalten.

In den meisten Fällen sind Formeln Aggregierungen, d. h. Berechnungen, die potenziell zahlreiche
Datensätze umfassen können. Das bedeutet, dass alle Feldreferenzen in Formeln von einer
Aggregierungsfunktion umschlossen sein müssen. Wenn keine Aggregierungsfunktion verwendet
wird, wird die Funktion Only() genutzt.

Wenn der Name einer Kennzahl in einer Formel verwendet wird, wird er als Alias für die Kennzahl
interpretiert. Damit wird die Wiederverwendung eines bereits definierten Elements zugelassen. Sie
können die Beschriftungen von Master-Kennzahlen und Diagrammkennzahlen auf diese Weise
verwenden. Die Diagrammkennzahl muss sich aber im gleichen Diagramm befinden. Sie können
keine Beschriftungen von Kennzahlen in anderen Diagrammen verwenden.

Sie können eine Kennzahl rekursiv definieren. Die Kennzahl kann also einen Bezug auf sich selbst
enthalten. Das sollte aber nur in Diagrammen mit wenigen Zeilen genutzt werden. Bei Diagrammen
mit vielen Zeilen kommt es zu einer Leistungsverschlechterung. Wenn Hunderte von Zeilen
vorhanden sind, versagt die rekursive Definition vollständig.

Eine Variable kann auf zwei verschiedene Weisen verwendet werden: in einem direkten Bezug oder
in einer Dollarzeichenerweiterung. Wenn Sie einen direkten Bezug verwenden, wird der
Variablenwert in der Berechnung verwendet. Wenn Sie eine Dollarzeichenerweiterung verwenden,
wird die gesamte Dollarzeichenerweiterung durch den Variablenwert ersetzt, bevor die Formel
analysiert wird. Daher können die beiden unterschiedlichen Methoden verschiedene Ergebnisse
liefern.

Interpretation von Namen
Ein Name in einer Formel kann einen Bezug auf ein Feld, eine Variable, eine Funktion oder eine
Kennzahl darstellen. Der Name kann situationsabhängig unterschiedlich interpretiert werden.

Beispiel:

Die Zeichenfolge XXX steht für ein Feld, eine Variable, eine Funktion oder eine Kennzahl. Je
nachdem, wie Sie die Formel erstellen, wird XXX als eine davon interpretiert.
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Formel XXX interpretiert als

XXX Kennzahl, Variable oder Feld

$(XXX) Variable

Count(XXX) Feld oder Variable

XXX() Funktion

Beispiele für die Interpretation von Namen

Verwenden Sie nicht den gleichen Namen für ein Feld und eine Variable (bzw. eine Kennzahl). Wenn
Sie es dennoch tun und eine Mehrdeutigkeit eintritt, wird die folgende Vorrangsreihenfolge
verwendet:

l Wenn der Name in einer Aggregierungsfunktion gefunden wird, hat ein Feld Vorrang vor einer
Variablen.

l Wenn der Name außerhalb einer Aggregierungsfunktion gefunden wird, hat eine
Kennzahlbezeichnung Vorrang vor einem Variablennamen, der wiederum Vorrang vor einem
Feldnamen hat.

Regeln für Formeln
Folgende Regeln gelten für Diagrammformeln:

l Wenn eine Feldreferenz nicht von einer Aggregierungsfunktion umschlossen ist, wird die
Funktion Only() von der Engine verwendet.

l Alle Formeln liefern als Ergebnis eine Zahl und/oder einen String.
l Logische Funktionen und Operatoren liefern 0 für False und -1 für True. Umwandlungen von

Zahlen in Strings und Strings in Zahlen sind implizit.
l Logische Operatoren und Funktionen interpretieren 0 als False und alles andere als True.
l Formeln, die nicht eindeutig ausgewertet werden können, z. B. aufgrund falscher Parameter

oder Funktionen, ergeben NULL.

Arbeiten mit Funktionen in Diagrammen
Bei einer Funktion handelt es sich um ein Verfahren oder eine Routine zur Ausführung einer
bestimmten Aufgabe zu Daten in Apps. Qlik Sense enthält mehrere hundert vorgefertigte
Funktionen, die in Diagrammen beim Erstellen von Visualisierungen verwendet werden können.
Funktionen können beispielsweise mathematisch oder logisch sein, Finanzdaten oder Datum und
Uhrzeit zur Grundlage haben sowie zum Bearbeiten von Strings usw. verwendet werden.

Funktionen können nach Typen gruppiert werden:

l Aggregierungsfunktionen, die mehrere Datensätze als Input verwenden und einen einzelnen
Wert als Ergebnis liefern.

l Skalarfunktionen, die einen einzelnen Input erfordern und einen einzigen Output als Ergebnis
liefern.

l Mengenfunktionen, die auf Grundlage mehrerer Inputwerte einen einzigen Wert ausgeben.
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l Funktionen, die einen Wertebereich ausgeben, verhalten sich wie Mengenfunktionen, geben
jedoch einen Wertebereich aus.

Viele der Funktionen können sowohl in Diagrammformeln als auch in Skripten verwendet werden,
manche sind aber spezifisch für Diagrammformeln.

Die folgende Liste zeigt einige Beispiele von Funktionen:

l Max: eine Aggregierungsfunktion, die in Skripten und Diagrammen verwendet werden kann.
Hier ein Beispiel: Max(Sales) berechnet den höchsten Wert im Feld Sales.

l IF: eine Konditionalfunktion, die in Skripten und Diagrammen verwendet werden kann.
Hier ein Beispiel: IF(Amount>0, 'OK','Alarm') bestimmt, ob die Bedingung „ist der Wert von
Amount größer als Null?“ erfüllt wird. Wenn ja, erscheint OK, anderenfalls Alarm.

l Date#: eine Interpretationsfunktion, die in Skripten und Diagrammen verwendet werden
kann.
Hier ein Beispiel: Date#(A) wertet den Eingabewert A als Datum aus.

Hinsichtlich Syntax und verfügbarer Funktionen bestehen einige Unterschiede zwischen
Skript-Formeln und Diagrammformeln. Der wesentliche Unterschied besteht in der Rolle
der Aggregierungsfunktionen und in der Verwendung von Feldverweisen. In
Diagrammformeln muss ein Feldname von genau einer Aggregierungsfunktion
eingeschlossen sein. Eine Aggregierungsfunktion kann niemals eine andere Formel
enthalten, die eine Aggregierungsfunktion als Argument enthält.

Detaillierte Referenzen zur Skript- und Tabellenfunktionen finden Sie in der Datei
Skriptsyntax und Diagrammfunktionen.

Using variables in expressions
Eine Variable in Qlik Sense ist eine Sammelbox, die einen statischen Wert oder eine Berechnung
speichert, z. B. einen Zahlenwert oder alphanumerischen Wert. Wenn Sie die Variable in der App
verwenden, wird jede Änderung an der Variable überall dort angewendet, wo die Variable
verwendet wird. Sie können Variablen in der Variablenliste oder im Skript mithilfe des Dateneditors
definieren. Den Wert einer Variablen legen Sie mithilfe der Let- oder Set-Anweisungen im
Datenladeskript fest.

Beim Einsatz von Variablen in Formeln können Sie die verwendete Formel in
verschiedenen Diagrammen gleichzeitig verwenden, indem Sie die Variable bearbeiten.

Klicken Sie bei der Bearbeitung eines Arbeitsblatts in der Bearbeitungsleiste auf , um die
Variablenliste zu öffnen.
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Die Übersicht Variablen ist in veröffentlichten Apps nicht verfügbar. Wenn Sie Variablen
in einer veröffentlichten App hinzufügen oder ändern möchten, verwenden Sie das
Variableneingabe-Steuerelement, das im Bundle „Dashboard“ zur Verfügung steht.

The following actions are available in the variables overview:

l Create a new variable.
l Edit the selected variable.
l Delete the selected variable.

To edit or delete a variable that is defined in the script, you must edit the script.

Getting an overview of all variables in an app
You can get an overview of all variables in an unpublished app.

Gehen Sie folgendermaßen vor:

l Klicken Sie bei der Bearbeitung eines Arbeitsblatts in der Bearbeitungsleiste auf , um das
Variablendialogfeld zu öffnen.
The variables dialog opens and displays a list of all variables in the app and their definitions 
(if any).

Examples
For examples of how to use variables in expressions, see Beispiel: Verwenden einer Variablen mit
Dollarzeichenerweiterung (page 170).

Siehe auch:

Working with the expression editor (page 161)

Erstellen einer Variablen
Eine Variable in Qlik Sense ist ein benanntes Element, das einen Datenwert enthält.
Wird eine Variable in einer Formel verwendet, wird diese durch ihren Wert oder die
Definition der Variablen ersetzt.  Variablen werden mithilfe des Variablendialogfelds
oder im Skript über den Dateneditor definiert.

Sie können über das Variablendialogfeld eine neue Variable erstellen, wenn Sie ein Arbeitsblatt in
einer nicht veröffentlichten App bearbeiten.

Sie können eine vorhandene Variable duplizieren, indem Sie auf klicken und Duplizieren
auswählen.

Eine visuelle Demo für die Variablenerstellung finden Sie unter Erstellen einer Variablen.
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Gehen Sie folgendermaßen vor:

1. Klicken Sie bei der Bearbeitung eines Arbeitsblatts in der Bearbeitungsleiste auf , um das
Variablendialogfeld zu öffnen.
Die Variablenliste wird geöffnet.

2. Klicken Sie auf Neu erstellen.
Folgende Inputfelder für die Variable werden angezeigt:

l Name (obligatorisch)
l Definition
l Beschreibung
l Tags

Drücken Sie Esc oder klicken Sie auf Abbrechen, um das Erstellen der neuen Variablen
abzubrechen.

3. Geben Sie einen Namen für die Variable ein (obligatorisch). Beachten Sie bei der Wahl des
Namens Folgendes:

l Sie können den Namen nicht mehr ändern, nachdem Sie die Variable erstellt haben.
l Verwenden Sie einen Buchstaben als erstes Zeichen, keine Ziffer und kein Symbol.
l Es wird nicht empfohlen, für eine Variable in Qlik Sense denselben Namen wie für ein

Feld oder eine Funktion zu verwenden.
Weitere Informationen finden Sie unter So werden Namen interpretiert (page 171).

l Verwenden Sie die folgenden Zeichen nicht, wenn Sie eine Variable benennen: $ ( ) [ 

] "

l Der Name muss eindeutig sein. Sie können eine Variable nicht mit einem Namen für
eine reservierte Variable oder eine Systemvariable benennen. Diese Variablen sind im
Variablendialogfeld nicht aufgeführt. Wenn Sie aber einen bestimmten Namen nicht
verwenden dürfen, obwohl Sie im Variablendialogfeld keine andere Variable mit
diesem Namen finden können, so bedeutet das, dass es bereits eine reservierte
Variable oder Systemvariable mit diesem Namen gibt.

l Lange Namen sollten vermieden werden. Wenn ein Variablenname zu lang ist, kann er
in der Variablenliste nicht komplett angezeigt werden.

4. Geben Sie optional eine Beschreibung für die Variable ein.
5. Erstellen Sie eine Definition für die Variable. Sie können den Ausdruck löschen, indem Sie auf

klicken.
Weitere Informationen finden Sie unter Working with the expression editor (page 161).

Beispiel:

Legen Sie den Variablenwert auf das heutige Datum fest, das als Zahl dargestellt wird: 
Num(Today())

6. Geben Sie optional Tags für die Variable ein.
7. Klicken Sie auf Erstellen, um die Variable zu speichern.

Bearbeiten einer Variablen
Variablen können über das Dialogfeld „Variablen“ bearbeitet werden.
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Sie können Variablen bearbeiten, die im Skript im Variablendialogfeld definiert sind.
Wenn Sie das Skript neu laden, werden Ihre Änderungen aber gelöscht.

Gehen Sie folgendermaßen vor:

1. Klicken Sie bei der Bearbeitung eines Arbeitsblatts in der Bearbeitungsleiste auf , um das
Variablendialogfeld zu öffnen.
Das Variablendialogfeld wird geöffnet.

2. Klicken Sie in der Zeile der Variablen, die Sie löschen möchten, auf und wählen Sie
Löschen aus.

3. Bearbeiten Sie die Variable nach Wunsch.
4. Klicken Sie auf Speichern.

Löschen einer Variablen
Sie können Variablen aus einer nicht veröffentlichten App löschen, indem Sie sie aus
dem Variablendialogfeld löschen.

Gehen Sie folgendermaßen vor:

1. Klicken Sie bei der Bearbeitung eines Arbeitsblatts in der Bearbeitungsleiste auf , um das
Variablendialogfeld zu öffnen.
Das Variablendialogfeld wird geöffnet.

2. Wählen Sie die Variable aus, die Sie löschen möchten, und klicken Sie auf Löschen. Sie
können bis zu 20 Variablen auswählen.
Sie können auch in der Zeile der Variable, die Sie löschen möchten, auf klicken und
Löschen auswählen.

Wenn Sie eine Variable aus dem Skript entfernen und die Daten erneut laden,
verbleibt die Variable in der App. Falls Sie die Variable vollständig aus der App
entfernen möchten, müssen Sie sie auch über das Variablendialogfeld löschen.

Das Löschen einer Variable kann nicht rückgängig gemacht werden.

3. Klicken Sie auf Löschen.

Beispiele zur Verwendung einer Variablen in einer Formel
Eine Variable in Qlik Sense ist ein benanntes Element, das einen Datenwert enthält.
Wird eine Variable in einer Formel verwendet, wird diese durch ihren Wert oder die
Definition der Variablen ersetzt.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 169



3   Visualizations

Verwenden von Variablen in Formeln
Eine Variable kann auf zwei verschiedene Weisen verwendet werden: in einem direkten Bezug oder
in einer Dollarzeichenerweiterung. Wenn Sie einen direkten Bezug verwenden, wird der
Variablenwert in der Berechnung verwendet. Wenn Sie eine Dollarzeichenerweiterung verwenden,
wird die gesamte Dollarzeichenerweiterung durch den Variablenwert ersetzt, bevor die Formel
analysiert wird. Daher können die beiden unterschiedlichen Methoden verschiedene Ergebnisse
liefern.

Beispiel: Verwenden einer Variablen mit Dollarzeichenerweiterung
Die Variable x enthält den Textstring Sum(Sales).

In einem Diagramm können Sie die Formel $(x)/12 definieren. Die Wirkung ist genau dieselbe, wie
wenn die Diagrammformel Sum(Sales)/12 lautet.

Ändern Sie jedoch den Wert der Variablen x zu beispielsweise Sum(Budget), werden die Daten im
Diagramm sofort neu berechnet, da die Formel als Sum(Budget)/12 interpretiert wird.

Beim Einsatz von Variablen in Formeln können Sie die verwendete Formel in
verschiedenen Diagrammen gleichzeitig verwenden, indem Sie die Variable bearbeiten.

Beispiel: Verwenden einer Variablen mit Dollarzeichen-
Erweiterung in einer Pivottabelle
Angenommen, Sie haben eine Pivottabelle oder ein Pivot-Objekt, das Folgendes enthält:

l Die Dimensionen sind Product Type und Product Name.
l Die Kennzahlen sind Sum(Sales) und Count (distinct InvoiceNumber).
l Die Elemente unter Spalten sind Werte (Standard) und das Feld Quarter.

You can use variables to encourage interactive analysis. Suppose you also create a variable
vUserInteraction with a blank definition. Then, you create two Button charts on your sheet,
configured with the Set variable value action:

l Show more detail: Clicking this button sets vUserInteraction to a value of ='Yes'.
l Show less detail: Clicking this button sets vUserInteraction to a value of ='No'.

In your pivot table, you could add a number of additional measures to the chart, such as Count
(Quantity) and Sum(Cost). Then, configure each measure column to have the following value for
Show column if:

'$(Reference)'='Yes'

This allows the chart to adapt to whether or not the user wants additional information. If the user
clicks the Show more detail button, additional measures are added to the table. If not, or if they
click Show less detail, the additional measures are removed.
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Weitere Beispiele: Verwenden von Variablen in Dollarzeichen-
Erweiterungen
Dollarzeichen-Erweiterungen sind ein vielseitiges und leistungsstarkes Werkzeug in Qlik Sense mit
vielen möglichen Verwendungen. Weitere Beispiele finden Sie unter Vorschau der Dollarzeichen-
Erweiterung.

Beispiel: Direkte Referenzierung einer Variablen in einer Formel
Die Verwendung einer Variablen als direkte Referenz ist weniger üblich, aber dennoch nützlich. Zum
Beispiel:

Nehmen wir an, Sie haben ein Feld TransactionSummary in Ihrem Datenmodell, das
Zusammenfassungen von Transaktionen in Freitextform enthält. Dieses Feld kann zusätzliche
Informationen über Transaktionen enthalten. Ein Beispiel: Eine Transaktion könnte eine
Zusammenfassung enthalten, um zu dokumentieren, dass der Kunde einen Artikel mit einem
Ladenguthaben gekauft hat, oder um alle Probleme zu dokumentieren, die während des Verkaufs
aufgetreten sind.

In Ihrer App möchten Sie TransactionSummary verwenden, aber Sie möchten den Daten Kontext
hinzufügen, ohne das Datenmodell oder das Ladeskript zu beeinflussen und ohne diesen Kontext
an anderer Stelle im Diagramm zu speichern.

Sie könnten Folgendes tun:

1. Erstellen Sie im Variablendialogfeld eine Variable mit dem Namen vIntroStatement mit der
folgenden Definition:
='The following summary was provided by the vendor: '

2. Fügen Sie die folgende Kennzahl zu einem Text und Bild-Diagramm hinzu:
vIntroStatement & TransactionSummary

Wenn Sie den einleitenden Befehl als Variable speichern, können Sie die Verwendung eines Wertes
zentral steuern. Zum Beispiel könnte die Variable vIntroStatement in mehreren Diagrammen und
innerhalb einer Reihe verschiedener Kennzahlen verwendet werden (z. B. könnte es ein separates
Diagramm geben, das manchmal Text enthält, der beschreibt, wie viele Einheiten während der
Transaktion verkauft wurden). Durch die Verwendung einer Variablen können Sie den Prozess der
Aktualisierung von Formeln in der App vereinfachen. Um eine Änderung am Wortlaut vorzunehmen,
aktualisieren Sie einfach die Variable und die Änderungen werden in der gesamten App
übernommen.

So werden Namen interpretiert
Es wird nicht empfohlen, für eine Variable in Qlik Sense denselben Namen wie für ein Feld oder eine
Funktion zu verwenden. Aber wenn Sie es tun, müssen Sie wissen, wie sie in einer Formel
anzuwenden sind.

Beispiel:

Die Zeichenfolge XXX steht für ein Feld, eine Variable, eine Funktion oder eine Kennzahl. Je
nachdem, wie Sie die Formel erstellen, wird XXX als eine davon interpretiert.
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Formel XXX interpretiert als

XXX Kennzahl, Variable oder Feld

$(XXX) Variable

Count(XXX) Feld oder Variable

XXX() Funktion

Beispiele für die Interpretation von Namen

Wenn Sie ein Element benennen, müssen Sie vermeiden, den gleichen Namen mehr als einem Feld,
einer Variablen oder einer Kennzahl zuzuweisen. Beim Auflösen von Konflikten zwischen Elementen
mit identischen Namen wird eine strikte Reihenfolge eingehalten. Diese Reihenfolge gilt auch bei
allen Objekten oder Kontexten, in denen diese Elemente verwendet werden. Diese Reihenfolge
lautet wie folgt:

l Innerhalb einer Aggregierung hat ein Feld Vorrang vor einer Variablen.
Kennzahlbezeichnungen sind in Aggregierungen nicht relevant und haben keine Priorität.

l Außerhalb einer Aggregierung hat eine Kennzahlbezeichnung Vorrang vor einer Variablen,
die wiederum Vorrang vor einem Feldnamen hat.

l Zudem kann außerhalb einer Aggregierung eine Kennzahl wiederverwendet werden, indem
ihre Bezeichnung referenziert wird, es sei denn, es handelt sich um eine berechnete
Bezeichnung. In dieser Situation reduziert sich die Bedeutung der Kennzahl, um das Risiko
eines Selbstbezugs zu verringern, und in diesem Fall wird der Name immer zuerst als
Kennzahlbezeichnung interpretiert, an zweiter Stelle als Feldname und an dritter Stelle als
Variablenname.

Als bewährtes Verfahren sollten Sie eine standardisierte Namenskonvention für die Variablen
verwenden, die Sie in einer App erstellen. Sie könnten zum Beispiel sicherstellen, dass alle Ihre
Variablennamen mit v beginnen. Beispiel: vUserText. Dies trägt dazu bei, dass Variablen schnell als
solche erkannt und von Kennzahlen, Feldern und Funktionen unterschieden werden können.

Variable Berechnung
Variablen mit berechneten Werten lassen sich in Qlik Sense vielfältig einsetzen, und das Ergebnis
hängt von der Definition und der Art und Weise des Abrufs in einer Formel ab.

Dieses Beispiel erfordert das Laden der folgenden Daten in den Dateneditor:

LOAD * INLINE [

Dim, Sales

A, 150

A, 200

B, 240

B, 230

C, 410

C, 330

];

Definieren wir zwei Variablen über das Variablendialogfeld:
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l Name vSales Definition'Sum(Sales)'
l Name vSales2 Definition'=Sum(Sales)'

Bei der zweiten Variable wird ein Gleichheitszeichen vor der Formel hinzugefügt. Dadurch wird die
Variable berechnet, bevor sie erweitert und die Formel evaluiert wird.

Wird die Variable vSales beispielsweise in einer Kennzahl alleine verwendet, ist das Ergebnis der
String Sum(Sales), das heißt, es erfolgt keine Berechnung.

Wenn Sie ein Dollarzeichen hinzufügen und $(vSales) in der Formel abrufen, wird die Variable
erweitert und die Summe von Sales angezeigt.

Wenn Sie $(vSales2) abrufen, wird die Variable vor ihrer Erweiterung berechnet. Dadurch wird als
Ergebnis die Gesamtsumme von Sales angezeigt. Der Unterschied zwischen der Verwendung von
=$(vSales) und =$(vSales2) als Kennzahlformeln wird in dieser Tabelle mit den Ergebnissen
verdeutlicht:

Dim $(vSales) $(vSales2)

A 350 1560

B 470 1560

C 740 1560

Ergebnisse

Daraus ist ersichtlich, dass $(vSales) die Partialsumme eines Dimensionswerts ergibt, während
$(vSales2) die Gesamtsumme liefert.

Siehe auch:

Working with the expression editor (page 161)

Verwendung der Skripterstellung auf Diagrammebene in
Visualisierungen
Mit Skripterstellung auf Diagrammebene können Sie den Ergebnissen einer
Visualisierung skriptähnliche Funktionen hinzufügen. Sie ergänzt Diagrammformeln, da
Skripterstellung auf Diagrammebene Steuerungsbefehle wie Schleifen und rekursive
Aktionen für komplexere mathematische Berechnungen zulässt. Sie können auch
mehrere Spalten ändern, solange ein Platzhalter im Diagramm vorhanden ist, und neue
Zeilen zu einem Ergebnis hinzufügen.

Skripterstellung auf Diagrammebene kann für die meisten Visualisierungstypen verwendet werden,
und Sie können über das Eigenschaftsfenster darauf zugreifen. Manche Visualisierungen oder
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spezifischen Konfigurationen unterstützen Skripterstellung auf Diagrammebene nicht. In diesen
Fällen haben Sie keinen Zugriff auf die Skripterstellung auf Diagrammebene über das
Eigenschaftsfenster, oder Sie erhalten eine Fehlermeldung.

Wenn Sie Diagrammdaten ändern, verwenden Sie einen Teil des Qlik Sense-Skripts, der aus einer
Reihe von Befehlen besteht. Weitere Informationen finden Sie unter Skripterstellung auf
Diagrammebene.

Skripterstellung auf Diagrammebene wird in den App-Einstellungen aktiviert. Wenn sie aktiviert ist,
wird eine Steuerung Skripte im Abschnitt Daten des Eigenschaftsfensters für eine Visualisierung
angezeigt. Weitere Informationen finden Sie unter Aktivieren der Skripterstellung auf
Diagrammebene.

Auch wenn die Option deaktiviert ist, werden vorhandene Diagrammskripte verarbeitet. Durch die
Deaktivierung der Option, nachdem verfasste Inhalte entwickelt wurden, kann verhindert werden,
dass neue Diagrammskripte von anderen Benutzern erstellt werden.

Hinzufügen eines Diagrammskripts zu einer Visualisierung
Sie können Diagrammskripte zu vorhandenen Visualisierungen oder bei der Erstellung neuer
Visualisierungen hinzufügen.

Bevor Sie ein Diagrammskript zu einer Visualisierung hinzufügen, muss Skripterstellung auf
Diagrammebene in der App aktiviert werden. Weitere Informationen finden Sie unter Aktivieren der
Skripterstellung auf Diagrammebene.

Damit Sie ein Diagrammskript zu einer Visualisierung hinzufügen können, müssen Sie sich im Modus
Arbeitsblatt bearbeiten befinden, und Erweiterte Optionen muss aktiviert sein.

Hinzufügen von Diagrammskripten zu einer neuen Visualisierung

Gehen Sie folgendermaßen vor:

1. Ziehen Sie die Visualisierung aus dem Extras-Fenster auf das Arbeitsblatt oder doppelklicken
Sie auf die Visualisierung.

2. Fügen Sie der Visualisierung auf der Registerkarte Daten Dimensionen und Kennzahlen
hinzu.

3. Ebenfalls auf der Registerkarte Daten fügen Sie im Abschnitt Skripte ein Diagrammskript
hinzu.
Pro Visualisierung können maximal fünf Diagrammskripte hinzugefügt werden.

Hinzufügen von Diagrammskripten zu einer vorhandenen Visualisierung

Gehen Sie folgendermaßen vor:

1. Wählen Sie im Modus Arbeitsblatt bearbeiten die Visualisierung aus.

2. Fügen Sie auf der Registerkarte Daten im Abschnitt Skripte ein Diagrammskript hinzu.
Pro Visualisierung können maximal fünf Diagrammskripte hinzugefügt werden.
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Beispiel
Bei diesem Beispiel wird davon ausgegangen, dass Sie eine Visualisierung, z. B. ein
Balkendiagramm, erstellt und eine Dimension und eine Kennzahl hinzugefügt haben.

In diesem Beispiel werden die Werte der ersten Dimension in umgekehrter Reihenfolge in die erste
Kennzahl eingegeben.

Let P = HCNoRows();

For J = 1 to P

Put #hc1.measure.1(J) = HCValue(#hc1.dimension.1, P - J + 1);

Next

Einschränkungen der Skripterstellung auf Diagrammebene
Im Standardbearbeitungsmodus kann die Skripterstellung auf Diagrammebene nicht verwendet
werden.

Skripterstellung auf Diagrammebene funktioniert nicht für Visualisierungen, für die
Diagrammvorschläge aktiviert ist.

Pro Visualisierung können maximal fünf Diagrammskripte hinzugefügt werden.

Für die folgenden Visualisierungen ist Skripterstellung auf Diagrammebene nicht verfügbar:

l Balkendiagramme im gestapelten Modus
Wenn Sie ein Diagrammskript im gruppierten Modus erstellt haben und zum gestapelten
Modus wechseln, wird ein Fehler über ungültigen Hypercube angezeigt.

l Boxplot
l Schaltfläche
l Verteilungsdiagramm
l Filterfenster
l Liniendiagramme mit zwei Dimensionen
l Pivottabelle
l Text und Bild
l Baumkarte
l Matrixdiagramm (Visualization Bundle)
l Gittercontainer (Visualization Bundle)

Searching in the assets panel
Suchen Sie über das Suchfeld nach Objekten. Durch die Eingabe in das Suchfeld
werden Elemente angezeigt, bei denen der Name oder ein Tag das Suchwort enthält.

The search function is not case sensitive.

When editing a sheet, use the assets panel to search for items you can use for building the app.
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When a matching string is found in a tag, it is indicated by a tag icon in the search result. Click an
item in the list of results to preview it.

Searching for "inv" among the measures presents any measure that contains that string in its name or a tag.

Searching in sheet analysis mode
Search for exploration-related assets when you are viewing a sheet in analysis mode. For example,
you search for sheets, bookmarks, notes, or key driver analyses.
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Searching for sheets in the assets panel

Gestalten von Visualisierungen mit Direct Discovery
Gestalten von Visualisierungen aus Direct Discovery-Feldern erfordert etwas
Hintergrundwissen über die Struktur der Feldtypen, die verwendet werden können.
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Direct Discovery-Felder in Visualisierungen

DIMENSION
l Der Feldtyp Direct Discovery DIMENSION kann auf die gleiche Weise verwendet werden wie

alle andere Dimensionen.

MEASURE
l Ein Direct Discovery MEASURE muss mit einer der gemeinsamen Funktionen aggregiert

werden, bevor er in einer Visualisierung verwendet werden kann.
l Ein normales Feld, das auf ein Arbeitsblatt gezogen wird, verwandelt sich in eine Filterbox.

Dies gilt jedoch nicht für ein Direct Discovery MEASURE, da dieses zuerst aggregiert werden
muss.

DETAIL
Der Feldtyp Direct Discovery DETAIL kann nur in Tabellen und nicht in Kombination mit einer
Kennzahl verwendet werden.

Wenn Sie eine Tabelle mit einem Direct Discovery DETAIL-Feld erstellen und die Zahl der
abzurufenden Reihen einen im Ladeskript definierten Wert übersteigt (standardmäßig
1000 Reihen), erscheint möglicherweise eine Warnmeldung und die Tabelle kann
ungültig sein. Damit die Tabelle normal funktioniert, versuchen Sie in der App Auswahlen
zu treffen, die den Datensatz reduzieren.

Diese Funktion ist nicht in allen Ausgaben von Qlik Sense verfügbar.

3.3 Best practices for choosing visualization types
A good visualization clearly presents relationships among many values, and lets you
analyze data at a glance. Qlik Cloud Analytics offers a range of Qlik Sense
visualizations and charts. Each chart excels at visualizing data in different ways for
different purposes. You should select your charts by deciding what you want to see
from the data in your charts.

If you are unsure of what visualizations to use, Qlik Sense can offer recommendations. For more
information, see Creating visualizations with Insight Advisor (page 580) and Visualisierungen
mithilfe von Insight Advisor Diagrammvorschlägen erstellen (page 608).

The following lists the purposes for viewing data and the chart type recommended to achieve that
purpose:
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Viewing comparisons
Comparison charts are used to compare values against each other. They show the differences in
values, such as the difference between categories, or how values are changing over time.

Questions that might be answered by comparison charts include:

l What product has the highest total sales this year?
l How have product sales risen or fallen over the last 24 months?

Chart type Common purpose

Bar chart (page 186) Comparing categories against the same measure or measures.

Line chart (page 253) Comparing trends over time.

Combo chart (page 213) Comparing measures that are different in scale.

Chart types for viewing comparisons

If you want to compare different values of the same dimension, you can use alternate states.

Viewing relationships
Relationship charts are used to explore how values relate to each other. A relationship chart allows
you to find correlations, outliers, and clusters of data.

Questions that might be answered by relationship charts include:

l Is there a correlation between advertising spending and sales for our products?
l How do expenses and income vary per region?

Chart type Common purpose

Scatter plot (page
355)

Viewing the relationship between two or three measures for a
dimension.

Chart types for viewing relationships

Viewing compositions
Composition charts take a total value and discover what component values make up that total.
Composition charts can be static, showing the current composition of a total value, or they can
show how the composition of a total value changes over time. Composition charts can display
compositions either by percentage of the total value or the fixed values in the total value.

Questions that might be answered by composition charts include:

l What percentages of our total sales come from which regions?
l What is each department's allotment of our total quarterly budget over the past year?
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Chart type Common purpose

Bar chart (page 186) Viewing the changing composition of a value over a short period of time.

Line chart (page 253) Viewing the changing composition of a value over a long period of time.

Pie chart (page 337) Viewing the static composition of a value.

Waterfall chart (page
395)

Viewing the static composition of a value with accumulation or
subtraction to the total.

Treemap (page 387) Viewing the static composition of a value's accumulation to the total.

Chart types for viewing compositions

Viewing distributions
Distribution charts are used to explore how the values within data are grouped. Distribution charts
show you the shape of your data, the range of its values, and possible outliers.

Questions that might be answered by distribution charts include: 

l What is the number of customers per age group?
l What cities have the highest use of our services?

Chart type Common purpose

Histogram (page 243) Viewing the how data is distributed over intervals.

Scatter plot (page 355) Viewing the distribution of two measures.

Distribution plot (page 223) Viewing the distribution of measure values in a dimension.

Box plot (page 202) Viewing the range and distribution of numerical data.

Chart types for viewing distributions

Viewing performances
Performance charts provide a quick view of a performance measure. Looking at a performance
chart, a user can quickly identify the measure value and whether the results are as expected or not.

Questions that might be answered by performance charts include:

l What are the current total sales for this quarter?
l Are current total sales for this quarter meeting the projected sales for the quarter?
l How is performance for this product line compared with other product lines?

Chart type Common purpose

Bullet chart (page 208) Comparing performance of a measure for several dimensions.

Gauge (page 239) Viewing a performance value to understand performance
immediately.

Chart types for viewing performances
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Chart type Common purpose

KPI (page 248) Viewing one or two performance measures.

Text & image (page
383)

Viewing text or several measures with an image.

Viewing data
Data charts present detailed data rather than a visualization of the data. Data charts are useful
when you need to view precise values, and when you want to compare individual values.

Questions that might be answered by data charts include:

l What are the records for each transaction for this month?
l What are the quantity and sales for each item in each product group for each of our

customers?

Chart type Common purpose

Table (page 364) Viewing precise values from your data without trends or patterns.

Pivot table (page 343) Viewing precise value for several dimensions and measures.

Chart types for viewing data

Viewing geography
Geographical charts let you visualize your data by geography, displaying your data on a map either
as points or areas.

Common questions that might be answered by geographical charts include:

l What cities have the highest use of our services?
l Which countries have the most customers?

Chart type Common purpose

Map chart (page 260) Viewing data represented geographically by point or area.

Chart types for viewing geography

What if no standard chart suits my purpose?
You can use controls or objects from a bundle supplied by Qlik:

l Dashboard bundle (page 425)
l Visualization bundle (page 462)

You can also create custom visualization objects if none of the standard charts provided fit your
requirements for visualizing your data.
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For more information, see Erstellen einer Visualisierung mit einem benutzerdefinierten Objekt (page
620).

3.4 Visualisierungen
Mithilfe von Visualisierungen können Sie die in die App geladenen Daten darstellen. Sie
können beispielsweise ein Balkendiagramm zum Vergleich der Umsatzwerte für
verschiedene Regionen oder eine Tabelle mit genauen Werten für dieselben Daten
verwenden.

Die von Ihnen in einer Visualisierung vorgenommenen Einstellungen spiegeln sich in allen
zugehörigen Visualisierungen auf allen Arbeitsblättern wider.

Erstellen einer Visualisierung
Sie erstellen Visualisierungen aus vordefinierten Diagrammen oder benutzerdefinierten Objekten.
Damit Sie dem Arbeitsblatt eine Visualisierung hinzufügen können, müssen Sie sich im
Bearbeitungsmodus befinden.

1. Ziehen Sie die Visualisierung aus dem Extras-Fenster auf das Arbeitsblatt oder doppelklicken
Sie auf die Visualisierung.

2. Fügen Sie der Visualisierung Dimensionen und Kennzahlen hinzu. Welche Anzahl von
Dimensionen und Kennzahlen benötigt wird, hängt von der ausgewählten Visualisierung ab.
Dimensionen legen fest, wie die Daten in einer Visualisierung gruppiert werden. Beispiel:
Gesamtumsatz pro Land oder Anzahl der Produkte pro Anbieter Weitere Informationen
finden Sie unter Dimensions (page 101).
Bei Kennzahlen handelt es sich um in Visualisierungen verwendete Berechnungen, die
normalerweise auf der Y-Achse eines Balkendiagramms oder in einer Tabellenspalte
dargestellt werden. Kennzahlen werden aus einer Formel berechnet, die sich aus
Aggregierungsfunktionen wie beispielsweise Sum oder Max zusammensetzt und mit einem
oder mehreren Feldern kombiniert wird. Weitere Informationen finden Sie unter Kennzahlen
(page 107).

3. Passen Sie die Darstellung an, beispielsweise die Sortierung, Farbgebung oder Beschriftung.

Sie können von einem Visualisierungstyp zu einem anderen konvertieren, indem Sie ein neues
Diagramm in eine Visualisierung auf einem Arbeitsblatt ziehen.

Andere Methoden zum Erstellen einer Visualisierung finden Sie unter Erstellen und Bearbeiten von
Visualisierungen (page 574).

Wiederverwenden einer Visualisierung
Wenn Sie eine Visualisierung erstellt haben, die Sie in anderen Arbeitsblättern der App
wiederverwenden möchten, können Sie sie als Master-Visualisierung speichern. Sie können
Master-Visualisierungen nur in einer nicht veröffentlichten App erstellen. Nach der Veröffentlichung
der App können alle Benutzer die Visualisierung ihren eigenen Arbeitsblättern hinzufügen, sie aber
nicht ändern.
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Klicken Sie mit der rechten Maustaste auf eine Visualisierung und wählen Sie Zu
Master-Elementen hinzufügen aus, um sie als Master-Visualisierung zu speichern.

Sie können Master-Visualisierungen im Extras-Fenster unter finden.

Welche Visualisierungen sind verfügbar?
Im Extras-Fenster sind zwei Grundtypen von Visualisierungen verfügbar.

l Diagramme veranschaulichen die Daten mit visuellen Elementen wie Balken, Linien oder
Punkten.

l Textbasierte Visualisierungen stellen Daten in Textform dar. Dies gilt beispielsweise für
Tabellen oder Filter.

Im Extras-Fenster sind Dashboard-Objekte verfügbar.

Die beste Wahl eines Diagrammtyps hängt vom Zweck der Visualisierung ab.

Wenn die vordefinierten Visualisierungen für Ihre Zwecke nicht ausreichen, können Sie eine
Visualisierungserweiterung verwenden. Beide finden Sie im Extras-Fenster unter .

Diagramm Symbol Beschreibung

Balkendiagramm Das Balkendiagramm zeigt einen
Balken für jeden Dimensionswert an.
Die Länge des Balkens entspricht
jeweils dem numerischen Wert seiner
Kennzahl.

Boxplot Der Boxplot dient zum Vergleichen
von Bereich und Verteilung von
Gruppen mit Zahlendaten und wird
durch eine Box mit Whiskern und
eine Mittellinie dargestellt.

Bullet-Diagramm Bullet-Diagramme können
verwendet werden, um die Leistung
einer Kennzahl anzuzeigen und mit
einem Zielwert und einer qualitativen
Skala wie schlecht, durchschnittlich
und gut zu vergleichen.

Diagramme
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Diagramm Symbol Beschreibung

Kombi-Diagramm Ein Kombi-Diagramm kombiniert
Balken und Linien in einem einzigen
Diagramm. Die Balken und Linien
haben unterschiedliche Achsen,
sodass Prozentsätze und Summen
verglichen werden können.

Verteilungsdiagramm Verteilungsdiagramme eignen sich
zum Vergleich von Bereich und
Verteilung von Gruppen mit
numerischen Daten. Die Daten
werden als Wertpunkte entlang einer
Achse dargestellt.

Messzeiger Der Messzeiger zeigt den Wert einer
einzelnen Kennzahl ohne
Dimensionen an.

Histogramm Das Histogramm eignet sich zur
Visualisierung der Verteilung von
numerischen Daten über ein
kontinuierliches Intervall oder einen
bestimmten Zeitraum hinweg. Die
Daten sind in Klassen unterteilt.

Liniendiagramm Das Liniendiagramm stellt
Datenlinien zwischen Werten dar.
Liniendiagramme werden oft
verwendet, um Datentrends über
Zeiträume darzustellen.

Karte Die Karte kombiniert geografische
Daten und Kennzahlwerte, z. B. den
Umsatz für eine Region oder eine
Filiale.

Navigationsmenü Über das Navigationsmenü werden
dem Arbeitsblatt Arbeitsblatt-
Navigationsoptionen hinzugefügt.

Kreisdiagramm Das Kreisdiagramm zeigt das
Verhältnis zwischen einer einzelnen
Dimension und einer einzelnen
Kennzahl an.
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Diagramm Symbol Beschreibung

Punktdiagramm Das Punktdiagramm stellt Werte aus
zwei Kennzahlen dar. Dies ist
hilfreich, wenn jedem
Dimensionswert zwei Formelwerte
zugeordnet werden sollen (z. B.
Bevölkerungszahl und
Bevölkerungswachstum pro Land).
Eine dritte Kennzahl kann optional
verwendet werden und wird dann in
der Größe der Punkte
widergespiegelt. Beim Anzeigen
großer Datensätze werden zur
Darstellung der Kennzahlgröße
Farben anstelle der Punktgröße
verwendet.

Baumkarte Die Baumkarte zeigt hierarchische
Daten. Baumkarten können
gleichzeitig eine große Zahl von
Werten auf begrenzter Fläche
anzeigen.

Wasserfalldiagramm Das Wasserfalldiagramm zeigt, wie
ein Anfangswert durch positive und
negative Zwischenwerte beeinflusst
wird.

Visualization bundle
(page 462)

Das Visualization bundle ist ein
Diagrammsatz, der zur Verbesserung
und Erhöhung der
Diagrammabbildungsfähigkeit Ihrer
Qlik Sense App verwendet werden
kann.

Diagramm Symbol Beschreibung

Filterfenster Das Filterfenster lässt Sie festlegen, welche
Daten in den Visualisierungen auf einem
Arbeitsblatt dargestellt werden. Ein
Filterfenster kann die Daten mehrerer
Dimensionen gleichzeitig filtern.

Textbasierte Visualisierungen
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Diagramm Symbol Beschreibung

KPI Die KPI dient dazu, essenzielle
Leistungskennzahlen zu präsentieren. Sie
können Links zu einem Arbeitsblatt
hinzufügen.

Pivottabelle Eine Pivottabelle stellt Dimensionen und
Kennzahlen als Zeilen und Spalten einer
Tabelle dar. In einer Pivottabelle können Sie
Daten gleichzeitig in mehreren Dimensionen
analysieren. Die Daten in einer Pivottabelle
können anhand einer Kombination der
Dimensionen gruppiert werden und es
können Teilsummen angezeigt werden.

Tabelle Eine Tabelle zeigt Werte als Datensätze an.
Jede Zeile der Tabelle enthält dabei Felder,
die mithilfe von Kennzahlen berechnet
wurden. Typischerweise enthält eine Tabelle
eine Dimension und mehrere Kennzahlen.

Text und Bild Sie können die Text- und Bildvisualisierung
verwenden, um Text, Bilder, Kennzahlen und
Links zu einem Arbeitsblatt hinzuzufügen.

Objekt Symbol Beschreibung

Schaltfläche Sie können Schaltflächen verwenden, um
schnelle Links für die einfache Auswahl und
Navigation in Ihrer App hinzuzufügen.

Sammelbox Sie können die Visualisierungen einem
begrenzten Bereich hinzufügen und sie in der
Sammelbox anhand von Bedingungen
anzeigen oder ausblenden.

Dashboard
bundle (page
425)

Ein Satz von Steuerelementen, die Sie zum
Verbessern der Navigation und Auswahl in
Ihrer Qlik Sense App nutzen können.

Dashboard-Objekte

Bar chart
The bar chart is suitable for comparing multiple values. The dimension axis shows the
category items that are compared, and the measure axis shows the value for each
category item.
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In the image, the dimension values are different regions: Nordic, USA, Japan, UK, Spain, and
Germany. Each region represents a dimension value, and has a corresponding bar. The bar height
corresponds to the measure value (sales) for the different regions.

You can make more complex comparisons of data by using grouped or stacked bars. This requires
using two dimensions and one measure. The two example charts use the same two dimensions and
the same measure:
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Grouped bars: With grouped bars, you can easily compare two or more items in the same
categorical group.

Stacked bars: With stacked bars it is easier to compare the total quantity between different months.
Stacked bars combine bars of different groups on top of each other and the total height of the
resulting bar represents the combined result.

The bar chart can be displayed horizontally or vertically, as in the example below:
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When to use it
Grouping and stacking bars makes it easy to visualize grouped data. The bar chart is also useful
when you want to compare values side by side, for example sales compared to forecast for
different years, and when the measures (in this case sales and forecast) are calculated using the
same unit.

Advantages: The bar chart is easy to read and understand. You get a good overview of values when
using bar charts.

Disadvantages: The bar chart does not work so well with many dimension values due to the
limitation of the axis length. If the dimensions do not fit, you can scroll using the scroll bar, but then
you might not get the full picture.

Creating a bar chart
You can create a simple bar chart on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty bar chart to the sheet.
2. Klicken Sie auf Dimension hinzufügen und wählen Sie eine Dimension oder ein Feld aus.
3. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine

Kennzahl aus einem Feld.

In a bar chart you need at least one measure.

You can include up to two dimensions and one measure, or one dimension and up to 15 measures in
a bar chart. Each bar corresponds to a dimension, and the values of the measures determine the
height or length of the bars.

You can also create a bar chart with no dimension and up to 15 measures. In this case, one bar is
displayed for every measure. The value of the measure determines the height or length of a bar.
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Dimensions Measures Result

1 dimension 1 measure A simple bar chart with one bar for each dimension value.

2 dimensions 1 measure A grouped or a stacked bar chart with one bar for each value of
the two dimensions.

No dimension up to 15
measures

A simple bar chart with one bar for each measure.

1 dimension up to 15
measures

A grouped or a stacked bar chart with one bar for each value of
each measure.

Creating a bar chart

When you have created the bar chart, you may want to adjust its appearance and other settings in
the properties panel.

Styling the bar chart
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 190



3   Visualizations

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font, font size, and color for the following text elements:
l Achsentitel: Legen Sie das Design der Titel auf den Achsen fest.
l Achsenbeschriftung: Legen Sie das Design der Beschriftungen auf den Achsen fest.
l Value labels: Style the labels which display the measure value for each dimension

value.
Wenn Sie die Präsentationsoption Gestapelt verwenden, steuert diese Einstellung
Segmentbezeichnungen (Kennzahlenwerte für jeden Dimensionswert) und
Gesamtwertebezeichnungen (kombinierte Kennzahlenwerte für jeden
Dimensionswert).

l Legendentitel: Legen Sie das Design des Legendentitels fest.
l Legendenbezeichnungen: Legen Sie das Design der Bezeichnungen für die einzelnen

Legendenelemente fest.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the bar segment outline and bar width
You can adjust the outline surrounding each bar segment in the chart, as well as the width of the
bars.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Chart tab of the styling panel, under Outline, set the thickness and color of the
outlines.

4. Adjust the slider for Bar width to set the width of the bars.

Customizing the border and shadow
You can customize the border and shadow of the chart.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Adding trend lines
You can add trend lines to the chart. Use trend lines to visualize how data changes over time.

For more information about trend lines, see Trendlinien (page 112).

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Data section.
2. Under Measures, expand the measure for which you are adding trend lines.
3. Under Trend lines, click Add trend line.
4. Define the Label and Type for the trend line.
5. Use the Colors slider to define Custom or Auto coloring.
6. Use the checkbox to toggle a Dashed appearance on or off.

Showing or hiding dimensions and measures depending on a condition
Sie können eine Dimension oder Kennzahl ein- oder ausblenden, je nachdem, ob eine Bedingung
wahr oder falsch ist. Dies wird als Anzeigebedingung bezeichnet und wird als Formel eingegeben.
Die Dimension oder Kennzahl wird nur angezeigt, wenn die Formel in diesem Feld als wahr bewertet
wird. Wenn dieses Feld leer ist, wird die Dimension oder Kennzahl immer angezeigt. Erweitern Sie
die Dimension oder Kennzahl im Abschnitt Daten des Eigenschaftsfensters und geben Sie eine
Formel unter Dimension anzeigen, wenn oder Kennzahl anzeigen, wenn ein.

Benutzerdefinierte Quickinfos sind für ein Balkendiagramm deaktiviert, wenn eine der
Dimensionen im Diagramm eine Anzeigebedingung verwendet.

Angenommen, Sie haben einen Datensatz, der u. a. die Felder City, Manager und Sales enthält. Sie
können Ihr Balkendiagramm so konfigurieren, dass aggregierte Umsätze zusammen mit einer
Dimension mit dem Namen City angezeigt werden. Sie können eine zweite Dimension (Manager)
hinzufügen, aber die Daten nur dann nach dieser Dimension organisieren, wenn mehr als drei
Managernamen mit Ihren Umsatzdaten verknüpft sind.
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Gehen Sie folgendermaßen vor:

1. Aktivieren Sie im Bearbeitungsmodus die erweiterten Optionen.
2. Ziehen Sie aus dem Extras-Fenster ein Balkendiagramm auf das Arbeitsblatt.
3. Fügen Sie City als Dimension hinzu.
4. Fügen Sie über das Eigenschaftsfenster Manager als zweite Dimension hinzu.
5. Fügen Sie Sum(Sales) als Kennzahl hinzu.
6. Erweitern Sie im Eigenschaftsfenster die Dimension Manager. Fügen Sie unter Dimension

anzeigen, wenn die folgende Formel hinzu:
Count(distinct Manager)>3

Wenn Ihre Daten nur zwei Managernamen enthalten, organisiert das Balkendiagramm die Umsätze
nicht nach Manager, da diese Formel als falsch ausgewertet wird. Wenn die Daten drei oder mehr
eindeutige Werte für Manager enthalten, werden die Umsätze sowohl nach City als auch nach
Manager organisiert.

Display limitations

Displaying large numbers of dimension values
Wenn die Anzahl der Dimensionswerte die Breite der Visualisierung übersteigt, wird ein Mini-
Diagramm mit einer Scroll-Leiste angezeigt. Sie können mithilfe der Scroll-Leiste im Mini-Diagramm
blättern oder, abhängig von Ihrem Gerät, mithilfe des Scroll-Rads oder durch Wischen mit zwei
Fingern. Werden sehr viele Werte verwendet, zeigt das Mini-Diagramm nicht mehr alle Werte an.
Stattdessen zeigt eine zusammengefasste Version des Mini-Diagramms (Elemente werden grau
angezeigt) eine Übersicht über die Werte an, wobei die sehr niedrigen und sehr hohen Werte noch
sichtbar sind. 

You can exchange the mini chart with a regular scrollbar, or hide it, with the Scrollbar
property.
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Displaying out of range values
In the properties panel, under Appearance, you can set a limit for the measure axis range. Without a
limit, the range is automatically set to include the highest positive and lowest negative value, but if
you set a limit you may have values that exceed that limit. A bar that exceeds the limit will be cut
diagonally to show that it is out of range.

When a reference line is out of range, an arrow is displayed together with the number of reference
lines that are out of range.

Displaying large amounts of data in a stacked bar chart
When displaying large amounts of data in a stacked bar chart, there may be cases when not each
dimension value within a bar is displayed with correct color and size. These remaining values will
instead be displayed as a gray, striped area. The size and total value of the bar will still be correct,
but not all dimension values in the bar will be explicit.

To remove the gray areas, you can either make a selection or use dimension limits in the properties
panel.

The approximate limit for how many stacked bars that can be displayed without gray areas is 5000
bars, assuming that each bar consists of 10 inner dimension values and one dimension value and
one measure value for the whole bar.

Die anfängliche Datenladung besteht aus 500 Dimensionswerten oder Dimensionsstapeln. (Der
Wert 500 bezieht sich auf die äußeren Dimensionswerte, nicht auf die einzelnen Dimensionswerte
in einem Stapel.) Wenn Sie über mehr als 500 Werte gescrollt sind, wird ein inkrementeller
Ladevorgang durchgeführt, bei dem die Werte basierend auf der aktuellen Ansicht oder
Scrollposition geladen werden.
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Displaying large amounts of data in a bar chart with continuous scale
If the chart uses a continuous scale, a maximum of 2000 data points can be displayed. The actual
maximum number of data points in the chart is affected by the distribution of the data. Above that
number, data points are neither displayed, nor included in selections made in the chart. Additionally,
only twelve dimension values are displayed for the second dimension in a chart with two
dimensions and continuous scale.

To avoid displaying limited data sets, you can either make a selection or use dimension limits in the
properties panel.

Colors and legend
Wenn Einfärbung nach Dimension in diesem Diagramm verwendet wird, können maximal 100
eindeutige Dimensionswerte und 100 eindeutige Farben auf der Legende aufgetragen werden.

Stacked bar charts and number formatting by measure expression
Stacked bar charts ignore number formatting by measure expression and instead will always us the
default formatting to make it consistent with the formatting of totals.

Vergleichen von Kategorien mit einer Kennzahl mit Balkendiagramm
Dieses Beispiel zeigt, wie ein Balkendiagramm zur Visualisierung von Umsatzdaten
erstellt wird und wie verschiedene Produktgruppen mit der gleichen Kennzahl
verglichen werden.
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Datensatz
In diesem Beispiel werden zwei Datendateien verwendet, die im Qlik Sense Tutorial - Aufbau einer
App verfügbar sind. Laden Sie das Tutorial herunter und blenden Sie die enthaltenen Ordner ein.
Die Dateien sind im Ordner Tutorials source verfügbar:

l Sales.xls
l Item master.xls

Um die Dateien herunterzuladen, gehen Sie zu Tutorial - Aufbau einer App.

Fügen Sie die beiden Datendateien einer leeren App hinzu und vergewissern Sie sich, dass sie
anhand der Artikelnummer (Item Number) miteinander verknüpft sind.

Der Datensatz, der geladen wird, enthält Umsatzdaten. Die Tabelle in der Datei Item master.xls
enthält die Informationen über die bestellten Artikel, beispielsweise Produktgruppen.

Kennzahl
Wir verwenden das Umsatzvolumen als Kennzahl, indem eine Kennzahl in den Master-Elementen
mit dem Namen Sales und der Formel Sum(Sales) erstellt wird.

Visualisierung
Wir fügen dem Arbeitsblatt ein Balkendiagramm hinzu und legen die folgenden Dateneigenschaften
fest:

l Dimension: Product Group (Produktgruppe).
l Kennzahl: Sales; Kennzahl, die als Master-Element erstellt wurde.

Das folgende Balkendiagramm wird erstellt. Die einzelnen Balken zeigen die Umsätze für jede
Produktgruppe an:
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Da wir jedoch an detaillierteren Informationen zum Umsatz der Produkte interessiert sind, fügen wir
Product Sub Group als Dimension hinzu. Das Feld Product Sub Group unterteilt die Produktgruppen
in Untergruppen. Beim Hinzufügen der zweiten Dimension wird standardmäßig ein gruppiertes
Diagramm ausgewählt. Wir möchten stattdessen ein gestapeltes Diagramm anzeigen. Die
entsprechende Einstellung wird im Eigenschaftenfenster unter Darstellung geändert.

Entdecken
Das Balkendiagramm visualisiert das Umsatzvolumen der verschiedenen Produktgruppen, die in
Produktuntergruppen unterteilt sind. Die Visualisierung ist in der Reihenfolge der Umsatzvolumina
nach Produkt angeordnet. Sie können den Mauszeiger über eine Produktuntergruppe bewegen und
die Details anzeigen.

Im Balkendiagramm sehen Sie, dass Produce das höchste Umsatzvolumen aufweist. Eines der
Unterprodukte macht den größten Anteil des Umsatzes von Produce aus. Wenn Sie den Mauszeiger
über den entsprechenden Teil des Balkens bewegen, sehen Sie, dass es sich dabei um Fresh
Vegetables handelt.

Akkumulieren von Werten über eine Dimension in einem Balkendiagramm
Dieses Beispiel zeigt, wie ein Balkendiagramm zum Visualisieren von Umsatzdaten, die
über eine Dimension hinweg akkumulieren, genutzt wird.
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Dataset
In diesem Beispiel wird eine Datendatei verwendet, die in der Qlik Sense Tutorial - Aufbau einer App
verfügbar ist. Laden Sie das Tutorial herunter und erweitern Sie es. Die Datei ist im Ordner der
Tutorials source verfügbar: Sales.xls

Um die Datei herunterzuladen, gehen Sie zu Tutorial - Aufbau einer App.
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Fügen Sie die Datendatei zu einer leeren App hinzu. Der Datensatz, der geladen wird, enthält
Umsatzdaten.

Kennzahl
Das Umsatzvolumen wird als die Kennzahl verwendet, die in Master-Elemente:

l Sales mit der Formel Sum(Sales) erstellt wird. Dies ist die Summe des Umsatzvolumens.

Visualisierung
Wir fügen dem Arbeitsblatt ein Balkendiagramm hinzu und legen die folgenden Dateneigenschaften
fest:

l Dimension: Month (Date.Month).
l Kennzahl: Sales; die zuvor erstellte Kennzahl.

Das folgende Balkendiagramm wird erstellt. Die einzelnen Balken zeigen die Umsätze für jeden
Monat an.

Akkumulierung
Damit die Umsatzdaten über eine Dimension hinweg akkumuliert werden, muss ein Modifikator auf
die Sales-Kennzahl angewendet werden.

Gehen Sie folgendermaßen vor:

l Legen Sie unter Kennzahl: Sales den Modifikator auf Accumulation fest. Dadurch wird die
Kennzahl so festgelegt, dass sie über eine Dimension hinweg akkumuliert.

Das Balkendiagramm sieht dann wie folgt aus, wobei die Umsätze von einem Monat zum nächsten
kumuliert werden.
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Eine visuelle Trennung der Zeiträume soll durch Hinzufügen von Quarter als zweite Dimension
erzielt werden. Das Feld Quarter gruppiert die Monatsbalken in größere Gruppen. Beim Hinzufügen
einer zweiten Dimension wird standardmäßig ein gruppiertes Diagramm ausgewählt.

Gehen Sie folgendermaßen vor:

1. Dimension hinzufügen: Quarter (Date.Quarter).
2. Legen Sie unter Kennzahl: Sales den Modifikator>Dimension auf Month fest. Damit wird die

Dimension festgelegt, für die die Akkumulierung stattfinden wird.

Wenn Übergreifend in allen Dimensionen aktiviert ist, wird die Akkumulierung übergreifend in
allen Quartalen fortgesetzt.
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Sie können sehen, dass die Balken der vorigen beiden Balkendiagramme die Gleichen sind.

Wenn Übergreifend in allen Dimensionen deaktiviert ist, beginnt die Akkumulierung zu Beginn
jedes Quartals von Neuem. Das Balkendiagramm sieht dann wie folgt aus, wobei die Umsätze
innerhalb jedes Quartals von einem Monat zum nächsten akkumuliert werden.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 201



3   Visualizations

Es empfiehlt sich, die Titel der Diagramme entsprechend deren Inhalt festzulegen. Daher sollten Sie
den Titel des neuen Balkendiagramms ändern, um anzugeben, dass die Balken jetzt
Umsatzakkumulierungen darstellen.

Entdecken
Das Balkendiagramm visualisiert das Umsatzvolumen der einzelnen Monate, in Quartalen gruppiert.
Durch die Akkumulierung des Umsatzes in jedem Quartal lässt sich das Umsatzvolumen der
einzelnen Quartale besser veranschaulichen. Sie können den Mauszeiger über einen Monat
bewegen und die Details anzeigen.

Im Balkendiagramm sehen Sie, dass Q1 das höchste Umsatzvolumen aufweist. Zudem ist zu
erkennen, dass Q4 zwar das niedrigste Umsatzvolumen hatte, die ersten beiden Monate aber
besser liefen als die Monate in Q3.

Box plot
The box plot is suitable for comparing range and distribution for groups of numerical
data, illustrated by a box with whiskers, and a center line in the middle. The whiskers
represent high and low reference values for excluding outlier values.
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You can define the box start and end points, and whiskers ranges with a few different presets, or
define your own settings using expressions.

1. First whisker
2. Box start
3. Center line
4. Box end
5. Last whisker

You can hover over a box to display a popup showing the respective values of the box
plot elements.

When to use it
The box plot is suitable for comparing range and distribution for groups of numerical data.

Advantages: The box plot organizes large amounts of data, and visualizes outlier values.

Disadvantages: The box plot is not relevant for detailed analysis of the data as it deals with a
summary of the data distribution.

Creating a box plot
You can create a box plot on the sheet you are editing.
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In a box plot you need to use one or two dimensions, and one measure. If you use a single
dimension you will receive a single box visualization. If you use two dimensions, you will get one box
for each value of the second, or outer, dimension.

By default, the Standard (Tukey) preset is used.

You cannot use calculated dimensions in a box plot.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty box plot to the sheet.
2. Add the first dimension.

This is the inner dimension, which defines a box.
3. Add a second dimension.

This is the outer dimension, which defines the boxes shown on the dimension axis.
4. Click Add measure and create a measure from a field. The measure does not have to contain

an aggregation.

When you have created the box plot, you may want to adjust its appearance and other settings in
the properties panel.

When you have created the bar chart, you may want to adjust its appearance and other settings in
the properties panel.

Styling the box plot
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font, font size, and color for the following text elements:
l Achsentitel: Legen Sie das Design der Titel auf den Achsen fest.
l Achsenbeschriftung: Legen Sie das Design der Beschriftungen auf den Achsen fest.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Changing the definition of the box plot
You can use one of the three presets, found under Box plot elements in the properties panel, to
define your box plot.
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l Standard (Tukey)
This preset is based on the original box plot definition by J. Tukey. The center line represents
the median (second quartile), and the box start and end points represent the first and third
quartiles. Whisker length can be set to 1, 1.5 or 2 inter-quartile ranges. An inter-quartile range
represents the difference between the first and third quartiles.

l Percentile-based
This preset is also defined with the box start and end points representing the first and third
quartiles, and the center line representing the median, but the whisker length is adjusted by
setting a percentile based whisker position.

l Standard deviation
This preset is based on standard deviations, with the center line representing the average
value, and the box start and end points representing one standard deviation variance. You
can set the whisker length to a multiple of standard deviations.

You can also define a custom box plot where you set the value of each box plot element using an
expression.

Visualisierung des Bereichs und der Verteilung von numerischen Daten mit
einem Boxplot
Dieses Beispiel zeigt die Erstellung eines Boxplots zum Anzeigen des Bereichs und der
Verteilung von numerischen Daten anhand von täglichen Temperaturmessungen.

Datensatz
In diesem Beispiel werden die folgenden Wetterdaten verwendet.

l Location: Sweden > Gällivare Airport
l Date range: all data from 2010 to 2017
l Measurement: Average of the 24 hourly temperature observations in degrees Celsius
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Der geladene Datensatz enthält eine tägliche Durchschnittstemperatur-Messung einer
Wetterstation in Nordschweden im Zeitraum 2010 bis 2017.

Kennzahl
Wir verwenden die Durchschnittstemperatur-Messung im Datensatz als Kennzahl, indem eine
Kennzahl in den Master-Elementen mit dem Namen Temperature degrees Celsius und der Formel
Avg([Average of the 24 hourly temperature observations in degrees Celsius]) erstellt wird.

Visualisierung
Wir fügen dem Arbeitsblatt einen Boxplot hinzu und legen die folgenden Dateneigenschaften fest:

l Dimension: Date (Datum) und Year (Jahr). Die Reihenfolge ist wichtig. Date muss die erste
Dimension sein.

l Kennzahl: Temperature degrees Celsius; die Kennzahl, die als Master-Element erstellt
wurde.

In diesem Beispiel verwenden wir die Voreinstellung des Standard-Boxplots Standard (Türkisch)
mit der Whisker-Länge 1,5 Quartilsabstände.

Entdecken
Der Boxplot visualisiert der Verteilung der täglichen Temperaturmessungen. Die Visualisierung ist
nach der mittleren Temperaturreihenfolge sortiert. Die mittlere Temperatur für jedes Jahr wird
durch die mittlere Zeile in jedem Feld (Box) dargestellt. Das Feld erstreckt sich vom ersten Quartil
bis zum dritten Quartil, und die Whiskers erstrecken sich über 1,5 Quartilabstände. Es gibt auch eine
Reihe von Ausreißerwerten. Das sind die Punkte, die außerhalb der Whiskers platziert sind. Sie
können den Mauszeiger über einen Ausreißerpunkt bewegen und die Details anzeigen.

Im Boxplot sehen wir, dass das Jahr 2010 über das längste Feld (Box) und die längsten Whiskers
verfügt. Das zeigt, dass das Jahr 2010 über die größte Verteilung der gemessenen Temperaturen
verfügt. Es scheint auch das kälteste Jahr im Durchschnitt zu sein.
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Der Bereich des Jahres 2017 ist klein, da der Datensatz nur Messungen aus den ersten Monaten
des Jahres enthält.

Bullet chart
The bullet chart displays a gauge with extended options. Bullet charts can be used to
visualize and compare performance of a measure to a target value and to a qualitative
scale, such as poor, average, and good.

In a bullet chart you need one measure, which determines the length of the bar.

You can also add a dimension. This will show one gauge for every dimension value. If you do not
define a dimension, the chart will show a single gauge.

Beispiel:

A bullet chart showing sales performance for each value of the dimension (quarter)

The example shows a bullet chart with sales performance for each quarter. It also shows the
performance relative to target and performance range, which are different for each quarter.

When to use it
Bullet charts let you compare and measure performance with more enriched information than a
common gauge. This is helpful when comparing performance according to a target and a simple
performance rating. For example: you can show how sales relate to a target value, and in context of
poor, good, and stretched performance.

Creating a bullet chart
You can create a bullet chart on the sheet you are editing.
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Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty bullet chart to the sheet.
2. Click Add dimension to select the dimension that define how many gauges are shown.
3. Click the Add measure button to select the value measure of the chart that defines the

length of the bar.
Once the measure is selected the bullet chart is displayed with default settings. Each gauge
is displayed with an individual range. If you want to use a common range, you can set it with
Appearance>Y-axis>Common range.

4. To add a target value, click Target under the measure. You can define a fixed value or use a
measure with target values.

5. To add performance ranges, set Use segments under the measure to On.
Click Add limit to set a range limit for the segments. You can adjust the color of each
segment by clicking on it.
You can define a fixed limit value or an expression.

The bullet chart is now displayed with the dimension and measure you selected.

When you have created the bullet chart, you might want to adjust its appearance and other settings
in the properties panel.

Styling the bullet chart
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font, font size, and color for the following text elements:
l Achsentitel: Legen Sie das Design der Titel auf den Achsen fest.
l Achsenbeschriftung: Legen Sie das Design der Beschriftungen auf den Achsen fest.
l Value labels: Style the labels which display the measure value for each dimension

value.
Click the checkbox for Auto contrast color to automatically override the selected
color with the default color for the app's theme. This only applies to value labels inside
the bars or inside white rectangles outside the bars.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
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6. Under Shadow in the General tab, select a shadow size and color. Select None to remove
the shadow.

Setting a target value
You can add a target value which is displayed as a marker line. If the measure contains sales
numbers, this could be budgeted sales for example.

You can define a fixed value or use a measure with target values.

Setting performance ranges
To add performance ranges, set Use segments under the measure to On.

You need to add the limits for the ranges you want to use for showing indicators with Add limit. You
can set a limit value in three ways.

l Use the slider.
l Type a value in the text box.
l Set an expression that returns the limit value.

Changing the color scheme
You can change color scheme of the value bar and the target by setting Appearance > Colors >
Colors to Custom. You can set single colors or use an expression.

It's a good idea to use a bar color that is visually dominant to the range colors.

When you have added the limits, you can select the color and the symbol of the indicator for each
defined range.

Adding a custom tooltip
You can add measures, charts, and images as tooltips. To add custom tooltips, select
Appearance>Tooltip>Custom.

l If you want to add a measure as a tooltip, you can add it from a field using From a field. You
can also use an expression to add a measure. Klicken Sie zum Öffnen des Formel-Editors auf

. The existing expression is displayed by default. You can add a title and description to the
tooltip. You can change the label of the tooltip using Label as well as its formatting using
Number formatting.

l If you want to add a chart as a tooltip, select a master visualization from the list of Master
items.

l Set the size of the tooltip container. Qlik Sense fits the chart into the container.
o Small. Sets the width and height of the container to 140 pixels.
o Medium. Sets the width and height of the container to 200 pixels.
o Large. Sets the width and height of the container to 340 pixels.
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After you add the chart, you can edit it by clicking Edit master item. See
Editing a master visualization (page 120).

l If you want to add an image as a tooltip, choose whether to add an image from your Media
library or from a URL.

o Set the size of the tooltip container. Qlik Sense fits the image into the container.
o Small. Sets the width and height of the container to 50 pixels.
o Medium. Sets the width and height of the container to 200 pixels.
o Large. Sets the width and height of the container to 340 pixels.
o Original. Qlik Sense fits the image into the container. If the image is larger than

340 pixels, it is scaled down.
o Media library: Appears when you choose Media library for Type. Click to select an

image from your media library.
o URL: Appears when you choose URL for Type. Enter a URL.

Setting the scale of the axis
If you use a dimension to show several gauges, you can select how to show the scale of the axis
with Appearance>Y-axis>Common range.

l If you want each dimension gauge to use the same scale, enable Common range. If the
range measure depends on the dimension value, the range bars will have different lengths.
This is useful when you want to be able to compare the actual values.
You can also set a common axis for all gauges with Appearance>Y-axis>Common range.

l If you want each range bar to be equally long, disable Common range.
This is useful when you want to be able to compare the relative performance of each
dimension value.

Changing the orientation of the labels
To change the orientation of the chart's labels, the chart's presentation must be vertical. This can
be set with Appearance > Presentation > Vertical. Label orientation can then be selected with
Appearance > X-axis > Label orientation. The following orientations are available:

l Auto: Automatically selects one of the other options depending on the space available on the
chart.

l Horizontal: Labels are arranged in a single horizontal line.
l Tilted: Labels are stacked horizontally at an angle.
l Layered: Labels are staggered across two horizontal lines.

To view examples of label orientation, see X-axis and Y-axis (page 635).

Limitations
Wenn Einfärbung nach Dimension in diesem Diagramm verwendet wird, können maximal 100
eindeutige Dimensionswerte und 100 eindeutige Farben auf der Legende aufgetragen werden.
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Combo chart
The combo chart is suitable for comparing two sets of measure values that are usually
hard to compare because of the differences in scale. It is basically a bar chart
combined with a line chart.

A typical example is when you have a bar chart with sales figures and want to combine these
figures with the margin values (in percent). In a regular bar chart, the bars for sales would be
displayed as usual, but the margin values would be almost invisible because of the very large
difference between the numeric values for sales and margin.
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A combo chart with the margin values (in percent) and bars with sales figures.

With a combo chart you can combine these values by, for example, using bars for the sales values
and a line for the margin values. By default, the bars have the measure axis on the left and the
margin values have a separate axis to the right. The two measures use the same dimension
(YearMonth).

If you have yet another measure, for example, gross sales, with values that are roughly in the same
range as the sales values, you can add the third measure as bars and either stack or group the new
measure values with the sales values. Mit gruppierten Balken können Sie einfach zwei oder mehr
Elemente in der gleichen Kategoriegruppe vergleichen. Gestapelte Balken kombinieren Balken
verschiedener Gruppen, die übereinander dargestellt werden. Die Gesamthöhe des resultierenden
Balkens stellt das kombinierte Ergebnis dar.
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A combo chart with three measures; the margin values (in percent), bars with sales figures and the measure
Gross sales grouped with the sales values.

The combo chart can only be displayed vertically.

When to use it
With the possibility to have different measure scales, one to the left and one to the right, the combo
chart is ideal when you want to present measure values that are normally hard to combine because
of the significant difference in value ranges.

But a combo chart can also be quite useful when comparing values of the same value range. In the
image above, the combo chart only has one measure axis, but the relationship between the two
categories sales and cost is clear.

Advantages
The combo chart is the best choice when combining several measures of different value ranges.

Disadvantages
The combo chart only supports one dimension, and can therefore not be used when you need to
include two or more dimensions in the visualization.

Creating a combo chart
You can create a combo chart on the sheet you are editing. In a combo chart, you need at least one
dimension and one measure.
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Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty combo chart to the sheet.
2. Klicken Sie auf Dimension hinzufügen und wählen Sie eine Dimension oder ein Feld aus.
3. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine

Kennzahl aus einem Feld. Select to show the measure as a bar.
4. Add another measure by selecting Add under Height of line. Enter an expression, or master

measure item, or a field with an aggregation function applied. By default a line will appear as
the measure.

5. When you are done adding measures, configure each measure to display as bars, lines, or
markers. For more information, see Configuring the presentation of measures (page 219).

You can only have one dimension, but you can continue adding up to 15 measures. You can only
have two measure axes though. This means, if you add three or more measures with a large
difference in value range it can be hard to display all measures with a good distribution of values.

When you have created the combo chart, you might want to adjust its appearance and other
settings in the properties panel.

Styling the combo chart
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Customizing the text
You can set the text for the title, subtitle, and footnote under Appearance > General. To hide these
elements, turn off Show titles.

The visibility of the labels shown on the chart depends on how you configure the measure values to
be displayed, as well as other chart-specific settings and label display options. Configure a
measure to be shown as Bars, Line, or Marker by expanding the measure under Data > Measures,
and clicking More properties. Configure additional chart and label options under
Appearance > Presentation.

You can style the text that appears in the chart.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, expand the Bars section. This section appears if any of the measures are
being displayed as bars.

5. Under Bar labels, style the labels for measure values configured as Bars. You can select the
font, font size, and color.
Wenn Sie die Präsentationsoption Gestapelt verwenden, steuert diese Einstellung
Segmentbezeichnungen (Kennzahlenwerte für jeden Dimensionswert) und
Gesamtwertebezeichnungen (kombinierte Kennzahlenwerte für jeden Dimensionswert).

6. Expand the Lines section of the Chart tab. This section appears if any of the measures are
being displayed as lines.

7. Under Point labels, style the labels for measure values configured as Line. You can select
the font, font size, and color.

8. On the Chart tab, expand the Markers section. This section appears if any of the measures
are being displayed as markers.

9. Under Marker labels, style the labels for measure values configured as Marker. You can
select the font, font size, and color.

10. Legen Sie auf der Registerkarte Diagramm die Schriftart, die Schriftgröße und die Farbe der
folgenden Textelemente fest:

l Achsentitel: Legen Sie das Design der Titel auf den Achsen fest.
l Achsenbeschriftung: Legen Sie das Design der Beschriftungen auf den Achsen fest.
l Legendentitel: Legen Sie das Design des Legendentitels fest.
l Legendenbezeichnungen: Legen Sie das Design der Bezeichnungen für die einzelnen

Legendenelemente fest.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
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When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the bar segment outline and bar width
If your combo chart contains measure data represented as bars, you can adjust the outline
surrounding each bar segment in the chart, as well as the width of the bars.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Chart tab, expand the Bars section.
4. Under Outline, set the thickness and color of the outlines.
5. Adjust the slider for Bar width to set the width of the bars.

Customizing the lines and data points
If your combo chart contains measure data represented as lines, you can customize the
appearance of the lines and data points in the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Chart tab, expand the Lines section.
4. Under Data point size, adjust the slider to change the size of the data points in the chart.
5. Under Line options, adjust the line thickness, line type (solid or dashed), and line curve

(linear or monotone).

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.
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Configuring grid line spacing
You can change the placement of grid lines on the chart. Select whether to show grid lines based on
the primary or secondary axis, and adjust the spacing. You can also turn off grid lines if desired.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.
2. Expand Appearance > Presentation.
3. Toggle Grid line spacing from Auto to Custom.
4. Use the drop down menu to select whether the grid lines are placed along the Primary axis

or Secondary axis.
Depending on the scale used by each axis, you might not notice any difference between
these settings.

5. Use the second drop down menu to select the spacing, or choose No lines to remove grid
lines.

Configuring the presentation of measures
Optionally, you can change the presentation of measures between bars, lines, or markers.
Additional options are also available.

Gehen Sie folgendermaßen vor:

1. In the properties panel, under Measures, select More Properties in a measure.
2. Choose the Presentation of the measure. You can:

l Change the presentation of measures between bars, lines, or markers. For markers
you can choose between several different shapes.

l Select drop-down options to switch between the Primary axis or the Secondary axis.

The primary axis is on the left side of the chart, and the secondary axis in
on the right side. Right and left axes are reversed if Right-to-left is turned
on in App settings.

Adding bar and marker labels
If any measures in the chart are configured as bars or markers, you can show or hide their value
labels. Bar and marker labels can be configured separately from one another.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.
2. Under Presentation, do one or both of the following:

l Set Bar labels to Auto.
l Set Marker labels to Auto.
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Adding segment and total labels
For combo charts with a specific configuration, you can add segment and total labels. Segment
labels show values for each measure segment in a chart. Total labels show values for an entire set
of measures arranged along a single axis.

You can add segment and total labels if all of the following apply:

l Two or more measures on the same axis are configured as bars.
l The combo chart uses the Stacked presentation option. This setting is located under

Appearance > Presentation, and only appears if there are two or more bar measures on the
same axis.

l Bar labels are set to Auto.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.
2. Under Presentation, set Bar Labels to Auto.
3. Do one or both of the following:

l Set Segment labels to Auto.
l Set Total labels to Auto.

Display limitations

Displaying out of range values
In the properties panel, under Appearance, you can set a limit for the measure axis range. Without a
limit, the range is automatically set to include the highest positive and lowest negative value, but if
you set a limit you may have values that exceed that limit. A bar that exceeds the limit will be cut
diagonally to show that it is out of range. For a line data point value that is out of range, an arrow
indicates the direction of the value.

Displaying large amounts of data in a combo chart
If the chart uses a continuous scale, a maximum of 2000 data points can be displayed. The actual
maximum number of data points in the chart is affected by the distribution of the data. Above this
actual maximum number of data points, data points are neither displayed, nor included in selections
made in the chart.

To avoid displaying limited data sets, you can either make a selection or use dimension limits in the
properties panel.

Colors and legend
Wenn Einfärbung nach Dimension in diesem Diagramm verwendet wird, können maximal 100
eindeutige Dimensionswerte und 100 eindeutige Farben auf der Legende aufgetragen werden.
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Vergleichen von Kennzahlen mit unterschiedlicher Skala in einem Kombi-
Diagramm
In diesem Beispiel wird die Erstellung eines Kombi-Diagramms zur Visualisierung von
Umsatzdaten gezeigt. Daneben werden verschiedene Produktgruppen mit zwei
Kennzahlen mit unterschiedlicher Skala verglichen.

Dataset
In diesem Beispiel werden zwei Datendateien aus Qlik Sense Tutorial - Aufbau einer App
verwendet. Um die Dateien herunterzuladen, gehen Sie zu Tutorial - Aufbau einer App. Laden Sie
das Tutorial herunter und entzippen Sie die enthaltenen Ordner. Suchen Sie folgende Dateien im
Ordner Tutorials source:

l Sales.xls
l Item master.xls

Erstellen Sie eine neue App und fügen Sie die beiden Datendateien hinzu. Vergewissern Sie sich,
dass sie über Elementnummer verknüpft sind.

Der Datensatz, der geladen wird, enthält Umsatzdaten. Die Tabelle in der Datei Item master.xls
enthält die Informationen über die bestellten Artikel, beispielsweise Produktgruppen.

Kennzahlen
Es müssen zwei Kennzahlen in Master-Elemente erstellt werden:

l Umsatzvolumen: mit dem Namen Sales und der Formel Sum(Sales).
l Umsatzmarge in Prozent: mit dem Namen Margin % und der Formel Avg(Margin/Sales)*100.
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Visualisierung
Wir fügen dem Arbeitsblatt ein Kombi-Diagramm hinzu und legen die folgenden
Dateneigenschaften fest:

l Dimension: Product Group (Produktgruppe).
l Kennzahl: Sales (die von Ihnen erstellte Master-Kennzahl).

Das folgende Diagramm wird erstellt. Die einzelnen Balken zeigen die Umsätze für jede
Produktgruppe an. Zu diesem Zeitpunkt handelt es sich um ein Balkendiagramm.

Zudem soll aber die Umsatzmarge angezeigt werden, die eine andere Skala als das Umsatzvolumen
hat. Das Umsatzvolumen ist in Millionen angegeben, während die Marge ein Prozentsatz zwischen
0 und 100 ist. Wenn die Marge als Balken neben dem Umsatzvolumen hinzugefügt wird, ist der
Balken zu klein, um erkennbar zu sein.

Gehen Sie im Eigenschaftsfenster zu Kennzahlen > Linienhöhe. Verwenden Sie die Dropdownliste,
um Margin % als Kennzahl hinzuzufügen.
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Entdecken
Das Kombi-Diagramm zeigt das Umsatzvolumen und die Marge verschiedener Produktgruppen. Sie
können den Mauszeiger über eine Produktgruppe bewegen und die Details anzeigen. Die Balken
zeigen das Umsatzvolumen mit der Skala auf der linken Seite, während die Linie die Marge mit der
Skala auf der rechten Seite anzeigt.

Im Diagramm sehen Sie, dass Produce und Canned Products das höchste Umsatzvolumen
aufweisen. Beide Gruppen haben eine geringere Marge als die meisten anderen Produktgruppen.

Einige Produktgruppen mit geringerem Umsatzvolumen, wie Eggs und Seafood, haben eine
signifikant höhere Marge.

Distribution plot
The distribution plot is suitable for comparing range and distribution for groups of
numerical data. Data is plotted as value points along an axis.

You can choose to display only the value points to see the distribution of values, a bounding box to
see the range of values, or a combination of both as shown here:
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When to use it
The distribution plot is suitable for comparing range and distribution for groups of numerical data.

Advantages
The distribution plot visualizes the distribution of data.
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Disadvantages
The distribution plot is not relevant for detailed analysis of the data as it deals with a summary of
the data distribution.

Creating a distribution plot
You can create a distribution plot on the sheet you are editing.

In a distribution plot you need to use one or two dimensions, and one measure. If you use a single
dimension you will receive a single line visualization. If you use two dimensions, you will get one line
for each value of the second, or outer, dimension.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty distribution plot to the sheet.
2. Add the first dimension.

This is the inner dimension, which defines the value points.
3. Add a second dimension.

This is the outer dimension, which defines the groups of value points shown on the
dimension axis.

4. Click Add measure and create a measure from a field.
p Anzeige der Verteilung von Kennzahlwerten in einer Dimension mit einem
Verteilungsdiagramm (page 227)

When you have created the distribution plot, you might want to adjust its appearance and other
settings in the properties panel.

Styling the distribution plot
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.
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Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font, font size, and color for the following text elements:
l Achsentitel: Legen Sie das Design der Titel auf den Achsen fest.
l Achsenbeschriftung: Legen Sie das Design der Beschriftungen auf den Achsen fest.
l Legendentitel: Legen Sie das Design des Legendentitels fest.
l Legendenbezeichnungen: Legen Sie das Design der Bezeichnungen für die einzelnen

Legendenelemente fest.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.
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Display limitations

Displaying large amounts of data in a distribution plot
When displaying large amounts of data in a distribution plot, the message "Currently showing a
limited data set." is shown to indicate that not all data is displayed.

l If the chart uses more than one dimension, 3000 data points are displayed.

Colors and legend
Wenn Einfärbung nach Dimension in diesem Diagramm verwendet wird, können maximal 100
eindeutige Dimensionswerte und 100 eindeutige Farben auf der Legende aufgetragen werden.

Anzeige der Verteilung von Kennzahlwerten in einer Dimension mit einem
Verteilungsdiagramm
Dieses Beispiel zeigt, wie ein Verteilungsdiagramm erstellt wird, um die Verteilung von
Kennzahlenwerten in einer Dimension anzuzeigen. Als Beispiel werden die Wetterdaten
verwendet.

Datensatz
In diesem Beispiel werden die folgenden Wetterdaten verwendet.

l Location: Sweden > Gällivare Airport
l Date range: all data from 2010 to 2017
l Measurement: Average of the 24 hourly temperature observations in degrees Celsius

Der geladene Datensatz enthält eine tägliche Durchschnittstemperatur-Messung einer
Wetterstation in Nordschweden im Zeitraum 2010 bis 2017.
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Kennzahl
Wir verwenden die Durchschnittstemperatur-Messung im Datensatz als Kennzahl, indem eine
Kennzahl in den Master-Elementen mit dem Namen Temperature degrees Celsius und der Formel
Avg([Average of the 24 hourly temperature observations in degrees Celsius]) erstellt wird.

Visualisierung
Wir fügen dem Arbeitsblatt ein Verteilungsdiagramm hinzu und legen die folgenden
Dateneigenschaften fest:

l Dimension: Date (Datum) und Year (Jahr). Die Reihenfolge ist wichtig. Date muss die erste
Dimension sein.

l Kennzahl: Temperature degrees Celsius, die Kennzahl, die als Master-Element erstellt
wurde.

Verteilungsdiagramm mit den Dimensionen Date (Datum) und Year (Jahr) und der Kennzahl Temperature
degrees Celsius.

Entdecken
Das Verteilungsdiagramm visualisiert der Verteilung der täglichen Temperaturmessungen. Die
Visualisierung ist nach Jahr sortiert, und jeder Punkt stellt eine Temperaturmessung dar.

In der Visualisierung wird angezeigt, dass das Jahr 2012 die niedrigste Extremtemperatur-Messung
aufweist, fast -40 Grad Celsius. Wir können auch sehen, dass das Jahr 2016 über die größte
Verbreitung von Temperaturmessungen zu verfügen scheint. Mit diesen vielen Punkten im
Verteilungsdiagramm kann es schwierig sein, Cluster und Ausreißer zu erkennen, aber das Jahr
2017 weist zwei Niedrigtemperatur-Messungen auf, die sich von anderen abheben. Sie können den
Mauszeiger über einen Punkt bewegen und die Details anzeigen.
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Filter pane
You can add a filter pane to control what data that is shown in the visualizations on a
sheet. A filter pane can filter the data of several dimensions at once.

For example, if you have a chart of sales over time, you can use a filter pane to limit the data in the
chart to only show sales from a selected time period, from certain product categories, and from a
certain region.

When a dimension is added, it is placed to the right of the previous dimensions, or below,
depending on the available space. As long as there is enough space, the dimensions are displayed
as expanded lists. If there is not enough space, the dimensions that were added first are turned into
filter panes.

Selections have been made in the dimensions Year, Quarter, and Month.

When to use it
With filter panes, you can easily make several selections to define your data set exactly like you
want it. With your well-defined data set, you can explore data of particular interest.
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By using the selection menu options in the filter panes (select possible, select alternative, and
select excluded), you can make adjustments to the data set and compare the results with the
previous selection.

Advantages
Filter panes are good for making selections and defining data sets. But they also show the
relationship between different values, the associations. The green, white, and gray colors reflect
the data associations that exist - and that do not exist. And by analyzing those associations, you
can make new discoveries, for example, that a sales representative has too many customers, or
that a region lacks a sales representative.

Disadvantages
When the dimensions contain a very large amount of values, it may be hard to manage the data.

Creating a filter pane
You can create a filter pane on the sheet you are editing.

In a filter pane you can use up to 1000 dimensions.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty filter pane to the sheet.
2. Klicken Sie auf Dimension hinzufügen und wählen Sie eine Dimension oder ein Feld aus.
3. If you want to add more dimensions, click Add dimension again.

When you have created the filter pane, you may want to adjust its appearance and other settings in
the properties panel:

l Styling the filter pane (page 231)
l Customizing individual listboxes in a filter pane (page 233)

If you double-click or drag a field or a dimension from the assets panel, a filter pane is
added to the sheet using the dimension. If you then double-click more dimensions, they
are automatically added to the new filter pane.
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Styling the filter pane

You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart.
The styling panel contains various sections under the Filter pane and Listboxes tabs. Settings on
the Filter pane tab applies styling for the filter pane and settings on the Listboxes tab applies
styling for all listboxes inside the filter pane.

You can reset your styles by clicking next to each section. Clicking Reset all resets styles in
both Filter pane and Listboxes.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Filter pane tab, set the font, emphasis style, font size, and color for the following text
elements:

l Title
l Subtitle
l Footnote

4. On the Listboxes tab, set the font, emphasis style, font size and color for the following text
elements:

l Header: Style the text of the headers for the listboxes.
l Content: Style the text of the listbox values.

Click the checkbox for Auto contrast color to automatically override the selected
color with colors that have higher contrast with the selection state of the listbox value.

Customizing the background
You can customize the filter pane background, the background of the header area, as well as the
background of the listboxes. The filter pane and the listbox background can be set by color and
image, while the background of the header area can be set to a single color.

In the styling panel, you can configure background options.

Setting the filter pane background
The filter pane background of the chart includes the title area, as well as the filter pane itself, which
is partially covered by the listboxes.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Filter pane tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Setting the listbox background
You can style the background of the listboxes. This styling applies to all listboxes in the filter pane.

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Listboxes tab of the styling panel, you can select a background color (single color or
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expression), and also set the background to an image from your media library.
When using a background image, you can adjust image sizing and position.

Coloring the selection states
Each selection state of a listbox value can be assigned a specific color. This coloring is applied to
the background of the listbox value.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Listboxes tab of the styling panel, under Selection state, set colors for each of the
selection states:

l Selected
l Alternative
l Excluded
l Selected excluded
l Possible

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Filter pane tab of the styling panel, under Border, adjust the Outline size to increase
or decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the Filter pane tab, select a shadow size and color. Select None to remove

the shadow.

Customizing individual listboxes in a filter pane
A filter pane can contain one or more listboxes to filter dimension values over specified fields. Add
fields to the filter pane, then re-arrange them in the properties panel in an order that meets your
preferences.

Each field in the filter pane has its own listbox, which shows the individual field values. Each listbox
in a filter pane can be customized with its own unique properties. To customize a listbox, you need
to turn on the Advanced options when editing the sheet.
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Gehen Sie folgendermaßen vor:

1. Create a filter pane on a sheet.
2. Add a field to the filter pane to create a new listbox for that field.
3. In the properties panel, under Data, click the field you just added.

This expands the Listbox properties panel, where you can customize the design of the listbox.

Listbox properties panel for a single listbox in a filter pane.

Configuring search options
In Listbox properties, you can choose whether or not users can search for individual field values in
each listbox within the filter pane. You can also switch the default Search mode from Normal to
Wildcard. Wildcard adds default wildcard symbols (*) to the search field.

Condensing information in the filter pane
There are multiple settings available in Listbox properties to help you customize how much space
each listbox occupies in the filter pane.

Enabling compact view
To remove space between each dimension value, select the Compact view checkbox under
Presentation.
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Adjusting the collapse behavior
You can adjust whether the listbox is shown as expanded or collapsed in the filter pane. When a
listbox is collapsed, you can click to expand it temporarily to view and apply selections.

Regardless of the collapse behavior selected, the exact behavior of each listbox within a filter pane
depends on a number of factors. These include its configuration in relation to other listboxes in the
filter pane, and available space. For more information, see Display limitations (page 237).

To adjust the collapse behavior, select an option in the Collapse listbox drop down menu. This is
located under Presentation.The following options are available:

l Auto: The listbox automatically adjusts to be expanded or collapsed, based on available
space and configuration in relation to other listboxes in the filter pane. The listbox defaults to
this option.

l Always: The listbox always collapses. It might be placed inside the drop down menu for
additional dimensions.

l Never: The listbox never collapses. It might still be placed inside the drop down menu for
additional dimensions.

Changing selection behavior
You can adjust several different settings in Listbox properties to customize how selections are
made in the listbox.

Enabling checkbox mode
If you select Checkbox mode under Presentation in Listbox properties, the listbox switches to a
view where each dimension value is represented by a checkbox. In this mode, selections are made
by clicking the checkbox next to each item, rather than the default behavior allowing clicking and
dragging to select multiple values at once.

If you have applied Always one selected value for the field within the assets panel, radio buttons
are used instead of checkboxes. The functionality is the same.

Toggling selection toolbar
By default, a selection toolbar appears when you make selections in a listbox. This toolbar allows
you to explore other options for selections, as well as clear, cancel, or confirm the selections.

In Listbox properties, the Show selection toolbar checkbox is checked by default. Clear this
checkbox if you want the toolbar not to appear above the listbox when you make selections.

If you toggle this setting off, selections are confirmed when you press Enter or click outside the
listbox.

Displaying dimension value frequencies
Under Presentation in Listbox properties, click the checkbox next to Histogram to display bars
underneath each dimension value to represent how frequently each value appears in the data.
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Switching to grid layout
By default, a listbox for a field in a filter pane is set to show data in a single column. Alternatively,
you can show data in a grid layout. Under Presentation, in Listbox properties, switch the
parameter for Show data in from Single column to Grid.

In the grid layout, you can also configure how the data is ordered (by Row or Column), and
customize the maximum visible rows or columns in the grid.

Showing the frequency of values
You can show the frequency next to each value, either as an absolute number or as a percentage.
You select this by opening Listbox properties, expanding the Presentation section, and selecting
an option in Show frequency.

In some cases the frequency cannot be calculated and is displayed as -. One example of
this is for key fields.

Selections in filter panes
During analysis, you make selections in a filter pane listbox. Click a collapsed filter pane dimension
to open a selection listbox.

When you make a selection, it is reflected in the small bars at the bottom of each filter pane
dimension. Four states can be displayed in the bars: selected (green), possible (white), alternative
(light gray), and excluded (dark gray). Locked values are indicated by a lock icon. The details of the
selections are displayed in the selections bar, above the sheet. You can click an item to see the
details and change your selection.

You can customize the selection behavior for each individual listbox in a filter pane. For more
information, see Changing selection behavior (page 235).

Fields are filtered out from each dimension to be shown in the visualizations on the sheet.

Making selections in filter pane lists
When there is space enough in a filter pane, the dimension values are displayed in a listbox. In
listboxes, you can click to select a single value or draw to select several values. On a touch device,
you can two-finger-tap in the listbox to select a range of values.
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Germany, Japan, and Nordic selected in the Region filter pane.

The selections tool
The selections tool offers an option to get an overview of the fields and dimensions in an app. In the
selections tool you can make selections in all the fields and dimensions in the app, regardless of
whether they are used in the app or not.

Klicken Sie während der Analyse auf , um die Auswahlansicht zu öffnen.

Display limitations

Responsive design
The filter pane has a responsive design and renders as many dimensions as possible. When space
is limited, this could involve reducing the size of each dimension so that all dimensions are
displayed.

Beispiel:

The following image shows a filter pane while it is being edited. Only three out of five dimensions
are displayed. There is an additional item below the displayed dimensions. When this is clicked, the
remaining dimensions are listed.

Filter pane in edit mode.

When you have finished editing the filter pane and enter analysis mode, you will see the filter pane
with all the dimensions displayed. If all items cannot be shown due to lack of space, click below
the displayed dimensions to view the remaining dimensions.

Filter pane in analysis mode, with expanded drop down list showing additional dimensions.
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Full screen view
In full screen view, the filter pane is maximized and displays as many dimensions as possible
expanded. When not all dimensions can be displayed expanded, the priority order is that the most
recently added dimensions are expanded to the right. You can change the priority order in the
properties panel, under Dimensions. Drag the dimensions to change the order.

Keyboard navigation
You can use your keyboard to navigate a filter pane. Use the arrow keys or the Tab key to alternate
between the different objects on the sheet. Once you have moved the focus to the filter pane, use
the Enter, Space and Esc keys to move the focus between the following levels:

l Entire filter pane
l Listboxes inside the filter pane
l Values inside each listbox

Tastaturnavigation Beschreibung

Leertaste oder
Eingabetaste

Setzt den Fokus auf das erste Listenfeld im Filterfenster. Ein weiterer
Tastendruck setzt den Fokus auf den ersten Wert im Listenfeld.

Wenn der Fokus sich auf einem ausgeblendeten Listenfeld befindet,
drücken Sie die Eingabetaste, um das Listenfeld in einem Popover zu
öffnen.

Esc Bewegt den Fokus um eine Ebene zurück (von den Werten zum
Listenfeld zum Filterfensterobjekt).

Pfeil rechts Wenn sich der Fokus auf einem einzelnen Listenfeld im Filterfenster
befindet, bewegt die „Pfeil rechts“-Taste den Fokus auf das nächste
Listenfeld auf der rechten Seite.

Wenn sich der Fokus auf einem Wert in einem Listenfeld befindet, wird
er mit der „Pfeil rechts“-Taste zum nächsten Wert im Listenfeld bewegt.

Pfeil links Wenn sich der Fokus auf einem einzelnen Listenfeld im Filterfenster
befindet, bewegt die „Pfeil links“-Taste den Fokus auf das nächste
Listenfeld auf der linken Seite.

Wenn sich der Fokus auf einem Wert in einem Listenfeld befindet, wird
er mit der „Pfeil links“-Taste zum vorherigen Wert im Listenfeld bewegt.

Tastatursteuerungen in Filterfenstern
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Tastaturnavigation Beschreibung

Pfeil nach oben Wenn sich der Fokus auf einem einzelnen Listenfeld im Filterfenster
befindet, bewegt die „Pfeil nach oben“-Taste den Fokus auf das
vorherige Listenfeld (links neben oder über dem aktuellen Listenfeld).

Wenn sich der Fokus auf einem Wert in einem Listenfeld befindet, wird
er mit der „Pfeil nach oben“-Taste zum vorherigen Wert im Listenfeld
bewegt.

Pfeil nach unten Wenn sich der Fokus auf einem einzelnen Listenfeld im Filterfenster
befindet, bewegt die „Pfeil nach unten“-Taste den Fokus auf das
nächste Listenfeld (rechts neben oder unter dem aktuellen Listenfeld).

Wenn sich der Fokus auf einem Wert in einem Listenfeld befindet, wird
er mit der „Pfeil nach unten“-Taste zum nächsten Wert im Listenfeld
bewegt.

Gauge
The gauge shows a single measure value and visualizes how to interpret that value.
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When to use it
The gauge is often used to present KPIs, for example, on an executive dashboard, and together
with segmenting and color coding, it is an effective way of illustrating a performance result.

It is important to set relevant max and min values to support the interpretation of the value. You can
use a reference line to provide additional context.

Advantages
A gauge is easy to read and understand and gives an instant indication of the performance within
an area.

Disadvantages
The gauge is quite space-demanding in relation to the single value it visualizes.

Although visually compelling, the gauge is not always the best choice for presenting a single
measure value. Problems when deciding the max and min values can indicate that some other
visualization should be used.

If you only want to show a performance value, without a gauge, consider using a KPI instead.

Creating a gauge
You can create a gauge on the sheet you are editing. In a gauge you can only have one measure and
no dimensions.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 240



3   Visualizations

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty gauge to the sheet.
2. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine

Kennzahl aus einem Feld.

When you have created the gauge, you may want to adjust its appearance and other settings in the
properties panel.

The following settings are used by default in a gauge:

l A radial gauge.
l A single (blue) color.
l Range limits: min (0), max (100).
l No segments.
l Label and title are displayed in medium scale.

For example, you can change the radial gauge to a bar, and use a color gradient.

Styling the gauge
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Customizing the text
You can set the text for the title, subtitle, and footnote under Appearance > General. To hide these
elements, turn off Show titles.
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The visibility of the labels and other titles on the chart depends on how it has been configured
outside of the styling panel. For a gauge, these display options can be configured in other areas the
Appearance section.

You can style the text that appears in the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font and font color for the following text elements:
l Axis title: Style the title for measure displayed in the gauge.
l Axis label: Style the labels for gauge's range limits.
l Value label: Style the label displaying the measure value.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
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6. Under Shadow in the General tab, select a shadow size and color. Select None to remove
the shadow.

Display limitations
When a measure value is outside the range limits, an arrow indicates whether the measure value is
higher or lower than the range values.

Histogram
The histogram is suitable for visualizing distribution of numerical data over a
continuous interval, or a certain time period. The data is divided into bins, and each bar
in a histogram represents the tabulated frequency at each bin.
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When to use it
The histogram is suitable for visualizing distribution of numerical data over a continuous interval, or
a certain time period.

Advantages
The histogram organizes large amounts of data, and produces a visualization quickly, using a single
dimension.

Disadvantages
The histogram is not relevant for detailed analysis of the data as it deals with a summary of the data
distribution.

Creating a histogram
You can create a histogram on the sheet you are editing. You can only apply a single dimension to a
histogram. Histograms do not need a measure, as the frequency of the binned data is automatically
calculated.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty histogram to the sheet.
2. Add the dimension to calculate the frequency on.

When you have created the histogram, you may want to adjust its appearance and other settings in
the properties panel.

Dimension limitations
There are some limitations to the dimension used in a histogram.
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l The dimension must be a numerical field.
l You cannot use a master dimension that was created using the expression editor, even if the

resulting field is numeric.
l The dimension cannot be based on an aggregation function.

Styling the histogram
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font, font size, and color for the following text elements:
l Achsentitel: Legen Sie das Design der Titel auf den Achsen fest.
l Achsenbeschriftung: Legen Sie das Design der Beschriftungen auf den Achsen fest.
l Value label: Style the labels displaying the frequency value of each dimension value

bin.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Anzeige der Verteilung der Daten über Intervalle hinweg mit einem
Histogramm
In diesem Beispiel wird gezeigt, wie ein Histogramm für die Verteilung der Daten über
Intervalle hinweg erstellt wird. Dabei werden Wetterdaten verwendet.
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Datensatz
In diesem Beispiel werden die folgenden Wetterdaten verwendet.

l Location: Sweden > Gällivare Airport
l Date range: all data from 2010 to 2017
l Measurement: Average of the 24 hourly temperature observations in degrees Celsius

Der geladene Datensatz enthält eine tägliche Durchschnittstemperatur-Messung einer
Wetterstation in Nordschweden im Zeitraum 2010 bis 2017.

Visualisierung
Wir fügen dem Arbeitsblatt ein Histogramm hinzu und fügen das Feld Mittelwert der 24-stündlichen
Temperaturbeobachtungen in Grad Celsius als Dimension hinzu.

Die Visualisierung erstellt automatisch eine Häufigkeitskennzahl und sortiert die
Temperaturmessungen nach der Häufigkeitsverteilung in mehrere Balken.

Wir können die Größe der Balken anpassen, um gleichmäßige Intervalle zu erhalten, indem Balken
auf Benutzerdefiniert und Balkenbreite (X) mit einer Breite von 5 festgelegt wird. Dadurch werden
die Balken auf Intervalle von 5 Grad Celsius eingestellt, wie unten gezeigt:
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Entdecken
Das Histogramm visualisiert die Häufigkeitsverteilung der Temperaturmessungen. Sie können den
Mauszeiger über einen Balken bewegen, um weitere Details der Häufigkeit anzuzeigen.

Wir sehen, dass die Temperaturen an den meisten Tagen zwischen -5 und 15 Grad Celsius liegen.
Es gibt Tage mit Temperaturen unter -30, aber es sind nicht viele.

KPI
The KPI visualization can show one or two measure values, and is used to track
performance.

A KPI visualization with two measure values, using conditional colors and symbols.
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When to use it
Use KPIs to get an overview of performance values that are central to an organization. Use color
coding and symbols to indicate how the figures relate to the expected results.

Advantages
KPIs give a quick understanding of the performance within an area.

Disadvantages
The KPI is somewhat limited when it comes to graphical components. You can use symbols to help
illustrate the performance, but if you want a more conspicuous component, consider using a gauge.

Creating a KPI
You can create a KPI visualization on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty KPI chart to the sheet.
2. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine

Kennzahl aus einem Feld.

In a KPI visualization, you can have one or two measures and no dimensions. With two measures,
the second value automatically becomes a complementary value and is shown with a smaller font
size. You can easily switch their order by dragging the measures in the properties panel under
Measures.

When you have created the KPI visualization, you might want to adjust its appearance and other
settings in the properties panel.
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The following settings are used by default in a KPI visualization:

l Centered alignment.
l Black text color.
l No background color.
l Responsive layout behavior.
l Medium font size.
l No titles.
l Measure label displayed.
l Conditional colors and symbols are turned off.
l No link to sheet.

If you double-click or drag a measure from the assets panel, a KPI visualization is added
on the sheet using the measure.

Styling the KPI
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Customizing the text
You can set the text for the title, subtitle, and footnote under Appearance > General. To hide these
elements, turn off Show titles.

In a KPI, you can style the text in the following components of the chart:

l Title area: Includes the chart title, subtitle, and footnote.
l Chart area: Includes measure titles and measure values.

Styling the title, subtitle, and footnote
You can customize the text displayed in the title area of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.
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3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Styling the chart text
The data displayed in a KPI chart consists of text. The appearance of this text can be customized
separately from the title area.

You can set the text alignment for the chart. Choose between left-aligned, centered, or right-
aligned text.

You can also select between several layout behavior options. The layout behavior defines how the
size of the text adapts given the configured font size, chart size, and text length. The following
options are available:

l Responsive: You can adjust the font size, with additional text size adjustments applied
based on chart size and text length. Adjustments are made to fit all text content into the KPI.

l Fluid: You can adjust the font size, with additional text size adjustments applied based on
chart size only. This re-scaling of the text is independent of text length. If the text is too long,
an ellipsis is inserted at the end.

l Fixed: You can adjust the font size, but it does not automatically adapt to chart size or text
length. It remains at the same size regardless of changes to these components.

Additionally, you can show or hide each of the measure titles in the KPI, and set the font size for the
chart text.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Navigate to the Chart tab.
4. Under Alignment, set the text alignment. Choose between left, centered, or right alignment.
5. Under Layout behavior, adjust how text size adapts to chart size and text length. The

appearance of each setting depends on the Font size you set for the chart.
6. Under Show, select whether to show or hide each KPI title in the chart.
7. Under Font size, adjust the size of the text that displays the measure titles and values.

For further customization settings, you can set the Styling mode to Advanced options to style
each measure title and measure value individually.

Gehen Sie folgendermaßen vor:

1. In the Chart tab of the styling panel, under Styling mode, turn on Advanced options.
2. Under First measure title, configure the following settings:
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l Set Show title on or off to display or hide the measure title.
l Style the text. Choose the font, emphasis style, font size, and color.

3. Under First measure value, set the font, emphasis style, and font size.
4. Repeat the steps above to customize the Second measure title and Second measure value.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Using conditional colors and symbols
You can set your KPI visualization to display in different colors, and with different symbols,
depending on the value of the selected measure. Conditional colors and symbols can be configured
in the properties panel.

You can do this by adding multiple range limits to the KPI, creating subsections that indicate
performance. For example, you can set your KPI so that it displays in:

l Green with a check mark symbol when performance is strong.
l Yellow with a caution symbol when performance falls below expectations.
l Red with an X symbol when performance is low.

You can also set range limits with expressions, rather than defining a single value.
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Gehen Sie folgendermaßen vor:

1. In the properties panel for a KPI visualization, select Appearance and expand Color.
2. If necessary, turn off Library colors and turn on Conditional colors.
3. Click Add limit to create a new limit. Multiple limits can be added to a single KPI chart.
4. Specify a value for the limit, or enter an expression using the expression editor.
5. On the Value color bar, click the range area of the KPI you would like to modify.
6. Under Colors, select a preset color or use a custom color. Toggle, if needed, to Symbols to

choose the symbol displayed when your KPI falls within the specified limit.

Linking to another sheet
You can link from the KPI visualization to a sheet in the app. When making data analysis and clicking
the visualization, you can click a second time to go to a predefined sheet. The sheet is opened in a
new tab. When hovering over , the name of the sheet is displayed. The icon is only displayed
when Show title is selected, under Presentation.

Line chart
The line chart is used to show trends over time. The dimension is always on the x-axis,
and the measures are always on the y-axis.

Your data set must consist of at least two data points to draw a line. A data set with a single value is
displayed as a point.

If you have a data set where data is missing for a certain month, you have the following options for
showing the missing values:

l As gaps
l As connections
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l As zeros

When a month is not present at all in the data source, it is also excluded from the presentation.

When to use it
The line chart is primarily suitable when you want to visualize trends and movements over time,
where the dimension values are evenly spaced, such as months, quarters, or fiscal years.

Advantages
The line chart is easy to understand and gives an instant perception of trends.

Disadvantages
Using more than a few lines in a line chart makes the line chart cluttered and hard to interpret. For
this reason, avoid using more than two or three measures.

Creating a line chart
You can create a line chart on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty line chart to the sheet.
2. Klicken Sie auf Dimension hinzufügen und wählen Sie eine Dimension oder ein Feld aus.
3. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine

Kennzahl aus einem Feld.

In a line chart you need at least one dimension and one measure.
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You can include up to two dimensions and one measure, or one dimension and up to 15 measures in
a line chart.

Dimensions Measures Result

1 dimension 1 measure A simple line chart with a single line.

2 dimensions 1 measure A line chart with the first dimension on the X-axis, and a line for
each value of the second dimension.

1 dimension up to 15
measures

A line chart with one line for each measure.

Creating a line chart

When you have created the line chart, you may want to adjust its appearance and other settings in
the properties panel.

Styling the line chart
You have a number of styling options available in the properties panel. Click Styling under
Appearance > Presentation to style the text, background, data point size, and lines at the chart
level (for the entire chart). The styling panel contains various sections under the General and Chart
tabs. Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten

klicken. Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren
Registerkarten im Designfenster zurückgesetzt. Any customization you apply here overrides the
styling set in the app theme.

You can also set line styling options individually for each measure in the chart. These options are
available for each measure in the Data section of the properties panel. When you style an individual
measure, the settings you choose override both the chart-level settings and the app theme for that
specific measure only.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.
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3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. Legen Sie auf der Registerkarte Diagramm die Schriftart, die Schriftgröße und die Farbe der
folgenden Textelemente fest:

l Achsentitel: Legen Sie das Design der Titel auf den Achsen fest.
l Achsenbeschriftung: Legen Sie das Design der Beschriftungen auf den Achsen fest.
l Value label: Style the labels for the measure values that are configured as Lines.
l Legendentitel: Legen Sie das Design des Legendentitels fest.
l Legendenbezeichnungen: Legen Sie das Design der Bezeichnungen für die einzelnen

Legendenelemente fest.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the data points at the chart level
You can set the size of the data points. The settings defined here apply to all measures in the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Chart tab of the styling panel, under Data point size, adjust the slider to change the
size of the data points in the chart.

Customizing the measure lines at the chart level
You can customize the appearance of the lines in the chart. The settings defined here apply to all
measures in the chart.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Switch to the Chart tab of the styling panel.
4. In the Line options section, adjust the line thickness, line type (solid or dashed), and line

curve (linear or monotone).

Styling each measure individually
Each measure line in the chart can be styled with separate settings. For each measure, you can
customize the data point size, line thickness, line type, and line curve.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Data section.
2. Click the measure you want to customize.
3. Under Styling, click Add.
4. Adjust the data point size, line thickness, line type (solid or dashed), and line curve (linear or

monotone).

Repeat these steps for each individual measure you need to customize separately from the app
theme or chart-level style settings.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Showing or hiding dimensions and measures depending on a condition
Sie können eine Dimension oder Kennzahl ein- oder ausblenden, je nachdem, ob eine Bedingung
wahr oder falsch ist. Dies wird als Anzeigebedingung bezeichnet und wird als Formel eingegeben.
Die Dimension oder Kennzahl wird nur angezeigt, wenn die Formel in diesem Feld als wahr bewertet
wird. Wenn dieses Feld leer ist, wird die Dimension oder Kennzahl immer angezeigt. Erweitern Sie
die Dimension oder Kennzahl im Abschnitt Daten des Eigenschaftsfensters und geben Sie eine
Formel unter Dimension anzeigen, wenn oder Kennzahl anzeigen, wenn ein.
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Benutzerdefinierte Quickinfos sind für ein Liniendiagramm deaktiviert, wenn eine der
Dimensionen im Diagramm eine Anzeigebedingung verwendet.

Angenommen, Sie haben einen Datensatz, der u. a. die Felder Sales, Quarter, Year und Order Number

enthält. Sie können Ihr Diagramm so konfigurieren, dass Umsätze zusammen mit einer zeitbasierten
Dimension für jährliche Aggregierungen angezeigt werden. Sie können eine zweite Dimension für
vierteljährliche Aggregierungen hinzufügen, aber die Daten nur nach dieser Dimension organisieren,
wenn die Gesamtzahl der von Ihrem Unternehmen erhaltenen Bestellungen das Ziel von 100.000
erreicht hat.

Gehen Sie folgendermaßen vor:

1. Aktivieren Sie im Bearbeitungsmodus die erweiterten Optionen.
2. Ziehen Sie aus dem Extras-Fenster ein Liniendiagramm auf das Arbeitsblatt.
3. Fügen Sie Quarter als Dimension hinzu.
4. Fügen Sie über das Eigenschaftsfenster Year als zweite Dimension hinzu.

Jedes unterschiedliche Jahr im Datenmodell wird zu einer eigenen Linie im Diagramm.
5. Fügen Sie Sum(Sales) als Kennzahl hinzu.
6. Erweitern Sie im Eigenschaftsfenster die Dimension Manager. Fügen Sie unter Dimension

anzeigen, wenn die folgende Formel hinzu:
Count([Order Number])>100000

Wenn Ihre Daten 50.000 Bestellungsdatensätze enthalten, organisiert das Diagramm die Umsätze
nicht nach Quartal, da diese Formel als falsch ausgewertet wird. Wenn die Daten 100.000 oder
mehr Bestellungsdatensätze enthalten, werden die Umsätze sowohl nach Year als auch nach
Quarter organisiert.

Adding trend lines
You can add trend lines to the chart. Use trend lines to visualize how data changes over time.

For more information about trend lines, see Trendlinien (page 112).

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Data section.
2. Under Measures, expand the measure for which you are adding trend lines.
3. Under Trend lines, click Add trend line.
4. Define the Label and Type for the trend line.
5. Use the Colors slider to define Custom or Auto coloring.
6. Use the checkbox to toggle a Dashed appearance on or off.
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Display limitations

Displaying large numbers of dimension values
Wenn die Anzahl der Dimensionswerte die Breite der Visualisierung übersteigt, wird ein Mini-
Diagramm mit einer Scroll-Leiste angezeigt. Sie können mithilfe der Scroll-Leiste im Mini-Diagramm
blättern oder, abhängig von Ihrem Gerät, mithilfe des Scroll-Rads oder durch Wischen mit zwei
Fingern. Werden sehr viele Werte verwendet, zeigt das Mini-Diagramm nicht mehr alle Werte an.
Stattdessen zeigt eine zusammengefasste Version des Mini-Diagramms (Elemente werden grau
angezeigt) eine Übersicht über die Werte an, wobei die sehr niedrigen und sehr hohen Werte noch
sichtbar sind.  Note that for line charts with two dimensions, the mini chart is only available in
stacked area mode.

Line chart with a mini chart, since the dimension values exceeds the width of the visualization.

Displaying out of range values
In the properties panel, under Appearance, you can set a limit for the measure axis range. Without a
limit, the range is automatically set to include the highest positive and lowest negative value, but if
you set a limit you may have values that exceed that limit. When a data point value cannot be
displayed, due to the range limits, an arrow indicates the direction of the value.

When a reference line is out of range, an arrow is displayed together with the number of reference
lines that are out of range.

Displaying large amounts of data in a line chart
If the chart uses a continuous scale, you can set the maximum number of visible points and lines. In
the properties panel, go to Presentation. Then adjust the following:

l Max visible points: Set the maximum number of points that will be displayed. The default is
2,000. The maximum is 50,000. If you set a number less than 1,000, the line chart will behave
as if the maximum is 1,000 visible points. The actual maximum number of data points in the
chart is affected by the distribution of the data, and could be lower than the value you
configure with this setting. When there are more data points than the value you have set,
data points are neither displayed, nor included in selections made in the chart.

l Max visible lines: Set the maximum number of lines that will be displayed. The default is 12.
The maximum is 1,000.
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If there are more data points than the number set in Max visible points, you will not see any points,
only lines. If there are more than 5,000 visible points, then labels will not be shown. If you have a
large number of lines, not all lines will be displayed, or lines may overlap.

If you have a large number of points or lines, it may take your chart longer to render when you zoom
or pan. You cannot make selections when the line chart is rendering.

A line chart with a large data set. This chart is set to display 50 lines, and 20,000 data points.

To avoid displaying limited data sets, you can either make a selection or use dimension limits in the
properties panel.

Colors and legend
Wenn Einfärbung nach Dimension in diesem Diagramm verwendet wird, können maximal 100
eindeutige Dimensionswerte und 100 eindeutige Farben auf der Legende aufgetragen werden.

Map chart
Maps enable you to view your data geographically.

Maps have many ways to present your data. You can add multiple layers to your map to display
different types of information on the same map. You can set a custom scope for locations so that if
two locations have the same name, you display the locations and their data correctly. You can use
drill-down dimensions to create a hierarchy of geographic areas for selection. You can limit the pan
of a map to a specific view and scope of the map, such as a region of interest, out of which users
cannot pan or zoom out. You can add custom base maps to your map and use non-WGS-84
coordinates.
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Map with density layer displaying number of global volcanic eruptions.

When to use maps
You can use a map to show the geographical distribution of offices, stores, and other sites of
business interest. You can visualize not only locations but also sales values and other measures and
display the value differences by bubble size or color.

Advantages
The map is a versatile visualization that efficiently presents the geographical distribution of key
values related to location or area.

Disadvantages
With a large number of values, it may be hard to get a good overview. Values may be placed on top
of each other and not visible until zoomed in.

Server connection requirements
In order for a Qlik Sense map chart to be able to perform location lookup and show a background
map (base map and layers), your web browser needs to be able to establish a connection with both
of the following servers on port 443 (HTTPS):

l maps.qlikcloud.com (required for location lookups and background map)
l ibasemaps-api.arcgis.com (required for Satellite base map)

For more information, refer to the Map service connection requirements on Ports used by user web
browser.

If you are instead using an on-premise GeoAnalytics server, your map chart will not need access to
maps.qlikcloud.com and can function without an internet connection. However, in this setup, the
Satellite base map will not be displayed as it requires a connection with ibasemaps-api.arcgis.com.
For more information, see Using GeoAnalytics with Qlik Sense map.
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Base map
The base map provides the background for the data contained in your layers. You can select your
base map in Map settings. Qlik Sense has four default base maps:

l Default: An OpenStreetMap-based map.
l Pale: A paler version of Default.
l Dark: A darker version of Default.
l Satellite: A satellite image map.
l None: No base map.

As of December 7, 2021 the map tile service used by Qlik Sense for satellite base maps
changed from services.arcgisonline.com to ibasemaps-api.arcgis.com. If your maps are
not functioning as expected, contact your Qlik administrator. They might need to allow
this new service.

Additionally, custom base maps can be added using background layers to add your own custom
base maps. For example, you could add the floor plan of an airport or office as a custom base map.

Layers
Layers contain visualized dimension and measure data that is displayed over your map. You can
stack layers on top of each other. You can also control at what zoom levels different layers appear
in or have layers that appear only if other values in a drill-down dimension are selected. This
enables you to create different levels of detail as you make selections and zoom in and out of areas
of interest on your map. The following layers are available:

l Point layer: A point layer overlays individual locations on a map, representing them with
shapes.
Point layers (page 267)

l Area layer: An area layer presents areas on your map, such as countries or states. With
polygon geometry loaded into a field, it can present any custom area.
Area layers (page 269)

l Line layer: A line layer enables you to display lines between points on your map.
Line layers (page 270)

l Density layer: A density layer enables you to visualize the density of points in an area using a
color ramp.
Density layers (page 273)

l Chart layer: A chart layer enables you to display small pie charts or bar charts over locations
in your map.
Chart layers (page 275)

l Background layer: Background layers enable you to display a custom base map for your
map visualization.
Hintergrundebenen (page 277)
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Layers that use drill-down dimensions can be used to create drill-down layers. Drill-down layers
enable you to drill-down different hierarchical dimensions in a single layer or in multiple layers. You
could, for example, switch between area and point layers as selections are made. For more
information, see Drilldown-Ebenen (page 280). For an example map that uses drill-down
dimensions and layers, see Kontrolle der sichtbaren Kartendaten mit Drilldown-Ebenen (page 281).

Location data for map layers
Maps support several ways for determining locations in a layer. You can use the dimension added
to the layer. You can alternatively specify fields containing location data for the layer, if the layer
dimension does not contain geographic data. In the Location properties, you can specify additional
parameters for the location field, such as adding additional fields that include country or
administrative area information. For example, if you have a field containing custom area geometries
and a field containing the names of the custom areas, you can set the name field as the dimension
and then set the area geometry field as the location field in Location in the map properties.

Locations can be either geometries or names of locations such as names of countries, regions,
cities, postal codes etc. Layer locations can be defined using fields that contain names and codes.
Qlik Sense can identify the following types of locations: 

l Continent names
l Country names
l ISO alpha 2 country codes
l ISO alpha 3 country codes
l First-order administrative area names, such as a state or province names
l Second-order administrative area names
l Third-order administrative area names
l Fourth-order administrative area names
l Postal codes or ZIP Codes
l City, village, or other populated place names
l IATA airport codes
l ICAO airport codes

Availability of locations may vary by country. If the named location is not available, use
coordinate or area data for the location.

Qlik Sense verwendet Karten- und Standortdaten von auf diesem Gebiet anerkannten
führenden Stellen, die wiederum anerkannte Methodiken und Best Practices bei der
Kennzeichnung von Grenzen und der Benennung von Ländern in ihren Karten einsetzen.
Qlik Sense bietet Benutzern die Flexibilität, eigene, getrennte Hintergrundkarten zu
integrieren. Wenn die Standardkarten nicht geeignet sind, bietet Qlik Sense die Option,
vom Kunden bereitgestellte Hintergrundkarten, Grenzen und Gebiete zu laden.
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Geometries can either be added at load time by the data preparation service or loaded from
geographic sources such as KML. Point layers also support latitudes and longitudes in separate
fields. For area layers, areas can be defined using geometries from a geographic data source such
as KML files. Line layers support the same point data as point layers. Line layers also support
strings with line geometries in GeoJSONLineString or MultiLineString formats.

If you are using a custom map in a background layer that uses non-WGS-84 coordinates, you can
use a field with locations defined in the coordinate system the map uses (either degrees or meters).
For more information, see Using non-WGS-84 coordinate systems (page 267).

Creating maps
You can add a map to the sheet you are editing.

You can create several map visualizations based on different point data or area data,
which use the same dimension data.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty map to the sheet.
2. From Map settings, select the Base map.
3. From Layers in the properties panel, add layers to your map.

Layers are placed above layers of the same type. You can set the order of layers by dragging
layers up and down in the list. The layer at the top of your list is also overlaid on top of the
other layers on your map.
For information on configuring layers, see:

l Point layers (page 267)
l Area layers (page 269)
l Line layers (page 270)
l Density layers (page 273)
l Chart layers (page 275)
l Hintergrundebenen (page 277)

Once the map is created, you can adjust its appearance and other settings for the map and its
layers in the properties panel.

will appear in the top-left corner of your map if there is an issue with the added layer.
Click the icon to see the error message.

Styling the map
There are options available in the properties panel for styling the text in the map chart.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).
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Customizing the text in the title area
Click Styling under Appearance > Presentation to customize the styling of the chart's title area

(title, subtitle, and footnote). Sie können Ihre Designs zurücksetzen, indem Sie auf neben den

einzelnen Abschnitten klicken. Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für
alle verfügbaren Registerkarten im Designfenster zurückgesetzt.

You can set the text for the title, subtitle, and footnote under Appearance > General. To hide these
elements, turn off Show titles.

You can style the text of the title information for the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the text in the map layer labels
The font, font size, and text color for the layers of individual layers can be customized. You can
style the text for the following types of map layers:

l Area layers
l Point layers
l Line layers
l Chart layers

Gehen Sie folgendermaßen vor:

1. Under Layers in the properties panel, click the layer for which you want to style the text.
2. Under Options > General, toggle on the Show label setting.
3. Use the options under Label font family to change the font for the layer labels.
4. Use the options under Label font size to adjust the text size of the layer labels.
5. Select a color for the label text under Label font color.

Customizing the border and shadow
You can customize the border and shadow of the chart.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limiting location scope in map layers
By default, Qlik Sense searches a broad scope of locations for the location field when names are
used. In cases where there are multiple possible matches, you may need to limit the scope of
locations searched to ensure Qlik Sense displays the desired location.

Gehen Sie folgendermaßen vor:

1. From Layers in the properties panel, click Location.
2. Set Scope for location to Custom.
3. After Location type, select the type of data contained in the field or expression selected as

Location field.
4. Optionally, after Country, enter a field, expression, or text indicating the country the

locations in the Location field are located.
5. Optionally, after Administrative area (Level 1), enter a field, expression, or text indicating

the first-level administrative area the locations in the Location field are located.
6. Optionally, after Administrative area (Level 2), enter a field, expression, or text indicating

the second-level administrative area the locations in the Location field are located.

Limiting panning in your map
You can limit the panning settings in your map to keep the view in your map limited to a set area,
such as a specific region of interest. When you limit the panning in a map, you lock the map to the
current view. The map will not zoom out further than the current view. You cannot pan the map
beyond the limits of the current view. If you zoom in, you can pan, but you are limited by the
boundaries of the pan limit.

Gehen Sie folgendermaßen vor:

1. From the properties panel, click Appearance.
2. In Presentation, set Limit pan navigation to Custom.
3. Set your map to the view you want to which you want to limit the pan.
4. Click Set pan limit.
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You can toggle the set pan limit on and off with Limit pan navigation. You can clear the saved pan
limit by clicking Clear pan limit.

Using non-WGS-84 coordinate systems
If you have data and a background map in a projection other than WGS-84, you should set the base
map to None, add your background map as a background layer, and then set your projection to use
undefined degrees or meters depending on the unit of length used in your base map.

When using non-WGS-84 coordinates, you must use geometries loaded into a field. Location names
cannot be used.

Gehen Sie folgendermaßen vor:

1. From the properties panel, click Map settings.
2. In Base map, select Empty (undefined degrees) or Empty (undefined meters).
3. Select Background layer.
4. After URL, enter the URL to a slippy map server.

For example, http://a.tile.opencyclemap.org/cycle/${z}/${x}/${y}.png .
5. After Attribution, enter the attribution string for the map.

For example, &copy; <a href='http://www.opencyclemap.org/' target='_
blank'>OpenCycleMap</a>. Map data &copy; <a
href='http://www.openstreetmap.org/copyright' target='_blank'>OpenStreetMap</a>
contributors.

6. From Layers, click Add layer.
7. Select your layer type.
8. In Dimensions, click Add and select a field containing data in your map's coordinate system.

Point layers
A point layer overlays individual locations on a map, representing them with shapes.
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By default, point layers use circular bubbles, but you can also use several other shapes. You can
also use custom images as the points in a point layer. The size of the points in your layer can be
fixed or you can specify a measure or expression to set the sizes of the different points. You can
highlight these differences in values further by coloring by measure.

Map with point layer displaying cities in Atlantic Canada colored and sized by population.
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Adding a point layer

Gehen Sie folgendermaßen vor:

1. Drag and drop a field onto the map, select Add as new layer, and select Add as point layer.
2. From Layers in the properties panel, click Add layer and select Point layer. In Dimensions,

click Add and select a field containing point data to use as the dimension.
3. If there are issues with the point locations, adjust the location settings in Locations in the

properties panel.
For more information, see Limiting location scope in map layers (page 266).

Once the layer is added, you can adjust settings for the layer in the properties panel.

Area layers
An area layer presents areas on your map, such as countries or states. With polygon
geometry loaded into a field, it can present any custom area.

With an area layer, each dimension value corresponds to a presented area. By using colors with
your area layer, you can present different measure values for the areas. In the properties panel,
under Appearance > Colors and legend, switch Colors to Custom where the options By measure
and By expression are available.
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Map with area layer displaying Australian states and territories colored by population.

Adding an area layer

Gehen Sie folgendermaßen vor:

1. Gehen Sie folgendermaßen vor:
l Drag and drop a field onto the map, select Add as new layer, and select Add as area

layer.
l From Layers in the properties panel, click Add layer and select Area layer. In

Dimensions, click Add and select a field containing area data to use as the dimension.
2. If there are issues with the point locations, adjust the location settings in Locations in the

properties panel.
Limiting location scope in map layers (page 266)

Once the layer is added, you can adjust settings for the layer in the properties panel.

Line layers
A line layer enables you to display lines between points on your map.
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For example, you can use a line layer to show aircraft flights between cities. With a line layer, you
can use two fields containing point data to define the start points and end points for lines in the
layer. Alternatively, you can use a field containing line geometry in either GeoJSON LineString or
MultiLineString format. You can customize the width and curvature of lines in the line layer and add
directional arrows to your lines.
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Map with line layer displaying departing flights between airports in Europe.

Adding a line layer
Line layers display lines using either start and end points, where two fields are used to determine
where lines start and end, or using line geometries in GeoJSONLineString or MultiLineString format.

If you are using a start and end point line layer, the dimension you select for your line layer should
represent the fields selected as the start and end points in your Location settings. For example, if
you wanted to visualize where your shipments are being sent, you could set Shipments as the
dimension and then use Distribution Center Location and Shipping Destination as the start point
and end point in Location.

Alternatively, you can add two dimensions to the line layer and use these as the start and end
points. This is useful if you want to display lines between all locations in the first dimensions to all
locations in the second dimension, which has an association to the first dimension.

Adding a line layer with start and end points

Gehen Sie folgendermaßen vor:

1. Gehen Sie folgendermaßen vor:
l Drag and drop a field containing start point data onto the map, select Add as new

layer, and select Add as line layer.
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l From Layers in the properties panel, click Add layer and select Line layer. In
Dimensions, click Add and select a field to use as the dimension.

2. If your dimension contains start point data, add a field containing end point data. Do one of
the following: 

l Drag and drop a field containing end point data onto the map, select Use in <layer
name>, and select Add <field name> as a second dimension.

l In Data, click Add and select a field containing end point data.
3. If your dimension does not contain start or end point data, in Location, add the fields

containing the start point data and end point data as location fields.
4. If there are issues with the start and end point locations, adjust the location settings in

Location in the properties panel.
Line layers using start point field and end point fields each have separate location settings in
Location.
For more information, see Limiting location scope in map layers (page 266).

Once the layer is added, you can adjust settings for the layer in the properties panel.

Adding a line layer with line geometries

Gehen Sie folgendermaßen vor:

1. Gehen Sie folgendermaßen vor:
l Drag and drop a field containing line geometries onto the map, select Add as new

layer, and select Add as line layer.
l From Layers in the properties panel, click Add layer and select Line layer. In

Dimensions, click Add and select a field to use as the dimension.
2. In Location, select Line geometry and then select a field in Line geometry field.

By default, your dimension is selected as the Line geometry field.

Once the layer is added, you can adjust settings for the layer in the properties panel.

Density layers
A density layer enables you to visualize the density of points in an area using a color
ramp.
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Each point influences a circular area, with the highest influence at the center and declining towards
its outer perimeter. You can specify the influence radius of the points, change its color and scale it
to suit your visualization. Density layers can be used to show hotspots of activity, population
densities and more.

Map with density layer displaying number of global volcanic eruptions.
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Adding a density layer

Gehen Sie folgendermaßen vor:

1. Gehen Sie folgendermaßen vor:
l Drag and drop a field containing point data onto the map, select Add as new layer,

and select Add as density layer.
l From Layers in the properties panel, click Add layer and select Density layer. In

Dimensions, click Add and select a field containing point data to use as the
dimension.

2. If there are issues with the point locations, adjust the location settings in Locations in the
properties panel.
For more information, see Limiting location scope in map layers (page 266).

Once the layer is added, you can adjust settings for the layer in the properties panel. .

Chart layers
A chart layer enables you to display small pie charts or bar charts over locations in your
map. It uses one dimension to identify the locations and a second dimension to create
the pie or bar charts.

You can label the charts and use an expression to control their size. The info bubble displays useful
information about the contents of the selected chart.
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Map with chart layer displaying source of funds in European Union countries as pie charts. The size of each
pie chart shows average absorption rate of funds.

Adding a chart layer

Gehen Sie folgendermaßen vor:

1. Gehen Sie folgendermaßen vor:
l Drag and drop a field containing point data onto the map, select Add as new layer,

and select Add as chart layer.
l From Layers in the properties panel, click Add layer and select Chart layer.

2. In Dimensions, under Location, click Add and select a field containing point data to use as
the locations on your map. Click Add and select a field containing data to use as the
dimension on your charts.

3. In Measures, click Add and select a field containing data to use as the measure on your
charts.

4. If there are issues with the point locations, adjust the location settings in Location in the
properties panel.
Limiting location scope in map layers (page 266)

Once the layer is added, you can adjust settings for the layer in the properties panel.
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Hintergrundebenen
Hintergrundebenen ermöglichen es Ihnen, eine benutzerdefinierte Basiskarte für Ihre
Kartenvisualisierung anzuzeigen.

Eine Hintergrundebene kann beispielsweise die Karte eines Flughafens sein, die dann von einer
Punktebene mit WIFI Hotspot-Standorten überlagert wird. Wenn die benutzerdefinierte Basiskarte
Transparenz unterstützt, können Sie mit ihr eine andere Karte überlagern. Qlik Sense unterstützt
die folgenden benutzerdefinierten Kartenformate als Hintergrundebenen:

l Slippy-Maps- oder Kachel-Kartendienste (TMS)
l Web-Kartendienst (WMS)
l Bild-URL (Bild)

Kartendienste müssen sich auf ihrem eigenen Server befinden. Im Gegensatz zu anderen Ebenen
verwendet die Hintergrundebene keine Dimensionen oder Kennzahlen und zeigt nur eine externe
Basiskarte an.

Wenn Ihr WMS Bereiche ohne Daten enthält, können Sie die Bereiche ohne Daten als transparent
festlegen. Dadurch kann die WMS-Hintergrundebene über eine andere Basiskarte oder
Hintergrundebene gelegt werden. Sie können auch wählen, welche WMS-Ebenen in die
Hintergrundebene eingeschlossen werden.

Sie können ein Bild als Hintergrundebene einfügen. Es kann als benutzerdefinierte Basiskarte
verwendet werden. Beispielsweise können Sie ein Bild eines Grundrisses hinzufügen und es als
benutzerdefinierte Basiskarte verwenden. Eine Bild-Hintergrundebene kann auch über eine andere
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Hintergrundebene gelegt werden. Sie können zum Beispiel ein Bild einer detaillierten Ortskarte als
Hintergrundebene über eine andere Karte legen. Hintergrundebenen unterstützen die folgenden
Bildtypen:

l PNG
l JPG
l JPEG
l GIF

Karte mit Hintergrundebene, die eine TMS OpenStreetMap-Karte anzeigt.

Hinzufügen einer Hintergrundebene
Die Konfiguration der Hintergrundebene kann abhängig vom Typ der Hintergrundkarte
unterschiedlich sein.

Hinzufügen einer TMS-Hintergrundebene

Gehen Sie folgendermaßen vor:

1. Klicken Sie in Ebenen im Eigenschaftsfenster auf Ebene hinzufügen.
2. Wählen Sie Hintergrundebene.
3. Wählen Sie hinter Format die Option TMS aus.
4. Geben Sie hinter URL die URL eines Slippy-Map- oder Kachelkarten-Servers ein.

Hier ein Beispiel: http://a.tile.opencyclemap.org/cycle/${z}/${x}/${y}.png.
5. Geben Sie hinter Zuordnung den Zuordnungsstring für die Karte ein.

Hier ein Beispiel: &copy; <a href='http://www.opencyclemap.org/' target='_
blank'>OpenCycleMap</a>. Map data &copy; <a
href='http://www.openstreetmap.org/copyright' target='_blank'>OpenStreetMap</a>
contributors.
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Nachdem die Ebene hinzugefügt ist, können Sie deren Einstellungen im Eigenschaftsfenster
anpassen.

Hinzufügen einer WMS-Hintergrundebene

Gehen Sie folgendermaßen vor:

1. Klicken Sie in Ebenen im Eigenschaftsfenster auf Ebene hinzufügen.
2. Wählen Sie Hintergrundebene.
3. Wählen Sie unter Format die Option WMS aus.
4. Klicken Sie auf WMS-Einrichtung.
5. Geben Sie unter WMS-Server-URL die URL ein.
6. Wählen Sie unter Version die WMS-Version aus.
7. Klicken Sie auf WMS laden.
8. Geben Sie hinter CRS das Koordinatenreferenzsystem ein, das von der WMS-Karte

verwendet wird.
9. Wählen Sie Transparent aus, um Kartenbilder zu generieren, die transparent sind, wenn

keine Daten vorhanden sind.

Dies wird nicht von allen WMS unterstützt.

10. Wählen Sie unter Bildformat das WMS-Bildformat aus.
11. Wählen Sie unter Ebenen die Kartenebenen aus, die von Ihrem WMS-Server unterstützt

werden.
12. Klicken Sie auf Speichern.
13. Geben Sie hinter Zuordnung den Zuordnungsstring für die Karte ein.

Hier ein Beispiel: &copy; <a href='http://www.opencyclemap.org/' target='_
blank'>OpenCycleMap</a>. Map data &copy; <a
href='http://www.openstreetmap.org/copyright' target='_blank'>OpenStreetMap</a>
contributors.

Nachdem die Ebene hinzugefügt ist, können Sie deren Einstellungen im Eigenschaftsfenster
anpassen.

Hinzufügen einer Bild-Hintergrundebene
Bilder können als benutzerdefinierte Basiskarte verwendet werden, z. B. für Grundrisse. Wenn Sie
eine Bild-Hintergrundebene als benutzerdefinierte Basiskarte verwenden, legen Sie Basiskarte in
Karteneinstellungen auf Keine fest. Wählen Sie Benutzerdefiniert (Meter) oder
Benutzerdefiniert (Grad) als Projektion aus. Die Standortdaten für Ihre anderen Ebenen müssen
das gleiche Koordinatensystem wie diese Hintergrundebene verwenden.
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Wenn Sie eine Bild-Hintergrundebene für ein kleineres geografisches Gebiet als das
einer benutzerdefinierten Basiskarte hinzufügen, fügen Sie gleichzeitig eine Ebene mit
Daten (z. B. eine Punktebene) hinzu. Damit kann die Karte automatisch auf die Position
Ihrer Bild-Hintergrundebene vergrößert werden.

Die kleinste Einheit in der Skalenleiste ist 10 Meter. Wenn diese Abmessung für Ihr Bild
zu groß ist, können Sie die Skalenleiste unter Präsentation deaktivieren und dann
proportional Ihr Bild in der Hintergrundebene an die gewünschte Skala anpassen.
Skalieren Sie die Standortdaten, die Sie auch in anderen Ebenen verwenden möchten.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in Ebenen im Eigenschaftsfenster auf Ebene hinzufügen.
2. Wählen Sie Hintergrundebene.
3. Wählen Sie unter Format die Option Bild aus.
4. Geben Sie nach URL die URL des Bildes ein.
5. Positionieren Sie Ihr Bild, indem Sie die Koordinaten für die obere linke und untere rechte

Ecke des Bildes eingeben.
Die Koordinaten müssen den gleichen Koordinatentyp haben, der auch in Projektion
ausgewählt wurde.

Wenn Sie sich über die Koordinaten in Ihrer Bild-Hintergrundebene nicht sicher
sind, aktivieren Sie Debug-Info anzeigen. Damit werden die Koordinaten für den
aktuellen Mittelpunkt Ihrer Karte angezeigt.

6. Geben Sie hinter Zuordnung den Zuordnungsstring für das Bild ein.
Hier ein Beispiel: &copy; <a href='http://www.opencyclemap.org/' target='_
blank'>OpenCycleMap</a>. Map data &copy; <a
href='http://www.openstreetmap.org/copyright' target='_blank'>OpenStreetMap</a>
contributors.

Nachdem die Ebene hinzugefügt ist, können Sie deren Einstellungen im Eigenschaftsfenster
anpassen. Für Bild-Hintergrundebenen, die als benutzerdefinierte Basiskarten verwendet werden,
wird empfohlen, die Einstellungen Vergrößerungsstufen begrenzen und Schwenknavigation
begrenzen zu ändern, um den Fokus auf Ihre benutzerdefinierte Karte zu setzen.

Drilldown-Ebenen
Wenn Sie eine Karte erstellen, die mehrere Datenpunkte in einem großen
geografischen Gebiet enthält, können Sie mithilfe von Drilldown-Dimensionen die
Ebenen in einer Auswahlhierarchie anzeigen.
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Dies ermöglicht es Ihnen, verschiedene Ebenen auf verschiedenen Levels innerhalb Ihrer Karte zu
verwenden, um sicherzustellen, dass nur die relevantesten Informationen angezeigt werden.

Wenn Sie in einer Drilldown-Ebene Auswahlen treffen, wechselt die für Standorte verwendete
Dimension zur nächsten Dimension in der Drilldown-Dimension. Der Drilldown erfolgt über Ebenen
hinweg, die die gleiche Drilldown-Dimension verwenden. Wenn Sie eine Gebiets- und Punktebene
haben, die die gleiche Drilldown-Dimension verwenden, können Sie einstellen, welche Ebene mit
welcher Dimension aus der Drilldown-Dimension angezeigt wird.

Wenn Auswahlen bewirken, dass das aktuelle Drilldown-Dimensionsfeld nur einen
möglichen Wert enthält, wird stattdessen das nächste Feld in der Liste verwendet.

Für Drilldown-Dimensionen, die für Drilldown-Ebenen verwendet werden, müssen die Felder in der
Reihenfolge vom höchsten geografischen Gebiet bis zum kleinsten geografischen Gebiet sortiert
sein.

Weitere Informationen zu Drilldown-Dimensionen finden Sie unter Creating a drill-down dimension
(page 123).

Gehen Sie folgendermaßen vor:

1. Klicken Sie in Ebenen im Eigenschaftsfenster auf Ebene hinzufügen.
2. Wählen Sie Punktebene, Gebietsebene, Linienebene, Dichteebene oder Diagrammebene

aus.
3. Klicken Sie aufDimensionen, und klicken Sie dann auf Hinzufügen und wählen Sie Ihre

Drilldown-Dimension aus.
4. Klicken Sie in Ihrer Ebene auf Optionen.
5. Klicken Sie auf Ebenenanzeige.
6. Wählen Sie hinter Sichtbare Drilldown-Ebenen aus, welche Dimensionen in der Ebene

angezeigt werden sollen.

Kontrolle der sichtbaren Kartendaten mit Drilldown-Ebenen
In diesem Beispiel wird gezeigt, wie Sie eine Karte mit einer Gebietsebene der obersten
Ebene erstellen, die einen Drilldown zu zwei Punkteebenen ermöglicht.

Wenn Sie eine Karte mit mehreren Datenpunkten in einem großen geografischen Gebiet erstellen,
können Sie Ihre Ebenen mithilfe von Drilldown-Dimensionen in einer Hierarchie darstellen. Wenn
Benutzer in einer Ebene Auswahlen treffen, wechselt die in der Ebene angezeigte Dimension zur
nächsten Dimension in der Drilldown-Dimension. Dies ermöglicht es Ihnen, Anzeigedaten auf
verschiedenen Ebenen innerhalb Ihrer Karte zu verwenden, um sicherzustellen, dass nur die
relevantesten Informationen angezeigt werden.
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Im National Register of Historic Places des United States National Park Service steht eine Liste aller
historischen Stätten zur Verfügung. Wenn wir die Städte mit historischen Stätten als Punktebene zu
einer Karte hinzufügen erhalten wir präzise Positionsdaten für unsere kugelförmigen Blasen. Es
könnte jedoch durch eine bessere Organisation verständlicher gemacht werden.

Wie können wir diese Informationen besser organisieren, insbesondere, wenn wir auch eine weitere
Punktebene mit Flughäfen hinzufügen möchten, um besser zu planen, wie man zu den
verschiedenen Orten kommt?

Um dieses Problem zu lösen, werden wir eine Karte der Vereinigten Staaten von Amerika mit einer
Ebene für die Bundesstaaten erstellen, die bis auf County-Ebene aufgeschlüsselt werden kann.
Beim Drilldown zur Landkreis-Ebene werden die Städte mit historischen Stätten sowie alle
Flughäfen in diesem Bundesstaat und in den umliegenden Bundesstaaten als Datenpunkte
angezeigt.
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Datensatz
In diesem Beispiel werden zwei Datensätze verwendet:

l Federal listings: National Register of Historic Places listed properties from federal agencies
(federal_listed_20190404.xlsx)
Dieser Datensatz ist im Nationalen Register der historischen Orte des National Park Service
verfügbar. Er enthält Daten zu allen registrierten historischen Orten, deren geografischer
Position und den mit ihnen verbundenen Bundesbehörden.
≤ federal_listed_20190404.xlsx.

l Airport data
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Diese Tabelle enthält Daten zu den Flughäfen in den Vereinigten Staaten. Diese Daten
beinhalten für jeden Flughafen den zugehörigen IATA-Code (International Air Transport
Association), eine Angabe zur zugeordneten Stadt sowie eine Angabe zum Bundesstaat oder
Territorium, in dem er sich befindet.
Sie müssen diese Daten in Qlik Sense importieren, indem Sie sie zu einer Tabelle hinzufügen
und diese Tabelle in Qlik Sense importieren oder indem Sie die Tabelle von dieser Hilfeseite
als Webdatei importieren.
Airport data

Airport AirportCity AirportState

ABE Allentown/Bethlehem/Easton, PA PA

ABI Abilene, TX TX

ABQ Albuquerque, NM NM

ABR Aberdeen, SD SD

ABY Albany, GA GA

ACT Waco, TX TX

ACV Arcata/Eureka, CA CA

ADK Adak Island, AK AK

ADQ Kodiak, AK AK

AEX Alexandria, LA LA

AGS Augusta, GA GA

ALB Albany, NY NY

ALO Waterloo, IA IA

AMA Amarillo, TX TX

ANC Anchorage, AK AK

APN Alpena, MI MI

ART Watertown, NY NY

ASE Aspen, CO CO

ATL Atlanta, GA GA

ATW Appleton, WI WI

AUS Austin, TX TX

AVL Asheville, NC NC

AVP Scranton/Wilkes-Barre, PA PA

AZO Kalamazoo, MI MI

Airport data
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Airport AirportCity AirportState

BDL Hartford, CT CT

BET Bethel, AK AK

BFL Bakersfield, CA CA

BGR Bangor, ME ME

BHM Birmingham, AL AL

BIL Billings, MT MT

BIS Bismarck/Mandan, ND ND

BJI Bemidji, MN MN

BKG Branson, MO MO

BLI Bellingham, WA WA

BMI Bloomington/Normal, IL IL

BNA Nashville, TN TN

BOI Boise, ID ID

BOS Boston, MA MA

BPT Beaumont/Port Arthur, TX TX

BQK Brunswick, GA GA

BQN Aguadilla, PR PR

BRD Brainerd, MN MN

BRO Brownsville, TX TX

BRW Barrow, AK AK

BTM Butte, MT MT

BTR Baton Rouge, LA LA

BTV Burlington, VT VT

BUF Buffalo, NY NY

BUR Burbank, CA CA

BWI Baltimore, MD MD

BZN Bozeman, MT MT

CAE Columbia, SC SC

CAK Akron, OH OH

CDC Cedar City, UT UT
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Airport AirportCity AirportState

CDV Cordova, AK AK

CEC Crescent City, CA CA

CHA Chattanooga, TN TN

CHO Charlottesville, VA VA

CHS Charleston, SC SC

CIC Chico, CA CA

CID Cedar Rapids/Iowa City, IA IA

CLD Carlsbad, CA CA

CLE Cleveland, OH OH

CLL College Station/Bryan, TX TX

CLT Charlotte, NC NC

CMH Columbus, OH OH

CMI Champaign/Urbana, IL IL

CMX Hancock/Houghton, MI MI

COD Cody, WY WY

COS Colorado Springs, CO CO

COU Columbia, MO MO

CPR Casper, WY WY

CRP Corpus Christi, TX TX

CRW Charleston/Dunbar, WV WV

CSG Columbus, GA GA

CWA Mosinee, WI WI

CVG Cincinnati, OH KY

DAB Daytona Beach, FL FL

DAL Dallas, TX TX

DAY Dayton, OH OH

DBQ Dubuque, IA IA

DCA Washington, DC VA

DEN Denver, CO CO

DFW Dallas/Fort Worth, TX TX
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Airport AirportCity AirportState

DHN Dothan, AL AL

DIK Dickinson, ND ND

DLH Duluth, MN MN

DRO Durango, CO CO

DSM Des Moines, IA IA

DTW Detroit, MI MI

EAU Eau Claire, WI WI

ECP Panama City, FL FL

EGE Eagle, CO CO

EKO Elko, NV NV

ELM Elmira/Corning, NY NY

ELP El Paso, TX TX

EUG Eugene, OR OR

EWN New Bern/Morehead/Beaufort, NC NC

EWR Newark, NJ NJ

EVV Evansville, IN IN

EYW Key West, FL FL

FAI Fairbanks, AK AK

FAR Fargo, ND ND

FAT Fresno, CA CA

FAY Fayetteville, NC NC

FCA Kalispell, MT MT

FLG Flagstaff, AZ AZ

FLL Fort Lauderdale, FL FL

FNT Flint, MI MI

FOE Topeka, KS KS

FSD Sioux Falls, SD SD

FSM Fort Smith, AR AR

FWA Fort Wayne, IN IN

GCC Gillette, WY WY
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Airport AirportCity AirportState

GCK Garden City, KS KS

GEG Spokane, WA WA

GFK Grand Forks, ND ND

GGG Longview, TX TX

GJT Grand Junction, CO CO

GNV Gainesville, FL FL

GPT Gulfport/Biloxi, MS MS

GRB Green Bay, WI WI

GRI Grand Island, NE NE

GRK Killeen, TX TX

GRR Grand Rapids, MI MI

GSO Greensboro/High Point, NC NC

GSP Greer, SC SC

GTF Great Falls, MT MT

GTR Columbus, MS MS

GUC Gunnison, CO CO

GUM Guam, TT TT

HDN Hayden, CO CO

HIB Hibbing, MN MN

HLN Helena, MT MT

HNL Honolulu, HI HI

HOB Hobbs, NM NM

HOU Houston, TX TX

HPN White Plains, NY NY

HRL Harlingen/San Benito, TX TX

HSV Huntsville, AL AL

IAD Washington, DC VA

IAH Houston, TX TX

ICT Wichita, KS KS

IDA Idaho Falls, ID ID

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 288



3   Visualizations

Airport AirportCity AirportState

ILG Wilmington, DE DE

ILM Wilmington, NC NC

IMT Iron Mountain/Kingsfd, MI MI

IND Indianapolis, IN IN

INL International Falls, MN MN

ISN Williston, ND ND

ISP Islip, NY NY

ITO Hilo, HI HI

JAC Jackson, WY WY

JAN Jackson/Vicksburg, MS MS

JAX Jacksonville, FL FL

JFK New York, NY NY

JLN Joplin, MO MO

JNU Juneau, AK AK

KOA Kona, HI HI

KTN Ketchikan, AK AK

LAN Lansing, MI MI

LAR Laramie, WY WY

LAS Las Vegas, NV NV

LAW Lawton/Fort Sill, OK OK

LAX Los Angeles, CA CA

LBB Lubbock, TX TX

LCH Lake Charles, LA LA

LEX Lexington, KY KY

LFT Lafayette, LA LA

LGA New York, NY NY

LGB Long Beach, CA CA

LIH Lihue, HI HI

LIT Little Rock, AR AR

LMT Klamath Falls, OR OR
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Airport AirportCity AirportState

LNK Lincoln, NE NE

LRD Laredo, TX TX

LSE La Crosse, WI WI

LWS Lewiston, ID ID

MAF Midland/Odessa, TX TX

MBS Saginaw/Bay City/Midland, MI MI

MCI Kansas City, MO MO

MCO Orlando, FL FL

MDT Harrisburg, PA PA

MDW Chicago, IL IL

MEM Memphis, TN TN

MFE Mission/McAllen/Edinburg, TX TX

MFR Medford, OR OR

MGM Montgomery, AL AL

MHK Manhattan/Ft. Riley, KS KS

MHT Manchester, NH NH

MIA Miami, FL FL

MKE Milwaukee, WI WI

MKG Muskegon, MI MI

MLB Melbourne, FL FL

MLI Moline, IL IL

MLU Monroe, LA LA

MMH Mammoth Lakes, CA CA

MOB Mobile, AL AL

MOD Modesto, CA CA

MOT Minot, ND ND

MQT Marquette, MI MI

MRY Monterey, CA CA

MSN Madison, WI WI

MSO Missoula, MT MT
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Airport AirportCity AirportState

MSP Minneapolis, MN MN

MSY New Orleans, LA LA

MTJ Montrose/Delta, CO CO

MYR Myrtle Beach, SC SC

OAJ Jacksonville/Camp Lejeune, NC NC

OAK Oakland, CA CA

OGG Kahului, HI HI

OKC Oklahoma City, OK OK

OMA Omaha, NE NE

OME Nome, AK AK

ONT Ontario, CA CA

ORD Chicago, IL IL

ORF Norfolk, VA VA

ORH Worcester, MA MA

OTH North Bend/Coos Bay, OR OR

OTZ Kotzebue, AK AK

PAH Paducah, KY KY

PBI West Palm Beach/Palm Beach, FL FL

PDX Portland, OR OR

PHF Newport News/Williamsburg, VA VA

PHL Philadelphia, PA PA

PHX Phoenix, AZ AZ

PIA Peoria, IL IL

PIH Pocatello, ID ID

PIT Pittsburgh, PA PA

PNS Pensacola, FL FL

PPG Pago Pago, TT TT

PSC Pasco/Kennewick/Richland, WA WA

PSE Ponce, PR PR

PSG Petersburg, AK AK
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Airport AirportCity AirportState

PSP Palm Springs, CA CA

PVD Providence, RI RI

PWM Portland, ME ME

RAP Rapid City, SD SD

RDD Redding, CA CA

RDM Bend/Redmond, OR OR

RDU Raleigh/Durham, NC NC

RHI Rhinelander, WI WI

RIC Richmond, VA VA

RKS Rock Springs, WY WY

RNO Reno, NV NV

ROA Roanoke, VA VA

ROC Rochester, NY NY

ROW Roswell, NM NM

RST Rochester, MN MN

RSW Fort Myers, FL FL

SAF Santa Fe, NM NM

SAN San Diego, CA CA

SAT San Antonio, TX TX

SAV Savannah, GA GA

SBA Santa Barbara, CA CA

SBN South Bend, IN IN

SBP San Luis Obispo, CA CA

SCC Deadhorse, AK AK

SCE State College, PA PA

SDF Louisville, KY KY

SEA Seattle, WA WA

SFO San Francisco, CA CA

SGF Springfield, MO MO

SGU St. George, UT UT
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Airport AirportCity AirportState

SHV Shreveport, LA LA

SIT Sitka, AK AK

SJC San Jose, CA CA

SJT San Angelo, TX TX

SJU San Juan, PR PR

SLC Salt Lake City, UT UT

SMF Sacramento, CA CA

SMX Santa Maria, CA CA

SNA Santa Ana, CA CA

SPI Springfield, IL IL

SPS Wichita Falls, TX TX

SRQ Sarasota/Bradenton, FL FL

STL St. Louis, MO MO

STT Charlotte Amalie, VI VI

STX Christiansted, VI VI

SUN Sun Valley/Hailey/Ketchum, ID ID

SUX Sioux City, IA IA

SWF Newburgh/Poughkeepsie, NY NY

SYR Syracuse, NY NY

TLH Tallahassee, FL FL

TOL Toledo, OH OH

TPA Tampa, FL FL

TRI Bristol/Johnson City/Kingsport, TN TN

TTN Trenton, NJ NJ

TUL Tulsa, OK OK

TUS Tucson, AZ AZ

TVC Traverse City, MI MI

TWF Twin Falls, ID ID

TXK Texarkana, AR AR

TYR Tyler, TX TX
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Airport AirportCity AirportState

TYS Knoxville, TN TN

VLD Valdosta, GA GA

VPS Valparaiso, FL FL

WRG Wrangell, AK AK

XNA Fayetteville, AR AR

YAK Yakutat, AK AK

YUM Yuma, AZ AZ

Anleitung
Sobald Sie die Datensätze in eine neue App in Qlik Sense geladen haben, können Sie mit dem
Erstellen Ihrer Karte beginnen. Um die Beispielkarte zu erstellen, müssen Sie folgende Aufgaben
durchführen: 

1. Erstellen der Drilldown-Dimensionen
2. Fügen Sie die Karte zu unserem Arbeitsblatt hinzu.
3. Hinzufügen des Gebiets-Layers State-County
4. Fügen Sie die Punktebene State-City hinzu.
5. Fügen Sie die Punktebene State-Airport hinzu.
6. Hinzufügen des Filterfensters Resource

Erstellen der Drilldown-Dimensionen
Zuerst müssen Sie drei Drilldown-Dimensionen erstellen. Dadurch werden die Beziehungen
zwischen State und den Feldern County, City und Airport hergestellt, was den Layern County, City
und Airport ermöglicht, sichtbar zu werden, nachdem ein Bundesstaat aus dem State-Layer
ausgewählt wurde.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Klicken Sie auf , um die Master-Elemente anzuzeigen.

3. Klicken Sie auf Dimensionen.
4. Klicken Sie auf Neu erstellen.
5. Wählen Sie Drilldown aus.
6. Fügen Sie das Feld State zur Dimension hinzu.
7. Fügen Sie das Feld County zur Dimension hinzu.
8. Geben Sie hinter Name State-County ein.
9. Klicken Sie auf Erstellen..

10. Fügen Sie das Feld State zur Dimension hinzu.
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11. Fügen Sie das Feld City zur Dimension hinzu.
12. Geben Sie hinter Name State-City ein.
13. Klicken Sie auf Erstellen..
14. Fügen Sie das Feld State zur Dimension hinzu.
15. Fügen Sie das Feld Airport zur Dimension hinzu.
16. Geben Sie hinter Name State-Airport ein.
17. Klicken Sie auf Erstellen..

18. Klicken Sie auf Bearbeitung erledigt.

Karte zum Arbeitsblatt hinzufügen
Im nächsten Schritt fügen Sie Ihrem Arbeitsblatt eine Karte hinzu.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Ziehen Sie aus dem Extras-Fenster eine leere Karte auf das Arbeitsblatt.

Hinzufügen des Gebiets-Layers State-County
Die erste Ebene, die Sie hinzufügen, ist eine Gebietsebene, der Sie die Dimension State-County
hinzufügen. Darüber hinaus legen Sie als Land 'USA' fest, um sicherzustellen, dass Sie den
Bundesstaat Georgia und nicht die Nation Georgien darstellen.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in Ebenen im Eigenschaftsfenster auf Ebene hinzufügen.
2. Wählen Sie Gebietsebene.
3. Klicken Sie unter Dimensionen auf Hinzufügen und wählen Sie State-County aus.
4. Klicken Sie auf Standort.
5. Legen Sie den Geltungsbereich für die Standorteauf Benutzerdefiniert fest.
6. Geben Sie nach Land 'USA' ein.
7. Wählen Sie nach Verwaltungsgebiet (Ebene 1) State aus.
8. Klicken Sie auf Farben.
9. Stellen Sie Colors auf Custom ein und wählen Sie By dimension und 100 colors aus.

10. Wählen Sie Farben bei Auswahl beibehalten aus.
11. Verschieben Sie den Schieberegler Deckung auf halbe Deckkraft fest.

12. Klicken Sie auf Bearbeitung erledigt.

Fügen Sie die Punktebene State-City hinzu.
Die nächste Ebene, die Sie hinzufügen, ist eine Punktebene. Fügen Sie State-City als Dimension
hinzu und legen Sie das Land als 'USA' fest. Dann legen Sie State als Verwaltungsgebiet der ersten
Ordnung hinzu, da einige Städte der Counties in verschiedenen Staaten dieselben Namen haben.
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Gehen Sie folgendermaßen vor:

1. Klicken Sie in Ebenen im Eigenschaftsfenster auf Ebene hinzufügen.
2. Wählen Sie Gebietsebene.
3. Klicken Sie unter Dimensionen auf Hinzufügen und wählen Sie State-City aus.
4. Klicken Sie auf Standort.
5. Legen Sie den Geltungsbereich für die Standorteauf Benutzerdefiniert fest.
6. Geben Sie nach Land 'USA' ein.
7. Wählen Sie nach Verwaltungsgebiet (Ebene 1) State aus.
8. Klicken Sie auf Farben.
9. Stellen Sie Colors auf Custom ein, wählen Sie die Option Single color und dann eine Farbe

aus.
10. Klicken Sie auf Optionen.
11. Legen Sie in der Anzeige Ebene die Sichtbaren Drilldown-Ebenen auf Benutzerdefiniert

fest.
12. Löschen Sie Staat.

13. Klicken Sie auf Bearbeitung erledigt.

Fügen Sie die Punktebene State-Airport hinzu.
Die letzte Ebene, die Sie zur Karte hinzufügen, ist eine Punktebene, zu der Sie das Feld State-
Airport als Dimension hinzufügen. Qlik Sense erkennt IATA-Codes für die Platzierung. Damit ist
sichergestellt, dass die Flughäfen an ihrer tatsächlichen geografischen Position und nicht nur in
ihrer Stadt platziert werden.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in Ebenen im Eigenschaftsfenster auf Ebene hinzufügen.
2. Wählen Sie Gebietsebene.
3. Klicken Sie unter Dimensionen auf Hinzufügen und wählen Sie State-Airport aus.
4. Klicken Sie auf Standort.
5. Legen Sie den Geltungsbereich für die Standorteauf Benutzerdefiniert fest.
6. Geben Sie nach Land 'USA' ein.
7. Wählen Sie nach dem Verwaltungsgebiet (Ebene 1) State aus.
8. Klicken Sie auf Größe und Form.
9. Wählen Sie unter Form Dreieck aus.

10. Klicken Sie auf Farben.
11. Stellen Sie Colors auf Custom ein, wählen Sie die Option Single color und dann eine Farbe

aus.
12. Klicken Sie auf Optionen.
13. Legen Sie in der Anzeige Ebene die Sichtbaren Drilldown-Ebenen auf Benutzerdefiniert

fest.
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14. Löschen Sie Staat.

15. Klicken Sie auf Bearbeitung erledigt.

Hinzufügen des Filterfensters Resource
Schließlich können Sie noch optional ein Filterfenster mit dem Feld Resource hinzufügen. Auf diese
Weise erhalten Sie eine Liste der verfügbaren historischen Stätten, auf die Sie beim Auswählen in
Ihrer Karte zugreifen können.

Gehen Sie folgendermaßen vor:

1. Ziehen Sie im Extras-Fenster ein Filterfenster in das Arbeitsblatt.
2. Klicken Sie auf Neue Dimension.
3. Fügen Sie ein neues Filterfenster mit dem Feld Resource hinzu.

Creating a map with an image background layer
You can use images as custom base maps in map visualizations. You may want to
display data over a floor plan.

This example map chart displays an office floor plan with a point layer. Each bubble is positioned
over an employee's desk. The weekly average of customer issues handled per day by the employee
determines the size and color of each bubble.

Map example with floor plan image background with a point layer showing employees sized by the number
of customer issues they have resolved

This example hides the default scale. Images do not have a consistent size scale. Image size in a
map background layer is also dependent on what coordinates the user sets for the corners of the
image.
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Dataset
This example uses two tables and a background image. You can import the two tables into your app
using the web file connector.

CustomerIssues

Date EmployeeNumber CustomerIssues

8/1/2019 1 24

8/1/2019 2 31

8/1/2019 3 21

8/1/2019 4 42

8/1/2019 5 24

8/1/2019 6 40

8/1/2019 7 40

8/1/2019 8 19

8/1/2019 9 23

8/1/2019 10 47

8/1/2019 11 38

8/1/2019 12 21

8/1/2019 13 22

8/1/2019 14 15

8/1/2019 15 30

8/1/2019 16 46

8/1/2019 17 41

8/1/2019 18 31

8/1/2019 19 50

8/1/2019 20 27

8/1/2019 21 35

8/1/2019 22 38

8/1/2019 23 37

8/1/2019 24 31

8/1/2019 25 13

8/1/2019 26 11

8/2/2019 1 35

CustomerIssues
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Date EmployeeNumber CustomerIssues

8/2/2019 2 31

8/2/2019 3 33

8/2/2019 4 14

8/2/2019 5 24

8/2/2019 6 33

8/2/2019 7 40

8/2/2019 8 14

8/2/2019 9 44

8/2/2019 10 24

8/2/2019 11 37

8/2/2019 12 39

8/2/2019 13 49

8/2/2019 14 16

8/2/2019 15 42

8/2/2019 16 13

8/2/2019 17 45

8/2/2019 18 48

8/2/2019 19 46

8/2/2019 20 18

8/2/2019 21 18

8/2/2019 22 45

8/2/2019 23 47

8/2/2019 24 31

8/2/2019 25 10

8/2/2019 26 21

8/3/2019 1 16

8/3/2019 2 34

8/3/2019 3 15

8/3/2019 4 44

8/3/2019 5 49

8/3/2019 6 18
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Date EmployeeNumber CustomerIssues

8/3/2019 7 16

8/3/2019 8 41

8/3/2019 9 27

8/3/2019 10 46

8/3/2019 11 21

8/3/2019 12 49

8/3/2019 13 38

8/3/2019 14 30

8/3/2019 15 48

8/3/2019 16 17

8/3/2019 17 42

8/3/2019 18 48

8/3/2019 19 44

8/3/2019 20 44

8/3/2019 21 12

8/3/2019 22 44

8/3/2019 23 17

8/3/2019 24 24

8/3/2019 25 25

8/3/2019 26 33

8/4/2019 1 20

8/4/2019 2 45

8/4/2019 3 32

8/4/2019 4 37

8/4/2019 5 32

8/4/2019 6 50

8/4/2019 7 41

8/4/2019 8 14

8/4/2019 9 37

8/4/2019 10 39

8/4/2019 11 28
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Date EmployeeNumber CustomerIssues

8/4/2019 12 35

8/4/2019 13 24

8/4/2019 14 19

8/4/2019 15 25

8/4/2019 16 26

8/4/2019 17 23

8/4/2019 18 45

8/4/2019 19 48

8/4/2019 20 36

8/4/2019 21 40

8/4/2019 22 21

8/4/2019 23 10

8/4/2019 24 42

8/4/2019 25 35

8/4/2019 26 26

8/5/2019 1 24

8/5/2019 2 28

8/5/2019 3 44

8/5/2019 4 19

8/5/2019 5 34

8/5/2019 6 37

8/5/2019 7 14

8/5/2019 8 26

8/5/2019 9 38

8/5/2019 10 25

8/5/2019 11 41

8/5/2019 12 35

8/5/2019 13 48

8/5/2019 14 36

8/5/2019 15 36

8/5/2019 16 37
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Date EmployeeNumber CustomerIssues

8/5/2019 17 31

8/5/2019 18 44

8/5/2019 19 21

8/5/2019 20 28

8/5/2019 21 13

8/5/2019 22 10

8/5/2019 23 50

8/5/2019 24 35

8/5/2019 25 11

8/5/2019 26 39

8/6/2019 1 26

8/6/2019 2 14

8/6/2019 3 45

8/6/2019 4 27

8/6/2019 5 33

8/6/2019 6 21

8/6/2019 7 14

8/6/2019 8 45

8/6/2019 9 41

8/6/2019 10 35

8/6/2019 11 35

8/6/2019 12 13

8/6/2019 13 35

8/6/2019 14 26

8/6/2019 15 40

8/6/2019 16 14

8/6/2019 17 20

8/6/2019 18 23

8/6/2019 19 11

8/6/2019 20 23

8/6/2019 21 31
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Date EmployeeNumber CustomerIssues

8/6/2019 22 48

8/6/2019 23 39

8/6/2019 24 50

8/6/2019 25 47

8/6/2019 26 40

8/7/2019 1 49

8/7/2019 2 39

8/7/2019 3 16

8/7/2019 4 28

8/7/2019 5 46

8/7/2019 6 37

8/7/2019 7 36

8/7/2019 8 15

8/7/2019 9 18

8/7/2019 10 25

8/7/2019 11 12

8/7/2019 12 37

8/7/2019 13 40

8/7/2019 14 35

8/7/2019 15 11

8/7/2019 16 12

8/7/2019 17 22

8/7/2019 18 16

8/7/2019 19 46

8/7/2019 20 39

8/7/2019 21 41

8/7/2019 22 26

8/7/2019 23 25

8/7/2019 24 34

8/7/2019 25 50

8/7/2019 26 41
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EmployeeData

Employee EmployeeNumber Latitude Longitude

Nehru Pollard 1 2.1 -2.1

Duncan Bell 2 1.675 -2.1

Arthur Miller 3 2.1 -1.6

Latifah Randall 4 1.675 -1.6

Glenna Giles 5 2.1 -1.1

Chaim Gates 6 1.675 -1.1

Elijah Mcgowan 7 2.1 -0.585

Serina Richards 8 1.675 -0.585

Nora Odonnell 9 2.1 0.595

Fiona Craig 10 1.675 0.595

Kirestin Mcguire 11 2.1 1.155

Francesca Wilkerson 12 1.675 1.155

Virginia Sanford 13 2.1 1.6

Beau Weeks 14 1.675 1.6

Justin Cook 15 2.1 2.2

Lisandra Sloan 16 1.675 2.2

Brody Ball 17 2.1 2.6

Kirk Welch 18 1.675 2.6

Julian Mcgee 19 0.7 3.25

Geoffrey Wheeler 20 0.7 3.7

Carter Leonard 21 0.14 3.25

Noel Watson 22 0.14 3.7

Damian Everett 23 -0.3 3.25

Justina Frazier 24 -0.3 3.7

MacKenzie Garcia 25 -0.85 3.25

Germane Carey 26 -0.85 3.7

EmployeeData
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Background image
Example background image

How I built this

Gehen Sie folgendermaßen vor:

1. Add the data sources to your app and associate the tables using the EmployeeNumber fields
in each table.

2. In a sheet, add a map chart.
3. In Map settings, do the following:

l Change Base map to None.
l Change Projection to User defined (degrees).

4. In Appearance > Presentation, do the following:
l Toggle the Scale bar to Off.
l Set Limit zoom levels to Custom and set the zoom to 7x zoom - 8x zoom.

5. Add a background layer to the map chart and in Data, do the following:
l In Format, select Image.
l Set the URL to https://help.qlik.com/en-

US/sense/Subsystems/Hub/Content/Resources/Images/ui_map-image-background-
example.png.

l Set the Top left corner to 2.5 for Top (latitude) and -4.1 for Left (longitude).
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l Set the Bottom right corner to -2.5 for Bottom (latitude) and 4.1 for Right
(longitude).

At this point in the example, the image does not appear yet. After you add a point
layer with the next step, the map updates with the correct scale and image
position.

6. Add a point layer to the map chart and do the following:
l In Data, add Employee as the field.
l In Location, select Latitude and longitude fields. Set Latitude as the Latitude field

and Longitude as the Longitude field.
l In Size & Shape, set Size by Avg(CustomerIssues).
l In Colors, do the following:

l Set Colors to Custom and color By measure.
l Select Avg(CustomerIssues) as the measure.
l Select Diverging classes as the color scheme.

To get the same look and feel as the image at the top of the page, set the app theme to Sense
Classic.

Erstellen einer Karte mit Fokus auf einer Region
Sie können Ihre Kartendiagramme so konfigurieren, dass sie auf eine bestimmte Region
fokussiert bleiben, beispielsweise auf ein Land. Sie können auch die maximale und die
minimale Vergrößerungsstufe der Karte festlegen. Damit wird gesteuert, wie stark Qlik
Sense die Karte vergrößert, wenn Sie Auswahlen vornehmen.

Im folgenden Beispiel wird erläutert, wie Sie eine Karte mit einer einzelnen, fest fokussierten Region
und einer benutzerdefinierten maximalen Vergrößerungsstufe konfigurieren.
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Kartendiagramm mit Schwenkung, die auf die gewünschte Region beschränkt ist

Für diese Karte ist eine Schwenkbegrenzung festgelegt, damit die Benutzer den Fokus der
Kartenvisualisierung nicht von der gewünschten Region wegbewegen können. Benutzer können
einen Drilldown zwischen einzelnen Kartenebenen durchführen, aber nicht außerhalb der
anfänglichen Ansicht scrollen.

Diese Kartenvisualisierung verwendet eine Punktebene und eine Gebietsebene mit zwei Drilldown-
Dimensionen. Mit der einen Drilldown-Dimension können auf Gebietsebene Countys angezeigt
werden, sobald Bundesstaaten ausgewählt wurden. Mit der anderen Drilldown-Dimension können
Orte auf der Punktebene als Punkte angezeigt werden, sobald auf der Gebietsebene ein
Bundesstaat ausgewählt wurde.

Ein Zoomlimit wird auf das Kartendiagramm angewendet. Wenn in der Gebietsebene einen
Bundesstaat ausgewählt wurde, wird auf der Karte ein Drilldown ausgeführt, um die Countys auf
der Gebietsebene und die Orte auf einer getrennten Punktebene anzuzeigen. Die Karte behält eine
Vergrößerungsstufe bei, die für einen allgemeinen Überblick über die Region geeignet ist.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 307



3   Visualizations

Kartendiagramm mit angewendeter Bundesstaatenauswahl

Datensatz
In diesem Beispiel werden zwei Datensätze verwendet. Sie müssen diese Daten in Qlik Sense
importieren. Sie können die Daten zu einem Arbeitsblatt hinzufügen und sie in Qlik Sense
importieren. Sie können auch die Tabelle aus dieser Hilfeseite als Webdatei importieren.

City data

City
City
Code

County State Latitude Longitude

New York 1 New York County USA 40.730599 -73.986581

Los Angeles 2 Los Angeles County CA 34.053678 -118.242702

Chicago 3 Cook County IL 41.875555 -87.624421

Philadelphia 5 Philadelphia County PA 39.952335 -75.163789

Phoenix 6 Maricopa County AZ 33.446768 -112.075672

San Antonio 7 Bexar County TX 29.4246 -98.49514

San Diego 8 San Diego County CA 32.717421 -117.162771

Dallas 9 Dallas County TX 32.776196 -96.796899

San Jose 10 Santa Clara County CA 37.34385 -121.883135

Austin 11 Travis County TX 30.271129 -97.7437

Indianapolis 12 Marion County IN 39.76838 -86.158045

Jacksonville 13 Duval County FL 30.332184 -81.655651

Beispieldaten für Ort
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City
City
Code

County State Latitude Longitude

Columbus 15 Franklin County OH 39.96226 -83.000706

Charlotte 16 Mecklenburg County NC 35.227087 -80.843127

Detroit 17 Wayne County MI 42.348664 -83.056738

Memphis 18 Shelby County TN 35.149022 -90.051628

Seattle 19 King County WA 47.603832 -122.330062

Denver 20 Denver County CO 39.739154 -104.984703

Boston 22 Suffolk County MA 42.360482 -71.059568

Nashville 23 Davidson County TN 36.162226 -86.774342

Baltimore 24 Baltimore City
County

MD 39.290861 -76.610807

Portland 25 Multnomah County OR 45.520247 -122.674195

Las Vegas 26 Clark County NV 36.166286 -115.149225

Milwaukee 27 Milwaukee County WI 43.034993 -87.922497

Albuquerque 28 Bernalillo County NM 35.084103 -106.650985

Tucson 29 Pima County AZ 32.221742 -110.926476

Fresno 30 Fresno County CA 36.73082 -119.699202

Sacramento 31 Sacramento County CA 38.581572 -121.4944

Kansas City 32 Jackson County MO 39.084469 -94.56303

Colorado
Springs

33 El Paso County CO 38.833958 -104.825348

Atlanta 34 Fulton County GA 33.749099 -84.390185

Omaha 35 Douglas County NE 41.258732 -95.937873

Raleigh 36 Wake County NC 35.780402 -78.639078

Miami 37 Miami-Dade County FL 25.774266 -80.193659

Minneapolis 38 Hennepin County MN 44.9773 -93.265469

Tulsa 39 Tulsa County OK 36.152436 -95.990409

Cleveland 40 Cuyahoga County OH 41.505161 -81.693445

New Orleans 41 Orleans Parish LA 29.949932 -90.070116
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Customer

Customer Customer Number City Code

A Superior System 10000453 1

Beech Aircraft Corporation 10003882 1

Deere and Company 10009863 1

Gailey Enterprises 10012851 1

J.A. Bauer Pottery Company 10017852 1

Old Towne Creations 10020715 1

Real World 10022755 1

ValueClick 10025878 1

A&G 10000457 2

Bell Canada Enterprises 10004207 2

Échange CAC Exchange 10010832 2

Gainunion 10012885 2

J.M. Haggar 10018129 2

OnDeck Systems 10020849 2

Reflex Presentations 10022962 2

Wasabi 10026294 2

Aadast 10000471 3

Bendix Corporation 10004255 3

ECI com 10010855 3

Galaxy Marketing Associates 10012907 3

Johnson and Higgins 10018352 3

One Planet Solutions 10020864 3

Relcom 10022978 3

Wayne'sWorld 10026334 3

ABI TruTrac 10000488 5

Best Way! Imaging 10004602 5

Ed Stefanov 10010881 5

Gamacles 10013011 5

Joy Line 10018371 5

Beispieldaten für Kunde
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Customer Customer Number City Code

Onebox 10020907 5

SageGroup 10023511 5

VEI 10026023 5

AboveNet 10000496 6

Bezeq 10005043 6

EDA Today 10010882 6

Gamma One Conversions 10013039 6

K 10018518 6

Keystroke Quality 10019420 6

Outsource Documents 10020982 6

PAGE 10021240 6

Sarcom 10023703 6

Systems of Missouri 10024915 6

Velos Medical Informatics 10026038 6

Abplus 10000497 7

BF Datacom 10005099 7

Edmark 10010923 7

GammaGraphX (GGX) 10013052 7

K&K Enterprises 10018603 7

Overdreams 10021006 7

SAS Institute 10023757 7

Ventana s Group 10026081 7

ABSolute 10000499 8

BH Feldman Consulting 10005236 8

Elbit Oy 10010990 8

Gammel Group 10013061 8

Karickal Exports 10018868 8

Owl's Eye Productions 10021015 8

SAT-SAGEM (usa) 10023780 8

White Oak Interactive 10026365 8
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Customer Customer Number City Code

Absolute Magic 10000501 9

Bibb Manufacturing Company 10005376 9

Eloi Companies 10011018 9

Gandalf Systems 10013079 9

KAT Micro Distributing 10018877 9

P.C'S 10021111 9

Science Applications International (SAIC) 10023964 9

Xcert 10026521 9

Abstract 10000502 10

BidCast 10005620 10

Elucidex 10011052 10

Ganymede 10013080 10

Kendrick Jansen 10018950 10

P.C.G. Associates 10021107 10

Screen Digest 10024016 10

Xyratex 10026868 10

AC Exchange 10001103 11

Bien Logic 10005688 11

Embedded Support Tools (EST) 10011089 11

Garbee and Garbee 10013127 11

Kennecott Copper Corporation 10018957 11

Pacific Bell 10021160 11

Smith Manufacturing Company 10024477 11

Yurie Systems 10027119 11

AC&E 10001263 12

Acara 10001786 12

Big 10005810 12

Big Picture Technologies 10005919 12

EMC 10011093 12

Garlin Imports 10013137 12
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Customer Customer Number City Code

KENROB and Associates 10019066 12

Packet Design 10021232 12

Sterling Armament Company 10024704 12

Zero G 10027370 12

Acacia 10001784 13

Big Mountain Multi 10005861 13

Emergency 10011286 13

Gate9th 10013312 13

Kerite Company 10019194 13

PADL 10021239 13

Sun Microsystems 10024880 13

Acc Tonec 10001818 15

Big Planet 10005922 15

Enterprises 10011355 15

Gatierf Publications 10013341 15

kGS 10019469 15

Page Marketing 10021242 15

T & S 10024916 15

Accel Partners 10002114 16

Biz-comm 10006836 16

Equitable Life Assurance Society 10011360 16

GCC Technologies 10013376 16

KillerGraffix 10019502 16

Page Research 10021270 16

T.F.C. 10024918 16

Accent Interactive 10002115 17

Boott Cotton Mills Corporation 10006916 17

Farmland Industries 10011499 17

GDC 10013426 17

Kim Tom Co 10019512 17
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Customer Customer Number City Code

PageBoy 10021283 17

T.J.T. International 10024919 17

Accent Systems 10002117 18

Borden Company 10006917 18

Farrell Lines Company 10011546 18

GEAR 10013538 18

Kimball (W.W.) Company 10019514 18

PagePoint 10021286 18

T.M. Denton Consultants 10024924 18

Access Point 10002128 19

Accidental 10002137 19

Boston and Albany Railroad Company 10006919 19

Bre-X 10007117 19

FCS 10011600 19

Federated Co-Operatives Limited 10011732 19

GearSource 10013572 19

Gehlken Enterprises 10013670 19

Levi Strauss and Company 10019783 19

Lobster Productions 10019952 19

PageSites 10021297 19

PageWeavers 10021302 19

T3West 10024930 19

Tag Systems 10024942 19

AccessWare 10002136 20

Brazilian Traction, Light and Power Company 10006977 20

Federal Express Corporation 10011623 20

Gebbie Press 10013574 20

Lewis Grocer Company 10019812 20

PageWave 10021300 20

Tadpole 10024940 20
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Customer Customer Number City Code

ACCPAC International 10002138 22

Brentano's 10006983 22

FenP Innovators 10011821 22

Greymac Trust Company 10013870 22

Lucky 10020080 22

Pallister Management 10021305 22

Take 3 10025022 22

Accrue 10002139 23

C&C 10007134 23

Fentek Industries 10011842 23

Grove Farm Co., Inc. 10013871 23

Market 10020181 23

Palo Alto 10021331 23

Talarian 10025024 23

Accton 10002140 24

C. Hoelzle Associates 10007163 24

Fenwick & West 10011870 24

Grumman Corporation 10013899 24

Maui Island(MIC) 10020193 24

Panasonic 10021350 24

Target 10025052 24

AccuCom 10002142 25

C.O.F. 10007183 25

Ferrari 10011918 25

Guarantee Mutual Life Company 10014043 25

MaxBan 10020227 25

Pangaea Systems 10021380 25

Taroch 10025063 25

ACCUCOMP 10002144 26

C3 Development 10007253 26
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Customer Customer Number City Code

FiberPlex 10011979 26

GURUs 10014059 26

MaXpeed 10020239 26

Panix 10021411 26

Tartanchase 10025086 26

AccuLAN 10002149 27

C3I 10007258 27

FICOM 10012023 27

H.H. Robertson Company 10014064 27

MAXSTRAT 10020247 27

Paraclipse 10021494 27

Taskers of Andover, Ltd. 10025158 27

Accumedic Systems 10002150 28

Cabco West 10007268 28

Fifth Generation 10012128 28

HarborGroup 10014238 28

Maxtor 10020256 28

Parian Development Group 10021575 28

Tatters 10025213 28

Ace Equipment 10002153 29

Cadtex 10007309 29

Fifth Moon 10012157 29

HarveyOpolis 10014540 29

Maxwell Laboratories 10020266 29

Password Busters 10021641 29

Teamaker 10025239 29

Acer 10002154 30

Cajun 10007448 30

Filene’s 10012158 30

HBS 10014802 30
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Customer Customer Number City Code

Mb digital marketing 10020281 30

Patrick Townsend & Associates 10021677 30

Teammax 10025241 30

ACES Research 10002155 31

CalComp 10007457 31

Filetron 10012161 31

Hederman Brothers 10015011 31

McGraw-Hill Publishing Company 10020306 31

Patton Enterprises 10021736 31

Teamsolve 10025242 31

ACI 10002159 32

Caleidoscopio S.r.l. 10007468 32

Emergent 10011345 32

FIND/SVP 10012305 32

GateMaster 10013332 32

Hekimian Laboratories 10015253 32

Mead Corporation 10020323 32

Paul Budde 10021750 32

Todd Shipyards Corporation 10025267 32

ACME Laboratories 10002161 33

Calypso 10007536 33

Finder 10012328 33

Helfand Enterprises 10015267 33

Medics 10020332 33

PayMaxx 10021794 33

Transylvania Company 10025288 33

Acsior 10002412 34

Camelot IT 10007591 34

Finest Host 10012369 34

Helius 10015325 34
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Customer Customer Number City Code

Melville Shoe Corporation 10020340 34

Payton Group International 10021800 34

UBF 10025304 34

Action Systems 10002501 35

Camros 10007866 35

Finisar 10012399 35

Hercules Incorporated 10015686 35

Mersey Docks 10020364 35

Pick Professionals 10021802 35

UK Total.net 10025353 35

ActivCard 10002520 36

Champion International 10009606 36

Firehole 10012514 36

hesketh.com 10015789 36

Nancy Leffingwell Enterprises 10020449 36

Picka 10021804 36

UKnames.net 10025359 36

Active 10002526 37

Dan River Mills, Inc. 10009633 37

FireTrans 10012600 37

Hewlett Packard 10015886 37

Nbase 10020491 37

PLAINFIELD ROOFING AND SHEET METAL 10026438 37

Ultimate Group 10025392 37

Aberdeen 10000486 38

Ad-vantage 10003687 38

Besicorp 10004516 38

Data General Corporation 10009639 38

ECS Associates 10010865 38

Galaxy Systems 10012927 38
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Customer Customer Number City Code

G-Com International 10013397 38

Hidden Oak 10015956 38

Jones and Laughlin Steel Corporation 10018363 38

NBTel 10020492 38

One World 10020868 38

QualityLogic 10022166 38

Safe 10023495 38

Ultra-Image 10025418 38

Vectrix 10026009 38

Ad Agency 10003554 39

Day and Zimmermann, Inc. 10009645 39

G.R. Barron 10012761 39

Hill and Knowlton, Inc. 10016113 39

NBX 10020515 39

Quallaby 10022167 39

Underwriters Laboratories 10025467 39

Associates 10003749 40

Dayton Rubber Company 10009650 40

Gadzoox Microsystems 10012792 40

iBEAM 10016780 40

Nematron 10020662 40

Quantum 10022201 40

Universal Access 10025608 40

Beckman Instruments, Inc. 10003857 41

De Postel 10009669 41

Gaecom 10012799 41

Id 10017290 41

Oki 10020672 41

Rdlabs 10022746 41

Userland 10025737 41
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Erstellvorgang

Gehen Sie folgendermaßen vor:

1. Importieren Sie die Daten in den Datenmanager.
2. Nehmen Sie die empfohlenen Verknüpfungen zwischen den beiden Tabellen im

Datenmanager vor.
3. Erstellen Sie zwei Drilldown-Dimensionen, eine für State (Bundesstaat) und County

(Landkreis) und eine für State und City (Ort).
4. Fügen Sie eine Karte hinzu und legen Sie in Präsentation ein benutzerdefiniertes Zoomlimit

mit einer maximal 7-fachen Vergrößerung fest.
5. Fügen Sie eine Punktebene mit State-City als Dimension hinzu. Legen Sie die folgenden

Eigenschaften fest:
l Legen Sie unter Standort den Bereich auf Benutzerdefiniert fest und geben Sie 'USA'

in Land ein.
l Legen Sie in Größe und Form die Option Dimensionieren nach auf Count(Distinct

(Customer)) fest.
l Legen Sie in Farben die Farbe nach Kennzahl fest, indem Sie Count(Distinct

(Customer)) verwenden.
l Legen Sie unter Optionen>Ebenenanzeige die Option Sichtbare Drilldown-Ebenen

auf Benutzerdefiniert fest und wählen Sie Ort aus.
6. Fügen Sie eine Gebietsebene mit State-County als Dimension hinzu. Legen Sie die folgenden

Eigenschaften fest:
l Legen Sie unter Standort den Bereich auf Benutzerdefiniert fest und geben Sie 'USA'

als Land und Bundestaat in Verwaltungsgebiet (Ebene 1) ein.
l Legen Sie unter Farben die Farbe nach Kennzahl fest, indem Sie Count(Distinct

(Customer)) verwenden, und legen Sie den Schieberegler für Opazität auf 40 % fest.
7. Zentrieren Sie die Region auf der Karte und legen Sie dann Schwenknavigation begrenzen

auf Benutzerdefiniert fest und klicken Sie auf Schwenkgrenzwert festlegen.

Mekko chart
The mekko chart is suitable for comparing groups, while being able to compare
category items contained within these groups. Mekko charts are also known as mosaic
plots, Marimekko charts, and Mondrian diagrams. The dimension axis shows the
groups, while the measure axis shows the normalized percentage value for each
category item. The size of each group shows its value.

In this image, the dimensional groups represent different yearly quarters. The width of each quarter
shows the normalized percentage value of the sum of sales, for that quarter. Each quarter is divided
in several product categories, such as Produce, Canned Products, and Frozen Foods. The height of
each product category corresponds to the normalized percentage value of the sum of sales of that
product category, within that quarter. This allows you to easily compare between product
categories inside a specific quarter, and between different quarters.
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Sorting is automatic according to size. By default, the coloring is by dimension, with 12 colors, but
that can be changed in the properties panel. You can decide which dimension to color by. In this
example, the coloring is by product category to clearly distinguish the different categories and how
their contribution to the sales change in each quarter.

If the data set contains negative values, a text message is shown stating that the negative values
cannot be displayed.
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When to use it
Use a mekko chart when you need to visualize normalized percentage values of grouped data.
Mekko charts should primarily be used with values that can be aggregated.

Advantages
The mekko chart is easy to read and understand. You get a good comparison between groups, and
a comparison of the impact of categories within each group.

Disadvantages
The mekko chart does not work so well with many dimension values due to the limitation of the axis
length.

Mekko charts are not good when there is a big difference in the magnitude of the measure values.
Nor is a mekko chart the right choice when mixing absolute and relative values.

Negative values cannot be displayed in mekko charts.

Creating a mekko chart
You can create a simple mekko chart on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty mekko chart to the sheet.
2. Klicken Sie auf Dimension hinzufügen und wählen Sie eine Dimension oder ein Feld aus. This

dimension defines the grouping.
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3. Add a second dimension in the order of hierarchy level. The second dimension you add
defines the categories.

4. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine
Kennzahl aus einem Feld.

In a mekko chart you need two dimensions and one measure.

Each bar corresponds to the first dimension, divided into smaller categories based on the second
dimension. The values of the measures determine the relevant height of the categories inside each
bar, as well as the size of the bars.

When you have created the chart, you might want to adjust its appearance in the properties panel.

Styling the mekko chart
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote
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4. Legen Sie auf der Registerkarte Diagramm die Schriftart, die Schriftgröße und die Farbe der
folgenden Textelemente fest:

l Achsenbeschriftung: Legen Sie das Design der Beschriftungen auf den Achsen fest.
l Value label: Style the labels for the dimension and measure values, including the

percentage contributed by each value towards the total of the grouping above it in the
hierarchy.

l Legendentitel: Legen Sie das Design des Legendentitels fest.
l Legendenbezeichnungen: Legen Sie das Design der Bezeichnungen für die einzelnen

Legendenelemente fest.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
Wenn Einfärbung nach Dimension in diesem Diagramm verwendet wird, können maximal 100
eindeutige Dimensionswerte und 100 eindeutige Farben auf der Legende aufgetragen werden.
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Vergleichen von Gruppen und Gruppenkategorien mit einer Kennzahl mit
einem mekko-Diagramm
Dieses Beispiel zeigt, wie ein mekko-Diagramm erstellt wird, um den Umsatz
verschiedener Jahre zu vergleichen und zu sehen, welchen Einfluss bestimmte
Produktgruppen auf den Umsatz eines Jahres haben und wie diese Werte im Vergleich
zu anderen Jahren aussehen.

Datensatz
In diesem Beispiel werden zwei Datendateien verwendet, die in Qlik Sense Tutorial - Aufbau einer
App verfügbar sind. Laden Sie das Tutorial herunter und blenden Sie die enthaltenen Ordner ein.
Die Dateien sind im Ordner Tutorials source verfügbar:

l Sales.xls
l Item master.xls

Um die Dateien herunterzuladen, gehen Sie zu Tutorial - Aufbau einer App.

Fügen Sie die beiden Datendateien einer leeren App hinzu und vergewissern Sie sich, dass sie
anhand der Artikelnummer (Item Number) miteinander verknüpft sind.

Der Datensatz, der geladen wird, enthält Umsatzdaten. Die Tabelle in der Datei Item master.xls
enthält die Informationen über die bestellten Artikel, beispielsweise Produktgruppen.

Kennzahl
Wir verwenden das Umsatzvolumen als Kennzahl, indem eine Kennzahl in den Master-Elementen
mit dem Namen Sales und der Formel Sum(Sales) erstellt wird.
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Visualisierung
Wir fügen dem Arbeitsblatt ein mekko-Diagramm hinzu und legen die folgenden
Dateneigenschaften fest:

l Dimension: Date.autoCalendar.Quarter (Jahr).
l Dimension: Product Group (Produktgruppe)
l Kennzahl: Sales; Kennzahl, die als Master-Element erstellt wurde.

Das folgende mekko-Diagramm wird erstellt:

Die Größe der einzelnen Spalten stellt das Umsatzvolumen für jedes Jahr dar. Die Größe der
verschiedenen Abschnitte innerhalb einer Spalte stellen das Umsatzvolumen jeder spezifischen
Produktgruppe während dieses Jahres dar.

Sie sehen, dass die Summe aller drei jährlichen Prozentsätze 100 % ergibt. Das Gleiche gilt für die
Prozentsätze des Produktgruppenabschnitts für jedes Jahr. Das liegt daran, dass die Prozentsätze
normalisiert sind, sodass die Größe jedes Abschnitts für den Gesamtbetrag relevant ist.

Wir möchten einen besseren Überblick darüber erhalten, wie sich der Umsatz jeder Produktgruppe
von einem Jahr zum nächsten ändert. Das ist für Produktgruppen wie Baking Goods, Dairy oder
Beverages, die in den einzelnen Spalten nicht nebeneinander liegen, nicht auf Anhieb ersichtlich.
Wir möchten eine andere Sortierung anzeigen, die auf den Produktgruppen basiert.

Dies kann im Eigenschaftsfenster unter Sortieren geändert werden.

Legen Sie die Sortierreihenfolge wie folgt fest:

1. Date.Year
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2. Product Group

3. Sum(Sales)

Das Diagramm sieht folgendermaßen aus:

Entdecken
Das mekko-Diagramm zeigt den normalisierten Umsatzprozentsatz pro Jahr für verschiedene
Produktgruppen sowie den normalisierten Prozentsatzes des Umsatzes für jedes Jahr. Die
Visualisierung ist in der Reihenfolge der Produktgruppen pro Jahr sortiert. Sie können den
Mauszeiger über eine Produktgruppe bewegen und die Details anzeigen.

Im mekko-Diagramm sehen Sie, dass Produce das höchste Umsatzvolumen während der drei Jahre
aufweist.

Navigation menu
The navigation menu adds sheet navigation options into your sheet.

Users can navigate between sheets from the assets panel. You can also add a sheet navigation
menu to allow users to navigate directly in the sheets, without needing to open the assets panel.

By default, the navigation menu displays all public sheets and groups in an app.
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Navigation menu

You can choose to have the navigation menu open a drawer menu over the app. When this is
selected, the navigation menu become an icon ( ).

Drawer navigation menu

The navigation menu can only be added in advanced edit mode.
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When to use it
The navigation menu is useful when you want to provide an alternative method of navigating sheets
in an app.

Creating navigation menus
You can format and color the text in the menu. The background image has sizing and positioning
options.

Gehen Sie folgendermaßen vor:

l From the assets panel, drag a navigation menu on to the sheet.

Styling the navigation menu
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Customizing the text
You can set the text for the title, subtitle, and footnote under Appearance > General. To hide these
elements, turn off Show titles.

The visibility of the different labels on the chart depends on chart-specific settings and label
display options. These can be configured in the properties panel.

You can style the text that appears in the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote
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4. On the Menu tab, set the font, font size, and color for the following text elements:
l Labels: Style the labels of the individual items.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

4. On the Menu tab of the styling panel, select a default color for the menu items, a highlight
color, and a hover color.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.
7. On the Menu tab, under Border, adjust the Outline size to increase or decrease the border

lines around the chart.
8. Select a color for the border.
9. Adjust the Corner radius to control the roundness of the border.

10. Under Shadow in the Menu tab, select a shadow size and color. Select None to remove the
shadow.

Setting navigation menus as drawer menus
You can make your navigation menu a drawer menu. When set as a drawer menu, the navigation
menu acts as a button that opens a menu over the whole app listing sheets. You can optionally add
a menu icon ( ) to the navigation menu.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.
2. Under Appearance > Presentation, turn on Drawer menu.
3. Optionally select Show drawer icon.

Styling drawer menus
You can style your drawer button and panel.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Click Menu.
4. Under Drawer button, optionally customize the colors and add a background image.
5. Under Drawer panel, optionally customer the color and background image used by the

panel.

Setting orientation and layout

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.
2. Under Appearance > Presentation, under Orientation, select Vertical or Horizontal.
3. Under Layout, select Fill or Minimal.
4. Under Position, select the position of the menu items in the navigation menu.
5. If you selected Horizontal or Minimal, optionally select Same item width to make all tabs

have the same size.

Separating items in navigation menus

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.
2. Under Appearance > Presentation, turn on Separate items.

Showing large items

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.
2. Under Appearance > Presentation, select Show large items.
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Showing item icons

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.
2. Under Appearance > Presentation, select Show item icons.

NL insights
The NL insights visualization displays natural language insights and information about
selected dimensions and measures.

NL insights uses Insight Advisor to generate natural language information about the dimensions
and measure added to the chart. The chart updates the insights as selections are made in the app.

Native NL insights object displaying natural language insights with full verbosity

NL insights is a native chart type replacing the deprecated NL Insights control from the Dashboard
bundle.

By default, NL insights generates insights for all analysis types supported for the selected fields.
The classification of fields in your app logical model determines which fields are available as
dimensions or measures.

When to use it
Use NL insights when you want to include a narrative or analytical summary of your data. For
example, on a sheet focused on sales, you might want narratives summarizing key ranking,
correlation, and comparison analyses for sales to complement your other visualizations.

It is also helpful to pair NL insights with another chart containing the same dimensions and
measures. This provides additional context and information for the chart. To do this, configure the
NL insights object to use an input chart that has already been created on the current sheet. The
dimensions and measures from that input chart are used to generate the natural language insights,
and the NL insights will update based on changes you make in the input chart.
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NL insights with natural language insights generated directly from input bar chart

Migrating from the Dashboard bundle to native object
NL Insights extension objects from the Dashboard bundle must be migrated to native charts if they
appear on a public (base) sheet or published (community) sheet. To do this, follow the applicable
steps to make the sheet private, then publish and/or make it public again.

An alternative to the following instructions is to duplicate the app in the stream, open the
sheet in the duplicated app to ensure proper chart migration, and then re-publish the
app to the stream.

Public sheets

Gehen Sie folgendermaßen vor:

1. Open the app overview, or open Sheets from sheet view.

2. Right-click the public sheet and select Unapprove.
3. Right-click the community sheet and select Unpublish.
4. Open the private sheet and ensure the chart has been migrated.
5. Right-click the sheet and then select Publish.
6. Right-click the community sheet and select Approve.
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Published sheets

Gehen Sie folgendermaßen vor:

1. Open the app overview, or open Sheets from sheet view.

2. Right-click the community sheet and select Unpublish.
3. Open the private sheet and ensure the chart has been migrated.
4. Right-click the sheet and then select Publish.
5. Right-click the community sheet and select Approve.

Creating NL insights
You need at least one dimension or one measure to create the chart. Combine dimensions and
measures as needed. If you use an existing chart to generate the content of your NL Insights, the
dimensions and measures from that input chart are used and will be dynamically updated if you
change the input chart.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty NL insights chart to the sheet.
2. Click Add chart to use natural language insights from an existing chart in the NL insights

visualization. Choose from any of the supported charts in the current sheet.
Alternatively, click Add dimension or Add measure to add natural language insights from a
dimension or measure into the chart.

3. In the properties panel, add or remove dimensions and measures from the chart.

You cannot add or remove dimensions and measures if you have chosen to use
insights from an existing chart.

When you have created the NL insights visualization, you might want to adjust its appearance and
other settings in the properties panel.

Styling NL insights
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).
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Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, style the following text elements:
l Analysis type: Set the font, font size, and color of the headers displaying the analysis

types of the insights.
l Style: Set the font, font size, and color of the narrative insights.
l Structure: Set how the narrative insights in the chart should be presented. Choose

bullet points or sentences.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Adjusting the verbosity
You can control the verbosity of the natural language insights. Verbosity can be full or brief. Full
verbosity groups natural language insights by analysis type. Brief verbosity displays all natural
language insights as a list.

Verbosity can be configured under Appearance > Presentation in the properties panel.

Removing analysis types
You can remove unwanted analysis types from NL Insights under Appearance > Presentation in
the properties panel.

Changing the language of the natural language insights
You can change the language of the generated natural language insights under
Appearance > Presentation in the properties panel.

NL insights has the same language supports as natural language insights in Qlik Sense
within Qlik Cloud Analytics. For information, see Supported languages.

Considerations
The analysis types and number of narrative insights generated in the NL insights chart depend on
the volume and variety of data that belongs to the fields selected. A limited number of analysis
types and insights might be displayed in the following scenarios:

l The selected items use the same underlying field with aggregations or selections.
l The selected items include only measures and no dimensions.
l The selected items are mostly unrelated.

Limitations
The NL insights object has the following the limitations:
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l You cannot use the following chart types for direct input into the NL insights chart:
l Animator
l Button
l Container
l Date picker
l Filter pane
l Text & image
l Video player

l The NL insights chart does not provide natural language insights for the following analysis
types (even if it uses an input chart generated from these analysis types):

l Clustering (k-means)
l Overview
l Period changes
l Process control (rolling mean)
l Year to date

l Expressions with modifiers, either applied directly to the chart or via an input chart, might not
provide correct values in natural language insights.

l The number format accompanying an expression is only applied to narrative statements
generated using that expression. Additional narratives that are generated might not adhere
to the expression's number format.

l When using an existing chart as the input for an NL insights object, certain actions taken on
the input chart will not result in the natural language insights being updated automatically.
Specifically, switching to alternative measures or dimensions, or customizations made
through chart exploration in analysis mode, do not update natural language insights unless
those changes are applied and made available for all users.

l Changing the number format of a measure might not always result in this formatting being
changed in all available insights.

Pie chart
The pie chart displays the relation between values as well as the relation of a single
value to the total. You can use a pie chart when you have a single data series with only
positive values.

In the pie chart, the dimensions form sectors of the measure values. A pie chart can have one
dimension and up to two measures. The first measure is used to determine the angle of each slice in
the chart.
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Sales per region in a pie chart.

Optionally, a second measure can be used to determine the radius of each pie slice. This style of pie
chart is also known as a rose chart.
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Sales by product sub group in a pie chart with the average sales per invoice sales determining slice radius

In the pie presentation of the pie chart, negative values in the radius measure are not supported and
will be excluded. Negative values in the radius measure are supported in the donut presentation
and will point in towards the center of the pie chart.
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Sales by product sub group in a pie chart with radius measure containing a comparison of sales from the
previous year

When to use it
The primary use of a pie chart is to compare a certain sector to the total. The pie chart is particularly
useful when there are only two sectors, for example yes/no or queued/finished.

We do not recommend that you compare the results of two pie charts with each other.

Advantages
The pie chart provides an instant understanding of proportions when few sectors are used as
dimensions. When you use 10 sectors, or less, the pie chart keeps its visual efficiency.

Disadvantages
It may be difficult to compare different sectors of a pie chart, especially a chart with many sectors.
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The pie chart takes up a lot of space in relation to the values it visualizes.

Creating a pie chart
You can create a pie chart on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty pie chart to the sheet.
2. Klicken Sie auf Dimension hinzufügen und wählen Sie eine Dimension oder ein Feld aus.
3. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine

Kennzahl aus einem Feld.

The following settings are used by default in a pie chart:

l The top 10 sectors are presented in descending size order, clockwise.
l Colors are presented by dimension.
l Value labels are presented in percent.

After you have created the pie chart, you may want to add a radius measure or adjust its
appearance and other settings in the properties panel.

Styling the pie chart
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. Legen Sie auf der Registerkarte Diagramm die Schriftart, die Schriftgröße und die Farbe der
folgenden Textelemente fest:

l Dimension label: Style the label for the dimension shown in the chart.
l Dimension value label: Style the individual dimension values.
l Value label: Style the labels which display the measure value (displayed as a value or

relative percentage) for each dimension value.
l Legendentitel: Legen Sie das Design des Legendentitels fest.
l Legendenbezeichnungen: Legen Sie das Design der Bezeichnungen für die einzelnen

Legendenelemente fest.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the outline and shape
You can customize the outline surrounding the chart, as well as the shape and thickness of the
slices.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Chart tab of the styling panel, under Outline, set the thickness and color of the
outlines of the slices.

4. Under Corner radius, set the roundness of the corners of the slices.
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Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
Wenn Einfärbung nach Dimension in diesem Diagramm verwendet wird, können maximal 100
eindeutige Dimensionswerte und 100 eindeutige Farben auf der Legende aufgetragen werden.

Pivot table
The pivot table presents dimensions and measures as rows and columns in a table. In a
pivot table you can analyze data by multiple measures and in multiple dimensions at
the same time.

You can rearrange measures and dimensions by pivoting rows and columns.
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When to use it
The pivot table is useful when you want to include several dimensions or measures in a single table,
and then want to reorganize them to see different subtotals.

Advantages
The pivot table is very powerful when you want to analyze multiple dimensions and measures at
once, and then reorganize them to get a different perspective on your data. You can expand the
rows you are interested in while keeping the rows in the rest of the table collapsed.

Disadvantages
The pivot table may seem a bit complicated, and does not give insights at a glance.

Creating a pivot table
You can create a new pivot table on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty pivot table to the sheet.
2. Klicken Sie auf Dimension hinzufügen und wählen Sie eine Dimension oder ein Feld aus.
3. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine

Kennzahl aus einem Feld.

You can adjust appearance and other settings in the properties panel.

Column width is automatically set to keep columns together for improved readability.
You can adjust the width of the dimension column by dragging the header divider. The
width of individual measure columns will still be automatically set. Double-click the
header divider to reset to automatic column width.

Styling the pivot table
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).
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Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font size and color for the following text elements:
l Header: Style the text of the headers for each column to the right of the first column.
l Content: Style the text of the first column, as well as each cell in the table itself.

Additionally, you can customize how the text appears when a user hovers over a row. See
Customizing the hover behavior and scrollbar (page 345).

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

If a cell in the pivot table has a null value, it is colored separately from the background settings
applied in the styling panel (it appears in a white color).

Customizing the hover behavior and scrollbar
Sie können Anzeigeoptionen festlegen, wenn ein Benutzer den Mauszeiger über eine Zeile in der
Tabelle bewegt. Sie können auch die Größe der Scrollleiste festlegen.
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Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Passen Sie auf der Registerkarte Diagramm des Designfensters unter Beim Draufzeigen die
folgenden Einstellungen an:

l Um Zeile in der Tabelle hervorzuheben, wenn ein Benutzer mit dem Mauszeiger
daraufzeigt, legen Sie den Schalter auf Ein um. Deaktivieren Sie das Verhalten je nach
Belieben.

l Farbe beim Daraufzeigen: Legen Sie die Farbe fest, mit der die Zeile hervorgehoben
wird, wenn ein Benutzer den Mauszeiger darüberbewegt.

l Schriftfarbe beim Daraufzeigen: Legen Sie die Farbe des Texts in der
hervorgehobenen Zeile fest, wenn ein Benutzer den Mauszeiger darüberbewegt.

4. Legen Sie unter Größe der Scroll-Leiste die Größe der Scroll-Leiste im Diagramm fest (Sie
können Klein, Mittel oder Groß auswählen).

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Pivoting your data in the table
When you want to rearrange your data, drag the items to a new column or row.

In the following pivot table, the dimension Customer has been dragged to the position after Product
Group. The dimension Item Desc has been moved to the position before Product Group. As a
consequence, the dimensions are now sorted by Item, primarily. Focus has shifted from Customer
to Item Desc. You can find out the quantities and sales for each customer by clicking . This will
expand a dimension.
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By moving the dimension Customer from rows to columns, you retain focus on the dimension Item
Desc, but you also get the distribution of items per customer. The move has made the pivot table
more information dense.

Measure grouping
As you may have noticed, Quantity and Sales are not presented as separate measures in the top
column row. Next to the dimension Customer, you find an item called Values. When you use more
than one measure, they are automatically grouped together forming a measure group, Values. This
group can be added to the rows section or the columns section. The measure group cannot be
edited or selected in the table. You cannot split up the measure item and use one measure as a row
and another as a column.

Pivoting your data in the properties panel
In the properties panel, you can add measures and dimensions to the pivot table, and also pivot
rows or columns.

Data
In the data pane, you can add dimensions and measures. You can move items between rows and
columns. You can also change item order inside rows or columns. When you use more than one
measure, they are grouped and a Values item is created.
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Sorting
On the sorting pane, you can change the internal order of dimensions and measures.

When sorting pivot tables, NULL values are always displayed first.

Sort by first measure
If you have more than one measure, a measure group is created. Turn on Sort by first measure to
sort dimension values by the numeric value of the first measure. You can choose between
Ascending and Descending sort order.

This sort order will affect all dimensions, and take precedence before any other sort order defined
under the dimensions.

For example, you have two measures: Quantity and Sales. In the properties pane, under Data>
Measures, Quantity is listed first. If you Sort by first measure in descending order, your table is
sorted starting with the dimension with the highest Quantity.

If Sort by first measure is turned off, the table uses the sort order configured for the dimensions.
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Pivot table in edit mode. Sort by first measure has been toggled on.

Limitations:

l This option is only supported if subtotals are calculated. You can calculate subtotals by doing
one of the following:

o In the properties pane, go to Data, and click on a dimension. Toggle on Show totals.
o In the properties pane, go to Appearance > Presentation. Toggle on Indent rows.

l This option is not supported for calculated dimensions.
l This option is only supported if all dimensions are in the Row section and all measures are in

the Column section.

Dimension sorting
With Sort by first measure turned off, the table can be sorted by dimension values. Each
dimension can have Auto or Custom sorting. With Auto sorting, field values are sorted
alphabetically and numerically in ascending order. With Custom sorting, you can turn each of the
following settings on or off:

l Sort by expression: Sorts by custom expression. Sort by expression overrides the Sort
numerically and Sort alphabetically settings. This option should only be used with the first
(outermost) dimension in the table.

l Sort numerically: Sorts field values starting with a number.
l Sort alphabetically: Sorts field values starting with a letter.

Ascending and Descending options are available for all three settings.

Sorting in search
The user can click a dimension name in the table to expand a listbox. In the listbox, the user can
search and select individual dimension values. The Sorting in search setting controls the sort order
of the values in a dimension listbox.
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You have the following options for the listbox sort order:

l Auto: Uses the default sort order. Numbers are sorted numerically in ascending order. Text is
sorted alphabetically in ascending order.

l Inherit from dimension: Uses the sort order defined for the individual dimension.

Global grouping
Global grouping lets you create a limited data set, and within that data set, single out values that
you want to focus on. For example: the best quarters, the top sales people, or the worst selling
products.

Beispiel:

In the following pivot table, no limitation is applied. The values are sorted on Sales, descending. The
list is long and the values for 2013 are not shown.

In the following pivot table, a limitation has been applied to the (inner) dimension Sales Rep Name,
so that only the top five sales representatives for the years 2013 and 2014 are shown.
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The next step is to select global grouping in the properties panel. The option Global grouping is
only available after you have applied a limitation on the dimension.

When global grouping is selected, the limitation on the top five sales representatives is applied
again, but this time the dimension Year is ignored. The five sales representatives with the highest
sales (either in 2013 or 2014) are the only ones that will be presented in the final pivot table.

The following image shows the six highest results for 2014 and 2013. The top four results are from
2014, but the fifth (John Greg) is from 2013. Because five other sales representatives have higher
sales than Brenda Gibson (who was number five in 2014), she is removed.

The following image shows the pivot table with global grouping applied. The pivot table only
contains the sales results for the top five sales representatives. Even though Brenda Gibson had a
better result in 2014 than John Greg, his result for 2013 qualified him for the top five list.
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Creating a bookmark with an expanded pivot table
By default, if you create a bookmark that contains a pivot table, the pivot table will be shown
collapsed. If you expanded any rows using , they will not be shown. However, you can choose to
show the pivot table as expanded.

Gehen Sie folgendermaßen vor:

1. Click in the toolbar.

2. Click Create new bookmark.
Change the name and description, if desired.

3. Toggle on Save layout.
4. Click Save.

Vergleichen von Tabellendiagrammen und Pivottabellen
Die Effizienz einer Pivottabelle können Sie feststellen, wenn Sie sie mit einer regulären
Tabelle mit den gleichen Daten vergleichen.

Tabellendiagramm
In der folgenden Tabelle sind folgende Elemente enthalten:

l Drei Dimensionen: Customer, Product Group und Item Desc
l Zwei Kennzahlen: Quantity und Sales
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Die Tabelle zeigt den Umsatz für Lebensmittelprodukte. Wenn Sie die Daten neu anordnen
möchten, um die Analyse zu vereinfachen, sind Ihre Möglichkeiten eingeschränkt. Sie können die
Reihenfolge der Spalten ändern, dadurch wird die Darstellung jedoch nicht übersichtlicher. Sie
können auch die Sortierreihenfolge festlegen, entweder im Sortierbereich im Eigenschaftsfenster
oder durch Klicken auf die Dimensionsspalten. Das Problem besteht jedoch weiter. Kunden,
Produktgruppen und Artikel sind jeweils mehr als einmal dargestellt. Es ist nicht möglich, eine gute
Datenübersicht zu erhalten.

Pivottabelle
Dem Arbeitsblatt wird eine Pivottabelle mit den gleichen Informationen hinzugefügt:

l Drei Dimensionen: Customer, Product Group und Item Desc
l Zwei Kennzahlen: Quantity und Sales
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Entdecken
Sie können sehen, dass die Pivottabelle die Daten in viel verdichteterer Form präsentiert. Im
Vergleich zur normalen Tabelle hat sich die Anzahl der Zeilen halbiert und es gibt nur noch drei statt
fünf Spalten.

Einer der Vorteile einer Pivottabelle ist die Austauschbarkeit: die Fähigkeit, Zeilenelemente in
Spalten und Spaltenelemente in Zeilen zu verschieben. Sie können Daten neu anordnen und ein-
und denselben Datensatz auf viele verschiedene Weisen betrachten. Sie können Dimensionen und
Kennzahlen verschieben, um die gewünschten Daten in den Vordergrund treten zu lassen und
Daten, die zu detailliert oder für die Analyse irrelevant sind, auszublenden.

Die Pivottabelle enthält die Dimensionen Customer, Product Group und Item Desc sowie die
Kennzahlen Quantity und Sales. In dieser Ansicht erhalten Sie eine Übersicht über die Mengen und
Umsätze für jeden Kunden. Wenn Sie wissen möchten, welche Artikel und Produktgruppen die
Kunden gekauft haben, können Sie die Kundenfelder erweitern. Klicken Sie dafür auf . Das

Symbol gibt an, dass durch Erweitern eines Felds nähere Informationen angezeigt werden

können. Das Symbol hingegen gibt an, dass ein Feld reduziert werden kann, um die Anzahl der
Felder und der näheren Angaben zu verringern.

Scatter plot
The scatter plot presents pairs of values from two or three measures.

This is useful when you want to show data where each instance has two numbers, for example, the
relationship between Sales and Quantity per Customer. In the scatter plot below, a third measure
(Cost) is used to generate the bubble size.
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Scatter plot displaying the relationship between Sales and Quantity per Customer.

The scatter plot presents values from different measures over one dimension as a collection of
points. In most charts you find your dimension on one of the axes, but for a scatter plot, the
dimension is represented by the points in the chart and the measures are found on each of the two
axes. When a third, optional, measure is used, its value is reflected in the bubble size. If you are
analyzing large data sets and view compressed data, the density of the data points is reflected by
color.

When to use it
The scatter plot helps you find potential relationships between values, and to find outliers in data
sets. The scatter plot is useful when you want to show data where each instance has at least two
metrics, for example, average life expectancy and average gross domestic product per capita in
different countries.
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Advantages
The scatter plot is a great way to visualize the correlation of two or more measures at the same
time. The third measure is an efficient way of differentiating between values and simplifying the
identification of, for example, large countries, large customers, large quantities, and so on.

Disadvantages
The scatter plot may be difficult to understand for an inexperienced user, because it has measure
value on both axes, and the third, optional, measure adds complexity to the interpretation. Make
sure a novice can interpret the scatter plot correctly. Using descriptive labels is a good way to make
the visualization easier to interpret.

Values may be placed on top of each other and are then not visible until you zoom in.

Creating a scatter plot
You can create a scatter plot on the sheet you are editing.

In a scatter plot you need one dimension and at least two measures. You can have maximum one
dimension and three measures, where the third measure is visualized as bubble size.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty scatter plot to the sheet.
2. Klicken Sie auf Dimension hinzufügen und wählen Sie eine Dimension oder ein Feld aus.
3. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine

Kennzahl aus einem Feld.
4. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine

Kennzahl aus einem Feld.
5. Optionally, if you want bubble size to be set according to a third measure:

Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine
Kennzahl aus einem Feld.

When you have created the scatter plot, you might want to adjust its appearance and other settings
in the properties panel.

Styling the scatter plot
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.
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For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. Legen Sie auf der Registerkarte Diagramm die Schriftart, die Schriftgröße und die Farbe der
folgenden Textelemente fest:

l Achsentitel: Legen Sie das Design der Titel auf den Achsen fest.
l Achsenbeschriftung: Legen Sie das Design der Beschriftungen auf den Achsen fest.
l Value label: Style the labels for the bubbles representing each dimension value.
l Legendentitel: Legen Sie das Design des Legendentitels fest.
l Legendenbezeichnungen: Legen Sie das Design der Bezeichnungen für die einzelnen

Legendenelemente fest.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Display limitations

Large data sets in scatter plots
You can set the maximum number of visible bubbles in a scatter plot if you are using advanced edit
mode. Go to Presentation > Max visible bubbles. The default is 2,500. The maximum is 50,000. If
you set a number less than 1,000, the scatter plot will behave as if the maximum is 1,000 visible
bubbles.

If the number of displayed data points is less than Max visible bubbles, the data will be shown as
individual bubbles. If there are more data points than the number set in Max visible bubbles, you
will see an overview of your dataset as a table with colored boxes. This switch between
compressed view and bubble view is done automatically. If there are more than 5,000 visible
bubbles, then bubble labels and out of bound bubbles will not be shown.
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Scatter plot with compressed data in a bubble view.

Zooming and panning
In a scatter plot, you can zoom and pan around in your data. The interaction differs depending on
what device you are using. If you are zooming in you can see where in the data set you are located
by looking at the mini chart in the bottom right corner. If you zoom in on large data sets you will be
able to see the data shown as boxes with values inside. The values represent the number of points
in each box.

You cannot make selections when the scatter plot is rendering during a pan or zoom.

Zoomen und Schwenken ist nicht möglich, wenn Sie eine Auswahl in der komprimierten
Datenansicht vorgenommen haben.

You can change the compression resolution in the visual exploration menu or in the properties
panel.
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Scatter plot with compressed data in a compressed view.

Colors and legends
Compressed scatter plots are always auto-colored by the primary data color. That means that any
custom color definition made will not affect compressed data. The density of the data points is
reflected by color. More dense data will be displayed in a darker color.

However, if you zoom or make selections so that the number of displayed data points is reduced to
less than Max visible bubbles, the data will be colored as defined.

Wenn Einfärbung nach Dimension in diesem Diagramm verwendet wird, können maximal 100
eindeutige Dimensionswerte und 100 eindeutige Farben auf der Legende aufgetragen werden.

Korrelieren von zwei Kennzahlen mit einem Punktdiagramm, um Ausreißer zu
finden
In diesem Beispiel wird gezeigt, wie ein Punktdiagramm zur Korrelation zweier
Kennzahlen erstellt wird. Es soll verglichen werden, wie das durchschnittliche
Umsatzvolumen für eine Gruppe von Vertriebsmitarbeitern mit der durchschnittlichen
Marge korreliert, und es sollen Ausreißer gefunden werden.
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Dataset
In diesem Beispiel werden zwei Datendateien verwendet, die im Qlik Sense Tutorial - Aufbau einer
App verfügbar sind. Laden Sie das Tutorial herunter und blenden Sie die enthaltenen Ordner ein.
Die Dateien sind im Ordner Tutorials source verfügbar:

l Sales.xls
l Sales rep.csv

Um die Dateien herunterzuladen, gehen Sie zu Tutorial - Aufbau einer App.

Fügen Sie die beiden Datendateien einer leeren App hinzu und vergewissern Sie sich, dass sie
anhand von Sales Rep ID – Sales Rep Number miteinander verknüpft sind.

Der Datensatz, der geladen wird, enthält Umsatzdaten. Die Tabelle Sales rep enthält die
Informationen über die Vertriebsmitarbeiter.

Kennzahlen
Es werden zwei Kennzahlen benötigt, die in Master-Elemente:

l AverageSales mit der Formel Avg(Sales) erstellt werden. Dies ist der Durchschnitt des
Umsatzwerts für alle Bestellungen.

l AverageMargin mit der Formel Avg(Margin/Sales) erstellt wird. Dies ist der Durchschnitt der
Umsatzmarge für alle Bestellungen.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 362

../../../../tutorials/Tutorial - Building an App.zip


3   Visualizations

Visualisierung
Wir fügen dem Arbeitsblatt ein Punktdiagramm hinzu und legen die folgenden Dateneigenschaften
fest:

l Dimensionen > Blase: Sales Rep Name (Vertriebsmitarbeiter)
l Kennzahlen > X-Achse: AverageSales
l Kennzahlen > Y-Achse: AverageMargin

Es wird ein Punktdiagramm erstellt, das eine Blase pro Vertriebsmitarbeiter enthält.

Wir möchten aber auch Informationen über den Gesamtumsatz pro Vertriebsmitarbeiter erhalten.
Dafür fügen wir die dritte Kennzahl Avg(Sales) hinzu. Die Größe jeder Blase spiegelt den
Gesamtumsatz für jeden Vertriebsmitarbeiter wider.

Entdecken
Das Punktdiagramm visualisiert den durchschnittlichen Umsatz im Vergleich zur durchschnittlichen
Marge für jeden Vertriebsmitarbeiter, und es ist zu erkennen, welche Vertriebsmitarbeiter eine
besonders gute Leistung erbringen. Sie können den Mauszeiger über einen Vertriebsmitarbeiter
bewegen und die Details anzeigen.
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Im Diagramm sehen Sie, dass Lee Chin den höchsten Umsatzwert aufweist. Stewart Wind hat das
höchste Gesamtumsatzvolumen, gefolgt von Judy Thurman. Cheryle Sincock hat eine deutlich
geringere durchschnittliche Marge als andere Vertriebsmitarbeiter, während sie die meisten
Kollegen beim durchschnittlichen Umsatzvolumen übertrifft.

Table
The table shows several fields simultaneously, where the content of each row is
logically connected. Typically, a table consists of one dimension and several measures.

You only make selections in the dimension columns. All dimension columns have a search icon in
the header.

When to use it
Use a table, when you want to view detailed data and precise values rather than visualizations of
values. Tables are good when you want to compare individual values. Drill-down group dimensions
are very efficient in tables. Within a limited space, you can drill down to the next level of detail and
analyze the updated measure values.

Advantages
You can filter and sort the table in different ways. Many values can be included in a table, and when
you drill down in a table, you make good use of the limited space on a sheet. A table is excellent
when you want to see exact values rather than trends or patterns.

Disadvantages
If the table contains many values, it is difficult to get an overview of how values are related. It is also
hard to identify an irregularity within the table.

Creating a table
You can create a new table on the sheet you are editing.
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Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty table to the sheet.
2. Klicken Sie auf Dimension hinzufügen und wählen Sie eine Dimension oder ein Feld aus.
3. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine

Kennzahl aus einem Feld.

When you have created the table, you may want to adjust its appearance and other settings in the
properties panel.

Column width is automatically set to keep columns together for improved readability.
You can adjust the width of a column by dragging the header divider. Double-click the
header divider to reset to the default width.

Styling the table
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:
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l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font size and color for the following text elements:
l Header: Style the text of the column headers.
l Content: Style the text of the table content. If you have selected to show a Totals row,

it will be styled using these settings, in addition to its text being bold.

Additionally, you can customize how the text appears when a user hovers over a row. See
Customizing the hover behavior and scrollbar (page 366).

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Setting the row height
You can adjust the height of the rows in the table.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Chart tab, under Row height (in lines), enter a positive integer value representing
how many originally sized rows should fit into one newly sized row, height-wise.

Customizing the hover behavior and scrollbar
Sie können Anzeigeoptionen festlegen, wenn ein Benutzer den Mauszeiger über eine Zeile in der
Tabelle bewegt. Sie können auch die Größe der Scrollleiste festlegen.

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Passen Sie auf der Registerkarte Diagramm des Designfensters unter Beim Draufzeigen die
folgenden Einstellungen an:
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l Um Zeile in der Tabelle hervorzuheben, wenn ein Benutzer mit dem Mauszeiger
daraufzeigt, legen Sie den Schalter auf Ein um. Deaktivieren Sie das Verhalten je nach
Belieben.

l Farbe beim Daraufzeigen: Legen Sie die Farbe fest, mit der die Zeile hervorgehoben
wird, wenn ein Benutzer den Mauszeiger darüberbewegt.

l Schriftfarbe beim Daraufzeigen: Legen Sie die Farbe des Texts in der
hervorgehobenen Zeile fest, wenn ein Benutzer den Mauszeiger darüberbewegt.

4. Legen Sie unter Größe der Scroll-Leiste die Größe der Scroll-Leiste im Diagramm fest (Sie
können Klein, Mittel oder Groß auswählen).

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Aligning data
If Text alignment is set to Auto, column data is aligned according to data type: text values are left-
aligned and number values, including date related values, are right-aligned. If you set it to Custom,
you can align the data to the left, center, or right.

Sorting the table
You can adjust the sorting of the table in several ways:

l Column sorting: adjust the order of the dimensions and measures from left to right
l Row sorting: adjust the sorting priority order of the rows
l Internal sorting: use the internal sorting order of dimensions and measures
l Interactive sorting: during analysis you can click on a column header to sort the table

Column sorting
By default, the order in which columns are sorted is set by the order in which dimensions and
measures are added to the table. If you add the measure Sales first, it is presented first (leftmost) in
the table. The next dimension or measure that is added is presented in the second column, and so
on. The column sorting order can be changed in the properties panel, under Columns.
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Row sorting
By default, rows are sorted by the first added dimension or measure, numeric values descending,
text values ascending. A small arrow under the column header shows by which column the table is
sorted.

You can change the row sorting in the properties panel, under Sorting. Drag the dimensions and
measures to change the sorting priority order. In many cases, sorting is not only affected by the
first dimension or measure in Sorting, but also the following ones.

Beispiel:

In the following screenshot, the rows are first sorted by Customer, then by Month, and then by
Product Type. As you can see, the columns Customer and Month have several rows with the same
values (A-2-Z Solutions and Month). The rows in Product Type are ordered alphabetically, but only
those that were sold in January to the customer A-2-Z Solutions are displayed.

By changing the sorting order, so that secondary sorting is by Product Type, followed by Month, all
Product Type items sold to the customer A-2-Z Solutions are presented in alphabetical order,
whereas only the months when they were sold are displayed under Month.
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Internal sorting
Each dimension and measure has a default (Auto) internal sorting order, which can be changed.
Under Sorting, click the item you want to change and click the button to switch to Custom sorting.
Changes made to the internal sorting of an item may not have any effect if the sorting is in conflict
with an item with higher priority.

Interactive sorting
During analysis, you can set which column to sort on by clicking the column header. The first click
sorts the table according to the default sorting of the selected item. A second click reverses the
sorting order. Interactive sorting is session based and is not saved. If you want your changes to the
sorting to be persistent, you need to make the changes in the properties panel.

Displaying totals
By default, the totals of numeric values are displayed under the column names. In the properties
panel, you can change this to display the totals at the bottom of a column, or not at all.

Displaying more data
The chart can be configured to display more data, or to show it in different ways. Under
Appearance > Presentation in the properties panel, you can:
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l Freeze the first column from scrolling.
For app consumers who have Touch screen mode activated in the navigation menu, you
need to turn on Enable on touchscreen to support the freezing of the first column for these
consumers.

l Select to wrap multiline text in headers and cells separately.
l Turn off horizontal scrolling and turn on the column picker feature. This lets app consumers

change table column order.

Adding a trend indicator to a measure
You can add a trend indicator to a measure column. This will show a symbol next to the measure
value. You can define the ranges that determine which symbol is displayed and in which color it is
displayed. You enable the indicator by setting Representation to Indicator in the measure
properties.

Setting the indicator limits
You need to add the limits for the ranges you want to use for showing indicators with Add limit. You
can set a limit value in three ways.

l Use the slider.
l Type a value in the text box.
l Set an expression that returns the limit value.

When you have added the limits, you can select the color and the symbol of the indicator for each
defined range.

Styling the indicator
You can style the way the indicator is displayed.

l You can show both the indicator and the measure value by selecting Show values.
l You can set the value color to the same as the indicator color with Apply color to value.
l You can display the indicator to the right or to the left of the value with Indicator position.

Example
In this example, we added a trend indicator to the Sales measure to indicate which values are below
the target value. The indicator limits are:

l For values below 3000000 a red flag is displayed.
l For values in the range of 3000000 to 3500000 a yellow flag is displayed.
l For values above 3500000 a green check-mark is displayed.
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Adding a mini chart to a measure
You can add a mini chart to a measure column. This will show a small chart visualization instead of
the measure value. You can define the dimension that determines what data is displayed and in
which color it is displayed. You enable the indicator by setting Representation to Mini chart in the
measure properties.

The mini chart popup only shows the value of the measure, and is not broken down by
individual dimension point values.
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Setting the mini chart type
After specifying which dimension the mini chart will be based on, you must select a Mode.

l Bars creates a bar chart.
l Dots creates a dot chart.
l Sparkline creates a sparkline chart. You can show dots at each data point along the sparkline

chart by selecting Show dots.
l Positive/negative creates a chart with each value represented by a dot above or below the

zero.

When you have selected the mode, you can specify the Y-axis of the Mini chart at the bottom of the
mini chart options.

Styling the mini chart
You can set the color of bars or lines for Bars, Dots, and Sparkline.

l You can optionally set the Max value color and Min value color, which will highlight the
highest and lowest visible chart values.

l You can optionally set the Highlight first and Highlight last colors, which will highlight the
first and last visible chart values.

You can set the positive and negative color for a Positive/negative mini chart.

Display limitations

Number of rows and columns
In a table, you can have millions of rows and virtually any number of columns with dimensions and
measures. But because huge tables are impractical and hard to manage, the limit for what is
practical is far less than the theoretical maximum. In most cases, it is desirable to see all the
columns without scrolling horizontally.

Tables with content of mixed sizes
In a table you can have both columns where the content fits on one row within the cell, and columns
containing wrapped multiline text. In some cases you will see a shift in alignment and number of
rows when the multiline column is scrolled in and out of view. When the view only contains content
that fits on one row, the table will adjust and show all content on single line rows, which means
more rows are displayed.

We recommend that you disable multiline text wrapping in these cases to avoid confusion for the
user.

Suchen in Tabellen
Sie können in einer Tabelle die Dimensionsspalten durchsuchen und in der
resultierenden Liste Auswahlen treffen.

Gehen Sie folgendermaßen vor:
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1. Klicken Sie in der Dimensionsspalte, die Sie durchsuchen möchten, auf .
Ein Auswahl-Popup wird mit einer Liste aller Werte des Felds angezeigt. Dies umfasst auch
Werte, die durch Auswahlen ausgeschlossen sind. Ausgeschlossene Werte sind dunkelgrau.

2. Geben Sie Ihr Suchwort ein. Sie können jeden der verfügbaren Suchtypen
verwenden.Weitere Informationen finden Sie unter Suchen innerhalb von Auswahlen oder
Visualisierungen.
Während Ihrer Eingabe wird die Liste gefiltert und zeigt nur Elemente an, die Ihre
Suchvorgabe erfüllen.

3. Treffen Sie durch Klicken oder Ziehen eine Auswahl.
4. Bestätigen Sie Ihre Auswahl.

Sie können die Auswahl aller entsprechenden Elemente bestätigen, indem Sie auf
die Eingabetaste drücken.

Die neue Auswahl ist aktiv und spiegelt sich in allen zugehörigen Visualisierungen wider.

Sie können das Suchwort löschen, indem Sie auf klicken oder Esc drücken. Das
Suchwort wird immer gelöscht, wenn Sie die Eingabetaste drücken.

Auswahl in Tabellen
Sie können in einer Tabelle durch Klicken oder Ziehen in den Dimensionsspalten
Auswahlen treffen.

Kennzahlwerte können nicht ausgewählt werden. Beim Treffen einer Auswahl wählen Sie immer die
Dimensionswerte aus. Sie können immer nur jeweils in einer Spalte Auswahlen treffen.
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Tabelle mit drei ausgewählten Feldern in der Dimension „Kunde“

Um eine Zeile zu deaktivieren, klicken Sie auf diese. Um eine Auswahl zu bestätigen, klicken Sie auf
oder klicken Sie außerhalb der Visualisierung. Sie können auch die Eingabetaste drücken.

Klicken Sie zum Abbrechen auf oder drücken Sie die Esc-Taste. Bei einer Bestätigung wird die
Auswahl in alle zur Tabelle gehörigen Visualisierungen übertragen.

Sie können keine Dimensionswerte auswählen, die null sind. Null-Werte in einer Tabelle werden als
Striche (-) dargestellt. Zeilen ohne gültige Dimensionswerte werden nicht in die Auswahl
einbezogen.

Akkumulieren von Werten über eine Dimension in einer Tabelle
Dieses Beispiel zeigt, wie eine Tabelle zum Vergleich von Daten, die über eine
Dimension hinweg akkumulieren, genutzt wird.
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Datensatz
In diesem Beispiel wird eine Datendatei verwendet, die in der Qlik Sense Tutorial - Aufbau einer App
verfügbar ist. Laden Sie das Tutorial herunter und erweitern Sie es. Die Datei ist im Ordner der
Tutorials source verfügbar: Sales.xls

Um die Datei herunterzuladen, gehen Sie zu Tutorial - Aufbau einer App.

Fügen Sie die Datendatei zu einer leeren App hinzu. Der Datensatz, der geladen wird, enthält
Umsatzdaten.

Kennzahl
Das Umsatzvolumen wird als die Kennzahl verwendet, die in Master-Elemente:

l Sales mit der Formel Sum(Sales) erstellt wird. Dies ist die Summe des Umsatzvolumens.

Visualisierung
Wir fügen dem Arbeitsblatt eine Tabelle hinzu und legen die folgenden Dateneigenschaften fest:

l Dimension: Year (Date.Year).
l Dimension: Month (Date.Month).
l Kennzahl: Sales; die zuvor erstellte Kennzahl.

Die folgende Tabelle wird erstellt. Die einzelnen Spalten zeigen das Jahr, den Monat und die
Summe der Umsätze für jeden Monat.
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Vergewissern Sie sich, dass Sortieren auf Year > Month > Sales festgelegt ist.

Akkumulierung
Damit die Umsatzdaten über eine Dimension hinweg akkumuliert werden, muss eine weitere
Dateneigenschaft festgelegt werden:

l Kennzahl: Sales; die zuvor erstellte Kennzahl.

Wir fügen diese Kennzahl zweimal hinzu, um sie für die Akkumulierung wiederzuverwenden. Hierzu
müssen wir einen Modifikator auf unsere Sales-Kennzahl anwenden.

Gehen Sie folgendermaßen vor:

1. Legen Sie unter Kennzahl: Sales den Modifikator auf Accumulation fest. Dadurch wird die
Kennzahl so festgelegt, dass sie über eine Dimension hinweg akkumuliert.

2. Legen Sie Modifikator>Dimension auf Month fest. Damit wird die Dimension festgelegt, für
die die Akkumulierung stattfinden wird.

3. Vergewissern Sie sich, dass Übergreifend in allen Dimensionen deaktiviert ist. Die
Akkumulierung soll zu Beginn jedes Jahres neu beginnen.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 376



3   Visualizations

Unter „Akkumulierung“ besteht die Option, Ausgeschlossene Werte anzeigen
auszuwählen. Wenn diese Option aktiviert wird, enthält Ihre Visualisierung alle
Dimensionswerte, die keine Daten enthalten. Damit wird sichergestellt, dass alle Werte,
auch Monate ohne Umsatzdaten, in der Akkumulierung gezählt werden.

Die Tabelle sieht dann wie folgt aus, wobei die letzte Spalte Umsätze zeigt, die innerhalb jedes
Jahres von einem Monat zum nächsten akkumuliert werden.

Es empfiehlt sich, die Titel der Diagramme entsprechend deren Inhalt festzulegen. Ändern Sie
beispielsweise die Titel der Spalten Ihrer Tabelle, um anzugeben, dass die letzte Spalte die
Akkumulierung der Umsätze enthält.

Unsere Daten für das Jahr 2014 sind nicht ausreichend, da sie im June enden. Um die
akkumulierten Umsätze aller drei Jahre besser vergleichen zu können, wählen wir einen
passenderen Monatsbereich, von January bis June.

Gehen Sie folgendermaßen vor:

1. Klicken Sie auf Erledigt.
2. Wählen Sie alle Monate von January bis June aus und bestätigen Sie die Auswahl.

Die Tabelle sieht dann wie folgt aus, wobei die Umsätze von January bis June innerhalb jedes
Jahres akkumuliert werden.
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Entdecken
Die Tabelle zeigt das Umsatzvolumen für jeden Monat, gruppiert in Jahren. Durch die
Akkumulierung des Umsatzes in jedem Jahr lässt sich das Umsatzvolumen der einzelnen Jahre
besser veranschaulichen. Wir haben eine Auswahl der Monate von January bis June getroffen, um
den gleichen Monatsbereich für die drei Jahre zu vergleichen. In der letzten Spalte der Tabelle ist
zu sehen, dass der akkumulierte Umsatz für 2014 bisher höher als der akkumulierte Umsatz für
2012 lag, aber nicht so hoch wie für 2013.

Verwenden von relativen Zahlen in einer Tabelle zur Beitragsberechnung
In diesem Beispiel wird die Verwendung des Modifikators „Relative Zahlen“ zum
Berechnen von Beiträgen in einer eindimensionalen Tabelle gezeigt.
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Datensatz
In diesem Beispiel wird eine Datendatei verwendet, die in der Qlik Sense Tutorial - Aufbau einer App
verfügbar ist. Laden Sie das Tutorial herunter und erweitern Sie es. Die Datei ist im Ordner der
Tutorials source verfügbar: Sales.xls

Um die Datei herunterzuladen, gehen Sie zu Tutorial - Aufbau einer App.

Fügen Sie die Datendatei zu einer leeren App hinzu. Der Datensatz, der geladen wird, enthält
Umsatzdaten.

Kennzahl
Das Umsatzvolumen wird als die Kennzahl verwendet, die in Master-Elemente:

l Sales mit der Formel Sum(Sales) erstellt wird. Dies ist die Summe des Umsatzvolumens.

Visualisierung
Wir fügen zunächst dem Arbeitsblatt ein Filterfenster hinzu und legen die folgenden
Dateneigenschaften fest:

l Dimension: Product Group.

Zudem fügen wir dem Arbeitsblatt eine Tabelle hinzu und legen die folgenden Dateneigenschaften
fest:

l Dimension: Year (Date.Year).
l Kennzahl: Sales; die zuvor erstellte Kennzahl.

Die folgende Tabelle wird erstellt. Die einzelnen Spalten zeigen das Jahr und die Summe der
Umsätze für jedes Jahr.

Die Zahlenformatierung muss auf Währung und das Zahlenformat auf $ #,##0;-$ #,##0
festgelegt werden.

Es empfiehlt sich, die Titel der Diagramme entsprechend deren Inhalt festzulegen. Zusätzlich
können Sie den Titel der einzelnen Spalten entsprechend ihrem Inhalt ändern. Die erste
hinzugefügte Spalte ist Year, die zweite Spalte enthält den Sales per year.
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Relative Zahlen
Wir könnten das Filterfenster verwenden, um spezifische Produktgruppen auszuwählen und deren
jährlichen Umsatz und Gesamtumsatz anzuzeigen. Damit ließe sich ihr Beitrag nur schlecht
vergleichen. Stattdessen verwenden wir relative Zahlen, um Prozentsätze als Angabe des Beitrags
der Produktgruppe zu erhalten. Indem wir die Parameter ändern, auf die sich die Berechnung der
relativen Zahlen stützt, erhalten wir verschiedene Beiträge und gewinnen bessere Einblicke.

Beitrag eines Jahres zum Umsatz einer Produktgruppe
Um zu sehen, wie viel jedes Jahr zum Gesamtumsatz einer bestimmten Produktgruppe beigetragen
hat, wenn wir eine Auswahl treffen, müssen wir eine dritte Spalte hinzufügen:

Gehen Sie folgendermaßen vor:

l Klicken Sie im Eigenschaftenfenster mit der rechten Maustaste auf Sales per year und
wählen Sie Duplizieren.

Um diese duplizierte Kennzahl als relative Zahl zu verwenden, wenden wir einen Modifikator an.

Gehen Sie folgendermaßen vor:

1. Legen Sie unter Kennzahl: Sales per year den Modifikator auf Relative numbers fest. Damit
wird die Kennzahl so festgelegt, dass sie als relative Zahl fungiert.

2. Legen Sie den Modifikator>Auswahlbereich auf Current selection fest. Damit wird der
Modifikator so festgelegt, dass er relativ zu jeder getroffenen Auswahl berechnet wird.

3. Der Modifikator>Dimensionsbereich wird standardmäßig auf Disregard dimension
festgelegt. Damit wird der Modifikator so festgelegt, dass er relativ zum Gesamtwert
berechnet wird.

4. Legen Sie die Zahlenformatierung auf Benutzerdefiniert und das Zahlenformat auf #,##0%
fest.

5. Ändern Sie die Bezeichnung in einen sinnvollen Namen wie Contribution to total sales of
current selection.

Unsere Tabelle sieht jetzt wie folgt aus, wobei die letzte Spalte den Beitrag der einzelnen Jahre zum
Gesamtumsatz der ausgewählten Produktgruppe anzeigt.
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Beitrag einer Produktgruppe zum Gesamtumsatz
Um zu sehen, wie viel der Umsatz der einzelnen Jahre zum Gesamtumsatz aller Produktgruppen
beigetragen hat, müssen wir eine vierte Spalte hinzufügen:

Gehen Sie folgendermaßen vor:

l Klicken Sie im Eigenschaftenfenster mit der rechten Maustaste auf Contribution to total sales
of current selection und wählen Sie Duplizieren.

Der Modifikator Relative numbers wird erneut angewendet, aber dieses Mal mit anderen
Eigenschaften.

Gehen Sie folgendermaßen vor:

1. Legen Sie den Modifikator>Auswahlbereich auf Disregard selection fest. Damit wird der
Modifikator so festgelegt, dass er unabhängig von jeder getroffenen Auswahl berechnet
wird.

2. Der Modifikator>Dimensionsbereich ist bereits auf Disregard dimension festgelegt. Damit
wird der Modifikator so festgelegt, dass er relativ zum Gesamtwert berechnet wird.

3. Ändern Sie die Bezeichnung in einen sinnvollen Namen wie Contribution to total sales from
all years.

Die Zahlenformatierung und das Zahlenformat sind bereits festgelegt, da die vorherige Kennzahl
dupliziert wurde.

Unsere Tabelle sieht jetzt wie folgt aus, wobei die letzte Spalte den Beitrag der ausgewählten
Produktgruppe zum Gesamtumsatz aller drei Jahre anzeigt.

Da wir noch keine Auswahlen getroffen haben, enthalten die letzten beiden Spalten die gleichen
Werte.

Beitrag einer Produktgruppe zu den jährlichen Umsätzen
Um zu sehen, wie viel der Umsatz einer bestimmten Produktgruppe zum Umsatz dieses Jahres im
Vergleich zu allen anderen Produktgruppen beigetragen hat, müssen wir eine fünfte Spalte
hinzufügen:
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Gehen Sie folgendermaßen vor:

l Klicken Sie im Eigenschaftenfenster mit der rechten Maustaste auf Contribution to total sales
from all years und wählen Sie Duplizieren.

Der Modifikator Relative numbers wird erneut angewendet, aber dieses Mal mit anderen
Eigenschaften.

Gehen Sie folgendermaßen vor:

1. Legen Sie den Modifikator>Auswahlbereich auf Disregard selection fest. Damit wird der
Modifikator so festgelegt, dass er unabhängig von jeder getroffenen Auswahl berechnet
wird.

2. Der Modifikator>Dimensionsbereich ist bereits auf Respect dimension festgelegt. Damit
wird der Modifikator so festgelegt, dass er relativ zu jedem Dimensionswert berechnet wird.

3. Ändern Sie die Bezeichnung in einen sinnvollen Namen wie Contribution to sales of each
year.

Unsere Tabelle sieht jetzt wie folgt aus, wobei die letzte Spalte den Beitrag der ausgewählten
Produktgruppe zum Gesamtumsatz aller drei Jahre anzeigt.

Da wir noch keine Auswahlen getroffen haben, zeigt die letzte Spalte den Jahresbeitrag aller
Produktgruppen für jedes Jahr.

Vornehmen einer Auswahl
Jetzt können wir beginnen, Auswahlen zu treffen, um unsere relativen Zahlen in Angaben zu
ändern, die besseren Einblick bieten.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Symbolleiste auf Bearbeitung erledigt.

2. Wählen Sie im Produktgruppen-Filterfenster Canned Products aus.

Unsere Tabelle sieht jetzt wie folgt aus.
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Entdecken
Die Tabelle zeigt den relativen Umsatz für jedes Jahr. Durch die einzelnen Beitragsspalten, in denen
relative Zahlen als Kennzahlenmodifikator verwendet werden, erhalten wir ein besseres
Verständnis für den Beitrag jeder Produktgruppe zum Gesamtumsatz. In der Spalte Contribution to
total sales of current selection können wir ablesen, dass 40 % des Umsatzes von Canned Product
im Jahr 2012 stattfand und im Jahr 2014 ein starker Rückgang zu verzeichnen war. Die Spalte
Contribution to total sales from all years zeigt, dass 8 % des Gesamtumsatzes aller drei Jahre dem
Umsatz von Canned Product aus dem Jahr 2012 entsprechen. Die Spalte Contribution to sales of
each year zeigt auch, dass im Jahr 2012 der Umsatz für Canned Product 21 % des Umsatzes für
dieses Jahr darstellt, und dass Gleiches für den Umsatz des Jahres 2014 gilt.

Text & image
The text & image visualization complements other visualizations by offering options to
add text, images, hyperlinks, and measures.

You can format and color the text and align the paragraphs. The background image has sizing and
positioning options. You can also set the responsive behavior for text and images.

The text & image visualization is only available in the advanced edit mode.

When to use it
The text & image visualization is intended for presentation purposes, and does not support
selections. However, the measures in the text & image visualization are updated when selections
are made. Some typical uses:

l Use it on the first sheet of an app for essential information.
l Display a company image, or use a background image together with formatted text and

measure values to present figures in a compelling way.
l Link to sites with additional information.
l Use the responsive behavior to ensure that the visualization renders well on all devices.

Advantages
The text & image visualization contrasts with the other visualizations. You have many options for
making the text & image visualization stand out next to more regular charts.
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Disadvantages
You are limited to a few measure values and rather short texts, otherwise the text & image
visualization will be cluttered.

Creating a text & image
You can create a text & image visualization on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty text & image chart to the sheet.
2. Click the text & image chart to open the editing toolbar.
3. Add and format text, images, hyperlinks or measures to the text & image chart.

If you double-click a text & image chart in the assets panel, it is added to the sheet
immediately.

Styling the text & image
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.
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3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

In a text & image object, you can also set a background image outside of the styling panel. Setting a
background image in this way will not exclude or negate any background modifications you have
made in the above procedure.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.
2. Under Background image, toggle on Use background image.
3. Add an image from your media library. You can select from a number of size and position

options.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.
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Editing a text & image
In the text & image visualization you can add and format text, images, measures, and links in various
ways.

When you are editing a sheet and the text & image visualization does not have focus, you need to
click twice to open the editing toolbar. In the editing toolbar, you can format text properties such as
color, size, and style, and also align the text. Additionally, you have options for adding links and
images.

Creating a link
You can mark a text section and use it for a link.

If you do not add a prefix, http:// is added automatically, assuming that you are adding a web
address.

Gehen Sie folgendermaßen vor:

1. Select the text section that you want to use for the link.

2. Click in the editing toolbar to open the link dialog.

3. Enter the web address that you want to link to.

4. Click .

Removing a link
You can remove a link from a text section.

Gehen Sie folgendermaßen vor:

1. Click the link so that the cursor is somewhere inside it.

2. Click in the editing toolbar to open the link dialog.

3. Click .

The link is removed, but not the text.

Adding an image
You can add an image through the editing toolbar. You can use one of the default images, or an
image of your own.

Gehen Sie folgendermaßen vor:

1. Click in the editing toolbar.
Die Medien-Bibliothek wird geöffnet.
Folgende Formate werden unterstützt: .png, .jpg, .jpeg und .gif.
Für Qlik Sense: Sie können Bilder in den Ordner In app in der Medienbibliothek hochladen. Sie
müssen die Qlik Management Console verwenden, um Bilder in den Standardordner
hochzuladen.
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Für Qlik Sense Desktop: Sie können Bilder im folgenden Ordner auf Ihrem Computer
platzieren: C:\Users\<user>\Documents\Qlik\Sense\Content\Default. Bilder stehen im
Ordner default in der Medienbibliothek zur Verfügung. Wenn eine App zwischen
Installationen verschoben wird, werden die in der App verwendeten Bilder in der qvf-Datei
zusammen mit der App gespeichert. Beim Öffnen der App an einem neuen Speicherort
befinden sich die Bilder im Ordner In App in der Medienbibliothek für die App.

2. Click on a folder in the media library, for example In app or Default.
3. Select the image that you want to add.
4. Click Insert.

Alternativ können Sie mit der rechten Maustaste auf die Bilddatei klicken, die Sie
hinzufügen möchten, und Einfügen wählen.

In the properties panel, you can add a background image, which, for example, can be
used when you want to insert text in the image. The images added through the editing
toolbar are not background images.

Adding a measure
You can add a measure in the following ways:

l By dragging a field from the assets panel and adding it as a measure.
l By dragging a measure from Master items.
l By adding a measure (existing or new) from the properties panel.

When you are editing the measure, it is displayed as a token, which can be styled and moved
around in the visualization. You can also apply number formatting to it. When you leave the editor,
the measure value is displayed . Values that cannot be aggregated are shown as a hyphen (-).

Deleting a measure
You can delete a measure in the following ways:

l Place the cursor before the token and press Delete.
l Place the cursor after the token and press Backspace.
l In the properties panel, right-click the measure and select Delete in the dialog.
l In the properties panel, click the measure and click Delete .

Treemap
Treemaps display hierarchical data by using nested rectangles, that is, smaller
rectangles within a larger rectangle.
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In this image you have several product groups, such as Produce, Canned Products, and Frozen
Foods. Each product group consists of a large rectangle. You can regard the product groups as
branches of the tree. When you select a product group, you drill down to the next level, the product
type, for example, Vegetables, Meat, and Dairy. You can regard the product types as sub-branches
of the tree. The branches have leaves. A leaf node's rectangle has an area proportional to a
specified dimension of the data. In this example, the items Ebony Squash, Bravo Large Canned
Shrimp, Red Spade Pimento Loaf, and so on, are the leaves. The leaf nodes are colored to show a
separate dimension of the data.

Sorting is automatic according to size. By default, the coloring is by dimension, with 12 colors, but
that can be changed in the properties panel. When you have more than one dimension, you can
decide which dimension to color by. In this example, the coloring is not by dimension, but by
expression (Avg(Margin)), a calculated measure and by using this expression, you can see which
items have the highest average margin. The darker the color, the higher the average margin.

If the data set contains negative values, a text message is shown stating that the negative values
cannot be displayed.
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When to use it
Use a treemap when space is constrained and you have a large amount of hierarchical data that you
need to get an overview of. Treemaps should primarily be used with values that can be aggregated.

Advantages
Treemaps are economical in that they can be used within a limited space and yet display a large
number of items simultaneously.

When there is a correlation between color and size in the tree structure, you are able to see
patterns that would be difficult to spot in other ways, for example, when a certain color is
particularly relevant.

Disadvantages
Treemaps are not good when there is a big difference in the magnitude of the measure values. Nor
is a treemap the right choice when mixing absolute and relative values.

Negative values cannot be displayed in treemaps.

Creating a treemap
You can create a treemap on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty treemap to the sheet.
2. Klicken Sie auf Dimension hinzufügen und wählen Sie eine Dimension oder ein Feld aus. This

should be the highest level in the hierarchy. It will be displayed as the main group in the chart.
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3. Klicken Sie auf Hinzufügen und wählen Sie eine Kennzahl aus oder erstellen Sie eine
Kennzahl aus einem Feld. The measure will define the size of a rectangle.

4. Add more dimensions in the order of hierarchy level . The last dimension you add defines the
rectangles. The other dimensions define the grouping of the rectangles.

In a treemap you need at least one dimension and one measure, but to make full use of the treemap
it is preferable to have two or three dimensions. You can only have one measure, but up to 15
dimensions. We do not recommend using more than three dimensions as the treemap may become
unmanageable.

When you have created the treemap, you may want to adjust its appearance and other settings in
the properties panel.

Styling the treemap
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote
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4. On the Chart tab, set the font, font size, and any other applicable properties for the following
text elements:

l Header labels: Style the header labels. You can customize the font, font size, and
color.

l Leaf labels: Style the labels for the leaf elements.
l Legendentitel: Legen Sie das Design des Legendentitels fest. You can customize the

font, font size, and color.
l Legendenbezeichnungen: Legen Sie das Design der Bezeichnungen für die einzelnen

Legendenelemente fest. You can customize the font, font size, and color.

Customizing the background
You can customize the general background and the background of the header area. The general
background can be set by color and image, while the background of the header area can be set to a
single color.

In the styling panel, you can configure background options.

Setting the general background
The general background of the chart includes the title area, as well as the chart itself, which might
be partially covered by the header.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Setting the header background
The header area is a branch-like frame surrounding the hierarchy of rectangles when two or more
dimensions are added to the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Chart tab of the styling panel, select a background color under Header background
color.

Customizing the border and shadow
You can customize the border and shadow of the chart.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Display limitations

Large amounts of data
When displaying large amounts of data in a treemap, there may be cases when not each dimension
value within a rectangle is displayed with correct color and size. These remaining values will instead
be displayed as a gray, striped area. The size and total value of the rectangle will still be correct, but
not all dimension values in the rectangle will be explicit.

To remove the gray areas, you can either make a selection or use dimension limits in the properties
panel.

Colors and legend
Wenn Einfärbung nach Dimension in diesem Diagramm verwendet wird, können maximal 100
eindeutige Dimensionswerte und 100 eindeutige Farben auf der Legende aufgetragen werden.

Anzeigen von hierarchischen Daten mit einer Baumkarte
Dieses Beispiel zeigt, wie Sie eine Baumkarte zum Anzeigen hierarchischer Daten
anlegen. Sie können eine große Anzahl Werte auf begrenztem Raum anzeigen und
Muster erkennen, die in anderen Diagrammen möglicherweise nur schlecht zu sehen
sind.

Wir betrachten Umsatzzahlen für verschiedene Produkte, die in vier Ebenen kategorisiert sind.

l Produktgruppe
l Produktuntergruppe
l Produktartikel
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Datensatz
In diesem Beispiel werden zwei Datendateien verwendet, die im Qlik Sense Tutorial - Aufbau einer
App verfügbar sind. Laden Sie das Tutorial herunter und blenden Sie die enthaltenen Ordner ein.
Die Dateien sind im Ordner Tutorials source verfügbar:

l Sales.xlsx
l Item master.xlsx

Um die Dateien herunterzuladen, gehen Sie zu Tutorial - Aufbau einer App.

Fügen Sie die beiden Datendateien einer leeren App hinzu und vergewissern Sie sich, dass sie
anhand der Artikelnummer (Item Number) miteinander verknüpft sind.

Der Datensatz, der geladen wird, enthält Umsatzdaten für Nahrungsmittel- und Getränkeprodukte.
Die Tabelle in der Datei Item Master enthält die Informationen über die Produktkategorien.

Visualisierung
Wir fügen die Baumkarte zum Arbeitsblatt hinzu und legen die folgenden Dimensionen und
Kennzahlen fest:

l Dimensionen > Gruppe: Product Group (Produktgruppe)
l Dimensionen > Gruppe: Product Sub Group (Produktuntergruppe)
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l Dimensionen > Rechteck: Item Desc (Produktartikelbeschreibung)
l Kennzahlen > Größe: Sum(Sales) (Umsatzsumme)

Es wird eine Baumkarte mit einem Rechteck pro Produktartikel erstellt. Die Größe der Rechtecke
wird durch die Umsätze bestimmt und nach Product Group und Product Sub Group gruppiert.

Dem Diagramm sollen aber noch weitere Informationen hinzugefügt werden. Die Rechtecke haben
Farben entsprechend der Produktgruppendimension, wir möchten sie aber nach Marge färben, um
auch zu sehen, welche Artikel am rentabelsten sind. Gehen hierzu zu Darstellung > Farben und
Legende.

l Legen Sie Farben auf Benutzerdefiniert fest.
l Legen Sie Farbgebung nach Kennzahl auf Avg(Margin/Sales) fest.

Im Diagramm sollen auch die Umsatzwerte angezeigt werden. Sie können sie mit
Wertebezeichnungen Darstellung > Präsentation aktivieren.

Entdecken

Wir können im Diagramm sehen, dass Produce den höchsten Umsatz hat, gefolgt von Canned
Products. Anhand der Farbgebung nach Marge können Sie Produktartikel oder Gruppen
identifizieren, die sich von anderen abheben. Sie können im Baum ein Drilldown durchführen, indem
Sie eine Produktgruppe auswählen.
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In diesem Beispiel wurden Produce und dann Fresh Fruit ausgewählt. Tell Tale Red Delicious Apples
haben sich am meisten verkauft, aber für Ebony Red Delicious Apples sind die Margen höher.

Waterfall chart
The waterfall chart is suitable for illustrating how an initial value is affected by
intermediate positive and negative values. The starting and the final values are
represented by whole bars, and intermediate values by floating bars. You can also
show subtotals in the chart.
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Waterfall chart displaying Sales, Sales cost, and Sales margin.
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When to use it
The waterfall chart is suitable for illustrating how an initial value is affected by intermediate positive
and negative values. One example of this is an income statement, when you want to show the
positive and negative contributions of different accounts.

Advantages
The waterfall chart provides a quick understanding of the transition of a value.

Disadvantages
The waterfall chart is not relevant for detailed analysis of the data as you can't make selections in
the chart or expand the data.

Creating a waterfall chart
You can create a waterfall chart on the sheet you are editing.

In a waterfall chart you need to use one measure for each bar in the chart. The order of the
measures defines the order of the bars in the chart. For each measure, you need to define how it
affects the previous value. You can add up to 15 measures in a waterfall chart.

Gehen Sie folgendermaßen vor:

1. From the assets panel, drag an empty waterfall chart to the sheet.
2. Add the first measure.

This is the first bar of the chart. By default, it will use the measure operation Add, and show a
positive value.

3. Add a second measure.
This is the second bar of the chart. If you want to show this measure as a negative
contribution, change Measure operation to Subtract.

4. Continue to add measures, setting Measure operation to Add or Subtract in the advanced
properties panel depending on how you want them to contribute.

5. Add subtotals. There are two ways of adding subtotal bars to the chart:
l If you have a data field containing subtotal data, add a measure with the subtotal data

and select Subtotals as Measure operation.
l If you don't have a data field containing subtotal data, you can add an automatically

calculated subtotal by selecting the Subtotals check box of the measure before where
you want the subtotal bar.

When you have created the waterfall chart, you may want to adjust its appearance and other
settings in the properties panel.

Defining your measures
You can use the Measure operation option of each measure to set how it affects the previous
value.
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l Add
The measure value adds to the previous bar. If this is the first measure, a whole bar is shown
starting at 0.

l Subtract
The measure value subtracts from the previous bar.

If the data already contains a negative sign, the result of subtraction will be a
positive change.

l Subtotals
The measure value is considered a subtotal.

If you do not have sub-totals as a field, you can add subtotals automatically by
enabling Subtotals in the measure before you want the subtotal.

In the waterfall chart shown above, the first bar, Sales, is defined as Add. The second bar, Sales
cost, is defined as Subtract, and the third bar, Sales margin, is defined as Subtotals.

Styling the waterfall chart
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.
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3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font, font size, and color for the following text elements:
l Achsenbeschriftung: Legen Sie das Design der Beschriftungen auf den Achsen fest.
l Value label: Style the labels for the measure values.
l Legendenbezeichnungen: Legen Sie das Design der Bezeichnungen für die einzelnen

Legendenelemente fest.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Visualisieren positiver und negativer Beiträge zum Ergebnis mit einem
Wasserfalldiagramm
Dieses Beispiel zeigt, wie ein Wasserfalldiagramm erstellt wird, um die Beiträge
positiver und negativer Werte zum Endergebnis zu visualisieren.
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Es sollen die positiven Beiträge zum CO2 in der Atmosphäre, wie durch Öl oder Gas, im Verhältnis
zu negativen Faktoren wie Kohlenstoffsenken angezeigt werden.

Datensatz
In diesem Beispiel verwenden wir einen einfachen Datensatz, den Sie in eine Textdatei kopieren
und als Datenquelle verwenden können. Er enthält den CO2-Gehalt in der Atmosphäre in ppm ab
1870 sowie die positiven und negativen Beiträge zum CO2 in der Atmosphäre im Zeitraum zwischen
1870 und 2017.

Atmosphere 1870,Coal,Oil,Gas,Cement,Land,Imbalance,Land sink,Ocean sink,Atmosphere 2017

288,94,72,31,5,88,-12,-89,-72,405

(Quelle: CDIAC/GCP/NOAA-ESRL/UNFCCC/BP/USGS)

Fügen Sie die Textdatei als Datenquelle in einer leeren App hinzu und laden Sie die Daten.
Vergewissern Sie sich, dass Sie Kommas als Feldtrennzeichen verwendet haben.

Visualisierung
Fügen Sie dem Arbeitsblatt ein Wasserfalldiagramm hinzu und fügen Sie Felder als Kennzahlen in
der folgenden Reihenfolge hinzu. Bearbeiten Sie die Bezeichnung für jede Kennzahl, um den Sum()-
Teil zu entfernen.

l Sum(Atmosphere1870)
l Sum(Coal)
l Sum(Oil)
l Sum(Gas)
l Sum(Cement)
l Sum(Land)
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l Sum(Imbalance)
l Sum(Land_sink)
l Sum(Ocean_sink)

Um einen Balken hinzuzufügen, der das berechnete Ergebnis anzeigt, den CO2-Gehalt im Jahr
2017, öffnen Sie die letzte Kennzahl und wählen Sie Teilsummen. Sie können die Bezeichnung für
Teilsumme auf Atmosphäre 2017 festlegen.

Entdecken
Wie Sie im Diagramm sehen können, ist der CO2-Gehalt in der Atmosphäre 2017 höher als 1870.
Kohle trägt am stärksten zum CO2 bei. Ein Teil der Erhöhung wird durch Kohlenstoffsenken
aufgefangen, die CO2 absorbieren, zum Beispiel durch den Ozean. Wie zu sehen ist, reicht dies
leider nicht aus, um den Anstieg des CO2-Gehalts in der Atmosphäre aufzuhalten.

Button
You can use buttons to:

l add quick links for easy selection and navigation in your app
l reload data

When to use it
The button is useful when you want to help the app user by providing:

l predefined selections or selection controls
l navigation links to other sheets, stories, or websites
l reload data functionality in an app

You can reload data in an app that you own. App users need the appropriate access rights.
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Example of buttons in use on a sheet

Creating a button
You can create a button on the sheet you are editing. This shows how to create a button that makes
a selection and then navigates to another sheet. It is also possible to create a button that just
performs the action, or that navigates.

Gehen Sie folgendermaßen vor:

1. In the Assets panel under Charts, drag a Button object to the sheet.
2. Click Add action under Actions in the properties panel.
3. Select the action you want to use.

For some actions you need to provide details for the action. For example, for the Select
values in a field action, you need to select a field, and which value to select in the field.

4. Select which navigation option to use under Navigation. You can navigate to another sheet,
a story or a website.

5. Set the label of the button in Label under General in the properties panel.

You will now have a button that makes a data selection and then navigates to the place in the app
you selected.

Setting the action
You can add one or more actions to be performed when the button is clicked. For some actions you
need to provide details for the action.

The actions are performed in the order they are listed under Actions. You can change the order of
an action by dragging it.
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Toggle Runtime evaluation on or off to change when the expressions in the button are evaluated. If
this setting is turned off, the expressions in the button (for example, the value expression for a
variable) are evaluated independently of one another. With the setting turned on, the expressions
for each action are evaluated at the action's runtime. This allows expression values set in an action
to be carried forward for future actions in the chain.

You do not have to add an action if you just want the button to perform navigation.

Verwandte Videoinhalte
Das Konfigurieren einer Aktion für eine Schaltfläche gleicht der Einstellung von
Arbeitsblattaktionen. Die Hauptunterschiede sind:

l Arbeitsblattaktionen werden im Eigenschaftsfenster unter Aktionen konfiguriert, wenn das
Arbeitsblatt das Objekt im Fokus ist.

l Schaltflächenaktionen werden im Eigenschaftsfenster unter Aktionen und Navigation bei
ausgewählter Schaltfläche konfiguriert.

l Es bestehen einige Unterschiede zwischen den für Schaltflächen und für Arbeitsblätter
verfügbaren Aktionen.

Videoinhalte, die die Aktionskonfigurationen für Arbeitsblätter beschreiben, finden Sie unter
Hinzufügen von Aktionen zu Arbeitsblättern (page 22).

Apply bookmark
You can apply the selection that is defined in a bookmark that you choose.

Clear all selections
You can clear all selections in all states in the app. You can optionally overwrite locked selections.

Clear selections in other fields
You can clear selections from all fields except the one you specify. You can optionally overwrite
locked selections.

If no selections are made in the specified field, all values in this field will be selected.

Move forwards in your selections
You can move one step forwards in your selection history.

Move backwards in your selections
You can move one step backwards in your selection history.

Clear selections in field
You can clear all selections from a field that you specify.

Lock all selections
You can lock all selections in the app.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 403



3   Visualizations

Lock a specific field
You can lock selections in a field that you specify.

Unlock all selections
You can unlock all selections in the app.

Unlock a specific field
You can unlock selections in a field that you specify.

Select all values in a field
You can select all values in a field that you specify. You can optionally overwrite locked selections.

Select values in a field
You can select a list of values in a field that you specify. Separate the values to select with a semi
colon. You can optionally overwrite locked selections.

It is not possible to use fields with date, timestamp, or money data type.

This button action does not select numeric values that are stored or classified as text.
For this purpose, use the Select values matching search criteria action instead.

Select values matching search criteria
You can select all values that match the search results from a search criteria that you specify. You
need to specify the search criteria as a string. You can optionally overwrite locked selections.

l If you want to use an expression, you need to enclose it in single quotes, for example,
='=Sum([Sales Amount]) > 200000'.

l If you want to search for a partial string, you need to use wild cards (*, ?,^). If you do not use
wild cards, only strings that match exactly are selected.

Select alternatives
Select all alternative values in a field that you specify. You can optionally overwrite locked
selections.

Step cyclic dimension
Cycle fields in a selected cyclic dimension forward or backward.

Limitations
Step cyclic dimension has the following limitations:

l In Qlik Sense Mobile, buttons with the action Step cyclic dimension will only cycle dimension
if the button is in a container.

l In Qlik Sense Mobile, buttons with the action Step cyclic dimension do not cycle the
dimension in offline mode.
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Set active field
Set the active field in a cyclic dimension.

Limitations
Set active field has the following limitations:

l Set active field uses the position of the selected field in the cyclic dimension. If the fields are
reordered in the cyclic dimension, Set active field will use the field in the same position as
the originally selected field. To resolve this, select the field again in the button properties.

Select excluded
Select all excluded values in a field that you specify. You can optionally overwrite locked selections.

Select possible values in a field
Select all possible values in a field that you specify. You can optionally overwrite locked selections.

Toggle field selection
You can set the button to toggle between the current selection, and a selection that adds selections
defined by a search string. You can use wild cards in the search string. If you want to define a list of
values you need to use the format (A|B), where A and B are values to select.

Set variable value
You can assign a value to a variable.

Reload data
You can run the load script to reload data.

You can also select Partial reload.
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Refresh dynamic views
Refreshes the displays of all dynamic objects on the sheet based on the current selection.

Navigation
You can choose to navigate to another sheet, a story, or a website when the button is clicked. You
do not have to specify an action if you want to create a simple navigation button. A button can only
have one navigation option at a time.

Navigation is not supported in stories.

Go to next sheet
Navigate to the next sheet sequentially.

Go to previous sheet
Navigate to the previous sheet sequentially.

Go to last sheet
Navigate to the last sheet.

Go to first sheet
Navigate to the first sheet.

Go to a sheet
Navigate to a specific sheet, and optionally highlight a specific chart on the sheet.

Under Sheet, enter the name of the desired sheet or select it from the list. Under Chart ID, enter the
object ID for the chart or select the desired chart from the list.

You can obtain the object ID with either of the following methods:

l Add /options/developer to your URL. Next, right-click the chart and click
Developer.

l For certain chart types, you can use the ObjectId chart function. For example, add
=ObjectId() as a dimension along with any measure. The chart ID is displayed and
you can write it down for future reference. For more information, see ObjectId -
Diagrammfunktion.

Go to a sheet defined by sheet ID
Navigate to a specific sheet. Enter the sheet ID of the desired sheet. You can find the ID of a sheet
in the URL of the browser with the sheet open. The sheet ID follows after /sheet/ followed by /.

Beispiel: Sheet URL

qlik.com/sense/app/8f8ffa0e-3fde-48a5-a127-59645923a1fc/sheet/7300b241-f221-43db-bb8b-

8c8cc1887531/state/analysis
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The ID of the sheet is 7300b241-f221-43db-bb8b-8c8cc1887531 in this example.

Go to a story
Navigate to a specific story. Enter the name of the desired story, or select it from the list.

Open a website or email
Open a specified website or email client. Enter the URL to navigate to. Optionally, select Open in
same window to have the website or email client open in the same window.

Generate on-demand app
Creates an on-demand app based on the current selection. You must select an on-demand app
navigation link . The status of the app is displayed as the app is created.

Styling the button
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Adding an icon
You can add an icon to the button under Appearance > Icon. Choose from a number of preset
options.

Customizing the text
You can set the text for the title, subtitle, and footnote under Appearance > General. To hide these
elements, switch the Show titles setting to off.

Additionally, you can set the text for the button Label.

You can style the text that appears in the chart.

Gehen Sie folgendermaßen vor:

1. Under Appearance > Presentation, click Styling.

2. On the General tab, set the font, emphasis style, font size, and color for the following text
elements:

l Title
l Subtitle
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l Footnote
3. On the Chart tab, set the text properties for the button Label. Set the font, emphasis style,

text alignment, font size, and color.
You can also choose from a number of text layout options for this label under Layout
behavior. The following options are available:

l Responsive: You can adjust the font size of the Label, with additional text size
adjustments applied based on button size and text length. Adjustments are made to fit
all text content into the button.

l Fluid: You can adjust the font size of the Label, with additional text size adjustments
applied based on button size only. This re-scaling of the text is independent of text
length. If the text is too long, an ellipsis is inserted at the end.

l Fixed: You can adjust the font size of the Label in pixels. If the text is too long, an
ellipsis is inserted at the end.

Customizing the background
You can customize the general background, as well as the background of the button itself. The
background of each can be set by color and image. Background options can be configured by
expanding Appearance > Presentation in the properties panel, then clicking Styling.

Setting the general background
The general background of the button includes the title area, as well as the chart itself, which is
partially covered by the button itself.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Setting the background of the button
The background of the button includes the portion that the user can click to execute the action.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Chart tab of the styling panel, you can select a background color (single color or
expression), and also set the background to an image from your media library.
When using a background image, you can adjust image sizing and position.
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Adjusting the border of the interactive portion of the button
You can adjust the border of the part of the button the user interacts with to perform intended
action.

Gehen Sie folgendermaßen vor:

1. Under Appearance > Presentation, click Styling.

2. On the Chart tab, under Border, switch the border On to display it on the button.
3. Adjust the corner radius and width.
4. Set the color of the border, either a single color or with an expression.

Customizing the border and shadow of the entire object
You can customize the border and shadow of the entire object in which the button is located. Note
that you can also adjust the border of the clickable button itself.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Disabling and enabling the button
You can set a calculation condition to enable the chart under Enable chart. If the condition is
evaluated to 0, the button is disabled.

Converting from the Button for navigation in the Dashboard bundle
You can convert an existing Button for navigation control into a button. There are some limitations
when you do the conversion.

l The navigation option to switch to edit mode (Switch to edit mode) is not supported.
l The action to select a value and then lock the field (Select a value and lock field) is not

supported. This will be converted into two consecutive actions, Select values in a field and
Lock a specific field.

Registerkarten-Sammelbox
Eine Registerkarten-Sammelbox ist ein Objekt, mit dem Sie Visualisierungen auf
begrenztem Platz hinzufügen können. Sie können die Visualisierungen in der
Registerkarten-Sammelbox auch anhand von Bedingungen anzeigen oder ausblenden.
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Die Registerkarten-Sammelbox ersetzt die vorherige Sammelbox. Die Sammelbox ist im
Dashboard bundle verfügbar. Weitere Informationen finden Sie unter Container (page
430).
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Verwendung
Die Registerkarten-Sammelbox ist hilfreich, wenn Sie in einem Dashboard mit wenig Platz schnell
zwischen verschiedenen Visualisierungen wechseln möchten. Sie können eine Registerkarten-
Sammelbox auch verwenden, wenn Sie verschiedene Visualisierungen auf der Grundlage von
Folgendem anzeigen möchten:

l Welcher Benutzer auf das Diagramm zugreift.
l Wert einer Variablen.
l Die mögliche Anzahl von Werten in einem Feld; dazu wird die Funktion GetPossibleCount()

in der Bedingungsformel verwendet.
Anzeigen verschiedener Diagramme gestützt auf Auswahlen mit einer Registerkarten-
Sammelbox (page 415)

Erstellen einer Registerkarten-Sammelbox
Sie können auf dem Arbeitsblatt, das Sie bearbeiten, eine Registerkarten-Sammelbox erstellen.

Gehen Sie folgendermaßen vor:

1. Ziehen Sie im Extras-Fenster ein Registerkarten-Sammelbox-Objekt auf das Arbeitsblatt.
2. Klicken Sie im Eigenschaftsfenster unter Content (Inhalt) auf Add (Hinzufügen).
3. Wählen Sie eine Master-Visualisierung in Master items aus, oder erstellen Sie eine neue

Visualisierung in Charts.
Alternativ können Sie Inhalte zu Ihrer Registerkarten-Sammelbox hinzufügen, indem Sie die
verfügbaren Visualisierungen von Ihrem Arbeitsblatt oder aus Ihren Master items (Master-
Elementen) direkt in die Registerkarten-Sammelbox ziehen.

4. Ziehen Sie die Diagramme in das Eigenschaftsfenster, um die Reihenfolge der Registerkarten
festzulegen.

Jetzt haben Sie eine Sammelbox mit einer Registerkarte für jede hinzugefügte Visualisierung. Sie
können zwischen den Registerkarten wechseln, um verschiedene Visualisierungen anzuzeigen.

Hinzufügen von Anzeigebedingungen
Sie können Anzeigebedingungen zu den erstellten Registerkarten hinzufügen.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster unter Content (Inhalt) auf das Diagramm, dem Sie eine
Anzeigebedingung hinzufügen möchten.

2. Fügen Sie in Show condition eine Anzeigebedingung für das Diagramm hinzu. In der Regel
verwenden Sie eine If()-Funktion.

3. Fügen Sie eine weitere Anzeigebedingung zu einem anderen Diagramm hinzu.
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Je nach den hinzugefügten Bedingungen werden die Diagramme jetzt angezeigt oder
ausgeblendet. Wenn die Bedingung eines Diagramms „Wahr“ ergibt, wird sie angezeigt; ist
sie „Falsch“, wird sie ausgeblendet.

Ändern der Registerkartenausrichtung
Die Registerkarten können vertikal oder horizontal ausgerichtet werden.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster auf Darstellung > Präsentation
2. Wählen Sie unter Ausrichtung die Position der Registerkarten in der Registerkarten-

Sammelbox aus.

Ändern der aktiven Standardregisterkarte
Standardmäßig wird die erste Registerkarte angezeigt, wenn Sie eine Registerkarten-Sammelbox
anzeigen.Sie können dies im Eigenschaftsfenster ändern.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster auf Darstellung > Präsentation
2. Verwenden Sie das Dropdown-Menü Registerkarte „Standard“, um auszuwählen, welches

Diagramm angezeigt wird, wenn Benutzer ein Arbeitsblatt anzeigen. Im Dropdown-Menü
sind die verfügbaren Diagramme in der gleichen Reihenfolge wie in der Sammelbox
aufgelistet.

3. Damit die neue Registerkarten-Standardeinstellung wirksam wird, schließen und öffnen Sie
den Browser.

Formatieren der Registerkarten-Sammelbox
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.
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Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. Legen Sie auf der Registerkarte Registerkarte die Schriftart, die Schriftgröße und die Farbe
der folgenden Textelemente fest:

l Bezeichnung: Legen Sie das Design der Bezeichnungen auf den Achsen fest.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Anpassen des Rahmens

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Legen Sie unter Rahmen den Rahmenumriss und den Eckradius fest.

Hinzufügen eines Schattens

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Wählen Sie unter Schatten eine Schattengröße und -farbe aus.
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Festlegen der Registerkartenbreite

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Klicken Sie auf Registerkarten.
4. Legen Sie unter Breite die Breite in Prozent oder Pixeln fest.
5. Legen Sie unter Min./Max. die maximale und minimale Größe der Registerkarten fest.

Festlegen der Indikatorfarbe der ausgewählten Registerkarte

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Klicken Sie auf Registerkarten.
4. Wählen Sie unter Indikator aus, ob Sie eine einzelne Farbe oder eine Farbe nach Formel

verwenden möchten.
5. Wenn Sie eine einzelne Farbe verwenden, wählen Sie eine Farbe aus.
6. Wenn Sie eine Formel verwenden, geben Sie eine Formel ein.

Formatieren von Symbolen
Wenn Sie die Option Symbole anzeigen aktivieren, können Sie die Symbole formatieren.

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Klicken Sie auf Registerkarten.
4. Legen Sie unter Symbol die Größe, Farbe und Position von Diagrammsymbolen fest.

Benutzerdefinierte Farben für den Registerkartenhintergrund

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Klicken Sie auf Registerkarten.
4. Wählen Sie unter Hintergrundfarbe die Farben für Registerkarten, ausgewählte

Registerkarten und Registerkarten mit darüber bewegtem Mauszeiger aus. Sie können eine
einzelne Farbe oder eine Farbe nach Formel wählen.
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Erstellen eines Lesezeichens mit einer Registerkarten-Sammelbox
Wenn Sie ein Lesezeichen erstellen, das ein Registerkarten-Sammelbox-Objekt mit Auswahlen
enthält, wird bei Auswahl des Lesezeichens standardmäßig die erste Registerkarte aktiviert. Um
eine andere aktive Standardregisterkarte für die Registerkarten-Sammelbox zu speichern, können
Sie Layout speichern aktivieren, wenn Sie das Lesezeichen erstellen, während diese Registerkarte
geöffnet ist. Wenn Sie das Lesezeichen als Standardlesezeichen festlegen, indem Sie mit der
rechten Maustaste darauf klicken und Als Standardlesezeichen festlegen auswählen, wird das
Arbeitsblatt mit den Auswahlen und der Registerkarte geöffnet, die bei Erstellung des Lesezeichens
aktiv waren.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Symbolleiste auf .

2. Klicken Sie auf Neues Lesezeichen erstellen.
Ändern Sie bei Bedarf den Namen und die Beschreibung.

3. Wenn Sie eine andere als die Standardregisterkarte als aktive Registerkarte festlegen
möchten, aktivieren Sie Layout speichern, wenn diese Registerkarte geöffnet ist. Dadurch
wird die Einstellung für die Registerkarte „Standard“ im Eigenschaftsfenster überschrieben.

4. Klicken Sie auf Speichern.

Anzeigebeschränkungen
l Sie können keine Master-Visualisierung verwenden, die eine Registerkarten-Sammelbox in

einer weiteren Sammelbox enthält.
l Sie können die gleiche Master-Visualisierung nicht zweimal zu einer Registerkarten-

Sammelbox hinzufügen.
l Sie können ein Diagramm nicht innerhalb einer Registerkarten-Sammelbox erstellen, indem

Sie Kennzahlen oder Dimensionen in der Sammelbox ablegen.

Anzeigen verschiedener Diagramme gestützt auf Auswahlen mit einer
Registerkarten-Sammelbox
Dieses Beispiel zeigt, wie verschiedene Diagramminhalte gestützt auf
Benutzerauswahlen unter Verwendung einer Registerkarten-Sammelbox angezeigt
werden.

l Wenn eine einzelne Produktgruppe ausgewählt ist, wird ein Diagramm für
Produktuntergruppen angezeigt.

l Wenn mehr als eine Produktgruppe ausgewählt ist, wird ein Diagramm für Produktgruppen
angezeigt.
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Datensatz
In diesem Beispiel werden zwei Datendateien aus Qlik Sense Tutorial - Aufbau einer App
verwendet. Um die Dateien herunterzuladen, gehen Sie zu Tutorial - Aufbau einer App. Laden Sie
das Tutorial herunter und entzippen Sie die enthaltenen Ordner. Suchen Sie folgende Dateien im
Ordner Tutorials source:

l Sales.xls
l Item master.xls

Erstellen Sie eine neue App und fügen Sie die beiden Datendateien hinzu. Vergewissern Sie sich,
dass sie über Elementnummer verknüpft sind.

Der Datensatz, der geladen wird, enthält Umsatzdaten. Die Tabelle in der Datei Item master.xls
enthält die Informationen über die bestellten Artikel, beispielsweise Produktgruppen.

Kennzahlen
Es müssen zwei Kennzahlen in Master-Elemente erstellt werden:

l Umsatzvolumen: mit dem Namen Sales und der Formel Sum(Sales).
l Umsatzmarge in Prozent: mit dem Namen Margin % und der Formel Avg(Margin/Sales)*100.

Visualisierungen
Es werden zwei verschiedene Master-Visualisierungen benötigt, die auf den
Produktgruppenauswahlen basieren. Eine von ihnen enthält die Produktgruppe als Dimension, die
andere die Produktuntergruppe als Dimension.

Produktgruppen-Visualisierung
Diese Visualisierung soll angezeigt werden, wenn mehr als eine Produktgruppe ausgewählt ist.

Wir fügen dem Arbeitsblatt ein Kombi-Diagramm hinzu und legen die folgenden
Dateneigenschaften fest:

l Dimension: Product Group (Produktgruppe).
l Kennzahl: Sales (die von Ihnen erstellte Master-Kennzahl).

Das folgende Diagramm wird erstellt. Die einzelnen Balken zeigen die Umsätze für jede
Produktgruppe an. Zu diesem Zeitpunkt handelt es sich um ein Balkendiagramm.
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Zudem soll aber die Umsatzmarge angezeigt werden, die eine andere Skala als das Umsatzvolumen
hat. Das Umsatzvolumen ist in Millionen angegeben, während die Marge ein Prozentsatz zwischen
0 und 100 ist. Wenn die Marge als Balken neben dem Umsatzvolumen hinzugefügt wird, ist der
Balken zu klein, um erkennbar zu sein.

Gehen Sie im Eigenschaftsfenster zu Kennzahlen > Linienhöhe. Verwenden Sie die Dropdownliste,
um Margin % als Kennzahl hinzuzufügen.

Produktuntergruppen-Visualisierung
Diese Visualisierung soll angezeigt werden, wenn eine einzelne Produktgruppe ausgewählt ist.

Kopieren Sie die Produktgruppen-Visualisierung und ändern Sie die Dimension zu Product Sub
Group.
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Master-Visualisierungen
Sie müssen zwei Master-Visualisierungen erstellen, die in der Registerkarten-Sammelbox
verwendet werden sollen.

l Fügen Sie die Produktgruppen-Visualisierung als Master-Visualisierung mit dem Namen
Product Group - sales and margin hinzu.

l Fügen Sie die Produktuntergruppen-Visualisierung als Master-Visualisierung mit dem Namen
Product Sub Group - sales and margin hinzu.

Jetzt können Sie die beiden zuvor erstellten Visualisierungen löschen; sie sind als Master-
Visualisierungen gespeichert.

Registerkarten-Sammelbox
Sie müssen eine Registerkarten-Sammelbox zum Arbeitsblatt hinzufügen. Fügen Sie die beiden
Visualisierungen zur Registerkarten-Sammelbox hinzu.

l Product Group - sales and margin
Anzeigebedingung auf =GetPossibleCount([Product Group])>1 festlegen

l Product Sub Group - sales and margin
Anzeigebedingung auf =GetPossibleCount([Product Group])=1 festlegen

Sie können die Auswahlregisterkarten der Registerkarten-Sammelbox auch unter
Darstellung>Sammelbox>Registerkarten ausblenden.

Um die Funktionsweise zu zeigen, können Sie ein Filterfenster mit Product Group hinzufügen.

Entdecken
Jetzt können Sie Auswahlen in Product Group vornehmen. Wenn eine einzelne Produktgruppe
ausgewählt ist, zeigt das Diagramm Daten für Produktuntergruppen dieser Produktgruppe an.
Andernfalls zeigt das Diagramm Daten für Produktgruppen an.

Reference lines
A reference line is a line intersecting the chart area from a given point on the measure
axis.

For information about how to create reference lines, see Adding reference lines to visualizations
(page 623).
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You can use a reference line to indicate a certain level of chart data. The reference line is only
drawn if it falls within the current range of the measure axis. You can have several reference lines in
the same chart.

Bar chart Top 5 customers with a reference line at 5M.

Reference lines are available in the following visualization types:

l Bar chart
l Box plot
l Combo chart
l Distribution plot
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l Gauge
l Histogram
l Line chart
l Scatter plot
l Waterfall chart

Reference line expression
You can either set the reference line expression to an absolute numeric value, or enter an arbitrary
numeric expression.

Dimensional reference lines
You can also add reference lines along the dimension axis. Both continuous and discrete axes are
supported. It is possible to enter text values for discrete dimensional axes, and numerical values or
expressions for continuous axes. On a time axis it is possible to enter an expression that gives a
time-based result like a date or a month.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 420



3   Visualizations

Line chart average sales per month, with a reference line at 3.5k and a dimensional reference line in
September.

Dimensional reference lines are available in the following visualization types:

l Bar chart
l Combo chart
l Line chart

Creating custom tooltips
Create a custom tooltip to add extra information to a visualization. You can include
measures a master visualization chart or an image. Tooltips display when you hover
over a visualization.
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Custom tooltip over a pie chart slice
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Custom tooltips are available with the following visualization types:

l Bar chart
l Bullet chart
l Combo chart
l KPI
l Line chart
l Map
l Pie chart
l Scatter plot
l Treemap

Creating a custom tooltip
Tooltips can contain measures, a chart, or an image. Add a measure from a field or using an
expression. Select a chart from the master visualizations available in the app. Choose an image
from the media library or by URL. You can also hide the basic rows that appear in a tooltip by
default.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Select the chart to edit.
3. In the properties panel, click Appearance, and then click Tooltip.
4. Set the toggle to Custom.
5. Optionally, enter a Title and Description for the tooltip.

Click to use the expression editor if you need to add more than 512 characters.

You can remove basic tooltip rows that appear by default by clicking Hide basic
rows.

6. If you want to add a measure, under Measures, click Add measure. Select a measure from a
field using From a field, or use an expression. The existing expression displays by default, or
you can create a custom expression. Klicken Sie zum Öffnen des Formel-Editors auf . You
can change the label of the tooltip using Label as well as its formatting using Number
formatting.

7. If you want to add a chart, under Chart, click Add chart.
l From the Master items list, select the master visualization to add to the tooltip.
l Under Chart size, select the size of the chart container in the tooltip.

l Small. Sets the width and height of the container to 140 pixels.
l Medium. Sets the width and height of the container to 200 pixels.
l Large. Sets the width and height of the container to 340 pixels.
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After you add the chart, you can edit it by clicking Edit master item. See
Editing a master visualization (page 120).

8. If you want to add an image, under Images, Click Add an image.
l  Under Type, select whether to add the image from your Media library or from a URL.

l Media library: Select the image from the media library.
l URL: Enter a URL.

l Under Size, select the size of the image container in the tooltip.
l Small. Sets the width and height of the container to 50 pixels.
l Medium. Sets the width and height of the container to 200 pixels.
l Large. Sets the width and height of the container to 340 pixels.
l Original. Qlik Sense fits the image into the container. If the image is larger than

340 pixels, it is scaled down.

Limitations
Custom tooltips have the following general limitations:

l Benutzerdefinierte Quickinfos sind für ein Balken- oder Liniendiagramm deaktiviert, wenn
eine der Dimensionen im Diagramm eine Anzeigebedingung verwendet.

Limitations of charts in custom tooltips
Charts have the following limitations with custom tooltips:

l Charts will not appear in custom tooltips when selecting visualizations on touch devices.
l Treemap chart must have only one dimension to use the chart in a custom tooltip.
l Chart in tooltip is not supported in Storytelling.
l Using container and trellis container charts inside a custom tooltip is not supported.

Null Werte in Visualisierungen
Manchmal fehlen Daten oder können nicht berechnet werden, weil die Felder Werte enthalten, die
null oder not a number (NaN) sind. In den Visualisierungen werden null- und NaN-Werte auf
unterschiedliche Weise angezeigt, entsprechend der folgenden Tabelle.

Visualisierungstyp
Null-Werte in
Dimensionen

NaN-Werte in Kennzahlen

Balkendiagramm – – (wenn Bezeichnungen im Eigenschaftsfenster
aktiviert sind, ansonsten leer)

Boxplot – Keine Darstellung

Kombi-Diagramm – Eine Kombination des NaN-Werts für den Balken
und die Linie.

Darstellung von Null- und NaN-Werten

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 424



3   Visualizations

Visualisierungstyp
Null-Werte in
Dimensionen

NaN-Werte in Kennzahlen

Verteilungsdiagramm – Keine Darstellung

Filterfenster Keine Darstellung n. v.

Messzeiger n. v. –

Histogramm – Keine Darstellung

KPI n. v. –

Liniendiagramm – Leer

Karte Keine Darstellung Grau

Kreisdiagramm – Leer

Punktdiagramm – Leer

Tabelle – –

Text und Bild n. v. –

Baumkarte – Leer

Dashboard bundle
Dashboard bundle is a set of controls that you can use to enhance navigation and
selection in your Qlik Sense app. The controls are optional. You do not have to install or
enable them to use Qlik Sense.

Enabling Dashboard bundle
You can install the Dashboard bundle when you install Qlik Sense. If you need to adjust your
installation, see: Modifying an object bundles installation.

Dashboard bundle controls
Dashboard controls are in the asset panel under Custom objects.

The following controls are included:

l Animator (page 428)
You can animate changes in your visualizations over a period of time.

l Container (page 430)
Add multiple visualizations to a container to save space.

l Date range picker (page 436)
You can select a single date or a range of dates from a calendar.

l Layout containers allow you to add visualizations in a limited space. You can also show or
hide the visualizations inside the layout container based on conditions. (page 443)
Add and arrange visualizations in a container.

l Add lines to your sheets with the Line control. (page 439)
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Add vertical and horizontal lines to a sheet.
l On-Demand-Berichtssteuerelement (page 446)

You can add a button that creates a Qlik NPrinting report using the current selections in the
app.

l Text objects complements other visualizations by offering options to add text, hyperlinks,
and measures. You can also add background images. (page 451)
A text object allows app developers to create and format text.

l Variable input control (page 455)
You can set the value of a variable.

l Video player (page 458)
You can add a video to your sheet.

Deprecated controls
These controls have been deprecated by the addition of a native control. Unless otherwise stated,
existing instances of these controls will still function. However, new instances cannot be added. We
recommend that you replace deprecated controls with the native control.

Share button control
If you need to configure existing instances of this control, please refer to the last version of the help
before deprecation.

Show/hide container
Deprecated by Container.

If you need to configure existing instances of this control, please refer to the last version of the help
before deprecation.

Tabbed container
Deprecated by Tab container.

If you need to configure existing instances of this control, please refer to the last version of the help
before deprecation.

Navigation button
Deprecated by Button.

If you need to configure existing instances of this control, please refer to the last version of the help
before deprecation.

NL Insights
Deprecated by native NL insights object. Existing instances may need to be migrated manually.

Limitations
When you use objects from Dashboard bundle there are some limitations compared to built-in
controls. The following limitations are valid for all controls from Dashboard bundle:
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l The user interface of the visualization is not localized to the language that Qlik Sense is
using.

l Right-to-left reading order is not supported.
l Accessibility features are not supported.
l It is not possible to edit objects from an object bundle supplied by Qlik with Dev Hub.

The following table shows which additional features are supported, or not supported, for all
bundled objects:

l Qlik NPrinting
There is an On-Demand-Berichtssteuerelement (page 446). However, visualizations made in
some objects cannot be used in Qlik NPrinting reports.
On-Demand-Berichtssteuerungen werden auf Mobilgeräten nicht unterstützt. Eine On-
Demand-Berichtssteuerungs-Schaltfläche funktioniert nur, wenn von einem PC aus darauf
zugegriffen wird.

l Download
Downloading as image, PDF, or Excel.

l Storytelling
Using a snapshot of a visualization created with an object in a story.

l Alternate states
Making different selections on the same dimension and comparing the selections in a single
visualization or in two or more visualizations side by side.

l Qlik Sense Client-Managed Mobile offline

Control
Qlik
NPrinting

Download Storytelling
Alternate
states

Qlik Sense Client-
Managed Mobile
offline

Animator Not
applicable

Excel only Not applicable Yes Yes

Date picker Not
applicable

Not
applicable

Not applicable Yes Yes

Layout
container

Yes Image and
PDF only

Yes Yes Not applicable

Line Not
applicable

Image and
PDF only

Yes Yes Yes

On-demand
reporting

Yes Not
applicable

Not applicable Not
applicable

Not applicable

Text Yes Yes Yes Yes Yes

Variable
input

Not
applicable

Not
applicable

Not applicable Not
applicable

Yes

Video player Not
applicable

Not
applicable

Yes Yes Not applicable

Dashboard bundle capability support
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Animator
The animator control animates the changes in values in your visualizations over a range
of values. For example, you could view changes in your visualizations over a period of
time. It is included in the Dashboard bundle.

The animator control adds a button and progress slider to the sheet. When pressed, animator
cycles through the values of its dimension. Users can use the slider to manually pick values from
the dimension to display.

Animator

When to use it
The animator is useful when you want to see your visualizations change over a specified range,
such as over a period of time. For example, you could use the animator control to view how
visualizations in your sheet change month to month over a period of a year. Animator can be used
to animate any dimension values. You could, for example, animate how your sales visualizations
change city to city by selecting a dimension containing city vales to use with animator.

The selections animator makes while running through values are applied to your current selections.

Creating animators
You can create an animator on the sheet you are editing. The dimension you select to use with
animator contains the range of values you want animated. By default, every value in the dimension
will be used as a step. You can customize the number of steps used in the animation as well as how
quickly animator moves between steps. Animator runs through dimension values by the order in
Sorting.

Gehen Sie folgendermaßen vor:

1. In the assets panel, open Custom objects > Dashboard bundle and drag a Animator object
to the sheet.

2. Select a field to add as the dimension.

Once you have created the animator, you may want to adjust its animation options and other
settings.

Setting animator options
Animator options are set in Animator Options in the Properties pane.
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You can control how fast an animator transitions between values in the selected dimension in Time
Between Steps. Time Between Steps requires values be set in milliseconds.

It is not recommended to set Time Between Steps lower than 300 milliseconds.

You can set the total steps the animator runs through in Total Steps. The animator will divide the
total steps evenly across the dimension values. For example, if there are 10 values in the time
dimension selected and Total Steps is set to 5, animator will go to values 2, 4, 6, 8, 10). If Total
Steps is set to 0, the animator will use every value.

If you want the animation to show the total building over time for your selected values, select
Aggregate. When Aggregate is selected, each step is aggregated to the previous step.

By default, the animator will run through steps in a loop. You can control this with the Loop option.

You can control whether or not the dimension and current value displays in the animator as it runs
with Show Dimension Label and Show Dimension Value.

Customizing styling
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart. Sie

können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
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l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
Animator has the following limitations:

l Animator does not support drill-down dimensions as the dimension.
l Animator does not support animating trellis charts.

Container
The container is an object that lets you add visualizations in a limited space. You can
also show or hide the visualizations inside the container based on conditions.

The container has been replaced by the tab container. For more information,
see Registerkarten-Sammelbox (page 409).
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When to use it
The container is useful when you want to quickly switch between different visualizations on a
dashboard with limited space. You can also use a container to show different visualizations based
on:

l Which user is accessing the chart.
l The value of a variable.
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l The possible number of values in a field by using the GetPossibleCount() function in the
condition expression.
Anzeigen verschiedener Diagramme gestützt auf Auswahlen mit einer Registerkarten-
Sammelbox (page 415)

Creating a container
You can create a container on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. In the assets panel, open Custom objects > Dashboard bundle and drag a Container object
to the sheet.

2. Click Add under Content in the properties panel.
3. Select a master visualization in Master items, or create a new visualization in Charts.

Alternatively: you can add content to your container by dragging available visualizations from
your sheet, or from your Master items, directly on the container.

4. Drag the charts in the property panel to set the tab order.

You now have a container with a tab for each visualization you added. You can switch between tabs
to show different visualizations.

Adding show conditions
You can add show conditions on the tabs you have created.

Gehen Sie folgendermaßen vor:

1. Click on the chart you want to add a show condition to, under Content in the property panel.
2. Add a show condition for the chart in Show condition. Typically you would use an If()

function.
3. Add another show condition to a different chart.

The charts will now be shown or hidden depending on the result of the conditions you added.
If the condition of a chart results in True, it is shown, and if it is False, it is hidden.

Changing the default active tab
By default, the first tab is displayed when you view a container. You can change this in the property
panel.

Gehen Sie folgendermaßen vor:

1. Go to Appearance > Container in the property panel.
2. Use the Default tab dropdown to select which chart displays when users view a sheet. The

dropdown lists the available charts in the same order they are arranged in the container.
3. If you want to see the new default tab setting take effect, close and re-open your browser.
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Creating a bookmark with a container object
By default, if you create a bookmark that contains a container object with selections, the first tab
will be active when the bookmark is selected. To save a different default active tab for the
container, you can toggle on Save layout when creating the bookmark with that tab open. If you set
that bookmark as the default bookmark by right-clicking and selecting Set as default bookmark in
the bookmark list, the sheet will open to the selections and tab that were active when the bookmark
was created.

Gehen Sie folgendermaßen vor:

1. Click in the toolbar.

2. Click Create new bookmark.
Change the name and description, if desired.

3. If you want a tab other than the default tab to be the active tab, toggle on Save layout with
that tab open. This will override the Default tab setting in the property panel.

4. Click Save.

Display limitations
l You cannot use a master visualization that has a container inside another container.
l You cannot add the same master visualization twice in a container.
l You cannot create a chart inside a container by dropping measures or dimensions on the

container.

Anzeigen verschiedener Diagramme gestützt auf Auswahlen mit einer Sammelbox
Dieses Beispiel zeigt, wie verschiedene Diagramminhalte gestützt auf
Benutzerauswahlen unter Verwendung einer Sammelbox angezeigt werden.

l Wenn eine einzelne Produktgruppe ausgewählt ist, wird ein Diagramm für
Produktuntergruppen angezeigt.

l Wenn mehr als eine Produktgruppe ausgewählt ist, wird ein Diagramm für Produktgruppen
angezeigt.

Datensatz
In diesem Beispiel werden zwei Datendateien aus Qlik Sense Tutorial - Aufbau einer App
verwendet. Um die Dateien herunterzuladen, gehen Sie zu Tutorial - Aufbau einer App. Laden Sie
das Tutorial herunter und entzippen Sie die enthaltenen Ordner. Suchen Sie folgende Dateien im
Ordner Tutorials source:

l Sales.xls
l Item master.xls

Erstellen Sie eine neue App und fügen Sie die beiden Datendateien hinzu. Vergewissern Sie sich,
dass sie über Elementnummer verknüpft sind.

Der Datensatz, der geladen wird, enthält Umsatzdaten. Die Tabelle in der Datei Item master.xls
enthält die Informationen über die bestellten Artikel, beispielsweise Produktgruppen.
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Kennzahlen
Es müssen zwei Kennzahlen in Master-Elemente erstellt werden:

l Umsatzvolumen: mit dem Namen Sales und der Formel Sum(Sales).
l Umsatzmarge in Prozent: mit dem Namen Margin % und der Formel Avg(Margin/Sales)*100.

Visualisierungen
Es werden zwei verschiedene Master-Visualisierungen benötigt, die auf den
Produktgruppenauswahlen basieren. Eine von ihnen enthält die Produktgruppe als Dimension, die
andere die Produktuntergruppe als Dimension.

Produktgruppen-Visualisierung
Diese Visualisierung soll angezeigt werden, wenn mehr als eine Produktgruppe ausgewählt ist.

Wir fügen dem Arbeitsblatt ein Kombi-Diagramm hinzu und legen die folgenden
Dateneigenschaften fest:

l Dimension: Product Group (Produktgruppe).
l Kennzahl: Sales (die von Ihnen erstellte Master-Kennzahl).

Das folgende Diagramm wird erstellt. Die einzelnen Balken zeigen die Umsätze für jede
Produktgruppe an. Zu diesem Zeitpunkt handelt es sich um ein Balkendiagramm.

Zudem soll aber die Umsatzmarge angezeigt werden, die eine andere Skala als das Umsatzvolumen
hat. Das Umsatzvolumen ist in Millionen angegeben, während die Marge ein Prozentsatz zwischen
0 und 100 ist. Wenn die Marge als Balken neben dem Umsatzvolumen hinzugefügt wird, ist der
Balken zu klein, um erkennbar zu sein.

Gehen Sie im Eigenschaftsfenster zu Kennzahlen > Linienhöhe. Verwenden Sie die Dropdownliste,
um Margin % als Kennzahl hinzuzufügen.
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Produktuntergruppen-Visualisierung
Diese Visualisierung soll angezeigt werden, wenn eine einzelne Produktgruppe ausgewählt ist.

Kopieren Sie die Produktgruppen-Visualisierung und ändern Sie die Dimension zu Product Sub
Group.

Master-Visualisierungen
Sie müssen zwei Master-Visualisierungen erstellen, die in der Sammelbox verwendet werden
sollen.

l Fügen Sie die Produktgruppen-Visualisierung als Master-Visualisierung mit dem Namen
Product Group - sales and margin hinzu.

l Fügen Sie die Produktuntergruppen-Visualisierung als Master-Visualisierung mit dem Namen
Product Sub Group - sales and margin hinzu.

Jetzt können Sie die beiden zuvor erstellten Visualisierungen löschen; sie sind als Master-
Visualisierungen gespeichert.

Sammelbox
Sie müssen eine Sammelbox zum Arbeitsblatt hinzufügen. Fügen Sie die beiden Visualisierungen
zur Sammelbox hinzu.

l Product Group - sales and margin
Anzeigebedingung auf =GetPossibleCount([Product Group])>1 festlegen

l Product Sub Group - sales and margin
Anzeigebedingung auf =GetPossibleCount([Product Group])=1 festlegen

Sie können die Auswahlregisterkarten der Sammelbox auch unter
Darstellung>Sammelbox>Registerkarten ausblenden.
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Um die Funktionsweise zu zeigen, können Sie ein Filterfenster mit Product Group hinzufügen.

Entdecken
Jetzt können Sie Auswahlen in Product Group vornehmen. Wenn eine einzelne Produktgruppe
ausgewählt ist, zeigt das Diagramm Daten für Produktuntergruppen dieser Produktgruppe an.
Andernfalls zeigt das Diagramm Daten für Produktgruppen an.

Date range picker
The date range picker (Date picker) lets you select a single date or a range of dates
from a calendar. It is included in Dashboard bundle.

Date picker has two modes:

l In single date mode, you select from a simple calendar.
l In date interval mode, you can select a range from the calendar, or any of the predefined

ranges that are available.

Dates associated to data appear in black in the calendar. Dates with no associated data appear in
grey. Users can select any date.

When to use it
The date range picker is useful when you have one or more date fields that you need to use to filter
your selections. Unlike a filter pane, a date range picker will only display date fields.

Creating a date range picker
You can create a date range picker on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. In the assets panel, open Custom objects > Dashboard bundle and drag a Date picker
object to the sheet.

2. Select the date field to use as filter in Date field.
The list contains only fields that are recognized as a date field by Qlik Sense.

If you want to use a timestamp field, you need to convert it to a date. Use the
expression =date(floor(myTimeStamp_Field)) instead of myTimeStamp_Field.

3. Select if you want to be able to pick a single date or a date interval in Single date / interval.
Date interval lets you pick a range of dates.
Single date lets you pick a single date only.

When you have created the date range picker, you may want to adjust its appearance and other
settings.
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Setting the available date range
You can set the range of dates available to pick by setting the option Advanced setup to On. You
can use expressions or explicit date values. The expressions used below refer to a field named
DateField.

l Set the first date of the calendar with Min date.
Default value is =Min( {1} [DateField]). This expression returns the first date in DateField in
the full data set.

l Set the last date of the calendar with Max date.
Default value is =Max( {1} [DateField]). This expression returns the last date in DateField in
the full data set.

l Set the date to show when the date range picker is opened with Start date.
Default value is =Min([DateField]). This expression returns the first date in DateField in the
current selection.

Setting locale of the calendar
You can set the locale of the calendar to get local names for days and months. Change the setting
Locale under Calendar Settings > Language and labels to the two-letter code of the locale you
want to use. For example, you can change the default value of en for English to de for German.

Using predefined ranges
In date interval mode there are a number of predefined ranges available to pick if Show predefined
ranges is set to On. You can customize the text labels for the predefined range selections with the
settings under Calendar Settings > Predefined ranges:

l Custom Range represents the option where you select a date interval freely from the
calendar. Default value is Range.

l Today represents the date value of today. Default value is Today.
l Yesterday represents the date value of yesterday. Default value is Yesterday.
l Last $ days represents the two options for showing the last 7 or 30 days. $ is replaced by 7

or 30 in the string. Default value is Last $ days.
l This represents the current period. By default Month is selected. You can select:

l Day
l Month
l Quarter
l Year
l None

l Last represents the previous period. By default Month is selected. You can select:
l Day
l Month
l Quarter
l Year
l None
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You can specify how many of the previous periods to include in Last number of.
You can include the current period by selecting Include current.

Customizing text labels
You can customize the text labels that are shown when the date range picker is used.

You change the text prompt shown when the date range picker is minimized with the setting
Default Text under Calendar Settings > Language and labels. The default setting is 'Select date
range'.

Customizing styling
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart. Sie

können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
The date range picker cannot filter date ranges greater than 28 years or that contain 10,000 or
more values. If your date range contains a large number of dates, use another object such as a line
chart.

For information about general limitations, see Limitations (page 426).

Line
Add lines to your sheets with the Line control.
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With Line controls, you can add vertical and horizontal lines to your sheets. They can be dotted or
solid.

Line in a sheet dividing visualizations
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When to use it
The Line control is useful for helping to group or divide sheet objects, as well as decorating sheets
to help improve visual appeal.

Creating lines

Gehen Sie folgendermaßen vor:

1. In the advanced edit mode assets panel, open Custom objects > Dashboard bundle and
drag Line to the sheet.

2. Adjust the Line on the grid.
3. In the properties panel, in Presentation under Orientation, select Vertical or Horizontal.
4. Under Alignment, select:

1. Leading: Line is placed to the left (vertical orientation) or top (horizontal orientation) of
Line on the grid.

2. Center: Line is placed in the center of Line on the grid.
3. Trailing: Line is placed to the right or bottom of Line on the grid.

5. Under Stroke, set the following line styling options.
l Color: Select the color of the line.
l Width: Set the width of the line.
l Dash: Set whether the line is solid or dashed. If the line is dashed, the following

options are available:
l Dash length: Set the length of dashes in the line.
l Dash spacing: Set the gap between dashes in the line.

6. Optionally, to add a title, subtitle, or footnote, under General, select Show titles.

Styling Line controls
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart.
The styling panel contains various sections under the General tab. You can reset your styles by
clicking next to each section.

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
Line has the following limitations:

l You cannot connect the lines in separate Line controls together. If you want to have
intersecting lines in your sheet, consider using a background image with the lines on the
sheet instead.
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Layout container
Layout containers allow you to add visualizations in a limited space. You can also show
or hide the visualizations inside the layout container based on conditions.

Layout container

A layout container can hold a range of visualizations while occupying a small amount of space on a
sheet. When expanded to full sheet, each chart expands as well.

When to use it
The layout container is useful when you want to build a custom display containing multiple charts as
a single unit. Unlike the container, which uses tabs to cycle through charts, the layout container is a
space where you are free to customize your own layout of the charts in the layout container. As the
layout container offers sheet-like arrangement of visualizations, you can functionally store multiple
sheets within a sheet that can be expanded for more detail.

You can place visualizations on top of one another. You can use conditions in the layout container
to control which visualizations display. For example, you could show visualizations based on:

l Which user is accessing the chart.
l The value of a variable.

As a best practice, be aware the more visualizations that are added to a container, the longer is can
take to display visualizations. Too may objects in a layout container might overwhelm the user and
make the app slower to render visualizations.
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Creating a container
You can create a container on the sheet you are editing.

Gehen Sie folgendermaßen vor:

l In the advanced edit mode assets panel, open Custom objects > Dashboard bundle and
drag Layout container to the sheet.

You now have a layout container. You can start adding and configuring charts to your layout
container.

Adding charts to a layout container

You can copy and paste charts in and out of the layout container, but you must use the
right-click context menu.

Gehen Sie folgendermaßen vor:

1. Select a layout container.
2. Click Add under Content in the properties panel.

Alternatively, click Add content in the layout container.
3. Select a visualization in Charts.
4. Click Add dimension and Add measure to add data to the chart.
5. To resize the chart, do one of the following:

l Click and drag the corners or edge of the chart.
l In properties, enter the width and height of the chart in percent.

6. To reposition the chart, do one of the following:
l Click and drag the chart into position.
l In properties, enter the x-axis and y-axis positions of the chart, in percent.

To show grid lines for layout, in properties, under Presentation > Styling, turn on Show grid
lines. You can also set the number of rows and columns in the grid, and snap visualizations to
the grid lines.
To keep charts within the borders of the layout container, under Presentation > Styling, turn
on Keep charts within bounds.

7. To reorder the layers of visualizations in the layout container, right-click on the visualization
in the layout container, select Reorder chat layers, and choose to bring the visualization
forward or back. Alternatively, click and drag the visualizations in the properties panel.

8. To configure the chart with all properties available for that chart type, click Edit properties.
9. Repeat for any additional charts you want to add to the layout container.

Adding show conditions
You can add show conditions on the tabs you have created.
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Gehen Sie folgendermaßen vor:

1. Click on the chart you want to add a show condition to, under Content in the property panel.
2. Add a show condition for the chart in Show condition. Typically you would use an If()

function.
3. Add another show condition to a different chart.

The charts will now be shown or hidden depending on the result of the conditions you added.
If the condition of a chart results in True, it is shown, and if it is False, it is hidden.

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
Layout containers have the following limitations:

l You cannot create a chart inside a layout container by dropping measures or dimensions on
the container.

l You cannot add a container, trellis container, or layout container inside a layout container.
l Keyboard shortcuts are not supported for copying and pasting charts in a layout container.

On-Demand-Berichtssteuerelement
Mit dem On-Demand-Berichtssteuerelement wird eine Schaltfläche hinzugefügt, um
Qlik NPrinting On-Demand-Berichte zu erstellen. Es ist im Dashboard bundle enthalten.

Voraussetzungen
l Qlik NPrinting Server (September 2019 oder höher) mit einer Qlik NPrinting App, die mit der

Qlik Sense App verbunden ist, die Sie designen. Diese Qlik NPrinting App enthält Ihre
Berichtsvorlagen.

l Alle Benutzer, die On-Demand-Berichte generieren, müssen als Benutzer in Qlik NPrinting mit
einer Sicherheitsrolle hinzugefügt werden, die die Ausführung von On-Demand-Berichten
unterstützt.

l Benutzer müssen über NTML-Authentifizierung (Windows) bei Qlik Sense angemeldet sein,
um Berichte oder Berichtsschaltflächen erstellen zu können.

Verwendung
Das On-Demand-Berichtssteuerelement ist hilfreich, wenn Benutzer in der Lage sein sollen,
vordefinierte Qlik NPrinting Berichte in Qlik Sense zu drucken und dafür ihre Auswahlen in der App
als Filter zu verwenden.

Installieren von Dashboard bundle
Sie können das Dashboard bundle installieren, wenn Sie Qlik Sense installieren.

Sie können Objekt-Bundles jederzeit zu Ihrer Qlik Sense Bereitstellung hinzufügen oder daraus
entfernen. Wenn Sie eine Installation mit mehreren Knoten haben, werden Objekt-Bundles auf dem
zentralen Knoten installiert.
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Im Abschnitt Erweiterungen in der Qlik Management Console (QMC) können Sie sehen,
welche Erweiterungen in Ihrer Bereitstellung installiert sind.

Gehen Sie folgendermaßen vor:

1. Wählen Sie in der Windows-Systemsteuerung die Option Programme und Funktionen.
2. Doppelklicken Sie in der Liste der Programme auf das Objekt-Bundle, das Sie ändern

möchten.

3. Der Assistent für die Einrichtung von Objekt-Bundles wird geöffnet. Klicken Sie auf Weiter.
4. Wählen Sie Ändern aus.
5. Klicken Sie auf dem Bildschirm Benutzerdefinierte Einrichtung auf das Bundle-Symbol, um

auszuwählen, wie die Bundle-Installation geändert werden soll:
o Wenn das Bundle installiert ist, wählen Sie Gesamte Funktion ist nicht mehr

verfügbar, um es zu deinstallieren.
o Wenn das Bundle nicht installiert ist, wählen Sie Gesamte Funktion ist wird auf

lokaler Festplatte installiert, um es zu installieren.
Klicken Sie dann auf Weiter.

6. Klicken Sie auf Ändern.
Nachdem die Änderung abgeschlossen ist, müssen Sie den Qlik Sense Repository Service
manuell neu starten.

7. Klicken Sie auf Fertig stellen, um den Assistenten für die Einrichtung von Objekt-Bundles zu
schließen.

8. Starten Sie den Qlik Sense Repository Service manuell neu, um die Änderungen anzuwenden.

Im Abschnitt Erweiterungen in der QMC können Sie überprüfen, ob die Änderungen korrekt
angewendet wurden.

Hinzufügen eines Servers als vertrauenswürdige Herkunft
Wenn Sie On-Demand-Berichte in Qlik Sense oder einem auf QlikView Web Server gehosteten
QlikView AccessPoint erstellen, müssen Sie diese Server als vertrauenswürdige Herkunft in Qlik
Nprinting-Webkonsole hinzufügen.
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Für jeden Serverpfad, der für den Zugriff auf die Qlik Nprinting-Webkonsole verwendet wird,
müssen Sie eine vertrauenswürdige Herkunft hinzufügen. Wenn beispielsweise auf Ihren Server
über eine lokale Domäne, einen gekürzten Host oder voll qualifizierte URLs zugegriffen werden
kann, muss eine vertrauenswürdige Herkunft für jeden dieser Serverpfade hinzugefügt werden.

Wie Sie die Serverpfade in das Feld Adresse der vertrauenswürdigen Herkunft eingeben, hängt von
Ihrer Sicherheitskonfiguration ab.

Konfiguration 1: SSL-Sicherheit ist nicht eingerichtet mit Qlik Nprinting-Webkonsole
Eine vertrauenswürdige Herkunft ist für jeden Serverpfad erforderlich, der für die Anmeldung bei
der Qlik Nprinting-Webkonsole verwendet wird. Beispiel: Wenn Ihr Server qlikserver1 ist und die IP-
Adresse 192.168.0.101 hat, fügen Sie die folgenden vertrauenswürdigen Herkünfte hinzu:

l http://qlikserver1
l http://qlikserver1.domain.local
l http://192.168.0.101

Konfiguration 2: SSL-Sicherheit ist für Qlik Nprinting-Webkonsole und Drittanbieter
eingerichtet
Eine vertrauenswürdige Herkunft ist für jeden Serverpfad erforderlich, der für die Anmeldung bei
der Qlik Nprinting-Webkonsole verwendet wird. URLs müssen HTTPS verwenden. Beispiel: Wenn
Ihr Server qlikserver1 ist und die IP-Adresse 192.168.0.101 hat, fügen Sie die folgenden
vertrauenswürdigen Herkünfte hinzu:

l https://qlikserver1
l https://qlikserver1.domain.local
l https://192.168.0.101

Hinzufügen einer vertrauenswürdigen Herkunft
Gehen Sie folgendermaßen vor:

1. Klicken Sie in Qlik NPrinting auf Admin > Einstellungen.
2. Klicken Sie auf On-Demand-Einstellungen.
3. Klicken Sie auf Vertrauenswürdige Herkunft hinzufügen.
4. Geben Sie nach Name einen Namen für die vertrauenswürdige Herkunft ein.
5. Geben Sie nach Beschreibung eine Beschreibung für die vertrauenswürdige Herkunft ein.
6. Geben Sie nach Adresse die URL für QlikView Server ein.

Die URL darf nur die Basis-URL (Schema und Host) sein. Beispiel: http://qlikserver1 anstelle
von http://qlikserver1/qlikview/index.htm.

7. Klicken Sie auf Erstellen.

Konfigurieren von On-Demand-Einstellungen auf Qlik NPrinting Server
Sie müssen die folgenden Einstellungen auf Ihrem Qlik NPrinting Server konfigurieren:

l Sie benötigen eine Verbindung zu einem QlikView Server oder einem Qlik Sense Server.
QlikView Server und QlikView Cluster-Verbindungen werden mit On-Demand unterstützt.
Lokale Verbindungen werden nicht unterstützt. Siehe: Erstellen von Verbindungen.
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l Wenn Sie eine Verbindung zu einem QlikView Server oder Cluster mit einer QlikView Server-
Extranetlizenz herstellen, müssen die folgenden Optionen beim Konfigurieren der
Verbindung aktiviert sein:

o Verbindung erfordert Authentifizierung
o Section Access für Benutzer auf Berichte anwenden

l Sie müssen Ihre Qlik NPrinting-Berichte für On-Demand aktivieren.
l Sie können die On-Demand-Berichterstellung über Sicherheitsrollen einschränken. Siehe:

Rollenbasierte Sicherheit.

On-Demand ist mit Chrome, Firefox und Explorer kompatibel. Die Ausführung unter
Microsoft Edge ist nicht möglich, weil die Zertifikate nicht heruntergeladen werden.

Aktivieren von Qlik NPrinting-Berichten für On-Demand-Erstellung
Qlik NPrinting-Berichte müssen manuell für On-Demand-Erstellung aktiviert werden. Berichte
müssen dem QlikView Dokument oder der Qlik Sense App zugewiesen werden, mit dem/der Sie On-
Demand-Berichte generieren möchten. On-Demand -Erstellung kann während der Erstellung eines
neuen Berichts aktiviert werden.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in Qlik Nprinting-Webkonsole auf Berichte.
2. Öffnen Sie einen Bericht oder erstellen Sie einen neuen Bericht.
3. Wählen Sie eine App aus der Dropdown-Liste App aus, die mit dem QlikView Dokument oder

der Qlik Sense App verbunden ist, für das/die Sie einen Bericht generieren möchten.

On-Demand -Anforderungen funktionieren nur zusammen mit Berichten, die auf
einer einzelnen Verbindung basieren. MultiDoc-Berichte werden nicht unterstützt.

4. Aktivieren Sie das Kontrollkästchen On-Demand aktivieren.
5. Klicken Sie auf Speichern.

Die Berichtsvorlage ist jetzt verfügbar.

Akzeptieren des Qlik Nprinting-Webkonsole-Zertifikats
Das Zertifikat für die Standardinstallation für Qlik Nprinting-Webkonsole kann von Ihrem Browser
als ungültig registriert werden. Wenn Ihr Browser das Qlik Nprinting-Webkonsole-Zertifikat als
ungültig registriert, müssen Sie das Zertifikat akzeptieren, bevor Sie On-Demand im QlikView
AccessPoint oder in Qlik Sense verwenden können.

Wenn Sie zu einem anderen Browser wechseln oder den Cache Ihres Browsers leeren,
müssen Sie das Qlik NPrinting-Zertifikat erneut akzeptieren. On-Demand funktioniert in
Chrome, Firefox und Explorer. Es kann nicht in Microsoft Edge ausgeführt werden, weil
die Zertifikate nicht heruntergeladen werden können.
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Gehen Sie folgendermaßen vor:

1. Öffnen Sie die Qlik Nprinting-Webkonsole.
2. Gehen Sie abhängig von Ihrem Browser wie folgt vor:

l Gehen Sie weiter zur Qlik Nprinting-Webkonsole.
l Fügen Sie eine Sicherheitsausnahme hinzu und gehen Sie weiter zur Qlik Nprinting-

Webkonsole.
3. Melden Sie sich bei Ihrer Instanz von Qlik Nprinting-Webkonsole an.

Sie können jetzt Qlik NPrintingOn-Demand mit diesem Browser verwenden.

Erstellen einer Schaltfläche zur Erstellung von On-Demand-Berichten
Sie können auf dem Arbeitsblatt, das Sie bearbeiten, eine Schaltfläche zur Erstellung von On-
Demand-Berichten erstellen.

Gehen Sie folgendermaßen vor:

1. Ziehen Sie im Extras-Fenster unter Benutzerdefinierte Objekte > Dashboard bundle On-
demand reporting auf das Arbeitsblatt.

2. Legen Sie im Eigenschaftsfenster unter NPrinting Connection > NPrinting server URL die
Serververbindung fest. Die URL muss mit / enden.
Beispiel: https://<servername>:4993/

3. Wählen Sie unter NPrinting App die Qlik NPrinting App mit der Berichtsvorlage aus.
4. Wählen Sie unter NPrinting connection die Qlik NPrinting Verbindung aus.

Als Standard zeigt die Liste nur Qlik NPrinting Verbindungen mit der Qlik Sense App, in der
Sie arbeiten. Sie können den Schalter App-/Verbindungsfilter verwenden, um
Verbindungen anzuzeigen, die nicht mit der aktuellen Qlik Sense App verknüpft sind.

5. Wählen Sie unter Report Configuration > Choose Report den Bericht aus, der mit der
Schaltfläche verbunden werden soll.

6. Wählen Sie in Default Export Format ein Standardexportformat aus.
7. Legen Sie unter Appearances > Button Label die Schaltflächenbezeichnung fest. Hier ein

Beispiel: Bericht generieren.

Sie haben jetzt eine On-Demand-Berichtsschaltfläche erstellt.

Generieren eines Berichts
Sie können einen Bericht generieren, der gemäß den aktuellen Auswahlen in der Qlik Sense App
gefiltert wird. Sie müssen sich im Analysemodus befinden.

Sie können nur nach Feldern filtern, die in der Qlik NPrinting Berichtsvorlage enthalten
sind. Andernfalls schlägt der Bericht fehl. Es ist nicht möglich, anhand einer Formel nach
Auswahlen zu suchen.
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Gehen Sie folgendermaßen vor:

1. Klicken Sie auf die von Ihnen erstellte Schaltfläche.
Das Dialogfeld Export wird geöffnet.

2. Sie können zwischen zwei Schaltflächen wählen:
a. Schneller Bericht: Generiert einen einzelnen Bericht mit dem

Standardausgabeformat.
b. Neuer Bericht: Wählen Sie aus einer Liste von Berichten, die an Sie bereitgestellt

wurden. Sie können auch das Ausgabeformat wählen.
3. Wenn der Bericht generiert wurde, wird eine Schaltfläche zum Herunterladen aktiviert.

Klicken Sie auf die Schaltfläche Herunterladen, um den Bericht herunterzuladen.

Beschränkungen
Informationen zu allgemeinen Beschränkungen finden Sie unter Limitations (page 426).

App-Auswahlen und Aggregierung mit Auswahlformeln
Wenn Sie einen Bericht mit den On-Demand-Berichtssteuerungen generieren, werden nur die
möglichen Werte der Kombination aller aktuellen Auswahlen an Qlik NPrinting gesendet. Daher
werden ausgewählte ausgeschlossene Werte nicht eingeschlossen. Das kann zu unerwartetem
Verhalten führen, wenn Diagramm- oder Berichtselemente Auswahlformeln verwenden oder
mithilfe von alternativen Zuständen auf den Standardzustand verweisen.

Wenn außerdem die Qlik NPrinting Berichtsvorlage einen Filter enthält, können in der Qlik Sense
App keine konfliktierenden Auswahlen getroffen werden. Andernfalls schlägt der Bericht fehl.

Weitere Beschränkungen
l Wenn die Qlik NPrinting Berichtsvorlage einen Filter enthält, können in der Qlik Sense App

keine konfliktierenden Auswahlen getroffen werden. Andernfalls schlägt der Bericht fehl.
l Wenn Sie die On-Demand-Berichtssteuerung in einem Mashup verwenden, müssen Sie

Windows-Authentifizierung verwenden. Header-Authentifizierung wird nicht unterstützt.
Wenn außerdem das Mashup mehrere Apps enthält, können Sie nur die App, aus der On-
Demand stammt, zum Filtern von On-Demand-Berichten verwenden.

l On-Demand-Berichtssteuerungen werden auf Mobilgeräten nicht unterstützt. Eine On-
Demand-Berichtssteuerungs-Schaltfläche funktioniert nur, wenn von einem PC aus darauf
zugegriffen wird.

Text
Text objects complements other visualizations by offering options to add text,
hyperlinks, and measures. You can also add background images.

You can format and color the text and align the paragraphs. The background image has sizing and
positioning options.

Text is only available in the advanced edit mode.
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When to use it
Text is intended for presentation purposes, and does not support selections. However, the
measures in Text are updated when selections are made. Some typical uses:

l Use it on the first sheet of an app for essential information.
l Display a company image as a background image together with formatted text and measure

values to present figures in a compelling way.
l Link to sites with additional information.

Advantages
Text contrasts with the other visualizations. You have many options for making Text stand out next
to more regular charts.

Disadvantages
When organizing content within the chart, it is advised to use only a few measure values and
shorter texts. Otherwise, Text will be cluttered.

Creating Text objects
You can create a Text on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. In the advanced edit mode, drag an empty Text to the sheet from the assets panel.
2. Click Text to open the editing toolbar.
3. Add and format text, tables, hyperlinks or measures to Text.

If you double-click a Text in the assets panel, it is added to the sheet immediately.

Styling and formatting text in Text
Text offers several editing and formatting options for text. You can format your text using several
styles:

l Paragraph
l Quote
l Heading 1
l Heading 2
l Heading 3
l Unordered list
l Ordered list

You can also select font families and size. You can apply emphases to your text and change text
color. You can also add hyperlinks.
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Styling and formatting tables in the Text
You can insert tables into Text from the toolbar. You can resize column and rows and hide borders.
You can insert additional tables inside table cells.

Styling Text
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart.
The styling panel contains various sections under the General and Chart tabs. Sie können Ihre
Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken. Wenn Sie auf
Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten im
Designfenster zurückgesetzt.

Customizing the text
You can set the text for the title, subtitle, and footnote under Appearance > General. To hide these
elements, turn off Show titles.

You can style the text that appears in the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Creating a link
You can mark a text section and use it for a link.

Gehen Sie folgendermaßen vor:

1. Select the text section that you want to use for the link.

2. Click in the editing toolbar to open the link dialog.

3. Enter the web address that you want to link to.

4. Click .

Removing a link
You can remove a link from a text section.

Gehen Sie folgendermaßen vor:

1. Click the link so that the cursor is somewhere inside it.

2. Click in the editing toolbar to open the link dialog.

3. Click .

The link is removed, but not the text.

Adding a measure
You can add a measure in the following ways:

l By dragging a field from the assets panel and adding it as a measure.
l By dragging a measure from Master items.
l By adding a measure (existing or new) from the properties panel.

When you are editing the measure, it is displayed as a value with a grey background, which can be
styled and moved around in the visualization. You can also apply number formatting to it. When you
leave the editor, the measure value is displayed . Values that cannot be aggregated are shown as a
hyphen (-).

Deleting a measure
You can delete a measure in the following ways:
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l Place the cursor before the token and press Delete.
l Place the cursor after the token and press Backspace.
l In the properties panel, right-click the measure and select Delete in the dialog.
l In the properties panel, click the measure and click Delete .

Limitations
You can add a maximum of 10 measures to this chart.

Variable input control
You can use the variable input control to set the value of a variable. It is included in
Dashboard bundle.

When to use it
If you have visualizations with expressions that contain a variable, you can use the variable input
control to let the user control the variable value.

Creating a variable input control
You can create a variable input control on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. In the assets panel, open Custom objects > Dashboard bundle and drag a Variable input
object to the sheet.

2. Select the variable to use in Name under Appearance > Variable in the property panel.
3. Select how you want to input data in Show as:
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l Buttons lets you add a number of buttons with one button for each defined variable
value.
You can select how to display the buttons in Display, select Row to show them in a
horizontal row or Column to show them in a vertical column.
You can define the buttons in two different ways, fixed (Fixed) or (dynamic) Dynamic
with the Fixed or dynamic values setting under Values.
If you select to use fixed values, you need to add each button with Add Alternative
and define a value (Value) and a label (Label) for each button.
If you use dynamic values, you define the buttons with a string in Dynamic values.Use
| to separate buttons, and ~ to separate value from label. For example,
'Germany~GER|France~FRA' will create two buttons labelled GER and FRA. The first
will change the variable value to Germany, and the second changes the value to
France. You do not need to specify labels if you want to use values as labels.

l Drop down adds a drop down with one item for each defined variable value.
You can define the items in two different ways, fixed (Fixed) or (dynamic) Dynamic
with the Fixed or dynamic values setting under Values.
If you select to use fixed values, you need to add each item with Add Alternative and
define a value (Value) and a label (Label) for each item.
If you use dynamic values, you define the items with a string in Dynamic values.Use |
to separate items, and ~ to separate value from label. For example,
'Germany~GER|France~FRA' will create two items labelled GER and FRA. The first will
change the variable value to Germany, and the second changes the value to France.
You do not need to specify labels if you want to use values as labels.

l Input box provides a simple input box that will update the variable value.
l Slider creates a slider that updates the variable value. You define the minimum setting

with Min and the maximum setting with Max under Values. You can also set the step
to use with Step. If you select Slider label, the selected value is displayed when you
drag the slider.
The variable value is updated when you stop dragging the slider, but you can select
Update on drag if you want the variable value to be updated while you drag. This can
be useful when you want visualizations based on the variable to update dynamically
when dragging the slider. Use this option with caution, as the constant redrawing of
charts can be annoying.

Customizing styling
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart. Sie

können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).
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Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
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6. Under Shadow in the General tab, select a shadow size and color. Select None to remove
the shadow.

Limitations
For information about general limitations, see Limitations (page 426).

l The slider label can only display numeric values. This means, if the value is a date the
numeric value of the date is displayed. If the value is a percentage value, the percentage
character is not displayed.

Video player
The video player lets you play videos in different formats from external sources. It is
included in the Dashboard bundle.

The following video formats are supported.

l MP4
l OGG
l WEBM
l YouTube

Video player
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When to use it
The video player is useful when you want to include a video in your application. For example, you
want to show a demo or a training video, add a tutorial, or present corporate news.

Adding videos
You can add video player object to a sheet that you are editing. Add or paste a video link into the
video object. The video is streamed from a source; it is not uploaded to Qlik Sense. By default, the
video format of the link will be auto-detected, the video will not auto-play, and video controls will be
available to app consumers.

Do the following:

1. In the assets panel, open Custom objects > Dashboard bundle and drag a Video player
object to the sheet, or click Add to Sheet.

2. Add a video as a URL in the video player object field Add URL, or in the properties panel
under Video > URL. You can format the URL field as an expression.

3. Autodetect format is default setting and it will adjust accordingly based on the URL. You can
also turn off Autodetect, and then select the correct supported video format.

Once you have added the video, you may want to adjust its options.

Setting video options
Video options are set in the Properties pane.

Click Auto play if you want the video to automatically start when viewed in analyzer mode. Auto
play is turned off by default. When Auto play is selected, the video starts but it is muted. The app
user has to select Unmute to turn the sound on.
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Click Hide Controls to turn off video controls in analyzer mode. By default, video controls are
visible.

You can add a Poster image. By default, the poster image is turned off. For Source, select an
external URL that directs to an image, or add an image from your media library.

If a poster image is selected, the selected image is displayed before the video starts playing. Poster
alignment specifies how the poster image will align inside the video player.

You cannot play the video in edit mode. The video restarts when you switch between analyzer
mode and edit mode.

In analyzer mode, you start the video with the play button. You can pause, switch between mute
and unmute, and view the video in full screen. You can also share the video player object, and Take
snapshot.

In edit mode, the right-click context menu provides options for Qlik Sense. In analyzer mode, the
context menu provides options for YouTube.

The app developer (edit mode) or app c+onsumer (analyzer mode) must allow YouTube videos to
play in Qlik Sense.

Customizing styling
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart. Sie

können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:
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l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
The video player has the following limitations:

l Safari does not support OGG and WEBM formats.
l Qlik Sense Desktop cannot play MP4 format due to limitations in Chromium.
l Qlik Sense Client-Managed Mobile on iOS can only play MP4 compressed in H.264 or MPEG-

4 format, but not other MP4, OGG and WEBM formats due to limitations in iOS.
l Qlik Sense Client-Managed Mobile offline is not supported for video playing.
l iPhone adds native video controls. It does not use video player controls, therefore Hide

Controls will not turn off controls.
l Android does not support OGG format.
l When exporting or printing a sheet that includes a video player object, the video player
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object will not be included.
l Qlik NPrinting does not support the video player object.

Visualization bundle
Visualizations are an important means of conveying information from massive data.
The Visualization bundle is a set of charts that can be used to enhance and increase
your Qlik Sense app's charting capacity. The charts are optional. You do not have to
install or enable them to use Qlik Sense.

Enabling Visualization bundle
You can install the Visualization bundle when you install Qlik Sense. If you need to adjust your
installation, see: Modifying an object bundles installation.

Visualization bundle charts
Visualization bundle charts are in the asset panel under Custom objects.

The following charts are included:

l Trichterdiagramm (page 464)
A funnel chart is a visual representation of the connected stages of a linear process.

l Grid chart (page 473)
A chart that displays comparative data and with the values represented as colors.

l Multi KPI chart (page 478)
A chart that shows KPI for multiple dimension values to quickly understand and track
performance.

l Network chart (page 491)
Creates a cluster diagram representing a graphical chart of a computer network.

l P&L pivot chart (page 502)
Creates a pivot table that you can style, for example for profit and loss reporting.

l Pivot table (page 508)
Creates a pivot table with additional styling options not available in the pivot table
visualization.

l Radar chart (page 521)
Creates a two-dimensional chart using radial axes to show the scoring of a measure in one
dimension or another.

l Sankey-Diagramm (page 527)
A flow chart diagram chart visually emphasizing major transfers or flows within defined
system boundaries.

l Tabellendiagramm (page 533)
A table that allows app developers to create tables that can be customized by users who do
not have edit permissions.

l Trellis container (page 549)
Creates a trellis chart based on a master visualization.

l Variance waterfall chart (page 565)
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Shows the variance between two measures over the different values of a dimension.
l Word cloud chart (page 568)

A cloud chart of words with their size based on measure value.

Deprecated charts
These charts have been deprecated. Existing instances of these charts will still function, but new
ones cannot be added.

Bar & area chart
New bar & area charts are no longer supported as of May 2021. If you need to configure existing
instances of this chart, please refer to the last version of the documentation before support ended: .

Bullet chart
Deprecated by addition of native Bullet chart. For new charts, we recommend that you use the
native Bullet chart instead of this object. If you need to configure existing instances of this chart,
please refer to the last version of the documentation before the introduction of the native chart: .

Heatmap chart
As of February 2022, the Heatmap extension is no longer supported. Apps that use the Heatmap
extension will continue to function. If you need to configure existing instances of this chart, please
refer to the last version of the documentation before support ended: .

Limitations
Visualization bundle visualizations have more limitations than built-in visualizations, such as bar
charts. The following limitations are valid for all visualizations from Visualization bundle:

l The user interface of the visualization is not localized to the language that Qlik Sense is
using.

l Right-to-left reading order is not currently supported.
l Accessibility features are not currently supported.
l It is not possible to edit objects from an object bundle supplied by Qlik with Dev Hub.

The following table shows which additional features are supported, or not supported, for all
bundled objects.

l Printing
Printing a visualization made in an object.

l Qlik NPrinting
There is an On-Demand-Berichtssteuerelement (page 446). However, visualizations made in
some objects cannot be used in Qlik NPrinting reports.

l Download
Download as image, PDF, or Excel.

l Storytelling
Using a snapshot of a visualization created with an object in a story.

l Alternate states
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Making different selections on the same dimension, and comparing the selections in a single
visualization or in two or more visualizations side by side.

Exported radar charts will not include the chart legend.

Chart Printing
Qlik
NPrinting

Download Storytelling
Alternate
states

Funnel Yes Yes Yes Yes Yes

Grid chart Yes Yes Yes Yes Yes

Multi KPI No No Yes Yes Yes

Network Yes No Yes Yes Yes

Org chart Yes Yes Yes Yes Yes

P&L pivot Yes No Yes Yes Yes

Pivot object Yes Yes Yes Yes Yes

Radar Yes Yes Yes Yes Yes

Sankey Yes Yes Yes Yes Yes

Straight table Yes Yes Yes Yes Yes

Trellis container No No No No No

Variance
waterfall

Yes Yes Yes Yes Yes

Wordcloud Yes No Yes Yes Yes

Visualization bundle capability support

Trichterdiagramm
Mit dem Trichterdiagramm (Trichterdiagramm) können Sie ein Abfolgediagramm
hinzufügen, das die verbundenen Phasen eines Prozesses zeigt. Jede Phase wird
verkleinert und sollte eine Teilmenge der vorherigen Phase enthalten. Die
Verkleinerung ist graduell, wodurch das Diagramm einem schmaler werdenden Trichter
entspricht.
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Trichterdiagramm mit Anzeige der Konversionsraten von potenziellen Kunden zu Kunden in einem
Verkaufsprozess

Trichterdiagramme zeigen Werte über mehrere Phasen in einem Prozess hinweg. Sie können alles
darstellen, das kleiner wird. Das Trichterdiagramm zeigt einen Prozess, der bei 100 % beginnt und
bei einem geringeren Prozentsatz endet. Jedes Diagrammsegment stellt den Wert eines
bestimmten Elements dar und kann die Größe anderer Segmente beeinflussen. Das
Trichterdiagramm ist im Visualization Bundle enthalten.

l Das Diagramm benötigt eine Dimension und eine Kennzahl.
l Im Gegensatz zu Balkendiagrammen sind Trichterdiagramme zentriert, um die Form eines

Trichter nachzuahmen.
l Ein Diagramm mit zunehmenden Phasen anstatt abnehmenden Phasen ist ein

Pyramidendiagramm.
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Verwendung
Das Trichterdiagramm kann nützlich sein, um die Phasen eines Prozesses und die Gesamtabnahme
jedes Schritts darzustellen, zum Beispiel:

l Darstellen eines Verkaufsprozesses mit der Anzeige des Betrags für potenziellen Umsatz für
jede Phase

l Darstellen der Anzahl von potenziellen Kunden in jeder Phase der Verkaufskette, also der
Prozess vom potenziellen Kunden zum getätigten Einkauf

l Identifizieren potenzieller Problembereiche und Engpässe eines Verkaufprozesses
l Vermitteln eines Verkaufsprozesses an neue Teammitglieder und Lieferanten
l Darstellen von Website-Besuchertrends – von Homepage-Treffern der Besucher bis zu

anderen Bereichen, zum Beispiel Downloads usw.
l Anzeigen der Auftragsabwicklung mit eingeleiteten Aufträgen ganz oben, gefolgt von

beispielsweise in Auslieferung befindlichen, ausgelieferten, stornierten und retournierten
Aufträgen

l Anzeige des Informationsflusses von Streng geheim bis Keine Verschlusssache
l Darstellen von Wissensbereichen von Allgemeinwissen bis Expertenwissen

Erstellen eines Trichterdiagramms
Sie können auf dem Arbeitsblatt, das Sie bearbeiten, ein Trichterdiagramm erstellen.

l Die Dimension entscheidet, wie die Gruppierung in Segmente erfolgt. Standardmäßig werden
Dimensionswerte in absteigender Reihenfolge nach dem Kennzahlwert angezeigt.

l Die Kennzahl ist der Wert, der über die Größe der einzelnen Segmente entscheidet.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 466



3   Visualizations

Gehen Sie folgendermaßen vor:

1. Öffnen Sie im Extras-Fenster die Option Benutzerdefinierte Objekte >Visualization bundle
und ziehen Sie ein Grid chart-Objekt auf das Arbeitsblatt.

2. Klicken Sie oben auf die Schaltfläche Dimension hinzufügen und wählen Sie die
Zieldimension (normalerweise der Zielmarkt) des Diagramms.

3. Klicken Sie auf die Schaltfläche Kennzahl hinzufügen, um die Kennzahl des Diagramms (zu
messender Inhalt) auszuwählen. Nachdem Dimensionen (Dimensionsbezeichnung) und
Kennzahl (Wertbezeichnung) ausgewählt wurden, wird das Trichterdiagramm (in Farbe)
automatisch im Diagrammfeld angezeigt.

4. Klicken Sie auf Fertig, um zum Hauptanzeigefeld zurückzukehren.
5. Klicken Sie unter Region auf die anwendbare Region. Das Diagrammfeld wird aktualisiert und

zeigt die gewählten Parameter und Details an.

Dimensions-, Kennzahl- und Regionsdetails werden weiterhin im Diagrammfeld angezeigt, selbst
wenn in den Bearbeitungsmodus zurückgewechselt wird.

Ändern der Darstellung des Diagramms
Sie können Ihr Diagramm mit einer oder mehreren Funktionen anpassen.

Trichtermodus
Sie können die Form des Trichters mit Darstellung > Präsentation > Trichtermodus festlegen.

Fläche
Die Fläche jedes Elements ist proportional zur Kennzahl. Nur die Höhe des einzelnen Segments ist betroffen
– nicht das Gesamtdiagramm oder der Gesamtinhalt.
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Höhe
Die Höhe jedes Elements ist proportional zur Kennzahl. Nur die Höhe des einzelnen Segments ist betroffen –
nicht das Gesamtdiagramm oder der Gesamtinhalt.

Breite
Die Breite der Oberkante ist proportional zum Maximalwert der Kennzahl. Das oberste Segment beträgt
immer 100 % und die Größe der folgenden Segmente steht zur Größe des ersten in Beziehung. Das unterste
Segment ist rechteckig. Dies betrifft die Form des Trichters, und jedes Segment hat seine eigene Steigung.
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Ordnung
Die Kennzahl ordnet nur die Segmente so, dass der größte Wert oben ist. Die Ordnung wird so festgelegt,
dass die Form des Trichters nicht beeinträchtigt wird.

Farben
Sie können die Farbe des Trichterdiagramms wählen, indem Sie die Einstellung Darstellung >
Farben von Auto zu Custom ändern.

Eine Farbe
Sie können eine einzelne Farbe für das gesamte Trichterdiagramm verwenden, indem Sie unter Farben die
Option Eine Farbe auswählen.
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Farbgebung nach Dimension
Sie können das gesamte Trichterdiagramm auch nach Dimension einfärben, indem Sie unter Farben
die Option Nach Dimension auswählen. Es sind zwei Farbverläufe verfügbar.

l 12 Farben
l 100 Farben

Sie können auch die Farben beibehalten, indem Sie die Option Farben bei Auswahl beibehalten
auswählen.

Farbgebung nach Kennzahl
Sie können die Farbe Ihres Trichterdiagramms nach Kennzahl festlegen, indem Sie unter Farben die
Option Nach Kennzahl auswählen. Die Kennzahl des Diagramms wird als Standard ausgewählt; Sie
können dies aber unter Kennzahl auswählen ändern. Die Verknüpfung mit dieser Kennzahl muss
zunächst aufgehoben werden, bevor eine neue ausgewählt werden kann. Sie können die Kennzahl
auch anhand einer Formel im Formel-Editor ändern ( ).

Sie können zwischen vier Farbschemas wählen. Die Farben können auch umgekehrt werden.

l Sequenzieller Farbverlauf
l Sequenzielle Klassen
l Divergierender Verlauf
l Divergierende Klassen

Sie können auch einen Farbbereich für das Diagramm nach Ihrer Kennzahl festlegen, indem Sie für
Bereich die Option Benutzerdefiniert wählen. Legen Sie den Bereich unter Bereich > Min und
Bereich > Max fest. Sie können eine Zahl oder eine Formel, die eine Zahl zurückgibt, verwenden.

Farbgebung nach Formel
Sie können die Farbe Ihres Trichterdiagramms nach Formel festlegen, indem Sie unter Farben die
Option Nach Formel auswählen. Für die Farbgebung gibt es zwei Möglichkeiten.

l Die Formel wird als gültige CSS-Farbe zur Farbgebung für das Diagramm ausgewertet. Die
Option Die Formel ist ein Farbcode muss aktiviert sein.

l Die Farbgebung des Diagramms erfolgt nach dem Formelwert entsprechend einem
Farbschema. Die Option Die Formel ist ein Farbcode muss deaktiviert sein.
Sie können auch den Farbbereich festlegen.

Sortieren
Elemente eines Trichterdiagramms werden automatisch vom Größten zum Kleinsten sortiert. Sie
können die Sortierreihenfolge im Eigenschaftsfenster ändern. Gehen Sie zu Sortierung und ziehen
Sie Ihre Dimensionen und Kennzahlen in die gewünschte Reihenfolge.
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Designs und Formatierung
Die Position und Reihenfolge von Bezeichnungen von Dimensions- und Kennzahlenwerten kann auf
verschiedene Arten angezeigt werden. Sie können beispielsweise den Dimensionswert ausblenden
oder Kennzahlen als Werte oder als Prozentsatz anzeigen.

Zudem können Sie die Titelbeschriftung konfigurieren, die für die Dimension unter Daten im
Eigenschaftsfenster angezeigt werden soll. Ändern Sie den Stil dieser Textelemente im
Designfenster. Weitere Informationen finden Sie unter Verwenden des Designfensters zur weiteren
Anpassung der Darstellung (page 471).

Dimensionsbezeichnung
Mit der Option Darstellung > Präsentation > Dimensionstitel können Sie wählen, ob Sie den
Dimensionstitel anzeigen möchten oder nicht.

Wertebezeichnungen
Sie können wählen, wie Wertebezeichnungen für jedes Segment angezeigt werden, indem Sie
Darstellung > Präsentation > Wertebezeichnungen auf Benutzerdefiniert festlegen.

l Mit Keine werden die Wertebezeichnungen ausgeblendet.
l Mit Anteil werden die Werte als Prozentsatz angezeigt.
l Mit Werte werden die aktuellen Kennzahlenwerte angezeigt.

Verwenden des Designfensters zur weiteren Anpassung der Darstellung
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font, font size, and color for the following text elements:
l Dimension title: Style the text of the dimension title that is displayed above the

visualization.
l Dimension value label: Style the text of the labels displaying the individual dimension

values.
l Value Label: Style the text of the measure value labels.

Use the Auto contrast color setting to automatically override the selected value label
color with a color that better contrasts the funnel colors.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
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6. Under Shadow in the General tab, select a shadow size and color. Select None to remove
the shadow.

Einschränkungen
Informationen zu allgemeinen Beschränkungen finden Sie unter Limitations (page 463).

Grid chart
The grid chart (Grid chart) uses symbols of varying size sorted in a grid. The grid chart
is included in the Visualization bundle.

Grid charts must have two dimensions and one measure. The dimension values are the x and y
axes. The measure is the metric that determines the size of the symbol in each crossing.

Grid chart with circles. Circle color is set by dimension (Quarter) and circle size is based on measure (Sum of
Sales)
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When to use it
A grid chart is useful when you need to quickly find measure values that stand out from other
values. For example: you want to see which products sell well in some months, but poorly in others.

Grid charts do not work well when the measure has:

l Many duplicate values.
l Values that are numerically close to each other.

Creating a grid chart
You can create a grid chart on the sheet you are editing.

Do the following:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Grid chart
object to the sheet.

2. Click the Add Dimension button to select the x axis value of the chart.
3. Click the second Add Dimension button to select the y axis value of the chart.
4. Click the Add Measure button to select the metric being weighed.

The grid chart is now displayed with the dimensions and measures you selected.

Sorting
Grid chart elements are automatically sorted alphabetically or numerically from smallest to largest
on the x axis. You can change the sort order of either axes in the property panel.

Do the following:

1. In the property panel, go to Appearance>Sorting.
2. Click on a dimension.
3. Toggle Sorting from Auto to Custom.
4. You can choose any of these options:

l Sort by expression: Ascending or Descending.
l Sort numerically: Ascending or Descending.
l Sort alphabetically: Ascending or Descending.

Changing the appearance of the chart
You can customize the appearance of your grid chart.
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Grid chart with stars. Star color and size is set by measure (Gross Sales).

Customizing the symbols
You can change the shape and size of the symbols from the Appearance>Presentation tab in the
property panel:

l Use the Symbol size slider to change size.
l Use the Symbol dropdown to change symbol type.

Placing labels on symbols
You can place the individual values of symbols directly onto the chart. From the
Appearance> Presentation tab, toggle the Labels from Off to Auto.

Using a grid chart as a heat map
You can change the layout of a grid chart to a heat map from the Appearance>Presentation tab in
the property panel. From the Layout dropdown menu, choose:

l Standard: The chart will show individual symbols.
l Heatmap: The chart will display data in a grid with a legend ordered by color.

For a visual demo about using a grid chart as a heatmap chart, see Creating a heatmap using a grid
chart.

Changing the color scheme
You can change the color scheme of the symbols from the Colors and legend tab. Set Colors to
Custom. From the dropdown menu, choose:

l Single color: You can choose any color.
l By dimension: Under Color scheme, you can change how many different colors are used.
l By measure: Under Color scheme, you can alter the color gradient. Click the Reverse colors

check box to flip the gradient order. The colors used are based on your app theme.
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l By expression: You can have a color code in the expression. Or, deselect the The
expression is a color code check box, and you can alter the color gradient. Click the
Reverse colors check box to flip the gradient order. The colors used are based on your app
theme.

Changing the range limits
You can customize the limits of the ranges if you color by measure or expression. The full range is
defined by the value of the dimensions. Go to Appearance > Colors and legend > Range in the
properties panel:

l Min: Defines the lower limit of the range.
l Max: Defines the upper limit of the range.

Changing the scale of the axes
You can customize the presentation of the x and y axes. Go to Appearance > X-axis: [dimension]
or Appearance > Y-axis: [dimension] in the properties panel. You can set:

l Labels and title: Select what labels and title to display.
l Label orientation: Select how to display the labels. The following options are available:

o Auto: Automatically selects one of the other options depending on the space available
on the chart.

o Horizontal: Labels are arranged in a single horizontal line.
o Tilted: Labels are stacked horizontally at an angle.
o Layered: Labels are staggered across two horizontal lines.

To view examples of label orientation, see X-axis and Y-axis (page 635).
l Position: Select where to display the dimension axis.
l Number of axis values:

o Auto: The number of visible bars is determined by the number of dimensions and
measures used.

o Max: The number of visible bars is set to maximum.
o Custom: When custom is selected, you can directly set the upper limit to the number

of visible bars using Maximum number, or by entering an expression. Click
Expression to open the Expression editor.

l Show grid lines: Select whether to display grid lines.

Using the styling panel to further customize the appearance
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.
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For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font, font size, and color for the following text elements:
l Axis title: Style the titles on the axes.
l Axis label: Style the labels on the axes.
l Value label: Style the labels which display the measure value for each dimension

value.
l Legend title: Style the title of the legend. The legend is only available for the Heatmap

configuration.
l Legend labels: Style the labels of the individual legend items. The legend is only

available for the Heatmap configuration.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
For information about general limitations, see Limitations (page 463).

l The Number of axis values setting in the property panel has a limit of 55 per axis.
l Sometimes when you set dimension limits on a grid chart, chart labels will incorrectly display

more items than requested.
l Wenn Einfärbung nach Dimension in diesem Diagramm verwendet wird, können maximal 100

eindeutige Dimensionswerte und 100 eindeutige Farben auf der Legende aufgetragen
werden.

Multi KPI chart
The Multi KPI chart (Multi KPI) is a visualization that allows you to show multiple KPI
values for different dimension values. The values can be individually customized using
various conditional formatting settings. This enables an easy view and tracking of
goals. It is included in the Visualization bundle.

l The chart shows KPIs using measures and one dimension.
l Up to 15 measures and 80 values can display simultaneously.
l All KPI values can be grouped or displayed individually.
l Each value can be independently customized using for example, colors, icons, labels, font

sizes, alignments, styles, links to different sheets, etc.
l The chart supports adding graphics, embedding objects into a chart and to display measures

infographically.
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When to use it
The multi KPI chart is useful when you want to easily view, understand and track the performance of
your goals. It is also helpful when you want to customize individual KPI values using conditional
formatting. You can link KPIs to separate sheet and insert objects to represent information or data.

Creating a multi KPI chart
You can create a multi KPI chart on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Multi KPI
object to the sheet.

2. Click the Add measure button and select the main measure of the KPI chart. The main
measure and a KPI value for the chosen measure is displayed.

3. Click Add under Data > Dimensions in the property panel and select dimension.

When you have selected measure and dimension, a multi KPI chart is displayed.

Beispiel:

A chart with the measure (Margin %) shown for different values of the dimension (City).
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Adding additional measures
You can add additional measures to your chart in property panel under Data > Dimensions. The
chart updates to reflect the added measures. Up to 15 measures and 80 values can display
simultaneously. The main measure is always the top measure listed for each dimension. When you
add more measures, they appear under the initial KPI value in the order they are entered.

Beispiel:

A chart with a two measures (Margin %, Quantity) grouped per dimension (City).

Customizing the KPIs
You can customize your KPI values and measures with one or more conditional settings. You can
add several KPIs together, group them and link to different sheets. You can also configure KPI
values independently by differentiating them with one or more conditional settings such as text,
color, icons, graphics, etc.

For conditional settings options, see Ändern einer Kennzahl-/Bezeichnungsfarbe (page 482).

Customizing styling
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart. Sie

können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
For information about general limitations, see Limitations (page 463).

Multi KPI charts cannot be used in Qlik NPrinting reports.
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Anpassen der KPIs
Mit dem Multi-KPI-Diagramm (Multi-KPI) können Werte und Kennzahlen anhand einer
oder mehrerer der Bedingungseinstellungen angepasst werden. Sie können mehrere
KPIs zusammen hinzufügen, sie gruppieren und Links zu verschiedenen Arbeitsblättern
erstellen. KPI-Werte können auch unabhängig angepasst werden, indem sie anhand
einer oder mehrerer CSS-Eigenschaften wie Textfarbe, Schriftarten, Größen,
Symbolen, Bezeichnungen oder Grafiken differenziert werden.

KPI-Werte können auch unabhängig angepasst werden, indem sie anhand einer oder mehrerer
CSS-Eigenschaften wie Textfarbe, Hintergrundfarbe, Schriftarten, Größen, Symbole,
Bezeichnungen oder Grafiken differenziert werden.

KPI-Werte mit Symbolen, verschiedenen Farben, Schriftarten, Master-Visualisierungen

Einfärben eines Multi-KPI
Anhand der Farboption können alle KPI-Werte (Kennzahlen und Bezeichnungen) nach Farben
differenziert werden. Sie können die Farben für Text, Symbole und den Hintergrund ändern. Die
Farben müssen gültige CSS-Farben sein.

Sie können aus folgenden Optionen auswählen:

l Der Farbpalette mit einer Reihe vordefinierter Farben.
l Dem Farbkreis (klicken Sie auf das Palettensymbol in der Farbpalette und wählen Sie

individuell).
l Geben Sie einen Farbcodestring in das Feld neben dem Palettensymbol ein.

Ändern einer Kennzahl-/Bezeichnungsfarbe

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster auf Daten > Kennzahlen.
2. Klicken Sie auf die entsprechende Kennzahl und wählen Sie sie zum Färben des Werts

(Wertfarbe) oder der Bezeichnung (Bezeichnungsfarbe) aus.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 482



3   Visualizations

3. Wählen Sie die Farbe aus der Farbpalette aus, die geöffnet wird.

Ändern der Hintergrundfarbe

Gehen Sie folgendermaßen vor:

1. Sie können auch Ihre eigene Farbe festlegen, indem Sie auf das Palettensymbol in der
Farbpalette klicken und die Farbe auswählen oder einen Farbcodestring in das Feld neben
dem Palettensymbol eingeben. Die Farben müssen gültige CSS-Farben sein.

2. Klicken Sie im Eigenschaftsfenster auf Darstellung > Designs.
3. Klicken Sie auf das Feld Hintergrundfarbe.
4. Wählen Sie die Farbe aus der Farbpalette aus, die geöffnet wird. Das Diagramm wird

aktualisiert.

Ändern der Größen eines Multi-KPI
Die Größe von Dimensionen, Kennzahlen, Bezeichnungen und Symbolen kann anhand der
vordefinierten Größen in einem Dropdown-Menü konfiguriert werden:

l Dimensionsbezeichnungen: Wählen Sie die Größe der Bezeichnungen im
Eigenschaftsfenster aus dem Dropdown-Menü unter Darstellung > Dimensionen > Größe
aus.

l Kennzahl-Bezeichnungen: Alle Kennzahlen können individuelle Größen haben.

Gehen Sie folgendermaßen vor:

1. Wählen Sie die Größe der Kennzahlen im Eigenschaftsfenster unter Daten > Kennzahlen
aus.

2. Wählen Sie Kennzahl aus und aktivieren Sie das Kästchen Parameter überschreiben.
3. Geben Sie den Bezeichnungstyp als String oder in der Formel unter Bezeichnung ein und

wählen Sie die Größe aus den Optionen des Dropdown-Menüs unter Größe aus.

Symbole: Alle Symbole können durch die Anwendung verschiedener Farben differenziert werden.
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Gehen Sie folgendermaßen vor:

1. Rufen Sie im Eigenschaftsfenster Daten > Kennzahlen auf.
2. Wählen Sie Kennzahl aus und wählen Sie „Symbol“ unter der Symboloption aus.
3. Wählen Sie dann Symbolgröße aus dem Dropdownmenü unter Symbol aus.

Ändern der Schriftarten eines Multi-KPI
Sie können die Schriftartenfamilie aller Bezeichnungen ändern. Gehen Sie hierfürim
Eigenschaftsfenster zu Daten > Kennzahlen und wählen Sie die betreffende Kennzahl aus. Geben
Sie unter Schriftschnitt einen Bezeichnungsstring ein und drücken Sie die Eingabetaste.

Sie können die Schriftart auch anhand einer Formel im Formel-Editor ändern ( ) oder individuelle
Schriftart-CSS-Eigenschaften anwenden, die im Eigenschaftsfenster über Darstellung > Designs
> Designs (CSS) eingegeben werden.

Ändern von Symbolen
Sie können ein vordefiniertes Symbol zur Darstellung eines Werts und/oder einer Bezeichnung
festlegen, indem Sie es aus dem Symbolsatz auswählen. Die Symbole können dann weiter
angepasst werden, indem zur Unterscheidung die Optionen für Farben, Schriftarten,
Bezeichnungen und Größe verwendet werden.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster auf Daten > Kennzahlen.
2. Aktivieren Sie das Kästchen Symbol auswählen und klicken Sie auf das entsprechende

Symbol im angezeigten Symbolsatz.

3. Klicken Sie auf OK. Das Popup-Fenster wird geschlossen und Ihr Diagramm aktualisiert.
4. Wählen Sie, ob Sie eine Bezeichnung oder einen Wert konfigurieren möchten, indem Sie

unter Symbolposition Bezeichnung oder Wert auswählen.

Sie können auch einen Wert/eine Bezeichnung in ein Symbol ändern, indem Sie einen Symbolstring
unter Symbol (Daten > Kennzahlen > anwendbare Kennzahl im Eigenschaftsfenster) eingeben und
dann die Eingabetaste drücken. Klicken Sie anschließendunter Symbolposition auf Bezeichnung
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oder Wert, abhängig davon, welches Element Sie konfigurieren möchten. Ein Symbol kann auch
anhand einer Formel im Formel-Editor geändert werden ( ). Die Symbole müssen gültige CSS-
Symbole sein.

Der Infografik-Modus
Im Infografik-Modus können Sie jede Kennzahl grafisch als eine entsprechende Anzahl Symbole
anzeigen.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster auf die entsprechende Kennzahl unter Daten >
Kennzahlenund dann auf die Schaltfläche Symbol.

2. Wählen Sie ein Symbol zur Darstellung der Kennzahl im vordefinierten Symbolsatz
(Symbole), der geöffnet wird.

3. Klicken Sie auf die Schaltfläche für den Infografik-Modus. Das sich ergebende KPI-
Diagramm wird aktualisiert und zeigt die Kennzahlen grafisch mit der entsprechenden Anzahl
Symbole an (maximal 100 Symbole pro Kennzahl).
Sie können ein Symbol auch anhand einer Formel im Formel-Editor auswählen ( ).

Einbetten einer Master-Visualisierung
Um ein KPI-Objekt grafisch zu illustrieren, können Sie eine Master-Visualisierung einbetten.

Gehen Sie folgendermaßen vor:

1. Gehen Sie im Eigenschaftsfenster zu Daten > Kennzahlen und klicken Sie auf Hinzufügen.

2. Klicken Sie auf die Schaltfläche Formel-Editor ( ).

3. Geben Sie den String ='Drag and Drop here' in den Formel-Editor ein und klicken Sie auf
Anwenden.

4. Ziehen Sie ein Master-Visualisierungsobjekt in die Werteregion jedes Kennzahlenplatzhalters
und legen Sie es dort ab.

Zum Ändern können Sie die Objekt-ID-Zeichenfolge unter Visualisierung für jede Kennzahl auch in
die Formel im Formel-Editor ( ) einfügen (Daten > Kennzahlen > entsprechende Kennzahl im
Eigenschaftsfenster).
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Arbeiten mit Designeigenschaften (CSS)
Sie können Ihre Kennzahlen weiter konfigurieren, indem Sie nicht definierte Designeigenschaften
(CSS) für jede Kennzahl verwenden. Das können Symbole, das Ändern von Text-/Symbolfarben,
Bezeichnungen, Schriftarten, Hintergrundfarbe, Größe usw. sein. Kopieren Sie die Designs und
fügen Sie sie in das Feld Designs (CSS) (unter Darstellung > Designs im Eigenschaftsfenster) ein.

Geben Sie für Symbole die entsprechenden Klassen im Feld Symbol der ausgewählten Kennzahl im
Eigenschaftsfenster unter Daten > Kennzahlen ein. Sie können die Symbolzeichenfolge auch
anhand einer Formel im Formel-Editor eingeben ( ).

Formatieren Ihrer KPIs
Sie können das Diagrammlayout für verschiedene Darstellungsweisen formatieren.

Ausrichtung
Sie können die Textausrichtung des Hauptdiagramms konfigurieren, indem Sie im
Eigenschaftsfenster unter Daten > Kennzahlen für die gewählte Kennzahl unter Ausrichtung das
betreffende Kontrollkästchen auswählen:

Alle KPIs können auch vertikal ausgerichtet werden. Diese Ausrichtung kann angepasst werden,
sodass sie oben, unten oder zentriert ausgerichtet bzw. gestreckt wird. Wählen Sie die betreffende
Ausrichtung im Eigenschaftsfenster unter Darstellung > Designs im Menü Vertikale Ausrichtung.
Bezeichnungen können auch zentriert werden, indem Sie die Option Bezeichnungen zentrieren im
Eigenschaftsfenster unter Darstellung > Dimensionen aktivieren.
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Zahlenformat
Sie können auch die KPI-Zahlenwerte benutzerdefiniert formatieren. Gleiche Werte können
unterschiedlich formatiert werden. Das Diagramm wird aktualisiert und zeigt den geänderten
Zahlentyp.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster auf Daten > Kennzahlen und wählen die gewünschte
Kennzahl aus.

2.  Wählen Sie das anwendbare Zahlenformat aus dem Menü Zahlenformat aus.

Zahlenformat
Der Text einer bestimmten Kennzahl kann geändert oder entfernt werden.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster auf Daten > Kennzahlen.
2. Klicken Sie auf die betreffende Kennzahl und geben Sie den anwendbaren Formatstring

unter Zahlenformat ein bzw. entfernen Sie ihn und drücken Sie die Eingabetaste.

Segment/Karte
Das Layout des KPI-Diagramms kann auch so konfiguriert werden, dass Dimensionen und Werte in
einem Segment- oder Kartenlayout angezeigt werden.
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Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster auf Darstellung > Dimensionen.
2. Wählen Sie das Layout Segment oder Karte aus dem Menü Anzeigen als aus. Das Diagramm

wird aktualisiert.

Das Segmentlayout kann im Eigenschaftsfenster unter Darstellung > Dimensionen > Ausrichtung
horizontal oder vertikal konfiguriert werden. Klicken Sie auf die Schaltfläche Horizontal bzw.
Vertikal.

Elemente pro Zeile
Im Eigenschaftsfenster unter Darstellung > Kennzahlen kann auch die Anzahl der Elemente (KPIs)
pro Zeile in einem Diagramm festgelegt werden. Verwenden Sie die standardmäßige automatische
Auswahl oder wählen Sie die entsprechende Zahl aus dem Menü Elemente pro Zeile aus (zwischen
1 und 8).

Rahmen
Sie können externe und interne Rahmen des Diagramms ausblenden. Standardmäßig werden alle
Rahmen angezeigt. Um Rahmen zu konfigurieren, gehen Sie im Eigenschaftsfenster zu Darstellung
> Dimensionen und aktivieren wahlweise die Option Externe Rahmen ausblenden oder Interne
Rahmen ausblenden.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 488



3   Visualizations

Layout und Formatierung von Werten/Bezeichnungen
Die Position und Reihenfolge von Bezeichnungen von Dimensions- und Kennzahlenwerten kann
geändert und auf verschiedene Arten angezeigt werden. Bezeichnungen können ausgeblendet
oder vertikal bzw. horizontal angezeigt werden. Standardmäßig ist Horizontal ausgewählt.

Dimensionsbezeichnungslayout

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster auf Darstellung > Kennzahlen.
2. Klicken Sie unter Bezeichnungsausrichtung auf Horizontal oder Vertikal, um auszuwählen,

wie die Bezeichnungen angezeigt werden sollen.

Kennzahlenwertlayout
 Das Layout des Kennzahlenwerts kann auf zwei verschiedene Weisen festgelegt werden.

Gehen Sie folgendermaßen vor:

1. Vorhandene Parameter:
a. Klicken Sie im Eigenschaftsfenster auf Darstellung > Kennzahlen.
b. Klicken Sie unter Bezeichnungsausrichtung auf Horizontal oder Vertikal, um

auszuwählen, wie die Bezeichnungen angezeigt werden sollen.
2. Neue Parameter:

a. Klicken Sie im Eigenschaftsfenster auf Daten > Kennzahlen.
b. Klicken Sie auf die entsprechende Kennzahl und aktivieren Sie das Kästchen

Parameter überschreiben.
c. Geben Sie unter Bezeichnung den Bezeichnungsstring ein und drücken Sie die

Eingabetaste.

Bezeichnungsreihenfolge
Sie können auch die Reihenfolge anpassen, in der die Kennzahlenwertbezeichnungen angezeigt
werden.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster auf Darstellung > Kennzahlen.
2. Klicken Sie unter Bezeichnungsausrichtung auf Bezeichnung, Wert oder Wert,

Bezeichnung, um auszuwählen, wie die Bezeichnungen angezeigt werden sollen.

Symbolreihenfolge
Sie können festlegen, ob Symbole vor oder nach einem Wert angezeigt werden. Gehen Sie im
Eigenschaftsfenster unter Darstellung > Kennzahlen zu Symbolreihenfolge und klicken Sie auf
die Schaltfläche Symbol, Wert oder Wert, Symbol, um auszuwählen, was im Diagramm zuerst
angezeigt wird.
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Bezeichnungen ausblenden
l Kennzahl-Bezeichnungen: Mit dieser Option wird die Kennzahl-Bezeichnung jedes KPI

ausgeblendet. Zum Ausblenden der Bezeichnungen klicken Sie im Eigenschaftsfenster auf
Daten > Kennzahlen und wählen die betreffende Kennzahl aus. Aktivieren Sie dann das
Kästchen Bezeichnungen ausblenden.

l Dimensionsbezeichnungen: Mit dieser Option wird die Dimensionsbezeichnung jedes KPI
ausgeblendet. Um die Bezeichnungen auszublenden, klicken Sie im Eigenschaftsfenster auf
Darstellung > Dimensionen. Aktivieren Sie dann das Kästchen Bezeichnungen
ausblenden.

Werte ausblenden
Mit dieser Option wird der Wert für jeden KPI ausgeblendet. Um den Wert auszublenden, klicken Sie
im Eigenschaftsfenster auf Daten > Kennzahlen. Aktivieren Sie dann das Kästchen Werte
ausblenden.

KPI-Werte gruppieren
Alle KPI-Werte können gruppiert oder einzeln nach Kennzahl angezeigt werden. Gehen Sie zu
Daten > Kennzahlen im Eigenschaftsfenster. Wählen Sie die betreffende Kennzahl aus und
aktivieren Sie das Kästchen Nach Dimension gruppieren.

Alternativ können Sie einen Dimensionswertstring unter Dimensionswerteingeben und die
Eingabetaste drücken. Das Diagramm wird aktualisiert. Sie können den Dimensionswert auch
anhand einer Formel im Formel-Editor eingeben ( ). Die Werte müssen gültige CSS-Werte sein.

Link zu einem getrennten Arbeitsblatt
Jede Kennzahl kann mit einem anderen Arbeitsblatt verlinkt werden.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im Eigenschaftsfenster auf Daten > Kennzahlen und wählen die gewünschte
Kennzahl aus.

2. Schieben Sie den Schieberegler Link zum Arbeitsblatt nach rechts, um die Option zu
aktivieren.

3. Klicken Sie auf die Schaltfläche Arbeitsblatt auswählen und klicken Sie im Popup-Fenster
Arbeitsblatt auswählen auf die Seite, zu der Sie einen Link erstellen möchten. Das
Arbeitsblatt wird geschlossen und Ihre Seiten werden verlinkt.
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Beschränkungen
Informationen zu allgemeinen Beschränkungen finden Sie unter Limitations (page 463).

Network chart
The network chart (network chart) lets you draw a network of connected nodes and
edges from a data set to a sheet. A network chart shows how information flows, how
components interact, and where components exist in the network. The network chart
is included in the Visualization bundle.

A network chart can provide a broad overview or be very detailed. Nodes represent system
components, and edges show the movement of information from one component to another.
Network nodes are connected to the nodes they interact with the most. This visualization uses
different styles, colors, sizes, and images to represent different levels of a network.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 491



3   Visualizations

What it contains
You need to define three dimensions with a fourth optional dimension:

l Node identifier: This dimension controls which nodes are presented in the chart.
l Node label: This dimension sets the label of each node.
l Node parent: This dimension sets the parent of a node, and controls the relationships

between nodes. It needs to contain the value of the node identifier of the parent to connect
to.

l Node group (optional): You can use this dimension to group nodes. All nodes in the same
group will have the same color.

You can use up to three measures to enhance the diagram. All measures are optional, but you need
to add them in the following order:

1. Tooltip: You can set a measure value that is displayed in a tooltip when hovering over a node.

2. Node size: You can set the size of the node according to a measure.
3. Edge size: You can set the width of the lines between nodes according to a measure.

You need to add a tooltip before you can set node size. You can set edge size after
adding a tooltip and node size.

When to use it
Network chart diagrams can illustrate computer or telecommunications networks. They show the
components of a network and how they interact. For example, a group of connected computers,
printers, modems, hubs, and routers. This type of chart is helpful when:
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l Planning the structure of a network.
l Coordinating updates to an existing network.
l Reporting and troubleshooting network problems .
l Keeping track of components.
l Documenting detailed network documentation.

Formatting your data
A network chart requires data that is structured consistently according to a network data model
where each record can have multiple parents and children. Each record needs to contain at least:

l A field that identifies the node, the node identifier. Node identifier values must be integer
values, starting from 0 and in sequential order.

l A field with the name of the node.
l A field that defines the parent node. This value needs to be the node identifier of another

node. If this field is empty, and no other record refers to this node, a disconnected node is
created.

It is also possible to use a hierarchical data model where each node has a single parent.
This will create a tree-shaped chart.

Here is some example data that you can save in a text editor and load in a new app. You need to
load both example files. The example shows passenger flows between different airports.

l ID is the identifier of an airport node.
l Name is the name of an airport node. This is used as label of the node.
l LinkTo contains the node identifier of the parent node.
l Group states the group of a node. This can be used to color the nodes according to group.
l Volume is the passenger flow volume between ID and LinkTo. This can be used as a measure

in edge size.
l NodeVolume is the total passenger flow volume for a node. This is loaded in a separate table

as the chart cannot aggregate the volumes automatically.

Example 1: Airports1.csv

ID;Name;LinkTo;Group;Volume

0;Frankfurt;;0;

1;London;0;1;5

2;Madrid;0;1;4

2;Madrid;1;1;8

3;Warsaw;0;1;7

4;Arlanda;0;1;1

3;Warsaw;1;1;5

4;Arlanda;1;1;6

5;Tunis;0;2;8

5;Tunis;2;2;4

6;Berlin;0;1;6

6;Berlin;4;1;4

7;Rome;0;1;6
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7;Rome;6;1;3

8;San Francisco;0;3;2

9;New York;0;3;9

Example 2: Airports2.csv

ID,NodeVolume

0,48

1,24

2,16

3,12

4,11

5,12

6,13

7,9

8,2

9,9

Creating a network chart
This example of a network chart illustrates how different airports are connected worldwide based
on base data set. It uses the example data set from Formatting your data. Prepare by saving the
example data set in a text file, creating a new app and loading the example data set.

Gehen Sie folgendermaßen vor:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Network chart
object to the sheet.

2. Click the top Add dimension button and select ID as the node identifier.
3. Click the second Add dimension button and select Name as the node label.
4. Click the third Add dimension button and select LinkTo as the parent node.
5. Click Data in the properties panel. Click the Add button under Node group and select Group

as the group dimension.
6. Under Measure, click the Add button under Tooltip, and select Volume > Sum

(NodeVolume).
7. Click the Add button under Node size, and select Volume > Sum(NodeVolume).
8. Click the Add button under Edge size, and select Volume > Sum(Volume).
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The chart displays:

Changing the appearance of the chart
You can customize your chart with one or more features.

Configuring edge type
You can configure the shape of the curve between chart nodes under Settings > Edge Type in the
properties panel. Select the shape option of the chart curves from the menu.

Beispiele:

A chart with dynamic edge type (curves).
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The same chart with curved CW edges.

Toggling edge value
The edge value represents value of the curves between chart nodes and their width. This option
hides the numerical value of each curve. To hide the value move the slide button under Settings >
Display edge value in the properties panel to the left to turn the option off.

Configuring edge label
The edge label value is the numerical value of each chart curve. You can change the position of
these or hide the labels.

l Hide edge label value: This option hides the edge label of the network chart. Toggle the
slide button under Settings > Display edge value in the properties panel.

l Edge label position: This option decides where on each chart curve the edge value displays,
for example: above or below. Select applicable option from the menu.

Configuring node shape
You can customize the shape of the nodes, for example: dot, square, diamond, or triangle. Go to
Settings > Node shape in the properties panel, and select the node shape from the menu.

Toggling shadow option
This option lets you turn off the shadow effects behind chart curves and nodes (used to highlight
background). Toggle the slide button under Settings > Display shadow in the properties panel.

Sorting
Sorting is set to Auto with the system choosing the sorting order as the default (under Sorting >
chosen dimension or measure in the properties panel) for all dimensions and measures. You can
change them individually by expression.
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Gehen Sie folgendermaßen vor:

1. Open the dimension or measure menu under Sorting in the properties panel.
2. Move Sorting slide button to the left to turn the option from Auto to Custom.
3. Click the Sort by expression check box.
4. Enter an order string under Expression and press Enter. You can also change the color using

an expression in the Expression editor ( ).

5. Choose start order by selecting Ascending or Descending for the menu below.

Number formatting
It is possible to format the measure value. Different formatting can be applied to the same value, for
example: money, data,or duration. The chart updates to reflect the changed number type.

Gehen Sie folgendermaßen vor:

1. Click Data > Measures in the properties panel and click chosen measure.
2. Select applicable number formatting form the Number formatting menu.
3. Enter details in the panel fields. These display when choosing an option other than Auto

when to configuring the chart.

Using the styling panel to further customize the appearance
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart. Sie

können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.
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3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
For information about general limitations, see Limitations (page 463).

l Network chart visualizations cannot be used in Qlik NPrinting reports.
l The maximum size of the data set displayed in the network chart is 1400 rows. If the selected

data set is larger, nodes and links can be omitted from the chart.
Use a smaller data set or employ selections to limit the data set.

Organisationsdiagramm
Sie können das Organisationsdiagramm verwenden, um Organisationsdiagramme aus
Daten mit einer Baumstruktur zu erstellen. Sie können durch die Hierarchie navigieren,
indem Sie die Struktur erweitern und reduzieren. Das Organisationsdiagramm ist im
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Visualization Bundle enthalten.

Sie müssen einen Datensatz mit zwei Dimensionen verwenden, die die Baumstruktur definieren.

l Die erste Dimension muss die ID des Knotens sein. Das entspricht in der Regel der
Mitarbeiter-ID in einem traditionellen Organisationsdiagramm.

l Die zweite Dimension muss die ID des übergeordneten Knotens sein. Das entspricht in der
Regel der Mitarbeiter-ID eines Vorgesetzten.
Sie wird mit der ersten Dimension verbunden, um eine Baumstruktur zu schaffen.
Wenn dieser Wert leer ist oder auf einen nicht vorhandenen Knoten verweist, wird der Knoten
zu einem Root-Knoten oben in der Struktur.

EmployeeID ManagerID Name Titel

A101 Mary Bell CEO

A102 A101 John Bialik Chefsekretärin

O101 A101 Lee Mayer COO

I101 A101 Wendy Sanderson CIO

T101 A101 Asim Nawrat CTO

T102 T101 Emily Diaz VP Produkte

T103 T101 Christine Nemic VP F & E

Beispieldatensatz für ein Organisationsdiagramm

Sie können auch eine Kennzahl hinzufügen, die als Kartenbeschreibung verwendet wird.
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Vorbereiten des Datensatzes
Beim Vorbereiten des Datensatzes für ein Organisationsdiagramm müssen einige Dinge
berücksichtigt werden.

l Sie benötigen einen Datensatz mit weniger als 33.000 Zeilen.
Wenn Sie einen größeren Datensatz verwenden, werden die überzähligen Zeilen ignoriert.
Das kann zu einer inkorrekten Baumstruktur führen. Es wird eine Meldung angezeigt: Die
Datenobergrenze ist erreicht. Die Struktur wird möglicherweise nicht korrekt
dargestellt.

l Vergewissern Sie sich, dass die Daten keine Zirkelbezüge enthalten.
Zirkelbezüge können dazu führen, dass Knoten ausgelassen oder mehrere Root-Knoten
erstellt werden. Eine der folgenden Meldungen wird angezeigt:
Die Daten enthalten Zirkelbezüge, Knoten werden ausgelassen.
Kein Root-Knoten, prüfen Sie die Daten auf Zirkelbezüge.

l Wenn ein Knoten mehr als 99 untergeordnete Knoten enthält, werden die überzähligen
untergeordneten Knoten nicht gerendert.
Es wird eine Meldung angezeigt: Maximale Anzahl an untergeordneten Knoten erreicht,
Knoten werden ausgelassen.

l Vermeiden Sie große Mengen an Zeilen ohne übergeordneten Knoten. Diese werden als
Root-Knoten angezeigt. Die maximale Anzahl an Root-Knoten ist 99.

Erstellen eines Organisationsdiagramms
Sie können den Beispieldatensatz anhand eines Organisationsdiagramms visualisieren. Jeder
Mitarbeiter wird als Karte in einer Baumstruktur dargestellt, die Sie erweitern und reduzieren
können.

Gehen Sie folgendermaßen vor:

1. Fügen Sie Ihrem Arbeitsblatt ein Organisationsdiagramm hinzu.
2. Legen Sie EmployeeID als erste Dimension fest.
3. Legen Sie ManagerID als zweite Dimension fest.
4. Fügen Sie Bezeichnungen zu den Karten hinzu. Erweitern Sie die Dimension EmployeeID, um

die Bezeichnungseigenschaften anzuzeigen.
a. Legen Sie den Kartentitel auf Name fest.
b. Legen Sie den Kartenuntertitel auf Title fest.
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Ändern der Darstellung des Diagramms
Sie können die Darstellung des Organisationsdiagramms anpassen.

Hinzufügen einer Kennzahl zum Festlegen einer Beschreibung
Sie können eine Beschreibung anzeigen, indem Sie eine Kennzahl hinzufügen. Dadurch wird der
Wert ersetzt, der in der Eigenschaft Kartenbeschreibung festgelegt ist.

Ändern des Präsentationsmodus
Unter Darstellung > Präsentation > Präsentationsmodus können Sie festlegen, wie das
Organisationsdiagramm angezeigt wird. Organisationsdiagramme können entweder die gesamte
Struktur anzeigen oder reduziert und erweitert werden. Wenn ein Organisationsdiagramm auf
Erweitern/Reduzieren festgelegt ist, können Sie auch festlegen, dass seine Größe bei jedem
Erweitern oder Reduzieren automatisch angepasst wird.

Ändern der Farben
Sie können die Farbe des Kartenhintergrunds auf zwei verschiedene Weisen ändern:

l Erweitern Sie unter Hintergrundfarbe der Karte die erste Dimension und legen Sie eine
Formel fest, die eine Farbe oder einen Farbcode zurückgibt. Sie können in der Formel auf
Datenfelder verweisen.

l Legen Sie unter Darstellung > Präsentation > Hintergrundfarbe eine Hintergrundfarbe fest.
Sie können alle Karten auf eine einzelne Farbe festlegen oder eine Formel verwenden. Wenn
Sie eine Formel verwenden, können Sie nicht auf Datenfelder verweisen.

Sie können auch die Textfarbe mit Darstellung > Präsentation > Schriftfarbe festlegen.

Ändern von Kartenrahmen
Unter Kartendarstellung können Sie wählen, ob die Karten für Organisationsdiagramme Rahmen
und obere Leisten aufweisen. Wenn Sie Rahmen festlegen möchten, können Sie unter Darstellung
> Präsentation > Rahmenfarbe eine Rahmenfarbe festlegen. Sie können für Rahmen einzelne
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Farben festlegen oder eine Formel verwenden. Wenn Sie eine Formel verwenden, können Sie nicht
auf Datenfelder verweisen.

Auswahlen im Organisationsdiagramm
Sie können Karten im Organisationsdiagramm auswählen. Wenn Sie eine Karte auswählen, werden
alle untergeordneten Knoten unter der Karte ebenfalls in die Auswahl eingeschlossen.

Informationen zu allgemeinen Beschränkungen finden Sie unter Limitations (page 463).

P&L pivot chart
You can use the P&L pivot chart to create a pivot table with a layout for profit and loss
reporting. You can color cells according to performance and style the chart with
custom fonts and alternating row colors. You can also download the chart to Excel
including formatting. The P&L pivot chart is included in the Visualization bundle.

Dimensions Measures Result

1 dimension up to 9
measures

A table with one row for each dimension value and one column
for each measure.

2 dimensions up to 8
measures

A pivot table with one row for each value of the first dimension
and one column for each measure pivoted using the second
dimension.

P&L pivot chart dimensions and meaures
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Coloring cells to show performance
You can color cells to show performance according to a scale of Poor, Fair and Good. All rows and
columns are colored by default, but you can choose which columns and rows to color if you want to.

Gehen Sie folgendermaßen vor:

1. Make sure that Enabled is set to On under Appearance > Color by condition.
2. Select which rows to color by performance.

Set Color all rows by condition to Specified rows.
Add rows to color by name (dimension value) with Add row to color.

3. Select which measures to color by performance.
Set Color all measures to Specified measures.
Add a list of measures by number in Measure indices with the first measure of the chart
numbered zero. Separate the measures with a comma.

Beispiel: Color the first, third, and fifth measure.

0,2,4
4. Set performance limits and colors.

You can set the range limits for Poor and Fair.
l All cells with a value lower than the Poor range limit are displayed with the background

color and text color set for Poor.
l All cells with a value lower than the Fair range limit, but higher than Poor, are displayed

with the background color and text color set for Fair. You should set the Fair range
limit higher than Poor.

l All other cells are displayed with the background color and text color set for Good.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 503



3   Visualizations

Styling the chart using a style template
You can create a layout for the chart, for example to show a profit and loss report, using a style
template.

You need to be able to add and load a CSV file to the app.

Gehen Sie folgendermaßen vor:

1. Create a style template as a CSV file. Use the style template format described below.
2. Load the style template to your app as one field. When you add the file, do not use semicolon

as field separator, each row should be loaded as one field.
3. Set Style template field under Appearance > Table format to the name of the template field

you added.

You can load several style templates in your app, and change the layout with Style template field.

Style template format
The style template is created as a comma separated text file (CSV) using UTF-8 encoding.

The style template rows need to align to the data in your first dimension. You need to refer to a
dimension value in the template. The dimension value should be first in every row. You do not need
to specify all rows/dimension values in the template. The style template can contain maximum 5000
rows.

Each row in the template should be in the following format. It is not required to use a header row.

DimensionValue;Bold;Background;FontStyle;TextColor;Align;FontSize;Comment

l DimensionValue
The dimension value of the row that you want to style.

l Bold
Set to <bold> if you want bold text.

l Background
Set a background color. You can use <dark>, <night>, <soft>, <red>, <orange>, <violete>,

<blue>, <green> or a color code in RGB format, for example rgb(183,219,255). The default
background color is white.

l FontStyle
You can set the font style to <italic> or <oblique>.

l TextColor
You can set the color of the text to <white>. The default background color is black.

l Align
You can center align the text with <center>. The default alignment is left for text and right for
numeric values.

l FontSize
You can set the font size to <large>, <medium> (default) or <small>.

l Comment
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You can use the <comment> tag to replace all zero values with a space. This is useful when you
want to include a sub header row. without values.

You can also use the style tags in any order, and exclude tags that are not used. These rows will
give the same result:

Operating expenses;<bold>;;<italic>;;;;

Operating expenses;<italic>;<bold>

Style template example for profit and loss reporting
Cost of goods sold;<bold>;RGB(225,226,226);;;;;

Extraordinary items after tax;<bold>;RGB(193,216,47);;;<center>;<large>;

Extraordinary items;<bold>;;<italic>;;<center>;;<comment>

Financial revenue & expenses;<bold>;;<italic>;;<center>;;<comment>

General & administrative expenses;<bold>;;<italic>;;<center>;;<comment>

Gross profit;<bold>;RGB(193,216,47);;;<center>;<large>;

Income before tax & extraordinary items;<bold>;RGB(193,216,47);;;;<large>;

Manufacturing overhead;<bold>;;<italic>;;<center>;;<comment>

Net costs of goods sold;<bold>;RGB(225,226,226);;;;;

Net gain on sale of land;<bold>;RGB(193,216,47);;;<center>;<large>;

Net Income (Profit);<bold>;#191970;;<white>;<center>;<large>;

Net mfr overhead;<bold>;RGB(225,226,226);;;;;

Net sales revenues;<bold>;RGB(225,226,226);;;;;

Operating expenses;<bold>;;<italic>;;;;

Operating income before taxes;<bold>;RGB(193,216,47);;;;<large>;

Other general & admin expenses;<bold>;rgb(128, 191, 255);<white>;;<center>;<large>;

Revenues;<bold>;;<italic>;;<center>;;<comment>

total general & admin expenses;<bold>;#efefef;;;;;

total operating expenses;<bold>;rgb(128, 191, 255);<white>;;;;

Total selling expenses;<bold>;RGB(225,226,226);;;;;

To use this template, you need a data file where the first dimension contains values that correspond
to the first item of each row, for example Cost of goods sold.
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P&L pivot chart styled with the layout template in the example

Using the styling panel to further customize the appearance
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart. Sie

können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
For information about general limitations, see Limitations (page 463).

l There is a limitation for data transfer between Qlik Engine and P&L pivot. This limits each
request for data to 10000 elements, for example, 1000 rows and 10 columns. P&L pivot can
make automatic requests for more data using pagination.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 507



3   Visualizations

You can set the limit of how much data to request with Pagination > Max pagination loops.
The default value is 20000 elements (20k cells) and the maximum value is 40000 elements.
You can also modify the error message displayed to the user when the data limit is exceeded.
The recommended workaround when the data limit is exceeded is to apply filters to the data
to limit the data transfer.

l It is not possible to convert a P&L pivot chart to another visualization or convert another
visualization to a P&L pivot chart.

Pivot table
The pivot table (Pivot) presents dimensions and measures as rows and columns in a
table. In a pivot table you can analyze data by multiple measures and in multiple
dimensions at the same time.

Pivot table, with expansions

When to use it
Pivot tables are useful when you want to include several dimensions or measures in a single table,
and then want to reorganize them to see different subtotals. The Qlik Visualization bundle pivot
table offers several different layout and styling options than the pivot table visualization, including:

l Headers for all dimensions
l Header menu options for all dimensions
l Custom null representation
l Customizable column widths by pixel or percentage
l Adjust column widths using mouse
l Totals at top or bottom
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Creating pivot tables

Gehen Sie folgendermaßen vor:

1. In the assets panel, open Custom objects > Visualization bundle and drag Pivot to the
sheet.

2. Click Add and select a field or master dimension for the row dimension.
Optionally, add more dimensions as rows. The pivot table drills down rows in the order they
are added. You can click and drag the dimensions to reorder them.

3. Click Add and select a field or master measure for the measure.
Optionally, add more measures.

You can adjust appearance and other settings in the advanced properties panel.

Pivoting your data in the properties panel
In the properties panel, you can add measures and dimensions to the pivot table, as well as pivot
rows or columns.

Data
In the data pane, you can add dimensions and measures. You can move items between rows and
columns. You can also change item order inside rows or columns. When you use more than one
measure, they are grouped and a Values item is created.
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Sorting
On the sorting pane in advanced properties, you can change the internal order of dimensions and
measures.

When sorting pivot tables, NULL values are always displayed first.

Sort by first measure
If you have more than one measure, a measure group is created. Sort by first measure will sort
dimension values by the numeric value of the first measure. This sort order will affect all dimensions
and take precedence before any other sort order defined under the dimensions.
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For example, you have two measures: Quantity and Sales. In the properties pane, under Data>
Measures, Quantity is listed first. If you Sort by first measure in descending order, your table is
sorted starting with the dimension with the highest Quantity.

If Sort by first measure is turned off, the table uses the sort order configured for the dimensions.

Pivot table in Edit mode. Sort by first measure has been toggled on.

Limitations:

l This option is only supported if subtotals are calculated. You can calculate subtotals by doing
one of the following:

o In the properties pane, go to Data, and click on a dimension. Toggle on Show totals.
o In the properties pane, go to Appearance > Presentation. Toggle on Indent rows.

l This option is not supported for calculated dimensions.
l This option is only supported if all dimensions are in the Row section and all measures are in

the Column section.

Dimension sorting
With Sort by first measure turned off, the table can be sorted by dimension values. Each
dimension can have Auto or Custom sorting. With Auto sorting, field values are sorted
alphabetically and numerically in ascending order. With Custom sorting, you can turn each of the
following settings on or off:
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l Sort by expression: Sorts by custom expression. Sort by expression overrides the Sort
numerically and Sort alphabetically settings. This option should only be used with the first
(outermost) dimension in the table.

l Sort numerically: Sorts field values starting with a number.
l Sort alphabetically: Sorts field values starting with a letter.

Ascending and Descending options are available for all three settings.

Sorting in search
The user can click a dimension name in the table to expand a listbox. In the listbox, the user can
search and select individual dimension values. The Sorting in search setting controls the sort order
of the values in a dimension listbox.

You have the following options for the listbox sort order:

l Auto: Uses the default sort order. Numbers are sorted numerically in ascending order. Text is
sorted alphabetically in ascending order.

l Inherit from dimension: Uses the sort order defined for the individual dimension.

Formatting dimension and measure columns
You can format your dimension and measure columns with additional options. You can:

l Limit displayed dimensions
l Format dimension representation
l Format measure numbers
l Create conditional columns
l Set background color of cells using expressions
l Set text color with expressions
l Setting column width

Limiting displayed dimensions
Limit the number of displayed values for a dimension. When you set a limitation, the only
dimensions displayed are those where the measure value meets the limitation criterion.

Gehen Sie folgendermaßen vor:

1. Under Data, select a dimension and expand the properties.
2. Under Limitation, select one of the following limitations:

l No limitation: The default value.
l Fixed number: Select to display the top or bottom values. Set the number of values.

You can also use an expression to set the number. Klicken Sie zum Öffnen des Formel-
Editors auf .

l Exact value: Use the operators and set the exact limit value. You can also use an
expression to set the number. Klicken Sie zum Öffnen des Formel-Editors auf .
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l Relative value: Use the operators and set the relative limit value in percent. You can
also use an expression to set the number. Klicken Sie zum Öffnen des Formel-Editors
auf .

Formatting dimension representation
You can format dimension columns to show values, links, or images using Representation in the
properties panel. You can select the following representations: 

l Text: Displays the dimension values as text. This is the default value.
l Link: Displays values as clickable links. Either the dimension value is used or the URL or you

can add other URLs to the displayed dimension values.
l Image: Displays values that contain an absolute URL to an image display as images.

Formatting links

The character ; is not supported as a query parameter separator in a URL.

Gehen Sie folgendermaßen vor:

1. Under Data, select a dimension and expand the properties.
2. Under Representation, select Link.
3. Under Link setting, select one of the following:

l Add label: The dimension contains the destination URL in either the dimension
expression or the data table. The links are displayed and ordered by destination
URL expression.
Under Link label, enter a descriptive text label for the destination URL. Click to
open the expression editor.

l Add URL: The dimension values become selectable text links that are labels for the
URLs.
Under Link URL, enter the destination URL expression. Click to open the
expression editor.

Formatting images

Images in pivot tables are only accessible from servers and domains that have been
safe-listed. Administrators make these resources available in the Management Console
by adding Content-Security-Policies (CSP) for each server or domain. CSP helps to
prevent cross-site scripting attacks by controlling what resources a browser can
request from a server.

The character ; is not supported as a query parameter separator in a URL.
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Gehen Sie folgendermaßen vor:

1. Under Data, select a dimension and expand the properties.
2. Under Representation, select Image.
3. Under Image setting, select one of the following:

l Add label: The dimension contains the absolute URL to the image in either the
dimension expression or the data table. The links are displayed and ordered by the
URL expression.
Under Image label, enter a descriptive text label for the image that displays as
alternative text when the image is hovered over. Click to open the expression
editor.

l Add URL: The dimension values become labels for the alternative text that displays
when the image is hovered over.
Under Image URL, enter the destination URL expression. Click to open the
expression editor.

4. Under Sizing, select one of the following sizing options:
l Always fit
l Fit to width
l Fit to height
l Stretch to fit
l Original size

5. Under Position, select the image position within the cell.

Formatting measure numbers
You can format measure numbers under Number formatting in the properties panel.

If you want to change the number format at app level, and not just for a single measure, it is better
to do that in the regional settings in the SET statements at the beginning of the script in the data
load editor.

Gehen Sie folgendermaßen vor:

1. Under Data, select a measure and expand the properties.
2. Under Number formatting, select the format:

l Auto: Qlik Sense automatically sets a number formatting based on the source data.
To represent numeric abbreviations, the international SI units are used, such as k
(thousand), M (million), and G (billion).

l Number: By default, the formatting is set to Simple, and you can select the formatting
from the options in the list. Change to Custom to and enter the format pattern under
Format pattern.
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Beispiele:

l # ##0 liefert eine ganze Zahl mit einem Tausendertrennzeichen. In diesem
Beispiel wird „.“ als Tausendertrennzeichen verwendet.

l ###0 describes the number as an integer without a thousands separator.
l 0000 describes the number as an integer with at least four digits. For example,

the number 123 will be shown as 0123.
l 0.000 liefert eine Zahl mit drei Dezimalstellen. In diesem Beispiel wird „.“ als

Dezimaltrennzeichen verwendet.
If you add the percent sign (%) to the format pattern, the measure values are
automatically multiplied by 100.

l Money: By default, the format pattern used for money is the same as set up in the
operating system. Use Format pattern to change the format pattern.

l Date: By default, the formatting is set to Simple, and you can select the formatting
from the options in the list. Change to Custom to and enter the format pattern under
Format pattern.

l Duration: By default, the format pattern used for duration is the same as set up in the
operating system. Duration can be formatted as days, or as a combination of days,
hours, minutes, seconds and fractions of seconds. Use Format pattern to change the
format pattern.

l Custom: By default, the format pattern used for custom is the same as set up in the
operating system. Use Format pattern to change the format pattern.

Creating conditional columns
Columns can be conditional, so that they only appear when certain conditions are met.

Gehen Sie folgendermaßen vor:

1. Under Data, select a dimension or measure and expand the properties.

2. Under Show column if, click to open the expression editor.

3. Enter the expression to determine the conditions for the column to appear.
4. Click Apply.

Example
Angenommen, Sie haben eine Pivottabelle oder ein Pivot-Objekt, das Folgendes enthält:

l Die Dimensionen sind Product Type und Product Name.
l Die Kennzahlen sind Sum(Sales) und Count (distinct InvoiceNumber).
l Die Elemente unter Spalten sind Werte (Standard) und das Feld Quarter.
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Part 1: Conditional column based on user selections

You might have a large number of years of data in your app, so you do not want to add too much
clutter to the visualization. At the same time, you want to encourage granular and interactive
analysis.

For the Quarter column, you could add the following expression for Show column if:

GetSelectedCount(Year)=1

With this expression, if the user selects a single year in the app, the pivot table breaks down each
measure by quarter. If not, the total measure values are shown.

Part 2: Conditional columns using variables

You can use variables to encourage interactive analysis. Suppose you also create a variable
vUserInteraction with a blank definition. Then, you create two Button charts on your sheet,
configured with the Set variable value action:

l Show more detail: Clicking this button sets vUserInteraction to a value of ='Yes'.
l Show less detail: Clicking this button sets vUserInteraction to a value of ='No'.

In your pivot table, you could add a number of additional measures to the chart, such as Count
(Quantity) and Sum(Cost). Then, configure each measure column to have the following value for
Show column if:

'$(Reference)'='Yes'

This allows the chart to adapt to whether or not the user wants additional information. If the user
clicks the Show more detail button, additional measures are added to the table. If not, or if they
click Show less detail, the additional measures are removed.

l Show more detail: Clicking this button sets vUserInteraction to a value of ='Yes'.
l Show less detail: Clicking this button sets vUserInteraction to a value of ='No'.

In your pivot table, you could add a number of additional measures to the chart, such as Count
(Quantity) and Sum(Cost). Then, configure each measure column to have the following value for
Show column if:

'$(Reference)'='Yes'

This allows the chart to adapt to whether or not the user wants additional information. If the user
clicks the Show more detail button, additional measures are added to the table. If not, or if they
click Show less detail, the additional measures are removed.

Setting background color with expressions
You can define the background color for a column using expressions. For example, you can have
cells in the column change background color depending on the values in the column cell. The text
color automatically changes to white when a dark background color is used.
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Gehen Sie folgendermaßen vor:

1. Under Data, select a dimension or measure and expand the properties.

2. Under Background color expression, click to open the expression editor.

3. Enter the expression to determine the conditions for the column to appear.
4. Click Apply.

Setting text color with expressions
You can define the text color for a column using expressions. For example, you can have cells in the
column change text color depending on the values in the column cell.

Gehen Sie folgendermaßen vor:

1. Under Data, select a dimension or measure and expand the properties.

2. Under Text color expression, click to open the expression editor.

3. Enter the expression to determine the conditions for the column to appear.
4. Click Apply.

Setting column width
By default, column width is automatically set. You can manually set column width by:

l Content
l Pixels
l Percentage

You can also manually size the columns by dragging the header borders.

Gehen Sie folgendermaßen vor:

1. Under Data, select a dimension or measure and expand the properties.
2. Under Column width, select how you want to set column width:

l Fit to content: Columns are sized by the width of the content in the column.
l Pixels: Set the width of the column in pixels.
l Percentage: Set the width of the column by percent.
l Auto: Automatically set the column width with Qlik Sense.

Customizing styling
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.
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Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font, emphasis style, font size, and color for the following text
elements:

l Header: Style the text of the headers for all dimensions.
l Dimension values: Style the text dimension values.
l Measure values: Style the text of the measure values.
l Measure labels: Style the text of the measure headers.
l Total values: Style the text of the totals.
l Null values: Style the text of the null values.

Customizing the background
You can customize the background of the chart. You can also color individual dimensions or
measures by expression.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.
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4. On the Chart tab, customize the background color for the following elements:
l Header
l Dimension values
l Measure values
l Measure labels
l Total values
l Null values

Customizing the grid
You can customize the pivot table grid.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the Chart tab, customize the grid with the following elements:
l Row height: Set the height of rows in lines.
l Border: Set the color of the cell borders.
l Divider: Set the color of the divider between that divides both dimensions and

measures as well as header and rows.
l Background: Set the color of the empty area created when you have dimensions in

Column.

Customizing null values
You can change how null values are represented in the pivot table.

Gehen Sie folgendermaßen vor:

1. Click Appearance > Presentation in the properties panel.
2. Under Null value text, enter the text you want to replace null values with.

Expanding the pivot table fully
You can set the pivot table to always be fully expanded.

Gehen Sie folgendermaßen vor:

1. Click Appearance > Presentation in the properties panel.
2. Select Fully expanded.

Customizing the border and shadow
You can customize the border and shadow of the chart.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
Pivot tables have the following limitations:

l You cannot pivot data in your Visualization bundle pivot table when your sheet is in analysis
mode as you can with the visualization pivot table.

Radar chart
The Radar chart (Radar chart) displays a two-dimensional chart using radial axes to
chart one or more groups of values over multiple variables. Radar charts can be used to
visualize and compare performance to a set standard or to a group's performance. The
Radar chart is included in the Visualization bundle.

Radar charts requires two dimensions and one measure. The y-axis goes from the center to the
perimeter and the x-axis is the perimeter of the chart. Each value represents the distance from the
center of the chart, and displays on axes starting from the center. The center of the chart
represents the minimum value, and the edge the maximum value.

A radar chart can show multiple series, each separately connected with their values. The data only
goes around the chart once. Adding values only increases the chart's granularity.
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Understanding a radar chart
A radar chart consists of evenly spaced segments (axes) arranged radially around a point. There is
one segment for each data value of the second dimension. The value of each measure is shown by
a node on applicable axis. A line connects the values that belong to the same series creating the
chart’s star-like shape.
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A radar chart with one axis for each month of the Date.Month dimension.

When to use it
Radar charts let you compare and measure data with an arbitrary number of variables. This is
helpful when comparing something's features or performance over several metrics. For example:
before buying a computer, you can compare different computers across several features, such as
memory storage processing, and screen size. A radar chart is also useful when:

l Measuring quality improvements and performance.
l Comparing allocated amount versus actual spending in an organization.
l Identifying outliers, commonality, and clusters of data with similar values and features.
l Charting an athlete's strengths and weaknesses.
l Comparing results of small-to-moderate-sized multivariate data sets.

Creating a radar chart
You can create a radar chart on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Radar chart
object to the sheet.

2. Click the top Add dimension button and select the first dimension category to be measured
(x-axis).
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3. Click the second Add dimension button to select the second dimension (y-axis).
4. Click the Add measure button to select the measure of the chart.

Once dimensions and measure have been selected the radar chart displays automatically (in color)
in the chart field

A radar chart with two dimensions and one measure.

Changing the appearance of the chart
You can customize your radar chart with one or more features.

Changing the color scheme
You can change color scheme of your chart by choosing from four predefined options.

Gehen Sie folgendermaßen vor:

1. Click Appearance > Design in the property panel.
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2. Select a color scheme under Color.

Changing the stroke type
You can also customize the shape line connecting each node under Appearance > Design >
Stroke type in the properties panel. Select the shape from the menu.

Toggling the legend
The legend provides a small text description of each node of the chart. The legend expands to
show its text, and the chart shrinks to accommodate the legend. To toggle the legend, move the
slide button under Appearance > Design > Legend in the properties panel.

Limiting dimensions
You can set limits on your dimension values. To change limitations and terms go to Data >
Dimensions in the properties panel. Click dimension, and under Limitation choose a limitation from
the menu.

Toggling titles
This option can hide the name of the radar chart. To toggle the name, click Appearance > General
in the properties panel. Move the Show titles slide button.

Number formatting
The default setting for Number formatting for measures and dimensions is Auto. You can change
this setting to Number, and then select a number format.

Using the styling panel to further customize the appearance
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart. Sie

können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.
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For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
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5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
Radar charts have the following limitations:

l Radar charts can only process 100 unique values per dimension.
l Exported radar charts will not include the chart legend.
l For information about general limitations, see Limitations (page 463).

Sankey-Diagramm
Mit dem Sankey-Diagramm (Sankey-Diagramm) können Sie einen bestimmten Typ
Datenflussdiagramm zum Arbeitsblatt hinzufügen, das Sie gerade bearbeiten. Das
Diagramm hebt größere Übertragungen oder Datenflüsse innerhalb definierter
Systemgrenzen visuell hervor. Die Breite der Diagrammpfeile wird proportional zur
Datenflussmenge angezeigt. Das Sankey-Diagramm ist im Visualization Bundle
enthalten.

l Es sind mindestens zwei Dimensionen und eine Kennzahl erforderlich. Sie können bis zu fünf
Dimensionen, aber nur eine Kennzahl verwenden.

l Die Dimensionen müssen nicht auf jeder Seite des Diagramms gleich groß sein.
l Anhand von Dimensionswerten können Sie die Farbe der Datenflüsse im Diagramm

festlegen.
l Linkfarben können auf Quell- oder Zielankern basieren.
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Diagramm mit einer Quelldimension (Quartal) und der Zieldimension (Jahr)

Verwendung
Das Sankey-Diagramm ist hilfreich, wenn Sie maßgebliche Beiträge in einem Gesamtdatenfluss
auffinden möchten. Das Diagramm ist auch hilfreich, wenn Sie bestimmte Mengen zeigen möchten,
die innerhalb festgelegter Systemgrenzen aufrechterhalten werden.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 528



3   Visualizations

Erstellen eines Sankey-Diagramms
Sie können auf dem Arbeitsblatt, das Sie bearbeiten, ein Sankey-Diagramm erstellen.

Gehen Sie folgendermaßen vor:

1. Öffnen Sie im Extras-Fenster die Option Benutzerdefinierte Objekte > Visualization bundle
und ziehen Sie ein Sankey-Diagramm-Objekt auf das Arbeitsblatt.

2. Klicken Sie auf obere Schaltfläche Dimension hinzufügen und wählen Sie die
Quelldimension für den Datenfluss des Diagramms (wird links angezeigt).

3. Klicken Sie auf die zweite Schaltfläche Dimension hinzufügen, um die Zieldimension für den
Datenfluss des Diagramms auszuwählen (wird rechts angezeigt).

4. Klicken Sie auf die Schaltfläche Kennzahl hinzufügen, um die Kennzahl des Diagramms
auszuwählen.

Nachdem Dimensionen und Kennzahl ausgewählt wurden, wird das Sankey-Diagramm (in Farbe)
automatisch im Diagrammfeld angezeigt.

Hinzufügen von zusätzlichen Dimensionen
Sie können bis zu fünf Dimensionen zu Ihrem Diagramm im Eigenschaftsfenster unter Daten >
Dimensionen hinzufügen. Das Diagramm wird aktualisiert, sodass die hinzugefügten Dimensionen
widergespiegelt werden. Die Dimensionen werden von links nach rechts angezeigt, wobei die erste
eingegebene Dimension immer die Quelldimension darstellt. Die Zieldimension wird immer auf der
rechten Seite angezeigt. Wenn Sie mehr Dimensionen hinzufügen, werden sie rechts in der
Reihenfolge hinzugefügt, in der sie eingegeben werden.

Ein Diagramm mit drei Dimensionen: Quelldimension (Ursprung), Zieldimension (Entscheidung) und
zusätzliche Dimension (Ziel)
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Sortieren
Sankey-Diagrammelemente werden automatisch vom größten zum kleinsten Fluss sortiert. Sie
können die Sortierreihenfolge im Eigenschaftsfenster ändern.

Gehen Sie folgendermaßen vor:

1. Klicken Sie unter Darstellung im Eigenschaftsfenster auf Sortieren.
2. Wechseln Sie unter Sortieren von Automatisch zu Benutzerdefiniert.
3. Sie können Numerisch sortieren umschalten:

l Einschalten: Sortieren Sie numerisch Aufsteigend oder Absteigend.
l Ausschalten: Ziehen Sie Ihre Dimensionen und Kennzahlen in die gewünschte

Reihenfolge.

Ändern des Designs und der Darstellung
Sie können Ihr Diagramm mit einer oder mehreren Funktionen anpassen. Ihr Diagramm wird
automatisch aktualisiert.

Linkfarben
Die Farben von Diagrammlinks basieren entweder auf den Quell- oder den Zielankern. Um die Quell-
oder Zielankerfarbe auf die Diagrammlinks anzuwenden, verwenden Sie die Zeichenfolge
='SOURCE' oder ='TARGET'. Sie können auch eine andere Farbe auswählen, indem Sie eine
Farbcodezeichenfolge eingeben. Bei der Farbe muss es sich um eine gültige CSS-Farbe handeln.

Gehen Sie folgendermaßen vor:

1. Klicken Sie unter Darstellung im Eigenschaftsfenster auf Präsentation.
2. Geben Sie die entsprechende Zeichenfolge unter Linkfarbe ein.
3. Drücken Sie die Eingabetaste. Daraufhin wird das Diagramm aktualisiert.

Sie können die Linkfarben auch anhand einer Formel im Formel-Editor ändern ( ). Es ist auch
möglich, einen Link einzufärben, dessen Intensität auf dem Margen-% der Dimensionswerte basiert.

Beispiel:

Geben Sie die Zeichenfolge =rgb(round(Avg ([Margin %])*255), 100, 100) ein, wobei Margen-% ein
Wert zwischen 0 und 1 ist und der Link im Diagramm rot angezeigt wird.

Linkdeckkraft
Sie können die Linkdeckkraft durch Verschieben der Schiebeschaltfläche auf dem
Linkdeckkraftleiste unter Darstellung > Linkdeckkraft im Eigenschaftsfenster anpassen.
Außerdem können Sie durch Festlegen der Deckkraft auf 1 (Position ganz rechts) die Einstellung
zum Platzieren eines Schattens aktivieren, wodurch Links ein individuelles Erscheinungsbild
erhalten.
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Knotenfarben
Sie können die Knotenfarben jedes Dimensionswerts ändern. Bei der Farbe muss es sich um eine
gültige CSS-Farbe handeln.

Gehen Sie folgendermaßen vor:

1. Wählen Sie die entsprechende Dimension im Eigenschaftsfenster unter Daten >
Dimensionen.

2. Geben Sie die Farbcodezeichenfolge unter Knotenfarbe ein und drücken Sie die
Eingabetaste. Das Diagramm wird aktualisiert.
Beispiel: Um die Farbe Aqua (#00ffff) zu verwenden, setzen Sie den Farbcode-String auf
='#00ffff'. Sie können die Knotenfarben auch anhand einer Formel im Formel-Editor
festlegen ( ).

Knotenabstand und -breite
Sie können sowohl den vertikalen Abstand zwischen Knoten („Knotenabstand“) als auch die
horizontale Breite der Diagrammknoten („Knotenbreite“) festlegen.

Gehen Sie folgendermaßen vor:

1. Klicken Sie unter Darstellung im Eigenschaftsfenster auf Präsentation.
2. Verschieben Sie die entsprechende Schiebeschaltfläche des Knotenabstands und/oder die

Schieberegler für Knotenbreite, um die Knoteneinstellungen anzupassen.

Verwenden des Designfensters zur weiteren Anpassung der Darstellung
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.
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Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. On the Chart tab, set the font, font size, and color for the following text elements:
l Node title: Style the text of the header for each node in the chart.
l Node label: Style the text of the labels displaying the individual values of the nodes.

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.
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Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Einschränkungen
Informationen zu allgemeinen Beschränkungen finden Sie unter Limitations (page 463).

Tabellendiagramm
Dias Tabellendiagramm zeigt mehrere Felder gleichzeitig, wobei die Inhalte jeder Zeile
logisch verknüpft sind. Eine Tabelle kann aus so vielen Dimensionen und Kennzahlen
wie erforderlich bestehen. Das Tabellendiagramm ist im Visualization Bundle
enthalten.

App-Ersteller können mehrere Felder gleichzeitig hinzufügen, die Tabelle auf Spaltenebene
anpassen, alternative Dimensionen und Kennzahlen hinzufügen, die Spaltenbreite festlegen,
Paginierung anwenden und Diagrammprüfung aktivieren.

Anhand der Diagrammprüfung können Benutzer ohne Bearbeitungsrechte das ursprüngliche
Tabellendiagramm anpassen, während sie sich im Analysemodus befinden. Diese Benutzer können
Spalten hinzufügen oder entfernen, die Sortierreihenfolge ändern, Spalten neu anordnen und
Auswahlen treffen. Sie können dann das neue Tabellenlayout teilen, herunterladen, abonnieren
oder mit einem Lesezeichen versehen. Die Änderungen, die ein Benutzer im Diagrammprüfmodus
vornimmt, sind für andere Benutzer, die das Arbeitsblatt analysieren, nicht sichtbar.

Diese Seite behandelt das Tabellendiagramm im Visualization Bundle. Weitere
Informationen zum nativen Tabellenobjekt finden Sie unter Table (page 364).
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Verwendung
Verwenden Sie ein Tabellendiagramm, wenn Sie detaillierte Daten und genaue Werte anstelle von
Visualisierungen von Werten anzeigen möchten. Tabellen eignen sich besonders für den Vergleich
einzelner Werte. Drilldown-Gruppen-Dimensionen sind in Tabellen sehr effektiv. Sie können so
innerhalb eines begrenzten Platzes einen Drilldown auf die nächste Detailebene durchführen und
die aktualisierten Kennzahlwerte analysieren. Verwenden Sie diese Tabelle, wenn Sie möchten,
dass die Benutzer benutzerdefinierte Tabellen im Analysemodus erstellen können.

Vorteile
Sie können Tabellen auf unterschiedliche Weisen filtern und sortieren. Eine Tabelle kann viele Werte
enthalten. Mit einem Drilldown in einer Tabelle nutzen Sie den begrenzten Platz des Arbeitsblattes
optimal aus. Eine Tabelle ist ausgezeichnet dafür geeignet, exakte Werte statt Trends und Muster
darzustellen. Tabellen sind eine einfache Möglichkeit, Daten in andere Programme zu exportieren.

Nachteile
Wenn ein Tabellendiagramm viele Werte enthält, ist es schwierig, einen Überblick über deren
Beziehung zu erhalten. Auch Unregelmäßigkeiten lassen sich innerhalb einer Tabelle nur schwer
erkennen.

Best Practices für das Optimieren von Tabellen
Wenn eine Tabelle zu viele Dimensionen und Kennzahlen enthält, wird sie möglicherweise nur
langsam geladen. Als Best Practice wird empfohlen, die meisten Ihrer Felder und Formeln als
alternative Spalten hinzuzufügen. Dadurch werden Benutzer veranlasst, nur die Felder
hinzuzufügen, die sie für die Diagrammprüfung benötigen.

Zudem können Sie die Leistung steigern, indem Sie sicherstellen, dass eine Tabelle maximal 10
Spalten umfasst.
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Tabellen, die Felder aus einer einzelnen Datenquelle extrahieren, weisen eine bessere Leistung auf
als Tabellen mit Feldern aus mehreren Datenquellen.

Erstellen von Tabellendiagrammen
Sie können auf dem Arbeitsblatt, das Sie bearbeiten, ein neues Tabellendiagramm erstellen.

Gehen Sie folgendermaßen vor:

1. Öffnen Sie im Extras-Fenster die Option Benutzerdefinierte Objekte > Qlik Visualization
bundle und ziehen Sie ein Tabellendiagramm-Objekt auf das Arbeitsblatt.

2. Klicken Sie auf Spalten hinzufügen, um Elemente zur Tabelle hinzuzufügen. Ein Dropdown-
Menü wird geöffnet:

l Felder und Master-Elemente: Ein durchsuchbares Dialogfenster wird geöffnet, das
die einzelnen Felder und Master-Elemente anzeigt. Sie können wählen, ein beliebiges
Element als Dimension oder Kennzahl hinzuzufügen.

l Benutzerdefinierte Formel: Ein Dialogfenster wird geöffnet, in dem Sie eine Formel
eingeben können. Sie können auch den Formel-Editor öffnen.

3. Klicken Sie im Eigenschaftsfenster unter Daten auf , um weitere Dimensionen oder
Kennzahlen zur Tabelle hinzuzufügen.

Wenn Sie die Tabelle erstellt haben, können Sie ihre Darstellung und andere Einstellungen über das
Eigenschaftenfenster ändern.

Standardmäßig sind die Spaltenbreiten alle auf einen Wert festgelegt, sodass ihre
Summe der Diagrammbreite entspricht. Sie können die Breite der Spalte durch Ziehen
des Headerunterteilers einstellen. Ein Doppelklick auf den Headerunterteiler stellt die
Standardbreite wieder her.

Arbeiten mit Tabellenelementen

Gehen Sie folgendermaßen vor:

1. Aktivieren Sie im Eigenschaftsfenster auf der Registerkarte Daten unter Spalten und
Alternative Spalten das Kontrollkästchen neben einem beliebigen Element. Klicken Sie auf

, um Aktionen wie Ausschneiden, Einfügen und Löschen durchzuführen. Aktivieren Sie das
Kontrollkästchen neben Spalten oder Alternative Spalten, um alle Elemente in der Liste
auszuwählen. Verwenden Sie die Pfeilsymbole, um Elemente zwischen den einzelnen
Abschnitten zu verschieben.

Alternative Spalten sind Spalten, die von Benutzern ausgewählt und zur Tabelle
hinzugefügt werden können, wenn sie Verwenden der Diagrammprüfung (page
546) verwenden.
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2. Um die Spaltenreihenfolge zu ändern, klicken Sie auf neben einem Feld oder einer Formel
und ziehen Sie das Element.

3. Klicken Sie auf einen Elementnamen, um dessen individuelle Eigenschaften zu öffnen. Hier
können Sie die Bezeichnung ändern, eine Hintergrundfarbe für die Spalte festlegen, die
Textausrichtung steuern, die Spaltenbreite festlegen usw. Weitere Informationen finden Sie
in den Abschnitten unten.

Wenn Textausrichtung auf Automatisch eingestellt ist, werden Spaltendaten
gemäß dem Datentyp ausgerichtet: Textwerte werden linksbündig und
Zahlenwerte, einschließlich datumsbezogener Werte, rechtsbündig ausgerichtet.
Wenn Benutzerdefiniert ausgewählt wird, können Sie die Daten linksbündig,
zentriert oder rechtsbündig ausrichten.
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Registerkarte „Daten“ im Eigenschaftsfenster bei ausgewähltem Tabellendiagramm. Das Feld „Customer“ 
wurde angeklickt. Daher werden die zugehörigen Dimensionseigenschaften links angezeigt.
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Definieren des Spaltentextstils mit einer Formel
Für jede Spalte können Sie eine getrennte Formel festlegen, um zu definieren, wie der Spaltentext
formatiert wird. Wenn Sie den Text einer Spalten mit einer Formel formatieren, überschreibt diese
Formel die App-Formatvorlage und jedes benutzerdefinierte Design, das auf die Visualisierung
angewendet wurde, für die betreffende Spalte.

Sie können die folgende Syntax in Ihrer Formel verwenden, um die Formatierung zu definieren (bei
dem Buchstaben im Tag wird nicht zwischen Groß- und Kleinschreibung unterschieden):

l <B>: Fett
l <I>: Kursiv
l <U>: Unterstrichen
l <S>: Durchgestrichen

Es können mehrere der obigen Optionen gleichzeitig angewendet werden.

Beispiele:

if(avg(Sales) > 300, '<B>')

if(count(OrderID) = 0, '<S>')

if(sum(Sales) > 100000, '<B><U>', '<I>')

Gehen Sie folgendermaßen vor:

1. Wählen Sie unter Daten eine Spalte aus und öffnen Sie in den Eigenschaften die Option
Präsentation.

2. Geben Sie unter Textstilformel die Formel ein. Klicken Sie zum Öffnen des Formel-Editors
auf .

Formatieren der Dimensionsdarstellung
Sie können Dimensionsspalten formatieren, um Werte, Links oder Bilder anzuzeigen, indem Sie im
Eigenschaftsfenster die Option Darstellung verwenden. Sie können die folgenden Darstellungen
auswählen: 

l Text: Zeigt die Dimensionswerte als Text an. Dies ist der Standardwert.
l Link: Zeigt Werte als klickbare Links an. Entweder der Dimensionswert oder die URL wird

verwendet. Sie können auch weitere URLs zu angezeigten Dimensionswerten hinzufügen.

Formatieren von Links

Das Zeichen ; wird als Abfrageparameter-Trennzeichen in einer URL nicht unterstützt.
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Gehen Sie folgendermaßen vor:

1. Wählen Sie unter Daten eine Dimension aus und öffnen Sie in den Eigenschaften die Option
Präsentation.

2. Wählen Sie unter Darstellung die Option Link aus.
3. Wählen Sie unter Link-Einstellung eine der folgenden Optionen aus:

l Bezeichnung hinzufügen: Die Dimension enthält die Ziel-URL entweder in der
Dimensionsformel oder in der Datentabelle. Die Links werden nach URL-Zielformel
angezeigt und sortiert.
Geben Sie unter Link-Bezeichnung eine Bezeichnung mit beschreibendem Text für
die Ziel-URL ein. Klicken Sie zum Öffnen des Formel-Editors auf .

l URL hinzufügen: Die Dimensionswerte werden zu auswählbaren Text-Links, die
Bezeichnungen für die URLs sind.
Geben Sie unter Link-URL die URL-Zielformel ein. Klicken Sie zum Öffnen des Formel-
Editors auf .

Formatieren von Bildern

Auf Bilder in Tabellendiagrammen kann nur über Server und Domänen zugegriffen
werden, die auf die sichere Liste gesetzt wurden. Administratoren können diese
Ressourcen in der Verwaltungskonsole bereitstellen, indem sie für jeden Server bzw.
jede Domäne Content-Security-Policies (CSP) hinzufügen. CSP tragen zur
Verhinderung von siteübergreifenden Skripting-Angriffen bei, indem kontrolliert wird,
welche Ressourcen ein Browser von einem Server anfordern kann.

Das Zeichen ; wird als Abfrageparameter-Trennzeichen in einer URL nicht unterstützt.

Gehen Sie folgendermaßen vor:

1. Wählen Sie unter Daten eine Dimension aus und öffnen Sie in den Eigenschaften die Option
Präsentation.

2. Wählen Sie unter Darstellung die Option Bild aus.
3. Wählen Sie unter Bildeinstellung eine der folgenden Optionen aus:

l Bezeichnung hinzufügen: Die Dimension enthält die absolute URL zum Bild entweder
in der Dimensionsformel oder in der Datentabelle. Die Links werden nach URL-Formel
angezeigt und sortiert.
Geben Sie unter Bildbezeichnung einen beschreibenden Text für die Bezeichnung
des Bildes ein, die als alternativer Text angezeigt wird, wenn der Benutzer den
Mauszeiger über das Bild hält. Klicken Sie zum Öffnen des Formel-Editors auf .

l URL hinzufügen: Die Dimensionswerte werden zu Bezeichnungen für den alternativen
Text, der angezeigt wird, wenn der Benutzer den Mauszeiger über das Bild hält.
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Geben Sie unter Bild-URL die URL-Zielformel ein. Klicken Sie zum Öffnen des Formel-
Editors auf .

4. Wählen Sie unter Größe anpassen eine der folgenden Größenoptionen aus:
l Immer anpassen
l Auf Breite anpassen
l Auf Höhe anpassen
l Auf passende Größe strecken
l Originalgröße

5. Wählen Sie unter Position die Bildposition innerhalb der Zelle aus.

Sortieren der Tabelle
Sie können die Sortierung der Tabelle auf unterschiedliche Arten anpassen:

l Spaltensortierung: Dabei passen Sie die Reihenfolge der Dimensionen und Kennzahlen von
links nach rechts an.

l Zeilensortierung: Dabei passen Sie die Reihenfolge der Zeilen nach Sortierpriorität an.
l Interne Sortierung: Dabei verwenden Sie die interne Sortierreihenfolge von Dimensionen und

Kennzahlen.
l Interaktive Sortierung: Während der Analyse können Sie auf eine Spaltenüberschrift klicken,

um die Tabelle zu sortieren.

Spaltensortierung
Standardmäßig wird die Reihenfolge, in der Spalten sortiert werden, durch die Reihenfolge
bestimmt, in der Dimensionen und Kennzahlen zur Tabelle hinzugefügt werden. Wenn Sie als Erstes
die Kennzahl Sales hinzufügen, wird sie in der Tabelle als Erstes (ganz links) angezeigt. Die nächste
Dimension oder Kennzahl, die hinzugefügt wird, wird in der zweiten Spalte angezeigt, usw. Die
Spaltensortierreihenfolge kann im Eigenschaftsfenster unter Spalten geändert werden.

Zeilensortierung
Standardmäßig werden Zeilen nach der zuerst hinzugefügten Dimension oder Kennzahl sortiert,
numerische Werte in absteigender, Textwerte in aufsteigender Reihenfolge. Ein kleiner Pfeil unter
der Spaltenüberschrift zeigt, nach welcher Spalte die Tabelle sortiert ist.

Sie können die Zeilensortierung im Eigenschaftsfenster unter Sortieren ändern. Ziehen Sie die
Dimensionen und Kennzahlen, um die Sortierreihenfolge zu ändern. In vielen Fällen wird die
Sortierung nicht nur von der ersten Dimension oder Kennzahl unter Sortierung, sondern auch von
den darauffolgenden beeinflusst.

Beispiel:

Im folgenden Screenshot sind die Zeilen zuerst nach Customer, dann nach Month und dann nach
Product Type sortiert. Wie Sie sehen, haben die Spalten Customer und Month mehrere Zeilen mit
denselben Werten (A-2-Z Solutions und Month). Die Zeilen in Product Type sind alphabetisch
geordnet, es werden jedoch nur diejenigen, die im Januar dem Kunden A-2-Z Solutions verkauft
wurden, angezeigt.
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Indem die Sortierreihenfolge so geändert wird, dass die sekundäre Sortierung nach Product Type,
gefolgt von Month, erfolgt, werden alle Product Type-Elemente, die dem Kunden A-2-Z Solutions
verkauft wurden, in alphabetischer Reihenfolge angezeigt. Unter Month werden hingegen nur die
Monate angezeigt, in denen sie verkauft wurden.
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Interne Sortierung
Jede Dimension und Kennzahl weist eine standardmäßige (Auto) interne Sortierreihenfolge auf, die
geändert werden kann. Klicken Sie unter Sortierung auf das Element, das Sie ändern möchten, und
klicken Sie dann auf die Schaltfläche, um zur Sortierfolge Benutzerdefiniert zu wechseln.
Änderungen an der internen Sortierung eines Elements haben möglicherweise keine Auswirkung,
wenn die Sortierung im Konflikt zu einem Element mit höherer Priorität steht.

Interaktive Sortierung
Während einer Analyse können Sie einstellen, welche Spalte sortiert wird, indem Sie auf die
Spaltenüberschrift klicken. Beim ersten Klick wird die Tabelle gemäß der Standardsortierung des
ausgewählten Elements sortiert. Bei einem zweiten Klick wird die Sortierreihenfolge umgedreht. Die
interaktive Sortierung ist sitzungsbasiert und wird nicht gespeichert. Wenn Sie möchten, dass Ihre
Änderungen an der Sortierung dauerhaft sind, müssen Sie die Änderungen im Eigenschaftsfenster
vornehmen.

Benutzer mit der Berechtigung zum Bearbeiten des Arbeitsblatts können anhand der
Diagrammprüfung interaktiv sortieren, auf Arbeitsblatt bearbeiten klicken und die Änderungen an
der Originaltabelle speichern.
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Arbeiten mit Add-Ons
Für Tabellendiagramme stehen die folgenden Optionen unter Add-Ons im Eigenschaftsfenster zur
Verfügung:

Datenverarbeitung: 

l Null-Werte einschließen: Wenn die Option nicht ausgewählt ist, werden Kennzahlen mit
dem Wert '0' in der Präsentation nicht berücksichtigt. Bei mehr als einem Kennzahlwert
müssen alle Kennzahlwerte den Wert '0' haben, um aus der Präsentation ausgeschlossen zu
werden.

l Berechnungsbedingung:: Geben Sie in diesem Textfeld eine Formel an, um eine Bedingung
festzulegen, die erfüllt (wahr) sein muss, damit das Objekt angezeigt wird. Der Wert kann als
berechnete Formel eingegeben werden. Beispiel: count(distinct Team)<3. Wenn die
Bedingung nicht erfüllt ist, wird die im Textfeld Angezeigte Meldung eingegebene Meldung
oder Formel angezeigt.
Eine Berechnungsbedingung ist nützlich, wenn ein Diagramm oder eine Tabelle aufgrund
großer Datenmengen nur langsam reagiert. Sie können die Berechnungsbedingung nutzen,
um ein Objekt auszublenden, bis der Anwender die Daten durch die Anwendung von
Auswahlen auf eine bestimmte Menge reduziert hat. Verwenden Sie die Eigenschaft
Angezeigte Nachricht, um den Benutzer zum Filtern der Daten anzuleiten.
Verwenden von Berechnungsbedingungen

Formatieren des Tabellendiagramms

Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

Allgemeine Informationen zum Formatieren einer einzelnen Visualisierung finden Sie unter Applying
custom styling to a visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.
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Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

4. Legen Sie auf der Registerkarte Diagramm die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Kopfzeile: Formatieren Sie den Text der Kopfzeilen für die Dimensionen und
Kennzahlen.

l Dimensionswerte: Formatieren Sie die Textdimensionswerte.
l Kennzahlenwerte: Formatieren Sie den Text der Kennzahlenwerte.
l Gesamtwerte: Formatieren Sie den Text der Gesamtwerte, wenn Sie unter

Darstellung > Präsentation ausgewählt haben, dass eine Zeile Gesamtwerte
angezeigt werden soll.

l Null-Werte: Formatieren Sie den Text der Null-Werte.
5. Auf der Registerkarte Diagramm können Sie das Design der Null-Werte anpassen. Sie

können Stil und Farbe von Hervorhebungen ändern.

Sie können auch das Textformat für jede Spalte in der Tabelle festlegen. Sie können die Farbe, den
Stil und die Ausrichtung des Texts konfigurieren. Diese Einstellungen werden auf der Registerkarte
Daten des Eigenschaftsfensters konfiguriert. Wenn Sie eine Spalte einzeln formatiert haben,
überschreibt dieses Format jedes Textformat, das auf Diagrammebene angewendet wurde. Weitere
Informationen finden Sie unter Arbeiten mit Tabellenelementen (page 535).

Zusätzlich können Sie anpassen, wie der Text aussieht, wenn ein Benutzer den Mauszeiger über
eine Zeile bewegt. Weitere Informationen finden Sie unter Anpassen des Mauszeigerverhaltens
(page 545).

Anpassen des Hintergrunds
Sie können den Hintergrund des Diagramms anpassen. Der Hintergrund kann mit einer Farbe oder
einem Bild festgelegt werden.

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Wählen Sie im Fenster „Design“ auf der Registerkarte Allgemein eine Hintergrundfarbe
(einzelne Farbe oder Formel) aus. Sie können den Hintergrund auch als Bild aus der
Medienbibliothek oder über eine URL festlegen.
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Wenn eine Hintergrundfarbe verwendet wird, können Sie die Opazität des Hintergrunds über
den Schieberegler einstellen. Die Kopfzeile des Diagramms wird immer mit einer Opazität von
100 % angezeigt.
Wenn Sie ein Hintergrundbild verwenden, können Sie die Bildgröße und -position anpassen.

4. Passen Sie auf der Registerkarte Diagramm die Hintergrundfarbe der folgenden Elemente
an:

l Kopfzeile (100% Opazität wird verwendet)
l Dimensionswerte
l Kennzahlenwerte
l Kennzahl-Bezeichnungen
l Gesamtwerte (100% Opazität wird verwendet)
l Null-Werte

Anpassen des Gitternetzes
Sie können das Gitternetz der Tabelle anpassen.

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Passen Sie auf der Registerkarte Diagramm das Gitternetz der folgenden Elemente an:
l Zeilenhöhe: Legen Sie die Höhe der Zeilen in Linien fest.
l Rahmen: Legen Sie die Farbe der Zellenränder fest.
l Teiler : Legen Sie die Farbe des Teilers fest, der die Kopfzeile und den Hauptteil der

Tabelle voneinander trennt.1943

Anpassen des Mauszeigerverhaltens
Sie können Anzeigeoptionen festlegen, wenn ein Benutzer den Mauszeiger über eine Zeile in der
Tabelle bewegt.

Gehen Sie folgendermaßen vor:

1. Erweitern Sie im Eigenschaftsfenster den Abschnitt Darstellung.

2. Klicken Sie unter Darstellung > Präsentation auf Design.

3. Passen Sie auf der Registerkarte Diagramm des Designfensters unter Beim Draufzeigen die
folgenden Einstellungen an:

l Um Zeile in der Tabelle hervorzuheben, wenn ein Benutzer mit dem Mauszeiger
daraufzeigt, legen Sie den Schalter auf Ein um. Deaktivieren Sie das Verhalten je nach
Belieben.

l Farbe beim Daraufzeigen: Legen Sie die Farbe fest, mit der die Zeile hervorgehoben
wird, wenn ein Benutzer den Mauszeiger darüberbewegt.

l Schriftfarbe beim Daraufzeigen: Legen Sie die Farbe des Texts in der
hervorgehobenen Zeile fest, wenn ein Benutzer den Mauszeiger darüberbewegt.
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Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Verwenden der Diagrammprüfung
Anhand der Diagrammprüfung können App-Nutzer und andere Benutzer ohne Bearbeitungsrechte
das ursprüngliche Tabellendiagramm anpassen, während sie sich im Analysemodus befinden. Sie
steht im Menü unter Diagrammprüfung zur Verfügung.

App-Nutzer und Betrachter können die Diagrammprüfung nutzen, um einer Tabelle Spalten
hinzuzufügen oder Spalten daraus zu entfernen, Spalten neu zu sortieren, die Spaltenbreite zu
ändern und Auswahlen anzuwenden. Die Größe oder das Layout der ganzen Tabelle auf dem
Arbeitsblatt können im Diagrammprüfungsmodus nicht geändert werden.

Der Diagrammprüfungsmodus ist eine praktische Möglichkeit, Daten rasch zu entfernen oder
hinzuzufügen und dann zu teilen, herunterzuladen oder den neuen Tabellenstatus mit einem
Lesezeichen zu versehen. Das ist besonders in Apps nützlich, die von zahlreichen Personen mit
unterschiedlichen Anforderungen angezeigt werden. Das Fenster für die Diagrammprüfung wird in
der Ergebnistabelle, die Sie freigegeben oder heruntergeladen haben, nicht angezeigt.

Wenn Sie eine Tabelle im Diagrammprüfungsmodus anpassen, können andere Benutzer Ihre
Änderungen nicht sehen, es sei denn, Sie speichern sie als öffentliches Lesezeichen. Das bedeutet,
dass mehrere Benutzer die gleiche Tabelle gleichzeitig ändern können. Ihre Änderungen bleiben für
Sie sichtbar, wenn Sie die Browserseite aktualisieren, gehen aber verloren, wenn Sie sich abmelden
oder Ihre Sitzung abläuft. Wenn dies eintritt, kehrt die Tabelle zu ihrem Standardstatus zurück, der
von der Person, die das Tabellendiagramm erstellt hat, eingerichtet wurde. Wenn Sie das
Tabellenlayout speichern möchten, erstellen Sie ein Lesezeichen.

Benutzer mit der Berechtigung zum Bearbeiten des Arbeitsblatts können anhand der
Diagrammprüfung Änderungen an der Tabelle vornehmen, auf Arbeitsblatt bearbeiten klicken und
die Änderungen an der Originaltabelle speichern.

App-Entwickler können Diagrammprüfung im Eigenschaftsfenster aktivieren:

l Diagrammprüfung aktivieren: Aktivieren Sie diese Option, um Diagrammprüfung
zuzulassen.

l Sichtbarkeitsoption:
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o Automatisch: Das Diagrammprüfungsfenster ist sichtbar, wenn Benutzer das
Arbeitsblatt öffnen.

o Minimiert: Das Diagrammprüfungsfenster ist aktiviert, aber nicht sichtbar, wenn
Benutzer das Arbeitsblatt öffnen. Benutzer können es im Daraufzeigen-Menü öffnen,
indem sie auf und dann auf Diagrammprüfung klicken.

Damit ein Tabellenelement im Diagrammprüfungsmodus verfügbar ist, muss der Tabellenersteller
(bzw. ein Benutzer, der das Arbeitsblatt bearbeiten kann) diese Felder, Master-Elemente oder
Formeln der Tabelle als Spalten oder alternative Spalten hinzugefügt haben. Weitere Informationen
finden Sie unter Arbeiten mit Tabellenelementen (page 535).

Diagrammprüfung in einem Tabellendiagramm. Die Tabelle enthält drei Spalten: Kunde, Region, Stadt.
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Diagrammprüfung der gleichen Tabelle wie oben, der aber zwei Kennzahlen hinzugefügt wurden: Umsatz
und Kosten. Die Hintergrundfarben sind das Ergebnis einer Formel.

Einschränkungen

In bestimmten Diagrammen ist Diagrammprüfung nicht verfügbar, wenn die Tabelle
eingebettet ist
Die Diagrammprüfung ist nicht verfügbar, wenn die Tabelle in eines der folgenden Objekte
eingebettet ist:

l Ein bestehendes Sammelboxobjekt, das nicht durch eine Registerkarten-Sammelbox ersetzt
wurde. Die Registerkarten-Sammelbox wurde in den Versionen November 2024 von Qlik
Sense Enterprise on Windows und Qlik Sense Desktop zum nativen Sammelboxobjekt.
Die Diagrammprüfung ist auch in bestehenden Instanzen der veralteten Objekte Sammelbox
ein-/ausblenden und Sammelbox mit Registerkarten nicht verfügbar. Es wird jedoch nicht
empfohlen, diese Objekte in Registerkarten-Sammelboxen umzuwandeln. Erstellen Sie
stattdessen eine neue Registerkarten-Sammelbox, um auf die Diagrammprüfung in
Tabellendiagrammen zuzugreifen.
Container (page 430)

l Gittercontainer
Trellis container (page 549)
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Anzahl der angezeigten Zeilen
Wenn Paginierung aktiviert ist, können Sie nur jeweils 100 Zeilen anzeigen. Wenn Paginierung
deaktiviert ist, können Sie jeweils bis zu 250.000 Zeilen anzeigen. Wenn Ihre Tabelle mehr als
250.000 Zeilen enthält, wird Paginierung verwendet.

Große Tabellen sind jedoch unpraktisch und schwierig zu verwalten. Eine praktikable Lösung wird
daher sehr viel kleiner sein als das theoretische Maximum. In den meisten Fällen ist es
wünschenswert, alle Spalten anzuzeigen, ohne horizontal scrollen zu müssen.

Barrierefreiheit
Ein umfassender Zugriff auf das Tabellendiagramm ist nur möglich, wenn Paginierung aktiviert ist.

Trellis container
You can use the Trellis container to show a trellis chart based on a master visualization.
The trellis chart shows a grid of the same chart for different dimension values. You can
use the trellis chart to compare metrics for different groups of data. The Trellis
container is included in the Visualization bundle.

Trellis chart based on a bar chart of sales data, shown for different product categories
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Creating a trellis chart
You can create a trellis chart on the sheet you are editing. The chart that you want to repeat for
different dimension values must be a master visualization.

Gehen Sie folgendermaßen vor:

1. Create the chart that you want to repeat for different dimension values and save it as a
master visualization.

2. In the assets panel, open Custom objects > Visualization bundle and drag a Trellis
container object to the sheet.

3. Select which master visualization to show in Appearance > Trellis options > Base
visualization in the property panel.

4. Select the dimension that you want to use as the first grid dimension in Data > Dimensions.
5. Optionally, add a second grid dimension to create a grid with one dimension in each axis.

If any of the grid dimensions are calculated dimensions, toggle on
Calculated Dimension in the settings for the dimension.

You will now see a grid of charts each based on the grid dimensions you selected.

Troubleshooting
I do not see a grid of charts, and receive this message: Too many dimension values!

Mögliche Ursache

There are more dimension values than the maximum number of charts allowed in the grid.
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Vorgeschlagene Aktion

You can increase the number of charts allowed in Appearance > Trellis options > Maximum
number of charts.

Changing the appearance of the chart
You can customize your chart with one or more features.

Setting the number of columns
You can set the number of columns in the chart grid with Appearance > Trellis options > Number
of columns.

Setting the y-axis range of charts
You can select which y-axis range to show for the charts in the trellis chart with Appearance >
Trellis options > Auto range.

l On will show the same range for all charts. This is the best option if you want to compare
values between different charts.

l Off will show an optimized range for each chart.

Show border
You can show a border for the trellis chart with Appearance > Trellis options > Border. You can
adjust width, color and style. It is also possible to define a custom border.

Slide mode
You can view the charts in slide mode instead of a grid by setting Appearance > Trellis options >
Slide mode to On. In slide mode, you view one chart at a time. You can scroll between the charts.

Using the styling panel to further customize the appearance
Unter Darstellung im Eigenschaftsfenster sind mehrere Designoptionen verfügbar.

Klicken Sie auf Design unter Darstellung > Präsentation, um das Design des Diagramms weiter
anzupassen. Das Designfenster enthält mehrere Abschnitte auf den Registerkarten Allgemein und
Diagramm.

Sie können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen
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Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.
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Configuring how null values are represented

Null measure values
To configure the representation of null measure values for a dimension value, use Appearance >
Trellis options > Show all possible dimensions. With Show all possible dimensions, you have the
following options:

l On: The container shows a measure value of 0 for a dimension value where no measure data
is present. Suppose that the master visualization aggregates sales by month and there are
no sales in October. Here, the Trellis container will still list October as a dimension in the
charts (with a value of 0 as applicable).

l Off: The container does not show dimension values where no measure data is present.
Suppose that the master visualization aggregates sales by month and there are sales in all
months except October. Here, the Trellis container will list each month except October in the
charts.

Null values in the grid dimensions
It could happen that there are null values in the grid dimension. If you want the Trellis container to
visualize these null values, toggle on the Include null values setting.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand Data.
2. Expand the dimension for which you want to show null values.
3. Turn on Include null values.

Best practices for creating the master visualization
Here are some tips for creating a master visualization that will work well in a trellis chart:

l Show the title in the master visualization. In the trellis chart, the title is replaced with the grid
dimension value of each chart.

l If you use expressions: create a label to hide the set expression.
l If you are using a combo chart: use only one axis, and set the minimum and maximum of the

y-axis.
l If you are using a box plot: set the minimum and maximum of the y-axis.
l If you are using a scatter plot: set the x-axis.
l If you are using a map: use advanced mode, and set the layer color and title. For an example,

see Example 2: Coloring on a map chart (page 559).

Using advanced mode
Use advanced mode to customize the set expressions and dimension values that will be shown in
the Trellis container. Advanced mode allows you to use placeholder values to allow dynamic output
tailored to the dimension being shown in each chart in the container.

Activate advanced mode by setting Appearance > Trellis options > Advanced mode to On.
Advanced mode allows you to:
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l Use advanced expressions for labels, titles, subtitles, and footnotes.
l Use advanced expressions to define the data shown in the visualization. For example:

l if expression as chart measure
l Coloring by measure
l Joining the Trellis set expression with other set expressions

Gehen Sie folgendermaßen vor:

1. In the properties panel for the master visualization, go to Appearance > Trellis options, and
set Advanced mode to On.

2. Use the placeholders in the table below in expressions for measures, coloring, chart text, and
other properties. They will be replaced in the Trellis container by the corresponding values.

Placeholder Replaced by value

$(vDim) Dimension Name

$(vDimValue) Dimension Value

$(vDimSet) ,[Dimension Name]={'Dimension Value'}

$(vDimSetFull) {<[Dimension Name]={'Dimension Value'}>}

Advanced mode value replacements in a trellis chart

Use cases and examples

$(vDim)
$(vDim) is useful as an expression for labels, titles, subtitles, or footnotes in the master
visualization. For example, in a subtitle:

='This chart presents the aggregation by ' & $(vDim)

$(vDimValue)
$(vDimValue) is useful in many scenarios:

l Expressions for measure data in the master visualization. For example, as a measure in a
Text & image or Text object:
=if(GetSelectedCount([Product Category])=1, Sum({<Region={$(vDimValue)}>} Sales),

'Please select a product category.')

l Expressions for label, titles, subtitles, or footnotes in the master visualization. For example,
as a footnote:
='This chart presents sales data for' & $(vDimValue) & '.'

$(vDimSet)
$(vDimset) is useful when you need to join multiple set expressions together. This can be used in an
expression for measure data in the master visualization. For example:

=sum({<ProductName={'Bike Helmet'} $(vDimSet)>} Sales)
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For the example above, the Trellis container would restrict the data to ProductName values of Bike
Helmet. A separate chart would be shown for each unique value in the dimension used in the Trellis
container.

$(vDimSetFull)
$(vDimSetFull) is useful for setting chart coloring by measure in the master visualization. For
example:

=Sum($(vDimSetFull) Sales)

Long-form examples
For step-by-step examples showing how to use advanced mode, see Add the data (page 556).

Limitations
For information about general limitations, see Limitations (page 463).

Unsupported visualizations
You cannot use the following visualizations in a trellis chart:

l Filter pane
l Histogram
l Container
l Layout container

Multi KPI visualizations with embedded master visualizations
It is not possible to use a Multi KPI chart that contains an embedded master visualization.

Selecting by dimension
If you make a selection on the dimension that is used as grid dimension in the trellis chart, the
selection is not reflected in the trellis chart.

Beispiel:

You have a filter pane with countries, and a trellis chart with country as the first grid dimension.
When you select a country in the filter pane, the trellis chart will still show a chart for each country
and ignore the selection.

Coloring by master measure color
Colors assigned to master measures in a trellis container do not appear unless the trellis container
is using the advanced mode.

Trellis container advanced mode examples
This help topic shows examples of how you can use a Trellis container in advanced
mode to configure advanced expressions in your charts.

The following variables are shown in this help topic:
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l $(vDim)
l $(vDimValue)
l $(vDimSetFull)

For additional examples, see Using advanced mode (page 553).

Example 1: Conditional measure expression
This example shows you how the $(vDimValue) variable can be added to measure expressions to
make the Trellis container compatible with advanced expressions. The expression used in this chart
is a conditional if expression.

Add the data
Create a new app and add the load script below into the Dateneditor. Then, load the data.

Load script
Sales:

LOAD * INLINE [

Region,Country,Item Type,Sales Channel,Order Priority,Order Date,Order ID,Ship Date,Units

Sold,Unit Price,Unit Cost,Total Revenue,Total Cost,Total Profit

Central America and the

Caribbean,Honduras,Household,Offline,H,2/8/2017,522840487,2/13/2017,8974,668.27,502.54,5997054

.98,4509793.96,1487261.02

Asia,Mongolia,Personal

Care,Offline,C,2/19/2014,832401311,2/23/2014,4901,81.73,56.67,400558.73,277739.67,122819.06

Asia,Sri

Lanka,Cosmetics,Offline,M,11/19/2016,419123971,12/18/2016,6952,437.20,263.33,3039414.40,183067

0.16,1208744.24

Asia,Turkmenistan,Household,Offline,L,12/30/2010,441619336,1/20/2011,3830,668.27,502.54,255947

4.10,1924728.20,634745.90

Central America and the

Caribbean,Honduras,Snacks,Online,L,6/30/2016,795490682,7/26/2016,2225,152.58,97.44,339490.50,2

16804.00,122686.50

Australia and Oceania,Australia,Office

Supplies,Online,C,10/27/2015,158535134,11/25/2015,2924,651.21,524.96,1904138.04,1534983.04,369

155.00

Europe,United

Kingdom,Household,Online,L,1/5/2012,955357205,2/14/2012,282,668.27,502.54,188452.14,141716.28,

46735.86

Sub-Saharan

Africa,Djibouti,Cosmetics,Offline,H,4/7/2014,259353148,4/19/2014,7215,437.20,263.33,3154398.00

,1899925.95,1254472.05

Australia and

Oceania,Australia,Cereal,Offline,H,6/9/2013,450563752,7/2/2013,682,205.70,117.11,140287.40,798

69.02,60418.38

Middle East and North

Africa,Libya,Clothes,Offline,H,10/30/2010,705784308,11/17/2010,6116,109.28,35.84,668356.48,219

197.44,449159.04

Central America and the

Caribbean,Haiti,Cosmetics,Offline,H,10/13/2013,505716836,11/16/2013,1705,437.20,263.33,745426.

00,448977.65,296448.35

Central America and the
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Caribbean,Belize,Clothes,Offline,M,7/25/2016,807025039,9/7/2016,5498,109.28,35.84,600821.44,19

7048.32,403773.12

Europe,Lithuania,Office

Supplies,Offline,H,10/24/2010,166460740,11/17/2010,8287,651.21,524.96,5396577.27,4350343.52,10

46233.75

Asia,Turkmenistan,Office

Supplies,Online,M,4/23/2013,462405812,5/20/2013,5010,651.21,524.96,3262562.10,2630049.60,63251

2.50

Middle East and North

Africa,Libya,Fruits,Online,L,8/14/2015,816200339,9/30/2015,673,9.33,6.92,6279.09,4657.16,1621.

93

Sub-Saharan

Africa,Djibouti,Cereal,Online,H,5/20/2017,555990016,6/17/2017,8656,205.70,117.11,1780539.20,10

13704.16,766835.04

Middle East and North

Africa,Pakistan,Cosmetics,Offline,L,7/5/2013,231145322,8/16/2013,9892,437.20,263.33,4324782.40

,2604860.36,1719922.04

North

America,Mexico,Household,Offline,C,11/6/2014,986435210,12/12/2014,6954,668.27,502.54,4647149.5

8,3494663.16,1152486.42

Australia and Oceania,Federated States of

Micronesia,Beverages,Online,C,10/28/2014,217221009,11/15/2014,9379,47.45,31.79,445033.55,29815

8.41,146875.14

Australia and

Oceania,Samoa,Cosmetics,Online,H,7/20/2013,670854651,8/7/2013,9654,437.20,263.33,4220728.80,25

42187.82,1678540.98

Europe,Spain,Household,Offline,L,10/21/2012,213487374,11/30/2012,4513,668.27,502.54,3015902.51

,2267963.02,747939.49

Middle East and North

Africa,Lebanon,Clothes,Online,L,9/18/2012,663110148,10/8/2012,7884,109.28,35.84,861563.52,2825

62.56,579000.96

Sub-Saharan

Africa,Kenya,Vegetables,Online,L,3/18/2012,827844560,4/7/2012,6457,154.06,90.93,994765.42,5871

35.01,407630.41

North America,Mexico,Personal

Care,Offline,L,2/17/2012,430915820,3/20/2012,6422,81.73,56.67,524870.06,363934.74,160935.32

Australia and

Oceania,Australia,Beverages,Offline,H,7/7/2014,240470397,7/11/2014,9389,47.45,31.79,445508.05,

298476.31,147031.74

North America,Mexico,Personal

Care,Offline,M,7/30/2015,559427106,8/8/2015,5767,81.73,56.67,471336.91,326815.89,144521.02

Sub-Saharan

Africa,Mozambique,Household,Offline,L,2/10/2012,665095412,2/15/2012,5367,668.27,502.54,3586605

.09,2697132.18,889472.91

];

Create the master visualization

Gehen Sie folgendermaßen vor:

1. Open a sheet in edit mode.
2. Drag a bar chart onto the sheet.
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3. Add Item Type as a dimension to the bar chart.
4. Add the following expression as a measure:

=if(Sum([Units Sold])>=40000, Sum({<Region={$(vDimValue)}>} [Total Profit]), Sum

({<Region={$(vDimValue)}>} [Units Sold]))

In the Trellis container, this expression will show:
l If there are 40,000 or more units sold: The total profit for each distinct region.
l If there are less than 40,000 units sold, or if the data is null: The total number of units

sold for each distinct region.
For each chart in the container, the $(vDimValue) variable will be replaced by the dimension
value name for Region.

5. For the measure you just added, add the following Label:
=if(Sum([Units Sold])>=40000, 'Total Profit', 'Items Sold')

6. In the properties panel, expand Sorting. Adjust the sorting so that the chart sorts primarily by
the measure value in descending order.

7. In the properties panel, under Appearance, expand Colors and legend.
8. Set Colors to Custom and choose the option to color the chart By dimension.
9. Turn on Persistent colors.

10. Right-click the chart, or use the button, and click Add to master items.

11. Give the master item a Name (for example, BarChartExample), and click Add.

Create the Trellis container

Gehen Sie folgendermaßen vor:

1. Drag a Trellis container onto the sheet.
2. Click Add dimension, and select Region.
3. Click Add master visualization. In the drop down menu, select the BarChartExample master

item.
4. In the properties panel for the Trellis container, under Appearance, expand Trellis options.
5. Set Advanced mode to On.
6. In the properties panel for the Trellis container, under Appearance, expand General.
7. Toggle on Show titles if needed. Add the following expression for the Title of the chart:

=if(Sum([Units Sold])>=40000, 'Total Profit, by Region and Item Type', 'Total Items

Sold, by Region and Item Type')

Resize the Trellis container on the sheet so that it has enough space to show all data. Your chart
should now look something like the following image.
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Example result with no selections made in the app

If you make selections in the app (for example, by selecting a specific Order Priority), the measure
shown in the chart could change given the lower order volume.

Example result with a selection made in the app

Example 2: Coloring on a map chart
This example will show you how to configure a Trellis container in Advanced mode to color a map
chart by measure expression. Specifically, it shows the following:

l Using $(vDimSetFull) to color map charts by measure.
l Using $(vDim) and $(vDimValue) in text within the charts (in this case, for the chart subtitles).

Add the data
Create a new app and the load script below into the Dateneditor. Then, load the data.

Load script
SET DateFormat='MM/DD/YYYY';
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[Regional Sales]:

Load RowNo() as OrderID, Year(OrderDate) as Year, * Inline [

Country,OrderDate,Sales

Peru,01/15/2022,227752.86

India,09/24/2023,273204.8

United Kingdom,10/12/2020,196509.42

Brazil,04/09/2022,62936.87

Peru,06/19/2023,343348.25

France,10/08/2021,137087.24

Brazil,04/02/2023,364144.83

France,01/18/2021,147458.3

France,07/31/2021,131735.39

France,08/28/2021,175657.49

Mexico,11/29/2023,347796.5

Brazil,10/22/2021,156415.67

United States,06/26/2022,71698.01

Mexico,07/06/2021,302858.53

United States,09/02/2023,380184.4

Japan,12/17/2023,138012.27

Spain,01/06/2022,360035.92

Nigeria,07/26/2020,117583.51

India,08/27/2022,319078.12

Nigeria,05/10/2021,185315.61

France,01/22/2021,79605.99

Mexico,11/08/2022,410677.64

United Arab Emirates,01/21/2022,304060.08

Japan,05/01/2020,382370.67

Peru,10/07/2020,163162.77

Japan,10/28/2023,116031.67

Japan,08/13/2021,202813.87

Brazil,12/18/2020,116177.28

France,08/05/2023,251482.97

United States,11/30/2023,354524.01

Brazil,02/27/2022,333082.0

Japan,03/02/2024,272875.61

Japan,10/05/2022,241957.76

Mexico,10/13/2020,415713.42

France,02/01/2021,278095.0

Brazil,04/21/2023,32234.39

United States,03/06/2020,31705.72

Japan,10/16/2021,397489.08

Peru,01/24/2021,164315.87

Peru,08/10/2021,39399.43

Japan,08/19/2021,55312.24

United States,06/19/2021,47950.8

France,04/05/2020,66698.87

Chile,02/05/2023,209699.99

Canada,04/03/2022,40362.07

India,05/07/2023,448813.12

France,11/21/2023,382234.7

United States,05/22/2020,454589.09

Brazil,12/20/2021,46482.62

Peru,04/18/2023,196877.9

Canada,12/22/2021,292966.22
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France,12/05/2020,441694.97

Brazil,02/14/2023,172206.44

Mexico,04/11/2022,302489.06

Peru,05/12/2022,293993.12

Peru,04/24/2022,248774.21

Canada,06/04/2024,392124.04

Mexico,03/04/2020,142287.51

Japan,02/27/2022,75894.1

Brazil,05/07/2021,52657.97

Mongolia,01/31/2020,447353.36

France,04/05/2022,275954.94

Brazil,03/03/2022,86689.07

United States,01/27/2023,304884.26

Spain,05/03/2021,143572.48

Australia,03/28/2022,132283.75

Japan,04/20/2021,259819.31

Canada,06/12/2020,366820.82

France,09/15/2020,337837.91

Japan,07/09/2020,95159.91

Japan,10/19/2021,149382.85

Brazil,09/09/2021,325617.68

Mexico,06/06/2021,324661.14

Brazil,09/28/2022,366444.31

Mexico,05/26/2023,394055.4

Japan,05/30/2021,77322.47

Japan,02/06/2023,187484.72

United States,11/13/2022,307780.43

France,03/26/2022,438656.23

Japan,03/16/2020,237080.43

United Kingdom,12/31/2022,372867.22

Mexico,12/23/2022,251630.19

Kenya,09/11/2023,167978.34

Peru,08/12/2022,174796.28

Brazil,03/20/2020,360178.71

Nigeria,06/04/2024,236178.16

United States,06/19/2022,230182.87

Brazil,12/30/2021,128965.58

Nigeria,07/26/2023,96338.83

Peru,05/16/2021,354580.5

Spain,02/21/2024,107994.23

Mongolia,05/19/2022,240049.35

United States,10/20/2022,302237.71

Brazil,02/11/2022,162125.17

Brazil,02/20/2023,223010.48

Nigeria,06/20/2024,206926.14

Mexico,02/27/2023,378327.98

France,03/07/2022,432543.14

France,05/20/2020,61227.11

Japan,08/26/2020,46839.45

France,01/18/2024,193017.69

France,11/25/2020,290340.4

Canada,08/08/2022,385273.52

United States,09/26/2021,204250.05

United States,08/04/2022,223287.59

Mexico,11/14/2022,256152.68
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Brazil,01/15/2020,242880.01

Mexico,11/25/2020,430857.71

United States,06/05/2021,378069.6

France,01/03/2022,316563.84

United Kingdom,05/19/2021,243918.77

United States,05/17/2023,204355.25

Nigeria,03/13/2020,293234.49

Mongolia,06/24/2022,245425.64

Australia,12/19/2020,379893.22

United States,01/01/2021,288622.04

Brazil,05/03/2022,242795.62

Mexico,04/07/2021,227912.73

Japan,11/26/2021,144015.86

Canada,09/17/2020,126427.98

Mexico,08/04/2021,170917.99

Brazil,09/16/2021,302048.81

Japan,12/16/2020,271152.67

Peru,09/10/2021,384189.71

United States,04/29/2020,454328.73

Peru,08/27/2020,190456.76

Canada,09/29/2022,296216.69

United States,06/20/2020,293064.04

Nigeria,07/21/2023,329696.64

France,03/29/2022,125031.6

Canada,11/28/2020,334136.19

India,01/27/2023,364236.69

United States,04/05/2024,146632.59

Brazil,11/23/2021,442283.3

Canada,09/17/2020,149007.7

Brazil,03/15/2023,170612.37

Peru,02/09/2021,156444.13

Brazil,03/17/2021,217404.08

Mongolia,04/26/2020,312406.89

Canada,10/08/2020,381041.07

Brazil,06/11/2022,347838.35

Peru,01/24/2022,250253.73

Canada,11/30/2020,54392.41

Brazil,12/14/2020,301046.63

United Kingdom,11/30/2023,23456.55

United States,11/18/2021,411647.97

Mexico,10/27/2022,35642.56

Nigeria,01/12/2021,310103.2

Mongolia,04/24/2023,66497.07

Japan,03/01/2020,115616.07

Brazil,11/11/2021,427971.79

Australia,04/30/2020,224772.13

Mongolia,10/31/2020,99216.73

Peru,08/21/2020,403962.65

Peru,01/30/2023,185795.36

Japan,01/25/2023,123502.1

Nigeria,01/12/2024,203772.15

United States,11/13/2020,148393.65

Brazil,12/06/2020,112804.31

United States,07/14/2022,301281.13

Peru,04/09/2020,250693.79
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Peru,05/21/2024,393405.04

Japan,03/26/2022,52544.23

Brazil,01/16/2023,90154.56

Mexico,01/22/2023,26075.54

Brazil,11/28/2021,23825.06

Peru,11/09/2020,161572.89

Mexico,07/28/2021,49412.07

Japan,01/11/2021,307169.36

Canada,09/06/2021,73335.63

Nigeria,04/14/2023,1187523.85

France,10/22/2021,72831.06

Brazil,03/07/2020,369401.17

Canada,06/04/2020,341681.27

Brazil,06/20/2021,386016.82

Peru,10/26/2022,32322.15

Canada,04/16/2021,345333.21

Japan,03/24/2020,205311.36

Japan,09/29/2023,415385.44

Nigeria,03/28/2023,449452.09

France,10/04/2020,95167.1

Japan,08/14/2021,358862.28

Mongolia,06/24/2024,329040.71

France,03/02/2023,132649.55

France,09/20/2022,408825.94

Canada,05/22/2021,423239.99

Spain,09/06/2020,47063.8

Brazil,05/11/2024,393786.01

Mexico,06/02/2023,34370.17

Brazil,01/31/2024,284225.11

Peru,04/17/2023,404147.81

Brazil,11/25/2022,190314.55

Peru,12/03/2021,141599.92

Chile,10/29/2021,244343.67

Japan,09/11/2022,448202.62

United States,02/11/2020,120006.54

France,12/11/2021,97129.11

Peru,01/30/2021,312698.45

France,09/24/2023,195299.87

France,04/10/2024,448665.96

];

Create the master visualization

Gehen Sie folgendermaßen vor:

1. Open a sheet in edit mode.
2. Drag a map chart onto the sheet.
3. In the properties panel, create a new area layer for the chart.
4. Add Country as the dimension for the area layer.
5. In the Country area layer, expand Colors.
6. Set Colors to Custom and select the By measure color setting.
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7. Add the following expression for Select measure:
=Sum($(vDimSetFull) Sales)

8. Add the following Label to the measure color: Total Sales
9. Expand the Appearance > General section in the properties panel.

10. Enter the following expression for the chart Subtitle:
='Total Sales, ' & $(vDim) & ': ' & $(vDimValue)

This expression returns an error in the master visualization, but in the Trellis container, it
functions intended. For each unique Year value, the title of the chart will be Total Sales,
Year: <year>.

11. Right-click the chart, or use the button, and click Add to master items.

12. Give the master item a Name (for example, MapChartExample), and click Add.

Create the Trellis container

Gehen Sie folgendermaßen vor:

1. Drag a Trellis container onto the sheet.
2. Click Add dimension, and select Year.
3. Click Add master visualization. In the drop down menu, select the MapChartExample

master item.
4. In the properties panel for the Trellis container, under Appearance, expand Trellis options.
5. Set Advanced mode to On.
6. Set Number of columns to a value that works best for your sheet and screen size. To match

the image below, set this to 5.
7. In the properties panel for the Trellis container, under Appearance, expand General.
8. Add the following Title for the chart: Total Sales by Country
9. Resize the chart if needed so that it occupies the entire length of the sheet.

10. Exit sheet edit mode.

To get the same color scheme as shown in the image below, set the app theme to Sense Classic.

Example result
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Variance waterfall chart
You can use the variance waterfall chart (Variance waterfall) to show the variance
between two measures over the different values of a dimension. The variance waterfall
chart is included in the Visualization bundle.

You need to use two measures, start value and end value, and one bridge dimension.

Variance waterfall chart showing spending over fiscal quarters

Creating a variance waterfall chart
You can create a variance waterfall chart on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Variance
waterfall object to the sheet.

2. Click the Add dimension button to select the bridge dimension.
3. Click the first Add measure button to select the measure to use as start value.
4. Click the second Add measure button to select the measure to use as end value.

The variance waterfall chart is now displayed with one bar for the start value measure and one bar
for the end value measure. Between the measure bars you will see the variance for each value of
the bridge dimension.

Changing the appearance of the chart
You can customize the appearance of your chart.

Labels
You can turn off value labels by setting Appearance > Presentation > Value labels to Off.
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Legend
You can customize the legend labels by setting Appearance > Presentation > Labels to Custom.
You can set a custom text for the following legend labels:

l Start value (Start value)
l End value (End value)
l Positive variance (Positive label)
l Negative variance (Negative label)

You can also hide the legend by setting Appearance > Colors and legend > Show legend to Off or
change the position of the legend with Appearance > Colors and legend > Legend position.

Using the styling panel to further customize the appearance
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart. Sie

können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.

Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Example of a variance waterfall chart
In this simple example we will show how quarterly sales numbers contribute to sales compared to
budget.

Dataset
The dataset we use contains sales numbers and budgeted sales for each quarter. You can paste it
into a text file and load it in Qlik Sense.

Quarter,Sales,Budget

Q1,9,10

Q2,14,12

Q3,12,12

Q4,18,14

Visualization
You can now create a variance waterfall chart.

l Add Quarter as dimension.
l Add Sum(Budget) as the first measure.
l Add Sum(Sales) as the second measure.
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The variance waterfall chart is created. We have adjusted the labels and colors in the example.
You can clearly see that Q1 had sales below budget, but the year ended with sales over budget, and
that Q4 was the largest contribution.

Variance waterfall chart showing spending over fiscal quarters

Limitations
For information about general limitations, see Limitations (page 463).

l It is not possible to use a variance waterfall chart in a Trellis container.
l You need to use the same number format for both measures to get correct number format for

the dimension variance bars.

Word cloud chart
The Word cloud chart (Word cloud chart) lets you visualize text data. Text values are
displayed with their size based on a measure value. The measure can be anything you
want to measure against, for example: times used, alphabetically, by importance, or by
context. You can customize your chart with different shapes, fonts, layouts, and color
schemes. It is included in the Visualization bundle.
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A word cloud chart displaying food items in different sizes and colors.

Requirements
Word cloud charts must have one dimension and one measure. 
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When to use it
A word cloud chart lets you visualize and identify the importance of a value against a measure. The
more important the value is against the measure, the larger it displays in the cloud.

Creating a word cloud chart
You can create a word cloud on the sheet you are editing.

Gehen Sie folgendermaßen vor:

1. In the assets panel, open Custom objects > Visualization bundle and drag a Word cloud
chart object to the sheet.

2. Click the Add dimension button and select the dimension.
3. Click the Add measure button to select the measure of the chart.

Once a dimension and a measure have been selected, the word cloud chart displays automatically.

Changing the appearance of the word cloud
You can customize your word cloud with one or more features.

Changing the orientation
You can set the number of orientations with Appearance > Design > Orientations in the
properties panel. You can set an integer from 1 to 10.

l 1 will display all words in the same direction, set with Appearance > Design > Start angle.
l 2 will display words in two orientations, Appearance > Design > Start angle and

Appearance > Design > End angle.
l 3-10 will display words in the same number of orientations between Appearance > Design

> Start angle and Appearance > Design > End angle.
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Beispiel:

A word cloud chart displaying food items in different orientations.

Adjusting the start and end angles
You can adjust the starting point (angle) parameter of the word cloud under Appearance > Design
> Start angle, and the end point under Appearance > Design > End angle in the properties panel.
The angles can have positive or negative numbers.

Changing font size
You can set maximum word font sizes under Appearance > Design > Font max size and the
minimum under Appearance > Design > Font min size in the properties panel.

If you set a large font size, this can result in the larger words not being displayed in the chart as they
do not fit.

Changing scale
The word could chart scale can be either in linear or in log scale. Select scale Linear or Log under
Appearance > Design > Scale in the properties panel. Only positive values can be used for the log
scale. Zero or negative values return nothing.

Setting custom ranges
You can also specify a range of colors or select from a predefined color scheme.
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Gehen Sie folgendermaßen vor:

1. Click Appearance > Design in the properties panel.
2. Ensure that the Enable color range is set to On (default).
3. Click the color palette beside From, and choose a color.
4. Click the color palette beside To, and choose a color.

You can set your own color range by clicking the easel symbol in the color palette, and selecting a
color. You can also enter a color code string in the field next to the easel symbol. The colors should
be valid CSS colors.

Gehen Sie folgendermaßen vor:

1. Click Appearance > Design in the properties panel.
2. Move the Enable custom range slide button to the left to turn the option off.
3. Select a color scheme under Scale color.

A word cloud chart displaying food items in different sizes and colors.

Formatting numbers
It is possible to format the measure value. Different formatting can be applied to the same value, for
example as money, date, duration. The chart updates to reflect the changed number type.

Gehen Sie folgendermaßen vor:

1. Click Data > Measures in the properties panel and click a measure.
2. Select applicable number formatting form the Number formatting menu.
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3. Enter details in the panel fields. These display when choosing an option other than Auto
when further configuring the chart.

Using the styling panel to further customize the appearance
You have a number of styling options available under Appearance in the properties panel.

Click Styling under Appearance > Presentation to further customize the styling of the chart. Sie

können Ihre Designs zurücksetzen, indem Sie auf neben den einzelnen Abschnitten klicken.

Wenn Sie auf Alle zurücksetzen klicken, werden die Designs für alle verfügbaren Registerkarten
im Designfenster zurückgesetzt.

For general information about styling an individual visualization, see Applying custom styling to a
visualization (page 663).

Anpassen des Texts
Sie können den Text für Titel, Untertitel und Fußnoten unter Darstellung > Allgemein festlegen. Um
diese Elemente auszublenden, deaktivieren Sie Titel anzeigen

Die Sichtbarkeit der verschiedenen Bezeichnungen des Diagramms hängt von den
diagrammspezifischen Einstellungen und den Anzeigeoptionen der Bezeichnungen ab. Diese
können im Eigenschaftsfenster konfiguriert werden.

Sie können das Design des im Diagramm angezeigten Texts ändern.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. Legen Sie auf der Registerkarte Allgemein die Schriftart, den Hervorhebungsstil, die
Schriftgröße und die Farbe der folgenden Textelemente fest:

l Titel
l Untertitel
l Fußnote

Customizing the background
You can customize the background of the chart. The background can be set by color and image.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, you can select a background color (single color or
expression). You can also set the background to an image from your media library or from a
URL.
When using a background color, use the slider to adjust the opacity of the background.
When using a background image, you can adjust image sizing and position.
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Customizing the border and shadow
You can customize the border and shadow of the chart.

Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Appearance section.

2. Under Appearance > Presentation, click Styling.

3. On the General tab of the styling panel, under Border, adjust the Outline size to increase or
decrease the border lines around the chart.

4. Select a color for the border.
5. Adjust the Corner radius to control the roundness of the border.
6. Under Shadow in the General tab, select a shadow size and color. Select None to remove

the shadow.

Limitations
For information about general limitations, see Limitations (page 463).

l The word cloud chart can handle maximum of 100 words per entry.
l Words that take up more space than the chart are not displayed. You can adjust the font size

to show more values, but we do not recommend that you use fields with long text values.
l Word cloud charts cannot be used in Qlik NPrinting reports.

3.5 Erstellen und Bearbeiten von Visualisierungen
Sie erstellen Visualisierungen aus vordefinierten Diagrammen, Feldern oder
benutzerdefinierten Objekten. Nach dem Hinzufügen zu Ihrem Arbeitsblatt können Sie
Ihre Visualisierungen bearbeiten und verfeinern.

Ihr Visualisierungsdesign richtet sich nach den Daten in Ihren Feldern und dem unbegrenzten
Potenzial zum Untersuchen von Verknüpfungen und Korrelationen über Kennzahlen und
Dimensionen.

Hier finden Sie erste Schritte: Creating visualizations (page 575)durch.

Nach dem Erstellen einer Visualisierung möchten Sie möglicherweise Anpassungen vornehmen, um
zu verbessern, wie sie den Benutzern Informationen vermittelt. Sie können beispielsweise die
verwendeten Daten ändern oder das Aussehen der Visualisierung anpassen. Sie können weitere
Dimensionen oder Kennzahlen hinzufügen und so detailliertere Informationen bereitstellen, oder Sie
können einige davon entfernen, damit das Ergebnis übersichtlicher wird. Weitere Informationen
zum Bearbeiten Ihrer Visualisierungen finden Sie hier: Bearbeiten von Visualisierungen (page
575)durch.

Die Einhaltung der Designprinzipien und klare Vermittlung von Informationen sind wesentlich beim
Erstellen von Apps, die ansprechend sind und zur Datenerkundung einladen. Die Best Practices für
das Designen von Visualisierungen eigenen sich für jeden Kenntnisstand. Weitere Informationen
finden Sie unter Best Practices für das Gestalten von Visualisierungen (page 577).
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Creating visualizations
You create visualizations by dragging the chosen type of visualization onto the sheet from the
assets panel and configuring its properties settings. For instructions on creating specific types of
visualizations, see that visualization type in Visualisierungen (page 182).

Gehen Sie folgendermaßen vor:

1. Drag the visualization from the assets panel onto the sheet, or double-click the visualization.
2. Add dimensions and measures to the visualization.

You can add dimensions and measures using the buttons on the visualization. Or you can
drag a field from the Fields tab of the assets panel, and then select it to use it as a dimension
or measure. The number of dimensions and measures that are required depends on which
visualization you select.

3. Adjust the presentation: for example: sorting, coloring, or labeling.
For more information, see Changing the appearance of a visualization (page 630).

You can also add a visualization by copying visualizations. This is useful if you want to
use existing visualization settings in another visualization type. For more information,
see Kopieren einer Visualisierung aus einer vorhandenen Visualisierung (page 621)

Custom objects are added in a similar manner. You start creating a visualization by dragging a
visualization extension onto the sheet. For more information, see Erstellen einer Visualisierung mit
einem benutzerdefinierten Objekt (page 620).

You can use containers to save space on your dashboard, by quickly switching between tabs with
different visualizations.

The types of data you have in your tables and fields impacts whether they can be used as
dimensions or measures.

l Dimensionen legen fest, wie die Daten in einer Visualisierung gruppiert werden. Beispiel:
Gesamtumsatz pro Land oder Anzahl der Produkte pro Anbieter For more information, see
Dimensions (page 101).

l Measures are calculations used in visualizations, typically represented on the y-axis of a bar
chart or a column in a table. Kennzahlen werden aus einer Formel berechnet, die sich aus
Aggregierungsfunktionen wie beispielsweise Sum oder Max zusammensetzt und mit einem
oder mehreren Feldern kombiniert wird. For more information, see Kennzahlen (page 107).

Bearbeiten von Visualisierungen
Nach dem Erstellen einer Visualisierung möchten Sie möglicherweise Anpassungen vornehmen, um
zu verbessern, wie sie den Benutzern Informationen vermittelt. Sie können beispielsweise die
verwendeten Daten ändern oder das Aussehen der Visualisierung anpassen. Sie können weitere
Dimensionen oder Kennzahlen hinzufügen und so detailliertere Informationen bereitstellen, oder Sie
können einige davon entfernen und die Visualisierung dadurch klarer und übersichtlicher gestalten.
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Die Daten in einer Visualisierung können geändert werden. Sie können zum Beispiel eine ungültige
Dimension oder Kennzahl korrigieren oder die Verknüpfung einer Kennzahl zu einer Master-
Kennzahl aufheben, um sie ändern zu können, ohne die Master-Kennzahl zu ändern. Weitere
Informationen finden Sie unter Changing the data of a visualization (page 625).

Die Darstellung einer Visualisierung kann bearbeitet werden, um das Design zu verbessern und die
Visualisierung verständlicher zu gestalten. Sie können die Darstellung Ihrer Visualisierungen auf
verschiedene Arten anpassen:

l Farben: Die Farbgebung ist eine der besten Möglichkeiten, um Werte in Ihren
Visualisierungen hervorzuheben. Qlik Sense stellt eine Reihe verschiedener
Farbgebungsoptionen bereit.
Sie können den distinkten Werten in einer Master-Dimension beispielsweise spezifische
Farben zuweisen, um sicherzustellen, dass für diese Werte in allen Ihren Visualisierungen
dieselben Farben verwendet werden.
Weitere Informationen finden Sie unter Farbige Kennzeichnung einer Visualisierung (page
640).

l Sortieren: Die Sortierung Ihrer Dimensionen und Kennzahlen trägt dazu bei, dass Inhalte in
logischer und verständlicher Form dargestellt werden.
Weitere Informationen finden Sie unter Ändern der Sortierung einer Visualisierung (page
636).

l Titel und Feldnamen: Titel und Feldnamen können geändert werden, um die Visualisierung
übersichtlicher und detaillierter zu gestalten.
In einem Kreisdiagramm zur Anzeige der Umsätze nach Region können Sie beispielsweise
eine Formel hinzufügen, durch die der Gesamtumsatz als Summe bereitgestellt wird.
Weitere Informationen finden Sie unter Changing the appearance of a visualization (page
630).

l Präsentation: Für unterschiedliche Visualisierungen lassen sich unterschiedliche Optionen
anpassen, um die Daten besser darzustellen.
Sie können beispielsweise festlegen, dass die Balken in einem Balkendiagramm gruppiert
oder gestapelt sowie vertikal oder horizontal angezeigt werden.
Weitere Informationen finden Sie unter Changing the appearance of a visualization (page
630).

Sie können eine Visualisierung in einen anderen Visualisierungstyp konvertieren und Ihre
Einstellungen beibehalten. Weitere Informationen finden Sie unter Konvertieren einer vorhandenen
Visualisierung in eine andere Art von Visualisierung (page 664).

Visualisierungseigenschaften werden im Eigenschaftsfenster bearbeitet.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Eigenschaftsfenster für das Arbeitsblatt wird rechts geöffnet.
Wenn es ausgeblendet ist, klicken Sie unten rechts auf Eigenschaften anzeigen .

2. Klicken Sie die Visualisierung an, die Sie bearbeiten möchten.
Im Fenster Eigenschaften werden jetzt die Eigenschaften der Visualisierung angezeigt.
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3. Nehmen Sie unter Eigenschaften Ihre Änderungen vor.
4. Nehmen Sie im Fenster Eigenschaften entsprechende Änderungen vor.

5. Klicken Sie in der Symbolleiste auf Bearbeitung erledigt.

Best Practices für das Gestalten von Visualisierungen

Ordnung schaffen in Ihren Apps
Zu viele Informationen in einer App machen es schwierig zu erkennen, was wichtig ist. Der Stil der
heutigen modernen Benutzeroberfläche hat ein sauberes, einfacheres, flacheres Design. Ein
vereinfachtes Design weist den Lesern auf subtile Art den Weg und ermöglicht ihnen, konzentriert
zu bleiben.

Weniger ist mehr
Die Benutzer versuchen oft, zu viele Informationen in eine App einzuschließen. Liniendiagramme mit
unterschiedlichen Kennzahlen können verwirrend und schwierig zu interpretieren sein. Versuchen
Sie, mehrere kleinere Visualisierungen zu erstellen, um die Informationen über eine Seite zu
verteilen. Dann können die Leser nebeneinander angeordnete Visualisierungen effizient
vergleichen und gegenüberstellen. Sie können auch alternative Dimensionen und Kennzahlen
verwenden, damit die Leser schnell zwischen Kennzahlen umschalten können, ohne eine
Visualisierung zu verändern. Weitere Informationen finden Sie unter Changing the data of a
visualization (page 625).

Es gibt mehrere verschiedene Möglichkeiten, das Erscheinungsbild und die Funktionalität Ihrer App
zu verbessern. Abhängig von Ihrer Zielgruppe und den Daten, die Sie hervorheben möchten, kann
Ihre Visualisierungsgestaltung starke Auswirkungen auf die Interpretation der Daten durch Ihre
Leser haben.

Beschränkungen beachten
Die Nutzer Ihrer Visualisierungen arbeiten möglicherweise mit wenig Platz auf dem Bildschirm oder
geringer Auflösung. Qlik Sense verwendet ein responsives Design für den Umgang mit diesen
Beschränkungen. Wenn der Bildschirmplatz oder die Auflösung aber zu gering sind, müssen
bestimmte Designanpassungen vorgenommen werden. Es gibt folgende Möglichkeiten:

l Eine Teilmenge der Daten wird in Balken- und Liniendiagrammen angezeigt. Wenn die Anzahl
der Dimensionswerte die Breite der Visualisierung übersteigt, wird ein Mini-Diagramm mit
einer Scroll-Leiste angezeigt.

l Reduzierte Menüs für die Auswahl von Datenfiltern. Wenn die Anzahl der Dimensionswerte
den verfügbaren Platz für das Filterfenster übersteigt, wird das Menü reduziert. Die App-
Nutzer müssen auf den Dimensionsnamen im Titel des Filterfensters klicken, um ein neues
Fenster zu öffnen. In diesem neuen Fenster können sie dann ihre Auswahl treffen. Zudem
können bei wenig verfügbarem Platz Dimensionsnamen als Elllipsen in Filterfenstertiteln
angezeigt werden. Die App-Nutzer müssen die Ellipsen anklicken, um den Namen des
Filterfensters anzuzeigen.

l Abgeschnittene Namen in Diagrammlegenden. Namen, die für den für Dimensionen und
Kennzahlen verfügbaren Platz zu lang sind, werden abgeschnitten. Am Ende des
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abgeschnittenen Namens wird eine Ellipse hinzugefügt. App-Nutzer können den Mauszeiger
über den abgeschnittenen Namen halten, um den vollständigen Namen anzuzeigen.

l Fehlende Legenden, Bezeichnungen und Titel.

Die App-Nutzer können Visualisierungen erweitern, um einige dieser Probleme zu beheben. Sie
sollten aber Ihre Apps auf den Geräten, auf denen die Apps voraussichtlich genutzt werden, testen.
Für das Testen stehen auch mehrere Tools zur Verfügung, wie der responsive Designmodus in
Firefox (Strg+Umschalt+M). Bei Bedarf können Sie Visualisierungen in neue Arbeitsblätter
verschieben, die in Visualisierungen angezeigte Datenmenge reduzieren usw.

Zugänglichkeit von Farben
Das Farbspektrum von Personen mit farbbasierten Sehproblemen ist stärker eingeschränkt. Sie
können die Visualisierung anders als von Ihnen beabsichtigt interpretieren.

Einige Menschen sehen die Farben Rot und Grün beispielsweise eher als Gelb oder Braun. Die Rot-
Grün-Farbblindheit ist am weitesten verbreitet. Darauf sollte hingewiesen werden, weil Rot in
Datenvisualisierungen häufig eine negative Bedeutung hat, insbesondere im Finanzwesen.

Ein roter oder grüner KPI-Status kann verwirrend sein. Sie können Formen mit Farben als
Leistungsindikatoren verwenden, um Ihre Designs zugänglicher zu machen. Nutzen Sie
beispielsweise einen leeren roten Kreis, um auf Schlechtes hinzuweisen, einen vollen grünen Kreis
für etwas Gutes und ein Dreieck als Warnsymbol, das nur erscheint, wenn der KPI-Status
inakzeptabel ist.

Linien, Balken und Tortenstücke lassen sich möglicherweise schlecht unterscheiden, wenn die
Farben verzerrt sind.

Weitere Informationen finden Sie unter Changing the appearance of a visualization (page 630).

Filter und Symbol-Platzierung
Filter und Symbole sind unerlässliche Bestandteile von Datenvisualisierungen. Allerdings ist nicht
immer offensichtlich, wo sie platziert oder wie sie sortiert werden sollten. Häufig können Sie auf
Grundlage einiger gut etablierter Designprinzipien antizipieren, wo Benutzer mit dem Lesen
beginnen.

Platzierung auf der linken Seite
Mehrere beliebte Websites arbeiten mit Navigationskacheln und Filtern, die links angeordnet sind.
Das liegt daran, dass viele Sprachen von links nach rechts gelesen werden. Daher müssen diese
Leser am häufigsten auf die linke Seite des Bildschirms schauen. Benutzer, die nach Inhalten
suchen, tendieren zur linken Seite des Bildschirms. Je weiter entfernt die Objekte sind, um so
weniger werden die Benutzer sie anschauen. Wenn alle Ihre Filter und Symbole vertikal auf der
linken Seite angeordnet sind, ist deren Gewichtung identisch.

Für Sprachen, in welchen der Text von rechts nach links geschrieben wird, trifft das Gegenteil zu.
Das sollte bedacht werden, wenn Ihre Apps in diese Sprachen übersetzt werden.
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Platzierung oben
Eine andere häufige Platzierungsoption für Symbole und Filter ist oben in einer App. Wenn Filter
oder Symbole nicht links platziert werden, vergrößert sich die Fläche für Visualisierungen ohne
störende Menüs. Wenn Filter und Symbole über Visualisierungen platziert werden, werden sie auch
als vom darunter stehenden Inhalt getrennt wahrgenommen. Das kann die Leser darauf hinweisen,
dass Sie Filter oder Symbole priorisieren. Wenn alle Ihre Filter und Symbole nebeneinander oben
angeordnet sind, hat der Filter bzw. das Symbol ganz links mehr Gewicht und wird vom Leser
priorisiert.

Weitere Informationen finden Sie unter Strukturieren von Apps mithilfe von Arbeitsblättern (page
11).

Informationshierarchie
Manchmal möchten Sie bewirken, dass Ihr Leser bestimmte Visualisierungen anderen vorzieht. Sie
können eine Informationshierarchie mithilfe einiger der Schlüsselpraktiken für das Design anzeigen.
Beispielsweise können Sie unterschiedliche Größen verwenden, um einige Visualisierungen
hervorzuheben. Größere Informationen werden als wichtiger wahrgenommen, und durch eine
Vergrößerung der Schriftart oder des Diagramms können Sie dem Leser zeigen, wohin er zuerst
schauen soll.

Der Seitenplatzierung kommt bei der Informationshierarchie ebenfalls eine Rolle zu. Die
Informationen oben auf der Seite werden zuerst gelesen und somit als wichtiger wahrgenommen,
als die Informationen unten auf der Seite. Informationen auf der ersten Seite werden als wichtiger
wahrgenommen, als jene auf der letzten Seite.

Hinzufügen von Kontext zu KPI
KPIs sind eine ausgezeichnete Möglichkeit, um die großartigen Ideen in Ihrer App zu vermitteln.
Allerdings bieten KPI-Werte keinerlei Kontext hinsichtlich der Zahlen und Berechnungen hinter den
Kulissen. Eine grüne Lampe neben einer KPI sagt dem Leser nicht, ob das Ziel einfach nur erreicht
wurde oder ob Sie es grandios übertroffen haben.

Damit Ihre KPIs auch Kontext haben, fügen Sie neben dem Wert in einer kleineren Schriftart Text
hinzu. Zum Beispiel können Sie den aktuellen KPI-Wert mit dem Wert aus dem Vorjahr vergleichen.
Sie können auch ein kleines Balkendiagramm ohne Achsen oder Werte hinzufügen, um
Informationen zum aktuellen Trend zu bieten.

Die Tücken der Datenvisualisierung vermeiden
Um von den Vorteilen von Datenvisualisierungen zu profitieren, müssen Sie deren Tücken
vermeiden. Hier einige häufige Fehler:

Übertriebener Einsatz von Farben
Verwenden Sie Farben nicht exzessiv. Der Einsatz der falschen Farbe am falschen Ort sorgt eher für
Verwirrung als für Klarheit. Zudem kann eine Farbe in verschiedenen Teilen der Welt
unterschiedliche Bedeutungen haben.
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Falsche Verwendung von Kreisdiagrammen
Verwenden Sie Kreisdiagramme nicht nebeneinander zum Vergleichen. Versuchen Sie nicht, sie mit
zu vielen Informationen zu überfrachten.

Visuelles Durcheinander
Zu viele Informationen gehen auf Kosten der Klarheit. Verwenden Sie maximal neun KPIs und
vermeiden Sie jedes visuelle Durcheinander.

Design vor Inhalt
Eine optisch ansprechende Visualisierung ist nicht unbedingt die effektivste. Folgen Sie immer den
besten Gestaltungspraktiken.

Mangelhafte Daten
Erkennen und korrigieren Sie Probleme mit Ihren Daten, bevor Sie sie präsentieren. Die Schuld sollte
nicht auf die Visualisierung geschoben werden, wenn das Problem bei fehlerhaften Daten liegt.

Creating visualizations with Insight Advisor
Explore your data and create visualizations with Analysetypen für Insight Advisor and
Insight Advisor Search. Insight Advisor creates visualizations for you using the Qlik
Cognitive Engine and your app logical model. Click Insight Advisor in a sheet to use
Insight Advisor Search and Analysetypen für Insight Advisor.
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Analysetypen für Insight Advisor
Select the type of analysis you want to see, such as breakdown, trend over time, or mutual
information. Then select the data you want used in the analysis. Insight Advisor generates charts
using your choices. Analysetypen für Insight Advisor is the fastest way to create charts when you
know what you want to see and the data sources to use, but not how to build the analysis yourself.

Creating analyses by selecting analysis types (page 582)

Navigating Insight Advisor (page 590)

Insight Advisor Search
Enter a natural language question or statement. Insight Advisor then uses the Qlik Cognitive Engine
to interpret your question and create visualizations to answer your questions from your data model.
Insight Advisor Search is the fastest way to create charts when you have a specific question to
answer.

You can also select fields and master items from the assets panel. Insight Advisor generates results
based on your selections.

Creating analyses using search (page 583)

Creating analyses by asset selection (page 584)

Navigating Insight Advisor (page 590)

Users can also access Insight Advisor in the hub with Insight Advisor Chat.

Insight Advisor and the logical model
Insight Advisor creates visualizations using the Qlik Cognitive Engine and a logical model of your
data. The logical model defines how fields in your data model should be used a dimensions or
measures, as well as the relationships between fields. By default, Insight Advisor builds a logical
model by learning from user interactions. If you add charts to sheets or edit charts, Insight Advisor
learns these preferences.

You can also create your own custom logical model for the app. Business logic lets you to define the
relationship and use of data in your logical model. When business logic is turned on, precedent-
based learning is not available. If you define calendar periods and set them as default periods,
period analysis and period performance analysis types are available.

As of August 2022, Insight Advisor, including business logic, is no longer supported with
Qlik Sense Desktop. In November 2022, Insight Advisor will be upgraded to a new
experience. This will only be available on Qlik Sense Enterprise on Windows. Users who
want to continue using Insight Advisor and business logic on Qlik Sense Desktop should
not upgrade to August 2022.
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Creating visualizations with Analysetypen für Insight Advisor and Insight
Advisor Search
You can generate charts using Insight Advisor in three ways:

l Select the type of analysis you want to see and the fields or master items that should be used
with it. Analysetypen für Insight Advisor then generates matching analyses .

l Ask Insight Advisor a question and let Insight Advisor Search generate charts using natural
language analytics.

l Select fields or master items and let Insight Advisor Search generate charts through auto-
analysis of your data.

The data assets available to you in Insight Advisor depend on if the app uses business logic to
define its logical model and your space permission. If you have Can view permission will only be
able to see master items, unless the app defines its logical model with business logic.

Creating analyses by selecting analysis types
Pick an analysis type and then add fields to create analyses with Analysetypen für Insight Advisor.
This is a fastest method of creating visualizations when you know what analyses you want to see
and the data you want to use, but not how to build the analyses yourself.

Click Create an analysis on the Insight Advisor start page. In Analysis options, all available
analysis types display with descriptions of their use.

Analysis options

After selecting an analysis type, you then select fields or master items to use in the analysis. Insight
Advisor offers suggestions of assets to use for each parameter. You can change analysis types by
selecting a new analysis type from the dropdown or clicking View all analyses to view the analysis
options. You can clear your selections by clicking Reset analysis.
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Building an analysis

Gehen Sie folgendermaßen vor:

1. In a sheet, click Insight Advisor.
2. Click Create an analysis.
3. Under Analysis options, select your analysis type.
4. Add the required fields or master items for your analysis type.

When you have added the required fields, Insight Advisor generates your charts.

Creating analyses using search
Ask Insight Advisor Search natural language questions and it generates relevant charts using field
names, field values, and master items. You can search Insight Advisor in the following ways:

l Enter a natural language question or statement, such as what are the top products for sales
or Show me Product by Revenue in Sweden. Natural language questions work best when
they refer to field or master items directly.
For guidelines on using natural language in your searches, see Verwenden von natürlicher
Sprache mit Insight Advisor (page 594).

l For information about language support in Suche für Insight Advisor, see Supported
languages (page 589).

l If your browser's voice-to-text capability is supported in Insight Advisor, you can click the
microphone icon to ask Insight Advisor your question.

Qlik Sense Desktop does not support voice-to-text capabilities for questions.

Insight Advisor uses the fields or terms you specify. It may use additional fields in the generated
visualizations. Insight Advisor uses any precedents you have given it for hiding charts, setting fields
as dimensions or measures, or excluding fields from analysis. In Qlik Sense Enterprise, Insight
Advisor can use precedents learned from other published apps if they use a similar or identical data
model.
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For natural language questions, Insight Advisor tries to find a matching Insight chart result. If one is
found, it shows related results as well. You can click to view how Insight Advisor generated
results from your question. .

Matching result with natural language insights

If you receive the following error message: "Unable to generate insights - Please try
again later," you might not meet the CPU requirements for Insight Advisor.

Gehen Sie folgendermaßen vor:

l In a sheet, enter a question or statement in the Ask Insight Advisor search bar and click .
Alternatively, click Insight Advisor, enter a question in the Insight Advisor search bar and
click .

Creating analyses by asset selection
Select fields and master items to use in charts and let Insight Advisor Search auto-generate charts,
select assets to use from the assets panel. You can also enter asset names in the Insight Advisor
search bar. Insight Advisor then uses the fields you selected to generate charts. It may use
additional fields in the generated visualizations.

Insight Advisor uses any precedents you have given it for hiding charts, setting fields as dimensions
or measures, or excluding fields from analysis. In Qlik Sense Enterprise, Insight Advisor can use
precedents learned from other published apps if they use a similar or identical data model.
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Insight Advisor analyses generated by selection

Gehen Sie folgendermaßen vor:

1. In a sheet, click Insight Advisor.
2. In the assets panel, select fields and master items to create analyses.

Alternatively, enter field or master item names in the search bar.
As you select assets, Insight Advisor generates visualizations.

Voice-to-text data transfer considerations
In vielen Internetbrowsern verwendet die Sprache-zu-Text-Suchfunktion von Insight Advisor die
Web Speech-API für die externe Verarbeitung von Sprach-zu-Text-Daten. Dies wird sowohl von
Suche für Insight Advisor als auch von Insight Advisor Chat verwendet. Der Internetbrowser des
Benutzers kann das Audiosignal, das von der Browser-API aufgezeichnet wurde, zur Transkription
an eine externe Quelle gesendet werden. Die Sprachverarbeitung erfolgt über den Webservice, der
vom Webbrowser des Benutzer gewählt wurde. In der Folge könnten die erfassten Informationen an
einen Server eines Drittanbieters gesendet werden. Qlik ist nicht für die Datenverarbeitung durch
diese Drittfirma verantwortlich.

Falls Benutzer diesen Informationsfluss zum relevanten Browser des Drittanbeiters (deaktivieren
Sie dazu die Sprache-zu-Text-Funktion) einschränken möchten, wird dies möglicherweise durch
spezielle Steuerelemente, einschließlich Einstellungen innerhalb des gewählten Browsers und
andere Sicherheitskonfigurationen, erreicht.

Using Insight Advisor analyses
You can expand an Insight Advisor analysis by selecting it or clicking . You can then make
selections in the analysis.

Note the following regarding selections:

l Selections apply to all analyses.
l Selections made in charts from your sheets are kept when you open Insight Advisor.
l Selections do not affect the charts created by Insight Advisor.
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If an analysis is new, you can add it to your sheets. If the chart exists in a sheet, you can click the
sheet name at the bottom of the chart to go to that sheet.

Some analysis types, such as period over period dashboard, provide multiple related visualizations
rather than a single chart. These show a preview of the kind of visualizations included in the
analysis. Click Open analysis to view the analysis with data.

A period over period dashboard analysis

You can view additional options by clicking . The following options are available:

l Full screen: Expand a chart to make selection.
l Edit analysis properties: Edit the chart properties to change dimensions, measures, and the

chart type.
Editing Insight Advisor analysis properties (page 587)

l Add to sheet...: Add the chart to a new or existing sheet.
l Add to new sheet: Add the charts to a new sheet (period changes, period changes

(detailed), period over period, period over period (selected) analysis types only).
l Download: Download the chart as an image, PDF, or data.
l Hide: Hide charts that you do not want Insight Advisor to use again. You can view the charts

hidden from your current search in General properties.

Hide is not available in apps using business logic.
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Editing Insight Advisor analysis properties
Edit Insight Advisor analysis by selecting a chart and clicking . The following properties are
available in Analysis properties:

l Chart type: If available, select a different chart type. For an outline of the alternate chart
types available for the different analyses, see Insight Advisor-Analysetypen (page 595).

l Favorable trend: (Rank analysis only) Indicate if the favorable trend for ranking is to increase
or decrease.

l Parameters: Make adjustments to parameters specific to the analysis type of the chart.
l Dimensions and Measures: Change the fields used as Dimensions or as Measures. You can

change the measure aggregation. Reorder measures or dimensions by dragging them.
Dimensions and measures from Insight Advisor analysis can be added to your master items.
Click a dimension or measure and then click Add new.
If you specified filters in a natural language question, such as specific field values, you can
modify them as well.

l Details: View information about why the chart was generated and the precedents Insight
Advisor has learned from a chart. Select details by clicking them to change or reject them.
You can set fields as dimensions or measures or exclude fields from future analysis. You can
hide charts from future analysis by selecting We suggested a chart for this combination of
data and clicking Hide this chart.

l Analysis period: Change which period from business logic calendar periods is applied to the
chart. You can adjust the analysis period by selecting new values from Period 1 or Period 2.
Select an analysis period for rank type charts to view period and period performance analysis
types.

Analysis period is only available when business logic is turned on and calendar
periods have been created for the app. If there is no business logic, Analysis
period is available if the app has date/time fields with autoCalendar derivations in
the load script.

Editing calendar period Insight Advisor analyses
If a default calendar period is assigned to a group, additional period analysis types are available for
Insight Advisor analysis. Default calendar periods are created in business logic. These have
different properties than other charts. The following types are available:

l Period changes: Shows the change of a measure from the current or latest period in the
selected analysis period.

l Period changes (detailed): Compares a change in a measure from the current period to the
previous period. The change is measured using a forecasted target value. You define the
percentages for meeting the target, almost meeting the target, and missing the target.

l Period over period: Compares a change in a measure of the current period versus the
previous period.
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l Period over period (detailed): Compares changes in a measure over time between periods.
It includes a filter pane for exploring dimension values period over period.

These analysis types have unique properties. Period changes and Period over period (detailed)
have the following properties:

l Breakdown: Select the dimension to use with the measure to view the period changes.
l Measures: Select the measure for which you want to see period changes.
l Analysis period: Select the analysis period. You can adjust the analysis period by selecting

new values from Period 1 or Period 2.

Period over period has the following properties:

l Measures: Select the measure for which you want to see period changes.
l Analysis period: Select the analysis period. You can adjust the analysis period by selecting

new values from Period 1 or Period 2.

Period over period (detailed) has the following properties:

l Parameters: Set the percentage limits, expected change margin, and expected change rate.
l Favorable trend: Indicate if the favorable trend for the measure is to increase or decrease.
l Breakdown: Select the dimension to view the detailed period changes with the measure.
l Measures: Select the measure for which you want to see period changes.
l Analysis period: Select the analysis period. You can adjust the analysis period by selecting

new values from Period 1 or Period 2.

These analysis types have unique properties. Period changes and Period over period (detailed)
have the following properties:

Insight Advisor learns your preferences for that chart if you add it to a sheet or click Learn after
editing the chart. Precedents set by a user only apply to that user's instance of Insight Advisor.

Managing general properties
In General properties, you can view and edit your hidden and learned charts and the precedents
you have set for generating charts.

General properties are not available when business logic is turned on.

The following properties are available:

l Hidden recommendations contains charts you have hidden from searches. You can click
to show the chart again in searches.

l Learned recommendations contains charts you selected Learn on after editing. You can
delete learned charts by clicking .

l Your defined preferences shows all the preferences Insight Advisor has learned. You can
delete preferences by clicking .
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You can clear all hidden charts, learned charts, and preferences by clicking Clear all.

Supported languages
Qlik Sense unterstützt die englische Sprache für Fragen in natürlicher Sprache.

Wenn Ihre Qlik Sense-Bereitstellung Zugriff auf einen Qlik Sense SaaS-Mandanten umfasst, können
Administratoren Unterstützung für die folgenden Sprachen aktivieren:

l Deutsch
l Spanisch
l Französisch
l Italienisch
l Niederländisch
l Polnisch
l Portugiesisch
l Russisch
l Schwedisch

Für Browser, bei denen keine unterstützte Sprache konfiguriert wurde, wird standardmäßig
Englisch verwendet. Sie können die für Fragen verwendete Sprache ändern, indem Sie eine neue
Sprache über die Schaltfläche Sprache auswählen. Weitere Informationen finden Sie unter
Aktivieren von Fragen in natürlicher Sprache für mehrere Sprachen in Qlik Sense Enterprise on
Windows.

Limitations
The following section lists limitations for Insight Advisor.

General limitations
Insight Advisor has the following general limitations:

l Insight Advisor supports master items that use dollar-sign expansions in their expressions
with the following limitations:

l Expressions and captions for master items are expanded once and the results are
cached. The dollar-sign expressions are not reevaluated until the expressions change
or the cache expires (usually 30 days after the evaluation).

l Dollar-sign expressions that are defined in a way that expands to values, such as =sum

(Sales), are not supported. These expressions cannot be combined with filters in
Insight Advisor. Dollar-sign expressions must expand to expressions to be used in
Insight Advisor.

l In published apps, only master items are available for use in Insight Advisor. Insight Advisor
Chat can use fields from published apps when creating Insights charts. If you go to Insight
Advisor using from Explore this further, your search may not be available.

l If a field name contains only numerical values, that field will be used when generating results
from a natural language question instead of a superlative (such as top or bottom with the
same numerical value).
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For example, if you searched for top 3 service providers and one of your fields was named 3,
3 will be used in the results instead of the top 3 results for service providers.

l English questions using the trend keyword with one measure and a time filter are not
supported.

Limitations for natural language insights
The following limitations apply to natural language insights in Insight Advisor:

l Natural language insights are not always included with supported analysis types, depending
on how a natural language question is processed and the data being used.

l Natural language insights only provide a general statement when the question includes more
than two filters or more than two data value filters on a dimension. The filters used are
included in the response, however.

l Natural language insights are available for the following analysis types:
l Ranking
l Trend over time
l Comparison
l Breakdown (geospatial)
l Clustering
l Correlation
l Process control (mean)

Navigating Insight Advisor
Click Insight Advisor in a open sheet to open Suche für Insight Advisor and
Analysetypen für Insight Advisor.

Insight Advisor is available from the sheet view of an app. Click the Insight Advisor button to open
Insight Advisor.

Insight Advisor is not available when a sheet is in edit mode.

Insight Advisor button

From Insight Advisor, you can start generating analyses with Suche für Insight Advisor or
Analysetypen für Insight Advisor.
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Insight Advisor

Enter a question or select fields from the assets panel to start creating analyses with Suche für
Insight Advisor. Click Create an analysis to start building analyses with Analysetypen für Insight
Advisor. You can also select from the common analysis types to start with Insight Advisor Analysis.

Insight Advisor assets panel
In Suche für Insight Advisor, you can create queries by selecting fields and master items. In
Analysetypen für Insight Advisor, you can select fields and master items to use in your analysis.

If the app is published, only master items are available.
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Insight Advisor assets panel
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Insight Advisor search box
You can also access Suche für Insight Advisor by entering a natural language question in the search
box.

Search box

You can enter your search here, either by entering asset names or using natural language. If you
used a natural language question, you can click to view the filters generated from your question.

Insight Advisor analyses
These are the charts created by Insight Advisor. Analysetypen für Insight Advisor shows the
primary chart for your analysis type, with alternative chart types for your analysis beneath. Suche
für Insight Advisor indicates the number of results and breaks them down as follows:

l How many results are found.
l How many charts already exist in your sheets.
l How many charts are newly generated by Insight Advisor.

Analyses generated by Insight Advisor

Insight Advisor charts can be added to existing or new sheets. Charts can also be downloaded as
an image, PDF, or as an Excel spreadsheet containing the data used in that chart.

Using Insight Advisor analyses (page 585)

Properties panel
The properties panel contains options for editing analysis and changing the precedents you have
set in Insight Advisor.
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Properties panel in Insight Advisor

In General properties, you can view and edit your charts and the precedents you have set for
generating analysis. For more information, see Managing general properties (page 588).

In Analysis properties, you can edit an analysis and view details. You can see the Analysis type
used to create the chart. Click to learn more about the analysis type used. For more information,
see Editing Insight Advisor analysis properties (page 587).

Analysetypen für Insight Advisor parameters
When using Analysetypen für Insight Advisor, you select the parameters for your analysis. You can
select from the assets panel or from the recommendations for each parameter type.

Parameters for Analysetypen für Insight Advisor

Verwenden von natürlicher Sprache mit Insight Advisor
Insight Advisor unterstützt Fragen in natürlicher Sprache, beispielsweise Show me
Product Inventory for Japan under 2500.

Fragen in natürlicher Sprache unterstützen drei Arten von Filtern:

l Zeit: Eine Uhrzeit- oder Datumseinheit. Beispiel: Show me 2019 Sales.
l Kategorie: Ein Wert aus einer der Dimensionen. Beispiel: Show me Sales by Product for

Sweden.
l Kennzahl: Ein Wert bzw. Werte aus einer Kennzahl. Beispiel: Show me Sales for Sweden by

Product under 1K.
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Sie können nach Fakten, Vergleichen und Rangfolgen suchen. Fakten sind Aussagen wie What are
my sales oder Show expenses over time for 2019. Sie können nach einem Vergleich fragen, indem
Sie Ihrer Frage die Begriffe vs oder compare hinzufügen. Beispiel: Compare sales to expenses over
time. Sie können nach Rangfolgen fragen, indem Sie der Frage top hinzufügen. Beispiel: Show me
top 10 product by sales for 2020.

Qlik Sense unterstützt die englische Sprache für Abfragen in natürlicher Sprache.

Für Browser, bei denen keine unterstützte Sprache konfiguriert wurde, wird
standardmäßig Englisch verwendet. Sie können die für Abfragen verwendete Sprache
ändern, indem Sie eine neue Sprache über die Schaltfläche Sprache auswählen. Weitere
Informationen finden Sie unter Aktivieren von Abfragen in natürlicher Sprache für
mehrere Sprachen in Qlik Sense Enterprise unter Windows.

Wenn Ihre Qlik Sense-Bereitstellung Zugriff auf einen Qlik Sense SaaS-Mandanten
umfasst, können Administratoren Unterstützung für weitere Sprachen aktivieren.
Weitere Informationen zu unterstützten Sprachen in Suche für Insight Advisor finden Sie
unter Unterstützte Sprachen.

Suchen in natürlicher Sprache müssen Feldnamen und Werte in Ihrem Datenmodell referenzieren.
Sie können auch Master-Elemente mit Synonymen kennzeichnen, indem Sie Tags für Ihre Master-
Elemente verwenden. Verwenden Sie für Synonym-Tags das Format alt:<begriff>. Wenn Sie
beispielsweise cities als Synonym verwenden möchten, kennzeichnen Sie das Master-Element als
alt:cities. Weitere Informationen finden Sie unter Tagging master items (page 154).

Klicken Sie in einem von Insight Advisor generierten Diagramm auf , um Feedback zur
Visualisierung zu geben. Sie können eine positive oder negative Antwort angeben und einen
Kommentar schreiben.

Beim Durchsuchen von Feldwerten durchsuchen Fragen in natürlicher Sprache nur die
ersten 100.000 Werte pro Feld in der Frage.

Weitere Informationen über Fragen in natürlicher Sprache finden Sie im Abschnitt zu Funktionen
von Abfragen in natürlicher Sprache in Qlik Sense.

Insight Advisor-Analysetypen
Insight Advisor liefert Ergebnisse anhand einer großen Auswahl an Analysetypen. Mit
diesen Analysetypen lassen sich für generierte Diagramme optimierte Visualisierungen
erzielen.

Abhängig von den Eingaben der Suche und den Merkmalen Ihrer Daten werden unterschiedliche
Analysetypen verwendet. Die Qlik Cognitive Engine bestimmt den besten Analysetyp für Ihre Suche
abhängig von den verfügbaren Daten. In der folgenden Tabelle sind die Analysetypen beschrieben.
Nicht alle Bedingungen für jeden Analysetyp sind aufgelistet. Die Tabelle listet auch Diagramme auf,
die als Alternativen verfügbar sein könnten, wenn eine Insight Advisor-Analyse bearbeitet wird.
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Analysetyp Beschreibung Dimensionen Kennzahlen

Aufschlüsselung Zeigt verschachtelte
Dimensionen von Daten, die
eine Aufschlüsselung
relativer Beiträge zu einer
Kennzahl bereitstellen.

2-3 1

Aufschlüsselung
(räumlich)

Gruppiert Daten nach
einfachen und hierarchischen
geografischen
Unterteilungen.

1-2 1-2

Berechnete Kennzahl
(KPI)

Fasst die Leistung in einem
bestimmten
Geschäftssegment oder
einer bestimmten Dimension
mithilfe einer
Leistungskennzahl (KPI)
zusammen.

0 1-2

Cluster (K-Means) Gruppiert Datenpunkte, die
nach Ähnlichkeiten aus 2
Kennzahlen über eine
Dimension mit einem K-
Means-Algorithmus von
Machine Learning aggregiert
wurden.

1 2

Vergleich Vergleicht zwei Kennzahlen
für eine Dimension.

1 2

Korrelation Identifiziert komplementäre
und umgekehrte
Beziehungen zwischen zwei
Datenwerten.

0-2 2

Analysetypen
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Analysetyp Beschreibung Dimensionen Kennzahlen

Gegenseitige
Informationen

Erstellt eine Kennzahl der
Sicherhheit zwischen
Wertepaaren unter
Verwendung eines Machine
Learning-Algorithmus, der
zufällige Datenverteilungen
anwendet.

Der Abhängigkeitsindikator
hat einen Wert zwischen 0
Prozent (keine Abhängigkeit)
und 100 Prozent (starke
Abhängigkeit).

Mit gegenseitigen
Informationen werden ein
Feld (eine Kennzahl oder
Dimension) als Ziel und dann
1 bis 10 Dimensionen oder
Kennzahlen als Treiber
ausgewählt.

Die Ergebnisse für diesen
Analysetyp für die gleichen
Felder oder Auswahlen
können aufgrund der
zufälligen Datenauswahl
voneinander abweichen.

Variable Variable

Überblick Beschreibt, wie
Datenbereiche bezüglich
einer absoluten Kennzahl
zueinander in Beziehung
stehen.

1-2 1
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Analysetyp Beschreibung Dimensionen Kennzahlen

Zeitraumänderungen Erstellt ein Arbeitsblatt mit
Kennzahlen, Rangfolge und
Vergleichsanalyse für
Dimensionen über
verschiedene Zeiträume
hinweg.

Dafür muss ein
Standardkalenderzeitraum
für die Gruppe festgelegt
sein, welche die Kennzahl im
logischen Modell enthält.

1-2 1

Zeitraumänderungen
(detailliert)

Erstellt ein Arbeitsblatt mit
Kennzahlen, Rangfolge und
Vergleichsanalyse für eine
Dimensionshierarchie über
verschiedene Zeiträume
hinweg.

Dafür muss ein
Standardkalenderzeitraum
für die Gruppe festgelegt
sein, welche die Kennzahl im
logischen Modell enthält.

1 1

Zeitraumvergleich Vergleicht Dimensionen über
Zeiträume hinweg.

Dafür muss ein
Standardkalenderzeitraum
für die Gruppe festgelegt
sein, welche die Kennzahl im
logischen Modell enthält.

1 1

Zeitraum über
Zeitraum (ausgewählt)

Vergleicht Dimensionen über
Zeiträume hinweg. Dazu
gehört ein Filterfenster für
das Auswählen von
Dimensionswerten.

Erfordert ein Zeitfeld mit
einem von „autoCalendar“ 
abgeleiteten Feld als Teil der
Abfrage.

1-3 1
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Analysetyp Beschreibung Dimensionen Kennzahlen

Prozesssteuerung
(Mittel)

Überwacht Daten im
Vergleich zu erwarteten
Statistikbereichen auf Basis
von Mittelwerten.

1 Datums-
/Uhrzeitdimension

1

Prozesssteuerung
(gleitendes Mittel)

Überwacht Daten im
Vergleich zu erwarteten
Statistikbereichen auf Basis
von angrenzenden Werten.

1 Datums-
/Uhrzeitdimension

1

Rangfolge Stuft Dimensionswerte nach
relativer Wichtigkeit mit einer
Kennzahl ein.

1-2 1

Rangfolge (gruppiert) Stuft hierarchische
Dimensionswerte nach
relativer Wichtigkeit mit einer
Kennzahl ein.

1-2 1

Relative Bedeutung Zeigt die Größe von
Dimensionswerten, die zum
Ganzen beitragen. Kann auch
verwendet werden, um eine
Pareto- oder 80/20-
Beitragsanalyse
durchzuführen.

1 1

Trend im Zeitverlauf Zeigt Datentrends im
Zeitverlauf, optional
aufgeschlüsselt nach einer
Dimension mit geringer
Kardinalität.

1 Datum-
/Uhrzeitdimension
und optional 1
weitere Dimension

1-3

Werte (Tabelle) Zeigt Daten, die in Zeilen und
Spalten, welche Kennzahlen
und Dimensionen zeigen,
angeordnet sind.

0-10 0-10

Seit Jahresbeginn Vergleicht Dimensionen über
denselben Zeitraum in einem
vorherigen Jahr.

1 1

Verwenden von intelligenten Arbeitsblättern in Insight Advisor für
zeitraumbasierte Analysen
Verwenden Sie intelligente Arbeitsblätter in Insight Advisor, um automatisch
vollständige Arbeitsblätter für Ihre Qlik Sense App zu erstellen. Intelligente
Arbeitsblätter wurden eigens für die Erstellung von zeitraumbasierten Analysen
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entwickelt.

Intelligente Arbeitsblätter werden von Insight Advisor automatisch generiert.

Greifen Sie über Analysetypen für Insight Advisor auf den Ersteller für intelligente Arbeitsblätter zu,
wenn Sie einen der folgenden Analysetypen auswählen:

l Zeitraum über Zeitraum (ausgewählt)
l Zeitraumänderungen
l Zeitraumänderungen (detailliert)

Der Analysetyp Zeitraumvergleich ist ein ähnlicher Analysetyp, der aber technisch nur
einzelne Visualisierungen erstellt. Er wird hier erwähnt, weil die Anforderungen für die
Arbeit mit diesem Analysetyp die Gleichen wie für die auf intelligenten Arbeitsblättern
basierenden Analysetypen sind.

Voraussetzungen
Die folgende Tabelle gibt einen Überblick über die Anforderungen, damit Sie die Analysetypen
Zeitraumvergleich, Zeitraumvergleich (ausgewählt), Zeitraumänderungen oder
Zeitraumänderungen (detailliert) verwenden können.

Analysetyp Voraussetzungen

Zeitraum über Zeitraum Mindestens ein Kalenderzeitraum muss mithilfe des automatischen
Kalenders definiert sein.

Zeitraum über Zeitraum
(ausgewählt)

Mindestens ein Kalenderzeitraum muss mithilfe des automatischen
Kalenders definiert sein.

Anforderungen für die Arbeit mit zeitraumbasierten Analysetypen in Insight Advisor
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Analysetyp Voraussetzungen

Zeitraumänderungen Einer der folgenden:

l Mindestens ein Kalenderzeitraum muss mithilfe des
automatischen Kalenders definiert sein.

l Mindestens ein Kalenderzeitraum muss mithilfe eines
benutzerdefinierten Kalenders definiert sein.

Zeitraumänderungen
(detailliert)

Einer der folgenden:

l Mindestens ein Kalenderzeitraum muss mithilfe des
automatischen Kalenders definiert sein.

l Mindestens ein Kalenderzeitraum muss mithilfe eines
benutzerdefinierten Kalenders definiert sein.

Verwenden von Kalenderzeiträumen und automatischem Kalender
Die Verwendung des automatischen Kalenders in Ihrer App ist die einfachste Möglichkeit, zu
gewährleisten, dass Sie alle zeitraumbasierten Analysetypen verwenden können. Das liegt daran,
dass der automatische Kalender automatisch eine Reihe von Kalenderzeiträumen zur App
hinzufügt, um zeitraumbasierte Analysen zu vereinfachen.

Wenn Sie eine App erstellen und Daten mit dem Datenmanager laden, wird der automatische
Kalender automatisch im Skript erstellt, wenn Datumsfelder in den Daten erkannt werden.

Wenn Sie diese Analysetypen in Ihrer App nicht verwenden können, liegt dies daran, dass Sie den
erforderlichen Kalenderzeitraum nicht erstellt haben. Das kann verschiedene Gründe haben, unter
anderem:

l Ihre App wurde mit Skripterstellung erstellt, und Sie haben das Skript für den automatischen
Kalender nicht manuell in das Ladeskript eingefügt.

l Sie haben den automatischen Kalender in der App, aber alle Kalenderzeiträume wurden aus
der Geschäftslogik der App entfernt.

l Ihre App enthält mindestens einen Kalenderzeitraum, wurde aber mit einem
benutzerdefinierten Kalender erstellt (bei Verwendung von benutzerdefinierten Kalendern
sind die Analysetypen Zeitraumvergleich und Zeitraumvergleich (ausgewählt) nicht
verfügbar).

Hinzufügen des automatischen Kalenders zu Ihrem Ladeskript
Wenn Sie Ihre App im Dateneditor erstellt und keinen benutzerdefinierten Kalender definiert haben,
können Sie das Skript für den automatischen Kalender direkt in das Ladeskript der App einfügen
und die Namen der Felder ändern, die Sie mit dem automatischen Kalender verknüpfen möchten.

Hinzufügen oder erneutes Hinzufügen von Kalenderzeiträumen
Wenn Kalenderzeiträume aus der Geschäftslogik Ihrer App gelöscht wurden, fügen Sie mindestens
einen von ihnen wieder hinzu, um Zugriff auf die verfügbaren zeitraumbasierten Analysetypen zu
erhalten. Für mit dem automatischen Kalender definierten Kalenderzeiträume können diese
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entweder Letzter sortierter Wert oder Relativ sein.

Erstellen von intelligenten Arbeitsblättern
Ein vollständiges Beispiel für das Erstellen eines intelligenten Arbeitsblatts und Hinzufügen zu
einem Arbeitsblatt in einer Qlik Sense App finden Sie unter Erstellen einer App. Suchen Sie nach
dem Abschnitt Arbeitsblatt aus Analysetypen erstellen.

Editing visualizations created by Insight Advisor
Insight Advisor selects and generates charts driven by analysis types. Analysis types
and chart functions are chosen based on the inputs of the search and characteristics of
the data. Business analysts design the business logic components of apps and can also
edit properties and extend the functions underlying the charts further. For more
information, see Business logic. For more information on analysis types, see .

The following examples show ways that Insight Advisor charts can be edited through properties
and the expression editor to enhance visualizations that best capture and frame your data. These
examples are based on charts that can be generated and then extended from the Insight Advisor
business logic tutorial app. .

Screenshots for these examples are from Qlik Sense SaaS and may differ in Qlik Sense
Enterprise on Windows. Screenshots in the examples may differ depending on the date
on which you loaded the business logic tutorial app.

Mutual Information: Changing measures for improved charts
Statistical dependencies between a specified value (measure) and other selected items is
presented in Insight Advisor by the Mutual Information chart. The dependency ranges between 0%
(no dependency) and 100% (strong dependency). This example shows how you can replace
measures to present more interesting and meaningful relationships in the chart.

Gehen Sie folgendermaßen vor:

1. In the business logic tutorial app, enter the search dependencies in the search box. Look for
a result displaying Mutual dependency between SalesOffice and selected items.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 602

/en-us/sense/Content/Sense_Helpsites/Tutorials/Tutorials-building-app.htm
/en-US/sense/Subsystems/Hub/Content/Sense_Hub/BusinessLogic/business-logic-logical-models.htm


3   Visualizations

Default results for Mutual Information search

2. Select Add to sheet in the chart, then Create new sheet.

3. From the app overview, click Sheets to view the sheets. Select My new sheet and give
the sheet a Title and Description. For this example, name the sheet Mutual Information Sales
and an optional description Mutual information between sales fields.

4. Click Edit sheet in the toolbar and select the mutual dependencies chart.

5. Click anywhere in the chart title to change the title from Mutual dependency between
SalesOffice and selected items to Mutual information around sales.

6. Modify the fields analyzed in this chart. Insight Advisor selected four measures to include in
the chart that are related to geography. This was a reasonable interpretation of what
dependencies the field SalesOffice might have because SalesOffice was classified as a city
in the logical model of the app. Modify the measures in the properties panel and change them
to fields that will better reflect how Sales is impacted by variables related to sales quantity,
cost of sales, and sales support.

a. Select Data in the properties panel and in the Measures section; expand the measure
SupplierCountry. Select in the Expression field to open the Edit expression dialog.
Click Apply.
Edit the expression by replacing SalesOffice with Quantity and replace
SupplierCountry with Discount.
Select the Label field. Replace SupplierCountry with Quantity and Sales.
Edit field parameters

b. Expand the measure SalesOffice and PostalCode. Select in the Expression field to
open the Edit expression dialog.
Edit the expression by replacing SalesOffice with Sales and replace PostalCode with
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SupportCalls.
Select the Label field . Replace PostalCode with Support calls and Sales.

c. Expand the measure SalesOffice and City. Select in the Expression field to open
the Edit expression dialog.
Edit the expression by replacing SalesOffice with Discount, and replace City with Cost
of Sale.
Select the Label field. Replace City with Discount and Cost of sale.

d. Delete the measure SalesOffice and Country by right-clicking on the measure and
choosing Delete.

e. Delete the measure SalesOffice and CountryCode by right-clicking on the measure
and choosing Delete.

7. Edit the X-axis range. These three measure comparisons all represent high levels of
dependency. To emphasize the differences in values and make the chart more interesting,
modify the range of the bar chart:

a. Expand the Appearance section and then X-axis.
b. Switch Range from Auto to Custom.
c. Select Min/Max for values to set. Set Min to 0.9 and Max to 1.

8. Select Done editing.
Mutual Information chart after editing

K-Means clustering: Editing the number of clusters and selections
Insight Advisor generates a scatter plot chart driven by k-means functions to group similar items
into clusters. The following example shows how you can specify the number of clusters generated
by the chart and remove outlying datapoints. For more information, see and .
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Gehen Sie folgendermaßen vor:

1. In the business logic tutorial app, enter the search Customer by Sales by Gross Profit in the
search box. Look for the result titled Customer clustered by sum(Sales) and sum(Gross
Profit) (K-Means).
Default results for kmeans search

2. Select Add to sheet in the lower right of this chart, then Create new sheet.

3. From the app overview, click Sheets to view the sheets. Select My new sheet and give
the sheet a Title and Description.For this example, name the sheet Customers clustered by
sales and add the description Kmeans applied to customer data by Sales and Gross Profit.

4. Select Edit sheet in the toolbar and select the k-means cluster chart.

5. Modify the scatter plot chart:
a. Enlarge chart: Make the chart larger to take up the canvas by dragging the lower right

corner.
b. Edit the number of clusters argument. Expand the Appearance section and then

Colors and legend. Insight Advisor has colored the clusters by dimension. Select
under the Select dimension field to open the expression editor. Modify the num_
clusters argument by changing the value 0 to 6 (Insight Advisor utilized auto-
clustering where if 0 is entered for the number of clusters, an optimal number of
clusters for that dataset is automatically determined). Select Apply.
Edit the first parameter in the expression (num_clusters)

c. Edit axis ranges: The default chart that is generated shows range that is less than 0.
Negative numbers are not meaningful in this context and this range takes up space in
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the chart. In the Appearance section, expand X-axis: Sales and change Range from
Auto to Custom. Note that Min automatically resets to 0. Expand Y-axis: Gross Profit
and change Range from Auto to Custom and note that Min automatically resets to 0
for the Y-axis as well.

6. Select Done editing.

7. Deselect data: Data can be excluded from the chart by deselecting items that are not of
interest. Exit edit mode by selecting Done editing and open the Selections tool .
Search for Customer and select all customers except the following customers: Big Foot
Shoes, Boleros, Bond Ltd, El Carnevale, Fritid AB, Las Corbatas, The Fashion, and Vite.
KMeans scatter plot chart after edits

Period over period analysis: Changing the analysis period
Insight Advisor supports creation of behaviors to use a preferred default calendar period with a
measure group. The following example demonstrates how to change the calendar period to view
results for a different period. You can change the calendar period property to generate a Period
over period chart that displays sales over the last year rather than over the last month.

Gehen Sie folgendermaßen vor:

1. From the business logic tutorial app, enter the search Show me sales in the search box.
Locate the Period over period result.
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Period over period result for sales search

2. Select the Period over period chart to display options to the right.
3. Expand Analysis period in the properties panel to display calendar period options.
4. Select Quarter comparison.
5. Change the value in Period 1 to 2020-Q1.
6. Change the value in Period 2 to 2021-Q1.
7. Sales now displays the results for the first quarter of 2021 compared to the first quarter of

2020.
Period analysis chart after changing the Analysis period
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Visualisierungen mithilfe von Insight Advisor
Diagrammvorschlägen erstellen
Qlik Sense bietet eine große Bandbreite an Visualisierungen zur Verwendung mit Ihren
Daten. Die Entscheidung für den richtigen Diagrammtyp kann bei der Erstellung Ihrer
ersten Qlik Sense App eine Herausforderung sein.

Insight Advisor Diagrammvorschläge ermöglichen es Ihnen, Datenfelder auszuwählen und Insight
Advisor die Dimensionen, Kennzahlen und Visualisierungstypen bestimmen zu lassen. Wenn Sie
Felder hinzufügen oder entfernen, passt sich die vorgeschlagene Visualisierung an Ihre
Änderungen an. Sie können eine vorgeschlagene Visualisierung mit einem spezifischen Satz an
Eigenschaften anpassen.

Wenn Sie eine Visualisierung gestartet haben, wird durch Aktivieren von Diagrammvorschläge Ihre
Visualisierung zu einer vorgeschlagenen Visualisierung geändert.

Wenn Sie Diagrammvorschläge zuerst aktivieren und dann deaktivieren, verlieren Sie
die in Ihrer Visualisierung vorgenommenen Änderungen. Sie können Ihre alte
Visualisierung wiederherstellen, indem Sie die Änderungen rückgängig machen. Wenn
Sie jedoch von der Arbeitsblatt-Ansicht weg navigieren oder Änderungen im Extras-
Fenster vornehmen, können Sie Ihre Visualisierung nicht rückgängig machen und
wiederherstellen.

Neue Visualisierungen mithilfe von Diagrammvorschlägen erstellen

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Symbolleiste auf Arbeitsblatt bearbeiten.
Das Extras-Fenster wird auf der linken Seite angezeigt.

2. Ziehen Sie unter Felder ein Feld durch Ziehen und Ablegen in Ihr Arbeitsblatt.
Felder, die als Dimensionen vorgeschlagen werden, werden als Tabellen oder Histogramme
hinzugefügt. Felder, die als Kennzahlen vorgeschlagen werden, werden als KPIs hinzugefügt.
Um Felder als Filterfenster hinzuzufügen, halten Sie die Umschalttaste gedrückt, wenn Sie
das Feld ziehen und ablegen.

3. Fügen Sie weitere Felder hinzu, indem Sie einen der folgenden Schritte ausführen:
l Ziehen Sie ein Feld mit Ziehen und Ablegen auf die aus dem ersten Feld erstellte

Visualisierung oder auf Vorschlag auf der rechten Seite.
Qlik Sense legt fest, ob das Feld als Dimension oder Kennzahl verwendet werden soll
und welche Kennzahlaggregierung verwendet werden soll.

l Klicken Sie im Eigenschaftsfenster auf Hinzufügen und wählen Sie ein Feld aus.
l Ziehen Sie unter Dimensionen oder Kennzahlen ein Feld mit Ziehen und Ablegen auf

Element hier ablegen.
Die Visualisierung ändert sich mit dem Hinzufügen von Feldern.
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4. Optional können Sie unerwünschte Felder entfernen.

5. Klicken Sie auf Done.

Eine bestehende Visualisierung mithilfe von Diagrammvorschlägen ändern
Eine vorhandene Visualisierung ändern Sie, indem Sie Felder hinzufügen oder unerwünschte Felder
entfernen. Das Aktivieren von Diagrammvorschläge im Extras-Fenster auf der rechten Seite ändert
die ausgewählte Visualisierung in einen Diagrammvorschlag, der auf den Feldern der Visualisierung
basiert. Sie können die von Qlik Sense gemachten Vorschläge ändern. Sie können z.°B. Folgendes:

l Felder zwischen Dimensionen und Kennzahlen ziehen, um anzupassen, wie ein Feld
verwendet wird. Wenn ein Feld in Dimensionen verschoben wird, wird seine Aggregierung
entfernt. Wenn ein Feld in Kennzahlen verschoben wird, wird ihm eine Aggregierung
zugewiesen.

l Eine andere Aggregierung für ein Feld wählen, das als Kennzahl verwendet wird. Ihre
Aggregierungsauswahl wird verwendet, sooft Sie dieses Feld als Kennzahl verwenden,
während Diagrammvorschläge aktiviert ist.

l Diagrammtyp ändern verwenden, um einen anderen Diagrammtyp als den vorgeschlagenen
zu wählen.

Die Einstellungen anpassen, wenn Sie Diagrammvorschläge verwenden
Sie können die Einstellungen im Extras-Fenster für Daten und Darstellung anpassen. Das Extras-
Fenster für Visualisierungen, die mithilfe von Diagrammvorschlägen erstellt wurden, enthält einen
speziellen Satz an Eigenschaften. Durch Deaktivieren von Diagrammvorschläge erhalten Sie
erneut Zugriff auf alle verfügbaren Eigenschaften. Beschreibungen der verfügbaren Felder finden
Sie in den Themen zu den Visualisierungseigenschaften unter Visualisierungen (page 182).

Beschränkungen bei der Verwendung von Diagrammvorschlägen
l Diagrammvorschläge kann nicht für Master-Visualisierungen aktiviert werden.
l Diagrammvorschläge kann nicht für Filterfenster, Histogramme oder Karten aktiviert

werden.
l Diagramme mit aktiviertem Diagrammvorschläge werden in Qlik NPrinting-Berichten nicht

unterstützt. Um Diagramme, die mit Diagrammvorschlägen erstellt wurden, in Qlik NPrinting-
Berichte einzuschließen, müssen Sie Diagrammvorschläge deaktivieren.

l Sie können die Aggregierung einer Kennzahl nur dann ändern, wenn ihre Bezeichnung der
Standardwert ist.

l Eine Master-Dimension kann nicht in Kennzahlen gezogen werden. Eine Master-Kennzahl
kann nicht in Dimensionen gezogen werden.

l Sie können ein Feld nur von Kennzahlen in Dimensionen ziehen, wenn seine Formel einfach
ist. Weitere Informationen zur Verwendung von Ausdrücken in Visualisierungen finden Sie
unter Arbeiten mit Formeln in Visualisierungen (page 160).
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Richtlinien für Visualisierungen, Felder und die Benennung
Beim Arbeiten mit Qlik Sense müssen Sie bestimmte Konventionen und
Beschränkungen berücksichtigen. Dazu gehören beispielsweise die zulässige
Zeichenanzahl für Namen, Beschreibungen und Formeln sowie die Zeichen, die nur von
Qlik Sense verwendet werden dürfen.

Maximale Anzahl an Visualisierungen
Die maximale Anzahl an Visualisierungen, die auf einem Arbeitsblatt möglich ist, wird durch die
Anzahl an Zellen eines Arbeitsblatts beschränkt: 288 (24x12). In der Praxis wird die maximale
Anzahl jedoch geringer sein, da der Nutzen von aus nur 1 Zelle bestehenden Visualisierungen
beschränkt ist.

Maximale Länge des Namens
Die folgenden Beschränkungen gelten für die Anzahl an Zeichen, die in verschiedenen Situationen
in Qlik Sense verwendet werden können:

Situation Obere Grenze

Namen (z. B. Titel, Dimension,
Fußnote)

Max. 255 Zeichen.

Beschreibungen Max. 512 Zeichen.

Formeln Max. 64.000 Zeichen.

Tags Max. 31 Zeichen pro Tag und max. 30 Tags pro Master-
Element.

Text- und Bilddiagramm: Max. 12.000 Zeichen.

Maximale Länge des Namens

Namenskonventionen
Sie können sich auf eine Reihe von Elementen in Qlik Sense mit ihrem Namen beziehen, z. B.:

l Felder
l Dimensionen
l Kennzahlen
l Variablen
l Lesezeichen

Einige Zeichen sind in Qlik Sense bestimmten Zwecken vorbehalten. Um mögliche Fehler zu
vermeiden, wird von der Verwendung der folgenden Zeichen in Namen abgeraten:

l :
l =
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l [
l ]
l {
l }
l (
l )
l $
l ´
l `
l '

Wenn Sie lange Namen für Ihre Dimensionen und Kennzahlen verwenden, werden sie
abgeschnitten, und „...“ wird angezeigt, um anzugeben, dass ein Teil des Namens ausgeblendet ist.

Maximale Anzahl von Zeichen in Ausdrücken
Die maximale Anzahl von Zeichen, die in einem Visualisierungsausdruck geschrieben werden
können, beträgt 64.000. Wenn Sie versuchen, einen Ausdruck mit einer höheren Anzahl von
Zeichen zu erstellen, wird der Ausdruck abgeschnitten.

Konventionen für Zahlen- und Uhrzeitformate
In vielen Interpretations- und Formatfunktionen können Zahlen und Daten durch einen Formatcode
beschrieben werden. Dieses Thema beschreibt die Formate der Funktionen für Zahl, Datum, Uhrzeit
und Zeitstempel. Diese Formate gelten gleichermaßen für Skript- und Diagrammfunktionen.

Zahlenformate
Die Zahl der angezeigten Dezimalstellen wird durch entsprechend viele Nullen "0" repräsentiert.

Eine mögliche Dezimalstelle links vom Dezimaltrennzeichen wird durch das Symbol "#"
repräsentiert.

Um die Position des zutreffenden Dezimal- und Tausendertrennzeichens festzulegen, fügen Sie
diese einfach an der gewünschten Stelle des Formatcodes ein.

Im Formatcode werden lediglich die Positionen von Tausender- und Dezimaltrennzeichen
festgelegt. Es ist hier nicht möglich, Tausender- oder Dezimaltrennzeichen zu definieren.
Verwenden Sie dafür die Variablen DecimalSep und ThousandSep im Skript.

Es ist möglich, beliebig viele Stellen durch das Tausendertrennzeichen abzugrenzen.
Beispielsweise würde der Formatcode "0000-0000-0000" mit "-" als Tausendertrennzeichen eine
zehnstellige Artikelnummer in der Form "0012-4567-8912" liefern.
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Beispiele:

Zahlenformat Beschreibung

# ##0 liefert eine ganze Zahl mit einem Tausendertrennzeichen. In diesem Beispiel
wird „.“ als Tausendertrennzeichen verwendet.

###0 liefert eine ganze Zahl ohne Tausendertrennzeichen.

0000 liefert eine ganze Zahl mit mindestens vier Stellen. Zum Beispiel wird die Zahl
123 in der Form 0123 angezeigt.

0.000 liefert eine Zahl mit drei Dezimalstellen. In diesem Beispiel wird „.“ als
Dezimaltrennzeichen verwendet.

Beispiel für Zahlenformate

Spezielle Zahlenformate
Qlik Sense kann numerische Werte beliebiger Stellenwertsysteme mit einer Basis zwischen 2 und
36 interpretieren und formatieren, darunter binäre, oktale und hexadezimale Darstellung. Auch
römische Zahlen werden korrekt verarbeitet.

Format Beschreibung

Binäre Zahl Um eine binäre Zahl zu signalisieren, muss der Formatcode mit (bin) oder
(BIN) beginnen.

Oktale Zahl Um eine oktale Zahl zu signalisieren, muss der Formatcode mit (oct) oder
(OCT) beginnen.

Hexadezimale Zahl Um eine hexadezimale Zahl zu signalisieren, muss der Formatcode mit
(hex) oder (HEX) beginnen. Bei Verwendung der groß geschriebenen
Variante wird bei der Formatierung A-F verwendet (zum Beispiel 14FA).
Bei Verwendung der klein geschriebenen Variante wird bei der
Formatierung a-f verwendet (zum Beispiel 14fa). Bei der Interpretation
besteht kein Unterschied zwischen Groß- und Kleinbuchstaben.

Dezimalzahl Um eine dezimale Zahl zu signalisieren, kann der Formatcode mit (dec)
oder (DEC) beginnen. Dieser Zusatz ist jedoch nicht zwingend
notwendig.

Spezielle Zahlenformate
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Format Beschreibung

Format mit
benutzerdefinierter
Basis

Um ein Stellenwertsystem mit Basis zwischen 2 und 36 zu signalisieren,
muss der Formatcode mit (rxx) oder (Rxx) beginnen, wobei xx eine
zweistellige Zahl ist, die den Wert der Basis angibt. Wenn R – groß
geschrieben – verwendet wird, werden Buchstaben mit einer Basis über
10 im Qlik Sense-Format groß geschrieben (zum Beispiel 14FA). Bei
Verwendung der klein geschriebenen Variante (r) wird bei der
Formatierung Kleinschreibung verwendet (zum Beispiel 14fa). Bei der
Interpretation besteht kein Unterschied zwischen Groß- und
Kleinbuchstaben. Somit ist (r02) äquivalent zu (bin), (R16) ist äquivalent
zu (HEX) usw.

Römische Zahlen Um eine römische Zahl zu signalisieren, muss der Formatcode mit (rom)
oder (ROM) beginnen. Bei Verwendung der groß geschriebenen Variante
wird bei der Formatierung Großschreibung verwendet (zum Beispiel
MMXVI). Bei Verwendung der klein geschriebenen Variante werden bei
der Formatierung Kleinbuchstaben verwendet (mmxvi). Bei der
Interpretation besteht kein Unterschied zwischen Groß- und
Kleinbuchstaben. Römische Zahlen werden verallgemeinert mit einem
Minuszeichen für negative Zahlen und 0 für Null. Dezimalstellen entfallen
bei römischen Zahlen.

Beispiele:

Beispiel Ergebnis

num(199, '(bin)') liefert 11000111

num(199, '(oct)') liefert 307

num(199, '(hex)') liefert c7

num(199, '(HEX)' ) liefert C7

num(199, '(r02)' ) liefert 11000111

num(199, '(r16)') liefert c7

num(199, '(R16)' ) liefert C7

num(199, '(R36)') liefert 5J

num(199, '(rom)') liefert cxcix

num(199, '(ROM)' ) liefert CXCIX

Beispiele für spezielle Zahlenformate

Datumsangaben
Sie können die folgenden Symbole für die Formatierung eines Datums verwenden. Es können
beliebige Trennzeichen verwendet werden.
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Symbole Beschreibung

D Die numerische Angabe des Tags wird durch ein "D" für jede gewünschte Stelle
repräsentiert.

M Verwenden Sie das Symbol "M", um den Monat anzugeben.

Verwenden Sie "M" oder "MM" für eine bzw. zwei Stellen.

"MMM" steht für den kurzen Monatsnamen, wie er vom Betriebssystem
vorgegeben oder durch die Skriptvariable MonthNames definiert ist.

"MMMM" steht für den langen Monatsnamen, wie er vom Betriebssystem
vorgegeben oder durch die Skriptvariable LongMonthNames definiert ist.

Y Die numerische Angabe des Jahrs wird durch ein "Y" für jede gewünschte Stelle
repräsentiert.

W Verwenden Sie das Symbol "W", um den Wochentag anzugeben.

Die dem numerischen Wochentag entsprechende Ziffer wird durch ein "W"
dargestellt (Beispiel: 0 für Montag).

"WW" liefert den zweistelligen numerischen Wochentag (Beispiel: 02 für Mittwoch).

"WWW" liefert den kurzen Wochentag (zum Beispiel Mo), wie vom Betriebssystem
vorgegeben oder durch die Skriptvariable DayNames definiert.

"WWWW" liefert den langen Wochentag (zum Beispiel Montag), wie vom
Betriebssystem vorgegeben oder durch die Skriptvariable LongDayNames
definiert.

Symbole zum Formatieren eines Datums

Beispiele: (mit dem 31. März 2013 als Beispieldatum)

Beispiel Ergebnis

YY-MM-DD liefert ein Datum in der Form 13-03-31.

YYYY-MM-DD liefert ein Datum in der Form 3/31/13.

YYYY-MMM-DD liefert ein Datum in der Form 2013-Mar-31.

DD MMMM YYYY liefert ein Datum in der Form 31. März 2013.

M/D/YY liefert ein Datum in der Form 3/31/13.

W YY-MM-DD liefert ein Datum in der Form 6 13-03-31.

WWW YY-MM-DD liefert ein Datum in der Form Sa 13-03-31.

WWWW YY-MM-DD liefert ein Datum in der Form Samstag 13-03-31.

Beispiele für Datumsformate
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Uhrzeiten
Sie können die folgenden Symbole für die Formatierung einer Uhrzeit verwenden. Es können
beliebige Trennzeichen verwendet werden.

Symbole Beschreibung

h Die numerische Angabe der Stunden wird durch ein "h" für jede gewünschte Stelle
repräsentiert.

m Die numerische Angabe der Minuten wird durch ein "m" für jede gewünschte Stelle
repräsentiert.

s Die numerische Angabe der Sekunden wird durch ein "s" für jede gewünschte
Stelle repräsentiert.

f Die Sekundenbruchteile (Zehntel, Hundertstel usw.) werden durch ein "f" für jede
Dezimalstelle repräsentiert.

tt Die Uhrzeit im AM/PM-Format wird durch "tt" hinter der Uhrzeit repräsentiert.

Symbole zum Formatieren einer Uhrzeit

Beispiele: (18.30 dient als Beispielzeit):

Beispiel Ergebnis

hh:mm liefert eine Uhrzeit in der Form 18:30

hh.mm.ss.ff liefert eine Uhrzeit in der Form 18.30.00.00

hh:mm:tt liefert eine Uhrzeit in der Form 06:30:pm

Beispiele für Uhrzeitformate

Zeitstempel
Für Zeitstempel gilt dieselbe Notation wie bei Datum und Uhrzeit.

Beispiele: (31. März 2013 18.30 dient als Beispielzeitstempel):

Beispiel Ergebnis

YY-MM-DD hh:mm liefert einen Zeitstempel in der Form 13-03-31 18:30

M/D/Y hh.mm.ss.ffff liefert einen Zeitstempel in der Form 3/31/13 18.30.00.0000

Beispiele für Zeitstempelformate

Verwendung von Systemfeldern in einer Visualisierung
Sie können in einer Visualisierung Systemfelder verwenden. Systemfelder werden von Qlik Sense
erstellt, wenn das Datenladeskript generiert wird. Sie enthalten Informationen über die Felder und
Tabellen in den geladenen Daten. Ein Systemfeld beginnt mit "$" und Sie müssen darauf verweisen,
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indem Sie den Feldnamen, einschließlich des $", manuell eingeben. Sie können ein Systemfeld
verwenden, um eine Dimension entweder als Master-Element oder über das Eigenschaftsfenster zu
erstellen.

Vorschau einer auf einem Systemfeld basierenden Dimension.

Ein als Dimension im Eigenschaftsfenster hinzugefügtes Systemfeld.

s
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Using alternate states for comparative analysis
If you want to perform comparative analysis you can use alternate states in Qlik Sense.
Alternate states allow you to make different selections on the same dimension, and
compare the selections in a single visualization or in two or more visualizations side by
side.

You can use alternate states in visualizations in two different ways:

l Applying a state to the visualization. This connects the selection of the visualization to the
selection of the state.

l Using states in the set expression of a measure. This is useful to compare measure values of
different states.

Creating alternate states
You can create a new alternate state under Alternate states in Master items:

1. Select Create new.
2. Provide a name for the new state. There are some naming limitations:

l Do not use $, 0, or 1 as a state name.
l Do not use a state name starting with $ or $_ followed by a number, for example, $3.
l Do not use a state name already used as a bookmark name.

You have now created a new alternate state that you can use to perform comparative analysis.
Typically you would want to create another new state to compare the two states.
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Applying alternate states to sheets and visualizations
You can apply a state to a visualization or a sheet. If you apply a state to a sheet, all visualizations
on the sheet inherit the state unless you apply another state to a specific visualization. When you
apply a state to a visualization, it reflects the selections made in the state. Any selections you make
will be applied to the state and be reflected in other visualizations that have the same state applied.

The easiest way to apply an alternate state is dropping it on a sheet or a visualization, and then
selecting Apply state.

You can also apply an alternate state with the State setting in the property panel:

l For a sheet, you find the setting under Alternate states.
l For a visualization, you find the setting under Appearance > Alternate states.

You can select:

l Any alternate state defined in Master items.
l <inherited>, in which case the state defined for the sheet is used.
l <default state>, which represents the state where no alternate state is applied.

Using alternate states in visualizations
Besides applying a state to a visualization you can also use alternate states in the set expression of
a measure. This is useful when you want to compare measure values for different dimension
selections side by side.

You can set the alternate state as an identifier in the set expression. If you want to use the measure
Sum(Sales) in your visualization, for example a bar chart, with a state called Group1 you use the
following expression as measure:

Sum({Group1}Sales)

To compare with a different state called Group2, you can create another measure with the
expression Sum({Group2}Sales).

The bar chart will now show sales for the selection in Group1 side by side with sales for Group2.

Getting information about the selection of an alternate state
You can see the selections of different states in the selections bar.

You may also want to be able to use information about which, and how many selections are made in
a alternate state in labels or titles of visualizations. You can use the following chart functions with
the state_name parameter to return selections associated with the specified state name:

l GetCurrentSelections() to return all current selections.
l GetFieldSelections() to return current selections of a field.
l GetSelectedCount() to return the number of selected values in a field.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 618



3   Visualizations

Expanding variables in alternate states
You can specify which state to use when expanding a variable. Changes in a specific state do not
affect variable values that are expanded in another state. If you do not specify a state, the variable
is expanded in the default state.

Beispiel:

If you have a state named MyState, and a variable named vMyVar:

l $(vMyVar) expands the variable in the default state.
l $({MyState} vMyVar) expands the variable in the MyState state.

Limitations
It is not possible to add visualizations to master items if you have set the state of the visualization to
any other value than <inherited>.

Comparative analysis example
In this example we want to be able to compare the sales numbers of product lines for different
selections of sales regions. We want to select the regions we compare dynamically, either as single
regions or a combination of regions.

Dataset and app
If you want to follow this example, you need to download the Qlik Sense Tutorial - Aufbau einer App
to get the dataset. If you have completed the tutorial you can use the app you created. Otherwise
you need to create an app, add all six data files in the Tutorials source folder, and associate them
using automatic recommendations in the data manager.

Create alternate states
For this example we need two alternate states. In Master items > Alternate states:

1. Create a new state called Group 1.
2. Create a new state called Group 2.

You have now created the two alternate states we need in this example.

Create filter panes for selection

Gehen Sie folgendermaßen vor:

1. Add a filter pane with the field Region.
2. Edit the label of the filter pane to say =StateName(). This is to make it easier to tell them

apart, as the state is not indicated in the filter pane. The StateName() function returns the
state that is applied to the function.

3. Drop the state Group 1 on the filter pane and select Apply state.
4. Add another filter pane with the field Region.
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5. Edit the label of the second filter pane to say =StateName().
6. Drop the state Group 2 on the second filter pane and select Apply state.

You have now created the two filter panes that are used to control the selections of each of the two
states. When you make a selection in the Group 1 filter pane, the same selection is applied to the
state Group 1 which is reflected in all visualizations connected to that state.

Create a bar chart for analysis

Gehen Sie folgendermaßen vor:

1. Create a master item measure with name Group1Sales.
Set Expression to Sum({[Group 1]}[Sales]).
This expression sums the sales for all selections in the Group 1 state.
Set Label expression to 'Sales '&GetCurrentSelections(chr(13)&chr(10), '=', ','

,9,'Group 1').
We use a label expression to be able to show the current selection of the state as a label in
the chart, instead of the default label.

2. Create another master item measure with name Group2Sales.
Set Expression to Sum({[Group 2]}[Sales]).
Set Label expression to 'Sales '&GetCurrentSelections(chr(13)&chr(10), '=', ','

,9,'Group 2').
3. Add a bar chart to the sheet.
4. Set the Product Line field as dimension.
5. Add the measures Group1Sales and Group2Sales.

You have now created a bar chart that shows the sales by product line for the two groups of
regions selected in the filter panes. When you make a new selection in one of the filter panes, the
corresponding measure value changes according to the new selection.

Discovery
You can now make selections in Group 1 and Group 2, and see the results of the selected
combinations of regions in the bar chart.

Erstellen einer Visualisierung mit einem benutzerdefinierten
Objekt
Sie können Ihre Apps mit benutzerdefinierten Objekten optimieren.

Verfügbare benutzerdefinierte Objekte sind:

l Visualisierungserweiterungen
l Objekt-Bundles bereitgestellt von Qlik:

o Dashboard bundle (page 425)
o Visualization bundle (page 462)
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Sie finden benutzerdefinierte Objekte im Extras-Fenster unter Benutzerdefinierte Objekte,
wenn Sie ein Arbeitsblatt bearbeiten.

Im Dev Hub können Sie Ihre eigenen Visualisierungserweiterungen erstellen.
≤ Informationen zum Dev Hub finden Sie unter Dev Hub .

Hinzufügen eines benutzerdefinierten Objektes zu einem Arbeitsblatt
Zur Erstellung einer Visualisierung ziehen Sie zunächst eine Visualisierungserweiterung auf ein
Arbeitsblatt.

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Klicken Sie links im Fenster auf , um die benutzerdefinierten Objekte anzuzeigen.

3. Ziehen Sie eine Visualisierungserweiterung auf das Arbeitsblatt.
Sie können es entweder auf eine freie Position auf dem Arbeitsblatt ziehen, den Bereich einer
vorhandenen Visualisierung in zwei Bereiche aufteilen oder eine vorhandene Visualisierung
ersetzen.

Wenn Sie auf ein benutzerdefiniertes Objekt doppelklicken, wird es sofort zum
Arbeitsblatt hinzugefügt.

4. Ändern Sie die erforderlichen Einstellungen für das benutzerdefinierte Objekt im
Eigenschaftenfenster. Die erforderlichen Einstellungen werden mithilfe des
Erweiterungsentwicklers definiert. Dabei kann es sich um Dimensionen, Kennzahlen oder
andere Einstellungen handeln.

Die Visualisierung ist nun komplett und Sie können sie beim Untersuchen der Daten in der App
verwenden.

Kopieren einer Visualisierung aus einer vorhandenen
Visualisierung
Sie können eine Visualisierung folgendermaßen kopieren:

l Innerhalb des gleichen Arbeitsblatts
l Zwischen Arbeitsblättern in derselben App
l Auf Arbeitsblättern, die zu verschiedenen Apps gehören (weitere Informationen finden Sie

unter Überlegungen (page 622))

Gehen Sie folgendermaßen vor:

1. While editing a sheet, click on the item you want to copy.
Das Element wird markiert.

2. On the edit bar, click .
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3. To insert the item on another sheet, navigate to the sheet in the assets panel.

4. Click to paste the item.

The copied item is added to the sheet.

Abhängig von der jeweiligen Situation kann beim Einfügen der kopierten Visualisierung in
ein Arbeitsblatt Verschiedenes passieren:

l Ist eine Visualisierung ausgewählt, wird die ausgewählte Visualisierung ersetzt.
l Wenn keine Visualisierung ausgewählt ist, wird die kopierte Visualisierung im

größten freien Bereich eingefügt.
l Wenn es keinen freien Bereich gibt, wird die größte Visualisierung auf dem

Arbeitsblatt halbiert, um Platz für die eingefügte Visualisierung zu schaffen.

Überlegungen
l Damit eine kopierte Visualisierung in einer anderen App funktioniert, müssen dieselben

Dimensionen und Kennzahlen auch Teil der Ziel-App sein.
l Beim Kopieren von Visualisierungen zwischen zwei Apps müssen sich die Apps in derselben

Bereitstellung von Qlik Sense Enterprise on Windows befinden.
l Sie können Visualisierungen nicht zwischen verschiedenen Umgebungstypen kopieren und

einfügen (zum Beispiel zwischen einer App in Qlik Cloud Analytics und einer App in Qlik
Sense Desktop).

Adding trend and reference lines to visualizations
Use trend lines to visualize changes in measure values over time. Use reference lines
to mark specific measure and dimension values on a chart.

Adding trend lines to visualizations
Trend lines are available for bar charts and line charts. Trend lines are added when you configure a
measure in the chart.

For more information about trend lines, see Trendlinien (page 112).

Gehen Sie folgendermaßen vor:

1. Click on an existing bar or line chart.
2. In the properties panel, expand the Data section.
3. Under Measures, expand the measure for which you are adding trend lines.
4. Under Trend lines, click Add trend line.
5. Define the Label and Type for the trend line.
6. Use the Colors slider to define Custom or Auto coloring.
7. Use the Dashed checkbox to give the line a dashed or solid appearance.
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Adding reference lines to visualizations
Reference lines can help users interpret a visualization, providing guidance on what to look for
during analysis. Reference lines are separately defined for measures and dimensions.

For more information about reference lines, see Reference lines (page 418).

Adding reference lines for chart measures

Gehen Sie folgendermaßen vor:

1. Click on an existing chart that supports reference lines.
2. In the properties panel, expand the Add-ons section.
3. Expand Reference lines.
4. Click Add reference line.
5. Optionally, define a Show condition and Label.
6. Under Reference line expression ,enter the expression to define the measure value for

which the reference line is shown.
7. Style the reference line with the Color, Line type, and Colored background settings.

To remove an existing reference line, expand the reference line and click Delete.

Adding dimensional reference lines

Gehen Sie folgendermaßen vor:

1. Click on an existing chart that supports dimensional reference lines.
2. In the properties panel, expand the Add-ons section.
3. Expand Dimension reference lines.
4. Click Add reference line.
5. Optionally, define a Show condition and Label.
6. Under Dimension value, enter the expression to define the dimension value for which the

reference line is shown.
7. Style the reference line with the Alignment, Color, Line type, and Colored background

settings.

To remove an existing dimensional reference line, expand the reference line and click Delete.

Erstellen von zeitbezogenen Diagrammen
Zeitbezogene Diagramme sind Visualisierungen, die eine stufenlose Skalierung
verwenden, um eine vollständige und genaue Ansicht zeitbasierter Daten zu bieten.
Zeitbezogene Diagramme sind Visualisierungen, die eine stufenlose Skalierung
verwenden, um eine vollständige und genaue Ansicht zeitbasierter Daten zu bieten.
Das heißt, wenn Sie die stufenlose Skalierung auf der X-Achse mit Datenfeldern
aktivieren, werden die Datenpunkte um eine Distanz relativ zur verknüpften Zeit
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voneinander getrennt. Und die Achsenbeschriftungen (Labels) werden unabhängig
davon, ob es Daten für diesen Punkt gibt, gleichmäßig getrennt. Die Diagrammansicht
wird komprimiert, und das Blättern ist nicht möglich.

Die stufenlose Skalierung wird für Linien-, Balken- und Kombi-Diagramme unterstützt.

Die stufenlose Skalierung wird häufig mit Datenfeldern verwendet, beispielsweise:

l Sekunde
l Minute
l Stunde
l Woche
l Monat
l JahrMonat
l Quartal
l JahrQuartal
l Jahr
l Datum
l Zeitstempel
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Hinzufügen einer stufenlosen Skalierung

Gehen Sie folgendermaßen vor:

1. Klicken Sie in der Arbeitsblatt-Ansicht in der Symbolleiste auf Arbeitsblatt bearbeiten.

2. Klicken Sie auf das Liniendiagramm, das Sie bearbeiten möchten.
3. Klicken Sie im Eigenschaftsfenster auf die Registerkarte Darstellung.
4. Markieren Sie Stufenlose Skalierung verwenden im Abschnitt X-Achse.

Das Diagramm wird komprimiert und die Datenpunkte und Beschriftungen werden neu
angepasst.

Auswählen in einem zeitbezogenen Diagramm
Wenn Sie durch ein zeitbezogenes Diagramm navigieren, können Sie eine kleinere Zeitspanne
erweitern, um Schnappschüsse der angezeigten Daten aufzunehmen und Datenwerte
auszuwählen. Auf einer Zeitachse mit der Bereichsauswahl getroffene Auswahlen umfassen alle
Datenwerte (auch diejenigen, die nicht sichtbar sind). Wenn Sie eine Auswahl auf der
Kennzahlenachse oder mit der Lasso-Auswahl treffen, werden nur die sichtbaren Werte
ausgewählt.

Changing the data of a visualization
The data displayed within a visualization can be changed after the visualization is
created.

For example, you may want to add additional dimensions or measures to a chart to add depth to the
existing data. Alternatively, you may need to correct an invalid dimension or measure.

Adding dimensions and measures to a visualization
You can add multiple dimensions and measures to a visualization to add depth to the data
displayed. Addition dimensions and measures enabled you to view more information in a single
visualization. For example, the image below contains a visualization with the measure Sales and a
dimension Month.
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Line chart with the measure Sales.

You can add a second measure, Gross Sales. The example line chart now gives use more context by
enabling a comparison of Gross Sales to Sales.

Line chart with the measures Sales and Gross Sales.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, click the Data tab.
The Data tab is expanded.

2. In the Dimensions or Measures section, click Add to add a dimension or measure.
A dialog with a text box opens. Below the text box all available dimensions or measures are
listed, grouped into Dimensions or Measures (that is master items) and Fields.

3. Start typing in the text box.
A list of matching fields and dimensions or measures is displayed.

You can also create a dimension by entering an expression directly in the text box,
or by clicking to create a dimension in the expression editor.

If no measure is displayed, you need to create one. You can enter an expression
directly in the text box, or you can click to create a measure in the expression
editor.

4. Select the dimension or measure that you want to use.

The dimension or measure is added to the visualization. The new dimension or measure settings are
shown in the properties panel.

Adding alternative dimensions and measures to a visualization
Alternative Dimensionen und Kennzahlen sind Dimensionen und Kennzahlen, die zu einer
Visualisierung hinzugefügt werden, aber erst dann angezeigt werden, wenn ein Benutzer bei der
visuellen Prüfung die Anzeige der Dimensionen und Kennzahlen wechselt. You can toggle which of
your dimensions and measures are displayed using the exploration menu of a visualization.

Adding alternative dimensions and measures to a visualization

You can add alternative dimensions and measures to all chart types but changing
alternative dimension and measures in the visualization can only be done in bar, line, and
combo charts. Only alternative dimensions can be changed in the pie charts visualization
and only alternative measures in scatter plots.

Alternative dimensions and measures enable you conserve space on your sheets. Rather than make
multiple similar visualizations of the same type, you can use alternative dimensions and measure
with a single visualization. You can then switch between the displayed dimensions and measures.
For example, if you wanted to see total sales by product category and total sales by product
subcategory, you could add product category as a dimension and product subcategory as an
alternate dimension in the same visualization.
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Alternative dimensions and measures enable you to have more dimensions and measures
associated to a visualization that the display limit. Many visualizations have limitations on how many
dimensions and measures that can be displayed at the same time. A line chart with two or more
measures can only have one dimension, and a line chart with two dimensions can only have one
measure. Alternative dimensions and measures enable you to exceed that limit.

Alternative dimensions and measures can be added like normal dimensions and measures in the
properties pane. You can also drag dimensions and measures in the Data section of the properties
panel into the Alternative dimensions or Alternative measures section.

Gehen Sie folgendermaßen vor:

1. In the properties panel, click the Data tab.
The Data tab is expanded.

2. In the Dimensions or Measures section, click Add alternative.
A dialog with a text box opens. Below the text box all available dimensions or measures are
listed, grouped into Dimensions or Measures (that is master items) and Fields.

3. Start typing in the text box.
A list of matching fields and dimensions or measures is displayed.

You can also create a dimension by entering an expression directly in the text box,
or by clicking to create a dimension in the expression editor.

If no measure is displayed, you need to create one. You can enter an expression
directly in the text box, or you can click to create a measure in the expression
editor.

4. Select the dimension or measure that you want to use.

The alternate dimension or measure is added to the visualization.

Editing data in a visualization
You can edit and adjust the data in a visualization. You may need to edit an existing dimension or
measure to adjust it to create a stronger visualization or correct an invalid dimension or measure.
You may also want to edit a master item in a visualization to change the master item across all
visualizations.

Invalid dimensions and measures
Dimensions and measures are invalid when the associated expression cannot be interpreted by Qlik
Sense.

If you create an invalid dimension or edit an existing one so that it becomes invalid, the dimension is
presented in the properties panel as dimmed with a red hue and the text Invalid dimension to
indicate that the dimension is invalid. If you use an invalid dimension in a visualization, the
visualization cannot be displayed.
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If you create an invalid measure or edit an existing one so that it becomes invalid, the Expression
text box under Measures in the properties panel is presented with a red border to indicate that the
measure is invalid.

Editing a dimension
You can edit dimensions, including master dimensions. In the properties panel, under Data, select
the dimension that you want to edit.

Dimensions have the following properties:

l Field: Start typing the field name to display a list of matching fields to choose from. You can
also click to open the expression editor, where you can create a calculated dimension.

l Label: Enter a name for the dimension.
l Include null values: When this is checked, the visualization will include the null values of the

dimension, presented as a gap or a dash, depending on the type of visualization. For
example, if you have sales figures but do not have any information about what company the
figures belong to, the figures will be added to the measure value for the null value dimension.

l Limitation: You can limit the number of dimension values that are displayed.
l Show others: Wenn Sie eine Begrenzung für die Anzahl der angezeigten Dimensionswerte

festgelegt haben, können Sie die Kennzahlwerte für die verbleibenden Dimensionen durch
die Auswahl Sonstige anzeigen zusammenfassen.

l Master item: Edit a master dimension to update all instances where the dimension is used, or
create a new master dimension by adding a dimension to the master items.

Editing a measure
You can edit measures, including master measures. In the properties panel, under Data, select the
measure that you want to edit.

Measures have the following properties:

l Expression: Enter the expression. You can also click to open and use the expression
editor. You can also apply a Modifier to automatically adjust the original expression. See
Applying a measure modifier (page 629).

l Label: Enter a name for the measure. The label is not automatically updated when you make
changes in Expression.

l Number formatting: Set the number formatting for the measure values. The options Number
and Date offer custom formatting options for defining your own format pattern.

l Master item: Edit a master measure to update all instances where the measure is used, or
create a new master measure by adding a measure to the master items.

Applying a measure modifier
Using a modifier, a measure expression can be automatically customized for a specific analytical
purpose. For example, you might want an expression in which data is presented as an accumulation
rather than standalone values.
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Gehen Sie folgendermaßen vor:

1. In the properties panel, expand the Data section.
2. Under Measures, expand the measure to which you are applying a modifier.
3. Underneath the Expression, click Modifier.
4. Use the drop down menu to select a modifier.
5. Fill in the parameters specific to the modifier you are using.

When you are finished, click Output expression to view how the original expression was modified.

For more information about measure modifiers, see Modifiers (page 108).

Editing master items
Dimensions and measures that are linked to a master item are displayed with a in the properties
panel. You can edit the master item to update all instances that use the dimension or measure, or
you can unlink the item from its master to edit only the current instance of the dimension or
measure.

A visualization that is linked to a master item is indicated by Linked visualization on the sheet.
You can edit a master visualization to update all instances that use the visualization, or you can
unlink a visualization from its master to edit only the current instance of the visualization. Unlinking
a visualization does not unlink any master dimensions or master measures used in the visualization.

Deleting dimensions and measures
In the properties panel, you can delete a dimension or measure. Long-touch or right-click the
dimension or measure and select Delete in the dialog. Alternatively, click the dimension or measure
and click Delete . If you delete an instance of a master item, the master item is still available in the
assets panel.

You can undo a deletion by clicking . Changing which sheet you are viewing will
prevent you from undoing your deletion.

Changing the appearance of a visualization
The Appearance section in the properties panel offers several options to set and
modify the appearance of a visualization.

Many of the settings have Auto options that support an optimal presentation of the visualization,
taking into account the number of dimensions and measures and the type of data used. Normally,
you do not need to change these settings, unless you have a special reason for doing so, for
example, when space is very limited.

Appearance can be affected by the sorting of the dimensions and measures.
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General
Show titles: On by default in all visualizations except filter panes and text & image visualizations.
Filter panes have the name of each dimension and in most cases do not need any additional title.
The text & image visualization includes an editing toolbar with many options to format the text, and
therefore the title field can be used for other purposes.

Title, Subtitle, and Footnote: Apart from the obvious use of title, subtitle, and footnote as text
fields, you can use these fields to also display an expression, which provides additional information
that complements the measure in the visualization. You could, for example, show the totals in the
title field, so that the totals of the selected values are always available.

Beispiel:

In the following image, the total sales are calculated and used in the title. When a selection is made,
the total sales are updated accordingly.

The following string was used to add the Total Sales expression to the field Title:

='Total Sales: $'& Round(Sum(Sales)/1000000, 0.1) & 'M'.

Because the title field is primarily a text field, it is necessary to start the string with an equals sign
(=), to signify that the strings contains an expression.

Because 'Total Sales: $' is a text string when it is used in an expression, the string must be
surrounded by single quotation marks.

& is used to concatenate the string and the expression.

Round(Sum(Sales)/1000000, 0.1) is the expression. The aggregation Sum(Sales) is divided by
1000000 and the function Round (x,0.1) reduces the number of decimals to one.
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& 'M', finally, concatenates the expression with the unit M for million.

For the title there are three options for adding an expression:

l Directly in the title field of a visualization. Beginnen Sie den String mit einem
Gleichheitszeichen (=).

l Directly in the box Title under Appearance in the properties panel. Beginnen Sie den String
mit einem Gleichheitszeichen (=).

l Through the expression editor in the box Title. Klicken Sie zum Öffnen des Formel-Editors
auf . No equals sign is needed.

For the subtitle and footnote only the last two options are available.

Details anzeigen: Standardmäßig Ausblenden. Wenn diese auf Anzeigen gesetzt wird, können
Benutzer bei der Analyse auf klicken, um Details wie beispielsweise Beschreibungen,
Kennzahlen und Dimensionen anzuzeigen.

Presentation and styling
Many of the presentation settings only apply to a certain visualization.

Visualization Description

Bar chart Set the bars to be displayed grouped or stacked, vertically or horizontally.

Box plot Select to show whisker ticks and grid lines. You can show the visualization
vertically or horizontally.

Combo chart Select whether to show labels for measures added as markers. You can select
to show grid lines based on primary or secondary axis, and adjust spacing
between them.

Distribution plot Select to show point, background or both. You can show the visualization
vertically or horizontally.

Gauge Set the gauge to be displayed as a radial or a bar. You can set range limits and
use segments with limits.

Histogram Select to show grid lines.

Line chart Set the line chart to be displayed as a line or an area.

Pie chart Set the pie chart to be displayed as a pie or a donut.

Scatter plot Turn on/off navigation. Set the size of the bubbles in a scatter plot. Set the
compression resolution for large data sets in scatter plot.

Table Set the totals to be displayed at the top, bottom, or not at all.

Treemap Set the headers, labels, overlay labels, and leaf values. Select to show the data
values.

Presentation settings in visualizations
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Beispiel:

A bar chart with two dimensions is by default presented with the bars grouped.

Let us assume that you want to compare the total monthly quantity for these years. Then it would
be a good idea to switch to a stacked bar chart.

In the properties panel, under Appearance > Presentation there is an option Stacked.

With stacked bars it is easier to compare the quantity between different months.

Now it is quite easy to compare the quantities per month. There is a legend to display the years.
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Under Colors and legend, Show legend is set to Auto, which means that the legend is displayed
when there is enough space. In the properties panel, you can also set where to display the legend
and whether to display the legend title.

There is only data for the first half of 2013 (red bars).

Styling
Apply additional customization to the visualization by using the styling panel. The styling panel is
available in the properties panel. Under Appearance > Presentation, click Styling.

For more information, see Applying custom styling to a visualization (page 663).

Colors and legend
The Colors and legend section of the properties panel sets your color and legend options. Qlik
Sense automatically colors visualizations as they are added to your sheets. As a best practice, it is
recommended to add or change colors only when it serves as purpose in the visualization. Too
many colors or indistinct color choices can make visualizations less clear.

You can manually set the colors and legends by deselecting the Auto option and selecting your
color preferences. Qlik Sense enables you to color your visualizations by:

l Single color
l Multiple colors
l Dimension
l Measure
l Master items
l Expression
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For more information on different visualization coloring options, see Farbige Kennzeichnung einer
Visualisierung (page 640). For examples of each of these methods of coloring visualizations and the
settings used can be found, see Beispiel 1: Farbgebung nach einer Dimension in der Visualisierung
(page 659).

X-axis and Y-axis
For both the y-axis and the y-axis, you have options for deciding what combination of labels and
title to display, as well as their orientation and position. Sometimes it may feel unnecessary to have
labels and/or a title, because the visualization is self-explanatory and then it would be good to be
able to hide them. Furthermore, when you create a visualization that is very small, for example,
three by three squares, the labels are automatically hidden.

Range: The measure axis (usually the y-axis) has an option to set the range of the axis. By default,
the range is adjusted according to the highest positive or the lowest negative measure value, but if,
for example, a single measure value is much larger than all the other values, you may want to set a
range that is suitable for the lower values. In the properties panel, under Appearance > Y-axis
<measure name>, there is a button for Range, which is set to Auto. Click the button to switch to
Custom. Now you can set the range for Max, Min, or both. In a bar chart, the bars that are out of the
range are cut diagonally to indicate that they are out range. In a line chart, only the parts that are
within the range are visible.

Label orientation: You can change the orientation of data labels on the dimensions axis (usually the
x-axis). In the properties panel, under Appearance > X-axis <dimension name>, there is a drop-
down menu for label orientation. By default, this is set to Auto. If there is not enough room for a
label to fully appear on the chart, it will be truncated with an ellipsis. The following options are
available:

l Auto: Automatically selects one of the other options depending on the space available on the
chart.

l Horizontal: Labels are arranged in a single horizontal line.
l Tilted: Labels are stacked horizontally at an angle.
l Layered: Labels are staggered across two horizontal lines.
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Examples of layered and tilted labels

Ändern der Sortierung einer Visualisierung
Sie können die Sortierreihenfolge der Dimensionen und Kennzahlen ändern, um die
Daten so zu präsentieren, wie Sie es wünschen.

Viele Visualisierungen haben im Eigenschaftsfenster den Bereich Sortieren. Dort können Sie den
Mauszeiger auf die -Zugleisten bewegen und die Dimension oder Kennzahl ziehen, um die
Sortierreihenfolge zu ändern. Auch in Visualisierungen ohne Sortierbereich können Sie jedoch die
Sortierung zu einem gewissen Grad anpassen.

Im folgenden Screenshot erfolgt die primäre Sortierung nach der Kennzahl Gross Sales.
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Ein Balkendiagramm mit dieser Sortierung sieht folgendermaßen aus.

Da es zwei Kennzahlen (Gross Sales und Sales) gibt, sind die Balken standardmäßig gruppiert.
Gross Sales wird zuerst angezeigt, denn es hat die 1. Sortierpriorität. Wenn Sie Sales ganz nach
oben in Sortieren ziehen würden, wäre der erste Balken Sales und der zweite Balken Gross Sales.

Wenn Sie stattdessen nach Year sortieren möchten, müssen Sie Year in Sortieren nach oben
ziehen. Das Balkendiagramm wird dann aktualisiert und nach Year sortiert.

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 637



3   Visualizations

In Balkendiagrammen mit mehreren Dimensionen ist die Sortierung an der ersten
Dimension arretiert. Auf dieser Dimension basieren Gruppen und Stapel. Eine Sortierung
nach einer anderen Dimension oder Kennzahl würde dieser Gruppen in unerwünschter
Weise auseinanderbrechen. Wenn Sie trotzdem nach dem Kennzahlwert sortieren
möchten, verwenden Sie die Option Nach Formel sortieren für die erste Dimension
unter Sortieren.

Sortieren der Dimensions- und Kennzahlbereiche
Die Sortierreihenfolge wird zwar in erster Linie unter Sortieren festgelegt, dennoch können Sie die
Reihenfolge auch im Eigenschaftsfenster-Bereich Daten unter Dimensionen und Kennzahlen
anpassen. In Dimensionen können Sie die Sortierreihenfolge der verschiedenen Dimensionen
ändern, indem Sie diese ziehen. Entsprechend können Sie in Kennzahlen die Kennzahlen ziehen,
um deren Sortierung zu ändern. Platzieren Sie den Cursor auf und ziehen Sie die Dimension oder
Kennzahl, um die Reihenfolge zu ändern. Änderungen werden in der Visualisierung widergespiegelt.

Interne Sortierung
Neben der Festlegung der Sortierreihenfolge für Dimensionen und Kennzahlen können Sie unter
Sortieren auch die interne Sortierreihenfolge festlegen.

Klicken Sie auf den Namen der Dimension oder Kennzahl, um die Einstellungen zu öffnen, und
klicken Sie auf die Schaltfläche zum Sortieren, um zur Sortierfolge Benutzerdefiniert zu wechseln.
Die folgende Tabelle zeigt die interne Sortierreihenfolge und die Sortieroptionen. Die
Sortierreihenfolge ist entweder Aufsteigend oder Absteigend.

Sortieroptionen:

l Nach Formel sortieren (Geben Sie eine Formel ein, nach der sortiert werden soll. Nur für
Dimensionen verfügbar.)

l Numerisch sortieren
l Alphabetisch sortieren

Außerdem können Sie nach Lade-Reihenfolge sortieren, indem Sie zu Benutzerdefiniert wechseln
und keine Sortieroption auswählen.

Wenn Sie für ein Feld eine benutzerdefinierte Reihenfolge festgelegt haben, überschreibt diese
jede unter Sortieren ausgewählte interne Sortierreihenfolge.

Standardsortierung
Standardmäßig werden die Dimensionen und Kennzahlen in der Reihenfolge sortiert, in der sie
hinzugefügt wurden, mit dem zuletzt hinzugefügten Element am Schluss. Jede Dimension wird
intern in der für den entsprechenden Datentyp üblichen Weise sortiert. Zahlen werden numerisch
und aufsteigend sortiert. Text wird alphabetisch und aufsteigend sortiert.
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Visualisierung Beschreibung

Balkendiagramm Ein Balkendiagramm mit einer Kennzahl und einer Dimension wird
standardmäßig mit vertikalen Balken dargestellt, die in absteigender
Reihenfolge nach der Kennzahl sortiert sind.

Wenn eine Dimension weniger als 10 Werte aufweist, erfolgt die
Sortierung alphabetisch nach Dimension.

Boxplot Boxplots werden standardmäßig nach der Mittellinie sortiert. Sie
können aber auch nach erstem Whisker, Box-Beginn, Box-Ende oder
letztem Whisker sortiert werden.

Kombi-Diagramm Die Sortierung erfolgt nach dem zuerst hinzugefügten Element,
entweder der Dimension oder der Kennzahl.

Verteilungsdiagramm Verteilungsdiagramme werden standardmäßig nach der äußeren
Dimension sortiert.

Filterfenster Standardmäßig werden Daten in Filterfenstern in aufsteigender
Reihenfolge dargestellt.

Messzeiger Ein Messzeiger nutzt nur einen einzigen Kennzahlwert, den ersten
unter Kennzahlen.

Histogramm Ein Histogramm hat keinen Sortierbereich.

KPI Standardmäßig wird die zuerst hinzugefügte Kennzahl zum
Hauptwert.

Liniendiagramm Liniendiagramme werden standardmäßig nach der Dimension sortiert.

Karte Eine Kartenebene kann nur eine Dimension haben. Das Sortieren dient
dazu, die Reihenfolge festzulegen, in der Punkte oder Bereiche zur
Karte hinzugefügt werden.

Kreisdiagramm Ein Kreisdiagramm nutzt eine Kennzahl und eine Dimension.
Kreisdiagramme werden standardmäßig nach der Kennzahl in
absteigender Reihenfolge sortiert.

Punktdiagramm Ein Punktdiagramm hat keinen Sortierbereich. Die Reihenfolge der
Kennzahlen bestimmt jedoch, wo diese verwendet werden. Die erste
Kennzahl wird für die X-Achse, die zweite Kennzahl für die Y-Achse
und die dritte (optionale) Kennzahl für die Punktgröße (wird zum
Festlegen der Farbe bei großen Datensätzen verwendet) im
Punktdiagramm verwendet. Ein Punktdiagramm kann nur eine
Dimension aufweisen.

Standardsortierung in Visualisierungen
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Visualisierung Beschreibung

Tabelle Standardmäßig stellt die Spalte die Dimensionen und Kennzahlen in
der Reihenfolge dar, in der sie hinzugefügt wurden.

Sortierreihenfolge der Zeilen: Standardmäßig wird die Tabelle in
aufsteigender Reihenfolge nach der ersten Dimension oder Kennzahl
unter Sortieren sortiert. Sie können die Sortierung vorübergehend
ändern, indem Sie auf die Überschrift der Zeile klicken, nach der Sie
sortieren möchten. Ein Klick – aufsteigende Reihenfolge, zwei Klicks –
absteigende Reihenfolge.

Text und Bild Eine „Text und Bild“-Visualisierung hat keinen Sortierbereich, Sie
können jedoch die Kennzahl-Token in der Visualisierung ziehen, um
die Reihenfolge zu ändern.

Baumkarte Eine Baumkarte hat keinen Sortierbereich. Das Sortieren erfolgt
automatisch nach der Größe der Kennzahl.

Farbige Kennzeichnung einer Visualisierung
Qlik Sense koloriert Visualisierungen automatisch so, wie sie zu Ihren Arbeitsblättern
hinzugefügt werden. Sie können die Farben in Ihren Visualisierungen manuell an Ihre
Anforderungen oder Vorlieben anpassen.

Die Farboptionen für die meisten Visualisierungen werden im Eigenschaftsfenster unter
Darstellung > Farben und Legende eingestellt. Wenn Sie Benutzerdefiniert wählen, können Sie
Ihren Visualisierungen mit folgenden Methoden manuell Farben zuweisen:
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l Farbgebung mit einer Farbe
l Farbgebung mit mehreren Farben
l Farbgebung nach Dimension

Außerdem können Dimensionsfelder aus dem Extras-Fenster auf eine Visualisierung
gezogen und abgelegt werden, um die Visualisierung farblich nach Dimension zu gestalten
(sofern vom Visualisierungstyp unterstützt).

l Farbgebung nach Kennzahl
Außerdem können Kennzahlfelder aus dem Extras-Fenster auf eine Visualisierung gezogen
und abgelegt werden, um die Visualisierung farblich nach Kennzahl zu gestalten (sofern vom
Visualisierungstyp unterstützt).

l Farbige Kennzeichnung nach Formel

Die Farbgebung von Tabellen und Pivottabellen kann nur nach Formel erfolgen. Optionen zur
Farbgebung von Tabellen und Pivottabellen finden Sie im Eigenschaftenfenster unter Daten.

Wenn Sie die Farben von Dimensionen oder Kennzahlen visualisierungsübergreifend beibehalten
möchten, können Sie Master-Elementen in Ihrer Bibliothek bestimmte Farben zuweisen. Die
meisten Visualisierungen verwenden automatisch die den Master-Elementen zugewiesenen
Farben. Wenn eine Visualisierung sowohl eine Master-Dimension als auch eine Master-Kennzahl mit
zugewiesenen Farben verwendet, wird standardmäßig die der Master-Dimension zugewiesene
Farbe verwendet. Sie können die für das Master-Element zu verwendende Farbe auswählen oder
Master-Element-Farben ganz deaktivieren.

Weitere Informationen finden Sie unter Zuweisen von Farben zu Master-Elementen (page 145).

Sie können auch einzelnen Master-Dimensionswerten Farben zuweisen und damit sicherstellen,
dass die Farben der verschiedenen Werte in allen Visualisierungen einheitlich verwendet werden.

Weitere Informationen finden Sie unter Assigning colors to master dimension values (page 148).

Wenn Sie Farben manuell einstellen, empfehlen wir zur Wahrung der Klarheit der Visualisierungen,
allgemein lesbare Farben zu wählen und nur dann verschiedene Farben zu wählen, wenn dies einem
bestimmten Zweck dient.

Farbgebung mit einer Farbe
Wenn Sie sich für einfarbige Farbgebung entscheiden, wird für alle Objekte im Diagramm nur eine
Farbe verwendet. Die Farbgebung mit nur einer Farbe verwenden Sie idealerweise in
Visualisierungen wie Balken- oder Liniendiagrammen mit nur einer Dimension und Kennzahl.

Wenn Sie eine Master-Dimension oder eine Master-Kennzahl haben, der eine Farbe zugewiesen ist,
können Sie diese eine Farbe für die Visualisierung verwenden. Wenn eine Visualisierung sowohl
eine Master-Dimension als auch eine Master-Kennzahl mit zugewiesenen Farben verwendet, wird
standardmäßig die der Master-Dimension zugewiesene Farbe verwendet. Sie können die für das
Master-Element zu verwendende Farbe auswählen oder Master-Element-Farben ganz
deaktivieren.

Folgende Optionen stehen zur Verfügung, wenn die Option Eine Farbe unter Farben in Darstellung
> Farben und Legende ausgewählt ist:
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Option Beschreibung

Bibliotheksfarben
verwenden

Wählen Sie diese Option aus, um Farben für Master-Elemente zu
verwenden. Wenn einer Visualisierung sowohl für die Master-Dimension
als auch für die Master-Kennzahl eine Farbe zugewiesen ist, können Sie
wählen, welche in der Visualisierung verwendet werden soll.

Diese Option ist verfügbar, wenn einer Master-Dimension oder einer
Master-Kennzahl in der Visualisierung eine Farbe zugewiesen ist.

Farbe Wählen Sie mithilfe der Farbauswahl eine Farbe. Sie können eine Farbe
aus der Standardpalette wählen, einen Hex-Wert für eine Farbe eingeben
oder eine Farbe aus einem Farbkreis wählen.

Optionen für die Einfärbung nach einer Farbe (Erweitert)

Farbgebung mit mehreren Farben
Wenn Ihre Visualisierung mehrere Kennzahlen enthält, können Sie Mehrfarbig auswählen, um jeder
Kennzahl eine andere Farbe zuzuweisen. Qlik Sense bietet zur Farbgebung der Visualisierung
wahlweise eine Farbpalette mit 12 und eine mit 100 Farben an. Standardmäßig ist 12 Farben als
Farbschema für Dimensionen ausgewählt.

Wenn Sie in Ihrer Visualisierung Master-Kennzahlen verwenden, können Sie auch deren Farben in
Ihrer Visualisierung verwenden. Wenn die Farbgebung einer Visualisierung nach Master-
Kennzahlen erfolgt, verwenden die Master-Kennzahlen ihre zugewiesenen Farben, und allen
weiteren Kennzahlen werden Farben aus dem 12 Farben-Schema zugewiesen.

Folgende Optionen stehen zur Verfügung, wenn folgende Option ausgewählt wird: Mehrere Farben
unter Farbe:

Option Beschreibung

Bibliotheksfarben
verwenden

Wählen Sie diese Option aus, um Farben für Master-Elemente zu
verwenden. Wenn einer Visualisierung sowohl für die Master-Dimension
als auch für die Master-Kennzahl eine Farbe zugewiesen ist, können Sie
wählen, welche in der Visualisierung verwendet werden soll.

Diese Option ist verfügbar, wenn einer Master-Dimension oder einer
Master-Kennzahl in der Visualisierung eine Farbe zugewiesen ist.

Optionen für die Farbgebung mit mehreren Farben

Folgende Optionen stehen zur Verfügung, wenn die Option Mehrfarbig unter Farben in Darstellung
> Farben und Legende ausgewählt ist:
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Option Beschreibung

Bibliotheksfarben
verwenden

Wählen Sie diese Option aus, um Farben für Master-Elemente zu
verwenden. Wenn einer Visualisierung sowohl für die Master-Dimension
als auch für die Master-Kennzahl eine Farbe zugewiesen ist, können Sie
wählen, welche in der Visualisierung verwendet werden soll.

Diese Option ist verfügbar, wenn einer Master-Dimension oder einer
Master-Kennzahl in der Visualisierung eine Farbe zugewiesen ist.

Farbige Codierung Wählen Sie das in Ihrer Visualisierung verwendete Farbschema aus.
Folgende Schemata sind verfügbar:

12 Farben: Die Farben werden mehrfach verwendet, wenn mehr als
12 Werte vorhanden sind. Die 12 Farben in diesem Farbschema können
auch von Menschen mit Farbblindheit unterschieden werden.

100 Farben: Die Farben werden mehrfach verwendet, wenn mehr als
100 Werte vorhanden sind. Nicht alle 100 Farben können von Menschen
mit Farbblindheit unterschieden werden.

Optionen für die Einfärbung nach mehreren Farben (Erweitert)

Folgende Optionen stehen zur Verfügung, wenn die Option Mehrfarbig unter Farben in Darstellung
> Farben und Legende ausgewählt ist:

UI-Element Beschreibung

Bibliotheksfarben
verwenden

Wählen Sie diese Option aus, um Farben für Master-Elemente zu
verwenden. Wenn einer Visualisierung sowohl für die Master-Dimension
als auch für die Master-Kennzahl eine Farbe zugewiesen ist, können Sie
wählen, welche in der Visualisierung verwendet werden soll.

Diese Option ist verfügbar, wenn einer Master-Dimension oder einer
Master-Kennzahl in der Visualisierung eine Farbe zugewiesen ist.

Farbige Codierung Wählen Sie das in Ihrer Visualisierung verwendete Farbschema aus.
Folgende Schemata sind verfügbar:

12 Farben: Die Farben werden mehrfach verwendet, wenn mehr als
12 Werte vorhanden sind. Die 12 Farben in diesem Farbschema können
auch von Menschen mit Farbblindheit unterschieden werden.

100 Farben: Die Farben werden mehrfach verwendet, wenn mehr als
100 Werte vorhanden sind. Nicht alle 100 Farben können von Menschen
mit Farbblindheit unterschieden werden.

Optionen für die Farbgebung mit mehreren Farben
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Farbgebung nach Dimension
Wenn Sie die Farben einer Visualisierung nach Dimension bestimmen, erhalten alle Werte in der
Visualisierung die Farbe der entsprechenden Werte im ausgewählten Dimensionsfeld.
Standardmäßig erhält die Visualisierung die Farbe ihrer primären Dimension, Sie können jedoch
auch die anderer Dimensionen auswählen. Qlik Sense bietet zur Farbgebung wahlweise eine
Farbpalette mit 12 und eine mit 100 Farben an. Standardmäßig ist 12 Farben als Farbpalette für
Farbe nach Dimensionen ausgewählt.

Wenn Sie eine Master-Dimension verwenden, können Sie die Visualisierung mithilfe der Farben, die
den einzelnen Werten dieser Dimension zugewiesen sind, farbig kennzeichnen.

Die Farbgebung nach Dimension ist nützlich, wenn Sie verwandte Informationen in Ihren
Visualisierung auch farblich nachvollziehbar machen möchten, beispielsweise indem Sie als Farbe
für mehrere Diagramme die der Dimension Region verwenden, um die Werte, die sich auf die
einzelnen Regionen beziehen, in den einzelnen Diagrammen eindeutig zu erkennen.

Folgende Optionen stehen zur Verfügung, wenn die Option Nach Dimension unter Farben in
Darstellung > Farben und Legende ausgewählt ist:

UI-Element Beschreibung

Dimension
auswählen

Wählen Sie die Dimension für die Farbgebung der Visualisierung mit
diesem Feld aus. Wenn Sie bereits eine Dimension für die Visualisierung
ausgewählt haben, wird standardmäßig diese Dimension verwendet.
Klicken Sie auf , um eine andere Dimension auszuwählen. Sie können

eine Formel eingeben. Öffnen Sie dazu mit den Formel-Editor.

Farben bei Auswahl
beibehalten

Wenn diese Option aktiviert ist, werden die Farben zwischen den
Auswahlstatus beibehalten. Ist sie deaktiviert, werden die Farben für
unterschiedliche Dimensionswerte geändert und neu zugewiesen, wenn
in der Visualisierung Auswahlen getroffen werden.

Farbige Codierung Wählen Sie das in Ihrer Visualisierung verwendete Farbschema aus.
Folgende Schemata sind verfügbar:

12 Farben: Die Farben werden mehrfach verwendet, wenn mehr als
12 Werte vorhanden sind. Die 12 Farben in diesem Farbschema können
auch von Menschen mit Farbblindheit unterschieden werden.

100 Farben: Die Farben werden mehrfach verwendet, wenn mehr als
100 Werte vorhanden sind. Nicht alle 100 Farben können von Menschen
mit Farbblindheit unterschieden werden.

Bibliotheksfarben Wählen Sie diese Option aus, um Farbwerte für Master-Dimensionen zu
verwenden.

Diese Option ist verfügbar, wenn eine Master-Dimension in der
Visualisierung verwendet wird.

Optionen für die Farbgebung nach Dimension
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Farbgebung nach Kennzahl
Wenn Sie die Farben einer Visualisierung nach Kennzahl bestimmen, erhalten alle Werte in der
Visualisierung die Farbe eines Farbverlaufs oder einer Klasse, die auf den Werten im ausgewählten
Kennzahlfeld beruhen. Standardmäßig erhält die Visualisierung die Farbe ihrer primären Kennzahl,
Sie können jedoch auch eine andere Kennzahl auswählen. Es stehen vier Farbschemata zur
Verfügung.

Die Farbgebung nach Kennzahl ist sinnvoll, wenn Sie die durch die entsprechenden Kennzahlwerte
kolorierten Objekte deutlich darstellen möchten.

Folgende Optionen stehen zur Verfügung, wenn die Option Nach Kennzahl unter Farben in
Darstellung > Farben und Legende ausgewählt ist:

UI-Element Beschreibung

Wählen Sie
Kennzahl
aus
ausgewählt
ist

Wählen Sie die Kennzahl für die Farbgebung der Visualisierung aus. Wenn eine
Kennzahl zu der Visualisierung hinzugefügt wurde, wird diese Kennzahl
standardmäßig ausgewählt. Klicken Sie auf , um eine Kennzahl auszuwählen.

Sie können eine Formel eingeben. Öffnen Sie dazu mit den Formel-Editor.

Farbige
Codierung

Wählen Sie das in Ihrer Visualisierung verwendete Farbschema aus. Folgende
Schemata sind verfügbar:

Sequenzieller Farbverlauf: Der Übergang zwischen den unterschiedlichen
Farbgruppen erfolgt über verschiedene Schattierungen. Hohe Kennzahlwerte
haben dunklere Farbtöne.

Sequenzielle Klassen: Der Übergang zwischen den unterschiedlichen
Farbgruppen erfolgt über besonders leicht unterscheidbare Farben.

Divergierender Verlauf: Wird für die Arbeit mit Daten in aufsteigender
Sortierung verwendet, um beispielsweise die Beziehung zwischen
verschiedenen Bereichen auf einer Karte anzuzeigen. Niedrige und hohe Werte
haben dunkle Farben, jene im mittleren Bereich sind hell.

Divergierende Klassen: Kann als Kombination zweier sequenzieller Klassen
betrachtet werden, wobei der mittlere Bereich gemeinsam genutzt wird. Die
beiden Extreme Hoch und Niedrig werden mit dunklen Farben mit
kontrastierenden Farbtönen hervorgehoben, die wichtigen Werte im
Mittelbereich werden durch helle Farben betont.

Farben
umkehren

Wählen Sie diese Option aus, um die für niedrige und für hohe Werte im
ausgewählten Farbschema verwendeten Farben umzukehren.

Optionen für die Farbgebung nach Kennzahl
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UI-Element Beschreibung

Abschnitt Legen Sie die Bereiche für die Kennzahlwerte fest, die zur Farbgebung der
Visualisierung dienen. Ist für diese Option Automatisch eingestellt, erstellt Qlik
Sense Bereiche anhand der ermittelten Höchst- und Tiefstwerte.

Ist für diese Option Benutzerdefiniert eingestellt, erstellt Qlik Sense Bereiche
automatisch anhand der benutzerdefinierten Höchst- und Tiefstwerte. Sie
müssen Werte oder Formeln zur Berechnung dieser Werte in den Feldern Min.
und Max. eingeben. Sie können eine Formel eingeben. Öffnen Sie dazu mit
den Formel-Editor.

Farbgebung nach Formel
Farbgebung nach Formel verwendet für die Farbgebung einer Visualisierung eine
benutzerdefinierte Formel. Damit können Sie sowohl für die verwendeten Farben als auch für die
Werte, auf die die Farben in einer Visualisierung angewendet werden, Formeln verwenden. So
können Sie beispielsweise eine Formel einsetzen, um bedingte Farben in einem Diagramm
festzulegen.

Folgende Optionen stehen zur Verfügung, wenn die Option Nach Formel unter Farben in
Darstellung > Farben und Legende ausgewählt ist:

UI-Element Beschreibung

Formel Geben Sie eine Formel ein. Öffnen Sie dazu mit den Formel-Editor.

Weitere Informationen finden Sie unter Beispiele (page 649).

Die Formel ist
ein Farbcode

Standardmäßig ausgewählt. In den meisten Fällen ist es am besten, diese
Einstellung beizubehalten. Beim Deaktivieren dieser Auswahl wird die Formel
als Wert ausgedrückt, der wiederum mit einem der Farbverläufe des
Diagramms dargestellt wird.

Bezeichnung Geben Sie die in der Legende anzuzeigende Bezeichnung ein.

Die Formel ist ein Farbcode muss deaktiviert werden.

Optionen für die Farbgebung nach Formel
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UI-Element Beschreibung

Farbige
Codierung

Das Farbschema legt die in der Visualisierung verwendeten Farben fest.
Folgende Farbschemata sind verfügbar:

Sequenzieller Farbverlauf: Der Übergang zwischen den unterschiedlichen
Farbgruppen erfolgt über verschiedene Schattierungen. Hohe Kennzahlwerte
haben dunklere Farbtöne.

Sequenzielle Klassen: Der Übergang zwischen den unterschiedlichen
Farbgruppen erfolgt über besonders leicht unterscheidbare Farben.

Divergierender Verlauf: Wird für die Arbeit mit Daten in aufsteigender
Sortierung verwendet, um beispielsweise die Beziehung zwischen
verschiedenen Bereichen auf einer Karte anzuzeigen. Niedrige und hohe
Werte haben dunkle Farben, jene im mittleren Bereich sind hell.

Divergierende Klassen: Kann als Kombination zweier sequenzieller Klassen
betrachtet werden, wobei der mittlere Bereich gemeinsam genutzt wird. Die
beiden Extreme Hoch und Niedrig werden mit dunklen Farben mit
kontrastierenden Farbtönen hervorgehoben, die wichtigen Werte im
Mittelbereich werden durch helle Farben betont.

Die Formel ist ein Farbcode muss deaktiviert werden.

Farben
umkehren

Mit dieser Option wird das Farbschema umgekehrt.

Die Formel ist ein Farbcode muss deaktiviert werden.

Abschnitt Mit dieser Einstellung können die Wertebereiche für die Farbergebnisse in der
Visualisierung festgelegt werden.

Automatisch: Qlik Sense erstellt anhand der ermittelten Höchst- und
Tiefstwerte Bereiche.

Benutzerdefiniert: Qlik Sense erstellt anhand der benutzerdefinierten
Höchst- und Tiefstwerte automatisch Bereiche. Sie müssen Werte oder
Formeln zur Berechnung dieser Werte in den Feldern Min. und Max. eingeben.
Sie können eine Formel eingeben. Öffnen Sie dazu mit den Formel-Editor.

Die Formel ist ein Farbcode muss deaktiviert werden.

Farbe nach Formel in Tabellenvisualisierungen
Mit Formeln können Hintergründe und Text von Tabellen und Pivottabellen farblich gestaltet
werden. Damit können Sie sowohl für die verwendeten Farben als auch für die Konditionalwerte, auf
die die Farben in einer Visualisierung angewendet werden, Formeln verwenden. So können Sie zum
Beispiel Formeln verwenden, um die Text- und Hintergrundfarben entsprechend der Werte in den
unterschiedlichen Tabellenzellen zu ändern.

Folgende Optionen stehen unter Daten zur Farbgebung von Visualisierungen von Tabellen und
Pivottabellen zur Verfügung:
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UI-Element Beschreibung

Formel für
Hintergrundfarbe

Geben Sie eine Formel ein. Öffnen Sie dazu mit den Formel-Editor. Die
Textfarbe ändert sich automatisch zu weiß, wenn eine dunkle
Hintergrundfarbe verwendet wird.

Weitere Informationen finden Sie unter Beispiele (page 649).

Formel für
Textfarbe

Geben Sie eine Formel ein. Öffnen Sie dazu mit den Formel-Editor.
Wenn Sie dieselbe Formel wie für die Hintergrundfarbe verwenden, ist der
Text nicht sichtbar.

Weitere Informationen finden Sie unter Beispiele (page 649).

Optionen zur Farbgebung von Tabellen- und Pivottabellen-Visualisierungen

Farbgebung nach Formel
Bei der Farbgebung nach Formel werden Farben anhand einer benutzerdefinierten
Formel festgelegt. Hierbei können Sie definieren, welche Farben für welche Werte
verwendet werden. Dadurch können Sie die Farbgestaltung in Visualisierungen besser
steuern.

So können Sie zum Beispiel besonders interessante Werte hervorheben oder Werte in
unterschiedlichen Wertebereichen voneinander abheben. Die Farbgebung nach Formel kann auch
verwendet werden, um in Visualisierungen Farben von Werten zu einzusetzen, die nicht in der
Visualisierung enthalten sind. So können beispielsweise Produkte und ihre monatlichen
Gesamtumsätze nach Herkunftsland farblich hervorgehoben werden.

Wenn Sie sich für die Farbgebung Nach Formel entscheiden, können Sie die Formel entweder als
Farbcode verwenden oder damit festlegen, wie Nach Kennzahl-Farboptionen auf die
Visualisierung angewendet werden.

Die folgenden Visualisierungen unterstützen Farbformeln:

l Balkendiagramm
l Kombi-Diagramm
l KPI-Diagramm
l Liniendiagramm
l Karte
l Kreisdiagramm
l Pivottabelle
l Punktdiagramm
l Tabelle
l Baumkarte
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Sie können auch Farbe nach Formel verwenden, um eine Hintergrundfarbe in einem Arbeitsblatt
festzulegen. Weitere Informationen finden Sie unter Strukturieren von Apps mithilfe von
Arbeitsblättern (page 11).

Die Legenden-Auswahl ist in einer Visualisierung nicht verfügbar, wenn die Farben nach
Formeln vergeben werden. Visualisierungen, die über eine Formel farbcodiert sind,
unterstützen keine Legenden.

Farbgebung nach Formel als Farbcode
Wenn Sie die Farbgebung nach Formel auswählen, ist standardmäßig die Option Die Formel ist ein
Farbcode aktiviert. Wenn diese Option ausgewählt ist, muss die Formel einen Farbcode in einem
unterstützten Format enthalten. Mit dieser Methode können Sie die Visualisierungsfarben und die
Bedingungen für die Verwendung der Farben manuell steuern. In Tabellen und Pivottabellen können
Sie mithilfe von Formeln die Hintergrundfarbe und die Textfarbe von Spalten definieren.

Bei der Farbgebung nach Formel werden Objekte in Visualisierungen grau dargestellt,
wenn die Formel Fehler enthält oder wenn den Objekten in der Visualisierung laut Formel
mehrere Farben zugewiesen werden könnten.

Beispiele
Nachfolgend ein paar Beispiele, die zeigen, was Sie in Bezug auf die Farbgestaltung mithilfe von
Formeln erreichen können.

Beispiel: Farbgebung nach zufälligem Farbbereich

argb(255,rand()*255,rand()*255,rand()*255)

In diesem Beispiel wird eine ARGB-Farbe verwendet. Ausgangspunkt ist ein Alphawert für
vollständige Deckung gefolgt von der Funktion rand(), die mit zufälligen Werten für Rot, Grün und
Blau eine Zufallsfarbe generiert.

Beispiel: Farbgebung mit nur einem Kennzahlwert

if(sum([Budget Amount]) > 1000000, 'cornflowerblue', magenta())

In diesem Beispiel kommt eine Bedingung vor. Wenn sum([Budget Amount]) größer ist als 1 Million,
werden die entsprechenden Kennzahlwerte in 'cornflowerblue' dargestellt, ansonsten sind sie
magentafarben.

'cornflowerblue' ist das Schlüsselwort für die Farbe rgb(100, 149, 227).

magenta() ist die Farbfunktion in Qlik Sense, die eine Magenta-Farbe generiert.

Beispiel: Farbgebung nach einem Kennzahlwert mithilfe einer aggregierten Formel

if(avg(Value) > avg(Total aggr(avg(Value), Name)), Blue(), Brown())

Erstellen von Apps und Visualisierungen - Qlik Sense, November 2024 649



3   Visualizations

In diesem Beispiel kommt eine Bedingung vor. Wenn der Wert avg(Value) größer ist als der
aggregierte Wert avg(Value) der gesamten Tabelle, wird der zugehörige Kennzahlwert blau
hervorgehoben. Wenn der Wert avg(Value) kleiner als der aggregierte Wert avg(Value) der
gesamten Tabelle ist, wird der zugehörige Kennzahlwert braun hervorgehoben.

Beispiel: Farbgebung nach mehreren Kennzahlwerten

if(Sum(Sales) > 3000000, 'green', if(Sum(Sales) > 2000000, 'yellow', if(Sum(Sales) > 1000000,
'orange', red())))

In diesem Beispiel kommen mehrere Bedingungen vor. Wenn „Sum(Sales)“ größer ist als 3.000.000,
werden die zugehörigen Kennzahlwerte grün hervorgehoben. Wenn „Sum(Sales)“ zwischen
2.000.000 und 3.000.000 liegt, werden die zugehörigen Kennzahlwerte gelb hervorgehoben. Wenn
„Sum(Sales)“ zwischen 1.000.000 und 2.000.000 liegt, werden die zugehörigen Kennzahlwerte
orange hervorgehoben. Alle anderen Kennzahlwerte werden rot hervorgehoben.

Beispiel: Farbgebung nach mehreren Dimensionen

if([CompanyName]= 'A Corp', rgb(100, 149, 227), if([CompanyName]= 'B Corp', rgb(100, 149, 200),
if([CompanyName]= 'C Corp', rgb(100, 149, 175), if([CompanyName]= 'D Corp', rgb(100, 149, 150),
'grey'))))

In diesem Beispiel wird mithilfe der Formel für jeden einzelnen Dimensionswert im Feld
„CompanyName“ eine RGB-Farbe definiert.

Beispiel: Schrift- und Hintergrundgrund eines Tabellenobjekts anhand eines Kennzahlwerts

if(Sum([Sales]) < 10000, 'red', green())

if(Sum([Sales]) > 200000, 'gold', )

In diesem Beispiel werden für die Farbgebung von Text und Hintergrund der Spalte Sales zwei
Formeln verwendet. Für Kennzahlwerte in Sales, die unter 10.000 $ liegen, wird eine rote
Hintergrundfarbe angezeigt, für alle anderen Werte eine grüne Hintergrundfarbe. Für Werte über
200.000 $ wird zudem die Textfarbe 'gold' angezeigt.
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Farbgebung nach Formel ohne Farbcode
Sie können die Farbgebung auch ohne Farbcode vornehmen, indem Sie die Option Die Formel ist
ein Farbcode deaktivieren. Bei dieser Art der Farbgebung wird die Formel zur Auswertung eines
Zahlenwert verwendet, der mit dem Diagramm-Farbverlauf Nach Kennzahl dargestellt wird. Die
Formel dann bei Farbgebung nach Kennzahl wie eine Kennzahl behandelt.

Bei der Farbgebung nach Formel werden Objekte in Visualisierungen grau dargestellt,
wenn die Formel Fehler enthält oder wenn den Objekten in der Visualisierung laut Formel
mehrere Farben zugewiesen werden könnten.

Beispiel:

100*Sum([Sales Margin Amount])/Sum([Sales Amount])

In diesem Beispiel werden Nach Kennzahl-Farbverläufe auf die Diagramme angewendet, abhängig
von dem durch die Formel berechneten Gewinnmargen-Perzentil.

Unterstützte Formelformate
Die folgenden Formate werden beim Erstellen von eigenen Formeln unterstützt.
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RGB
Bei RGB-Farben geben Sie eine ganze Zahl zwischen 0 und 255 (oder eine Formel, die einen
solchen Wert ergibt) für jede der drei Farben Rot, Grün und Blau ein. Die dargestellte Farbe ergibt
sich aus der Addition der drei verschiedenen Farben.

Beispiel:

rgb(0,0,255)

Dieses Beispiel ergibt die Farbe Blau. Für viele der RGB-Farben ist ein entsprechendes
Schlüsselwort im Klartext verfügbar, das anstelle des RGB-Codes verwendet werden kann. Wenn
Sie 'blue' als Formel eingeben, erhalten Sie genau dieselbe Farbe. Hexadezimalzahlen werden
ebenfalls unterstützt, und die Farbe Blau hätte beispielsweise den String '#0000ff'.

ARGB
Das ARGB-Farbmodell ähnelt dem RGB-Farbmodell, erweitert dieses jedoch um einen zusätzlichen
Alphawert, der die Deckung einer Farbe festlegt.

Beispiel:

argb(125,0,0,255)

Der erste Wert (125) legt den Alphawert fest. Der Wert 0 entspricht vollständiger Transparenz und
der Wert 255 vollständiger Deckung.

HSL
In HSL wird die Farbe durch einen Wert für den Farbton, die Sättigung und die Helligkeit definiert.
Sie verwenden Werte zwischen 0 und 1. Der Farbton wird als Winkel des Farbkreises dargestellt
(der in einem Kreis dargestellte Regenbogen). Die Sättigung ist bei einem Wert von 1 vollständig
vorhanden, bei einem Wert von 0 nur eine leichte Grauschattierung. Die Helligkeit ist bei einem Wert
von 1 weiß und bei einem Wert von 0 schwarz. Üblicherweise wird der Wert 0,5 verwendet.

Beispiel:

hsl(0,0.5,0.5)

In diesem Beispiel wird die Farbe Rot mit mittlerer Sättigung und Helligkeit generiert.

Farbschlüsselwörter
Qlik Sense unterstützt die von W3C empfohlenen Farbschlüsselwörter. Die Farben werden hierbei
durch einen Namen definiert, der einem RGB-Hexadezimalwert entspricht. Geben Sie den
Farbnamen in der Formel an, um die Farbe zu verwenden.

Weitere Informationen zu Farbschlüsselwörtern gemäß W3C finden Sie unter den folgenden Links:
≤ http://www.w3.org/TR/CSS21/syndata.html#value-def-color
≤ https://developer.mozilla.org/en-US/docs/Web/CSS/color_value
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Beispiel:

'cornflowerblue'

Mit diesem Beispiel wird mit dem Hexadezimalwert #6495ed und einem RGB-Wert von (100, 149,
237) die Farbe Blau generiert.

Qlik Sense-Farbfunktionen
In Formeln können die folgenden Farbfunktionen verwendet werden.

l black()
l darkgray()
l lightgray()
l white()
l blue()
l lightblue()
l green()
l lightgreen()
l cyan()
l lightcyan()
l red()
l lightred()
l magenta()
l lightmagenta()
l brown()
l yellow()

Erstellen einer Formel
Sie können Formeln für Farben im Eigenschaftenfenster erstellen.

Gehen Sie folgendermaßen vor:

1. Öffnen Sie im Eigenschaftenfenster Darstellung > Farben und Legende.
2. Klicken Sie auf die Schaltfläche Farben, um zu Benutzerdefiniert zu wechseln.
3. Wählen Sie in der Dropdown-Liste die Option Nach Formel aus.

Ein Formeltextfeld wird geöffnet.

4. Geben Sie Ihre Formel in das Textfeld ein oder klicken Sie auf , um den Formeleditor zu
öffnen.

Wenn die Formel gültig ist, werden die Visualisierungen aktualisiert.
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Visualisierungsunterstützung für Farbgebungsmethoden
Nicht alle Qlik Sense Visualisierungen unterstützen dieselben Farbgebungsoptionen.
Darüber hinaus bestehen für einige Visualisierungstypen spezifische Verhaltensweisen
oder Einschränkungen bei der Verwendung bestimmter Farbgestaltungsmethoden.

Die von Visualisierungen unterstützten Farbgebungsmethoden und ihre Beschränkungen werden in
erster Linie von den Datenarten bestimmt, die in den Visualisierungen dargestellt sind. So kann
beispielsweise die Farbgebung für Visualisierungen, die nur die Anzeige von Kennzahlen
unterstützen, nicht nach Dimension oder mithilfe von Master-Dimensionen erfolgen.

Unterstützte Farbgebungsmethoden nach Visualisierung
Die folgende Tabelle erläutert die Unterstützung der Farbgebung nach Visualisierungstyp.

Visualisierungen
Einzel
n

Mehrfarb
ig

Master-
Kennza
hl

Master-
Dimensio
n

Dimensio
n

Kennza
hl

Forme
l

Balkendiagramm Ja Ja Ja Ja Ja Ja Ja

Boxplot Ja - - - - - -

Kombi-Diagramm Ja Ja Ja Ja Ja Ja Ja

Verteilungsdiagr
amm

Ja - - - - - -

Filterfenster - - - - - - -

Messzeiger Ja Ja Ja - - -

Histogramm Ja - - - - - -

KPI Ja Ja - - - - -

Liniendiagramm Ja Ja Ja Ja Ja Ja Ja

Karte Ja - - Ja Ja Ja Ja

Kreisdiagramm Ja Ja Ja Ja Ja Ja Ja

Pivottabelle - - - - - - Ja

Punktdiagramm Ja - - Ja Ja Ja Ja

Tabelle - - - - - - Ja

Text und Bild - - - - - - -

Baumkarte Ja Ja Ja Ja Ja Ja Ja

In der Visualisierung unterstützte Farbmethoden
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Farbeinschränkungen und -verhaltensweisen nach Visualisierung
Unterschiedlichen Visualisierungen zeigen unterschiedliche Verhalten angesichts der Methoden
zur Einstellung von Farben in Visualisierungen. In diesem Abschnitt werden spezielle Überlegungen
dargestellt, die beim Kolorieren unterschiedlicher Visualisierung angestellt werden müssen.

Liniendiagramm

Liniendiagramme unterstützen die Farbgebung nach Kennzahl nicht, wenn sie mindestens zwei
Dimensionen aufweisen.

Karte

Farben, die Master-Dimension zugewiesen sind, die Geopunkt- oder Bereichsdaten (Polygone oder
Geopunkte) enthalten, können zur Farbgestaltung von Karten nicht verwendet werden.

Kreisdiagramm

Kreisdiagramme verwenden keine Farben für Master-Elemente, wenn unter Farben und Legende
die Option Automatisch ausgewählt ist.

Beispiele für Farbeinstellungen in Visualisierungen
Sie können die Verwendung von Farben in Ihren Visualisierungen mit verschiedenen
Methoden selbst steuern.

Folgende Methoden stehen Ihnen zum manuellen Zuweisen von Farben in Ihren Visualisierungen
zur Verfügung:

l Farbgebung mit einer Farbe
l Farbgebung mit mehreren Farben
l Farbgebung nach Dimension
l Farbgebung nach Kennzahl
l Farbgebung nach Formel

Im Beispiel-Dashboard unten ist für jede Methode eine entsprechende Visualisierung zu sehen. In
diesem Abschnitt werden die einzelnen Beispiele sowie die verschiedenen Einstellungen im
Eigenschaftsfenster erläutert.
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Farbgebung mit einer Farbe
Visualisierungen können nur eine benutzerdefinierte Farbe verwenden. Die Farben können aus
einer Palette oder einem Farbkreis oder durch Angabe eines Hexadezimalfarbcodes ausgewählt
werden.

In dieser Beispielvisualisierung wurde nur eine Farbe auf das Liniendiagramm angewendet.

Einstellungen im Eigenschaftenfenster

Für diese Visualisierung wurden die folgenden Eigenschaften im Eigenschaftenfenster unter
Darstellung > Farben und Legende festgelegt:

l Farben: Stellen Sie hier Benutzerdefiniert und Eine Farbe ein. Die Farbe wird auf den
hexadezimalen Wert 4477aa festgelegt.
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Farbgebung mit mehreren Farben
In Visualisierungen mit mehreren Kennzahlen kann für jede Kennzahl eine andere Farbe eingegeben
werden. Wenn für die Farbgestaltung einer Visualisierung die Option Mehrfarbig aktiviert ist,
werden automatisch Farben aus einem Standard-Farbschema mit 12 Farben oder 100 Farben
verwendet.

In dieser Beispielvisualisierung wurden den Kennzahlen Expense Amount und Budget im
Liniendiagramm unterschiedliche Farben zugewiesen.

Einstellungen im Eigenschaftenfenster

Für diese Visualisierung wurden die folgenden Eigenschaften im Eigenschaftenfenster unter
Darstellung > Farben und Legende festgelegt:

l Farben: Wählen Sie Benutzerdefiniert und Mehrfarbig aus.
l Farbcodierung: Stellen Sie 12 Farben ein.

Farbgebung nach Master-Element
Farben für Dimensionen oder Kennzahlen können visualisierungsübergreifend beibehalten werden,
indem Sie Farben in Master-Elementen einstellen. Wenn Visualisierungen so konfiguriert sind, dass
sie Farben aus Master-Elementen verwenden, werden alle mit den Master-Elementen verknüpften
Farben in den Visualisierungen verwendet. Die Farben von Master-Elementen können verwendet
werden, wenn für Farbe entweder Eine Farbe oder Mehrfarbig eingestellt ist.
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In diesen Beispielvisualisierungen verwenden das Balkendiagramm und das Liniendiagramm eine
gemeinsame Master-Kennzahl Revenue, die orange hervorgehoben ist. In jeder Visualisierung wird
jeder Instanz von Revenue die gleiche Farbe zugewiesen. Die Farbe des Liniendiagramms stammt
von einer zweiten Master-Kennzahl, Expense Amount, und ist Blau.

Einstellungen für Master-Kennzahlen

Bei dieser Visualisierung werden unter Kennzahl bearbeiten folgende Einstellungen auf die
Master-Kennzahlen angewendet:

l Farbe Als Hexadezimalfarben wurden f8981d für Revenue und 4477aa für Expense Amount
verwendet.

Weitere Informationen finden Sie unter Zuweisen von Farben zu Master-Elementen (page 145).

Einstellungen im Eigenschaftenfenster

Für das Balkendiagramm werden im Eigenschaftenfenster unter Darstellung > Farben und
Legende die folgenden Eigenschaften festgelegt:

l Farben: Stellen Sie hier Benutzerdefiniert und Eine Farbe ein.
l Bibliotheksfarben verwenden: Stellen Sie hier „Aktiviert“ ein.

Für das Liniendiagramm werden im Eigenschaftenfenster unter Darstellung > Farben und Legende
die folgenden Eigenschaften festgelegt:

l Farben: Wählen Sie Benutzerdefiniert und Mehrfarbig aus.
l Bibliotheksfarben verwenden: Stellen Sie hier „Aktiviert“ ein.

Farbgebung nach Kennzahl
Wenn die Farbgestaltung einer Visualisierung anhand der Kennzahl erfolgen soll, werden Werten im
Diagramm sequenzielle oder divergierende Farbverläufe oder Klassen auf Basis der Werte der
ausgewählten Kennzahl zugewiesen. Die Farbgebung von Visualisierungen kann anhand von
Kennzahlen innerhalb der Visualisierung erfolgen oder anhand von Kennzahlen, die mit Werten der
Visualisierung verknüpft sind.
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In diesem Beispiel erhält das Balkendiagramm die Farbe der in der Visualisierung verwendeten
Kennzahl Revenue. Für Werte im Diagramm wurde ein divergierender Farbverlauf verwendet, und
zwar abhängig vom Revenue-Wert der einzelnen Dimensionswerte.

Einstellungen im Eigenschaftenfenster

Für diese Visualisierung wurden die folgenden Eigenschaften im Eigenschaftenfenster unter
Darstellung > Farben und Legende festgelegt:

l Farben: Stellen Sie hier Benutzerdefiniert und Nach Kennzahl ein. Die ausgewählte
Kennzahl ist Revenue.

l Farbcodierung: Stellen Sie hier Divergierender Verlauf ein.
l Farben umkehren: Stellen Sie hier „Aktiviert“ ein.
l Abschnitt: Stellen Sie hier Automatisch ein.

Farbgebung nach Dimension
Wenn für die Farbgestaltung einer Visualisierung nach Dimension erfolgt, bedeutet dies, dass
jedem Wert innerhalb der Visualisierung eine Farbe zugewiesen wird, die auf einem verknüpften
Wert der Dimension basiert. Bei der Farbgebung nach Dimension werden die Farben automatisch
aus einer Standardpalette mit 12 oder 100 Farben verwendet.

Beispiel 1: Farbgebung nach einer Dimension in der Visualisierung
In diesem Beispiel erfolgt die Farbgebung des Liniendiagramms nach der Dimension der
verschiedenen Vertriebsmitarbeiter anhand des 100 Farben-Schemas. Jeder Vertriebsmitarbeiter
hat in der Visualisierung seine eigene Farbe.
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Liniendiagramm mit Farbgebung nach Dimension

Einstellungen im Eigenschaftenfenster

Für diese Visualisierung wurden die folgenden Eigenschaften im Eigenschaftenfenster unter
Darstellung > Farben und Legende festgelegt:

l Farben: Stellen Sie hier Benutzerdefiniert und Nach Dimension ein. Die Dimension Sales
Rep Name wird ausgewählt.

l Farben bei Auswahl beibehalten: Stellen Sie hier „Aktiviert“ ein.
l Farbcodierung: Stellen Sie 100 Farben ein.

Beispiel 2: Farbgebung nach einer Dimension außerhalb der
Visualisierung
In diesem Beispiel erfolgt die Farbgebung des Balkendiagramms nach der Dimension Region
anhand 12 Farben-Schemas. Die Farbe der Balken der einzelnen Vertriebsmitarbeiter wird von der
Region bestimmt, in der sie arbeiten.
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Einstellungen im Eigenschaftenfenster

Für diese Visualisierung wurden die folgenden Eigenschaften im Eigenschaftenfenster unter
Darstellung > Farben und Legende festgelegt:

l Farben: Stellen Sie hier Benutzerdefiniert und Nach Dimension ein. Die Dimension Region
wird ausgewählt.

l Farben bei Auswahl beibehalten: Stellen Sie hier „Aktiviert“ ein.
l Farbcodierung: Stellen Sie 12 Farben ein.

Farbgebung nach Formel
Sie können Formeln verwenden, sodass für bestimmte Werte bestimmte Farben verwendet
werden, und so die bedingte Farbgebung für Ihre Visualisierungen aktivieren. Erfolgt die
Farbgebung einer Visualisierung nach Formel, können Sie die Farben und ihre Anwendung auf die
Werte in der Formel definieren.

Beispiel 1: Farbgebung nach Formel in einer Tabelle
In diesem Beispiel werden zur Visualisierung der Tabelle zwei Formeln verwendet, eine für die
Hintergrundfarbe und eine für den Text. Durch diese Formeln werden auf den Hintergrund und den
Text der Zeilen mit den 10 besten und den 10 schlechtesten Werten für Revenue bedingte Farben
angewendet.
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Einstellungen im Eigenschaftenfenster

Für diese Visualisierung wurden im Eigenschaftenfenster unter Daten > Spalten die folgenden
Eigenschaften festgelegt:

l Formel für Hintergrundfarbe: if(Rank(Sum([Sales Quantity]*[Sales Price])) <= 10,
'honeydew', if(Rank(-Sum([Sales Quantity]*[Sales Price])) <= 10, 'mistyrose', ))

l Formel für Textfarbe: if(Rank(Sum([Sales Quantity]*[Sales Price])) <= 10, 'green', if(Rank(-
Sum([Sales Quantity]*[Sales Price])) <= 10, 'red', ))

Beispiel 2: Farbgebung nach Formel in einem Diagramm
In diesem Beispiel wird für das Balkendiagramm eine Formel verwendet, die den unterschiedlichen
Werten im Feld Customer bestimmte Farben zuweist.
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Einstellungen im Eigenschaftenfenster

Für diese Visualisierung wurden die folgenden Eigenschaften im Eigenschaftenfenster unter
Darstellung > Farben und Legende festgelegt:

l Farben: Stellen Sie hier Benutzerdefiniert und Nach Formel ein.
l Formel: Stellen Sie hier if([Customer]= 'Fill It', rgb(100, 149, 227), if([Customer]= 'Hetrick

Systems', rgb(100, 149, 200), if([Customer]= 'Icon', rgb(100, 149, 175), if([Customer]= 'J. S.
Lee Associates', rgb(100, 149, 150), 'grey')))) ein.

l Die Formel ist ein Farbcode: Stellen Sie hier „Aktiviert“ ein.

Applying custom styling to a visualization
By default, the styling properties of a visualization are determined by the app theme.
You can override the app theme for individual visualizations by using the styling panel.
In the styling panel, you can also style individual charts with properties that are not
available in the app theme.

The styling panel is available in the properties panel. Under Appearance > Presentation, click
Styling. The properties available to customize depend on the chart type.

Examples of styling properties you can customize include, but are not limited to:
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l Chart title, subtitle, and footnote
l Background color and image
l Measure, dimension, and axis labels

For a list of customizable properties available for each chart type, see the corresponding chart-
specific help topic.

Copying and pasting visualization styling
If you have applied custom styling to a visualization, you can copy its styling properties and paste
them onto another visualization. With this option, you can quickly align the styling of your
visualizations without editing them in the properties panel or adding a custom theme.

You can copy and paste styles between different chart types. The entire style definition is applied
to the chart. Therefore, if a chart contains properties that do not apply to the chart receiving the
styling, these properties are still transferred to the receiving chart.

Gehen Sie folgendermaßen vor:

1. In sheet edit mode, right-click a chart or open the options menu by selecting the button
next to it.

2. Click Copy style.

3. Right-click the chart onto which you want to paste the styling, or open its options menu.

4. Click Paste style.

Limitations
l You cannot copy and paste the styling of a master visualization.
l You cannot copy and paste the styling of a map.
l You cannot copy and paste the styling of a button.

App themes
If you are looking to change the styling for all visualizations in the app, it might be easier to change
the app theme. For increased control over specific styling aspects of all app visualizations, consider
developing a custom theme and applying it to the app.

For more information about styling an app, see App-Design anpassen (page 35).

Konvertieren einer vorhandenen Visualisierung in eine andere Art
von Visualisierung
Sie können von einem Visualisierungstyp zu einem anderen konvertieren, indem Sie ein
Diagramm aus dem Extras-Fenster auf der linken Seite auf die Visualisierung ziehen,
die Sie konvertieren möchten.

Alle Eigenschaften der ursprünglichen Visualisierung werden auf den neuen Typ übertragen. Die
neue Visualisierung nutzt die Dimensionen, Kennzahlen und Einstellungen, die für diesen
Visualisierungstyp gelten. Wenn eine Visualisierung eine zusätzliche primäre Dimension oder
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Kennzahl benötigt, wird standardmäßig die erste aufgeführte alternative Dimension oder Kennzahl
verwendet. Wenn keine alternative Dimension oder Kennzahl vorhanden ist, diese jedoch in der
Visualisierung benötigt wird, werden Sie aufgefordert sie hinzuzufügen.

Alle Eigenschaften der ursprünglichen Visualisierung bleiben jedoch erhalten, auch wenn sie in der
neuen Visualisierung nicht verfügbar oder sichtbar sind. Das heißt, dass Eigenschaften wieder
verfügbar werden können, wenn Sie zu einem weiteren Visualisierungstyp konvertieren, bei dem
diese Eigenschaften verwendet werden.

Gehen Sie folgendermaßen vor:

1. Ziehen Sie beim Bearbeiten eines Arbeitsblatts ein neues Diagramm aus dem Extras-Fenster
auf die Visualisierung, die Sie konvertieren möchten.
Das Shortcut-Menü wird geöffnet.

2. Wählen Sie die Konvertierungsoption aus.

Die neue Visualisierung wird angezeigt, unter Verwendung der Daten der ursprünglichen
Visualisierung.

Wenn Sie zu einem neuen Visualisierungstyp konvertieren, sind einige Einstellungen der
ursprünglichen Visualisierung, z. B. die Sortierreihenfolge, für die neue Visualisierung
möglicherweise nicht optimal. Daher müssen Sie möglicherweise einige Änderungen im
Eigenschaftenfenster vornehmen, damit die neue Visualisierung wunschgemäß
angezeigt wird.

Konvertierungen zu oder von einer Karte oder einer Text- und Bildvisualisierung sind
nicht möglich. Master-Visualisierungen lassen sich ebenfalls nicht konvertieren.

Einbetten einer Visualisierung oder eines Arbeitsblatts in eine
Webseite
Sie können Qlik Sense Visualisierungen oder Arbeitsblätter in ein iframe-Element auf
einer Webseite mithilfe der Single Integration API integrieren. Das kann beispielsweise
eine Webseite in Ihrem Intranet sein. Sie wählen aus, welche Visualisierung bzw.
welches Arbeitsblatt eingebettet werden soll, und nehmen einige Einstellungen zum
Anpassen der Auswahl, Interaktion und Darstellung vor. Dann können Sie den iframe-
Code mit der URL des Objekts kopieren und zu Ihrer Webseite hinzufügen.

Das eingebettete Objekt unterliegt den gleichen Zugriffsregeln wie das Originalobjekt und die
Original-App. Das bedeutet, dass jeder, der die eingebetteten Objekte anzeigen möchte, über
Folgendes verfügen muss:
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l Zugriff auf Qlik Sense.
l Zugriff auf die App. Wenn die App nicht (in Meine Arbeit) veröffentlicht ist, sind Sie der

einzige Benutzer mit Zugriff.
l Zugriff auf das Arbeitsblatt. Wenn das Arbeitsblatt nicht (in Meine Arbeitsblätter) in einer

veröffentlichten App veröffentlicht ist, sind Sie der einzige Benutzer mit Zugriff.
l Zugriff auf jedes für die Auswahl verwendete Lesezeichen. Private Lesezeichen werden für

Sie, aber für niemanden sonst angewendet.
l Gleichen Datenzugriff auf die in der Auswahl verwendeten Daten wie Sie, wenn Section

Access zum Einschränken des Datenzugriffs verwendet wird.

Einbetten eines Arbeitsblatts
Sie können ein Arbeitsblatt in Ihre Webseite einbetten.

Gehen Sie folgendermaßen vor:

1. Klicken Sie im globalen Menü auf Arbeitsblatt einbetten.
2. Passen Sie die Optionen für Auswahl, Darstellung und Interaktion für das eingebettete

Arbeitsblatt an.
3. Klicken Sie auf Vorschau auf neuer Registerkarte öffnen, um eine Vorschau des

eingebetteten Arbeitsblatts anzuzeigen.
4. Klicken Sie auf Kopieren.

Jetzt befindet sich der iframe-Code des Arbeitsblatts in Ihrer Zwischeneinlage und kann Ihrer
Webseite hinzugefügt werden.

Einbetten einer Visualisierung
Sie können eine Visualisierung in Ihre Webseite einbetten.

Gehen Sie folgendermaßen vor:

1. Klicken Sie mit der rechten Maustaste auf die Visualisierung oder klicken Sie auf das
Daraufzeigen-Menü .

2. Wählen Sie Freigeben. Wählen Sie dann Einbetten.
3. Passen Sie die Optionen für Auswahl, Darstellung und Interaktion für die eingebettete

Visualisierung an.
4. Klicken Sie auf Vorschau auf neuer Registerkarte öffnen, um eine Vorschau der

eingebetteten Visualisierung anzuzeigen.
5. Klicken Sie auf Kopieren.

Jetzt befindet sich der iframe-Code der Visualisierung in Ihrer Zwischeneinlage und kann Ihrer
Webseite hinzugefügt werden.

Festlegen von Darstellung und Interaktion
Sie können anpassen, wie Sie mit dem eingebetteten Objekt interagieren können.
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l Interaktion zulassen
Sie können wählen, ob der Benutzer in der Lage sein soll, mit dem eingebetteten Objekt zu
interagieren.

l Kontextmenü aktivieren
Sie können wählen, ob das Kontextmenü verfügbar sein soll, wenn mit der rechten Maustaste
auf das eingebettete Objekt geklickt wird.

l Sprache
Sie können wählen, welche Sprache in Menüs für das eingebettete Objekt verwendet wird.

l Formatvorlage
Sie können wählen, welche Formatvorlage für das eingebettete Objekt verwendet wird.

Auswahlen im eingebetteten Objekt
Sie können wählen, ob der Benutzer Auswahlen im eingebetteten Objekt treffen kann, und welcher
Auswahlstatus im eingebetteten Objekt angezeigt wird.

l Aktuelle Auswahlen verwenden
Sie können wählen, die aktuellen Auswahlen in der App zu verwenden.

l Auswahlleiste anzeigen
Sie können wählen, die Auswahlleiste oberhalb des Arbeitsblatts anzuzeigen.

l App-Auswahlen beim Aktualisieren löschen
Sie können wählen, alle in der App getroffenen Auswahlen zu löschen, wenn das Objekt
gerendert wird.

l Lesezeichen anwenden
Sie können wählen, ein Lesezeichen anzuwenden und die im Lesezeichen definierten
Auswahlen zu verwenden.

Wenn die Seite mit dem eingebetteten Objekt gerendert wird, wird der anfängliche Auswahlstatus
durch die Reihenfolge der Ausführung und Ihre Einstellungen definiert.

1. App-Auswahlen beim Aktualisieren löschen
2. Lesezeichen anwenden
3. Aktuelle Auswahlen verwenden

Wenn Sie Auswahlen im eingebetteten Objekt treffen, werden sie in der App repliziert. Wenn Sie
beispielsweise App-Auswahlen beim Aktualisieren löschen wählen und das eingebettete Objekt
verwenden, werden Auswahlen in der App gelöscht.

Sie können Vorschau auf neuer Registerkarte öffnen verwenden, um eine Vorschau
des eingebetteten Objekts anzuzeigen, und damit interagieren, ohne die Auswahlen in
der App zu verändern.

Einschränkungen von eingebetteten Objekten
l Die Funktionen Arbeitsblatt einbetten und Diagramm einbetten sind auf Geräten mit

kleinem Bildschirm nicht verfügbar.
l Der Arbeitsblatttitel wird nicht eingeschlossen, wenn Sie Arbeitsblätter einbetten.
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l Die URL ist aufgrund von Browserbeschränkungen auf 2083 Zeichen beschränkt. Wenn Ihre
URL zu lang ist, liegt dies wahrscheinlich an einer großen Anzahl einzelner Auswahlen.

Sie können ein Lesezeichen mit dem gleichen Auswahlsatz erstellen und das
Lesezeichen anwenden. Damit wird eine kürzere URL erstellt.

l Abhängig von der Breite des Schattens und des Abstands um Visualisierungen können auf
Diagramme angewendete Schatten abgeschnitten werden, wenn das Diagramm mit dem
Schatten außerhalb von Qlik Sense eingebettet wird.

3.6 Fehlerbehebung – Erstellen von Visualisierungen
In diesem Abschnitt werden Probleme beschrieben, die beim Erstellen von Visualisierungen in Qlik
Sense auftreten können.

Ich finde die Felder im Extras-Fenster nicht
Ich kann Diagramme und Master-Elemente im Extras-Fenster finden, jedoch nicht in Feldern.

Mögliche Ursache

Sie arbeiten mit einer veröffentlichten App. Einige Inhaltesind im Extra-Fenster in einer
veröffentlichten App nicht verfügbar.

Mein Diagramm wird nicht richtig sortiert
Ich habe für mein Diagramm die automatische Sortierung der Dimension festgelegt, doch die
Ergebnisse werden nicht richtig sortiert.

Mögliche Ursache

Die Dimension ist eine Formel mit einem Ergebnis, das einen anderen Datentyp hat als die in der
Formel verwendeten Datenfelder.

Vorgeschlagene Aktion

Ändern Sie die Sortierung der Dimension in Custom (Benutzerdefiniert) und wählen Sie eine
Sortieroption aus, die dem Ergebnis der Formel entspricht. Beispiel: Wenn Ihre Formel zwei Felder
zu einem String verkettet, z. B. Month(salesDate)&'/'&Day(salesdate), wählen Sie die alphabetische
Sortierung.

Meine Kalenderkennzahlen zeigen falsche Aggregierungen in
Visualisierungen an
Wenn ich meine Kalenderkennzahlen in Visualisierungen verwende, werden falsche
Aggregierungsergebnisse angezeigt. Zum Beispiel werden Kalenderkennzahlen aus identischen
Feldern und Aggregierungen erstellt, aber unterschiedliche Zeiträume können identische
Gesamtwerte anzeigen.
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Mögliche Ursache

Die Tabelle mit dem Aggregatfeld wird nicht mit der Tabelle mit dem Datumsfeld verknüpft, was die
korrekte Aggregierung des Felds durch die ausgewählten Zeiträume verhindert.

Vorgeschlagene Aktion

Erstellen Sie eine Verknüpfung zwischen der Tabelle mit dem Aggregatfeld und der Tabelle mit dem
Datumsfeld. Falls keine Verknüpfung möglich ist, fügen Sie im Datenmanager eine Tabelle hinzu,
die ein Datumsfeld enthält, die eine Verknüpfung zu der Tabelle mit dem Aggregatfeld aufweist.

Unter Kalenderkennzahlen erstellen sind keine Zeiträume zum
Auswählen vorhanden
Wenn ich im Dialogfeld Create calender measures (Kalenderkennzahlen erstellen) versuche, aus
einem Feld Kalenderkennzahlen zu erstellen, sind im Dialogfeld Kalenderkennzahlen erstellen
keine Zeiträume zum Auswählen vorhanden.

Mögliche Ursache

Das ausgewählte Datumsfeld hat nicht die richtigen Zeit-Flags, die für die Arbeit mit
Kalenderkennzahlen erforderlich sind. Wenn Sie keine gültigen Datumsfelder haben, können Sie
keine Kalenderkennzahlen erstellen. Wenn Sie mindestens ein gültiges Datumsfeld haben, werden
alle Datumsfelder im Datumsfeld verfügbar. Doch nur die Datumsfelder mit den korrekten, in
autoCalendar festgelegten Zeit-Flags aktivieren die Auswahl von Zeiträumen in der Dropdown-
Liste „Zeitraum“.

Vorgeschlagene Aktion

Wählen Sie ein Datumsfeld aus, das autoCalendar verwendet. Wenn Sie nicht sicher sind, welcher
Kalender mit Ihrem Datumsfeld verknüpft ist, klicken Sie auf die Datumsfelder im Abschnitt Feld im
Fenster Extras, um anzuzeigen, welcher Kalender vom Datumsfeld verwendet wird.

Mein ausgewähltes Datumsfeld für Kalenderkennzahlen
verwendet nicht den richtigen Kalender
Ich habe zwei Kalender, zu denen ich manuell Zeit-Flags hinzugefügt habe. Meine Zeit-Flags haben
dieselben Namen wie diejenigen in autoCalendar, sodass beide für die Verwendung mit
Kalenderkennzahlen qualifiziert sind. Doch nur einer der Kalender hat dieselbe Definition für die
Zeit-Flags wie autoCalendar. Ich habe mit beiden Kalendern ein Datumsfeld verknüpft. Wenn ich
versuche, Kalenderkennzahlen mithilfe dieses Datumsfelds zu erstellen, wird der Kalender mit den
korrekten Namen, aber anderen Definitionen als autoCalendar verwendet.

Mögliche Ursache

In Fällen, bei denen ein Datumsfeld mit mehreren Kalendern verknüpft ist und für jeden Kalender die
korrekt benannten Zeit-Flags festgelegt sind, verwenden Kalenderkennzahlen die ersten
qualifizierten Kalender in Ihrem Datenladeskript.
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Vorgeschlagene Aktion

Verschieben Sie den Skriptabschnitt mit dem Kalender, den Sie mit Kalenderkennzahlen verwenden
möchten, sodass er vor den anderen qualifizierten Kalendern in Ihrem Datenladeskript steht.

Ich kann einen Variablenwert nicht bearbeiten
Ich kann eine Variable nicht bearbeiten, die im Variablendialogfeld aufgeführt ist.

Mögliche Ursache

Die Variable ist im Skript definiert.

Vorgeschlagene Aktion

Bearbeiten Sie die Variable über den Dateneditor im Skript oder löschen Sie sie über den
Dateneditor aus dem Skript, um die Variable über das Variablendialogfeld bearbeiten zu können.

Weitere Informationen finden Sie unter Bearbeiten einer Variablen (page 168)

Sie können eine Variable nicht umbenennen.

Auf der Karte sind die Standorte in meinem Standortfeld falsch
platziert
Wenn ich ein Standortfeld zu einer Ebene in meiner Karte hinzufüge, werden die Standorte nicht an
den richtigen Stellen angezeigt.

Mögliche Ursache

Die Karte verfügt nicht über ausreichend Kontext, um die Standorte in Ihrem Feld zu finden. Das
kann vorkommen, wenn ein Standort im Feld den gleichen Namen wie mehrere andere mögliche
Standorte auf der Karte hat.

Vorgeschlagene Aktion

Legen Sie den Bereich für Standort in Ihrer Ebene auf Benutzerdefiniert fest und geben Sie
zusätzliche Informationen ein. Alternativ können Sie das Standortfeld qualifizieren, indem Sie eine
Formel mit zusätzlichen Feldern mit relevanten geografischen Informationen verwenden. Wenn Ihr
Standortfeld beispielsweise Städte enthält und Sie die Felder Country und State haben, können Sie
[City]&','&[State]&','&[Country] verwenden.

Es wird keine Karte angezeigt
Ich verwende einen Qlik GeoAnalytics-Server, und die Hintergrundkarte wird nicht angezeigt.

Mögliche Ursache

Ihr Browser kann nicht auf qlikcloud.com zugreifen, oder Ihre Firewall-Einstellungen oder Proxys
verhindern die Nutzung von JavaScript über qlikcloud.com.
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Vorgeschlagene Aktion

Gehen Sie über Ihren Browser zur Statusseite.

Wenn Ihr Browser nicht auf qlikcloud.com zugreifen kann, wenden Sie sich an den
Systemadministrator, um Unterstützung zu erhalten.

Wenn die Seite „ok“ ausgibt, kann Ihr Browser auf qlikcloud.com zugreifen. Vergewissern Sie sich,
dass JavaScript von qlikcloud.com aus zulässig ist.

Gehen Sie folgendermaßen vor:

l Fügen Sie https://*.qlikcloud.com als vertrauenswürdige Website hinzu. (Empfohlen)
l Aktivieren Sie JavaScript von nicht vertrauenswürdigen Websites aus. (Nicht empfohlen).

Fehlermeldung: Die Daten enthalten ungültige Geometrien, die
nicht auf der Karte angezeigt werden konnten. Prüfen Sie Ihre
Daten auf Fehler und versuchen Sie es erneut.
Ich habe Geoformen aus einer KML-Datei in Qlik Sense geladen. Wenn ich versuche, das Feld zu
meiner Karte hinzuzufügen, weist eine Fehlermeldung darauf hin, dass meine Daten ungültige
Geometrien enthalten, die nicht auf der Karte angezeigt werden können.

Mögliche Ursache

Ihre Geometrien enthalten einen Fehler, der verhindert, dass Qlik Sense sie auf der Karte anzeigt,
oder Ihre Geometriedaten haben ein ungültiges Format.

Vorgeschlagene Aktion

Prüfen Sie Ihre Geometriedaten auf Fehler und versuchen Sie es erneut.

Fehlermeldung: Die folgenden Standorte konnten nicht gefunden
werden: <Standorte>. Prüfen Sie die Werte Ihrer Daten und
versuchen Sie es erneut.
Ich habe mein Standortfeld zu meiner Karte hinzugefügt und eine Fehlermeldung erhalten, die
darauf hinweist, dass die Standorte in meinem Standortfeld nicht gefunden werden konnten.

Mögliche Ursache

Qlik Sense konnte den Standort nicht finden. Der Name kann einen Rechtschreibfehler enthalten,
oder der Standort ist in der Standortdatenbank von Qlik Sense nicht verfügbar.

Vorgeschlagene Aktion

Prüfen Sie die Werte Ihrer Daten auf Fehler und versuchen Sie erneut, das Feld hinzuzufügen. Wenn
ein Standort nicht gefunden werden kann, können Sie ihn alternativ manuell hinzufügen, indem Sie
die Koordinaten für Punkte oder Geoformen für Gebiete verwenden.
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Fehlermeldung: Die folgenden Standorte konnten nicht gefunden
werden: <Standorte>. Prüfen Sie die Werte Ihrer Daten und
versuchen Sie es erneut.
Ich habe ein Standortfeld zu meiner Ebene hinzugefügt und eine Fehlermeldung erhalten, die darauf
hinweist, dass bestimmte Standorte in meinem Standortfeld nicht gefunden werden konnten.

Mögliche Ursache

Qlik Sense konnte den Standort nicht finden. Der Name kann einen Rechtschreibfehler enthalten,
oder der Standort ist in der Standortdatenbank von Qlik Sense nicht verfügbar.

Vorgeschlagene Aktion

Prüfen Sie die Werte Ihrer Daten auf Fehler und versuchen Sie erneut, das Feld hinzuzufügen. Wenn
ein Standort nicht gefunden werden kann, können Sie ihn alternativ manuell hinzufügen, indem Sie
die Koordinaten für Punkte oder Geoformen für Gebiete verwenden.

Fehlermeldung: Die folgenden Standorte hatten mehr als ein
Ergebnis: <Standorte>. Legen Sie einen benutzerdefinierten
Bereich fest, um zu klären, welche Standorte angezeigt werden
sollen.
Ich habe ein Standortfeld zu meiner Ebene hinzugefügt und eine Fehlermeldung erhalten, die darauf
hinweist, dass bestimmte Standorte in meinem Feld mehr als ein mögliches Ergebnis auf der Karte
hatten.

Mögliche Ursache

Ein oder mehrere Standorte in Ihrem Standortfeld sind mehrdeutig und ergeben mehrere mögliche
Standorte auf Ihrer Karte.

Vorgeschlagene Aktion

Legen Sie den Bereich für Standort in Ihrer Ebene auf Benutzerdefiniert fest und geben Sie
zusätzliche Informationen ein. Alternativ können Sie das Standortfeld qualifizieren, indem Sie eine
Formel mit zusätzlichen Feldern mit relevanten geografischen Informationen verwenden. Wenn Ihr
Standortfeld Städte enthielt, können Sie z. B. angeben: [City]&','&[County]&','&[State]

Fehlermeldung: Einige Linien konnten aufgrund von ungültigen
Daten in der Breitenformel nicht angezeigt werden. Prüfen Sie Ihre
Daten auf Fehler und versuchen Sie es erneut.
Ich habe ein Feld oder eine Formel eingegeben, um die Breite der Linien auf meiner Karte zu
steuern, und ich habe eine Fehlermeldung erhalten, die darauf hinweist, dass bestimmte Linien
ungültige Daten aufweisen.
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Mögliche Ursache

Es liegt ein Fehler in Ihrer Breitenformel vor, der Qlik Sense daran hindert, spezifische Linien auf der
Karte anzuzeigen.

Vorgeschlagene Aktion

Ihre Formel enthält möglicherweise nichtnumerische Werte. Prüfen Sie Ihre Daten auf Fehler und
versuchen Sie es erneut.

Fehlermeldung: Einige Dichtepunkte konnten aufgrund von
ungültigen Daten in der Gewichtungsformel nicht angezeigt
werden. Prüfen Sie Ihre Daten auf Fehler und versuchen Sie es
erneut.
Ich habe ein Feld oder eine Formel eingegeben, um die Dichte der Punkte auf meiner Karte zu
steuern, und ich habe eine Fehlermeldung erhalten, die darauf hinweist, dass bestimmte Dichten
ungültige Daten aufweisen.

Mögliche Ursache

Es liegt ein Fehler in Ihrer Gewichtungsformel vor, der Qlik Sense daran hindert, spezifische Dichten
auf der Karte anzuzeigen.

Vorgeschlagene Aktion

Ihre Formel enthält möglicherweise nichtnumerische Werte. Prüfen Sie Ihre Daten auf Fehler und
versuchen Sie es erneut.

Ich habe eine Bild-Hintergrundebene hinzugefügt und kann mein
Bild nicht sehen
Ich habe eine Bild-Hintergrundebene zu meiner Kartenvisualisierung hinzugefügt, aber ich kann sie
auf der Karte nicht sehen.

Mögliche Ursache

Abhängig von der Projektion Ihrer Karte und der Skalierung des Bildes ist die Karte möglicherweise
zu stark verkleinert, um das Bild sehen zu können.

Vorgeschlagene Aktion
Gehen Sie folgendermaßen vor:

l Aktivieren Sie unter Karteneinstellungen die Option Automatische Vergrößerung. Fügen
Sie eine Ebene mit den Standortdaten hinzu, die über den gleichen Bereich wie die Bild-
Hintergrundebene gelegt wird.

l Aktivieren Sie unter Präsentation die Option Debug-Info anzeigen. Die Karte enthält jetzt
Koordinaten für die Mitte des angezeigten Bereichs.
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